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Chapter1
WebFOCUS Business User Edition

With the WebFOCUS Business User Edition (BUE), you can perform reporting, analysis,
and discovery tasks using a single tool.

In this chapter:

Introducing the WebFOCUS Business User Edition

Installation

Navigating the Environment

Introducing the WebFOCUS Business User Edition

This topic provides an overview the WebFOCUS Business User Edition (BUE).

WebFOCUS BUE Components

WebFOCUS BUE is a web-based environment, consisting of the following components:

InfoAssist+

Perform reporting and analysis as well as data discovery, from a single user interface. These
categories of self-service analytics include the following capabilities:

Reporting and Analysis. Create ad hoc queries; develop reports, charts, documents and
other analytic views for personal usage or sharing and distribution in static or interactive
formats. You can also create more advanced information assets, such as multi-page
analytic documents and multi-source dashboards.

Data Discovery. Explore your data to find trends, patterns, and gain new insight, by
creating visualizations. Running against a high-speed data sandbox and other data sources,
you can create interactive visualizations that can be saved, shared, published, and
delivered as PowerPoint presentations to help you build business cases through
storytelling.

Business User Edition Portal

Provides access to a single web-based environment, where you can create, access, or manage
content and groups. You can develop new content or interact with content that has been
created by other users, as well as create personal portal pages.

ReportCaster
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Provides scheduling and distribution capabilities for reports and procedures, as well as
independent files and URLs. Using ReportCaster, reports and files are automatically distributed
on a monthly, weekly, daily, or specific basis.

WebFOCUS Installation Overview

This section briefly explains the different WebFOCUS installation components.

WebFOCUS and Your Network

WebFOCUS seamlessly integrates into your existing network by connecting web servers and
application servers to your data. Users then access WebFOCUS through a web browser. 

The main requirements for installing WebFOCUS are:

Web Browser. To access WebFOCUS applications, you need a web browser and a TCP/IP
connection to a web server or application server.

Web Server and Application Server. WebFOCUS runs in part through a web server or
application server. WebFOCUS BUE installs and configures a required application server.

Data. WebFOCUS BUE accesses data through a High-Speed Analytics Sandbox
(Hyperstage), a hybrid in-memory data store that stores, in a very compressed form, large
amounts of data for retrieval, aggregation, and calculation.

Installation

Installing WebFOCUS Business User Edition on a Windows Environment

This topic provides the step-by-step instructions that you need to install WebFOCUS Business
User Edition (BUE).

You can begin using WebFOCUS BUE immediately after you install the product. No additional
configuration steps are required.

WebFOCUS Business User Edition System Requirements for Windows

To install WebFOCUS BUE, you must have administrator privileges. Additionally, your machine
must meet the system requirements that are defined in the Hardware and Software
Requirements topics.

Hardware Requirements

Quad-core processor, 2.5 GHz minimum per core is recommended.

Installation
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16 GB of RAM or higher is recommended for optimal performance. 8 GB of RAM minimum.

8 GB of free disk space.

Ensure that the Windows page file is properly configured and that is set to Automatically
manage paging file size. For Windows 64-bit, the recommended paging file size is three
times the size of the RAM.

Software Requirements

Windows 10, 8.1, 7, Windows 2012, 2012 R2, or 2008 R2 Service Pack 1 Server editions.

Note: The Windows 10 Anniversary upgrade Version 1607 (OS Build 14398.82) is not
supported. This version causes Hyperstage to become unstable and disconnect.

64-bit Version of Windows.

Supported browsers: Internet Explorer
®
 11, Microsoft Edge

®
, Google Chrome

™
 (latest

version), Mozilla Firefox
®
 (latest version).

Note: Accessibility Compliance is not supported at this time.

Installing WebFOCUS Business User Edition

This section describes how to install WebFOCUS BUE.

Procedure: How to Install WebFOCUS Business User Edition

1. Download the installation files.

2. Double-click installWebFOCUS_BUE8201.exe.

Note: Java Version 8 Update 102 (8u102) and Tomcat 8.0.36 are included with the
WebFOCUS BUE product installation.

Tomcat Memory Allocation

The Tomcat initial memory pool size (JvmMs) is configured to use 1/8 of the physical
memory of the machine. For example, on a machine with 16 GB RAM, the pool size is
set to 2130. The maximum memory pool size (JvmMx) is configured to use 1/4 of the
physical memory of the machine. For example, on a machine with 16 GB RAM, the pool
size is set to 4261.

You can change the Java memory allocation by running the WfBUE82AppSrvw.exe
Tomcat configuration utility, located in the drive:\ibi\WebFOCUS_BUE82\tomcat\bin
folder, and selecting the Java tab.

1. WebFOCUS Business User Edition
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The InstallAnywhere installation program opens, as shown in the following image.

3. Choose the appropriate language from the drop-down list and click OK.

The list of languages depends on the regional language settings of the Windows Operating
System where WebFOCUS BUE is being installed.

Note: The language selected will be the language used during the installation program.
This language is also used to set the code page of the Reporting Server, which is
responsible for data access.

If your data sources are in a different language, you will have to change the code page of
the Reporting Server.

Installation
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The Welcome window opens.

4. Click Next to continue.

1. WebFOCUS Business User Edition
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The License Agreement window opens.

5. Click I accept the terms of the License Agreement, and then click Next.

Note:

Only one installation per platform is supported.

If you have an earlier release of WebFOCUS BUE installed on your machine, you will be
prompted to update your installation. For more information, see Updating WebFOCUS
Business User Edition on page 33. To perform a full or new installation, you must quit
the installation program, uninstall the existing version, and perform a new installation.
When you uninstall WebFOCUS BUE, all components are removed from your directory
structure, except the WebFOCUS BUE Reporting Server applications. For more
information, see Uninstalling WebFOCUS Business User Edition on page 35.
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The License Code window opens, as shown in the following image.

6. Type the WebFOCUS BUE license code and first four digits of the site code that were
provided with your copy of WebFOCUS BUE, and then click Next.

1. WebFOCUS Business User Edition
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The Setup Preferences window opens, as shown in the following image.

7. In the Setup Preferences window, complete the following steps:

a. The installation program preconfigures a user name, but requires that you type a
password. You must complete the User Name credentials section to proceed with the
installation. In the Password field, type a password, and then confirm your password.

Note: Passwords must be between 4 and 20 characters and cannot include double
quotation marks (") or a percent sign (%). Leading blanks and trailing blanks will be
removed.

b. Optionally, select the Configure email distribution check box to select the type of Mail
Server to be used for report distribution. Valid options are:

Google. This requires a Google Account Name and Password.
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Note: Google may block sign-in attempts when delivering reports through
WebFOCUS BUE. To allow WebFOCUS BUE to connect to the Google email account
that was configured for email distribution, sign in to the Google account, navigate
to My Account settings, select Sign-In & security, and turn the Allow less secure
apps option On.

For more information, see:

https://www.google.com/settings/security/lesssecureapps

Yahoo. This requires a Yahoo Account Name and Password.

Other. Select this for all other mail servers. This option requires you to type the
host name or IP address for your SMTP mail server.

c. Select the Configure WebFOCUS BUE services to start automatically check box to start
the WebFOCUS BUE services. This sets the services Startup Type to Automatic. This
will ensure that the services required to run the product are always running, and will
not require that you start the services manually, even if you restart the machine.

If you do not select this option, you can manually start and stop the WebFOCUS BUE
services from the shortcut options found in the WebFOCUS Business User Edition 82
group, or through the Windows services program.

d. Select the Advanced Configuration check box if you want to customize the location of
your Reporting Server applications directory. The default location is
\WebFOCUS_BUE82\data\apps.

8. Click Next to continue.

The Pre-Installation summary window opens.

1. WebFOCUS Business User Edition
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Note: If you selected the Advanced Configuration check box, the following window opens.

Server applications can be created in the default location or in a new location outside of
the drive:\ibi\WebFOCUS_BUE82\ folder. Select the location of your applications and then
click Next.

9. Confirm that the summary information is correct, and then click Install.

10. When the installation completes, click Done to close the installation program.
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The Sign In page opens, as shown in the following image.

11. Sign in using the manager user credentials that you configured during the installation
program.

Updating WebFOCUS Business User Edition

The following needs to be performed after the upgrade completes:

Ensure all WebFOCUS BUE services are running.

Run the drive:\ibi\WebFOCUS_BUE82\WebFOCUS\utilities\WFReposUtil\update_repos.bat
file.

This script will make updates to the WebFOCUS BUE repository that are required to support the
new Collaborative Portals.

Running WebFOCUS Business User Edition Services Manually

You should refer to this topic if you did not select the Configure WebFOCUS BUE services to
start automatically after a reboot check box during the installation program.

The installation program installs the following services:

An application server

A Distribution Server

1. WebFOCUS Business User Edition
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A repository server

A Reporting Server

Note: If you are updating an earlier release of WebFOCUS BUE, you must manually stop all
WebFOCUS BUE services before beginning the installation program. For more information, see 
Running WebFOCUS Business User Edition Services Manually on page 33.

To view the status of these services, launch your Windows Services program from the Control
Panel, and click the Standard tab. The following image highlights the WebFOCUS BUE services
as they appear in the Windows Services program.

Display name Service Name

WebFOCUS BUE 82 Application Server WfBUE82AppSrv

WebFOCUS BUE 82 Distribution Server WfBUE82DistSrv

WebFOCUS BUE 82 Reporting Server WebFOCUS BUE 82 Reporting Server

WebFOCUS BUE 82 Repository Server WfBUE82DbSrv

Installation

34  Information Builders



Procedure: How to Start or Stop WebFOCUS Business User Edition Services Manually

From the Start menu, navigate to the WebFOCUS Business User Edition shortcut, under the
Information Builders program group.

Click Start WebFOCUS_BUE Services to start the WebFOCUS BUE services.

Click Stop WebFOCUS_BUE Services to stop the WEBFOCUS BUE services.

Uninstalling WebFOCUS Business User Edition

If you want to remove an existing WebFOCUS BUE installation and want to perform a full
installation of a newer release, you can run the uninstall program.

Note: Before you uninstall WebFOCUS BUE, it is recommended that you save the cleanup utility
to a different location on your machine in case the uninstall fails and you need to manually
uninstall any components. For more information, see Troubleshooting WebFOCUS Business User
Edition on page 37.

Procedure: How to Preserve Your Data

The following steps can be performed if you want to preserve your data and perform a new
installation, if you need to move your data to another location, or if an upgrade installation fails
and you need to perform a new full installation.

1. Back up the WebFOCUS BUE repository server and Reporting Server application folders to
a different location on your machine.

By default, these are located in the following folders:

drive:\ibi\WebFOCUS_BUE82\derby\WFBUE82\

drive:\ibi\WebFOCUS_BUE82\data\apps\

drive:\ibi\WebFOCUS_BUE82\srv\wfs\hs\

2. Uninstall WebFOCUS BUE. You can uninstall WebFOCUS BUE from the Start menu, or
manually, as described in How to Manually Uninstall WebFOCUS Business User Edition
Components on page 38.

Procedure: How to Restore and Move Backed Up Data

1. Install WebFOCUS BUE.

2. After the installation program is complete, do the following:

a. Manually stop the repository server service.

b. Replace the new repository server and Reporting Server application folders, using the
backup directories that you made in step 1 of How to Preserve Your Data on page 35.

1. WebFOCUS Business User Edition
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c. Restart the repository server service.

Procedure: How to Uninstall WebFOCUS Business User Edition

1. From the Start menu, navigate to the Uninstall shortcut, under the Information Builders
Program group.

2. Click Uninstall.

The InstallAnywhere installation program opens.

Note: If the uninstall program is not visible from the Windows Start menu, uninstall the
software using the Programs and Features option on the Control Panel. Alternatively,
create a shortcut to C:\ProgramData\Microsoft\Windows\Start Menu\Programs. This will
open Windows Explorer with a classic view of all installed programs. You can use this to
navigate to WebFOCUS Business User Edition 82 in the Information Builders folder, and
then run the uninstall program.

3. In the Uninstall WebFOCUS Business User Edition 82 window, click Uninstall, as shown in
the following image.

Installation
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The installation program begins and uninstalls the WebFOCUS BUE components.

Troubleshooting WebFOCUS Business User Edition

If you are unable to launch WebFOCUS BUE, ensure that all services are running. If they are
not, do the following: 

Stop all services.

Restart the services, and launch WebFOCUS BUE.

If this does not work, stop the services again. Before you restart the services, ensure that the
Hyperstage processes, ibengine.exe and postgres.exe, are also stopped. Restart your machine
if you are still unable to restart the services.

Port Assignment

By default, ports in the range of 26000 to 26040 are checked for availability. If the installation
program detects that no ports in that range are available, it then increases the range by 10
and checks again for availability. For example, if ports 26000 to 26040 are unavailable, ports
26010 to 26050 are then checked.

Default Port Assignment.

Ports 26000 to 26003 are used by the application server.

Port 26010 is used by the repository server.

Ports 26020 to 26023 and port 26040 are used by the Reporting Server .

Port 26030 is used by the Distribution Server.

WebFOCUS Business User Edition Log Files

WebFOCUS BUE creates a log file in the following location for Windows 7:

drive:\Users\user_id\WebFOCUS_BUE82_Install_date_time.log

where:

user_id

Is your Windows user ID.

1. WebFOCUS Business User Edition
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date_time 

Is the date and time the log file was created. This log file provides information about the
WebFOCUS BUE installation. If you contact Customer Support Services with an installation
problem, have this file available.

Troubleshooting the Uninstall Process

If you choose to uninstall WebFOCUS BUE, and the uninstall process fails, you can follow one
of the procedures in this section to clean up your machine before reinstalling the product.

Before performing one of the following procedures, ensure that you have uninstalled
WebFOCUS BUE, as described in Uninstalling WebFOCUS Business User Edition on page 35.

Procedure: How to Manually Uninstall WebFOCUS Business User Edition Components Using the
Cleanup Utility

If the WebFOCUS BUE uninstall process fails, you can run the wf_cleanup.bat file to clean a
damaged installation on your machine.

1. Navigate to the following location on your machine:

drive:\ibi\WebFOCUS_BUE82\WebFOCUS\utilities\install\

2. Copy the wf_cleanup.bat file from the install directory to a different directory (for example,
drive:\ibi\).

3. Right-click wf_cleanup.bat, and then click Run as administrator.

4. When prompted, type the location of the install directory to proceed.

Note: By default, the utility will back up the Reporting Server apps, data, and the Derby
database.

Procedure: How to Manually Uninstall WebFOCUS Business User Edition Components

If the WebFOCUS BUE uninstall process fails, you can do the following to manually cleanup the
remaining WebFOCUS BUE components on your machine.

1. Stop any running WebFOCUS BUE services on the system, as detailed in How to Start or
Stop WebFOCUS Business User Edition Services Manually on page 35.
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2. Remove any remaining services from your machine.
a. Locate the existing WebFOCUS BUE services. To get the service name, right-click the

service in the Windows Services program and click Properties. The Properties dialog
box opens, where you can right-click the service name and click Copy, as shown in the
following image.

b. To remove a service, open the Command Prompt as an Administrator and issue the
following command:

sc delete "service name"  

where:
service name 

Is the name of the service you are manually deleting. For example:

C:\sc delete "WfBUE82AppSrv"
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Note: The service name must be enclosed in double quotation marks (").

Repeat this for the remaining services.

3. Open Task Manager and ensure that the process ibengine.exe is not running.

4. Remove files from disk, except for the Reporting Server application folders.

For example, if WebFOCUS BUE is installed on the C:\ drive, remove all folders under C:
\ibi\WebFOCUS_BUE82\, except for the following folders:

C:\ibi\WebFOCUS_BUE82\data\

C:\ibi\WebFOCUS_BUE82\srv\wfs\hs\

C:\ibi\WebFOCUS_BUE82\Derby\WFBUE82\

5. Click Start, point to All Programs, and expand the Information Builders folder.

6. Right-click the WebFOCUS Business User Edition 82 folder and click Delete.

7. Launch the Windows Registry Editor, and remove the following registry keys.

HKEY_LOCAL_MACHINE\SOFTWARE\WebFOCUS_BUE82

HKEY_LOCAL_MACHINE\SOFTWARE\Information Builders\Derby\WfBUE82DbSrv

HKEY_LOCAL_MACHINE\SOFTWARE\Information Builders\WebFOCUS BUE 82
Reporting Server

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Information Builders
\ReportCaster\WfBUE82DistSrv

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Apache Software Foundation
\Procrun 2.0\WfBUE82AppSrv

Installing the WebFOCUS Business User Edition on a Linux Environment

The following topic describes how to install WebFOCUS Business User Edition (BUE) on a Linux
environment. WebFOCUS Business User Edition (BUE) is supported on:

Intel Linux - Kernel-2.6.32-glibc-2.6 and higher x86_64 64-bit

Note: Java Version 8 Update 102 (8u102) and Tomcat 8.0.36 are included with the
WebFOCUS BUE product installation.

Intel Linux - Kernel-3.10.0-glibc-2.17 and higher x86_64 64-bit

Note: Java Version 8 Update 102 (8u102) and Tomcat 8.0.36 are included with the
WebFOCUS BUE product installation.
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Linux on IBM Power Systems - Kernel-3.16.0-libc6-2.19 and higher ppc64le 64-bit (Little
Endian)

Note: Java Version 8 Update 101 (8u101) and Tomcat 8.0.36 are included with the
WebFOCUS BUE product installation.

WebFOCUS Business User Edition System Requirements on a Linux Environment

The following section describes the system requirements for installing WebFOCUS BUE on a
Linux environment.

Note: Only one installation per platform is supported.

Installation Prerequisites

The following are installation prerequisites for installing WebFOCUS BUE on Linux:

WebFOCUS BUE cannot be installed as user root, due to requirements of the PostgreSQL
database used by Hyperstage. If user root is detected, the installation will exit and the
following message displays:

The installation cannot proceed under the root user account and will 
terminate. Restart the installation as a non-root user.

When installing WebFOCUS BUE on Linux machines, if the unzip application is not found,
the following message displays:

Invalid unzip command found.

This is generated by the installation program and does not prevent the installation from
proceeding and completing successfully.

WebFOCUS BUE requires a minimum of 5GB of available disk space to successfully install
on the target system.

An additional 8GB of required disk space is used during the installation of the product. This
temporary use of disk space will be removed at the end of the installation.

If the temp directory on the host does not meet the minimum size requirements, the
InstallAnywhere environment variable IATEMPDIR can be set to use an alternate directory.

You may specify an alternate /tmp location by setting the following environment variable:

IATEMPDIR=/large_tmp
export IATEMPDIR
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System Resource Limits

The operating system provides ways of limiting the amount of resources that can be used.
These limits can affect the installation process.

Use the ulimit command to set process memory-related resource limits for your session.

The WebFOCUS BUE installation program requires ulimit to be set to 8192.

Limits can be hard or soft. Hard limits are set by the root user. Only the root user can increase
hard limits, although other users can decrease them. Soft limits can be set and changed by
other users, but they cannot exceed the hard limits. To view the current limits, enter the
following command:

ulimit -a

Use the /etc/security/limits.conf file to store ulimit settings. Changes to this file should be
made by a system administrator.

Installing WebFOCUS Business User Edition Using Console Mode

The following section describes how to install WebFOCUS BUE using Console Mode. 

Procedure: How to Installing WebFOCUS Business User Edition Using Console Mode

1. Download the self extracting installation program, installWebFOCUSBUE8201.bin.

2. Apply the permissions necessary for the owner of the file to execute the installation by
using the following command:

chmod u+x installWebFOCUSBUE8201.bin

3. Run the installation program using the following command:

./installWebFOCUSBUE8201.bin -i console

The Welcome to WebFOCUS Business User Edition 82 prompt displays.

4. Press Enter to continue.

The License Agreement prompt displays.

5. Read the License Agreement. Press Enter after each screen until you receive the License
Agreement Acceptance prompt.

6. Type Y to accept the terms of the agreement and press Enter to continue.

The Choose Install Type prompt displays.

7. Type 2 to perform a full installation of WebFOCUS BUE.

8. Press Enter.
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The License Code prompt displays.

9. Type the license code (17 digits) for the WebFOCUS BUE Installation.

This code was sent to you as part of the email message that contained the download link
for the software.

You are prompted to enter the site code.

10. Type the site code (4 digits) for the WebFOCUS BUE Installation.

This code was sent to you as part of the email message that contained the download link
for the software.

11. Press Enter.

The Setup Preferences prompt displays.

12. Accept the default destination folder for the installation. If you want to install WebFOCUS
BUE in a different folder, type the path to the location where you want to install the
software.

Note: Spaces are not allowed in the destination path.

You are prompted to enter the WebFOCUS BUE Administration credentials.

13. Type a password to use with the Administration ID, manager.

Note:

The manager Administration ID cannot be changed.

Passwords must be between 4 and 20 characters and cannot include double quotation
marks (") or a dollar sign ($). Leading blanks and trailing blanks will be removed.

The Advanced Configuration prompt displays. Type Y and press Enter if you want to change
the default directory location of the WebFOCUS BUE Reporting Server application. Type N
and press Enter if you want to use the default directory location of the WebFOCUS BUE
Reporting Server.

If you chose to use the default WebFOCUS BUE Reporting Server directory, the Pre-
Installation Summary prompt displays.

14. Verify that the information in the Pre-Installation Summary window is correct, and press
Enter to continue.

The installation begins.

During installation, the activity window indicates which installation program tasks are being
performed.

1. WebFOCUS Business User Edition

Online Help PDF  43



When installation is complete, a summary is provided displaying the servers that were
installed and the ports that have been assigned.

Configuring Java Memory Allocation for the Application Server

For UNIX installations, the default Tomcat Java memory configuration is set to use an initial
Java heap size of 256MB and a maximum Java heap size of 512MB.

These settings are in located in the /ibi/WebFOCUS_BUE82/tomcat/bin/catalina.sh file. For
example:

JAVA_OPTS="-XX:MaxPermSize=256m -Xms256m -Xmx512m -
Djava.awt.headless=true"

For better product performance, it is recommended to increase these values. The initial Java
heap size should be at least 1024MB (1GB). The size is normally set in Megabytes. For
example:

-Xms1024m
-Xmx2048m

These values need to be set based on the physical memory of the machine.

It is recommended to set the minimum/initial memory value to one eighth (1/8) of the physical
memory. The maximum value needs to be one quarter (1/4) of the physical memory.

Launching WebFOCUS Business User Edition

To launch WebFOCUS BUE, type the following:

http://host:port/ibi_apps/

Note: Enter the application server port number when using this command to start WebFOCUS
BUE. The application server port number is the lowest port number displayed in the summary
at the end of the WebFOCUS BUE installation.

The default port for the WebFOCUS BUE application server is 26000. It is listed during the end
of the installation and also available in the installation log file.

Installation log files are under the user home directory. An example of an installation log file is
shown in the example below:

/$HOME/WebFOCUS_BUE82_Install_date_time.log
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where:

date_time 

Is the date and time the log file was created. This log file provides information about the
WebFOCUS BUE installation. If you contact Customer Support Services with an installation
problem, have this file available.

Running WebFOCUS Business User Edition Servers Manually

The following commands are used to manually start and stop the required WebFOCUS BUE
servers.

Note: The /home/user/ path depends on your installation.

Starting Servers

You must start the servers in the following order:

Repository Server

Application Server

Distribution Server

Reporting Server

To start the WebFOCUS BUE Repository Server, run:

nohup /home/user/ibi/WebFOCUS_BUE82/derby/bin/start.sh &

To start the WebFOCUS BUE Application Server, run:

/home/user/ibi/WebFOCUS_BUE82/tomcat/bin/startup.sh

To start the WebFOCUS BUE Distribution Server, run:

nohup /home/user/ibi/WebFOCUS_BUE82/WebFOCUS/ReportCaster/bin/schbkr &

To start the WebFOCUS BUE Reporting Server, run:

/home/user/ibi/WebFOCUS_BUE82/srv/wfs/bin/edastart -start

Stopping Servers

You must stop the servers in the following order:

Application Server

Distribution Server
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Repository Server

Reporting Server

To stop the WebFOCUS BUE Application Server, run:

/home/user/ibi/WebFOCUS_BUE82/tomcat/bin/shutdown.sh

To stop the WebFOCUS BUE Distribution Server, run:

/home/user/ibi/WebFOCUS_BUE82/WebFOCUS/ReportCaster/bin/stopit

To stop the WebFOCUS BUE Repository Server, run:

/home/user/ibi/WebFOCUS_BUE82/derby/bin/stop.sh

To stop the WebFOCUS BUE Reporting Server, run:

/home/user/ibi/WebFOCUS_BUE82/srv/wfs/bin/edastart -stop

Creating Shell Scripts to Start and Stop Servers

You can create shell scripts that run the following commands to start and stop servers:

Start Servers

nohup /home/user/ibi/WebFOCUS_BUE82/derby/bin/start.sh &
sleep 5
/home/user/ibi/WebFOCUS_BUE82/tomcat/bin/startup.sh
nohup /home/user/ibi/WebFOCUS_BUE82/WebFOCUS/ReportCaster/bin/schbkr &
/home/user/ibi/WebFOCUS_BUE82/srv/wfs/bin/edastart -start

Stop Servers

/home/user/ibi/WebFOCUS_BUE82/tomcat/bin/shutdown.sh
/home/user/ibi/WebFOCUS_BUE82/WebFOCUS/ReportCaster/bin/stopit
/home/user/ibi/WebFOCUS_BUE82/derby/bin/stop.sh
/home/user/ibi/WebFOCUS_BUE82/srv/wfs/bin/edastart -stop

Note:

Adjust the paths based on your installation directories.

The sleep 5 command adds a wait period to ensure Derby has started.

Updating WebFOCUS Business User Edition

You can update an earlier release of WebFOCUS BUE using the following steps.
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Procedure: How to Update WebFOCUS Business User Edition

1. Manually stop all WebFOCUS BUE servers, including the Application Server, Repository
Server, Distribution Server, Reporting Server, and Hyperstage Server.

2. Ensure that all ports that are used by WebFOCUS BUE processes are stopped. You can
run a command, such as netstat, to check the ports.

Note: If the ports are busy, run a command, such as lsof, to identify what processes are
still running, and stop those processes. Before you proceed, you must rerun the netstat
command.

3. Download the self extracting installation program, installWebFOCUSBUE8201.bin.

4. Apply the permissions necessary for the owner of the file to execute the installation by
using the following command:

chmod u+x installWebFOCUSBUE8201.bin

5. Press Enter to continue.

The License Agreement prompt displays.

6. Run the installation program using the following command:

./installWebFOCUSBUE8201.bin -i console

The Welcome to WebFOCUS Business User Edition prompt displays.

7. Read the License Agreement. Press Enter after each screen until you receive the License
Agreement Acceptance prompt.

8. Type Y to accept the terms of the agreement and press Enter to continue.

The Choose Install Type prompt displays.

9. Type 1 to update an existing WebFOCUS BUE installation to a new Service Pack level.

10. Press Enter.

11. Verify that the information in the Pre-Installation Summary window is correct, and press
Enter to continue.

The installation begins.

During installation, the activity window indicates which installation program tasks are being
performed.

12. Clear the Tomcat cache, all folders under:

/home/user/ibi/WebFOCUS_BUE82/tomcat/work/catalina/localhost/

13. Before launching WebFOCUS BUE, start the WebFOCUS BUE Servers as outlined in 
Running WebFOCUS Business User Edition Servers Manually on page 45.
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14. Start the WebFOCUS BUE Repository Server by running:

nohup /home/user/ibi/WebFOCUS_BUE82/derby/bin/start.sh &

15. Run the following script:

/home/user/ibi/WebFOCUS_BUE82/WebFOCUS/utilities/WFReposUtil/
update_repos.sh

You are prompted for WebFOCUS BUE administrator credentials. The built-in user ID is
manager.

16. Start the other servers:

/home/user/ibi/WebFOCUS_BUE82/tomcat/bin/startup.sh
nohup /home/user/ibi/WebFOCUS_BUE82/WebFOCUS/ReportCaster/bin/
schbkr &
/home/user/ibi/WebFOCUS_BUE82/srv/wfs/bin/edastart -start

The upgrade is now complete and you can use the software.

Uninstalling WebFOCUS Business User Edition

To uninstall WebFOCUS BUE, delete the /home/user/ibi/WebFOCUS_BUE82/ folder or run the
uninstall program using the following command:

/home/user/ibi/WebFOCUS_BUE82/Uninstall/Uninstall

Configuring for Email Distribution

An email server is required for email distribution and notifications. The following procedures
provide the steps for configuring the supported mail servers.

Procedure: How to Configure the Mail Server

1. From the BUE Portal Menu bar, click Administration, then click Administration Console.
Click the ReportCaster tab.

or

From the BUE Portal Menu bar, click Tools, then click ReportCaster Status.

2. Click the Configuration option on the ribbon.

3. Select the Email Distribution folder.

4. Type the name of your mail server in the Mail Server text box.

In addition, if your mail server uses a secure connection or requires authentication, select the
appropriate options and type the required credentials. You need to save your configuration
changes and restart ReportCaster to make the changes effective.
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If you use Google as your email server, see How to Configure Google as the Email Server on
page 49.

If you use Yahoo as your email server, see How to Configure Yahoo as the Email Server on page
50.

Procedure: How to Configure Google as the Email Server

1. Type the name of the Google SMTP Server in the Mail Server text box, as shown in the
following image.

2. Select the This Server Requires a Secure SSL Connection check box.

3. Do not select the This Server Requires a Secure TLS Connection check box.

4. Select the This Server Requires Authentication check box.

5. Click the button to open the SMTP User ID/Password dialog box.

6. Type your Google account name.

7. Type the password for this account.

8. Confirm the password for this account.

9. Click OK to close the dialog box.

10. Click Save in the Manage Configuration group on the ribbon.
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11. Click Restart in the Manage Configuration group on the ribbon.

Procedure: How to Configure Yahoo as the Email Server

1. Type the name of the Yahoo SMTP Server in the Mail Server text box, as shown in the
following image.

2. Select the This Server Requires a Secure SSL Connection check box.

3. Select the This Server Requires a Secure TLS Connection check box.

4. Select the This Server Requires Authentication check box.

5. Click the button to open the SMTP User ID/Password dialog box.

6. Type your Yahoo account name.

7. Type the password for this account.

8. Confirm the password for this account.

9. Click OK to close the dialog box.

10. Click Save in the Manage Configuration group on the ribbon.

11. Click Restart in the Manage Configuration group on the ribbon.
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Navigating the Environment

This topic introduces the WebFOCUS Business User Edition environment. It describes how to
navigate the WebFOCUS Business User Edition (BUE) portal, the Administration Console, and
InfoAssist+.

It is also important to understand that Manager users, Developers, Advanced users, and Basic
users have different access to environment options. That access is determined by the group of
users to which you are assigned.

Navigating the WebFOCUS Business User Edition Portal

When you access the WebFOCUS Business User Edition (BUE), using the Sign-in page or
browser URL, you are presented with the BUE Portal. From the portal, depending on your user
role, you can create and edit content, view content that other users published or shared,
create and edit personal pages, manage users, configure the system, upload files to the
repository, connect to data and edit data, and access interactive help and instructional
materials.

The main components of the BUE Portal include a Getting Started Page, Home Page,
Resources tree, and Menu bar.

Getting Started Page

The Getting Started page, shown in the following image, is the first page that you see when
you sign in to WebFOCUS BUE with the login and password that you created during the
installation.
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The Getting Started page provides access to resources that get you started with the software.
You can access the Information Center, a series of videos, and the Upload wizard and Connect
to Data wizard features.

Only Manager users can access this page.

Home Page

The Home page, which is shown in the following image, is the first page that you see when you
sign in as a Basic User, Advanced User, Developer, or Group Administrator.

The Home page has three sections with which you can interact:

Menu bar

Resources tree

Quick Links tab

The content in these sections varies, depending on your user type.

Menu Bar

The Menu bar is located in the upper-right section of the screen, inside the top banner. The
following image shows the Menu bar that appears when you are signed in as a Manager.
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The Menu bar gives you access to the following options:

Change your password (click your username).

Tools:

View the status of deferred reports, and manage them.

Stop your outstanding interactive requests that are running.

Access Session Viewer, where you can visualize the exploratory analysis of the current
web session.

Access the ReportCaster Status, where you view the status of your scheduled jobs and
log reports.

Administration:

Access the Security Center, where you define users and groups and grant access
permissions.

Access the Administration Console, where you configure, administer, and monitor the
components of the WebFOCUS application.

Access the Reporting Server Console, where you can view and manage the server
environment.

View and administer the private resources for groups and users.

Switch between Normal mode (seeing your own content) and Manager mode (managing
other user content).

Open the Resources tree on the right side of the window, so you can manage content on
Personal Pages.

Access the online Help, Information Center, a library of Help topics, self-service videos,
Community, Information Builders Home page, as well as information about the WebFOCUS
Business User Edition application, version, and available licenses.

Sign out
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Resources Tree

The Resources tree, located on the left side of the Home page, contains your available
resources, such as domains, folders, and content. It also contains functionality that allows you
to save content as a favorite, or perform a Change Management import or export. The following
image shows the Resources tree that appears when you are signed in to WebFOCUS Business
User Edition.

The resources are secured using the security model, that is folder-based, similar to that of
desktop operating systems. The resources differ for every user. For example, the Basic User
sees only public content.

The Resources tree contains the following nodes:

Domains. Lists the domains and folders that you have created. Yellow folders are
published folders. Gray folders are unpublished.

Favorites. Lists the items that you have designated as Favorites.

Change Management. Lists the Import and Export facilities.

Import. Enables users to move a change package into an acceptance test.

Export. Enables a developer to move changes made to application files to the user
acceptance test environment.

Node Context Menu Options

Each node in the Resources tree has a shortcut menu. The available options include:

View. This option is only available for the Domains node, and includes:

Display By Title. Displays folders by title. The default display.
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Display By Name. Displays folders by name.

New. This option is only available to managers, and includes:

Domain. Creates a new domain.

Refresh. Refreshes the Resources tree. The option is available for all nodes.

Paste. Pastes the item under the applicable node.

Clear Favorites. Clears the Favorites list. This option is only available for the Favorites
node.

Quick Links

The Quick Links on the Home page, include links for uploading or connecting to data, creating
content, managing domains and users, and configuring your system. It also shows the name of
the domain that is currently highlighted in the Resources tree. Whenever you navigate to a
different domain, the Quick Links refresh to reflect the new active directory.

The available Quick Links also change depending on the user. Each user only sees the options
that they have privileges to access. The following image shows an example of the Quick Links
that are available for a Manager.
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Understanding Domain Content

A domain node is the highest level of folder organization in the Resources tree. All of the
domains that a user is authorized to access are displayed in the tree. Domains contain all of
the components and content that you can create.

Selecting a Domain

A list of the domain folders, populated from the WebFOCUS Repository, appear in the
Resources tree. The items you can access and the options available to you are permitted by
the Manager of your environment. When the contents of a folder change, such as when you
create and save a new report, or a report is published, the Resources tree automatically
refreshes. You can also use the Refresh button in the toolbar to update the Domain contents.

Identifying Types of Content in the Resources Tree

A domain can contain a wide range of items, including reports, charts, visualizations,
documents, dashboards, Internet hyperlinks, schedules, and distribution lists.

These items are located in folders. Both the items and the folder may be private, published, or
shared. If you are permitted to create your own reports, you also have the My Content folder.
My Content may contain the Custom Reports, Shared Reports, and folders for each My Report
report you created.

Published content. Domain content that is published is considered authoritative and has
usually undergone quality assurance and testing before being published for the user
community.

Private content. This content can be in the following forms:

My Content. Personal content created by a user. This content remains private to a user
unless the user chooses to share it with others or unless an administrative user has
the ability to manage private content for that user.

Other private content. Domain content which is not published. It is accessible only to
its owner, which may be a specific user or a group.

When you create a folder, it is private content. Private content appears as a gray folder in the
Resources tree. If you share a folder, the folder includes a link icon and is available either to
all users, specific groups, or users permitted to access the folder location. If you publish the
folder, it appears as a yellow folder in the Resources tree and is available to all users.
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Identifying Content in the Resources Tree

The icons located next to each item represent the item type. In the following table, the first
column lists the icons, and the second column describes what they represent.

Icon Identifies

Folder. Allows users to organize their private or published application
content.

My Content folder. Provides the user with a location to create private
reports, output, and schedules. This is created when the parent folder
has the Auto create My Reports folder property selected and the user
is permitted to create private content in a My Content folder. The
private content within this folder cannot be published.

Page. An item that is used to organize a wide array of dynamic
content. Pages can reside inside a domain or folder in your repository,
they can be viewed inside the BUE portal and the Portal Designer.

Report procedure. Contains the core language commands to tell the
Reporting Server how to create the report.

Visualization. Represents your data graphically, and is comprised of
one or more visuals. Visuals can be charts, maps, or grids.

Chart procedure. Contains the core language commands to tell the
Reporting Server how to create the chart.

Document or dashboard. Customized document or dashboard that
contains more than one item.

Schedule. Specifies when to run a report procedure, how to distribute
the report (Email, FTP, Managed Reporting, Printer), and the
destination to which the report will be distributed. This is available
when licensed for the feature that creates schedules.

Distribution List. Used with a ReportCaster schedule (Email, FTP, or
Printer) to specify the email addresses, directory locations, or printers
to distribute.

Microsoft
®
 Office Excel Worksheet
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Icon Identifies

Adobe
®
 Acrobat PDF file

GIF image file

HTML file

JPG image file

PNG image file

SVG image file

Webpage or a URL to run a report

Blog. An interactive item that operates as commonly seen blogs on
the internet and allows users to post and view comments.

The following topics describe the shortcut menu options for each type of item.

Options for Folders and Items

When you right-click an item, the options displayed in the shortcut menu are determined by the
selected item type, and the tools and features you are permitted to access.

Reference: Options for Folders

The following options are available when you right-click a folder:

New 

Provides access to the following options:

Report 

Opens InfoAssist+, where you can create a report.

Chart 

Enables you to create a chart in InfoAssist+.

Document 

Enables you to create a document in InfoAssist+.
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Visualization 

Opens InfoAssist+, where you can create visualizations.

Sample Content
Opens the Open dialog box where you can select a Master File for generating sample
content.

Shortcut 

Creates a shortcut to a Repository Resource or a Master File.

URL 

Launches the Create URL dialog box, where you can create a link to a webpage.

Page
Enables you to create a page, which is an item that is used to organize a wide array of
dynamic content. Pages can only be viewed inside the BUE portal.

Distribution List 

Launches the Distribution List tool, where you can create distribution lists.

Folder 

Creates a new folder.

Blog 

Enables you to create a blog, where users post and view comments

Duplicate 

Makes a copy of the item with an underscore and number appended to the title, for
example, duplicating Sales_Report creates Sales_Report_1 in the same location. The
number is incremented each time a duplicate is created.

Cut, Copy, and Paste 

Cuts, copies, or pastes the folder and its contents.

Delete 

Deletes the folder and its contents.

Change Title 

Launches a dialog box, where you can change the title of a folder. The Title is the value
that displays in the Resources tree and does not change the folder Name value.

Refresh 

Refreshes the content of the folder.
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Upload 

Enables you to upload a data file, document, or image.

Metadata 

Enables you to create or edit a synonym.

Publish/Unpublish 

Allows or suppresses public access to the content.

Show/Hide 

Shows or hides the item.

Security 

Provides access to the following option:

Owner 

Allows you to set the resource owner, either Published (no specific owner), or a
specific group or user.

Properties 

Shows the properties of the folder.

Note: The options available for a folder are also available for other types of items.

Reference: Options for Content

Like folders, content, such as report, chart, dashboard, and visualization, have options that
include the Duplicate, Cut, Copy, Delete, Change Title, Publish/Unpublish, Show/Hide,
Security, and Properties options.

Note: Documents and dashboards have the same options as report and chart procedures with
the exception of Publish/Unpublish.

Report and chart procedures also include the following right-click options:

Run 

Runs the report procedure or schedule.

Run Deferred 

Submits a report procedure or a schedule for deferred execution.

Run With SQL Trace 

Runs a report and includes an SQL trace of the report results. This option is not available
for visualizations.
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Schedule 

Schedules a report procedure. Scheduling options include Email, Printer, and Repository.
This option is not available for visualizations.

Edit 

Edits an item with the tool that was used to create it.

Add to Favorites 

Adds the item to the Favorites folder.

Note: The options available for content are also available for other item types.

Reference: Options for Pages

Like content, these options include the Edit, Delete, Change Tile, Publish/Unpublish, Show/
Hide and Security options.

Like folders, these options include the Duplicate, Cut, Copy, and Properties options.

Pages also include the following shortcut menu option:

Add to Portal/Remove From Portal 

Adds a page to or removes it from the BUE portal.

Note: This option is only available for published pages.

Reference: Options for Schedules

Like folders, Schedule options include the Duplicate, Cut, Copy, Delete, Change Title, Security,
and Properties options.

Like content, Schedule options include the Edit and Run options.

Schedules also include the following right-click option:

View Log 

Launches the Schedule Log Options dialog box from which you can select whether to view
the most recent log report for the schedule or specify a time range for which to obtain log
reports.

Reference: Options for Distribution Lists

Like folders, Distribution List options include the Duplicate, Cut, Copy, Delete, Change Title,
Publish/Unpublish, Show/Hide, Security, and Properties options.
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Like content, Distribution List options include the Edit option. The Edit option invokes the
Distribution List tools.

Reference: Options for URLs

Like folders, URL options include the Duplicate, Cut, Copy, Delete, Change Title, Publish/
Unpublish, Show/Hide, Show/Hide, Share/Unshare, Share with, Security, and Properties
options.

Like content, URL options include the Edit, and Add to Favorites options.

URLs also include the following right-click option:

View 

Enables you to launch the URL link.

Reference: Options for Excel Workbooks, PDF, and Image Files

Like folders, these options include the Duplicate, Cut, Copy, Delete, Change Title, Publish/
Unpublish, Show/Hide, Security, and Properties options.

These files also include the following right-click option:

View 

Enables you to download a copy of the file to your browser, which will launch the File
Download dialog box to allow you to open or save the file. If you choose open, the file will
open in its corresponding application.

Reference: Options for Blogs

Like content, these options include the Edit, Delete, Change Tile, Create Shortcut, Publish/
Unpublish, Show/Hide and Security options.

Like folders, these options include the Duplicate, Cut, Copy, and Properties options.

Blogs also include the following shortcut menu option:

Comments 

Provides access to the following options:

View Comments. Opens the blog item and expands all comments.

Remove All Comments. Clears all comments from the blog.
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Reference: Options for Favorites

These files include the following right-click option:

Remove Favorite 

Removes the Favorite from the list.

Viewing Folder and Item Properties

Authorized users can select the Properties option to review information about a folder or item,
including when it was created, last modified, title, name, and settings that control the
Reporting Server and applications it will access. There are also settings that control the
functionality available to users when accessing the folder or running or scheduling an item.

The following image displays the Properties dialog box for an item. 
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The Main Properties tab includes the following settings:

Language. Provides a list of languages that you can select.

View All. Opens the Language Properties dialog box, where you can select a language.

Title. Displays a value in the Resources tree users can see which identifies the content
within the folder.

Folder/File Name. Displays a unique reference to the folder or item within the folder.
Select the Change Name check box to change the name of the folder or item.

Summary. Provides a detailed explanation with additional information about the folder or
item.

Parent Folder. Shows the previous folder in the folder path of the WebFOCUS repository.

Full Path. Displays full path of the folder or item in the WebFOCUS repository.

Created On. Identifies the date the folder or item was created.

Created By. Identifies the user who created the folder or item.

Last Modified On. Shows the date the folder or item was last modified.

Last Accessed On. Shows the date the folder or item was last opened.

Last Accessed By. Identifies the user who last opened the folder or item.

Properties. Shows a string of name value pairs that identify the properties of the folder or
item.

Size. Displays N/A bytes for folders. For items, displays the size in bytes.

Run. Displays N/A, as this property is not applicable to folders. For items, displays
Immediate.

Sort Order. Specifies the order to list the folder in the Resources tree or list items within a
folder.

Status. Indicates whether the folder or item is Published or Private. Private will also display
the owner information.

Authorized users can view or edit the access rules, effective policy, or sharing permissions by
clicking Security.
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The Details tab, shown in the following image, displays the components of the item in a tree
structure to allow a user to review the request information prior to running or opening the item
in a tool. The tree structure displays the request components, such as folders, Master Files,
Data Elements, Sorts, Conditions, Expressions, Output Formats, and Joins, which can be
opened to show the fields referenced.
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The Advanced tab, shown in the following image, allows you to set default height and width
values for the item, when it is displayed inside a portal at run time.

Navigating the Administration Console

The Administration Console contains four tabs and a menu bar that help you navigate to its
settings and other features. 

These tabs organize administration activities into the following categories:

Configuration. Configures Reporting Server connections, Application Settings, Custom
Settings, NLS Settings, the Dynamic Language Switch, Redirection Settings, and InfoAssist
+ Properties.

Security. Configures general security settings for Internal and External Authentication.

ReportCaster. Opens the ReportCaster Console where you can configure ReportCaster,
restart the Distribution Server, configure environment parameters, and turn traces on and
off. The Administration Console authenticates to ReportCaster with the value of the user ID,
IBIMR_RC_SVCUSER. If this authentication fails, users are prompted for their credentials.

Diagnostics. Displays component installation and configuration details, turns session
logging on or off, and enables Managers to view or delete log files.

You can view traces with the Session Viewer, which is accessible from the Tools option on
the Menu bar in the Portal.
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Options on the menu bar connect you to basic tasks, such as reviewing WebFOCUS BUE and
third party licensing information, clearing the cache, closing the Administration Console, or
opening the online Help.

To update or review an Administration Console setting, click a tab, and then click the folder or
page icon from the main menu on your selected tab. The main window refreshes and the
individual settings assigned to your selected page become available.

Navigating the Configuration Tab

The Configuration tab contains settings and features that describe Reporting Server
connections and other application settings, which are listed and described in the following
table.

Folder [Page] Available Functionality

Reporting Servers The Reporting Servers subfolders contain the tools that manage
all connections from the client to remote servers. Using the
following sub-folders, you can: 

Server Connections. Add and change Remote Services
settings. In the Business User Edition, this feature is limited
to the main reporting server, EDASERVE.

Alternate Server Mappings. Configure alternate mappings to
individual Remote Servers. This feature is not available in the
Business User Edition.

Configuration

[Application Settings]

Pages in the Application Settings folder of the Configuration tab
manage settings for the WebFOCUS BUE application. Pages in
this folder include settings for the following functional areas:

Change Management

Deferred Reporting

ESRI

Parameter Prompting

Text Generation Server
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Folder [Page] Available Functionality

Configuration

[Custom Settings]

The Custom Settings page of the Configuration tab contains a
text-based input field where you can define advanced
customization settings for the Client. Using this page, you can:

Customize Client settings.

Create a Client site profile.

Create a Client universal profile.

Configuration

[NLS Settings]

The NLS Settings page of the Configuration tab contains National
Language Support settings.

Configuration

[Dynamic Language
Switch]

The Dynamic Language Switch page of the Configuration tab
contains a list of languages that can be included in this feature.

In the Business User Edition, Dynamic Language Switch settings
are stored in the ibimultilanguage.js file located in the drive:/ibi/
WebFOCUS_BUE82/WebFOCUS/ibi_html/javaassist/intl directory.

Configuration

[Redirection Settings]

The Redirection Settings page of the Configuration tab contains
settings that manage the redirection of report output.

Configuration

[InfoAssist+
Properties]

The InfoAssist+ Properties page of the Configuration tab contains
properties that configure reporting options in the InfoAssist+
reporting tool.

Navigating the Security Tab

The Security tab contains internal and external security settings, which are listed and
described in the following table.

Folder [Page] Available Functionality

Security
Configuration

[Internal]

The Internal page of the Security tab contains login and password
settings for authentication and authorization managed within
WebFOCUS BUE.
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Folder [Page] Available Functionality

Security
Configuration

[External]

The External page of the Security tab contains settings that define
the method and location of authentication and authorization
activities managed by third-party applications outside of
WebFOCUS BUE.

Navigating the ReportCaster Tab

When you click the ReportCaster tab, the ReportCaster Server Status page opens, by default.
Features on that page identify the current status of ReportCaster Server operations. For more
information, see Using the ReportCaster Console on page 144. 

Navigating the Diagnostics Tab

The Diagnostics tab contains settings and features that describe system performance and
activities, which are listed and described in the following table.

Folder [Page] Available Functionality

Diagnostics The Diagnostics section of the Administration Console contains
the following functional areas:

About WebFOCUS. Displays version and release information
about your installation of WebFOCUS BUE.

Client Verification. Displays your directory permissions and
the status of your ability to perform common WebFOCUS and
WebFOCUS Client operations.

HTTP Request Info. Displays information about HTTP request
headers.

JVM Property Info. Displays information about your Java VM
environment.

Session Monitor. Displays session monitor events and links to
detailed traces.

Log Files. Displays links to WebFOCUS log files.
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Reviewing Version Information

The About WebFOCUS page displays information about the release you are using and the
optional components installed with it, as shown in the following image.

You can use the information on this page to identify your current product release and service
pack when corresponding with the Information Builders Customer Support team.

When you click About WebFOCUS, the following information appears in the main window:

Edition. Product edition, for example, WebFOCUS Business User Edition.

Product Release. Release number, for example, 8.2.

Service Pack. Service pack number, for example, 0.0.

Package Name. Installation file package name, for example, wb022316a.

Release ID. Product release number, for example, 8200.

Build/GEN Number. Specific product build number, for example, 15.

Build/GEN Date. Date and time the build number was generated, for example, February 23,
2016 10:28:10 PM EST.

Application Server. Application Server, for example, Apache Tomcat/8.0.21.

This version of the About WebFOCUS page, that opens from the Diagnostics tab, is only
available to those users whose privileges allow them to open and review the Administration
Console.

However, the information on this page is also available to those users whose privileges allow
them to view the About WebFOCUS Business Intelligence window. To open this other window,
in the BUE Portal, on the Menu bar, click Help, and then click About.
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Reviewing Client Verification

The Client Verification page displays the current status of client configuration and application
settings. When you open this page, the client automatically conducts the test required to verify
that configuration and application settings are open and available. 

Settings marked pass are available for use. Settings marked fail are not available for use.

The automated verification process includes checking web server aliases and directory
permissions for each type of client communication mode (CGI, WFServlet, or ISAPI).

The Client verification tools, by default, place the verification logs in the drive:\ibi
\WebFOCUS_BUE82\WebFOCUS\logs directory. These tools test read, write, and remove
permissions for the logs directory. They also test read and write permissions for the drive:\ibi
\WebFOCUS_BUE82\WebFOCUS\config directory.

To test a Reporting Server connection and the current status of the Graph or Table functionality
it can deliver, you must open the Configuration tab, and right-click the icon for the Reporting
Server you wish to test. All three tests are available on the shortcut menu assigned to each
server icon.

Procedure: How to Verify the WebFOCUS Client

From the Administration Console, click Diagnostics, and then click Client Verification.

The Client Verification page displays your directory permissions, such as creating and deleting
applications, signing in as the administrator, reading and writing from the standard directories,
creating and deleting domains, and creating and deleting reports.

Note: If you run this test immediately after performing the installation procedure, there might
be a delay resulting from a slow or delayed first time initialization of the Tomcat Web
Application that supports client operations.

HTTP Request Headers and JVM Property Information

The Diagnostics tab also contains information about HTTP request headers and your Java VM
environment. 

Settings on the HTTP Request Info page display information about the HTTP or HTTPS
headers returned to your browser. This is useful for troubleshooting and configuring HTTP
headers, especially if you integrate web or application server security with WebFOCUS BUE,
or if your web or application server uses virtual hosts (HTTP headers).
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Settings on the JVM Property Info page display information about your Java VM
environment. This is useful for troubleshooting and configuring the Java environment for
WebFOCUS BUE web applications and for resolving memory or resource issues. 

Navigating the InfoAssist+ Interface

InfoAssist+ provides an intelligent, flexible layout for creating reports, charts, visualizations,
and documents.

The application window provides intuitive menus and toolbars, a versatile ribbon that provides
access to specialized groups for different functional areas of report design, a taskbar for
selecting output, and a status bar for directing output.

The application window also provides a resources area for selecting and sorting data, and a
multi-faceted results area that can display report design, a preview of report output, or actual
report output.

InfoAssist+ Application Window

The components of the InfoAssist+ Application window are shown in the following image. 
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The main interface components are explained as follows:

1. Application button. Provides access to the Application menu of procedure-related
commands. 

2. Quick Access Toolbar. Displays frequently-used commands, such as New, Open, Save,
Undo, Redo, View code, Run, and Preview, in a toolbar that remains visible. For more
information, see Quick Access Toolbar on page 76. 

3. Ribbon. Displays the commands you need to create reports, charts, visualizations, and
documents. It also displays the Help menu. For details, see Ribbon on page 77. 

4. Help. Provides access to the online technical content for InfoAssist+ in a new browser
window. 

5. Resources panel. Displays the Data pane, Query pane, and Filter pane. 

6. Canvas. Displays the results of your report. In Live Preview mode, the canvas displays a
preview of the file as it is developed. 

Depending on the type of file that you are developing, the canvas may display differently.
For example, when creating a document, the canvas includes rulers around the
development area. This is to assist you in placing the components on to the document.

7. Navigation taskbar. Displays groups and icons that provide different views and quick
access to all active reports and report output. For details, see Using the Navigation Taskbar
on page 88. 

8. Status bar. Provides an output format button that you click to see the selected format and
an output target button that you click to view the selected option for displaying new output
windows or tabs. For more information, see Using the Status Bar on page 89. 

Application Main Menu

In the upper-left corner of the InfoAssist+ interface, click the IA button  to open the
Application main menu.

You can run the following commands from the Application main menu:

New. Opens the InfoAssist+ splash screen, where you can create a new report, chart,
visualization, or document. The exact functionality of the New command depends on your
current InfoAssist+ session.

When you open a new session of InfoAssist+ and then click New, a new report is created.
You are prompted to choose a data source.

Open. Opens an existing report, chart, visualization, or document.
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Save. Saves a report, chart, visualization, or document.

Save As. Saves a report, chart, visualization, or document with a new name.

Run. Runs a report, chart, visualization, or document.

Run Deferred. Submits a report, chart, or document for processing in the background while
you continue to work on other tasks.

Close. Closes the currently active report, chart, visualization, or document.

Recent Items. Displays recent reports, charts, visualizations, and documents and those
items that have been pinned to the menu. The Recent Items area of the InfoAssist+
Application main menu is shown in the following image.

Pinned reports, charts, visualizations, and documents are represented by a blue pin icon.
Pinned items appear at the top of the list in alphabetical order.

Recent reports, charts, visualizations, and documents are represented by a sideways blue

pin icon. Recent items appear below the separator bar in the order in which they were
created, with the most recently created item at the top.
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You can pin important reports, charts, visualizations, and documents to the top of the
Recent Reports section of the Application main menu for quick and easy access. To
promote a recent report to pinned report, click the sideways blue pin icon. The icon turns
upright and the report is moved to the pinned report area of the Recent Items window,
where it stays until it is unpinned.

To demote a pinned report, click the blue pin icon. The icon turns sideways and the report
is moved below the separator bar.

A shortcut menu is available when right-clicking a recent item, as shown in the following
image.

The options in the menu are:

Open. Opens the selected report, chart, visualization, or document.

Pin to list. Pins or unpins a recent report, chart, visualization, or document to the
pinned reports list above the separator bar.

Remove from list. Unpins a pinned report, chart, visualization, or document from the
pinned reports list.

Clear unpinned list. Clears all unpinned reports, charts, visualization, or documents
from the Recent Items list.
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Options. Opens the Options window to customize your user preferences.

Exit. Exits the application.

Reference: Open Dialog Box

The Open dialog box displays when you launch InfoAssist+. It also displays when you join and
blend data. You can use this dialog box to do the following:

Select data sources for creating reports, charts, visualizations, and documents.

Select data sources for joining and blending data.

Configure data adapters for connecting to an existing database and creating synonyms.

Upload user data.

The Open dialog box contains the following options:

Connect to Data 

Opens the Connect to Data wizard, where you can configure a Data Adapter to connect to
an existing database and create synonyms.

Upload Data 

Opens the Upload wizard, where you can upload user data from a machine to which you
have access. This data can be used with WebFOCUS reporting.

Open 

Opens the selected Master File.

Quick Access Toolbar

The Quick Access Toolbar provides access to the most commonly used functions. It is located
to the right of the Application main menu button and is always visible no matter which options
are selected. 

Undo and Redo. The Undo icon undoes your last action. The Redo icon repeats your last
action.

The Undo icon is enabled (blue) when there is an action to undo. Otherwise, the icon is
unavailable (gray). The Redo icon is enabled (blue) when there is an action to redo.
Otherwise, the icon is unavailable (gray).

For example, if you add a database field to a report, the Undo icon turns blue. You can now
click the Undo icon to remove the database field from the report. The Undo icon turns gray,
and the Redo icon turns blue. To restore the field to the report, click the blue Redo icon.
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You can also press Ctrl+Z to undo an action, or Ctrl+Y to redo an action.

You can undo and redo up to 25 actions per session. InfoAssist+ maintains the undo and
redo list of actions even when you switch between reports.

When a dialog box is open in the application window, you cannot use the Undo and Redo
icons. However, when you click OK and close the dialog box, the icons become available for
use. With a single click of Undo, you can undo all the actions that you performed in the
dialog box, and you can reinstate them with a single click of Redo.

View code. View the underlying code for the report.

Run. Click the Run button to run a report, chart, visualization, or document immediately.
Click the down arrow to open the Run menu, which contains the following additional
options:

Preview. Runs the report, chart, or document in the selected format with the limited
number of records as set in the Design group on the Home tab.

SQL Trace. Returns the SQL commands for the request.

SQL Preview Trace. Returns the SQL commands for the Live Preview run.

Ribbon

The ribbon is a rectangular area of distinct groups of buttons that spans the top of the
InfoAssist+ application window.

The ribbon is contextual and changes depending on the type of file that you are developing. For
example, in Chart mode, the ribbon is made up of nine tabs, whereas when working in
Visualization mode, the ribbon consists of five tabs. Each tab contains a subset of InfoAssist+
functionality organized in logically-related groups of controls and commands graphically
represented by distinctive icons.
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Working With the Ribbon

The ribbon contains two types of arrow-based buttons. The first type of button opens a menu
when you click it. The Orientation button is an example of this type of button. Clicking the
Orientation button opens a menu of options, as shown in the following image.

The second type of button is a split button. Clicking the left side of the split button performs a
default action. Clicking the down arrow, on the right side of the button, opens a menu of
options. The Header & Footer button is an example of a split button. It is shown in the
following image.

Clicking the Header & Footer button on the left opens the Header & Footer dialog box. Clicking
the down arrow on the right opens a menu of options.

Some options open dialog boxes of additional commands and option lists.

The ribbon displays all controls and commands using different sized icons and groups,
depending on the size of the monitor and application window.

When you reduce the size of the application window, some groups are collapsed into single
icons as determined by the amount of available space.

When a group is collapsed into a single icon, the individual icons are removed from view, but
are still available. Clicking a collapsed group icon restores the group to its normal full size and
displays all of the individual icons.

When expanding a collapsed group, the ribbon collapses a neighboring group to make enough
room to expand the selected group.
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When an icon, button, or option in a menu or dialog box appears dimmed, that functionality is
not available for that report as it currently exists. Some functionality is available for reports
only, charts only, visualizations only, or documents only.

In some situations, selecting one or more options makes other options incompatible with the
previously selected ones. As a result, the incompatible options are dimmed and unavailable for
selection. InfoAssist+ automatically makes incompatible options unavailable as you create and
modify a report.

Note: If you do not have access to a particular option, contact your administrator.

Home Tab

The Home tab contains the most commonly used commands and options, which you can use
when developing reports, charts, documents, or visualizations. The following list highlights the
features on the Home tab for each mode.

For reports, the Format, Design, Filter, and Report groups offer options for changing the
output format of your report, as well as styling it.

For charts, the Format Design, Filter, and Report groups enable you to change the theme or
your chart or add a header and footer.

For documents, options are enabled in the Format and Design groups only. Available
options for documents include changing the data source for the document and changing
the output format.

For visualizations, the Clipboard, Data, Visual, and Storyboard groups enable you to
perform some of the more basic functions, such as copy and paste. You also use the
Home tab to change your visual type.

Related Information for Reports, Charts, and Documents:

Using Filters to Customize the Display of Data on page 700

Related Information for Visualizations:

Building Visualizations on page 406

Using Storyboards on page 697

Joins on page 349

Insert Tab

The Insert tab contains options to add reports, charts, existing reports, text, images, and
active form controls (for active reports only) to a canvas in Document mode. 
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Note: The Insert tab is only available in Document mode.

Related Information for Documents:

Building a Document on page 392

Format Tab

The Format tab provides options for formatting your report, chart, document, or visualization.
Depending on the mode you are using, you can perform tasks such as selecting a chart type,
enabling Auto Linking, or adding navigational aspects to a report.

The following list highlights the features on the Format tab for each mode.

For reports, the Format tab provides access to the Destination, Navigation, Features, Auto
Drill, and Auto Linking groups. These options enable you to perform many functions related
to reports, including Auto Drill or any other report navigation feature.

For charts, the Format tab provides access to the Destination, Chart Types, Features,
Labels, Interactive, Auto Drill, and Auto Linking groups. These options enable you to
perform a variety of charting tasks, including changing the chart type and adding interactive
options.

For documents, the Format tab enables you to change to Report or Chart mode. You can
also access InfoMini.

For visualizations, the Format tab provides access to the Report, Features, Label, and
Interactive groups. These options enable you to format your visualization. Also included are
grid commands, as well as various features and label commands.

Related Information for Reports, Charts, and Documents:

Customizing Reports on page 607

Formatting a Series on page 627

Formatting Data Labels on page 642

Formatting a Legend on page 648

How to Style and Customize a Report on page 401

How to Style and Customize a Chart on page 401

Using Auto Drill on page 703

Using the Auto Linking Feature to Link Content on page 705
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Related Information for Visualizations:

Building Visualizations on page 406

Customizing Charts and Visualizations on page 625

Data Tab

The Data tab contains data manipulation and data display options. For example, you can
access Join functionality and work with Defines and Computes. The Data tab is available in the
Report, Chart, and Document mode. It is not available in Visualization mode.

The following list highlights the features on the Data tab for each available mode.

For reports, the Data tab provides access to the Calculation, Join, Filter, Display, and Data
Source groups. When working with reports, you can join data sources or create Defines and
Computes. You can also filter data.

For charts, the Data tab provides access to the Calculation, Join, Filter, Display, and Data
Source groups. When working with charts, these options enable you to join data sources,
create a Define or Compute, and filter data.

For documents, the Data tab provides access to the Calculation, Join, Filter, Display, and
Data Source groups. When working with a document, you can create a define or join data
sources. You can also add or switch data sources. 

Related Information for Reports, Charts, and Documents:

Joins on page 349

Using Filters to Customize the Display of Data on page 700

Slicers Tab

The Slicers tab provides the ability to create and edit slicers. Slicers are dynamic filters that
you can use with reports, charts, and documents.

Note: The Slicers tab is unavailable in Visualization mode.

The features on the Slicers tab are the same for reports, charts, and documents. You can
perform the following functions with the slicer functionality:

Add slicers to your report, chart, or document to create dynamic filters

Set a record limit for the display of your data
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Create groups of slicers to filter your data

Add fields to existing slicers

Clear slicers to clear all selected values from existing slicers

Related Information for Reports, Charts, and Documents:

Working With Slicers on page 725

Note: The slicer capabilities are only available in the full version of InfoAssist+.

Layout Tab

The Layout tab provides access to page display and layout options. These include page
orientation and AutoFit, which is a feature that limits the width of columns in a report to be no
wider than the largest value in each column.

The Layout tab is available in Report, Chart, and Document mode.

Note: The Layout tab is unavailable in Visualization mode.

The following list highlights the features on the Layout tab for each available mode.

For reports, the Layout tab provides access to the Page Setup and Report groups. These
options allow you to change the size or orientation of your report. You can also add page
numbers.

For charts, the Layout tab provides access to the Page Setup and Size & Arrange groups.
These options allow you to change the orientation or size of your chart. You can also set a
height and width for your chart, and enable the AutoFit functionality.

For documents, Layout tab provides access to the Page Setup and Size & Arrange groups.
You can change the size of your document and adjust its orientation. You can also lock the
height and width aspect ratio of your document.

Related Information for Reports, Charts, and Documents:

Customizing Reports on page 607

View Tab

The View tab provides access to reporting options, including design and display options. Some
of the options on the View tab control how information is displayed, whether it be in structured
view or list view. The View tab is available in all modes of InfoAssist+.
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The following list highlights the features on the View tab for each mode.

For reports, the View tab provides access to the Design, Show/Hide, Data Panel, Query
panel, Output Window and Report groups. When creating your report, you can change the
way your data displays or switch to another mode, such as document.

For charts, the View tab provides access to the Design, Show/Hide, Data Panel, Query
panel, Output Window and Report groups. When creating your chart, you can change the
output location for the chart or switch to another report or chart.

For documents, the View tab provides access to the Design, Show/Hide, Data Panel, Query
panel, Output Window and Report groups. When working with your document, you may want
to change the display of data in the Data pane or Query pane.

For visualizations, the View tab provides access to the Show/Hide and Data Panel groups.
When creating your visualization, you can use these options to show or hide the resources
panel. You can also change the display of your data to either logical, list or structured.

Related Information for Reports, Charts, and Documents:

Using the Query Pane and Filter Pane on the Canvas on page 85

Field Tab

The Field tab is enabled in the ribbon when you select a data source field. The options
available in the Field tab are specific to the data type that is selected. The options available for
numeric fields are different from the options available for non-numeric and date fields. The
Field tab provides access to the Filter, Sort, Break, Style, Format, Display, and Links groups.

The following list highlights the features on the Field tab for each mode.

For reports, the Field tab provides options for filtering and styling your report. It also
provides you with access to the Traffic Lights and Within functionality, making your reports
more robust and customized.

For charts, the Field tab enables you to hide a particular field or group values in your chart.
You can also use the filter options to limit the display of information in your chart.

For documents, the Field tab provides options for filtering, as well as Traffic Light
functionality. You can also hide fields and add aggregations.

For visualizations, the View tab provides access to the Show/Hide and Data Panel groups.
When creating your visualization, you can use these options to show or hide the resources
panel. You can also change the display of your data to either logical, list or structured.
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Related Information for Reports, Charts, and Documents:

How to Apply Traffic Light Conditional Styling to a Report (By Constant) on page 616

How to Apply Traffic Light Conditional Styling to a Report (By Field) on page 617

Changing a Field Format on page 728

Series Tab

The Series tab provides access to chart options through the Select, Style, Properties, Line, and
Pie groups. The Series tab is available in Document, Chart, and Visualization mode. It is not
available in Report mode.

The following list highlights the features on the Series tab for each available mode.

For charts, the Series tab enables you to add such features as a trendline or data labels to
your chart. If multiple series are specified, you can select a series and specify options
specific to that series.

For documents, the Series tab displays once you have specified fields within your document
or embedded chart. You can use the options on the Series tab to add markers,
smoothlines, or trendlines to your data.

For visualizations, the Series tab enables you to switch between series, style the selected
series, or add any other property or line features, as required.

Related Information for Reports, Charts, and Documents:

Formatting a Series on page 627

Formatting Data Labels on page 642

Related Information for Visualizations:

Formatting Axis Labels on page 663

Understanding the Canvas

The canvas displays a preview of the report being created or modified on the canvas when you
are in the default Live Preview. To select Live Preview, go to Home tab, and in the Design
group, click Live Preview, or on the View tab, in the Design group, click Live Preview. The
canvas is always fully maximized and cannot be minimized, cascaded, or tiled. However, a
blank canvas opens when there is no report.
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The canvas displays either live data or sample data.

To display live data, on the Home tab, in the Design group, click Data from Source (default).

When you select Data from Source, a live preview of the report being built is refreshed on
the canvas as you add, remove, and style data source fields in the report.

To display sample data, on the Home tab, in the Design group, click Use Sample Data.

When you select Use Sample Data, the canvas displays sample data based on the field
type, with the same formatting and styling used to display live data.

When you execute a report, the canvas displays the Output window. If the Output is minimized,
or if there is no report to preview, the canvas is blank. To change the canvas view, you can
select Query Design view or Live Preview from the Design group of the View tab or Home tab.

When working with a report in Live Preview, you can rearrange the columns of the report by
dragging them to the left or right, depending on your display preference. If the column is
numeric, you are presented with the option to Drop as Sum or Drop as Sort.

Note: If you select Drop as Sort, the values are listed individually and they are sorted. If you
select Drop as Sum, the values are summed for that particular row. The default is Drop as
Sum.

When placing the column in a new location, a red indicator bar displays, indicating the location
of placement for the moved column. This allows you to see where the column will be placed
before you actually perform the operation.

Note: Column sort order can also be rearranged by dragging the fields in the Query field
containers of the Query pane to reorder them.

If you create a filter, then the filter appears in the Filter pane.

Using the Query Pane and Filter Pane on the Canvas

If you click Query on the Home tab, in the Design group, the Query and Filter panes expand in
to the canvas.

This provides a larger area for displaying the Query and Filter panes. This feature is useful
when you are designing a report with multiple filters or numerous fields.

Depending on whether you are creating a report or a chart, the Query pane displays selected
data source fields using different types of Query field containers.

Related Information:

Using Filters to Customize the Display of Data on page 700
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Using Field Containers on page 96

Understanding Output Options

When you run a report, the output appears, either in a tab on the canvas, or in a new browser
window. You can create and display output in several different ways, depending on the
following options. You can select these options on the View tab, in the Output Window group:

Cascade

Tile Horizontally

Tile Vertically

Single Tab

New Tab

Single Window

New Window

Switch

Output window and tab options are also available in the status bar, and output window display
options are also available in the Navigation taskbar.

Note: When you run a report, tab focus is not on the output window and pressing the Tab key
does not move the selection. To move the Tab focus out of the output window, press F6.

Reference: Output Target Options

The following are output target options that you can select.

Single Tab. When you click Single Tab and run a report, a new output window is created on
the canvas, a report instance is created, and an output tab is placed on the Navigation
taskbar. As you modify a report, the same output window is refreshed each time the report
is run. This option, which is the default, is ideal when you are working with just one report.

New Tab. When you click New Tab, each time you run a report, a new output window is
created on the canvas. A new report instance is also created and preserved by the addition
of a new output tab on the Navigation taskbar. Each output tab maintains the output of the
report that generated the corresponding output window. Selecting an output tab on the
Navigation taskbar loads the associated output instance into the output window.
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Single Window. When you click Single Window and run a report, a new browser window is
opened and populated with the report output. As you modify the report, the same browser
window is refreshed each time the report is run. If the browser window is closed and the
report is run, a new browser window is opened again and is refreshed for each subsequent
run. The output is not displayed on the canvas, and an output tab is not added to the
Navigation taskbar.

New Window. When you click New Window, each time you run a report, a new browser
window is opened and populated with the report output. The output is not displayed on the
canvas, and an output tab is not added to the Navigation Taskbar.

Reference: Output View Options

The following are output view options (Arrange) that you can select.

Cascade. When you click Cascade, if multiple output windows exist, they are cascaded
diagonally across the canvas. This option does not affect open browser windows when you
select New Window or Single Window.

Tile Horizontally. When you click Tile Horizontally, if multiple output windows exist, they are
tiled horizontally, one above another, across the canvas. This option does not affect open
browser windows when you select New Window or Single Window.

Tile Vertically. When you click Tile Vertically, if multiple output windows exist, they are tiled
vertically, side by side, across the canvas. This option does not affect open browser
windows when you select New Window or Single Window.

Switch Output. When you click Switch Output, a drop-down menu opens, where you can
select any active report to view the output. The selected report is loaded into the output
window or browser window, depending on the selected output window or tab option.

Reference: Output Format Options

The Output window can display report output in the following formats: HTML, HTML5, active
report, and PDF.

Note: Excel and PowerPoint formats open in their native programs in a window external to
InfoAssist+.
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Using the Navigation Taskbar

The Navigation taskbar provides quick access to all active output windows and to the report
design that generated the output. You can return to the last report that you edited in the Query
pane by clicking Display Design View on the taskbar. The Navigation taskbar is always visible. It
is located near the bottom of the application window, just above the status bar.

Each of the active output windows displays a tab on the Navigation taskbar. Selecting the tab
displays that output window on the canvas. If you save a report with a unique name each time
you modify it, when the report is executed and a new output window is generated, the unique
name appears as a tab on the taskbar. If you continue to modify and execute a report without
saving it with a unique name, a number in parentheses is appended to the original, saved
report name to differentiate it among the multiple output windows.

The ability to select report output from the Navigation taskbar depends on the output window
option selected from the status bar or from the Output Window group of the View tab. For more
information, see Using the Status Bar on page 89, or Understanding Output Options on page
86.

Each report tab on the Navigation taskbar has a shortcut menu with the following options:

Restore

Minimize

Maximize

Close

Auto Resize

Restore, Minimize, Maximize, and Close are standard options available in any browser window
or software application. Minimize, Maximize (if the window is not maximized), or Restore (if the
window is maximized), and Close can also be found in the top-right corner of the output
window.

The Auto Resize option enables automatic resizing of an output window as needed when you
add or remove fields.

The Window Options menu at the far left of the Navigation taskbar provides options for
displaying all active output windows on the canvas. The display options that you can select are
Cascade, Tile Horizontally, Tile Vertically, Restore All, Minimize All, Maximize All, or Close All.
The name of each active output window appears at the bottom of the menu.

The Window Options menu options are directly linked to the options available in the Output
Window group of the View tab.
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Using the Status Bar

The status bar displays the status of the last selected action, a reports button that shows the
number of open reports, an output format button that shows the selected format, as well as a
list of the available formats, and an output target button that shows the selected option for
displaying new output windows or tabs. 

When you click the reports button, a menu opens, with options for selecting any of the open
reports. Each report is listed by name and an icon which represents the report type (report,
chart, visualization, document). The report you select becomes active.

When you click the output format button, a menu opens, with options for selecting a different
output format. For a complete list of options, see Understanding Output Options on page 86.

When you click the output target button, a menu opens, with options for Single Tab (default),
New Tab, Single Window, and New Window. For more information, see Understanding Output
Options on page 86.

Understanding the Resources Panel

The Resources panel is comprised of the Data pane, the Filter pane, and the Query pane. It is
located on the left side of the InfoAssist+ interface and is visible by default. You can
customize how the Resources panel displays by using the options on the Home tab and View
tab. For example, on the View tab, in the Design group, click Query to display only the Query
and Filter panes. 

The Data pane, which contains all the fields from the selected data sources, is always
displayed.

You can manually adjust the size of the Resources panel. To do so, move the mouse pointer
over the border. When the pointer changes to a two-way arrow, drag the border.

Reference: Field Image List

In the Resources panel, each field has an image associated with it. The following table
displays each image and describes what it represents. 

Icon Type

Blob

Calculated Date Field
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Icon Type

Calculated Numeric Field

Calculated Other Field

Calculated Text Field

Cube Property

Date or Date and Time Field

Dimension Field (Standalone or Drillable)

Dimension Field (Drillable, Second-level)

Dimension Field (Drillable, Third-level)

Note: There are 17 dimension field levels. Level 0 is
specific to certain databases.

Geographic Role Dimension Field (Standalone or
Drillable)

Geographic Role Dimension Field (Drillable, Second-level)

Geographic Role Dimension Field (Drillable, Third-level)

Note: There are 17 geographic role dimension field
levels. Level 0 is specific to certain databases.

Funnel (filter)

Geolocation

Index Field

Key Field
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Icon Type

Measure

Numeric Field

Text or Alpha Field

Note: This list of icons changes based on the type of database that is in use.

Reference: Filter Pane

The Filter pane displays all filters that have been created for the selected report. 

For more information on filtering, see Field Tab on page 83 and Data Tab on page 81.

Note: The Filter pane displays all created filters, both active (included) and inactive (excluded).

Using the Data Pane

The Data pane contains the data fields that are used to construct reports, charts, or
visualizations. The default structure of data in the Data pane displays your data by field type,
for example, measure field or dimension field. You can explore this structure using the sample
retail database that is included with InfoAssist+. The structure of this sample database, which
is a cube database, includes measure groups, measure fields, dimension hierarchies,
dimension fields, and attributes.

The data fields that display in the Data pane may vary. Depending on the underlying structure
of your metadata, these fields may be organized and presented differently. For example, you
may have just measures and dimensions, or you may have fields that represent multiple drill
levels. You can also have any combination of these field types.

The structure of your metadata dictates the order of the fields, as well as the hierarchy that
they employ. InfoAssist+ displays this hierarchy based on the structure defined for the master
file that you choose. For more information on the specific field types, see Field Image List on
page 89.

If you are using a Business View Plus (BV+) data source, which is built based on a pre-
determined targeted hierarchy or structure, the view of your Data pane will be set to
Structured, by default. When using a BV+ data source, Logical view is disabled. These options
are available on the View tab, in the Data Panel group.
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Note: When you open a BV+ data source, you will have access to common components, such
as measures, dimensions, and filters, but values are not supported.

The fields in the database structure are displayed in Logical view, by default. You can use the
commands in the View tab to change how your data fields are organized in the Data pane.
These commands display the data fields in a Logical, List, or Structured view. All three views
provide options for displaying each data source field as a Title, Description, Field, or Alias. The
List view also includes options to show the Alias, Format, and Reference of each field. 

Field list search functionality is also available in the Data pane, which you can use to search
for specific fields within a tree or list. When conducting a search in the Tree view, the search
functionality searches only the attribute that is displayed.

When searching in List view, all attributes are searched at once.

Note: There are additional options on which you can search, including Name, Title, Alias,
Format, Segment, Filename, Description, and Reference.

As you enter search criteria, InfoAssist+ begins the search process. When you enter just a few
letters, the list of records that is returned is typically long. As your search criteria gets more
specific, the list of returned fields narrows.

If you are conducting a search that you wish to cancel, click the X icon in the field list search
tool to abort the search.

Note: The X icon displays only when you have search criteria specified in the Search fields box.
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The following is an example of the default Logical view, displaying the Title of each field. 

Using the Data Pane to Add Fields to a Report

There are several ways that you can add data source fields to a report. You can drag, double-
click, or right-click data source fields in the Data pane to add them to a Query field container or
the Filter pane.

After you add data source fields to a Query field container, you can change the order of the
fields by dragging and dropping one field above or below another field.

Drag. This method provides the most control. You can drag data source fields from the Data
pane to the appropriate Query field container or Filter pane.

For a larger work area in which to drop data source fields in the appropriate Query field
container, make sure that Query Design view is selected, and then, on the View tab, in the
Query Panel group, click Areas 2x2 or Areas 1x4.
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You can select Query Design view on the Home tab, in the Design group, by clicking Query or
on the View tab, in the Design group by clicking Query. That selection expands the Query and
Filter panes.

Multi-Select. You can multi-select data source fields that you want to add to a report in Live
Preview, Query Design view, and Document mode. To select multiple data source fields to add
to a report, click the appropriate fields while holding the Ctrl key on the keyboard. You can drag
fields onto the canvas, or add them to the Query field container.

Double-Click. To automatically add a field to the appropriate Query field container in the Query
pane, you can double-click a data source field in the Data pane.

When you double-click a measure field in the Data pane, it is automatically added to the
Sum Query field container.

When you double-click a dimension field in the Data pane, it is added to the By (Row Label)
Query field container for a report, or to the X-axis Query field container for a chart.

You cannot automatically add a field to the Across (Column Label) Query field container for a
report, or to the Legend (Series) and Multi-graph Query field containers for a chart.

Right-Click. You can right-click a field in the Data pane to add it to the Filter area or a Query
field container in the Query pane. For reports, the available shortcut menu options are as
follows:

Across. For dimension fields.

Add to Query. Opens a menu of available Query field containers, to which you can add your
data.

Create Group. Allows you to create a group of elements based on the field data type that
you select.

Include as Category Axis. For dimension fields.

Include as Coordinated. Only available in Document mode.

Include as Legends Series. For dimension fields.

Filter. For all types of fields.

Slicers. For all types of fields.

Sort. Adds the field to the Sort field container. This is for all types of fields.

Sum. For measure fields.
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A measure is a numeric value, such as Gross Profit or Cost of Goods Sold, that you may want
to aggregate. All numeric values that can be summed are measures. Numeric fields that
cannot be summed, such as product number and miles per gallon, are not treated as
measures. Instead, they may be used in the same way as dimension fields to analyze
measures. It is up to you to understand your data and determine whether each numeric field
can be summed. Related measures can be organized into measure groups. For example,
Gross Profit and Cost of Goods Sold can be part of a Sales measure group.

A dimension is a way to categorize data. You can use a dimension to analyze and compare
measures. Generally, any field that is not a measure, usually an alphanumeric field such as
product, is a dimension. Dimensions can be organized into hierarchies to define the
relationships between the fields in the hierarchies. For example, a Geography hierarchy can
contain the Continent, Country, State, and City dimensions. You can also define dimension
fields that are not part of a dimension hierarchy.

Using the Query Pane and Filter Pane

The Query and Filter panes appear below the Data pane, except when you select Query Design
view, which expands the size of the Query and Filter panes. There are different Query field
containers for reports and charts.

Note: If you have more than one item in either Sum, By, or Across Query field containers (for
reports) or Measure (Sum) or X-axis Query field containers (for charts), you can drag them up or
down in the Query pane to rearrange the order in which they display in your report or chart.
When you drag fields to rearrange them, an indicator line displays, providing guidance as to
where the field will be placed. The color of this line is determined by the theme. Once you have
performed the rearrangement, the Live Preview refreshes based on the newly indicated order.

Reports. For all reports, the Query field containers in the Query pane include Sum, By, and
Across.

Use the Sum  field container to aggregate or display numeric measure fields. Its context
menu provides options to Sum (default), Print, Count, or List the fields in the report.

Use the By Query field container to vertically sort dimension fields to produce row labels in
the report output. Dimension fields are normally non-numeric or date fields.

Use the Across Query field container to horizontally sort dimension fields to produce
column labels in the report output.
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Using Field Containers

Field containers are used to hold fields that you select based on the function that you want it
to perform. For example, in Chart and Visualization mode, you can add a field to the Color field
container, which will color your data based on the selected field.

For reports, the available field containers are different than those presented for charts and
visualizations. This section reviews all of the field containers, providing you with a reference
point when working with field containers.

Field Containers for Reports

The following field containers display when creating reports.

Across 

Enables you to display column headings across the top of the report for the measure or
dimension that is placed in this field container.

By 

Enables you to specify sort fields for your report.

Note: You can rearrange the display order of your By sorts by dragging them into the
desired order in the Query pane.

Sum 

Displays numeric totals for numeric (measure) fields that are added to this field container.

Field Containers for Charts and Visualizations

The following field containers display when creating charts and visualizations.

Animate 

Enables you to animate time progression using a slider control. As you move the control
along the slider bar, an animation effect results. The slider control has a Play button that
allows you to play and pause the animation. When you click Play, the Pause option is
activated, enabling you to pause the progression and analyze your data. Slider controls are
limited to one sort field and should be time or sequence related, such as month or year.
This field container displays for many different chart types.

By 

Use this field container to differentiate data types in a field that contains multiple
categorical values. For example, when creating a gauge chart, the field that you specify in
this field container becomes a By field, by which all values are displayed as a separate
chart.
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Category 

Enables you to display data categorically in a chart. This field container displays for Tag
Cloud charts, which are available in the Other charts category.

Category Axis 

Use this field container to specify a field that contains categorical data. These categories
display on the categorical portion of a 3D bar chart. The other axis, Series Axis, is plotted
against the categorical data.

Close 

Enables you to specify a numeric field to indicate the closing value of a stock. Other
required values include: Open, High, and Low. This field container displays for Stock
charts, which are available in the Other charts category.

Color 

Enables the application of different colors based on the underlying data set for the field in
this field container. When you place a numeric field in the Color field container, the legend
displays as a heat scale. When you place an alphanumeric or a date field (non-measure) in
the Color field container, the legend displays as colored markers. To change how the
legend displays, right-click the Color field container and click Color BY.

Columns 

Enables you to specify a field to display column data in a matrix chart in a visual. The use
of measure fields is supported. Column data is displayed at the top of the visual, along the
X axis. This field container is available for charts and visualizations.

Detail 

Use this field container to add detail to your visual by adding a data field to it. For
example, if you add Sale,Quarter to the Detail field container in your Scatter plot, the
points on the plot are quadrupled, one for each quarter. In addition, the field that you
specify in the Detail field container also displays on the hover menu for each point in the
plot.

Grouping 

Enables you to specify a field by which to present your data in categories or groups. For
example, this data field controls how a treemap is grouped.

High 

Enables you to specify a numeric field to indicate the high value of a stock. Other required
values include: Open, Low, and Close. This field container displays for Stock charts, which
are available in the Other charts category.
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Horizontal Axis 

Displays the data for the selected along the X axis. This field container is available for
charts and visualizations.

Note: You can specify up to three fields on the horizontal axis.

Layer 

Enables you to specify a Geolocation field for use in a map.

Note: Geolocation fields are listed in the Data pane with a Geolocation icon .

Legend (Series) 

Enables you to add a field to specify for the legend of the chart. This field container
displays for a number of charts that are available in the Other chart category.

Low 

Enables you to specify a numeric field to indicate the low value of a stock. Other required
values include: Open, High, and Close. This field container displays for Stock charts, which
are available in the Other charts category.

Lower Limit 

Enables you to specify a numeric (measure) field by which to establish a lower limit. This
field container displays for Vertical Box Plot charts, which are available in the Other chart
category.

Lower quartile 

Enables you to specify a numeric (measure) field by which to establish a lower quartile.
This field container displays for Vertical Box Plot charts, which are available in the Other
chart category.

Measure 

Use this field container to specify a measure that will serve as the basis for a pie chart.
The Measure metric is used with the Color field container for pie charts to create sections
based on your field selections. It is also used with Gauge charts.

Measure (Sum) 

Enables you to specify a numeric (measure field) by which to sum data. This field container
displays for a number of charts that are available in the Other chart category.
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Median 

Enables you to specify a numeric (measure) field by which to establish an median. This
field container displays for Vertical Box Plot charts, which are available in the Other chart
category.

Multi-graph 

Enables the creation of multiple graphs based on the field that you place in this field
container. This field container displays for many different chart types, including Spectral
Heatmaps, which are available from the Other dialog box.

Open 

Enables you to specify a numeric field to indicate the opening value of a stock. Other
required values include: High, Low, and Close. This field container displays for Stock
charts, which are available in the Other charts category.

Rows 

Enables you to specify a field to display row data in a matrix chart in a visual. The use of
measure fields is supported. Row data is displayed on the left side of the visual, along the
Y axis. This field container is available for charts and visualizations.

Series Axis 

Use this field container to specify a series to plot against the data presented on the
Categorical Axis. This field container displays for 3D bar charts.

Size 

Controls the size of markers or other data points.

Size (Sum) 

Enables you to specify a numeric (measure) field, which will control the size of the data
presented in a chart. This field container displays for Tag Cloud charts, which are available
in the Other charts category.

Slices 

Enables you to specify a field whose data values will dictate the size of the slices in a
chart. This field container is available for Funnel charts, which are available in the Other
chart category.

Tooltip 

When you place a field in this field container, InfoAssist+ enables you to view additional
information in the tooltip for a chart or visual.
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Upper limit 

Enables you to specify a numeric (measure) field by which to establish an upper limit. This
field container displays for Vertical Box Plot charts, which are available in the Other chart
category.

Upper quartile 

Enables you to specify a numeric (measure) field by which to establish an upper quartile.
This field container displays for Vertical Box Plot charts, which are available in the Other
chart category.

Vertical Axis 

Displays the data for the selected field along the Y axis. This field container is available for
charts and visualizations.

X Axis 

Enables the specification of a field on the X Axis of certain chart types. For example, XY
Polar. This field container displays for a number of charts that are available in the Other
chart category.

Y1 Measure (Sum) 

Enables you to specify a measure (numeric) field for the Y Axis in a Pareto and certain line
charts, which can be accessed from the Other chart category.

Y2 Measure 

Use this field container to indicate a measure to serve as the basis for second Y axis. This
field is used in various line charts, which can be accessed from the Other chart category.

Using Shortcut Menu Options in the Query Pane

In the Query pane, you can right-click any field and select from a list of available options that
are displayed in the menu that appears. The options that you can select vary, depending on
the type of Query field container in which the field is located and the type of report that you are
creating.

You can also rename the content type in the Query pane. You can right-click the component
and click Rename to change the title.

This allows you to customize the title in the Query pane. In addition, when working in Excel
format, the name that you provide is used as the worksheet name in the workbook that is
generated at run-time.

Note: If you are working with a report or chart in HTML format, you can also access Sum, Print,
List, and Count aggregations from the shortcut menu on the report or chart component.
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Related Information:

Using Field Containers on page 96

Right-Click Field Options in the Query and Filter Panes on page 101

Reference: Right-Click Field Options in the Query and Filter Panes

The following table lists and describes all the right-click field options available in the Query and
Filter panes for a selected field.

Option Description

# of Columns Opens the Number of Columns dialog box, where you can indicate
the number of columns in which you wish to display multiple
graphs.

Aggregation Functions Provides a menu for selecting options to assign an aggregation
type value to a selected numeric field in a report.

Break Provides a menu of options to enable page breaks and subtotals,
and resetting page numbers.

Create Group Allows you to create a group of elements based on the field data
type that you select. Once you define a new group, a higher-level
field is created that contains the selected elements.

For more information, see How to Create a Dynamic Group on
page 103.

Change Title Opens the Edit Title dialog box, where you can change the title of
the selected field by typing the new title in the Enter Title field.

Note: When changing the title of a column heading, you can place
a comma between words in the Enter Title field to create a multi-
line header.

Data Bars Provides a menu for enabling the data bar representation
functionality. Selecting On adds a data visualization column to the
right of a selected numeric field. The column displays values in
each row using horizontal bars that extend from left to right in
varying lengths, depending on the corresponding data values.
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Option Description

Delete Deletes the selected field.

Note: In the Query and Filter panes, you can select and delete
multiple data fields at one time. Using the CTRL key, select two or
more data fields, right-mouse click, and then click Delete.

Drill Down Opens the Drill Down dialog box, where you can create multiple
drilldown links on a data field to external procedures or websites.

Edit Format Opens the Field Format Options dialog box, where you can edit
the field type and display options.

Filter Values Opens the Filter dialog box for creating WHERE statements, which
enable you to select only the data that you want and to exclude
all unwanted data.

Missing Allows you to show or hide fields with no value.

Sort Provides access to the Sort, Rank, and Limit menus. The Sort
menu allows you to sort your data either in ascending or
descending order. The Limit menu allows you to specify the
number of unique values displayed for a sort group that has been
added. The Rank menu allows you to insert a rank column
immediately to the left if a Sort By field is selected and adds a
rank column to the left of the Sort By field if a Measure field is
selected. Ranking a Measure field results in two copies of the
field, the original Measure field and the Sort By field that is
created during ranking.

Sub Footer Opens the Sub Header & Sub Footer dialog box where you can
edit and style your footers.

Sub Header Opens the Sub Header & Sub Footer dialog box where you can
edit and style your headers.

Traffic Light Conditions Opens the Traffic Light Condition dialog box, where you can add
new conditional styling or modify existing conditional styling by
applying traffic light (and other) colors to a selected field in the
report output when the field meets specified criteria.
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Option Description

Visibility Provides a menu for controlling the visibility of the selected field.
Clicking Hide removes the selected field from the report output.
Clicking Show (default) displays the selected field in the report
output.

All of the shortcut menu options that are available in the Query and Filter panes are also
available in the Field tab. For more information, see Field Tab on page 83.

Dynamic Grouping

Dynamic grouping allows you to create groups of elements based on the field data type that
you select. For example, in the wf_retail_lite database, there are a number of brands of
televisions. Using the dynamic grouping functionality, you can create groups based on the
popularity of a particular brand. The first group might include top sellers such as LG and Sony.
The second group might contain the remaining brands (Panasonic, GPX, Supersonic, Tivax, and
Audiovox). This would allow you to group top sellers into one group, and the remaining brands
into another group.

Note: The Create Group option is only available for dimension fields of non-numeric format or
attribute.

You can also specify multiple, unique groupings in the same session. For example, you might
want to group the data to indicate groups or products, or specific regions.

Note: If you want to exclude a specific data element from your analysis, you can use the filter
functionality.

The grouping that you specify is applied and this new group then replaces the original field that
you selected in the Query pane. The name that you specify when creating the group is reflected
in the Query pane.

Note: You can edit the group once it has been created by right-clicking on the higher-level field
and clicking Edit Group.

Procedure: How to Create a Dynamic Group

1. From the Data pane, add one or more data fields to your report or chart.

Note: You can use the dynamic grouping functionality on non-numeric dimension fields
only.

2. In the Query pane, right-click the data field for which you want to apply dynamic grouping.

Note: The Create Group option is also available in the Data pane shortcut menu.
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3. Click Create Group.

The Create a Group dialog box displays.

4. In the Field text box, optionally type a name for the new group.

Note: The fully qualified field name is displayed in the Field Origin text field. This field is
enabled and has a read-only attribute. The display of the fully qualified field name is
particularly useful when renaming or editing a group, as it identifies the data source
followed by the hierarchical location of the field within a data set. For example,
WF_RETAIL_LITE.WF_RETAIL_PRODUCT.BRAND.

5. Select the data values that you want to group. Use CTRL + click to select more than one
value, as shown in the following image.

6. Click Group.

Note: To ungroup values, click a group and then click Ungroup.

Navigating the Environment

104  Information Builders



7. Optionally, create additional groups, as shown in the following image.

8. Click OK.

Your grouped data will display in the Data pane when your report, chart, or visualization
refreshes, as shown in the following image.
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Chapter2
Setting Up Your Environment

Configure and customize your environment, create users and groups, and manage your
resources using the available functionalities.

In this chapter:

Using the Administration Console

Changing Application Settings

Changing Client Settings

Using the ReportCaster Console

Working With Domains

Working With Folders

Managing Users

Managing Groups

Managing Private Resources

Authenticating Users to Your Active
Directory

Configuring WebFOCUS BUE for SSL

Creating a Change Management Package

Changing InfoAssist+ User Preferences

Configuring Hyperstage

Distributing the Quick Data Add-In File

Managing the Server or Global Profile

Using the Administration Console

The Administration Console contains the settings that configure the WebFOCUS Client,
customize internal or external authentication settings, connect you to ReportCaster, and
support diagnostic research.

Opening the Administration Console

Because the Administration Console contains settings that can alter the operation of your
entire WebFOCUS installation, it is available only to those users with the privileges to update
or reconfigure system settings. In the Business User Edition, the Administration Console is
available only to the Manager User.

Before you can open the Administration Console, you must sign in with a User ID that has the
privilege to do so. Once you have signed in with the appropriate privileges, the Administration
Console is visible and available for review and updates. You can then open the Administration
Console from the Menu bar, or from a link on the Getting Started page.
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You can also open the Administration Console directly from the address bar of your browser
window by entering the URL of the Administration Console and then signing in with a User ID
that has the appropriate privileges.

Procedure: How to Sign In to the Administration Console From the Start Menu

1. If WebFOCUS Business User Edition has been installed on a Windows machine, click the
Start button, and then click the Information Builders folder.

2. Click the WebFOCUS Business User Edition 82 folder, and then click Run WebFOCUS
Business User Edition.

3. In the Sign In page, type the ID and Password of a User that has privileges to open the
Administration Console, and then click Sign In.

4. To open the Administration Console from the Menu bar, click Administration, and then click
Administration Console.

5. To open the Administration Console from the Quick Links Page, in the Manage section,
click Configure System.

Procedure: How to Sign in to the Administration Console From a Browser Window

1. Go to the URL:

http(s)://machine:port/context/admin             

where:

machine 

Is the network id of your computer.

port 

Is the number of the port that connects your computer to the server hosting
WebFOCUS BUE.

context 

Is the local address for WebFOCUS BUE. For example, ibi_apps.

2. On the Sign In page, type the ID and Password of a User that has privileges to open the
Administration Console, and click Sign In.

The Administration Console opens automatically.

To display the Administration Console using a different language, you can use the Dynamic
Language Switch on the Configuration menu.
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Using the Administration Console Menu Bar

The Administration Console menu bar appears above the Administration Console tab display.
Its commands and features are available to all of the Administration Console tabs.

Using the Licenses Menu

The Licenses Menu links you to information about your current product license, an audit of
User and Group licenses and roles, and to information about licenses for all third-party
software products included in the installation. Using Licenses menu commands you can:

View the current license number, product edition, license key expiration date, and the
number of licensed users. You can also add new license numbers.

Access license information for all third-party software packaged with WebFOCUS BUE.

Reviewing Client License Information

The WebFOCUS Client command opens the License Information dialog box. This dialog box
identifies the current license key and the individual product components made available by
that key. You can also use it to replace the current license key with a new license key when
your current license expires or changes.

The License Information dialog box provides the following information:

Product Edition. The name of the current product edition.

License Key. The license key currently in use.

License Key Expiration Date. The date the license key will expire. By default, a warning
message for the client license key expiration date begins to appear fourteen (14) days
before the actual expiration date. This message displays the expiration date and the
number of days remaining until that date. The License Expiration Warning message appears
only to Administrators during sign on, and it is written to the event.log file located in the
logs directory of the WebFOCUS Client installation.

User Licenses. The total number of available user licenses and the number of licenses
used for each user category. For example:

Product Components. The product components your license entitles you to use. If the
check box to the right of an entry is visible and selected, you are entitled to use that
product component.

New License Key. Opens the Update License dialog box, where you can add a new license
key and site code.
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Reference: Managing Client Licenses

Access to WebFOCUS features and the number of licensed users is based on your license key
and site code.

When the number of users exceeds the number of licensed users, the User Licenses Used
count displays, in red, a message that the user license count has been exceeded, which is
written to the event.log trace file. Users that are authorized to access the Administration
Console will receive a message upon signing in.

User licenses are maintained or enforced when the following product components are licensed:

Total Users. The total number of named users in the WebFOCUS Repository.

Portal Users (PR). The number of users with portal privileges.

InfoAssist+ Users. The number of users with portal privileges and InfoAssist+ privileges.

Procedure: How to Configure License Codes

Access to the WebFOCUS features and the number of Managed Reporting users is based on
your license key and site code. You can change these values from the License Management
page.

1. In the Administration Console menu bar, click Licenses, and then click WebFOCUS Client. 

The License Information window opens, displaying features available under the current
license.

2. Click New License Key.

3. Type your new license key and site code.

4. Click Validate.

The License Management page displays the current license key, the new license key, and
the features that the new license key provides.

5. Click Save to implement the new license.

You must reload your web application in order for your changes to take effect. In addition,
users must sign out and sign back in to obtain access to any new features.

Reviewing User Audit Information

The User Audit command evaluates the repository license usage for Total Users, Portal Users,
and InfoAssist+ Users. The command produces a License Analysis report that identifies the
total number of licenses by license type, the number of licenses in use by license type, and
analyzes license assignments by Group and by User.
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You can run the User Audit utility (license_audit.bat) from your local WebFOCUS installation
directory, which is available in the following location:

drive:\ibi\WebFOCUS_BUE82\WebFOCUS\utilities\mr

When you run this program, it generates the License Analysis report and transfers it to the
auditUserCounts.htm file, in the same directory.

The License Analysis report contains the following information:

License Analysis

License Key Displays your current license key.

User License Displays the user license types that are authorized under
your current license key. This can include the following:

Total Named Users

Portal Users

InfoAssist+ Users

Code Displays the code for each user license, such as TU for Total
Users.

Maximum Displays the maximum number of user licenses that are
available with your license key.

In Use Displays the number of user licenses that are currently in
use.

Available Displays the number of user licenses that are available for
each license.

Analysis of Groups

2. Setting Up Your Environment

Online Help PDF  111



License Analysis

Group Path Displays the Groups stored in the repository. The following
groups are created by the WebFOCUS Repository Creation
utility, by default:

/EVERYONE

/Getting_Started

/Managers

/Retail Samples

License Type(s) Displays the license types for each Group, such as TU.

Role Displays the role of each Group, such as SystemFullControl.

On Resource Displays the resource to which the Role is applied for the
Group.

Former Type(s) Displays the former types of licenses for each Group.

Groups Summary Displays counts for the following:

Number of groups

Number of groups with license types

Number of groups with no license types

Number of groups with changed user types

Number of groups with cleared user types

Number of groups with unchanged types

Analysis of Users

User Name Displays the users stored in the repository. The following
users are created by the WebFOCUS Repository Creation
utility, by default:

manager

License Type(s) Displays the license types assigned to each user.
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License Analysis

# Group w/Licenses Displays the number of groups with licenses of which the
user is a member.

Former Type(s) Displays the license types that have been changed or
cleared for each user.

User Summary Displays counts for the following:

Number of users

Number of users with license types

Number of users with no license types

Number of users with changed user types

Number of users with cleared user types

Number of users with unchanged types

Procedure: How to Run the User Audit for the WebFOCUS Client from the Administration Console

From the Administration Console menu bar, click Licenses, and then click User Audit.

The License Analysis report opens in a separate browser window.

Reviewing Third Party Licenses

The Third Party command opens the 3rd Party Information page that displays the following
information for each third-party software application used to support different features in
WebFOCUS BUE:

Description

Version

File(s)

License

Third-Party Links
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The WebFOCUS BUE product uses various third-party software applications that support a
variety of features.

Clearing the Cache

The Clear Cache command refreshes the state of the WebFOCUS application by applying saved
changes that are not applied dynamically. Even though some changes are dynamic or only
require the administrative user to clear the cache to take effect, others require an
administrative user to recycle the web application. 

Closing the Administration Console

The Close command closes the Administration Console. After the console closes, you remain
signed in to your work session.

Opening Administration Console Help

When you click the Help icon, the online Help file opens to a topic that describes the tab,
setting, or feature currently on display.

Configuring Security

In the Administration Console Security Tab, you can adapt the default security settings to your
local environment.

Security can either be configured internally in the WebFOCUS BUE repository, or externally in a
Microsoft Active Directory or an LDAP directory that is not part of WebFOCUS BUE. To
accommodate this, you can use either the Internal page or the External page on the Security
tab in the Administration Console.

Internal authentication and authorization is enabled by default.

Using Internal Security

Internal authentication and authorization are enabled, by default. Optionally, you can use the
settings in the Internal page to configure sign in and password policies.

Sign In Settings (Enable Sign In Settings)
Determines the default values assigned to the Sign In Settings on the Internal Security
Page.

This check box is cleared (False), by default. Sign In Settings are inactive and unavailable,
and display a value of 0.
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When this check box is selected (True), Sign In Settings are activated, automatically
assigned a set of pre-configured values, and made available for updates. To deactivate an
individual setting while this check box is selected, type or select zero (0). When this check
box is later cleared, all values assigned to the Sign In Settings return to 0, and the
settings are deactivated.

This setting does not affect the value or availability of the Password Expiration Result
options.

Maximum Sign-in Attempts (IBI_Max_Bad_Attempts)
Specifies the number of unsuccessful sign-in attempts allowed before the account status
is changed to locked. When the Sign In Settings check box is cleared, the default value is
0, which allows unlimited attempts. When the Sign In Settings check box is selected, the
default value is 5, and managers can type or select an alternative value. To deactivate this
setting when the Sign In Settings check box is selected, type or select 0.

Lockout Duration (Minutes) (IBI_Account_Lockout_Duration)
Specifies the number of minutes before the status of an account changes from locked to
active. When the Sign-in Settings check box is cleared, the default value is 0 (off). When
the Sign In Settings check box is selected, the default value is 3 minutes, and managers
can type or select an alternative value. To deactivate this setting when the Sign In Settings
check box is selected, type or select 0.

Lockout Duration Reset (Minutes) (IBI_Account_Lockout_Duration_Reset)
Specifies the number of minutes that must elapse after the number of failed sign-in
attempts specified by the Maximum Sign-in Attempts setting before the allowed sign-in
attempt counter is reset to 0. The available range is from 1 to 99,999 minutes. When the
Sign-in Settings check box is cleared, the default value is 0 (off). When the Sign In Settings
check box is selected, the default value is 3 minutes, and managers can type or select an
alternative value. To deactivate this setting when the Sign In Settings check box is
selected, type or select 0.

Days Until Password Expires (IBI_Password_Expire)
Specifies the number of days that a password will remain active. When Sign-in Settings is
cleared, the default value is 0, which prevents passwords from expiring. When Sign In
Settings is selected, the default value is 90 days. Once the password has expired, the
user must take the action specified by the Password Expiration Result
(IBI_Password_Expire_Action) setting, and managers can type or select an alternative
value. To deactivate this setting when the Sign In Settings check box is selected, type or
select 0.
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Days Until Password Expiration Warning (IBI_Password_Expire_Warning)
Specifies the number of days prior to expiration that a warning will be displayed to the
user. When Sign-in Settings is cleared, the default value is 0, which provides no warning.
When Sign In Settings is selected, the default value is 75 days. This value should be less
than or equal to the value assigned to the Days Until Password Expires
(IBI_Password_Expire) setting, and managers can type or select an alternative value. To
deactivate this setting when the Sign In Settings check box is selected, type or select 0.

Password Expiration Result (IBI_Password_Expire_Action)
Specifies the action required when a password expires. You can choose one of the
following options:

To force Users with Expired passwords to change their passwords before signing in
(MUSTCHANGE). This is the default value.

Change the status of users with expired passwords to inactive. Such users cannot sign in
until an administrator resets the password (DISABLE-USER).

Enable Password Complexity (IBI_Password_Complexity) 

Determines the default values assigned to the Password Settings on the Internal Security
Page.

This check box is cleared (False), by default. All of the Password Settings are inactive and
unavailable, and display a value of 0.

When this check box is selected (True), all of the Password Settings are activated and
available for updates. WebFOCUS BUE automatically assigns a pre-configured set of values
to them.

When this check box is later cleared, all values assigned to the Password Settings return
to 0, and the settings are deactivated.

If this check box is selected (True), passwords also must:

Not contain the user account name or parts of the full name of the user that exceed
five consecutive characters.

Be at least six characters long or at least the number of characters specified in
Minimum Password Length, whichever is greater.

Contain characters from three of the following four categories:

Uppercase English characters (A through Z).

Lowercase English characters (a through z).
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Base 10 digits (0 through 9).

Non-alphabetic al characters (for example, !, $, #, %).

Complexity requirements are enforced when passwords are changed or created.

Minimum Password Length (IBI_Password_Minimum_Length) 

Defines the required minimum length of a password. When Enable Password Complexity is
cleared, the default value is 0 characters. When the Enable Password Complexity check
box is selected, the default value is 6 characters. To deactivate this setting when the
Enable Password Complexity check box is selected, type or select 0.

Password Reuse (IBI_Password_Reuse) 

Specifies the number of recent passwords that cannot be reused. If Password Reuse is
set to 6, for example, WebFOCUS BUE will track the 6 most recent password changes and
prevent you from reusing them when creating a new password. When the Enable Password
Complexity check box is cleared, the default value is 0 changes, and users can re-use any
previously-assigned password. When the Enable Password Complexity check box is
selected, the default value is 2 changes. To deactivate this setting when the Enable
Password Complexity check box is selected, type or select 0.

Procedure: How to Configure Sign In Settings

1. Sign in to WebFOCUS BUE as a manager and, from the BUE Portal Menu bar, click
Administration, and then click Administration Console.

2. Click the Security tab, and on the Security page, under the Security Configuration folder,
click Internal.

3. Select the Sign In Settings check box.

The Internal page displays the following default values:

Maximum Sign-in Attempts – 5

Lockout Duration (Minutes) – 3

Lockout Duration Reset (Minutes) – 3

Days Until Password Expires – 90

Days Until Password Expiration Warning – 75

4. To change the default value assigned to any of these settings, type or select an alternate
value in any of these boxes.

5. To clear all settings, clear the Sign In Settings check box. All values automatically return to
0.
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6. In the Password Expiration Result section, accept the default option To force users with
expired passwords to change their passwords before signing in, or click the alternative
option Change the status of users with expired passwords to inactive. Such users cannot
sign in until an administrator resets the password.

7. Continue with any other Internal Security page updates or save your changes.

Procedure: How to Configure Password Settings

1. Sign in to WebFOCUS BUE as a manager and, from the BUE Portal Menu bar, click
Administration, and then click Administration Console.

2. Click the Security tab. On the Security page, under the Security Configuration folder, click
Internal.

3. Select the Enable Password Complexity check box.

The Internal page displays the following default values:

Minimum Password Length – 6

Password Reuse – 2

4. To change the default value assigned to any of these settings, type or select an alternate
value in either of these boxes.

5. To clear all settings, clear the Enable Password Complexity check box. All values
automatically return to 0.

6. Continue with any other Internal Security page updates or save your changes.

Procedure: How to Save Internal Security Page Configuration Updates

1. When all of your Internal Security Page Configuration updates are complete, click Save.

2. When you receive a confirmation message, click OK.

3. When you receive a message to clear the cache, click OK.

4. In the Administration Console menu bar, click Clear Cache and, when you receive a
confirmation message, click OK.
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Using External Security

Use the External page if you have elected to configure security in a Microsoft Active Directory
(AD) or Lightweight Directory Access Protocol (LDAP) directory that is not part of WebFOCUS
BUE. 

Enable External Security 

When you select this check box, internal security settings are overridden. WebFOCUS BUE
directs all authentication activities and approvals to the external system you identify on
this page.

External Security Type (IBI_Authentication_Type) 

The drop-down list box for this field contains the following values:

Reporting Server. Authenticates users against an AD or LDAP directory.

Legacy LDAP. This value is not used with the Business User Edition.

Custom Java Plug-In. This value is not used with the Business User Edition.

Understanding Custom Settings

The Custom Settings page allows you to customize WebFOCUS BUE by typing customized
values for standard settings.

When you save updates to settings that you type into the Customized Setting text box, they are
transferred to the site.wfs file, located at drive:\ibi\WebFOCUS_BUE82\WebFOCUS\client\wfc
\etc\. When you use this page to assign new values to settings, they override the default
values assigned to them. These overrides are carried over as you upgrade to new versions.

After you save a custom setting, the text continues to display on this page. You can use
comments to identify specific updates and additional information about them.

Procedure: How to Configure Custom Settings

Only a manager can configure settings on the Custom Settings page.

1. In the BUE Portal, on the Menu bar, click Administration, and then click Administration
Console.

2. On the Configuration tab, click Custom Settings.

3. Under the final comment statement at the top of the Custom Settings text box, or the
most recent custom setting entry, type the variables, settings, commands, or comments
that comprise the custom settings.

Use the format required by the application or operating system that will execute the
command.
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To help track changes to custom settings, use comments to identify and separate
individual changes.

4. To store your custom settings in an encrypted format, select the Encrypt check box.

Note: Even when you select this check box, settings continue to appear in an unencrypted
format in the Custom Settings text box.

5. When your configuration is complete, click Save.

6. When you receive a confirmation message, click OK.

7. When the Custom Setting page clears, click Custom Settings under the Application
Settings folder to see your updated comments, settings, or commands in the Custom
Settings text box.

Procedure: How to Configure Collation Sequence Settings

Only a manager can configure settings on the Custom Settings page.

1. In the BUE Portal, on the Menu bar, click Administration, and then click Administration
Console.

2. On the Configuration tab, click Custom Settings.

3. Under the final comment statement at the top of the Custom Settings text box, type the
comment line:

# Collation Sequence Settings

4. Under the comment line, type the command:

_site_profile=&_site_profile\nSET COLLATION={BINARY|SRV_CI|SRV_CS|
CODEPAGE}

where:

BINARY

Bases the collation sequence on binary values.

SRV_CI

Bases the collation sequence on the LANGUAGE setting, and is case-insensitive.

SRV_CS

Bases the collation sequence on the LANGUAGE setting, and is case-sensitive.

CODEPAGE

Bases the collation sequence on the code page in effect, and is case-sensitive.
CODEPAGE is the default value. In most cases, CODEPAGE is the same as BINARY.
The only differences are for Danish, Finnish, German, Norwegian, and Swedish in an
EBCDIC environment.
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5. To store your custom settings in an encrypted format, select the Encrypt check box.

Note: Your settings will continue to appear in the Custom Settings text box in an
unencrypted format.

6. When your configuration is complete, click Save.

7. When you receive a confirmation message, click OK.

8. When the Custom Setting page clears, click Custom Settings under the Application
Settings folder to see your updated comments, settings, or commands in the Custom
Settings text box.

Understanding NLS Settings

You can use the Administration Console to configure National Language Support and enable
the Dynamic Language Switch.

Separate message files exist for every national language that WebFOCUS supports. If you want
to customize the set of characters used in your report output, you must select the code page
for every language you use.

These settings do not carry over during updates. You must repeat this customization step for
each new release that you install.

Procedure: How to Configure National Language Support

1. In the Administration Console, on the Configuration tab, click NLS Settings.

2. On the NLS settings page, click the option for the operating system on which the
WebFOCUS Client resides.

The list adjusts to display the code pages that are available to the selected operating
system.

3. From the list, select a code page that configures the client for the correct display of report
output in the browser.

Tip: The language selected for the Client usually corresponds to the language selected for
the Server from the Reporting Server Console.

If the language chosen from the Reporting Server Console does not appear in the list, click
User Defined Code Page and type the number of the user-defined code page.

Use this option, for example, when the server adds support for a new code page that is
not yet reflected in the client software.
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In the following sample configuration window, the administrator specified code page 437.

Unicode (UTF-8) is available for the Windows, UNIX, or AS/400 operating systems.

4. Click Save to store your NLS settings.

The Administration Console will generate and update the client configuration file
(nlscfg.err), found in drive:\ibi\WebFOCUS_BUE82\WebFOCUS\client\home\etc, with the
CODE_PAGE setting. Note that if you click NLS Settings again, your new setting is
highlighted as the active code page.

Reference: WebFOCUS BUE Client Code Page Settings

The following code page settings are available:

* 137 - U.S. English/Western European

874 - Thai

* 942 - Japanese

* 946 - Simplified Chinese

949 - Korean

1250 - Eastern European

1251 - Russian

* 1252 - Western European

1253 - Greek

1254 - Turkish
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1255 - Hebrew

1256 - Arabic

1257 - Baltic

* 10942 - Japanese EUC

* 10948 - Traditional Chinese

* 65001 - Unicode (UTF-8)

Note: Only those code page settings marked with an asterisk are fully supported in the current
release.

Customizing the Dynamic Language Switch

You can customize the languages that are made available on the sign in pages by activating
the Dynamic Language Switch.

Procedure: How to Customize the Dynamic Language Switch

1. On the Administration Console, on the Configuration tab, under the Application Settings
folder, click Dynamic Language Switch.

The Dynamic Language Switch window appears with a list of the languages made available
by the code page selected in the NLS Settings page. By default, the Enable Dynamic
Language check box is unselected, and all of the language check boxes are deactivated.

The Dynamic Language Switch window also shows the Client Code Page setting specified
in How to Configure National Language Support on page 121.

2. Setting Up Your Environment

Online Help PDF  123



2. Select the Enable Dynamic Language check box to activate the check boxes for all of the
available languages displayed in the panel, as shown in the following image:

Selecting the Enable Dynamic Language check box and one or more languages activates
the display of the Select Languages button on all of the sign in pages. It also activates the
Language menu on the BUE Portal Menu bar.

3. Select the check box next to the Locale heading if you want all of the languages to appear
in the Select Languages drop-down list on the sign in pages and in the Language menu.

OR

4. Clear the check box next to the Locale heading and select the individual check boxes next
to the individual languages that you want to appear on the sign in pages and in the
Language menu.

5. Click Save to save your changes.

Note: To remove individual languages from the Select Languages drop-down list on the
sign in pages, clear the check boxes next to the languages you want to remove.

Understanding Redirection Settings

You can view or edit redirection settings for the WebFOCUS Client though the Redirection
Settings area of the Administration Console. However, you should not alter Redirection
Settings without consulting Customer Support Services. 
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Redirection allows users to save report output in a temporary directory when a request is
executed. Then an HTTP call is made from the browser to retrieve the temporary stored output
for display in the browser.

If redirection is turned off, the report output displays in the browser immediately after the
request is executed.

To change redirection settings in the Administration Console, click the Configuration tab and
then Redirection Settings. The Redirection Settings panel opens, as shown in the following
image.

Procedure: How to Change Redirection Settings

It is recommended that you do not change these settings unless instructed to do so by
Customer Support Services.

1. In the Administration Console on the Configuration tab, click Redirection Settings.

2. In the Redirect column, select yes on a row to redirect the output to a temporary directory
for the specified extension.
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3. In the Save Report column, select yes to prompt users in the browser to open or save
report output. When Save Report is set to yes, the report output retains the Save As
name, if specified in the request.

For example, specifying ON TABLE PCHOLD AS MYREPORT FORMAT PDF in a request and
setting Save Report to yes for the .pdf extension enables a user to open or save the
output as MYREPORT.pdf. The Save As name specified is returned to the browser in
uppercase. If Save Report is set to yes and no Save As name is specified in the request, a
random file name is generated.

Important: You must do the following to use the Save Report functionality for GRAPH
requests (specified with a PNG, SVG, GIF, JPEG, or JPG format in the procedure):

Set Save Report to yes for the .htm Extension.

Running a server-side GRAPH request creates an HTM file that contains a link to the
actual graph output, which is stored as a temporary image file with
a .jpeg, .jpg, .gif, .svg, or .png extension.

When you execute a GRAPH request, if you select the Save option when prompted to
open or save the output, the output is saved to an HTM file using only a reference to
the graph image, which will eventually expire and be deleted from the server (according
to the temporary file expiration settings in the Client Configuration).

To preserve the output of the GRAPH request, open the saved HTM file, right-click the
graph image, and select Save Picture As to save it to disk permanently. You can then
substitute an absolute reference to the saved image file in the returned HTM output
file.

4. If you want to encrypt the redirection settings, select the Encrypt check box at the bottom
of the screen.

5. Click Save to save your changes in the Redirection Settings panel.

Changing Application Settings

The Application Settings enables Managers to update configuration settings that are required
by various components of the WebFOCUS BUE web application. You can view or edit the
application settings through the Administration Console.

Initially, WebFOCUS BUE reads the configuration file to locate parameters and their values. If a
parameter does not exist in the file, the BUE will then obtain the parameter and its value from
the web.xml file of the web application currently deployed by the BUE.
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Reference: Understanding Change Management Settings

The Change Management Settings determine which files are exported during the change
management process, the format of the exported file, and whether some legacy functionality is
preserved.

File Types Included in Export Package (IBI_CM_EXPORT_WFRS_FILE_EXTENSIONS) 

Determines, by file extension, which files from the WebFOCUS Reporting Server or the web
will be included in exports created by the change management feature. The values
included by default are acx, bmp, css, fex, gif, htm, html, ico, jpe, jpeg, jpg, js, mas, mnt,
png, sty, and svg. 

Retain Handles (IBI_CM_RETAIN_HANDLES) 

This option is not relevant to the BUE. 

Zip Change Management Package (IBI_CM_ZIP) 

When selected (True), the export package is compressed and delivered in a zip file. 

Name format of Zip export files (IBI_CM_ZIP_FILE_FORMAT) 

Select an option from the drop-down menu to specify the name format of the zip file. 

Verify Signature on Import (IBI_CM_ZIP_VERIFY_SIGNATURE ) 

When selected (True), the export package is flagged for signature verification, which
ensures both that the code has not been tampered with and that the signature was
produced with the expected key. 

Reference: Understanding Deferred Reporting Settings

Deferred Reporting Settings determine how deferred reports are processed.

Prompt for Custom Deferred Report Description 
(IBI_DEFERRED_CUSTOM_DESCRIPTION) 

When this check box is selected, the default setting, users are prompted to optionally
customize the description for the deferred report, which defaults to the title of the report
being run deferred. This occurs whenever the description defined in the parameter
(IBIMR_defer_description) has not been submitted with the run deferred report request. 

When this check box is clear, the title of the report being submitted to run deferred is
assigned to the deferred report description automatically, and no prompt appears.

Display Deferred Request Submitted Notification (IBI_DEFERRED_NOTIFY_SUBMITTED) 

When this check box is selected, the default setting, the Deferred Request Submitted
window displays to confirm a successful deferred request. The user clicks OK to close the
window. 
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When this check box is clear, the Deferred Request Submitted window does not display.

Display Deferred Ticket Delete Confirmation 
(IBI_DEFERRED_TICKET_DELETE_CONFIRM) 

Activates an automated message that prompts the user to confirm the deletion of a
deferred report. When this check box is selected, which is the default, a message prompts
the user to confirm the deletion, so a deletion requires two clicks. When this check box is
clear, the user is not prompted to confirm the deletion, so a deletion requires only one
click. Making a large number of deletions is faster when suppressing the confirmation
message. 

Reference: Understanding ESRI Settings

The ESRI Settings page defines the connection to the local application that supports Esri-
based maps.

ESRI On Premise (IBI_ESRI_ON_PREMISE)
Identifies the path to the internal ArcGIS JavaScript API Source used to develop Esri-based
maps for WebFOCUS BUE. This setting is blank, by default, meaning that the use of an
internal source is not activated. To activate the use of an internal ArcGIS JavaScript API to
develop Esri maps, type the path to it in this setting, typically, /web_resource/arcgis_api.

The default API that should be referenced by this setting is the ArcGIS API for JavaScript,
version 3.15, which can be found at https://js.arcgis.com/3.15/. The ArcGIS JavaScript API
zip file is available for download from https://developers.arcgis.com/downloads/.

For more information about the Esri ArcGIS JavaScript API, see https://
developers.arcgis.com.

For more information about how to configure Esri On Premise for InfoAssist+, see 
Configuring an Esri On Premise Environment on page 478.

Reference: Understanding Parameter Prompting Settings

The Parameter Prompting Settings determine parameter prompting behavior in the WebFOCUS
BUE Client.

Managed Reporting (IBIMR_PROMPTING) 

Enables or disables parameter prompting for all Managed Reporting requests. Possible
values are: 

Off. Turns off parameter prompting at the site level.
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Run with Default Values. (XMLRUN) Prompts for amper variables created with the -
DEFAULT command and any other amper variable that does not have a value. This is
the default value.

Always Prompt. (XMLPROMPT) Prompts for amper variables created with the -
DEFAULT command when there is another amper variable that does not have a value
assigned.

Managed Reporting when Prompt Parameters Property Unset 
(IBIMR_PROMPTINGUNSET) 

Enables or disables parameter prompting for Managed Reporting procedures (FEXes) when
IBIMR_prompting is set to XMLPROMPT or XMLRUN, and the Prompt for Parameters setting
is unchecked in the FEX Properties dialog box. Possible values are: 

OFF. Turns off parameter prompting.

Run with Default Values. (XMLRUN) Prompts for amper variables created with the -
DEFAULT command and any other amper variable that does not have a value. This is
the default value.

Always Prompt. (XMLPROMPT) Prompts for amper variables created with the -
DEFAULT command when there is another amper variable that does not have a value
assigned.

Self Service (IBI_WFDESCRIBE_DEFAULT) 

Enables or disables amper auto prompting for self-service reporting. Possible values are: 

OFF. Turns off auto prompting. This is the default value.

Run with Default Values. (XMLRUN) Prompts for amper variables created with the -
DEFAULT command and for any other amper variable that does not have a value.

Always Prompt. (XMLPROMPT) Only prompts for amper variables created with the -
DEFAULT command when there is another amper variable that does not have a value
assigned and, therefore, will be prompted for.

Display XML (Debug with syntax error checking). (XML) The XML document
describing the amper variables is displayed in the browser. This setting is used
internally, and is recommended for debugging and syntax error checking purposes only.

Display XML (Debug). (XMLCHECK) The XML document describing the amper
variables is displayed in the browser. This setting is used internally, and is
recommended for debugging purposes only.

Note: Managed Reporting uses a separate variable setting, which is IBIMR_prompting.
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Default Template (IBI_WF_DESCRIBE_HTML) 

The HTML template that defines the auto prompt layout. 

Null Behavior (IBIF_DESCRIBE_NULL) 

Specifies the value (_FOC_NULL or FOC_NONE) that the client assigns (in a -SET command)
to the amper variable when the dynamic multi-select list No Selection value is selected.
The default value is _FOC_NULL. 

Reference: Understanding Text Generation Server Settings

The Text Generation Server Settings define the connections to an independent server that
provides narrative descriptions for chart headers, footers, and tooltips.

Text Generation Server URL (IBI_TEXT_GENERATION_SERVER_URL)
Identifies the URL of the external natural language generation server that provides
narrative descriptions for chart headers, footers and tooltips. If your product installation
supports natural language generation for charts, type the URL of the text generation server
in this setting. This setting is blank, by default. 

Text Generation Server Key (IBI_TEXT_GENERATION_SERVER_KEY)
This setting is not in use and must remain blank.

Changing Client Settings

The client configuration settings are grouped into categories under the Configuration menu in
the WebFOCUS console. The term Initial Value next to a setting means that the value shown
initially is the installation default value and that it can be overridden by setting the variable
explicitly in the URL request.

InfoAssist+ Properties

Settings in the InfoAssist+ Properties page of the Administration Console determine the
display and use of the InfoAssist+ tool that opens when Advanced Users, Developers, or
Managers create or update content.

To enable or disable reporting options for the InfoAssist+ tool, click Utilities, scroll down to the
bottom of the Configuration tab menu, and then click InfoAssist+ Properties.
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Reference: Understanding InfoAssist+ Home Tab Properties

The InfoAssist+ Home tab enables you to control the most commonly used properties and
options from the Format, Design, Filter, and Report groups. These properties are:

Use Live Preview Mode 

Determines whether InfoAssist+ opens in the Live Preview mode or the Query Design View
by default. When Yes is selected, InfoAssist+ opens in the Live Preview mode as the
default. When Yes is not selected, InfoAssist+ starts with the Query Design View. If Allow
User Override is checked for this option, users can change the setting specified by the
Manager.

Record Limit 

Enables the Record Limit menu of the Home tab. If Show is not selected, the Record Limit
menu is removed from the InfoAssist+ interface.

Themes 

Provides InfoAssist+ users with various color-coded StyleSheet themes that can be used to
style reports and charts. Users can select standard InfoAssist+ themes, or select
customized cascading style sheet themes created by your organization.

Page Heading 

Enables the Head/Foot menu of the Home tab. InfoAssist+ users can use the Head/Foot
menu to add a heading or footing to each page of the report output.

Report Heading 

Enables the Head/Foot menu of the Home tab. InfoAssist+ users can use the Head/Foot
menu to add a heading or footing to the first page of the report output.

Reference: Understanding InfoAssist+ Format Tab Properties

For reports or charts, InfoAssist+ displays a list of output file format options, such as, HTML,
PDF, or Excel, in the Format Group of the Home tab. Other options that make additional layouts
and display features available when creating a report or chart appear on the Format tab itself.
You can control the display of both types of options through the settings contained in this
section. The settings that affect the Format tab display are InfoMini Run Immediate, Other
Chart Types, Pages on Demand, Stack Measures, User Selection.
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Note: Settings in this section do not affect the display of Format tab features for
visualizations.

Active Report Format 

Enables the use of the HTML active report format. An HTML active report is a self-
contained report that is designed for offline analysis. It contains all of the data and
JavaScript within the HTML output file and it includes analysis options, such as filtering,
sorting, and charting.

Select the check box to ensure that this option appears in the drop-down lists for the
Report Output Format, Chart Output Format, and Document Output Format properties under
the Tool Options Dialog Defaults section.

Additional HTML Formats for Chart 

Enables the use of the PNG, JPEG, GIF, and SVG output formats. The default value is PNG.
PNG is not available as a format for chart output.

Additional PDF Formats for Chart 

Enables the use of the PDF/SVG and PDF/GIF output formats. The default value is PDF/
SVG.

Excel 2000 Format 

Enables the use of the Excel 2000 spreadsheet output format. The Excel 2000 format
supports most StyleSheet attributes, allowing for full report formatting. The computer on
which the report displays must have Microsoft Excel 2000 installed.

When this check box is selected, this output format option is available to select in the
Output Format drop-down menus in the Tool Options Dialog Defaults section.

This check box is selected, by default.

Excel 2000 Formula 

Enables the use of the Excel 2000 formulas when the Excel 2000 Format option is
selected.

This check box is selected, by default.

Excel 2007 Format 

Enables the use of the Excel 2007 spreadsheet output format. The computer on which the
report displays must have Microsoft Excel 2007 installed.

When this check box is selected, this output format option is available to select in the
Output Format drop-down menus in the Tool Options Dialog Defaults section.

This check box is selected, by default.
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Excel 2007 Formula 

Enables the use of the Excel 2007 formulas when the Excel 2007 Format check box is
selected.

This check box is selected, by default.

Excel Pivot 

Enables the use of the Excel 2000 PivotTable output format. PivotTable is an Excel tool for
analyzing complex data, much like OLAP.

This check box is clear, by default.

HTML Format 

Enables the use of the HTML page report format.

Select the check box to ensure that this option appears in the drop-down lists for the
Report Output Format, Chart Output Format, and Document Output Format properties under
the Tool Options Dialog Defaults section.

InfoMini Run Immediate 

If Enable is selected, reports run immediately when InfoMini first launches. This setting is
enabled by default.

Other Chart Types 

Allows the creation of more complex graph output types, such as Spectral Maps, Gauge
Charts, and Pareto Charts.

Pages on Demand 

Enables the display of report output one page at a time. InfoAssist+ users can use the
navigation menu at the bottom of the output screen to view each page. This option is
activated only when HTML or active report output format is selected.

PDF Format 

Enables the use of the PDF report format.

Select the check box to ensure that this option appears in the drop-down lists for the
Report Output Format, Chart Output Format, and Document Output Format properties under
the Tool Options Dialog Defaults section.

PowerPoint 2000 Format 

Enables the use of the PowerPoint® 2000 document output format. The computer on
which the report appears must have Microsoft PowerPoint 2000 or higher installed.
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Select the check box to ensure that this option appears in the drop-down lists for the
Report Output Format, Chart Output Format, and Document Output Format properties under
the Tool Options Dialog Defaults section.

PowerPoint 2007 Format 

Enables the use of the PowerPoint® 2007 document output format. The computer on
which the report appears must have Microsoft PowerPoint 2007 or higher installed.

Select the check box to ensure that this option appears in the drop-down lists for the
Report Output Format, Chart Output Format, and Document Output Format properties under
the Tool Options Dialog Defaults section.

Stack Measures 

Displays all numeric measure field names in the first column of the report output, with the
corresponding numeric data values displayed across time in a column for each selected
time period. The Stack Measures feature is activated only when HTML, Excel, or
PowerPoint output format is selected. If Allow User Override is checked for this option,
users can change the setting specified by the Manager.

User Selection 

Allows users to change the output type of their reports at run time.

Reference: Understanding InfoAssist+ View Tab Properties

Enables InfoAssist+ users to customize the view of different report components in the
InfoAssist+ tool, such as the design mode, output location, and data view. You can configure
the following properties in the InfoAssist+ View tab:

Display View Tab 

Enables the View tab and all of its menu options. If this is not selected, the View tab is
removed from the InfoAssist+ interface.

Data Panel 

Allows the user to customize Data Panel settings. Values are Logical (default), List, and
Structured.

Query Panel 

Allows the user to customize the view of the query components, such as Filters, Column
and Row labels, and Measures when building a report. Values are Tree (default), Area 2x2
(2 columns by 2 rows), Area 1x4 (1 column by 4 rows). If Allow User Override is checked for
this option, users can change the setting specified by the Manager.
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Reference: Understanding InfoAssist+ Tool Options Dialog Defaults Properties

Enables Managers to specify default tool settings. If Allow User Override is checked for an
option, users can change the setting specified by the Manager. However, the Manager cannot
specify a default value that has already been disabled in one of the other groups. For example,
if you have disabled the active report format in the Format Tab section, you will see an error
message if you attempt to set that format as a default Compose Output Format in the Dialog
Defaults section.

Report Output Format 

Sets the default format for reports. Valid values are HTML, active report, PDF, EXL07,
EXL2K, PowerPoint 2000, PowerPoint 2007. To ensure that these options are available, a
Manager must select the check box for each under the Format Tab section. The default
value is HTML.

Chart Output Format 

Sets the default format for charts. Valid values are HTML, HTML5, active report, PDF,
EXL2K, PowerPoint 2000, and PowerPoint 2007. To ensure that these options are
available, a Manager must select the check box for each under the Format Tab section.
The default value is HTML.

Document Output Format 

Sets the default format for documents that are generated in InfoAssist+. Valid values are
HTML, active report, PDF, EXL2K, PowerPoint 2000, and PowerPoint 2007. To ensure that
these options are available, a Manager must select the check box for each under the
Format Tab section. The default value is active report.

Page Orientation 

Sets the default page orientation for reports and charts. Valid values are Portrait and
Landscape. The default value is Portrait.

Page Size 

Sets the default page size for reports and charts. Valid values are A3, A4, A5, Letter,
Tabloid, Legal, PPT-SLIDE, and Large Size. The default value is Letter.

Data Preview Method 

Sets the default action for whether reports are previewed using sample data or actual data
from the data source. Valid values are Sample and Live. The default value is Live.
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Record Limit

Sets the default maximum number of rows retrieved from the data source when Interactive
Design view is selected. This feature is useful in reducing response time if users are
working with a large amount of data. It is applicable only when developing the report. The
record limit setting will not affect the report output at run time. Valid values are 0 to
10,000 rows. The default value is 500 rows.

Output Target 

Sets the default location for reports and charts. Valid values are Single tab, New tab,
Single window, and New window. The default value is Single tab.

InfoAssist+/Portal StyleSheet 

Sets the style sheet to be used for InfoAssist+ and the Portal. Click Change Stylesheet to
open the Browse predefined template files window.

Visualization StyleSheet 

Sets the style sheet to be used when creating visualizations. Click Change Stylesheet to
open the Browse predefined template files window.

Encode HTML 

Encodes script tags within data, so that the tags are replaced and not executable in a
browser. The default value is Yes. This includes the ON TABLE SET HTMLENCODE ON
command in the procedure.

Enable Pages On Demand 

Allows InfoAssist+ users to view report output one page at a time. The user can use the
navigation menu at the bottom of the output screen to view each page. This option is
activated only when HTML or active report output format is selected.

Rows retrieved from cache 

Establishes how many rows of cached data stored in a binary file are returned to the
output window at one time. The default value is 100 rows.

Reference: Understanding InfoAssist+ File Options

Determines which of the following file types can be selected by InfoAssist+ users when
creating and saving HOLD files:

Binary 

Stores report or chart data as binary numbers in numeric fields. Binary files use the
extension (*.ftm).
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FOCUS 

Stores report or chart data as text in a segment structure that conforms to FOCUS
database requirements. FOCUS files use the extension (*.foc).

Comma Delimited with Titles 

Stores report or chart data as text in sequence by field. Alphanumeric fields are enclosed
in quotation marks. Fields are separated by commas and are preceded by Field Names.
Comma Delimited with Titles files use the extension (*.csv) (Comma Separated Values).

Plain Text 

Stores report or chart data as text in sequence by field without delimiters or field names.
Plain Text files use the extension (*.ftm).

Tab Delimited 

Stores report or chart data as text in sequence by field. Fields are separated by tab
characters. Tab Delimited files use the extension (*.tab).

Tab Delimited with Titles 

Stores report or chart data as text in sequence by field. Fields are separated by tab
characters, and are preceded with field names. Tab Delimited with Titles files use the
extension (*.tab).

Database Table 

Stores report or chart data as text in a field structure that conforms to a Structured Query
Language (SQL) Database format. Database Table files use the extension (*.sql).

Database Table output is only available when working against an SQL database.

Hyperstage 

Stores report or chart data as text in a field structure that conforms to the Hyperstage
database table format. Hyperstage files use the extension (*.bht).

Hyperstage output is only available when the reporting server has a Hyperstage adapter
configuration.

SQL script 

Stores report or chart data as text in a sequential field structure that can be imported into
a database table that conforms to the Structured Query Language (SQL) Database format.
SQL Script files use the extension (*.sql).

SQL Script output is only available when working against an SQL database.
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XML 

Stores report or chart data as text in a field structure that conforms to the rules of the
Extensible Markup Language. Fields are separated by tags that identify content. XML files
use the extension (*.xml).

Understanding InfoAssist+ Auto Drill Properties

Settings in this section enable the use of drill-down navigation options, which are part of the
Auto Drill functionality.

Single Click Navigate
Enables the use of single click navigation, which is an automatic drill down to the next
levelof a dimension within the body of a report or chart made in response to a single click
on a top-level entry or feature.

By default, this check box is not selected, meaning that single click navigation is disabled,
and top-level Auto Drill entries or features display the Drilldown menu in response to a
single click. If this check box is selected, single click navigation is enabled, and instead of
displaying the Drilldown menu, top-level Auto Drill entries or features automatically refresh
the report or chart with results based on the next lower level of your selected dimension in
response to a single click.

Breadcrumbs
Enables the display of a breadcrumb trail at the top of an Auto Drill report or chart.

By default, this check box is selected, and Auto Drill reports and charts display a
breadcrumb trail. If this check box is cleared, Auto Drill reports and charts do not display a
breadcrumb trail.

In an Auto Drill report or chart, a breadcrumb trail displays a series of links to previous
versions that were generated as you drilled through each level of your selected dimension
to reach the version currently on display.

Restore Original
Enables the display of the Restore Original option in the Drilldown menu.

By default, this check box is selected, and the Restore Original option appears in the
Drilldown menu. If this check box is cleared, the Restore Original option does not appear in
the Drilldown menu. In an Auto Drill report or chart, the Restore Original option returns you
directly to the original version.

Drill Up
Enables the display of the Drill up option in the Drilldown menu.
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By default, this check box is selected, and the Drill up option appears in the Drilldown
menu. If this check box is cleared, the Drill up option does not appear in the Drilldown
menu. In an Auto Drill report or chart, the selection of the Drill up option refreshes the
display with results based on the next level above the current level of your selected
dimension.

Drill Down

Enables the display of the Drill down option in the Drilldown menu.

By default, this check box is selected, and the Drill down option appears in the Drilldown
menu. If this check box is cleared, the Drill down option does not appear in the Drilldown
menu. In an Auto Drill report or chart, the selection of the Drill down option refreshes the
display with results based on the next level below the current level of your selected
dimension.

Note: In addition to disabling the Drill down option, clearing this setting also removes
hyperlinks from top level report entries and the breadcrumb trail display from reports and
charts. If the Single Click Navigate setting is also cleared, clearing the Drill Down setting
effectively disables Auto Drill navigation tools in reports and charts that contain only the
top level of a dimension value in their design. If the Single Click Navigate setting is
selected, and the report or chart contains entries below the top level, clearing the Drill
Down setting shifts the Single Click Navigation feature to those lower-level entries.
However, because this setting also suppresses the display of the Drilldown menu, users
will neither be able to restore the original version of the report or chart, nor will they be
able to drill back up to a higher level.

Reference: Understanding InfoAssist+ Miscellaneous Options

Use two-part file name 

If selected, this option requires the use of two-part file names, which specify the path to
the Master File location. If not selected, a one-part file name must be used instead. The
default value is selected.

Expand Data Source Tree 

Determines whether the initial view of the data source tree is expanded or collapsed. If
selected, the tree is expanded. If not selected, the tree is collapsed. The default value is
selected.

Join Tool 

Displays the Join menu option on the InfoAssist+ Data tab. If not selected, the Join menu
option is removed from the Data tab. The default value is selected.
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Layout Tab

Enables the Layout tab in the InfoAssist+ control panel. If not selected, the Layout tab is
removed from the InfoAssist+ control panel. The default value is selected.

Series Tab

Enables the Series tab in the InfoAssist+ control panel. The Series tab displays only when
working with chart queries. It provides access to charting properties and options in the
Properties, Line, and Pie menus. If not selected, the Series tab is removed from the
InfoAssist+ control panel. The default value is selected.

Reporting Server Configuration Settings

Reporting Server configuration settings are available on the Configuration tab of the
Administration Console. To view them you must expand the Reporting Server folder and the
Server Connections folder, and click the Reporting Server icon.

Reference: Reporting Server Node Properties

The Reporting Server Node properties from the Basic pane are explained below.

Basic

Node Name 

The logical name of the node. The name cannot be the same as any other node name. It
must begin with a letter and cannot be more than eight characters. The Client will use this
name when it accesses this server.

Node Description 

Optional. The description of the node that appears in the Configuration pane. If this is
omitted, the node name will be used.

Host 

The Host name or IP address of the Server.

TCP/IP Port 

The Port number for the TCP listener. The default port is 8120.

HTTP(S) Port 

The Port number for the HTTP listener. This is typically one port after the TCP/IP port.

The default HTTP port is 8121.
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Security 

The security options for the reporting server connection.

Prompt for Credentials. This option is not relevant for the BUE.

HTTP Basic. This option is not relevant to the BUE.

Kerberos. This option is not relevant for the BUE.

SAP Ticket. This option is not relevant to the BUE.

Service Account. This option is not relevant to the BUE.

Trusted. Allows you to connect to the Reporting Server with only a user ID. This option
is useful when no password is available for the user. Controls should be placed on the
Server to ensure that connections from unauthorized clients are rejected. For example,
you can employ the Reporting Server RESTRICT_TO_IP setting or configure a network
firewall so that only a particular client can connect to the Server.

Note: When configuring the Client to make trusted connections to the Reporting Server,
you must also enable the Reporting Server to accept trusted connections.

Advanced

The Reporting Server Node properties from the Advanced pane are explained below.

Service Name 

Description for the Reporting Server node. This description displays to end users.

Use HTTPS 

Enables encrypted communication between the Client and the Reporting Server HTTP
listener. The default value is off.

This option must be selected if the Reporting Server HTTP listener is configured to use
SSL. If you are using a self-signed certificate to enable HTTPS communication with a
Reporting Server, the certificate must be configured in the Java environment where the
Client is installed. This enables HTTPS communication between the Reporting Server and
the Administration Console.

Compression 

Enables data compression. By default, data compression is disabled.

Encryption 

Sets data encryption ability and the cryptography symmetric method used.
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Select one of the following options from the drop-down list:

0. Off. This is the default value.

AES. Advanced Encryption Standard. The AES selections are in the format

CIPHER(x)(-MODE)

where:

CIPHER

Is AES128, AES192, AES256.

x

Is optional and defines an RSA key length of 1024 bits. When this is not specified, the
RSA key is 512 bits.

CBC

Is optional and defines the use of Cipher Block Chaining (CBC) mode. When the mode
is not specified, Electronic Code Book (ECB) is used.

For example, AES256x-CBC is the AES256 cipher with a 1024-bit RSA key in CBC
mode. AES128 is the AES128 cipher with a 512-bit RSA key in ECB mode.

Connect Limit 

Specifies the number of seconds that the Client will hold the pending connection. Other
possible values are 0 (no wait) and -1 (infinite wait). The default value is -1.

Maximum Wait 

Specifies the time, in seconds, that the Client will wait before timeout. You can optionally
specify different return times for the first row and other rows. A single number indicates
the return time is valid for any row. If two numbers are separated by a comma, the first
number specifies the return time for the first row and the second number specifies the
return time for the subsequent rows. The default value is -1, which indicates an infinite
wait time.

Security Object 

For any security option, a Manager can specify one or more HTTP header names and/or
cookie names as follows:

Cookie. Specify each HTTP cookie name separated by a comma (,). For example:

cookie_name1, cookie_name2
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Header. Specify each HTTP header name separated by a comma (,). For example:

header_name1, header_name2

Note:

HTTP cookie and header names must not contain commas (,) or colons (:). These are
reserved delimiters.

REMOTE_USER is a special type of HTTP header variable whose contents will not be
sent to the Reporting Server. Therefore, it is not a valid HTTP header value. Instead,
specify the WF_REMOTE_USER variable.

Reference: Reporting Server Node Security Options

The security options from the Client Configuration pane are explained below.

Prompt for Credentials 

WebFOCUS makes an explicit connection to the Reporting Server with the user ID and
password specified in the Web Security tab. This is the default value.

HTTP Basic 

WebFOCUS extracts the user ID and password from the authorization header. These
credentials are then used to make an explicit connection to the Reporting Server. You
should only select this option when your web tier is performing Basic Authentication.

Note: You can verify that the authorization header is available in by selecting HTTP Request
Info in the Diagnostics tab.

Kerberos 

WebFOCUS passes a Kerberos ticket for the user to the Reporting Server. This option
enables an end-to-end single sign on solution from the desktop to WebFOCUS, from
WebFOCUS to the Reporting Server, and from the Reporting Server to supported relational
DBMS systems. To use Kerberos authentication, the Reporting Server must run in security
OPSYS mode.

SAP Ticket 

WebFOCUS passes the user MYSAPSSO cookie, which is created on SAP Enterprise Portal,
to the Reporting Server. The Reporting Server then validates the cookie using the SAP
security API. This option enables single sign on from WebFOCUS to a Reporting Server
configured with the Data Adapter for SAP for environments using Open Portal Services in
SAP Enterprise Portal.
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Service Account 

Allows you to specify a user ID and password to be used for all connections to the
Reporting Server.

The service account credentials are encrypted and stored in the SECURITY keyword of the
odin.cfg file. When defined, the service account overrides any other credentials that may
be presented to WebFOCUS for this Reporting Server node, and all users connect to the
Reporting Server using the same credentials. This approach does not make it possible to
identify which user is running a given request on the Reporting Server in Managed
Reporting deployments, and therefore is not recommended for them.

Trusted 

Allows you to connect to the Reporting Server with only a user ID. This option is useful
when no password is available for the user. Controls should be placed on the Server to
ensure that connections from unauthorized clients are rejected. For example, you can
employ the Reporting Server RESTRICT_TO_IP setting or configure a network firewall so
that only a particular client can connect to the Server.

Note: When configuring the WebFOCUS Client to make trusted connections to the
Reporting Server, you must also enable the Reporting Server to accept trusted
connections.

Using the ReportCaster Console

The ReportCaster Console is the interface that provides access to the tools that administer the
Distribution Server and manage schedule job logs, blackout dates, and execution Ids.

Note: Throughout this section, the ReportCaster Console will be referred to as the Console.

Using the ReportCaster Console

The following tools are accessible from the Console.

Server Status

Job Status

Job Logs

Configuration

Blackout Periods

Global Updates
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Purge Logs

In WebFOCUS Business User Edition configurations licensed for ReportCaster, authorized
users can access the ReportCaster Console through the Administration Console, from the
Administration option on the menu bar, as shown in the following image.

Depending upon your privileges, these options are also available from the ReportCaster Status
option on the Tools menu, as shown in the following image.
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The Console intuitive ribbon displays in a new browser window, as shown in the following
image. The ribbon displays a tab for each tool the user is authorized to access.

Server Status

The Server Status tool allows Managers to select a Distribution Server to restart, suspend, or
stop. The tool also enables Managers to view traces or refresh data, as shown in the following
image.
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Viewing the Distribution Server Status

The Server Status tool, accessed by selecting the Server Status tab in the Console, enables
you to view the status of the Distribution Server. The Server Status tool also provides details
about the Distribution Server, such as the host name and port number, the status, and the
number of jobs that are running and in the queue. The Distribution Server information includes:

Distribution Server. The name used to identify the server in the Console. Primary is the
name given to the server listed in the ReportCaster Configuration tool setting (Primary
Distribution Server).

Note: When the Distribution Server attempts to make an SMTP connection to an Email
server, the connection will timeout after five minutes.

Host and Port. The host name and port number where the Distribution Server is installed.

Mode. The state and function of the Distribution Server. Options include:

Full Function. Indicates that the Distribution Server is up and functioning. When you
configure ReportCaster with a secondary Distribution Server, this indicates that the
server is acting as the primary Distribution Server.

Down. Indicates that the Distribution Server is stopped.

Running. The number of scheduled and on demand jobs that are currently running.

Queued. The number of scheduled and on demand jobs that are in the Distribution Server
queue.

Services. The services currently running on the Distribution Server. Options include:

Cache Cleaner. The Distribution Server uses this service to refresh the IBFS Cache. The
frequency at which the cache is refreshed is controlled by the setting
IBI_Repository_Sync_Interval in the Administration Console. 

Console. The Distribution Server uses this service to listen for communication from the
ReportCaster application or API.

Dispatcher. The Distribution Server uses this service to execute scheduled jobs.

Note: Depending on your server configuration, you may have one or more additional
Dispatchers listed in the Server Status Dialog box.

Reader. The Distribution Server uses this service to poll the Repository.
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Status. The status of each service currently running on the Distribution Server. Options
include:

Active. The service is active.

Ready. The service is available.

Standing By. The service is standing by.

Suspend. The service is suspended.

Listening. The Console service is actively listening.

Polling. The Reader service is active.

Monitoring. The Repository Monitor is active.

Waiting. Displayed when a job in the running queue is waiting for a connection to the
reporting server. Occurs when a multi-task schedule is started because a connection is
available to the reporting server in the first task but then waits because a connection is
not available to the reporting server in the second task.

From the Server Status interface, you can perform the following tasks:

Refresh. Retrieves the most current information and refreshes the Distribution Server
status with this information.

Restart. Recycles the Distribution Server and the Application Server.

Suspend. This option is always available. Suspends the Distribution Server services, but
the server remains running. When you suspend a server, the Suspend button label will
change to Resume.

Stop. Brings the Distribution Server completely down.

Note: When you stop the Distribution Server using this option, you must restart it from the
machine where it resides. You cannot restart the Distribution Server remotely.

View Trace. Allows you to view trace information for the scheduler.log, main.trc, reader.trc,
console.trc, and dispatcher.trc files. You can also turn the Distribution Server traces on or
off. For more information, see How to Turn Distribution Server Traces On or Off on page
149.

Note: Distribution Server traces are tracked separately from Job traces using this
functionality. You do not need to turn on job traces to see distribution server traces.

Help. Opens the Console Server Status online documentation.
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Procedure: How to Turn Distribution Server Traces On or Off

1. From the ReportCaster Console, select Server Status.

2. From the Distribution Server list, select a server.

3. On the toolbar, click the down arrow on the Server Log button.

4. Click Turn On Server Traces to turn the Distribution Server traces on, as shown in the
following image.

To disable the Distribution Server traces, follow steps 1 and 2, and then hover over Turn
On Server Traces and click Turn Off Server Traces.
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Separate Job Queues for Each Data Server

The Distribution Server has separate job queues for each Reporting Server, as well as an
additional queue for tasks that do not require a Reporting Server, as shown in the following
image. Therefore, there will always be at least one job thread available for each Reporting
Server, in addition to at least one thread for non-server based jobs. No one Reporting Server
can have all of the available job threads consumed by jobs associated with that server.

Viewing, Stopping, Suspending, and Restarting the Distribution Server

The Server Status interface enables you to stop and restart the Distribution Server, as follows: 

To stop the Distribution Server, click the Stop button. A window opens, asking you to
confirm that you want to stop the server. Click Yes.

Note: When you stop the Distribution Server using this option, the Server Status Restart
option cannot be used to restart the Distribution Server. To start the Distribution Server, log
on to the machine on which the Distribution Server is installed.

To suspend the Distribution Server, click the Suspend button. A window opens, asking you
to confirm that you want to suspend the server. Click Yes.

To restart the Distribution Server, click the Restart button. A window opens, asking you to
confirm that you want to restart the server. Click Yes.

When you restart the server, the Distribution Server and the ReportCaster Application are
restarted.

To obtain the most current information about the Distribution Server, click Refresh.
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Procedure: How to Restart a Server

1. Select a server that is running.

2. From the toolbar, click Restart to restart the server.

A window opens, asking you to confirm that you want to restart the server.

3. Click Yes.

Procedure: How to Suspend and Resume a Server

1. Select the server in Full Function mode.

2. On the toolbar, click Suspend.

A window opens, asking you to confirm that you want to suspend the server.

3. Click Yes.

The reader service is suspended and the toolbar button changes to Resume.

To resume polling the repository for schedules, click Resume. Click Yes to confirm.

Procedure: How to Stop a Server

1. Select a running server and click Stop.

A window opens, asking you to confirm that you want to stop the server.

2. Click Yes.

Job Status

Another resource for tracking schedules is the schedule job status. The schedule status
provides a list of scheduled jobs that are in the Distribution Server queue. Status information
includes the Schedule ID, the time it started running, and the status of the job.

The schedule information includes:

Job Id. The ID assigned to the job.

Schedule ID. A unique ReportCaster generated key assigned to the job when it was
scheduled.
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Description. The description provided when the schedule was created.

Priority. The priority level of the schedule. 1 is the highest and 4 is the lowest priority.

Start Time. The time that the schedule run began.

Owner. The name of the user who owns the schedule.

Status. The status of the scheduled job. It contains one of the following values:

Running. The scheduled job is currently running.

Queue. The scheduled job is waiting for a thread to become available to run the
request.

Server Name. The Reporting Server to which the job has been submitted.

Job Log

The Job Log tab enables you to view the logs of executed jobs belonging to you or to users
whose job logs you are authorized to see. You can view log and trace information, open job
logs, delete job logs, refresh job logs, or access related help for job logs on the Job Log tab.
You can also view log and trace information for the daily and on-demand Log Purge jobs. The
Log Purge log can be accessed from the system folder. The logs for other jobs can be
accessed under the folder of the user to whom the job belongs.

Note: The Job Log tab supports the functionality of a multiple selection, whereby you can open
or delete multiple files simultaneously.

The job logs information includes:

Job Id. The ID assigned to the job.

Start Time. The time that the schedule was run.

Job Duration(seconds). The amount of time needed to complete a job.

Job Status. The status of the job when it completed processing.

Success. No errors occurred during the scheduled job processing.

Error. One or more errors occurred during the scheduled job processing. No report was
generated or distributed.

Warning. One or more warnings occurred during the scheduled job processing. A report
was generated and distributed.
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ReportCaster Configuration

The Configuration tool enables Managers to view and manage the configuration of the
Distribution Server, Servlet (deployed in WebFOCUS Business User Edition web application)
interfaces and tools. Options that Managers can modify include Distribution Servers,
Repository Settings, General Preferences, Email Distribution, Notification, and other options,
as shown in the following image.

Configuration Icons

In the Configuration tab on the ReportCaster Console ribbon, a series of icons enable you to
perform the following tasks.

Note: When you select Configuration in the ReportCaster Console ribbon, the Manage
Configuration group displays on the left-hand side. Clicking Server Status, Job Status, Job Log,
or Blackout Periods will change the name and functionality of this group, depending where you
are in the interface. These options all appear in the Show group of the ribbon.

Manage Configuration group

Save. Saves any changes made to the configuration. You will receive a message asking
you to confirm the save. You must save the changes to the configuration settings as
part of the process to implement the change. For details, see Changing Configuration
Settings on page 156
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New. Creates a new Reporting Server. This option is only active when working in the
Data Servers folder.

Remove. Deletes a Reporting Server from the ReportCaster configuration. You will
receive a message asking you to confirm the deletion. This option is only active when
working in the Data Servers folder.

Test. Tests the connection to the selected server or repository. This option is only
active when working in the Data Servers, Repository Settings, and LDAP Settings
folders. You may be prompted for a user ID and password to connect to a specified
server. You will receive a message describing whether the test succeeded or failed.

Restart. Restarts the Distribution Server and ReportCaster to implement changes to the
server configuration. You can also select Restart from the Action menu. For more
information, see Changing Configuration Settings on page 156.

Tools group

Global Updates.

Authorized users can make global updates for the values stored in schedules and
distribution lists. Using the Global Updates interface, the following settings can be
updated:

Mail Server

FTP Server

Printer

Email Address

Email From

Library URL

Data Server

Notification Type

Notification Reply Address

Notification Subject

Notification Brief Message To

Notification Full Message To
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Purge Job Logs. Provides on-demand capability for purging logs. You can also specify a
number of days (past) for which to purge logs. For example, if you want to purge logs for
the past month, you would use the default number of days, which is 30. You can also
specify an option for traces: Default Traces, No Traces, or Trace On. For more
information, see How to Purge Logs on Demand on page 219.

Actions group

Refresh. Refreshes the settings to reflect the last saved configuration settings.

Help. Opens the online Help file. This option is only available when accessing the
configuration tool through the ReportCaster web application. It is not available when
accessing the tool from the Windows Programs menu or by running editit.bat or the UNIX
editit script file from the /utilities directory within the ReportCaster Distribution Server
installation.

Configuration Tab Folders

The Configuration tab provides access to configuration settings through the following folders:

Distribution Servers. Defines and configures the Distribution Server.

General Preferences. Specifies which distribution formats and methods will be available to
a user creating a schedule. In this folder, you can also specify if ReportCaster scheduling
options will include the ability to distribute a PDF file directly to a printer. For details on
these settings, see General Preferences on page 160.

Email Distribution. Configures email settings, such as the default email host, number of
attempts to distribute to an email host, and security information. For details on these
settings, see Email Distribution on page 166.

Notification. Configures notification settings, such as the notification email host and
default notification type. For details on these settings, see Notification on page 171.

Zip Settings. Provides settings to configure how Zip files will be created and named. For
details on these settings, see Zip Settings on page 174.

Other Schedule Defaults. Defines the default end date and time of a ReportCaster
schedule. For details on these settings, see Other Schedule Defaults on page 176.

Log Purge. Allows you to specify the time and period that log files will be automatically
purged. For details on these settings, see Log Purge on page 177.

2. Setting Up Your Environment

Online Help PDF  155



LDAP Setting. Allows you to configure ReportCaster self-service users to be authenticated
and authorized against an LDAP data source rather than the WebFOCUS Business User
Edition Repository. You can also configure ReportCaster to retrieve email address
information from an LDAP data source. For details on these settings, see LDAP Setting on
page 178.

Data Servers. Allows you to configure multiple Reporting Servers, including cluster servers.
For details on these settings, see Data Servers Settings on page 181.

Changing Configuration Settings

To implement changes to the ReportCaster server configuration settings, you must save the
changes, and then restart the Distribution Server and the ReportCaster web application. Use
the following steps to save any configuration changes.

1. After you make changes to any of the configuration settings within a Configuration folder,
click the Save icon in the Manage Configuration group toolbar.

A window opens, asking you to confirm the save.

2. Click OK.

A window opens, explaining that you must restart the Distribution Server and the
ReportCaster Web Application in order for the changes that you saved to take effect.

3. Click OK.

4. Click the Restart icon in the Manage Configuration toolbar.

A window opens, asking you to confirm that you want to stop all running jobs and restart.

5. Click Yes.

6. Notify all users that are currently logged that they must restart their sessions to obtain the
new configuration information. This is required because user sessions have information
cached pertaining to the ReportCaster configuration. The user interfaces must be restarted
to obtain any updated configuration information.

Changing Default User IDs

Several of the Configuration tab folders provide the option to change the default user ID

and/or password. To change a default user ID settings, click the  icon that appears to the
right of the setting field. This opens the User dialog box, where you can type a new user ID and
password. When your changes are complete, click OK to exit the User dialog box. Remember to
save your changes and restart the Distribution Server to implement any changes.
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Distribution Server Settings

The Distribution Servers folder, shown in the following image, contains the settings that define
and configure the Distribution Server. The Server Status option, located on the ribbon, provides
the ability to restart the Distribution Server, suspend distribution, stop distribution, switch
servers, and refresh data. For more information, see Server Status on page 146. 

The Distribution Servers folder contains the following configuration settings.

Setting Optional or Required/
Default Value

Descriptions and Possible Values

Primary Distribution Server section

Host Required. Host name of the primary Distribution
Server.

Port Required. Port number of the primary Distribution
Server.
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Setting Optional or Required/
Default Value

Descriptions and Possible Values

Reader Interval Required.

Default value is 1 minute.

Polling interval (in minutes) for the
ReportCaster Distribution Server to
check for scheduled jobs.

An acceptable value is any positive
integer from 1 to 999999. Negative
numbers and zero are not allowed.

Recovery Default value is OFF. On. During startup, the ReportCaster
Distribution Server recovers scheduled
jobs that were processed but not
completed.

Off (Default). During startup, the
ReportCaster Distribution Server does
not recover any scheduled jobs.
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Setting Optional or Required/
Default Value

Descriptions and Possible Values

Processing for No
Report to Distribute

Required.

Default value is Error.

Specifies whether the No Report to
Distribute message from the
WebFOCUS Reporting Server is
categorized as an error or a warning.
This is a global setting, relevant to all
schedules. Possible values are:

Error. The No Report to Distribute
message is categorized as an error
and the message is written to the
ReportCaster log report in red.
When the schedule has the
Notification option set to Error, the
Notification is sent.

Warning. The No Report to
Distribute message is categorized
as a warning and the message is
written to the log report (in orange)
as an informational message.
When the schedule has the
Notification option set to Warning,
no error notification is sent.

These settings also apply to burst
reports when there is a No Report to
Distribute message for an individual
burst value.

Max Messages per
Task from Data
Server

Required.

Default value is 1000

Controls the number of messages for
each task from the Data Server written
to the ReportCaster log file.

Setting Optional or Required/
Default Value

Descriptions and Possible Values

Scan-back section
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Setting Optional or Required/
Default Value

Descriptions and Possible Values

Scan-back Type Required.

Default value is On.

Possible values are:

On

Off

Reset Next Run Time

Scan-back Interval Default value is 15, 24
hour periods.

If the Distribution Server is unavailable
for a period of time, this is the number
of 24 hour periods (beginning with the
Distribution Server restart time) that
you want the Distribution Server to
scan for jobs not yet run and run them.

General Preferences

The General Preferences folder in the Configuration tab, as shown in the following image,
contains settings that determine which distribution formats and methods will be available to a
user. 
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The General Preferences folder contains the following configuration settings.

Setting Optional or
Required/Default
Value

Descriptions and Possible Values

Allow PDF
Distribution Directly
to a Printer

Required.

By default, this
option is selected.

When selected, PDF is a selectable format for
the Printer distribution method. This enables
a PDF file to be distributed directly to a
printer. The printer must have the appropriate
driver to print PDF files.

Distribution
Formats

Optional.

All formats are
enabled, by default.

Specifies what report and graph formats are
available to users.

Distribution
Methods

Optional.

All distribution
methods are
enabled, by default.

Specifies what distribution methods are
available to users.

Specifying Schedule Format Settings

The Distribution Formats setting in the General Preferences folder enables users to specify
what report and graph formats are available to users and groups. 

This setting only applies to WebFOCUS (Repository) procedures. By default, all report and
graph formats are enabled (selected). A minimum of one report or graph format must be
selected.

Note: If a Format is cleared after a schedule using that Format has been created, the schedule
will fail when it is run. A message in the log will indicate how to fix the problem.

Procedure: How to Specify Schedule Format Settings

1. In the General Preferences folder, click the icon to the right of the Distribution Formats
field.
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The ReportCaster - Report/Graph Formats dialog box opens, as shown in the following
image.

2. Using the Styled Formats drop-down list, you can select Specialized Formats, Non-styled
Formats, or Graph Images. Optionally, you can keep the default, Styled Formats.

By default, Styled Formats are displayed with each format type selected.

3. To enable or disable styled formats, select or clear the check box for one of the listed
formats.
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4. To enable or disable Non-styled Formats, which do not support styling using WebFOCUS
StyleSheet commands, select Non-styled Formats from the drop-down list. By default, the
Non-styled Formats are displayed with each format type enabled, as shown in the following
image.

5. To enable or disable graph images, which are created by a WebFOCUS BUE graph request,
select Graph Images from the drop-down list. By default, the graph image formats are
displayed with each format type enabled, as shown in the following image.
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6. When your selections are complete in the Report/Graph Formats dialog box, click OK.

The changes are saved and the Report/Graph Formats dialog box closes.

7. To implement the configuration changes, restart the Distribution Server and WebFOCUS
BUE web application.

Specifying Schedule Distribution Method Settings

The Distribution Methods setting, in the General Preferences folder, enables authorized users
to specify the distribution methods that are available to users and groups. If a method is
cleared after a schedule using that method has been created, and Only run schedules for
selected Distribution Method is selected, the schedule processing will not run the scheduled
tasks. A message in the log will indicate that the distribution method is not configured for use.
In addition, a schedule that has multiple distributions will not run if one of the distribution
methods is cleared in the Distribution Methods drop-down menu, in the General Preferences
folder, of the Configuration tab.

By default, all distribution methods are enabled (selected).

Note: A minimum of one distribution method must be selected.

The Repository option only appears if these products are enabled. Repository is an optional
product component that is installed with the WebFOCUS BUE Client.

Procedure: How to Specify Schedule Distribution Method Settings

1. In the General Preferences folder, click the icon to the right of the Distribution Methods
field. 
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The ReportCaster - Schedule Distribution Methods dialog box opens, as shown in the
following image.

2. To enable or disable specific distribution methods, select or clear the check box for one of
the listed options.

Note: At least one schedule distribution method must be selected.

3. Optionally, select the Only run schedules for selected Distribution Methods check box to
limit the schedules running to those that have at least one of the Distribution Methods
selected.

4. When your selections are complete in the Schedule Distribution Methods dialog box, click
OK.

The changes are saved and the Schedule Distribution Methods dialog box closes.

5. To implement the configuration changes, restart the Distribution Server and WebFOCUS
BUE web application.
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Email Distribution

The Email Distribution folder in the Configuration tab contains default email settings, email
retry options, and email security. The Email Distribution window is shown in the following
image.

The Email Distribution and Notification folder contains the following configuration settings.

Setting Optional or
Required/Default
Value

Descriptions and Possible Values

Inline Report
Distribution

Required.

The default value is
Allowed.

Specifies whether the Schedule tool will
enable the email distribution option to send
a report in the body of the email (inline).

Note: If this option is cleared after a
schedule using this option has been
created, the schedule will fail when it is run.
A message in the log will indicate how to fix
the problem.
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Setting Optional or
Required/Default
Value

Descriptions and Possible Values

Packet Email Required.

The default value is
Yes.

Controls how task output and burst content
are distributed through email.

Valid values are:

No. Each burst value or task output is
distributed in a separate email.

Yes. People receiving burst values or
output from tasks will receive a single
email with multiple attachments.

Burst. Each burst value in a distribution
list will generate a separate email for a
given email address. There may be one
or more attachments in the email,
depending on the number of tasks in the
schedule.

Allowed Email
Domains

The default value is
Off.

Contains the email domains that are
authorized in a distribution.

Note: Files containing email addresses
intended for distribution are also verified for
valid domains at schedule execution time. If
it contains a restricted address, then no
delivery is made to that address and an
error message is written to the log file.

Customize
Attachment
Message

Optional Provides the ability to specify a custom
message.

Default Attachment
Message

Required. Defines the default message used in your
Email Distribution. The message that you
define here displays in the Basic Scheduling
Tool.
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Setting Optional or
Required/Default
Value

Descriptions and Possible Values

Mail Server Defaults section

Mail Server Required. Name of the default mail server used to
distribute an email schedule.

You can also specify a port for Mail Host
using hostname:port. If you do not specify a
port or the port you specify is not present,
the default port is used.

This Server
Requires a Secure
SSL Connection

Optional. Select this check box if the specified mail
server uses SSL.

This Server
Requires a Secure
TLS Connection

Optional. Select this check box if the specified mail
server uses TLS.

This Server
Requires
Authentication

Optional. Select this check box if the specified mail
server requires authentication with a user ID
and password.

SMTP User Id/
Password

Required if the
mailhost is using
SMTP Authorization.

No default value.

User ID and password used to connect to
the mailhost.

Email Reply Defaults section

Mail From Optional. Default value for the email From field. This
can be any value.

Mail Reply Address Optional. Default email reply address when creating
an email schedule.

Email Retries section

Using the ReportCaster Console

168  Information Builders



Setting Optional or
Required/Default
Value

Descriptions and Possible Values

Email Retries The default value is
1.

Number of times the Distribution server will
try to connect to the email server to deliver
report output.

If the Distribution server is unable to
connect to the email server on the first try,
it will attempt to connect again after the
specified Email Retry Interval has passed. A
message for each attempt is written to the
log file.

Valid values are 0 through 9.

Email Retry
Interval(seconds)

The default value is
60 seconds.

Amount of time that the Distribution server
will wait between retries.

Valid values are 1 through 999.

Procedure: How to Configure Email Distribution

1. From the Tools menu, click ReportCaster Status.
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2. Click the Configuration button, as shown in the following image.

Note: Authorized users can also access the ReportCaster Configuration tool from the
Administration Console.

3. In the left pane, select the Email Distribution folder.

4. Populate the email distribution fields. You can:

Make changes to the current email settings. For more information, refer to the
preceding table.

Supply any default values that you would like to be available at schedule creation time.

5. If your mail server(s) require authentication or SSL or TLS, check the appropriate boxes
and enter the required credentials. For more information, see the Installation topic in the
Information Center.

6. Click Save.
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Notification

The Notification folder in the Configuration tab contains default notification settings. The
Notification window is shown in the following image.

The Notification folder contains the following configuration settings.

Setting Optional or
Required/Default
Value

Descriptions and Possible Values

Notification Defaults section
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Setting Optional or
Required/Default
Value

Descriptions and Possible Values

Notify Mail Server Optional. Name of the mail server that distributes the
notification email. If blank, ReportCaster
uses the Mailhost setting as the notification
mail server.

Tip: Information Builders recommends using
different mail servers for notification and
email distribution. This way, if there is a
problem with your Mailhost, notification will
still be sent. Having separate mail servers
ensures that you will be informed when the
default mail server falters.

You can also specify a port for the Notify
Mailhost using hostname:port. If you do not
specify a port or the port you specify is not
present, the default port is used.

Default Notify Type The default value is
Never.

Specifies whether to send notification of the
schedule status to a specified email
address. Possible values are:

Never. This is the default value.
ReportCaster does not send notification
of the schedule status under any
circumstance.

On Error. The specified users are
notified when errors are encountered
while running the schedule. Information
Builders recommends using the On Error
notification option.

Always. The specified user is always
notified when the schedule runs.
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Setting Optional or
Required/Default
Value

Descriptions and Possible Values

Enable Brief
Notification Only

Optional. Controls whether Full Notification is
available as a scheduling option. When this
check box is selected, you can only select
the Brief Notification option when you
schedule a report. Full Notification is not
available.

Note: Messages are displayed in the log
when Full Notification is disabled. If a
schedule is created before Full Notification
is disabled, when the schedule executes, a
Brief Notification will be sent, and a warning
will be displayed in the schedule log.

Procedure: How to Configure Notification

1. From the Tools menu, click ReportCaster Status.

2. Click the Configuration button, as shown in the following image.

Note: Authorized users can also access the ReportCaster Configuration tool from the
Administration Console.

3. In the left pane, select the Notification folder.
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4. Populate the notification fields. You can:

Make changes to the current notification settings. For more information, refer to the
preceding table.

Supply any default values that you would like to be available at schedule creation time.

5. Click Save.

Zip Settings

The Zip Settings folder in the Configuration tab, as shown in the following image, contains
settings for adding an extension to a distributed Zip file, the Zip encryption to use for
distribution. 
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The Zip Settings folder contains the following configuration settings.

Setting Optional or
Required/Default
Value

Descriptions and Possible Values

Add Zip Extension
to Filename if Not
Specified

Required.

By default, this
option is selected.

Controls whether or not the .zip file extension
will be automatically appended to the Zip file
name entered by the user in a schedule
distributed by email or FTP.

Select this option if you want to automatically
append .zip to the entered file name.

Do not select this option if you want to use
the file name as entered by the user and not
have .zip automatically appended to the file
name.

Zip Minimum with
Email Distribution

Required.

The default size is
in KB and set to 0.

Select either MB or KB and customize the
size of your file using the up and down
arrows.

Zip Encoding Optional. Specifies an encoding other than the default
encoding of the ReportCaster Distribution
Server platform. The encoding specified must
match the encoding used by WinZip or any
other Zip utility installed on the Distribution
Server.

Maximum
Concurrent
Compressions

Optional

The default value is
zero (0).

The total number of compression operations
that the Distribution Server will perform
simultaneously. If many running jobs include
a compression operation (for example,
zipping the output before sending), the
compression operations could consume all of
the available resources on the Distribution
Server. You can lower this number to prevent
this from occurring.
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Procedure: How to Configure Zip Settings

1. From the ReportCaster Tools menu, click ReportCaster Status.

2. Click the Configuration button.

Note: Authorized users can also access the ReportCaster Configuration tool from the
Administration Console.

3. In the left pane, select the Zip Settings folder.

4. Populate the Zip Settings fields using the information provided in the preceding tables.

5. If you want to produce zipped output that is encrypted and password protected, you can
use the Zip Encryption Password Plug-in. To use your own program to supply the password,
select Custom from the drop-down list and enter the name of the program in the Zip
Encryption Password Plug-in Name field. To use the default, select Default.

6. Click Save.

Other Schedule Defaults

The Other Schedule Defaults folder in the Configuration tab, as shown in the following image,
contains settings for Schedule End Date and Schedule End Time.

Note: Depending on your time zone, the default Schedule End Date may be set to Jan 1, 2100.
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The following table lists and describes the configuration settings available in the Other
Schedule Defaults folder.

Setting Optional or
Required/Default
Value

Descriptions and Possible Values

Schedule End Date Required. Clicking the drop-down menu displays a
calendar where you can select the schedule
end date.

Schedule End Time Required. Manually, you can enter an end time for the
schedule. Alternatively, use the arrows to
assign a schedule end time.

Log Purge

The Log Purge folder in the Configuration tab, as shown in the following image, contains
settings for purging log files, log purge periods, and log purge times.
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The Log Purge folder contains the following configuration settings.

Setting Optional or
Required/Default
Value

Descriptions and Possible Values

Purge Log at
Distribution Server
Start

Optional.

By default, the
check box is
unchecked.

When selected, log reports are automatically
purged each time the Distribution Server
starts. This is in addition to the scheduled log
purging that is set using the Log Purge Period
and Log Purge Time options.

Daily Scheduled Log Purge section

Log Purge Period
(Days)

Optional. Automatically purges individual log reports
when they are older than a set number of
days.

Log Purge Time Optional. Time at which log purging occurs.

LDAP Setting

ReportCaster can be configured to retrieve email address information from an LDAP data
source. The leading mail server software vendors use LDAP for storage of email information.
This includes Active Directory on Windows platforms. 
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The LDAP Setting folder in the Configuration tab, as shown in the following image, contains
settings to define LDAP server connection and security, as well as LDAP email settings.

The LDAP Settings folder contains the following configuration settings.

Setting Optional or
Required/Default
Value

Descriptions and Possible Values

General Setting section

Active Directory By default, this
option is not
selected.

Select if you are using the Active Directory
technology for LDAP.

Do not select if you are using any other
technology for LDAP.

Secure Connection
(SSL)

By default, this
option is not
selected.

Indicates whether or not SSL (Secure Sockets
Layer) is used to communicate with the LDAP
server.

LDAP Host There is no default
value.

Host name or IP address of your LDAP
directory server.
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Setting Optional or
Required/Default
Value

Descriptions and Possible Values

LDAP Port Default value is
389.

Port on which the directory server listens.

LDAP Search Base There is no default
value.

Filter for LDAP searches. Only the subtree
below the search base is available for LDAP
queries. For example, dc=ibi, dc=com.

Search Time Out Default value is
120.

Time, in seconds, that ReportCaster can
search an LDAP data source before timing
out.

Security Principal No default value. Service account of the user performing
authentication. The user must have sufficient
access rights to locate user entries in the
directory.

Select the icon to the right of this option to
open the User dialog box, where you can type
a user name and password.

LDAP Email Setting section

Email LDAP Enabled By default, this
option is not
selected.

Indicates whether ReportCaster is enabled to
retrieve email address information from an
LDAP data source.

Email Map Default value is
mail.

Attribute type for email entries.
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Setting Optional or
Required/Default
Value

Descriptions and Possible Values

Email User Filter Default value
provided is
dependent on the
LDAP Type
selected.

Filter for email entries to be retrieved. For
example:

(& (mailnickname=*)
(|(&(objectCategory=person)
(objectClass=user)(!(homeMDB=*))
(!(msExchHomeServerName=*)))
(&(objectCategory=person)
(objectClass=user)(|(homeMDB=*)
(msExchHomeServerName=*)))
(&(objectCategory=person)
(objectClass=contact))
(objectCategory=group)
(objectCategory=publicFolder)))

First Name Map Default value is
givenName.

Attribute for first name entries.

Last Name Map Default value is sn. Attribute for last name entries.

Data Servers Settings

The Data Servers folder in the Configuration tab contains settings to configure the Reporting
Servers associated with ReportCaster. Using the configuration settings in this folder, you can
also configure multiple Reporting Servers with ReportCaster. 

Note: Data Server connection information is stored in the WebFOCUS BUE Client, and not in
ReportCaster. ReportCaster runs scheduled procedures through the WebFOCUS BUE Client
which is installed with the Distribution Server. When a ReportCaster job is executed by the
WebFOCUS BUE Client, the alternate deferred server is used if an alternate deferred server is
defined.
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The following image shows the display in the right panel when the Data Servers folder is
selected. Initially, the default data server appears in this panel with information, such as the
data server name, URL (used to connect to the Reporting Server), the type of server, whether
or not it is the default server, and what security type it is using. When you add a data server
that ReportCaster can access, it will appear in this list.

The following image shows the configuration settings when you select a specific data server
under the Data Servers folder (in this example, EDASERVE).
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The Data Servers folder contains the following configuration settings.

Setting Optional or Required/
Default Value

Descriptions and Possible Values

Settings for the Data Servers folder:

Graph Agents The default value is 1. Optimizes the processing of graphs. Due to performance
considerations, Information Builders generally
recommends configuring this setting to 1 Graph Agent
for each concurrent graph report. However, your own
internal testing should determine the Graph Agent value
that best suits the business needs of your organization.

Graph Servlet URL Optional.

There is no default.

Overrides the default graph server setting and configures
graph image files to be created on the Application
Server.

Type the following value

http://hostname/context_root/
IBIGraphServlet

where:

hostname 

Is the host name of the Application Server where the
WebFOCUS BUE Client is installed.

context_root 

Is the site-customized context root for the
WebFOCUS BUE web application deployed on your
Application Server. ibi_apps is the default value.

This setting is available for WebFOCUS BUE Server and
WebFOCUS BUE procedures.

This setting should not be used when web server
security is enabled. This includes Basic authentication,
IWA, SSL, and third-party security products (such as
SiteMinder). In these cases, the web server security
settings can prevent WebFOCUS BUE from creating the
graph.
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Setting Optional or Required/
Default Value

Descriptions and Possible Values

Excel Servlet URL Default value is

http://localhost: 
8080/ibi_apps

Specifies the application server to be used to zip the file
components that comprise an EXCEL

®
 2007 file (.xlsx)

as follows:

&URL_PROTOCOL://servername/alias/
IBIEXCELSERVURL

where:

URL_Protocol

Is HTTP.

servername

Is the name of the application server where the
WebFOCUS BUE Client is installed.

alias

Is the context root of the WebFOCUS BUE
application. The default is ibi_apps.

This setting is available for WebFOCUS BUE Server and
WebFOCUS BUE procedures. This setting should not be
used when web server security is enabled. This includes
Basic authentication, IWA, SSL, and third-party security
products (such as SiteMinder). In these cases, the web
server security settings can prevent WebFOCUS BUE
from creating the Excel 2007/2010 file.

FOCEXURL/
FOCHTMLURL

Default value is

http://localhost:
8080

Specifies the host name and port of the FOCEXURL/
FOCHTMLURL.

Settings for an individual Data Server:

Name Required. Name of the selected Data Server.

Note: Data Server names are case-sensitive. Data
Servers are defined in the WebFOCUS BUE Client as
uppercase so you should also define Data Servers as
uppercase in ReportCaster.
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Setting Optional or Required/
Default Value

Descriptions and Possible Values

Default Required. This option is selected by default.

Set FOCEXURL/
FOCHTMLURL in the
scheduled
procedure

Required. This setting is selected, by default. If this setting is not
selected, the Distribution Server will not set the value of
FOCEXURL or FOCHTMLURL for a scheduled procedure.
Therefore, when cleared, if FOCEXURL or FOCHTMLURL
is already set in the edasprof.prf file, this setting
remains in effect, unless it is overridden in the
scheduled procedure.

Security section

Security Type By default, this option is set
to User.

Static. A valid Execution Id and password is supplied in
the User setting. When creating a schedule, you cannot
specify an Execution Id and password.

User. A valid Execution Id and password must be
specified when creating a schedule.

Shared. When creating a schedule, the user ID and
password is internally assigned as the Execution Id and
password.

Note: Since the actual password is not stored in the
WebFOCUS BUE repository, the Shared configuration can
only be used when a password is not required to
connect to the Reporting Server.

Trusted. The Execution Id is the schedule owner and no
password is sent to the WebFOCUS BUE Reporting
Server when schedules run.

Note: The Reporting Server must be a configured to
accept a Trusted connection when the Trusted option is
selected.

Graph section

Graph Engine Required. The value is
GRAPH53.

Controls which graph engine to use for server-side
graphics. By default, this specifies the GRAPH53 setting.
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Setting Optional or Required/
Default Value

Descriptions and Possible Values

Headless By default, this option is not
selected.

Determines whether a graphics card exists on the
WebFOCUS BUE Reporting Server. When not selected
(the default), a graphics card exists on the server. When
selected, no graphics card exists on the server.

Maximum
Connection/
Threads

Required.

The default connection is 3.

Maximum number of connections available to the
Reporting Server. You can specify a maximum of 20
connections.

This setting works in conjunction with the optional
Weight setting, enabling you to prioritize the alternate
servers in a cluster queue.

Configuring Reporting Servers With ReportCaster

You can configure multiple Reporting Servers with ReportCaster through the Data Server folder
in the ReportCaster Configuration tab. Although the installation program automatically
populates values for the default EDASERVE server, all additional Reporting Servers must be
added to the configuration manually. 

Note: If the default Reporting Server is changed on the Client, then the change will not be
effective until the period specified by the IBFS Cache Cleaner service or until the Distribution
Server is restarted. If the Distribution Server is installed on another machine with a separate
copy of the Client, then a change to the default Reporting Server will not be effective until the
same change is made on the Client installed on the same machine as the Distribution Server.
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Procedure: How to Add a Reporting Server

1. In the left panel of the Configuration tab, select the Data Servers folder, then select New in
the toolbar, as shown in the following image. 

Note: The default Data Server names are SERVER, SERVER 2, SERVER 3, and so on.

2. From the Available Data Servers dialog box, select one or more Data Servers, and click
OK. You can optionally select the Select All check box.

3. Double-click the new server node in either the Data Servers folder in the left panel or the
server list in the right panel.

The right panel displays the default properties for the selected server, as shown in the
following image.

4. Provide values for the appropriate settings.
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In the Name field, verify the name of the server you want to add to the ReportCaster
configuration is the same as the NODE setting for that server specified in the WebFOCUS
BUE Client Server Connections configuration. You can review the WebFOCUS BUE Client
Server Connections by accessing the Administration Console and selecting Reporting
Servers within the Configuration tab.

Optionally, provide values for the Security Type and Maximum Connections settings or
leave the default values in place.

You can also optionally set the Data Server being added to be the default Data Server
when new schedules are created, specify not to have the FOCEXURL and FOCHTMLURL
settings automatically added when scheduled jobs run, and specify that the Data Server
does not have a graphics card, is Headless.

5. To implement the changes in ReportCaster, in the Configuration tab toolbar, select Save,
then Restart.

Caution: Information Builders recommends that you avoid changing the name of a Reporting
Server, since all existing jobs on that server will no longer run.

Using Blackout Periods

Blackout Periods are those dates and times on which schedules will not run and cannot be set
to run. A user authorized to access the Blackout Periods tool can view, define, update, import,
export, and delete blackout periods. 
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To view schedule blackout periods, select Blackout Periods from the Show group in the
Console. The Blackout Periods interface, which is shown in the following image, provides a
calendar in the left panel and the right panel lists the blackout dates you are authorized to
manage.

Users authorized to manage blackout periods can add new blackout periods, delete blackout
periods, replace the description of existing blackout periods, and extract existing blackout
period information to a file for future use. In the ReportCaster Blackout Periods interface,
these tasks can be completed using the following features:

The Blackout Date and Time dialog box, accessed from the New and Edit buttons in the
Manage Blackout Periods group.

The Import Dates dialog box, accessed from the Manage Blackout Periods group.

The Extract Blackout Dates dialog box, accessed from the Manage Blackout Periods group.
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You can change the month or year using the arrows at the top of the calendar. Dates only
appear as available or unavailable. You can show or hide the left panel by clicking the arrow in
the top-right corner of the left panel. The following image shows the display with the left panel
hidden.

Reference: Blackout Period Configurations

Every type of Blackout Period profile shares the same basic settings: Group Assignment,
Name, Description, Details, and Blackout Time. Within that basic configuration, there are four
types of Blackout Periods that accommodate differing scheduling requirements. These include:

Weekly Blackout Periods. Recur on a specified day or days of the week.

Monthly Blackout Periods. Recur on a specified monthly date or dates.

Single Day Blackout Periods. Occur only once on a specified date.

Every Day Blackout Periods. Recur at a specified time every day.

This variety of profiles enables you to build blackout periods into your reporting schedule that
accommodate those regularly recurring and special one-day events that would cause you to
suspend reporting.

Reference: Basic Blackout Period Settings

The Blackout Date and Time dialog box contains settings that define the timing and frequency
of a scheduled Blackout Period. There are four variations of this dialog box to accommodate
the Weekly, Monthly, Single Day, and Every Day frequency options.
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The following table describes settings in the Global Blackout Date and Times profile.

Setting Optional or Required/Default
Value

Descriptions and Possible Values

Group Displays the name (Global). Displays the name (Global).

Name Optional.

By default displays the name:
Blackout-[Current Date] [Current
Time]

For example: Blackout-Jun 26
2015 10:27 AM

A descriptive name for the Blackout
Date and Time profile.

You can modify the default name by
clicking within the Name field.

Description Optional. A detailed description of the
Blackout Date and Time profile.

Details Label Assigned to the profile after
creation.

A summary of the detailed times
and frequency of the Blackout
Period.

This is a narrative description of the
selections you make in the Weeks,
Days, Months, and Blackout Time
fields.

ReportCaster creates this
description automatically when you
save the profile, and updates it
when you save changes to it. You
cannot create, edit, or delete it
directly.
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Setting Optional or Required/Default
Value

Descriptions and Possible Values

Blackout Time
check box

By default this check box is
cleared.

Selected. The Blackout Period
covers the hours specified in the
Start (Time) and End (Time) fields.

Not Selected. The Blackout Period
covers the entire day.

Note: If you change a profile from
Single Date to any other frequency
setting, you must clear this check
box if the blackout period is to cover
the entire day.

Start (Time) Optional. By default, displays
the current hour and minute.

The Hour and Minute in which a
Blackout Period is to begin.

This value is relevant only if the
Blackout Time check box is
selected.

End (Time) Optional. By default, displays
the time two hours after the
current hour and minute.

The Hour and Minute in which a
Blackout Period is to end.

This value is relevant only if the
Blackout Time check box is
selected.

Frequency Required. By default, the Weekly
option is selected.

Weekly. Blackout periods that recur
on a specified day of the week.

Monthly. Blackout periods that
recur on a specified monthly date.

Single Day. Blackout periods that
occur once on a specified date.

Every Day. Blackout periods that
recur at a specified time every day.
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Procedure: How to Configure a Blackout Period

To configure a blackout period:

1. From the Manage Blackout Periods group on the ribbon, click New.

The Blackout Date and Time dialog box opens, as shown in the following image.

2. Accept the default Name assigned to the Blackout Period profile or enter a new value for
Name.

3. Type a description for the Blackout Period profile in the Description field.

4. If this blackout period must cover the entire day, leave the Blackout Time check box
cleared and skip to step 7.

5. If this blackout period must be limited to a range of hours within a day, select the Blackout
Time check box and configure the start and end time for the Blackout Period.

For more information, see How to Configure a Start Time and End Time for a Blackout
Period on page 202.
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6. Click the appropriate frequency option:

Weekly. Establish the frequency for the blackout period. For configuration information,
see Configuring Weekly Blackout Periods on page 194.

Monthly. Establish the frequency for the blackout period. For configuration information,
see Configuring Monthly Blackout Periods on page 197.

Single Day. Select the date for the blackout period. For configuration information, see 
Configuring Single Day Blackout Periods on page 200.

Every Day. Establish the hours for the daily blackout period. For configuration
information, see Configuring Every Day Blackout Periods on page 201.

7. Review your configuration.

If your configuration of dates and hours is unacceptable, the OK button will not
respond when you attempt to click OK. Adjust your configuration and refresh the profile
by clearing and reselecting the recurring check boxes.

If your configuration is acceptable, the OK button will be available, and the Details
label will include a description summarizing your selections.

8. When your configuration is complete, click OK.

An entry for the Blackout Profile appears in the right pane of the Blackout Dates window
and the Blackout Date Calendar in the left pane highlights the new blackout dates.

Configuring Weekly Blackout Periods

The Weekly Blackout Period configuration bases its recurrence on a specified day of the week.
It suits events that recur as part of a weekly schedule, regardless of the date on which that
day falls.

Even though the name implies that this Blackout Period occurs only once a week, Blackout
Periods using the weekly configuration can occur more or less frequently.

The tools in this configuration enable you to specify:

The day, or days, of the week on which the blackout period will occur.

The week, or weeks, of the month in which the blackout period will occur.

The month, or months, of the year in which the blackout period will occur.
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Instead of requiring you to enforce blackout periods on the same day each and every week,
this flexible configuration enables you to schedule Blackout Periods that occur more than once
a week. It also enables you to configure Blackout Periods that skip one or more weeks in a
month or skip one or more months in a year.

Weekly Blackout Period Settings

If you select the Weekly option, the Blackout Date and Time dialog box displays a unique set of
options that enables you to schedule Blackout Periods for specified days of the week.

Setting Optional or Required/
Default Value

Descriptions and Possible Values

On

Week of the Month
Check Boxes (Left
Column)

Required (At least one
selection from this
column.)

The week of the month check boxes
list ordinal weeks of the month. When
you select one, you define the week of
the month in which this blackout period
is to occur. That is, the first week of
the month, the second week, and so
on.

You can select one or more individual
weeks.

The Select All check box automatically
selects every week of the month,
establishing a blackout period that
takes place every week in a month.
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Setting Optional or Required/
Default Value

Descriptions and Possible Values

On

Days of the Week
check boxes (Right
Column)

Required (At least one
selection from this
column).

The day of the week check boxes list
the days of the week. When you select
one, you define the day of the week in
which this blackout period will occur.
That is, on Monday, Tuesday, and so
on.

You can select one or more individual
days.

The Select All check box automatically
selects every day of the week,
establishing a blackout period that
takes place every day of your selected
weeks in the month.

Months Required (At least one
selection from this
group).

The Month check boxes list the months
of the year. When you select one, you
define the month of the year in which
this weekly black out period will occur.
That is, in January, February, and so
on.

You can select one or more individual
months.

The Select All check box automatically
selects every month of the year,
establishing a blackout period that
takes place during every month on your
selected week and day.

Procedure: How to Configure Weekly Blackout Period Settings

To configure weekly blackout period settings:

1. From the Blackout Date and Time dialog box, click Weekly.
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The dialog box displays check boxes that support the Weekly frequency schedule, as
shown in the following image.

Note: In order to enable the OK button and save the profile, you must select at least one
week, day, and month check box.

2. Select the check boxes for the week or weeks of the month in which the Blackout Period is
to occur, or click Select All to select every week automatically.

3. Select the check boxes for the day or days of the week on which the Blackout Period is to
occur, or click Select All to select every day of the week automatically.

4. Select the check boxes for the month or months in which the Blackout Period is to occur,
or click Select All to select every month automatically.

Configuring Monthly Blackout Periods

The Monthly Blackout Period configuration bases its recurrence on a specified monthly date. It
suits events that recur on the same date, regardless of the day of the week on which that date
falls.

Even though the name implies that this Blackout Period occurs only once a month, Blackout
Periods using this configuration can occur more or less frequently. They can occupy the entire
day, or they can be limited to a range of hours within a single day.

The tools in this configuration enable you to specify:

The day, or days, of the month on which the blackout period will occur.

The month, or months, of the year in which the blackout period will occur.
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Instead of requiring you to enforce blackout periods on the same day of the month, each and
every month, this flexible configuration enables you to schedule Blackout Periods that occur
more than once a month. It also enables you to configure Blackout Periods that skip one or
more months.

Monthly Blackout Period Settings

If you select the Monthly option, the Blackout Date and Time dialog box displays a unique set
of options that enables you to schedule Blackout Periods for specified dates of the month.

Setting Optional or
Required/Default
Value

Descriptions and Possible Values

Days Required. The Days check boxes list the dates within a
month. When you select one, you define the
day of the month on which this blackout period
will occur. That is, on the first day of the
month, the second, the third, and so on.

You can select one or more individual dates.

The Select All option automatically selects
every day of the month, establishing a
blackout period that takes place every day
during your selected months.

Months Required. The Months check boxes list the months of
the year. When you select one, you define the
month in which this black out period will occur.
That is, in January, February, and so on.

You can select one or more individual months.

The Select All option automatically selects
every month of the year, establishing a
blackout period that takes place during every
month on your selected day or days.
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Procedure: How to Configure Monthly Blackout Period Settings

To configure monthly blackout period settings:

1. From the Blackout Date and Time dialog box, click Monthly.

The Blackout Date and Time dialog box displays the check boxes that support the Monthly
frequency, as shown in the following image.

Note: At a minimum, you must select a check box for one day and a check box for one
month. Until you do, the OK button will be unavailable, and you will be unable to save the
profile.

2. Select the check boxes for the day or days of the month on which the Blackout Period is to
occur, or click Select All to select every date in the month automatically.

3. Select the check boxes for the month or months in which the Blackout Period is to occur,
or click Select All to select every month automatically.
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Configuring Single Day Blackout Periods

Single Day Blackout Periods occur once, on a single, specified date. They can occupy the
entire day, or they can be limited to a range of hours within a single day. The settings for
Single Day Blackout Periods are shown in the following image.

Single Day Blackout Period Settings

If you select the Single Day option, the Blackout Date and Time dialog box displays a copy of
the Blackout Dates calendar, which enables you to select a single date for a scheduled
Blackout Period.

Procedure: How to Configure Single Day Blackout Period Settings

1. From the Blackout Date and Time dialog box, click Single Day.

The dialog box appears, displaying the calendar automatically set to the current date.
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2. Click the single arrows to change the month and click the double arrows to change the
year.

3. When you have found the month and year for the scheduled single day blackout period,
click on the date on which you want the Blackout Period to occur.

The calendar highlights the new date.

Configuring Every Day Blackout Periods

Every Day Blackout Periods recur every day. To prevent Every Day Blackout Periods from
blocking the release of any reports, you must limit them to a range of hours within the day. The
settings for Every Day Blackout Periods are shown in the following image.
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Every Day Blackout Period Settings

If you select the Every Day option, the Blackout Date and Time dialog box limits its display to
the Beginning and End time for the Blackout Period. No other options are relevant.

Procedure: How to Configure Every Day Blackout Period Settings

1. From the Blackout Date and Time dialog box, click Every Day.

The Blackout Time check box is selected automatically, and the dialog box displays a note
reminding you to select the start and end time.

The Start time is automatically set to the current time, and the End time is automatically
set to a value two hours later.

2. To change the Start or End Time values, see How to Configure a Start Time and End Time
for a Blackout Period on page 202.

Procedure: How to Configure a Start Time and End Time for a Blackout Period

From the Blackout Date and Time dialog box:

1. To change the hour of the start time, click in the Hour section of the Start field.

a. Click the up or down arrow to move the value ahead one hour or back one hour,
respectively.

b. You can also type the hour in this section, but be careful to stay within the twelve
hour range. If you enter a value outside of this range, the dialog box will automatically
recalculate your value in terms of a twelve hour clock. For example, 44 hours would
become 8. (44-(12X3))=(44-36)=8

c. Ensure that the start time is earlier than the end time.

2. To change the minutes of the start time, click in the Minutes section of the Start field.

a. Click the up or down arrow to move the value ahead one minute or back one minute,
respectively.

b. You can also type the minutes in this section, but be careful to stay within the sixty
minute range. If you enter a value outside of this range, the dialog box will
automatically recalculate your value in terms of the number of minutes within an hour.
For example, 88 minutes would become 28. (88-60) = 28).

c. Ensure that the start time is earlier than the end time.

3. To change the start time from AM to PM, click in the AM/PM section of the Start field.

a. Click the up arrow to move from AM to PM.

b. Click the down arrow to move from PM to AM.
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c. You can also type AM or PM directly into this section.

4. To change the hour of the end time, click in the Hour section of the End field.

a. Click the up or down arrow to move the value ahead one hour or back one hour,
respectively.

b. You can also type the hour in this section, but be careful to stay within the twelve
hour range. If you enter a value outside of this range, the dialog box will automatically
recalculate your value in terms of a twelve hour clock. For example, 44 hours would
become 8. (44-(12X3))=(44-36)=8.

c. Ensure that the end time is later than the start time.

5. To change the minute of the end time, click in the Minutes section of the End field.

a. Click the up or down arrow to move the value ahead one minute or back one minute,
respectively.

b. You can also type the minute in this section, but be careful to stay within the sixty
minute range. If you enter a value outside of this range, the dialog box will
automatically recalculate your value in terms of the number of minutes within an hour.
For example, 88 minutes would become 28. (88-60 = 28).

c. Ensure that the end time is later than the start time.

6. To change the end time from AM to PM, click in the AM/PM section of the End field.

a. Click the up arrow to move from AM to PM.

b. Click the down arrow to move from PM to AM.

c. You can also type AM or PM directly into this section.

Important: You must use the right or left arrow keys to move between the Hour, Minutes,
and AM/PM sections of the Start and End fields.

If you try to use the Tab key to move between sections, you will move down to the next
option instead of across to the next section of the Start or End field.

For example, if you use the Tab key to move from the Hours section of the Start field, you
will move down to the Hours section of the End field, not over to the Minutes section of
the Start field. To move right, you must use the right direction key instead.

Similarly, the Shift+Tab key combination will move you to the previous option, not back to
a previous section within the Start or End field. To move left, you must use the left
direction key instead.

Procedure: How to Delete a Blackout Period Profile

1. In the left pane of the Blackout Dates dialog box, click the folder for the Group to which
the Blackout Period profile you want to delete is assigned.
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2. In the right pane, click the entry for Blackout Period profile you want to delete, as shown in
the following image.

3. On the ribbon, in the Manage Blackout Periods group, click Delete.

4. When you receive a confirmation message, click Yes, as shown in the following image.

Your newly deleted entry disappears from the right pane and the dates assigned to that
entry are no longer highlighted on the Blackout Dates calendar in the left pane.

Importing Blackout Periods

You can use the Blackout Period Import operation to automate Blackout Period management
tasks. Using a properly formatted import file with this tool, you can:

Create new Blackout Period profiles.

Remove Blackout Period profiles.

Enrich Blackout Period information.
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Note: All imported files must contain UTF-8 (National Language Support) character encoding to
upload correctly.

The source file for the import contains the following information about a Blackout Period
Profile:

Date. The date on which the Blackout Period profile becomes effective. This date can be
omitted for Every Day Blackout Period profiles.

Start Hour. The time (HH:MM:SS) at which the Blackout Period becomes effective. This
value is optional for all but Every Day Blackout Period profiles.

End Hour. The time (HH:MM:SS) at which the Blackout Period ceases to be effective. This
value is optional for all but Every Day Blackout Period profiles.

Description. A detailed description of the Blackout Period profile.

Name. The unique name assigned to a Blackout Period profile.

Note: Additional Codes precede entries for Weekly or Monthly Blackout Period profiles. For
more information, see Weekly Blackout Period Import File Entry Layout on page 206 and 
Monthly Blackout Period Import File Entry Layout on page 207.

The task you select when you run an import operation determines the way in which
ReportCaster uses the information in the source file for the Import.

If you select:

Add, the import creates new Blackout Period profiles from the records in the import source
file.

Remove, the import compares date and additional information in import file records to that
of existing Blackout Period profiles and removes those profiles that match the file records.

Replace, the import compares date information in import file records to that of existing
Blackout Period profiles and adds Name and Description information to them.

Use the actions specified in the file, the import runs the add, remove, and replace
operations as required by commands included in the Import file along with entries for the
Blackout Period profiles affected by them.

The automation of these tasks frees you from manually creating, updating, or deleting Blackout
Period profiles when operational changes, such as monthly, quarterly, or annual operation
schedule updates, require a sweeping review and revision of your reporting schedule.
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For example, at the start of the year, you have a file containing the dates and names of all
scheduled holidays that must be incorporated into your reporting schedule. The Blackout
Period Import enables you to import that file and establish the holiday blackout schedule for an
entire year in a single operation. Without the import you would have to create a Single Date
Blackout Date and Time profile for each holiday in the coming year.

Viewing Blackout Period Import File Format

Even though entries in the Import File format for Blackout Period records use the same basic
structure, each profile type contains minor variations that identify the type of Blackout Period
profile ReportCaster must create from the entry details.

Single Date Blackout Period Import File Entry Layout

You can import Single Date Blackout Date and Time profiles from a flat file that lists the
information for each profile on a separate line. Each line must follow the following layout:

[Date]/[Start Hour]| [End Hour] [Description]|[Name]

For example:

20150629/08:59:00|10:59:00 Report Blackout for June 29th Only|Special 
One Day Blackout - June 29th 

Dates use the format YYYYMMDD

Hours use the format HH:MM:SS

You can omit the hours to schedule an all day blackout.

The Weekly, Monthly, and Every Day Blackout Date and Time profiles use a variation of this
format.

Weekly Blackout Period Import File Entry Layout

You can import Weekly Blackout Date and Time profiles from a flat file that lists the
information for each profile on a separate line. Each line must follow the following layout:

[Blackout Pattern] [Description]|[Name]

For example:

[111111111111/10000:0000010]/17:00:00|23:59:00 Report Blackout First 
Friday of Every Month 5:00 PM to 11:59 PM|First Friday Afternoons
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This information identifies the entry as a Weekly Blackout Period, and includes its Description
and Name. The Blackout Pattern indicates the selected Month(s) and Selected Day(s) of the
Week. A '1' means that a month or day is selected. A '0' means that a month or day is not
selected.

Monthly Blackout Period Import File Entry Layout

You can import Monthly Blackout Date and Time profiles from a flat file that lists the
information for each profile on a separate line. Each line must follow the following layout:

[Blackout Pattern]/[Start Hour]|[End Hour] [Description]|[Name]

For example:

[111111111111/10000:0000010]/17:00:00|23:59:00 Report Blackout First 
Friday of Every Month 5:00 PM to 11:59 PM|First Friday Afternoons

This information identifies the entry as a Monthly Blackout Period, and includes its Description
and Name. The Blackout Pattern indicates the selected Month(s) and Selected Day(s) of the
Month. A '1' means that a month or day is selected. A '0' means that a month or day is not
selected.

Every Day Blackout Period Import File Entry Layout

You can import Every Day Blackout Date and Time profiles from a flat file that lists the
information for each profile on a separate line. Each line must follow the following layout:

/[Start Hour]|[End Hour] [Description]|[Name]

For example:

/21:04:00|23:04:00 Every Day Blackout between 3:00 PM and Midnight|
Daily Afternoon Blackout

This information identifies the entry as an Every Day Blackout Period and includes its
Description and Name.

Procedure: How to Add Blackout Period Profiles Using an Import File

To add a Blackout Period profile through the import is to create a new Blackout Period profile
from information in the import file. Your Import file must therefore contain records for all
Blackout Period profiles you want to add to ReportCaster through this import operation.

1. In the Blackout Dates pane, click the folder of the group for which you are importing
Blackout Period profiles.
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2. On the ribbon, in the Manage Blackout Periods group, click Import.

3. In the File Name field, type the full path to the file, or click Browse and navigate to the file
you want to import.

4. Click Add, and click OK.

The Import Blackout Data dialog box opens, listing details of the new Blackout Profiles
based on each entry in the Import file as shown in the following image.

5. Click Add to add the new Blackout Period profiles listed in the Import Blackout Data dialog
box to the Blackout Dates Calendar and Group entries.
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A message displays, informing you that the blackout dates have been successfully
imported, as shown in the following image.

6. Click OK.

The Blackout Dates calendar highlights the newly imported Blackout Period Dates in the
left pane of the Blackout Dates window and entries for the new Blackout Period profiles
appear in the right pane, as shown in the following image.

Procedure: How to Replace Blackout Periods Using an Import File

To replace a Blackout Period profile through the import is to add updated information to its
Name and Description fields. To ensure that the import-based update affects the proper
profiles, your Import file must contain records whose dates match those of the existing
Blackout Period profiles that must be enriched by this Import operation.
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Note: You must use this procedure to update or enrich information assigned to a Blackout
Period profile created from an Import.

1. In the right pane of the Blackout Dates dialog box, select the group for which you are
importing Blackout Period profiles.

2. On the ribbon, in the Manage Blackout Periods group, click Import.

The Import Dates dialog box opens, as shown in the following image.

3. In the File Name field, type the full path to the file, or click Browse and navigate to the file
you want to import.

4. Click Replace, and then click OK.

The Import Blackout Data dialog box opens, listing the details from each entry in the
Import file that will be added to their corresponding Blackout Period profiles.

5. Click Replace to add new the information listed in the Import Blackout Data dialog box to
the designated Blackout Period profiles.

A message displays, informing you that the blackout dates have been successfully
imported, as shown in the following image.
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6. Click OK.

Enriched entries for the updated Blackout Period profiles appear in the right pane.

Procedure: How to Remove Blackout Periods Using an Import File

Removing a Blackout Period profile through the import deletes it. To ensure that the import-
based deletion affects the proper profiles, your Import file must contain records whose dates
match those of the existing Blackout Period profiles that are to be deleted by this Import
operation.

1. In the Blackout Dates tab pane, select the group containing blackout period profiles that
must be removed.

2. On the ribbon, in the Manage Blackout Periods group, click Import.

The Import Dates dialog box opens, as shown in the following image

3. In the File Name field, type the full path to the file, or click Browse and navigate to the file
you wish to import.

4. Click Remove, and then click OK.

The Import Blackout Data dialog box opens, listing details from each entry in the Import
file that successfully matched an existing Blackout Period profile.

5. Click Remove to delete those Blackout Period profiles listed in the Import Blackout Data
dialog box.

A window opens, informing you that the blackout dates have been successfully imported.

6. Click OK.
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Blackout Period profiles removed by this operation are no longer highlighted in the left
pane of the Blackout Dates window or as entries for the new Blackout Period profiles in
the right pane, as shown in the following image.

Procedure: How to Manage Multiple Blackout Period Updates Using an Import File

The Use the actions specified in the file option allows the import process to add, remove, and
replace multiple Blackout Period profiles in a single operation. Your Import file must therefore
contain the all necessary commands followed by entries representing Blackout Period profiles
that must be added, removed, or enriched by the import operation.

1. In the right pane of the Blackout Dates dialog box, select the group for which you are
managing Blackout Period profiles.

2. On the ribbon, in the Manage Blackout Periods group, click Import.

The Import Dates dialog box opens.

3. In the File Name field, type the full path to the file, or click Browse and navigate to the file
you want to import.

4. Click Use the actions specified in the file, and then click OK.

The Import Blackout Data dialog box opens, listing details from each entry in the Import
file and a note about its proposed update.

5. Click OK.

6. When you receive the Blackout Dates have been successfully imported message, click OK.
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The Blackout Dates calendar highlights the dates of the newly imported Blackout Periods
in the left pane of the Blackout Dates window. Entries for the new and enriched Blackout
Period profiles appear in the right pane. Calendar highlights and entries for profiles
removed by the Import no longer appear.

Note: You will be unable to use the Edit command to update Blackout Period profiles
created from a direct file import. You will be required to update these profiles using the
Replace option in the Import operation.

Extracting Blackout Period Profiles

You can extract existing blackout period profile information from the ReportCaster
Development Interface to a .txt file.

A direct file extract minimizes the time it would take to transfer information about multiple
Blackout Periods to a text file that can serve as a backup of your Blackout Calendar
configuration or as the source of an import to an external system for reporting or auditing
purposes.

For example, if your group is required to maintain a backup copy of blackout dates for the
coming six months, the extract operation enables you to transfer the Description, Date, and
Name of all scheduled blackout periods during that time. You can recreate basic information
about these profiles from the backup file in an emergency, shortening the time required to
reconstruct your reporting schedule.

Extracting File Formats

The Import and Extract file operations use the same layout and format conventions. The
Extract file contains additional comments that document the range of dates selected for the
extract and templates for the format of the entries it contains, as shown in the following
image.

For more information about each entry type layout, see Viewing Blackout Period Import File
Format on page 206.
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Procedure: How to Extract Schedule Blackout Period Profiles to a File

To extract schedule blackout period profiles:

1. In the Blackout Dates pane, select the group from which you are extracting blackout period
profiles.

2. In the Manage Blackout Periods Toolbar group, click Extract.

The Extract Blackout Dates dialog box opens. The Group Name from which you are
extracting the blackout dates appears at the top of the dialog box, as shown in the
following image.

3. Select one of the following from the Date Range Options:

All to extract all currently saved blackout period profiles.

Date Range to specify the range of dates containing scheduled blackout period profiles
that you want to extract.

If you select Date Range, type or select the Start Date and End Date. To select a date,
click the down arrow next to the field. A calendar opens, from which you can choose a
date.

4. Click OK.

5. To open the file, click the Open button when your browser presents it.
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A window opens, displaying the contents of the extracted content profiles, as shown in the
following image.

You can save and close the file using the commands in the File menu.

6. To accept an automatic download of the extract file, click the Save button (users of Google
Chrome need only close the page displaying the new file name).

You can later retrieve the file from the Downloads folder of your computer, rename it if
necessary, and save a copy of it in another folder for archival or other purposes.

7. To rename and save the file in a different location, click the Open or Open With button,
and select the Save As command from the program that opens the file.

8. From the Save As window, navigate to the folder in which you want to save the file, rename
the file if necessary, and click Save.

You can close any additional web pages that may remain open after you save the file.

Note: The default extract file name is rcbdextract_GroupName_YYMMDD_HHMMSS.txt,
where GroupName is the name of the group from which the blackout dates are extracted,
YYMMDD and HHMMSS are the date (year, month, day) and time (hour, minute, second)
that the file was created.

Global Updates

Authorized users can make global updates for the values stored in schedules and distribution
lists. Using the Global Updates interface, the following settings can be updated:

Mail Server

FTP Server

Printer

Email Address

Email From

Library URL
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Data Server

Notification Type

Notification Reply Address

Notification Subject

Notification Brief Message To

Notification Full Message To

Procedure: How to Make a Global Update for a Mail Server

1. In the Global Updates interface, click the Setting drop-down list and select Mail Server (the
default).

2. Type the existing Mail Server in the Old Value box.

3. Type the new Mail Server in the New Value box.

4. Click Update to update the new Mail Server value in schedules and distribution lists.

Procedure: How to Make a Global Update for an FTP Server

1. In the Global Updates interface, click the Setting drop-down list and select FTP Server.

2. Type the existing FTP Server in the Old Value box.

3. Type the new FTP Server in the New Value box.

4. Click Update to update the new FTP Server value in schedules and distribution lists.

Procedure: How to Make a Global Update for a Printer

1. In the Global Update interface, click the Setting drop-down list and select Printer.

2. Type the existing Printer in the Old Value box.

3. Type the new Printer in the New Value box.

4. Click Update to update the new Printer value in schedules and distribution lists.

Procedure: How to Make a Global Update for an Email Address

1. In the Global Update interface, click the Setting drop-down list and select Email Address.

2. Type the existing Email address in the Old Value box.

3. Type the new Email address in the New Value box.
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4. Click Update to update the new Email address value in schedules and distribution lists.

Procedure: How to Make a Global Update for an Email From

1. In the Global Update interface, click the Setting drop-down list and select Email from.

2. Type the existing Email from in the Old Value box.

3. Type the new Email from in the New Value box.

4. Click Update to update the new Email from value in schedules and distribution lists.

Procedure: How to Make a Global Update for a Library URL

1. In the Global Update interface, click the Setting drop-down list and select Library URL.

2. Type the existing Library URL in the Old Value box.

3. Type the new Library URL in the New Value box.

4. Click Update to update the new Library URL value in schedules and distribution lists.

Procedure: How to Make a Global Update for a Notification Type

1. In the Global Updates interface, click the Setting drop-down list and select Notification
Type.
The notification options are:

Never. ReportCaster will not send a notification of the schedule status under any
circumstances. This is the default value.

Always. Send a notification each time the schedule runs.

On Error. Only send a notification when there is an error running the schedule.

For more information, see Notification Options in the Basic Scheduling Tool

2. Select the existing value in the Old Value box.

3. Select the new value in the New Value box.
If the Old Value is Never, then the Reply Address, Subject, Brief Message To, and Full
Message To fields will display. Provide each field with the necessary information.

4. Click Update to update the new Notification Type value in schedules and distribution lists.

Procedure: How to Make a Global Update for a Notification Reply Address

1. In the Global Updates interface, click the Setting drop-down list and select Notification
Reply Address.

2. Type the existing Notification Reply Address in the Old Value box.
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3. Type the new Notification Reply Address in the New Value box.

4. Click Update to update the new Notification Reply Address value in schedules and
distribution lists.

Procedure: How to Make a Global Update for a Notification Subject

1. In the Global Updates interface, click the Setting drop-down list and select Notification
Subject.

2. Type the existing Notification Subject in the Old Value box.

3. Type the new Notification Subject in the New Value box.

4. Click Update to update the new Notification Subject value in schedules and distribution
lists.

Procedure: How to Make a Global Update for a Notification Brief Message To

1. In the Global Updates interface, click the Setting drop-down list and select Notification
Brief Message To.

2. Type the existing Notification Brief Message To in the Old Value box.

3. Type the new Notification Brief Message To in the New Value box.

4. Click Update to update the new Notification Brief Message To value in schedules and
distribution lists.

Procedure: How to Make a Global Update for a Notification Full Message To

1. In the Global Updates interface, click the Setting drop-down list and select Notification Full
Message To.

2. Type the existing Notification Full Message To in the Old Value box.

3. Type the new Notification Full Message To in the New Value box.

4. Click Update to update the new Notification Full Message To value in schedules and
distribution lists.

Purge Logs

The Purge Logs functionality provides on-demand options for purging logs, including the ability
to specify a number of days (past) for which to purge logs. For example, if you want to purge
logs for the past month, you would use the default number of days, which is 30. You can also
specify an option for traces: Default Traces, No Traces, or Trace On.
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Procedure: How to Purge Logs on Demand

1. From the Tools group in the ReportCaster Console, click Purge Logs.

The Purge Logs dialog box displays, as shown in the following image.

2. In the Purge Logs older than (days) field, accept the default number of days or specify
another value. The default number of days is 30.

3. Under Trace Options, you can accept the default of Default Traces, or select No Traces or
Trace On.

4. Click OK.

Working With Domains

The BUE uses Domains, and the groups of users they define, to support workgroups. Domains
enable users to maintain private content, to share that content if their user role permits, and
to access governed content published by others. Domains are available to multiple users, who,
based on their role, have access to their own view of the Domain. This built-in workgroup
security makes your data analysis and reporting activities easier to configure and manage. 

In the Resources tree, Domains appear as root-level folders under the Domains node.

Domains comprise a collection of groups, an Application folder on the Reporting Server, and a
set of rules that makes them all work together in a single workgroup. Domains partition
content and metadata, and enable Managers to organize and store your content in the BUE
portal. They are the place where Developers and Advanced Users create and manage content.
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Procedure: How to Create a Domain

Only a Manager can create a Domain.

1. In the Resources tree, right-click Domains, point to New, and then click Domain.

The New Domain dialog box opens.

2. Type a title and a name.

Domain titles are shown to BUE users in the Resources tree. Managers can localize the
title for different languages by going into the Property dialog after the Domain is created.

The Domain name is an internal identifier used by BUE, and is not shown to users.

3. Click OK to create the Domain.

A confirmation dialog appears. Click OK.

A folder that contains the title of the new Domain appears below the Domains node in the
Resources tree.

Note: Within the new Domain, the BUE creates a Hidden Content folder as well as a My
Content folder for each user. The Hidden Content folder can be used to store things that
are related to the Domain but which you do not want users to see. For example, schedules
that distribute output back to the Domain and image files or style sheets that are used by
charts. The My Content folder is used by each user to store their personal content. Some
users can share personal content with Domain users. Domain Developers and Managers
can create folders and content within the domain and publish it so Domain users can
access and interact with it.

Managing Domain Users

When a Manager creates a new Domain, the WebFOCUS Business User Edition automatically
creates a new group for the Domain itself, and creates subgroups for each of the four user
types within it. A Domain accommodates multiple users, maintaining independent views and
levels of availability for each one. By assigning users to different groups within a Domain, a
Manager or Group Administrator can set security options for each user at the Domain level.

To review these groups, open the Security Center. From there, a Manager can create new
users for these Domain groups or add existing users to them. For more information about
Groups, see Managing Groups on page 234.

Granting Access to a Domain

When a Manager first creates a Domain, it is available only to the Manager that created it.
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To update this setting, the Manager must right-click a Domain, point to General Access, and
then select one of the following settings.

Domain Groups. Protects the Domain by limiting its availability to those users who are
assigned to it and work within it. This is the default setting for all new Domains.

All Users. Gives everyone Basic User access to the Domain. Using this setting, the
Manager that created the Domain can make content and resources available to all users in
a single action instead of individually assigning each user to the Domain.

The four Domain groups represent the four user types: Basic User, Advanced User, Developer,
and Group Administrator. When the Manager or a Group Administrator assigns users to one of
these groups, those users automatically obtain the privileges assigned to the user role
represented by that group when working with content in that Domain.

Managing Domain Private Resources

The Manage Private Resources feature allows Managers and Group Administrators to identify
and manage private resources owned by users or groups. In the BUE, Managers can manage
private resources by user, group, or Domain.

Deleting Domains

A domain can only be deleted by a manager who has rights to delete all of the resources within
it.

The process that deletes a domain first removes all users from groups in the domain, and then
cascade deletes the groups and rules that were created with it.

Note: The cascade delete process only removes users from groups within a domain. It does
not delete the users themselves.

Procedure: How to Delete a Domain

1. In the Resources tree, right-click an item, and then click Delete.
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You receive a message advising you that this process will delete all resources created by
this domain folder, as shown in the following Image.

2. Click Yes to delete the domain and associated resources.

3. If you receive a message warning that the folder contains private content, click OK to
delete the domain and its private content.

If you need to protect the private content, click Cancel to end the process without deleting
the domain.

When the process is complete, evidence of the domain and its resources disappear from
the Resources tree and the Security Center.

Managing Domain Users After Deleting a Domain

Even though deleting a Domain automatically deletes the groups associated with it, this action
does not delete the users assigned to those groups. Users from the deleted groups remain in
the Users pane in the Security Center, but, unless they are assigned to another group, they are
limited to view only privileges. To completely remove users from deleted groups, a Manager
must delete them from the Security Center.

Working With Folders

Folders contain all repository content. Whenever a user creates a folder, it will always be
created as a private folder. If the creator is permitted the necessary privileges, folders and
their contents can be shared with other users or published for general use.

Folders have both titles and file names. The title is what is typically displayed to users. The file
name is used as an internal reference by WebFOCUS BUE to provide an unambiguous context.
Titles can be duplicated within a container, but file names cannot.

The folder path may have up to 1,040 characters for the path information (not including the
object name), and up to 64 characters for the object name. For example, a folder may be
named: /WFC/Repository/AmericaBank/Finance. In this example, /WFC/Repository/
AmericaBank/ is 28 characters and Finance is 7 characters.
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Procedure: How to View Folder Properties

Right-click the folder or item and click Properties. The Properties dialog box opens, displaying
the information in the following table. 

Item Description

Language Provides a list of languages that you can click.

View All Opens the Language Properties dialog box, where you can click a
language.

Title Displays the value in the Resources tree, so users can identify the
content within the folder.

Folder Name Unique reference to the folder. click the Change Name check box to
change the name of the folder.

Summary Provides a detailed explanation with additional information about the
folder.

Parent Folder Shows the previous folder in the folder path of the WebFOCUS
Repository.

Full Path Displays full repository path of the folder in the WebFOCUS
Repository.

Created On Identifies the date and time the folder was created.

Created By Identifies the user who created the folder.

Last Modified On Shows the date the folder was last modified.

Last Modified By Displays the user ID that last modified the folder.

Last Accessed On Shows the date the folder was last opened.

Last Accessed By Identifies the user who last opened the folder.

Properties Shows a string of name value pairs that identify the properties of the
folder.

Size Displays N/A bytes for folders.
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Item Description

Run Displays N/A, as this property is not applicable to folders.

Sort Order Specifies the order to list the folder in the Resources tree or list
items within a folder.

Status Indicates whether the folder is Published or Private. Private will also
display the owner information.

In addition, the following options are available to control the usage of content within the folder:

Authorized users can view or edit the access rules, effective policy, or sharing permissions by
click Security.

The Server Properties tab shows the Assigned Server and available Application Paths. When a
Reporting Server is not specified, the report request is submitted to the default Reporting
Server specified in the Client configuration. When an Application Path is not specified, the
Application Path defined during the processing of the Client configuration and the Reporting
Server configuration is used.

Procedure: How to Create a Folder

1. In the Resources tree, right-click a domain or folder and click New Folder. 

The New Folder dialog box opens, as shown in the following image.

2. Type the title and summary for the new folder.

Note: The unique folder name is derived from the title. The following characters are not
permitted to be used within a folder name:
(Blank Space) & * ( ) | : ; " , ? /
If you use restricted characters in the Title when creating a new folder or item, it is
automatically removed from the Folder Name or File Name.
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3. Click OK.

Procedure: How to Publish a Folder

In the Resources tree, right-click a folder, and click Publish.

Procedure: How to Duplicate a Folder

In the Resources tree, right-click a folder, and click Duplicate.

A duplicate folder appears. The name and title of the duplicate folder are the same as those of
the original, appended with an underscore and an integer that increases each time the folder
is duplicated.

Procedure: How to Cut or Copy and Paste a Folder

1. In the Resources tree, right-click a folder, and click Cut if you want to move the folder, or
Copy if you want to leave the original folder in place.

2. Right-click the desired location and click Paste.

Folder names must be unique within a specific location. If the folder is pasted in a
different parent folder, its name remains the same, as long as no folder of that name
already exists in the new parent. If a folder of that name already exists, or if the pasted
folder has the same containing folder as the original, the name of the copy is the same as
the original, appended with an underscore and an integer that increases each time the
folder is pasted. The folder titles update in the same way as the folder names.

Procedure: How to Change a Folder Title

1. In the Resources tree, right-click a folder, and click Change Title.

A cursor appears in the folder title field in the Resources tree.

2. Type the new name and press the Enter key.

The folder name is updated.

Procedure: How to Delete a Folder

1. In the Resources tree, right-click a folder, and click Delete.

A confirmation dialog box opens.

2. Click Yes to proceed with the deletion.
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Managing Users

The Users pane of the Security Center lists all users. The Search field in this tab allows you to
search the name and description fields for users. Simple wildcard searches are supported. The
full range of features that manage users is available only to Managers. Group Administrators
can see the Security Center, but can only assign existing users to groups. Basic Users,
Advanced Users, and Developers cannot see the Security Center, nor can they create, update,
or delete users or assign users to groups.

The toolbar above the User pane allows Managers to perform the following actions:

Create, edit, or delete users.

Import users.

View when users last signed in.

Understanding Users

Users are those individuals who have access to the WebFOCUS Business User Edition (BUE).
Managers and Group Administrators can assign users with similar responsibilities to one of the
user type groups that the BUE automatically creates within a domain. This assignment allows
users to take advantage of those features and content that supports their daily activities, but
prevents them from using features or content that are beyond the range of their
responsibilities and authority. The four user types are: 

Basic Users. Can view reports and content in the domains accessible to them. They can
save deferred reports to their My Content folders, or copy parameters from a previously
created report. They cannot share, publish, copy, or paste any folder or content.

Advanced Users. Can do everything that Basic Users can do, and can also create original
reports, charts and other content for their My Content folders. They can share folders and
the content they contain with everyone or with selected users or groups.

Developers. Can do everything that Advanced Users can do, and can view and publish
content in their Hidden Folder. They can also copy and paste folders and content from their
domain to another domain, but they must be sure that the domain they target for this
operation maintains the same metadata as that used to create the content they are
copying.

Group Administrators. Can assign users to groups. They can also switch to Manager Mode
and manage private resources.
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Each user in the repository is defined by a unique name and may also be assigned a
description, an email address, and a password. The user must be placed in a group at account
creation and assigned a status. By default, the user is placed in the EVERYONE group, which is
the group of all users in the system, and assigned the Active status.

Any of these characteristics, except the unique user name, may be edited later by an
administrator.

Understanding User Name Requirements

Because user names are defined within the repository, they need to conform to the format
rules and character limitations it imposes. If your installation supports external authentication,
such as that provided by Microsoft Active Directory, user names also exist in an external
repository, and must conform to the format rules defined in it.

The set of characters you can use to create user names is defined by the current character
encoding setting established in the application server and the Client Code pages assigned to
your NLS setting. For example, if the application server is configured to support UTF-8
encoding, and the NLS Setting is also configured to support the US Unicode (UTF) code page,
you can use characters in the double-byte character set (DBCS) to create user names.

To support those installations that rely on external LDAP or Active Directory authentication,
WebFOCUS user names support all of the characters supported by the sAMAccountName
standard. Note that the range of allowable characters for WebFOCUS User Names is broader
than the range for the sAMAccountName standard, and administrators must be careful to avoid
including characters allowed by WebFOCUS but prohibited by the sAMAccountName standard in
User Names.

Given these considerations, when creating user names, take the following rules into account:

User names may contain alphanumeric characters, spaces, and underscores.

Depending upon the Client Code Page assigned to your NLS setting, user names can also
include single-byte or double-byte NLS characters.

Note: To prevent sign-in issues, and to conform to sAMAccountName best practices,
replace characters that contain accents or other diacritical marks in user names with
characters that exclude them. For example, convert Müller into Muller.

The following characters are not supported in user names: “|;/*,?

Note: if your user names must conform to sAMAccountName standards, you must
independently ensure that user names also exclude the following characters: [ ] : = + < > \

It is recommended that you limit user names to 64 characters. Longer user names may
cause problems during migration.
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Do not end user names with a period (.) .

If you support external authentication, avoid including characters in user names that your
external authentication repository does not support. For more information about which
characters to avoid, contact Customer Support Services.

Procedure: How to Create a User

Note: Only a Manager can create a user.

1. In the BUE Portal, on the Menu bar, click Administration, and then click Security Center.

2. On the Users & Groups tab, click the New User button .

The New User dialog box opens, as shown in the following image.

3. Type the user name, description, email address, password, and password confirmation,
and if desired, select a group and a status for the user, and then click OK.
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If you do not enter a description, the description defaults to the name. If you do not select
a group and status for the user, the user will be created in the EVERYONE group and
assigned the Active status by default.

Importing Users

The Import User command automatically creates new user accounts by importing user
information from a comma-separated values (.csv) text file and transferring those records to
the user accounts database in the repository. This operation streamlines the creation of
multiple user accounts by eliminating the necessity to open the New User dialog box, type, and
save the details for each new user account, individually.

The import does not overwrite records of existing users, nor can you use it to delete existing
user records. If a record in the user import file matches an existing user account, the import
generates a message identifying the record that could not be imported, as shown in the
following image.

2. Setting Up Your Environment

Online Help PDF  229



Understanding User Import File Layout and Format Requirements

You can create a new user import file by typing user information into any text editor and saving
it as a comma-separated values (.csv) file. If you are exporting user information from an
external source, you can create a user import file by reorganizing and reformatting the exported
information, as necessary, and then saving the exported user information in a .csv file.
Regardless of the method you use, you must ensure that all user import files you create
conform to the format and layout requirements described in this topic and that the information
within those user records conforms to the requirements described in Understanding User
Record Field Format Requirements on page 231.

The user import file must not contain a header or column heading line. The first line in the file
must contain the first user record. From that point on, each line within the user import file
contains the record for a single new user. Multiple user records must not be placed on the
same line. Because the import will end when it encounters the first blank line, do not include
any blank lines between user records.

User import files that contain only those NLS characters used in the U.S. English or Western
Europe code page 137 require no special encoding. However, user import files containing NLS
characters from other code pages require UTF-8 encoding, without a byte order mark (BOM). To
encode a user import file for UTF-8, open it in a third-party editor, change the appropriate
setting to specify that the file uses UTF-8 encoding, and save it with that value.

Each user record contains the following fields: user name, password, description, email
address, user status, and groups, as shown in the following image.

Within a user record, each field is separated by a comma. If the value assigned to a field
includes a comma, the value in that field must be enclosed within quotation marks ("). For
example the following new user record contains a comma in the third field, the description
field, and is enclosed in quotation marks ("):

testadv,password,"Getting Started, Advanced
User",testadv@domain.com,ACTIVE,Getting_Started/AdvancedUsers

If a field in a user record contains no information, the record must still define a placeholder for
the blank field by leaving two commas with no characters between them in the appropriate
place in the record. For example, the following new user record omits the password typically
found in the second field of a user entry:
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testbas,,Getting Started Basic User,testbas@domain.com,ACTIVE,Getting_Started/BasicUsers

Understanding User Record Field Format Requirements

When creating a user record, ensure that the values you assign to individual fields conform to
the following requirements:

User Name. Names assigned to imported users are subject to the same restrictions on
valid characters as those entered directly in the new user dialog box. For a detailed
description of user names and the range of characters that you can include in them, see 
Understanding User Name Requirements on page 227.

Password. You can assign a generic one-time password, such as password, to the
password field, or you can assign one of the hashed passwords from the UOA_USERS
table.

Description. Leave this field blank if you have activated the Synchronize User Information
setting, which is located on the External page of the Security tab of the Administration
Console. Otherwise, type the full name of the user or a brief description in this field. The
activation of the Synchronize User Information setting allows for automatic updates to the
value in this field from an external authentication or authorization provider.

Email Address. Leave this field blank if you have activated the Synchronize User
Information setting, which is located on the External page of the Security tab of the
Administration Console. Otherwise, type the email address for the new user. The activation
of the Synchronize User Information setting allows for automatic updates to the value in
this field from an external authentication or authorization provider.

User Status. Type ACTIVE, INACTIVE, or MUSTCHANGE in this field to identify the initial
status of the user when the new user account is created. Each of these values must be
typed in uppercase characters. If you type ACTIVE, the user represented by the account can
sign in and work within WebFOCUS BUE as soon as the account is created. If you type
INACTIVE, the user represented by the account can sign in and work with WebFOCUS BUE
only after a Manager has changed the status of that user account to Active. If you type
MUSTCHANGE, the user represented by the account is prompted to change his or her one-
time password the first time he or she signs in to WebFOCUS BUE.

Groups. Type the name of the group or groups to which the user is assigned. If you do not
include a value in the group name field, the user will be assigned to the EVERYONE group
automatically. If you do include a group name, make sure that it matches the spelling and
capitalization of its corresponding existing group name exactly.
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The format for a group name is the domain name, followed by a slash mark (/), and the
group name. For example, the following new user record adds a user to the AdvancedUsers
group of the Getting_Started domain, as shown in the last field in the record.

testadv,password,Getting Started Advanced
User,testadv@domain.com,ACTIVE,Getting_Started/AdvancedUsers

You can include more than one group name in this field. If you choose to do so, separate
each group name with a semi-colon. For example, the following new user record adds a
user to the Developers group and to the GroupAdmin group within the Getting_Started
domain, as shown in the last field in the record.

testdevgrp,password,Getting Started Dev-Grp
Admin,testdevgrp@domain.com,ACTIVE,Getting_Started/Developers;Getting_Started/
GroupAdmins

To prevent a user record from failing to load, any group that you identify in it must already
be defined within WebFOCUS BUE. You cannot use the import user operation to load new
groups as well as users simultaneously.

Procedure: How to Import Users

Before you begin, ensure that all groups that are identified in the user import file already
appear in the Groups pane of the Security Center, and create any groups or domains that do
not appear.

1. In the BUE Portal, on the Menu bar, click Administration, and then click Security Center.

2. On the Users & Groups tab, click Import Users.

3. In the Import Users dialog box, click Browse.

4. In the Choose File to Upload dialog box, navigate to the .csv file that contains the users to
import and double-click the entry, or click it, and then click Open.

5. In the Import Users dialog box, ensure that the name of the file that contains user records
for import appears in the File to Import field, and if so, click Import.

The import operation creates new user accounts for the users specified in the file records,
and assigns the new users to the groups specified in each record.

a. If you receive a message stating that there were issues processing the file, click Hide/
Show details, review the issues listed in Warning Details dialog box, and update the
import user file text or layout to address them.

b. When your updates are complete, save the revised user import file, close the Warning
Details dialog box, and return to step 2 to run the import again.

6. When the import is complete, click Close in the Import Users dialog box.
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7. Review the Users pane and the Users in Group pane to ensure that the full set of new
users was imported, and that they were appropriately assigned to all groups.

Procedure: How to Edit User Details

Only a Manager can edit user details.

1. In the BUE Portal, on the Menu bar, click Administration, and then click Security Center. 

2. On the Users & Groups tab, double-click a user, or right-click the user and select Edit, or

click the user and then click the Edit User button . The Edit User dialog box opens, as
shown in the following image.

3. If desired, type new information in the User Name, Description, or EMail Address field.

4. To change the status of a user, select Active, Inactive, or Must Change Password from the
Status drop-down list.

Note: If you select Must Change Password, users will be prompted to change their
password when they attempt to sign in.
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Procedure: How to Delete a User

Only a Manager can delete a user. The action of deleting a user also deletes that user's
private content. Be sure to publish or share any private content assigned to that user if it
supports ongoing activities.

1. In the BUE Portal, on the Menu bar, click Administration, and then click Security Center.

2. On the Users & Groups tab, right-click a user and select Delete, or select the user and

click the Delete User button .

A confirmation dialog box opens. Click Yes to delete the user.

Managing Groups

In the BUE, only Managers and Group Administrators can open the Security Center and review
groups. The Groups field in the Users & Groups tab of the Security Center lists all the groups
in the repository in alphabetical order. Subgroups appear indented below their parent groups.
The Users in Group field lists the members of the selected group. If no group is selected, the
field is blank. The Search field in this tab allows Managers and Group Administrators to search
the name and description fields for groups. Simple wildcard searches are supported. A toolbar
allows Managers and Group Administrators to perform the following actions:

View the groups to which a user belongs.

Add users to groups or remove them from groups.

View the members of a group.

Understanding Groups

Groups are formed of users or subgroups that require similar capabilities or access to the
same resources. All users are members of the EVERYONE group, which is the set of all named
users in the system.

A group is a collection of similar users. Typically, users are permitted actions based on rules
that apply to groups, although rules may also apply to individual user roles. Users may belong
to more than one group.

Creating Groups From Domains

The BUE automatically creates groups whenever a Manager creates a new Domain and deletes
them whenever a Manager deletes a Domain.
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This feature simplifies group management by limiting it to the assignment of users to
previously created groups. Managers and Group Administrators are not obligated to create or
delete groups independently.

Each Domain creates one master group that uses its name. This group does not contain any
users.

The Domain also creates four groups within that master group that correspond to the four
basic user types within the BUE.

Members of the Basic User group can view content within their Domain and can save copies of
reports they run deferred to their My Content folder for their own use.

Members of the Advanced User group have all the privileges of basic users, and they can
create, share, and distribute their own content.

Members of the Developers group have all the privileges of basic and advanced users, and
they can upload and connect to data, edit metadata, and create and organize Domain content.
They can also manage the content other users see.

Group Administrators determine the role each user can have within a Domain by adding users
to or removing users from groups and can change the General Access setting assigned to the
Domain.

Users can be members of more than one of these groups and can have different privileges in
different Domains. This capability is especially relevant to Group Administrators. In almost all
cases, this group assignment, and the privileges it grants, is combined with membership in
another group.

Procedure: How to Add a User to a Group

Only Managers and Group Administrators can add users to groups.

1. In the BUE Portal, on the Menu bar, click Administration, and then click Security Center. 

2. On the Users & Groups tab, under Groups, select a group.

Note: When you select a group, the members of the group appear in the Users in Group
field.

3. Drag a user from the Users field into the Users in Group field, or select the user and click

the Add selected users to group button .
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The user you added now appears in the Users in Group field, as shown in the following
image.

4. Click OK.

Procedure: How to Remove a User From a Group

Only Managers and Group Administrators can remove users from groups.

1. In the BUE Portal, on the Menu bar, click Administration, and then click Security Center. 

2. On the Users & Groups tab, under Groups, select a group.

3. Select a user and click the Remove selected users from group button , or drag the user
into the Users field.

You can also remove a user from a group by right-clicking on the user and selecting
Groups, then Remove from, then the group from which the user should be removed.
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Managing Private Resources

Sometimes it is necessary for a manager to view or modify the private resources owned by
another user. For example, when employees leave the company and their status is set to
inactive, their private resources may need to be deleted or transferred to another user. It can
also be useful for managers to have access to the private resources of the groups they
manage in order to share resources or troubleshoot procedures. BUE Managers and Domain
Group Administrators have access to this feature. Managers can access the private resources
of all users. Group Administrators can access the private resources of the users in their
Domain groups. 

You can perform most actions on non-output resources owned by other users, such as
FOCEXECs, and schedules. For output resources, such as PDFs or Libraries, your abilities are
limited to deleting the resources or changing their titles.

You can view and manage private resources by domain or by user or group.

Authenticating Users to Your Active Directory

You can configure WebFOCUS BUE to authenticate users against your corporate Active
Directory. The WebFOCUS BUE Client passes User sign in credentials to the WebFOCUS BUE
Reporting Server, which in turn, validates them within an external source. WebFOCUS BUE can
authenticate users against external Active Directory or LDAP directories. Users are externally
authenticated whenever they access WebFOCUS BUE and when they access the Reporting
Server Console. 

The benefits of authenticating users to the Active Directory include:

Improved usability. Users only need to remember a single user ID and password.

Reduced administration. WebFOCUS BUE synchronizes user information with Active
Directory. BUE Managers no longer need to maintain separate BUE passwords.

Improved maintenance. Each time a user signs in, their user description and email is
updated using the information found in the Active Directory, simplifying WebFOCUS BUE
administration.

Configuring Active Directory/LDAP Authentication

To convert to external Active Directory or LDAP authentication, you must override the default
setting of internal authentication in both the BUE Client and the Reporting Server, and
establish a connection between the Reporting Server and LDAP provider that will support
authentication activities.
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Here is an overview of the configuration steps:

1. Create a new WebFOCUS BUE Manager account whose name matches an account in Active
Directory.

Since the default Manager account manager generally does not exist in the external source,
it cannot be authenticated once external authentication has been successfully configured.
The new Manager account that you create will exist in both WebFOCUS and in Active
Directory so that you can use it for access to the BUE once you have restarted WebFOCUS
in its new authentication configuration.

2. Configure the BUE LDAP provider to authenticate users to Active Directory.

3. Configure BUE to use the LDAP provider and restart the BUE services.

In the steps which follow, you will be required to provide credentials for two service accounts.
The first is a BUE Reporting Server account, PTH\srvadmin, that is used by WebFOCUS BUE to
delegate authentication to the Reporting Server. The password for this account is pre-
configured during BUE installation to be the same as the password you supplied for the BUE
Manager account.

The second is an Active Directory account of your choice that is used by the Reporting Server
to authenticate users and retrieve their full description and email information, which in turn is
passed back to the BUE to update the user account. This service account simply needs read
access to Active Directory. Generally, any Active Directory account can be used for this purpose
but you must make sure its password is set to never expire.

Procedure: How to Create the Externally Authenticated Manager Account

1. Sign in to WebFOCUS BUE as a Manager.

2. In the BUE Portal, on the Menu bar, click Administration, and then click Security Center.

3. In the Security Center, under Users, click New User.

4. Type the Active Directory ID of the person who will be the new Manager for the BUE after
Active Directory authentication is established, in the User Name field.

You do not need to enter a description or email address because this information will be
automatically updated during sign in based on information retrieved by the BUE from Active
Directory.

5. Click Managers in the Create in Groups list.

6. Click OK.

An icon for the new user appears under Users and under Users in Group, when you click
the Managers group.
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Procedure: How to Establish LDAP as the Primary Security Provider on the Reporting Server

1. Sign in to WebFOCUS BUE as a Manager.

2. In the BUE Portal, on the Menu bar, click Administration, and then click Reporting Server
Console.

3. In the Reporting Server Console, click the Access Control tab.

The Navigation pane displays an expandable LDAP folder.

4. Right-click the LDAP folder, and then click New.

5. In the LDAP Security Provider Configuration page, accept the default name, LDAP01, or
type a new descriptive name for the LDAP security provider in the LDAP_PROVIDER field.

6. In the Connection Section, type the host name of your Active Directory server in the
ldap_host field.

In some cases, you can also enter the domain name of your organization, for example:
ibi.com.

7. Change the value in the LDAP port field only if your installation uses a different port
number.

Most installations use the default port number, 389.

8. Click Explicit in the security list.

The section expands and displays the fields, ldap_principal, and ldap_credentials.

9. Type the name of a Service Account that has read access to the Active Directory, in the
ldap_principal field.

It is important that this account has a non-expiring password to avoid disruption to the
BUE.

10. Type the password of the Service Account in the ldap_credentials field.

11. Click Next.

If you receive a message that the Discover LDAP server attributes failed, click OK, and
then review and update the settings you entered up to this point.

If all settings are correct, the page refreshes and displays additional headings. Fields in
the User Search section contain values populated directly from the Reporting Server.

12. Click the Trusted Connection section heading.

13. In the Trusted Connection section, click y in the trust_ext list.

14. Click Test User Authentication.

15. Type the Active Directory User ID and Password of the person that you previously identified
as the new BUE Manager, and then click Continue.
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If you receive a message that the connection or password failed, review and update your
settings if necessary, and try again.

If the password succeeded, continue with the next step.

16. Click Save.

17. In the Activate Providers page, in the LDAP entry that is identified by LDAP01, or by the
descriptive name you typed in the LDAP_PROVIDER field, click Primary in the Status list.

The Status of the LDAP entry changes to Primary, and the Status of the PTH<internal>
Security provider entry changes to Secondary automatically.

18. Click Save Provider's Status.

The screen refreshes and displays the Change Effective Security Provider page.

19. Click Apply and Restart Server.

When the confirmation dialog box opens, click OK.

The Reporting Server Console refreshes and displays the Applications tab.

20. Click the Access Control tab.

21. Review the new LDAP Security Provider and its Primary status.

22. Close the Reporting Server Console.

Procedure: How to Enable External Security in the WebFOCUS Client

1. Sign in to WebFOCUS BUE as a Manager.

2. In the BUE Portal, on the Menu bar, click Administration, and then click Administration
Console.

3. In the Administration Console, click the Security tab.

4. Under the Security Configuration folder, click External.

5. On the External page, select the Enable External Security check box.

The External page displays the settings currently assigned to the Reporting Server.

6. Type PTH\srvadmin in the Server Administrator ID field.

This is a Reporting Server administrator account that was installed automatically during
the BUE installation.

7. Type the password for this account in the Password field.

The password was assigned during BUE installation, and is initially set to the same value
that you entered for the manager account during installation.
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Note: The placement of this ID and its associated Password in the Server Administrator ID
field enables the Client to present them to the Reporting Server when sending User
authentication requests.

8. Click Connect to verify the credentials you provided.

9. Leave User Authorization set to Internal and ignore the Account Creation on Sign In
settings. The BUE does not support changes to these options.

10. Select the Synchronize User Information with Authentication Provider check box.

11. Click Save.

When the confirmation dialog box opens, click OK.

12. In the Administration Console menu, click Close.

13. Sign out of WebFOCUS BUE.

14. Stop and restart the Web Application to make these changes take effect. To do so:

If this installation of the BUE is based on the Windows operating system, stop and restart
the WebFOCUS BUE 82 Application Server service in the Services Window.

If this installation of the BUE is based on the Linux operating system, navigate to
drive/ibi/WebFOCUS_BUE82/tomcat/bin and run the shutdown.sh and startup.sh utilities.

15. When the Web Application restarts, sign in again using the Active Directory User ID and
Password of the new BUE Manager that you identified at the beginning of the
configuration.

The user description on the Menu Bar in the BUE Portal, and the Email Address of this
account now reflect the values retrieved by the BUE from the Active Directory.

Creating BUE User Accounts When Configured for Active Directory Authentication

Now that you have configured BUE to authenticate users to Active Directory, you can create
BUE accounts and assign them to the appropriate groups. This can be done in two ways:

Security Center. To use the Security Center to create and assign accounts to groups, create
accounts the normal way including assigning them to the desired groups. However, since you
are configured for Active Directory authentication you do not need to assign passwords for
these users and you do not need to populate the Description and Email fields for them. As you
have seen, this information will be automatically retrieved from Active Directory as each user
signs in.
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Import Users. To use the Import Users feature, simply define a CSV file containing one row for
each user account. You can use the following file located in your BUE installation directory
getting_started_sample_users.csv as a template. You can leave the password, user
description and email values blank but you need to preserve the same number commas in the
file to properly delimit all the required fields. You can adjust the group membership data in the
CSV for each user account to suit your requirements or you can leave it blank and assign users
in Security Center. The file should contain only data rows with the required number of commas
on each row and contain no blank lines. Here is an example:

user1, , , ,ACTIVE,

user2, , , ,ACTIVE,Getting_Started/Developers;Retail_Samples/AdvancedUsers

Configuring WebFOCUS BUE for SSL

The Hypertext Transfer Protocol over Secure Socket Layer (https) establishes an encrypted
Secure Socket Layer connection, and should be used to secure communications between
WebFOCUS BUE and browsers assigned to end users. There are many configuration options
that enable the use of this protocol, one of which is the Apache Tomcat configuration, as
described in this section. WebFOCUS BUE uses this configuration by default.

To activate Secure Socket Layer-based communications, create a self-signed certificate for
Java. You can optionally submit it to a Certificate Authority to establish it as a trusted
certificate. The keytool utility that creates the certificate also modifies the connection type
from open to SSL. Therefore, you must comment out the default Connector Protocol setting in
the Tomcat server.xml file, and ensure that a setting for the new SSL Connector Protocol
appears there instead.

Procedure: How to Create a Self-Signed Certificate

To create a Self-Signed Certificate with Java:

1. Open the command prompt window and redirect the command prompt to the drive:\ibi
\WebFOCUS_BUE82\jre\bin directory.

2. Type the keytool command and values as shown in the following example.

keytool -genkeypair -alias mykey -ext 
san=dns:dnsName1,dns:dnsName2… -keyalg RSA -validity 720 -keystore /
path_to_keystore/keystore -keysize 2048 –storepass MyPassword
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where:

dnsName
Is the name, or alias, of the entity (the subject) that will present this certificate for
authentication. You can include multiple names to ensure that all versions of the
subject names are recognized. For multiple alternative names use the syntax,
dns:first_dnsName,dns:second_dnsName and so on.

For example, dns:bue,dns:bue.ibi.com.

MyPassword
Is the password for this keystore. You can accept MyPassword, the default value, or
you can replace it with a unique password by typing it in this field.

/path_to_keystore/keystore
Is the location information that specifies where the key file will be placed. This value is
optional. If you do not specify a location for the key file, the Keytool utility places it in
the default location.

Note: The name mykey is important if you need to issue a -certreq (certificate request)
for a certificate signed by a Certificate Authority.

3. Press Enter.

The command prompt displays the first in a series of questions.

4. Respond to each question as follows:

“What is your first and last name?” Type the first and last name of the certificate
holder.

“What is the name of your organizational unit?” Type the name of the organizational
unit of the certificate holder.

“What is the name of your organization?” Type the name of the organization of the
certificate holder.

“What is the name of your City or Locality?” Type the name of the city or locality of the
certificate holder.

“What is the name of your State or Province?” Type the two-letter abbreviation for the
state in which the certificate holder is located.

“What is the two-letter country code for this unit?” Type the two-letter abbreviation for
the country in which the certificate holder is located.

5. When the command prompt displays the question, “Is CN=__, OU=__, O=__, L=__, ST=__,
C=__ correct?”, review the values and type y if they are correct.
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If they are not correct, Type n and retype the keytool command from step 2.

If they are correct, the new Self-Signed Certificate is ready for use.

Establishing the Self-Signed Certificate as a Trusted Certificate

Until you identify the new self-signed certificate to the browser as a Trusted Certificate, the
browser will display errors when you use it. During the initial testing period, you can add the
new self-signed certificate directly to the Trusted Certificate Authority of those browsers
included in the test. However, to fully establish the new certificate as a trusted certificate, you
typically request certification for it from a Certificate Authority using the following request:

keytool -certreq -alias mykey -storepass MyPassword –file ./mykey.csr –
keystore /path_to_keystore/keystore

where:

MyPassword
Is the password for this keystore. You can accept MyPassword, the default value, or you
can replace it with a unique password by typing it in this field.

/path_to_keystore/keystore
Is the location information that specifies where the key file will be placed. This value is
optional. If you do not specify a location for the key file, the Keytool utility places it in the
default location.

You can then send the certificate request file (mykey.csr) to a Certificate Authority to sign, and
when the authority returns the signed certificate, import it into the keystore.

Importing the Trusted Certificate into the Keystore

To import your certificate from the CA, type the following command:

keytool –import –alias mykey –file ./mykey.crt –keystore /
path_to_keystore/keystore

where:

/path_to_keystore/keystore
Is the location information that specifies where the key file will be placed. This value is
optional. If you do not specify a location for the key file, the Keytool utility places it in the
default location.

If your CA is an internal CA, then type the following command to import the certificate from your
Certificate Authority.

keytool –import –alias CA –trustcacerts –file ./ca.crt –keystore /
path_to_keystore/keystore
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where:

/path_to_keystore/keystore
Is the location information that specifies where the key file will be placed. This value is
optional. If you do not specify a location for the key file, the Keytool utility places it in the
default location.

Updating the Connector Protocols in the Tomcat Server.xml File

The Tomcat server.xml file is located in the following directory:

drive:\ibi\WebFOCUS_BUE82\tomcat\conf

The keytool utility disables the http connection assigned to port 26000. Therefore you must
comment out the Connector tag in the server.xml file that defines this http-based connection
by typing an exclamation point (!) after the open tag symbol (<).

<Connector connectionTimeout="20000" maxPostSize="-1" port="26000" 
protocol="HTTP/1.1" redirectPort="26001" useBodyEncodingForURI="true"/>

The keytool utility also establishes an SSL connector on port 443. This connection replaces
the old http based connection. Therefore, if it does not appear in the file, you must type this
updated version of the connector tag, with its attributes and values, as shown in the following
example:

<Connector protocol="org.apache.coyote.http11.Http11Protocol" 
port="443" SSLEnabled="true" keystoreFile="C:/users/path_to_keystore/
keystore" keystorePass="MyPassword" maxThreads="150" scheme="https" 
secure="true" clientAuth="false" sslProtocol="TLS" 
ciphers="TLS_RSA_WITH_AES_128_CBC_SHA,TLS_RSA_WITH_AES_256_CBC_SHA"/>

where:

/path_to_keystore/keystore
Is the location information that specifies where the key file will be placed. This value is
optional. If you do not specify a location for the key file, the Keytool utility places it in the
default location.

MyPassword
Is the password for this keystore. You can accept MyPassword, the default value, or you
can replace it with a unique password by typing it in this field.

Creating a Change Management Package

Many organizations do not grant developers write access to the user acceptance test and
production environments. Access to these environments is strictly controlled and granted only
to administrators, production control personnel, or automated change management processes.

2. Setting Up Your Environment

Online Help PDF  245



Only developers know which changes are ready to be moved into the test environment. The
Change Management Export facility presents developers with a graphical view of the resources
they manage and allows them to build a change management package. This package is then
loaded into another environment by production control personnel or automated processes.

Note: Execution IDs and passwords cannot be imported or exported through the Change
Management utility. A new Execution ID and password must be created on the selected
system.

Procedure: How to Create a Change Management Extract Package

Only members of the BUE Managers group have access to the Change Management feature,
which is available on the Resources tree as a node that contains two subfolders: Import and
Export.

The steps required to create a Change Management Package are:

1. Create a Scenario. Utilizing the Change Management Export facility, an authorized user
will create a scenario by selecting the resources to be exported. A scenario is a
description of all the resources that will be exported into a Change Management Export
Package.

2. Export a Scenario. After a scenario is created, a user can export this scenario into a
Change Management Export Package. This Change Management Export Package is placed
in the drive:\ibi\WebFOCUS_BUE82\WebFOCUS\cm\export directory in two formats: a zip
file and a folder, which contains the expanded contents of the zip file.

The zip file or the exported folder is then copied to the target environment and placed in
the drive:\ibi\WebFOCUS_BUE82\WebFOCUS\cm\import directory. For convenience the
CM zip file can be downloaded from the BUE using a web browser and similarly uploaded
to the target BUE where its content can then be imported and accessed.

Procedure: How to Access the Change Management Export Facility to Create a Scenario

1. In the Resources tree, expand the Change Management node.
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2. Right-click Export and click New Scenario, as shown in the following image.

3. You will then be prompted to enter the scenario name.

The Scenario Creation dialog box appears, as shown in the following image.
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Selecting Resources

You can select resources by dragging content from the Resources tree to the right
pane. You can also right-click the content you want to move and select Select With
Subtree or Select Folder Only.

Select With Subtree selects that folder and all subfolders.

Select Folder Only selects the specific folder, with no content. Typically, this is done
to move rules on the folder.

If a private resource is selected, the With Private Content check box is automatically
selected and cannot be cleared.

If a published folder is selected, you can include private content within that folder by
selecting the With Private Content check box for that resource. This will export ALL of
the private content in that folder and its subfolders, including user My Content folders,
even if you do not have the privileges necessary to view that private content.

Select resources only from a version that is equal to or greater than the currently
established Change Management minimum version, typically 8.2.00.

Note:

If private content is selected, it will only be imported if the owner of that private
content already exists in the target environment.

If a subfolder is selected, its parent folder must exist in the target system.

Now that resources are selected, click Save to save the scenario.

4. Click Export to create a Change Package based on the saved scenario file. You can do this
from within the interface or by right-clicking the scenario file item in the Resources tree.
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5. From the Resources tree, refresh the Export node under Change Management. If you do
not see the zip file, refresh the Export node again. You can now download the zip file, so
that it can be moved to the target system, as shown in the following image.

Procedure: How to Import a Change Management Package

Only members of the BUE Managers group can import Change Packages.

This procedure assumes that a change management zip package has been previously created
on another system, the Manager is signed in to the target BUE environment, and the CM zip
file is available to the Manager.

1. In the Resources tree, expand the Change Management node, then expand the Import
node.

2. Right-click the package that you just uploaded and click Import.

If you receive a message stating that the resources in the Change Management Package
are from a version that is below the minimum level, click OK and cancel the import.

You can recreate the Change Management Package using resources from a version that is
greater than or equal to the version identified in the message.
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The Import Package dialog box appears, as shown in the following image.

3. Select one of the following options:

Add New Resource Only (do not replace). This option will only add new resources to the
target environment. For newly created items, the Created On and Last Modified On fields
will be updated with the time at which they were imported. To view the Created On and
Last Modified On fields, right-click an item and click Properties.

If an item already exists in the target environment but is also part of the change
management export package, the target resource will be left alone and the Last Modified
On field will not be updated.

Add New and Update Existing Resources. This option will add new resources to the target
environment if they do not exist and update existing resources if they already exist. For
newly created items, the Created On and Last Modified On fields will be updated with the
time at which they were imported. For updated items, the Created On value for the target
will be retained, but the Last Modified On field will be updated with the time at which it
was imported.
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The other options on this panel are not used in BUE and can be ignored.

4. Click OK.

Changing InfoAssist+ User Preferences

You can change the default user preferences to customize the way that InfoAssist+ behaves
when you create reports and generate output. The application theme, which is inherited from
the BUE portal, customizes the InfoAssist+ interface, including all menus and dialog boxes. 

You can style your reports by selecting a document theme independent from the interface. On
the InfoAssist+ application main menu, click Options.

The Options window, as shown in the following image, opens to provide you with a user-friendly
interface for customizing the InfoAssist+ application.

Note: If you make changes to the default selections in the Options dialog box, changes will
take effect the next time InfoAssist+ launches.

If any of the options are unavailable, contact your administrator for assistance.
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View

The View area provides settings for establishing the design view in which you will work, the
type of data you will use when you preview your output, the limit you need to set on your record
input, how your data and query panels will look, and the output target that you will use. 

Design View. Values are Live Preview and Query. Select Live Preview to activate the Preview
Method drop-down menu. The default value is Live Preview.

Preview Method. Values are Preview with Source Data and Preview with Sample Data. This
menu becomes active when you select Live Preview from the Design View drop-down menu.
The default value is Preview with Source Data.

Record Limit. Values are All records, 1, 10, 50, 500, or you can type a numeric value
directly in the menu. The default value is 500.

Data Panel. Values are Logical, List, and Structured. The default value is Logical.

Query Panel. Values are 2x2 (2 columns by 2 rows), 1x4 (1 column by 4 rows), and Tree.
The default value is Tree.

Output Target. Values are Single Tab, New Tab, Single Window, and New Window. The
default value is Single Tab.

Layout

The Layout area provides settings for printing reports and charts.

Page Size. Values are A4, A3, A5, Letter, Tabloid, and Legal. The default value is Letter.

Orientation. Values are Portrait and Landscape. The default value is Portrait.

Format

The Format area provides settings for the output types for reports, charts, and documents. 

Report output type. Values are HTML, PDF, PowerPoint (pptx), Excel (xlsx), Excel (xlsx
Formula), Excel, Excel (Formula), and active report. The default value is HTML.

Chart output type. Values are HTML, HTML5, PDF, PowerPoint (pptx), Excel (xlsx), Excel,
and active report. The default value is HTML5.

Document output type. Values are HTML, PDF, PowerPoint (pptx), Excel (xlsx), Excel (xlsx
Formula), Excel, Excel (Formula), and active report. The default value is active report.
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Environment and Styling

The Environment and Styling area provides settings for styling reports and charts through the
specification of a Document Theme. Click the Browse button to open the Templates - Browse
predefined template files dialog box, in which you can search for an existing WebFOCUS
StyleSheet. The default StyleSheet is Warm.sty, but you can select from the other themes that
are available (Dark.sty or Flat.sty). 

Note: StyleSheets are stored in the following directory of your WebFOCUS BUE installation:

drive:\ibi\WebFOCUSBUE82\IBI_HTML\ibi_themes

In addition, you can access a repository of additional themes by accessing the Legacy
Templates, under Libraries, as shown in the following image.

The theme that you select determines the coloring and hues that display within InfoAssist+.
The default templates in the Templates section apply to all languages, whereas some of those
in the Legacy Templates sections are specific to just one language (for example, EN=English).

2. Setting Up Your Environment

Online Help PDF  253



Changing Global Preferences

You can change global preferences for InfoAssist+ through the Administration Console found
on the BUE Portal. To do so, in the Administration Console, on the Configuration tab, click
InfoAssist+ Properties.

Configuring Hyperstage

Hyperstage is a column-oriented, high performance analytic engine designed for analytic
applications and data marts that need fast query response across large data volumes.
Hyperstage was designed specifically for large volume data analytics applications with up to 50
Terabytes of data.

Hyperstage Overview

Hyperstage uses a unique and patent-pending approach to compressing, storing, and
processing data that allows it to be installed and run on commodity hardware with little or no
DBA intervention. Hyperstage requires little tuning to support ad hoc or complex business
analytic queries.

Hyperstage is a database engine utilizing the PostgreSQL database environment. As such,
Hyperstage is fully compatible with all PostgreSQL-compliant Business Intelligence tools and
utilizes the PostgreSQL administrative interface to reduce the learning curve for system
administrators.

Hyperstage provides a versatile, highly-compressed database system optimized for analytic-
type queries. The ratio of possible compression and the speed of data import and retrieval are
optimized at the expense of some transactional features of the engine performance, like the
frequent data updating.

Hyperstage executes complex or ad hoc queries across vast amounts of data with a low cost
of ownership.

Hyperstage and PostgreSQL

Hyperstage combines the Hyperstage storage engine with PostgreSQL server implementation.
Hyperstage consists of several layers. The upper layers are provided by the PostgreSQL server
implementation, and the lower layers are provided by Hyperstage.

Hyperstage includes both its own optimizer and executor along with the storage engine. The
PostgreSQL query engine can be used with Hyperstage. However, since the PostgreSQL
storage engine interface is row oriented, it cannot take full advantage of the column orientation
or the Knowledge Grid and hence query execution through this path is reduced. Queries will be
directed to the Hyperstage optimizer whenever possible.
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Hyperstage ships with the full PostgreSQL binaries required. PostgreSQL is used to store
catalog information (as with other storage engines). You can use the PostgreSQL instance for
other purposes, but joining PostgreSQL and Hyperstage tables may result in reduced
performance as the PostgreSQL query engine will be used.

PostgreSQL provides:

Mature connectors, tools and resources.

Interconnectivity and certification with BI tools.

Management services and utilities.

Hyperstage provides:

Load function that compresses data.

Column-oriented storage engine.

Knowledge Grid metadata layer that contains information about the compressed data.

Optimizer/executor that uses the Knowledge Grid.

Configuring the Hyperstage Database

The following section describes the configuration steps for Hyperstage.

Configuring Hyperstage

The Hyperstage configuration file is called infobright.cnf and is located in the ib_data
subdirectory within the Hyperstage Data installation directory (for example, C:\ibi
\WebFOCUS_BUE82\srv\wfs\hs\ib_data). The configuration file is a text file containing the
Hyperstage configuration parameters.

Each parameter is shown on a separate line.

If a parameter is not present in the configuration file or if the configuration file does not exist,
the default values are used. Blank lines and comments (lines starting with #) are ignored.

Be sure to customize the following parameters to optimize performance. These tuning
parameters are case sensitive and must be typed as shown in the following table.

Note: The values are commented out (preceded by #) in the infobright.cnf file, which causes
them to default to the application minimum allowed values of 600 and 320 for
ServerMainHeapSize and LoaderMainHeapSize, respectively.
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Hyperstage Configuration Parameters

Parameter Name Description

LicenseFile Specifies the path or name of the newly required
License file.

LogLevel Controls how much information is written to logs. This
is similar to the obsolete ControlMessages parameter.

LogRotateSize Specifies how large the log file can be before it is
rotated and archived.

LogRotateFiles Specifies how many log archive files are kept.

KNFolder Specifies the folder where Knowledge Grid is stored.

CacheFolder Specifies the folder where temporary objects are
stored.

ServerMainHeapSize Specifies the size (in MB) of the main memory heap.

ThrottleLimit Controls how many SELECT queries can run
concurrently.

Configuration Tips and Examples

Important: You must properly configure your memory settings to ensure optimal performance.

The following table shows sample, recommended memory configurations for different systems.

System Memory Server Main Heap Size Loader Main Heap Size

64GB 48000 800

48GB 32000 800

32GB 24000 800

16GB 10000 800

8GB 4000 800
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System Memory Server Main Heap Size Loader Main Heap Size

4GB 1300 400

2GB 600 320

In most cases, the loader does not benefit from larger memory settings. However, increasing
the LoaderMainHeapSize can help when:

A table to be loaded has very long text values.

or

The table has many columns (for example, 1000 columns).

You can use more memory at import if you are planning to execute several concurrent load
tasks to different data tables. However, disk access may become a bottleneck.

ServerMainHeapSize should be as large as possible, but safely smaller than the amount of
physical memory on the machine. If performance decreases because of memory swapping by
the operating system, try to set lower heap sizes. We also recommend decreasing the heap
size if many users are running queries in parallel.

Note: Hyperstage may use additional memory for heavy loads or queries. Also, other
applications on your server will use memory for their processes. It is important that the total of
ServerMainHeapSize is less than the total available physical memory. If the system needs to
swap memory, performance will be severely impacted.

Using the Hyperstage Database Beyond WebFOCUS

The following section describes how to work with the Hyperstage server.

Starting and Stopping the Hyperstage Server

The Hyperstage Server starts and stops automatically when starting and stopping the Business
User Edition Reporting Server. The Manager user ID is required to start and stop any
component of the Business User Edition.

2. Setting Up Your Environment

Online Help PDF  257



To manually stop the Hyperstage Server, from the Workspace/Select Special Services and
Listeners section of the Reporting Server Web Console, right-click the HYPER service and
select Stop, as shown in the following image.
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To manually start the Hyperstage server, from the Workspace/Select Special Services and
Listeners section of the Reporting Server Web Console, right-click the HYPER service and
select Start, as shown in the following image.

Quick Copy For Hyperstage Using Extended Bulk Load Utility

Note: Hyperstage only supports Quick Copy, and Custom Copy as ETL tools.

The Quick Copy tool allows for the copying of all data from a Source table into Hyperstage. The
Bulk Load option should be selected in order for data to be loaded quickly. If the Bulk Load
option is cleared, the data will take much longer to load.

The Custom Copy tool allows for the copying of selected columns, presorting data within
selected columns, and filtering of columns from a Source table into Hyperstage.

To access the Quick Copy tool, right-click the name of the synonym corresponding to the table
or data you wish to copy into Hyperstage, and select Quick Copy.
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The following configuration setting options are available:

Load Option

New. Recreate the target table before loading the data.

Append Existing Data. Data is loaded to an existing table.

Target Adapter

The list of adapters currently configured on the Reporting Server.

Target Connection

The Hyperstage connection used for the load operation.

Target Synonym Application

The target application on the Reporting Server where the target synonym will be stored.

Target Synonym

The name of the target synonym defining the Target Table Name.

Target Table Name

The name of the Hyperstage table where the data will be loaded.

Bulk Load

When selected, data will be loaded using the Hyperstage Bulk Load functionality. Bulk
Load is the recommended approach for loading data into Hyperstage.

When cleared, data will be loaded using Insert/Update. Insert/Update is not recommended
and will perform extremely slow.

Managing Hyperstage Tables

The following section describes how to work with the Hyperstage tables and lists the data
types supported.

About the Hyperstage Database Files

Hyperstage tables are located in the ib_data subdirectory in your Hyperstage installation
directory. Within the ib_data subdirectory, Hyperstage databases are stored in separate
subdirectories.

Important: Do not manually copy a data table from one database to another by copying the
database files. Internal table numbering errors and Knowledge Grid inconsistencies may occur.
To copy a table, backup the entire database directory (see Hyperstage Backup and Recovery on
page 265).
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The following path and image shows the content of the ib_data directory, containing the
Hyperstage databases webfocus and utf8test, as well as the BH_RSI_Repository directory,
which holds the Knowledge Notes:

C:\ibi\WebFOCUS_BUE82\srv\wfs\hs\ib_data

About Supported Data Types

The following data types are supported in Hyperstage. Note that numeric data types ranges are
1 less than the PostgreSQL minimums and maximums.

Numeric Types

BOOLEAN Values are either 0 or 1.

SMALLINT -32767 32767

INT (INTEGER) -2147483647 2147483647

BIGINT -9223372036854775807 -9223372036854775807

REAL -3.402823466E+38 3.402823466E+38

DOUBLE PRECISION -1.7976931348623157E
+308

1.7976931348623157E
+308
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Numeric Types

Numeric(M, D)

where:

0 < M <= 18 and 0 <= D
<= M

-(1E+M - 1) / (1E+D) (1E+M - 1) / (1E+D)

Date and Time Types

DATE 100-01-01 9999-12-31 YYYY-mm-dd

Time (without
timezone)

00:00:00 24:00:00 HH:MM:SS

TIMESTAMP
(without
timezone)

100-01-01
00:00:00

9999-12-31 23:59:59 YYYY-mm-dd HH:MM:SS

TIME0053TAM
P (with
timezone)

1970-01-01
00:00:00 in UTC

2038-01-01 00:59:59
in UTC

Interval -178000000
years

178000000 years

String Type

BYTEA (binary string) 0 < N <= 65536

CHAR(N) Fixed-length. Maximum length depends on
character set (encoding). 0 < N * B <=
65536 where B is the maximum number of
bytes for a single character.
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String Type

VARCHAR(N) Maximum length depends on character set
(encoding). 0 < N * B <= 65536, where B is
the maximum number of bytes for a single
character. For example, for UTF-8 it is 4
bytes, so the maximum number of
characters that can be stored in a
(VAR)CHAR column is 65536 / 4 = 16384

Creating and Dropping Tables

Use the standard PostgreSQL commands to create and drop tables in Hyperstage, the same
as you would with a PostgreSQL table. For detailed syntax information, see the PostgreSQL 9.2
Documentation.

Important: Do not manually copy a data table from one database to another by copying the
database files. Internal table numbering errors and Knowledge Grid inconsistencies may occur.
To copy a table from one database to another, back up the entire database directory (see 
Hyperstage Backup and Recovery on page 265). You can rename the entire database by
renaming the folder. However, you should not copy a database folder from one active instance
to another, or within the same active instance.

To create a table, enter the following command:

psql> create table <table_name> (<column(s)>) with (ENGINE=INFOBRIGHT);

Note:

'with (ENGINE=INFOBRIGHT)' syntax is necessary when creating tables manually, to specify
that the table will be stored as part of the Hyperstage-specific Infobright engine. Without
this syntax, the table will be created and stored as a regular PostgreSQL table.

When creating a table, as a matter of practice, you should always use the ENGINE= option
to ensure that the correct database engine is used. Hyperstage is shipped with DEFAULT
ENGINE=INFOBRIGHT, but this can be changed. The name of the engine can be specified
explicitly at the end of the create table statement.

To drop a table, enter the following command:

psql> drop table table_name;
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For information on supported and unsupported options when creating columns, see About
Column Options.

Character Set Support

The following section describes the character sets supported by Hyperstage.

Supported Character Sets

Hyperstage storage supports all ANSI and UTF-8 character sets. This means that Hyperstage
can store and retrieve data encoded in 8-bit and multi-byte character sets.

Important: Queries that evaluate against UTF-8 character data columns will execute with less
performance than an equivalent query against ASCII character data, due to ASCII support of
Character Maps in the Knowledge Grid. UTF-8 specific Knowledge Grid extensions will be
available in an upcoming release.

Collations and Comparisons

Hyperstage supports all custom UTF-8 collations supported by PostgreSQL:

utf8_bin

utf8_czech_ci

utf8_danish_ci

utf8_esperanto_ci

utf8_estonian_ci

utf8_general_ci (default)

utf8_hungarian_ci

utf8_icelandic_ci

utf8_latvian_ci

utf8_lithuanian_ci

utf8_persian_ci

utf8_polish_ci

utf8_roman_ci

utf8_romanian_ci

utf8_slovak_ci

utf8_slovenian_ci

utf8_spanish2_ci

utf8_spanish_ci

utf8_swedish_ci

utf8_turkish_ci

utf8_unicode_ci*

*utf8_unicode_ci properly handles both French and German collation, so specific collation
types for these languages are not necessary.

For more information, see the PostgreSQL 9.2 Documentation.

Configuring Hyperstage

264  Information Builders



The SQL standard does not define a default collation. Therefore, many DBMS engines have
different default collations and produce different results. As a result, there are several
differences between Hyperstage and other DBMS engines.

For Hyperstage, character data types are case-sensitive. For example, the condition
'toronto'='Toronto' is not true in Hyperstage. Similarly, the condition, LIKE 'Abc%' is not
true for 'abcde'.

The Hyperstage sorting order is A…Z a…z (for example 'Zeta' < 'alfa'), which is the same
sorting order as used by Oracle. The Hyperstage sorting order is different than the default
PostgreSQL sorting order, which mixes lowercase and uppercase. The SQL Server order,
which is aAbB…zZ; and the DB2 order, which is AaBb…Zz.

The Hyperstage sorting order affects ORDER BY results, GROUP BY results (which is the
order of groups and their definitions (for example, 'aaa' and 'AAA' define different groups)
and DISTINCT results. WHERE conditions may also be affected if you are expecting a
different sorting order than the one used by Hyperstage.

To simulate Hyperstage collation in the PostgreSQL engine, set latin1_bin collation while
creating a table (for more information, see the PostgreSQL 9.2 Documentation). Enter the
following command:

psql> create table … collate ascii_bin;

Padding

Hyperstage treats padding differently than other DBMS engines. Hyperstage assumes literal
comparisons of text fields, including all whitespace characters. Therefore, a string containing
two spaces is different than a string containing one space or an empty (0 length) string, which
is also different than the NULL value.

The Hyperstage padding definition is compatible with the SQL standard. However, most DBMS
systems have defined less restricted, customizable rules regarding text comparison. For
example, 'abc ' = 'abc' may be true in some databases, but is not true in Hyperstage.

Note: In CHAR columns, trailing spaces are trimmed on LOAD, INSERT, and UPDATE, whereas
in VARCHAR columns values are loaded with all spaces.

Hyperstage Backup and Recovery

The following section provides instructions on how to backup and restore the Hyperstage
databases.
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Backup Procedure

Use the following procedures to back up Hyperstage.

To back up the Hyperstage databases, copy the ib_data and pg_data directories.

You can take advantage of incremental backups, since only some of the database files are
updated when new data is imported. Be sure to do a full backup occasionally.

Important: Some files in the KNFolder are updated when queries (using JOIN) are run, so be
sure to back up the KNFolder on a regular basis.

Restore Procedure

To restore the Hyperstage databases from a backup copy, do the following:

1. Replace the ib_data and pg_data directories with the backup copy.

2. Replace the KNFolder with the backup copy (if the KNFolder is not inside the data
directory).

Important: Do not manually modify database files or move them from one database to
another. This may lead to data corruption and unpredictable results.

Functions and Operators

The following section lists the functions and operators supported by Hyperstage.

Hyperstage Optimizer Supported Functions and Operators

Comparison Functions and Operators

COALESCE YES

Control Flow Functions

CASE YES

COALESCE TBD

NULLIF YES
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String Functions

BIT_LENGTH YES

CONCAT YES

LEFT YES

LENGTH YES

LOCATE YES

LOWER YES

LPAD YES

LTRIM YES

OCTET_LENGTH YES

POSITION YES

RIGHT YES

RPAD YES

RTRIM YES

SUBSTR YES

TRIM YES

TRUNC TBD

UPPER YES

Numeric Functions

Modulo ( % ) YES

ABS YES
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ACOS YES

ASIN YES

ATAN2, ATAN YES

ATAN YES

CEIL YES

COS YES

COT YES

DEGREES YES

EXP YES

FLOOR YES

LN YES

LOG YES

MOD YES

PI YES

POWER YES

RADIANS YES

RANDOM TBD

SIGN YES

SIN YES

SQRT YES

TAN YES
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Date and Time Functions

CURRENT_DATE YES

CURRENT_TIME YES

DATE YES

DAY YES

DAYOFYEAR YES

FROM_UNIXTIME YES

HOUR YES

MINUTE YES

MONTH YES

NOW YES

QUARTER YES

SECOND YES

TIME YES

YEAR No

Text Search and Other Functions

CAST YES

MD5 TBD

Group By Aggregate Functions

AVG YES
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BIT_OR No

BIT_AND No

COUNT(DISTINCT) TBD

COUNT YES

MIN YES

MAX YES

STD, STDDEV YES

STDDEV_POP YES

STDDEV_SAMP YES

SUM YES

VAR_POP YES

VAR_SAMP YES

VARIANCE YES

Hyperstage Data Tools

The following section describes the data tools used by Hyperstage.

Hyperstage Consistency Manager

Hyperstage provides a tool to validate Hyperstage-specific metadata structures. The
Hyperstage Consistency Manager is an external stand-alone application that can be run
against a Hyperstage instance to verify and repair most Hyperstage data structures, including
the Knowledge Grid and Data Packs.

If you are seeing unexpected behavior with Hyperstage, such as server crashes, it can help to
run the Hyperstage Consistency Manager for information for support and to perform repairs.

Note: Currently, the Hyperstage database must be offline in order to run the Hyperstage
Consistency Manager.
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Hyperstage Consistency Manager Tests

The Hyperstage Consistency Manager runs tests, as described in the following table.

Test Description

Delete mask
consistency check

Checks that the delete mask headers contain the proper sum for the
delete mask body. If any inconsistency is found between the header
and body, the Hyperstage Consistency Manager returns the list of
blocks of delete mask where inconsistencies were found.

Number of objects
in columns equality

Compares the stored number of objects in each column file related
to the table. If any inconsistency is found in the number of objects,
the Hyperstage Consistency Manager returns the first two columns
with different object numbers.

Comparison of
maximal value in
DIMENSION
dictionary versus
DPN

Executes only for DIMENSION columns. Compares the maximal key
value stored in the DIMENSION column dictionary and in DPNs. If the
values differ, the Hyperstage Consistency Manager writes them to
the log.

Comparison of
number of objects
in first-column DPN
versus delete mask

Compares the metadata stored in the headers of the delete mask
and DPN file related to the number of objects. If any inconsistencies
are found, the Hyperstage Consistency Manager returns both
numbers. The Hyperstage Consistency Manager compares only the
first column because there is an independent test comparing this
value between columns. If the test does not find the proper delete
mask file or the proper DPN file, the Hyperstage Consistency
Manager reports corruption.

Knowledge Grid
consistency for
column

Checks if the histograms report the proper value of the fixed
parameter. A basic test of the Knowledge Node, ensuring the file
has a proper format and the type of Knowledge Node corresponds to
the column.

Knowledge Grid
format for column

Each Knowledge Node is stored in a separate file. This test validates
that the header data of each file is in the proper format.
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Test Description

Test for overlapping
Data Packs in data
files

Checks if there are Data Packs in files that overlap each other. If
this situation occurs, the Hyperstage Consistency Manager returns a
list of pairs of Data Packs numbers that are overlapping.

Tests of table
metadata
consistency

Verifies if the table metadata is valid. Includes verification of files
used to store items, such as table name, number of columns and
their names, types, and constrains like NOT NULL. These are the
files created on CREATE TABLE and modified only on ALTER TABLE.

Test of DPNs for
non-binary collation

Verifies Data Packs specifically for non-binary collation types (for
example: Latin1_swedish.ci). If errors exist, they can be repaired
using the Hyperstage Consistency Manager - -repair option.

Syntax: How to Run the Hyperstage Consistency Manager

To view the run options, run Hyperstage Consistency Manager with the - -help flag:

Icm-pure --help

To run Hyperstage Consistency Manager, use the following command:

Icm-pure --datadir=/data_directory_path [parameters]

For example:

c:\ibi\srv77\home06Hyperstage\hs\bin>icm-pure.exe 
  --datadir=C:\HyperstagePG\ib_data --log-file=C:\temp\icm-pure.log

Note: Hyperstage Consistency Manager should be run by the 'postgres' user. It should not be
executed by 'root' or any rebuilt knowledge nodes will be owned by root (and cannot be edited),
which will result in issues when loading any subsequent data into the 'corrected' tables.

The following table describes the Hyperstage Consistency Manager parameters.

Parameter Description

- -help Displays help message and exit.

-V [ - -
version ]

Displays version information and exit.
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Parameter Description

- -basedir Absolute path to Hyperstage installation directory.

arg

- -datadir arg Absolute path to directory. Mandatory.

- -database
arg

Name of database chosen for data integrity testing. Optional. If specified,
no other databases will be tested.

- -table arg Name of table chosen for data integrity testing. Optional. If specified, no
other tables will be tested.

- -log-file arg Prints output to log file. Optional. If not specified, the logs will be printed to
the console.

-F [ - -full-
check ]

Runs full set of tests (may be time-intensive). Running Hyperstage
Consistency Manager without the full-check option will result in a quicker
test. However, the "Knowledge Grid consistency for column" test will not be
run.

- -repair Repairs found problems.

- -rebuild-kns Rebuilds the Knowledge Grid. For more information, see About Rebuilding or
Repairing Knowledge Nodes on page 274.

- -stop-on-
error

Stops tests on first error and report.

- -cleanup In case of an error in the Hyperstage Consistency Manager repair
procedure, this option enables Hyperstage Consistency Manager to
manually revert the datadir to its previous state. Running Hyperstage
Consistency Manager with the - -cleanup option removes the old DPN files
(containing incorrect DPNs) from the datadir and also makes the changes
performed by Hyperstage Consistency Manager impossible to undo. If the - -
cleanup option is not used, the old DPN files remain in the datadir.
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About Rebuilding or Repairing Knowledge Nodes

Executing a rebuild of the Knowledge Nodes (using the - -rebuild-kns option) will run the
following tests:

Test of table metadata consistency

Test of Knowledge Grid format for column

Test of Knowledge Grid consistency for column

The - -rebuild-kns option will fix any issues found for the first two tests ("Test of table metadata
consistency" and "Test of Knowledge Grid format for column").

You can also use the - -repair option along with the - -full-check option to achieve the same
results as - -rebuild-kns. Using either of these methods will rebuild any Knowledge Nodes that
have been deleted.

About Cleanup Procedures

The Hyperstage Consistency Manager creates backup files when repairing problems related to
"Test of DPNs for non-binary collation" (backup files are not created for any other tests). These
backup files can be used to revert back to the original data if the Hyperstage Consistency
Manager encounters an error during the repair procedure. To revert to the original data, copy or
rename the TAXXXXXDPN.icm_bck files to the TAXXXXXDPN.ctb files (found in the ib_data
directory).

Distributing the Quick Data Add-In File

WebFOCUS Quick Data add-in allows you to bring a large amount of enterprise information to
the familiar Excel environment, and interact with this information without learning any
additional software. You can install the WebFOCUS Quick Data Add-in on your desktop, and you
can create and edit queries by accessing predefined data sources. You can save a query in an
Excel document, and you can refresh it at any time.

Because all WebFOCUS connection and report information can be saved in an Excel workbook,
users with the proper security and access rights can share spreadsheets throughout an
organization. As a result, you spend less time recreating reports and more time analyzing
information for effective decision-making.

Note: Quick Data is a WebFOCUS Business User Edition option, which requires a separate
license and installation. For more information about licensing Quick Data, contact your
Information Builders representative.
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To distribute and enable the Quick Data Add-in in your environment, follow the procedures
below.

Procedure: How to Distribute the Quick Data Add-in File

1. Copy the wfquickdata.xla add-in file and the configuration file, wfquickdata.cfg, located in
one of the following directories:

For Windows, drive:\ibi\WebFOCUS_BUE82\WebFOCUS\utilities\quickdata

For Unix, /ibi/WebFOCUS_BUE82/utilities/quickdata

2. Add the files to the following directory on the machines that use Quick Data.

C:\Users\userid\AppData\Roaming\Microsoft\AddIns\

where:

userid 

Is the name of the user logged on to the PC.

After the WebFOCUS Quick Data Add-in file is in the proper directory, you must open Excel and
select the WebFOCUS Quick Data option in the Add-Ins dialog box, as described in the
following procedure.

Note: If you already have Quick Data installed in your environment, be sure to backup your
existing wfquickdata.cfg file to preserve all your customizations. You can then copy your edits
from the existing wfquickdata.cfg file to the new file.

Procedure: How to Enable the Quick Data Add-In in Excel 2016

Use the following steps to enable the Quick Data Add-in in Excel 2016:

1. Launch Microsoft Excel 2016.

2. Click the File tab, click Options, and then click the Add-Ins category.

3. From the Manage dialog box, select Excel Add-ins, and then click Go.
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The Add-Ins dialog box opens, as shown in the following image.

Note: If WebFOCUS Quick Data is not listed in the Add-Ins dialog box, make sure that the
add-in is installed and placed in the correct directory.

4. Select the WebFOCUS Quick Data check box and click OK.

Procedure: How to Enable the Quick Data Add-In in Excel 2013

Use the following steps to enable the Quick Data Add-In in Excel 2013:

1. Launch Microsoft Excel 2013.

2. Click the File tab, click Options, and then click the Add-Ins category.

3. In the Manage dialog box, select Excel Add-ins, and then click Go.
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The Add-Ins dialog box opens, as shown in the following image.

Note: If WebFOCUS Quick Data is not listed in the Add-Ins dialog box, make sure that the
add-in is installed and placed in the correct directory.

If the Quick Data Add-in was installed in a different directory, use the Browse button in the
Add-Ins dialog box to locate it.

4. Select the WebFOCUS Quick Data check box and click OK.

Procedure: How to Enable the Quick Data Add-In in Excel 2010

Use the following steps to enable the Quick Data Add-In in Excel 2010:

1. Launch Microsoft Excel 2010.

2. Click the File tab, click Options, and then click the Add-Ins category.

3. In the Manage dialog box, click Excel Add-ins, and then click Go.
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The Add-Ins dialog box opens, as shown in the following image.

Note: If WebFOCUS Quick Data is not listed in the Add-Ins dialog box, make sure that the
add- in is installed and placed in the correct directory.

If the Quick Data Add-in was installed in a different directory, use the Browse button in the
Add-Ins dialog box to locate it.

4. Select the WebFOCUS Quick Data check box and click OK.

Procedure: How to Enable the Quick Data Add-In in Excel 2007

Use the following steps to enable the Quick Data Add-In in Excel 2007:

1. Launch Microsoft Excel 2007.

2. Click the Microsoft Office Button  in the top-left corner.

3. Click Excel Options and then click Add-Ins in the Excel Options dialog box.

4. From the Manage drop-down list, select Add-ins, and click Go.
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The Add-Ins dialog box opens, with WebFOCUS Quick Data listed as an add-in option, as
shown in the following image.

Note:

If WebFOCUS Quick Data is not listed in the Add-Ins dialog box, make sure that the
add-in is installed and placed in the correct directory.

If the Quick Data Add-in was installed in a different directory, use the Browse button in
the Add-Ins dialog box to locate it.

5. Select WebFOCUS Quick Data, and click OK.
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A WebFOCUS menu opens in the Add-Ins tab. The following image shows an example of
the WebFOCUS menu in Excel 2016.

WebFOCUS Quick Data Options

Once you have distributed the Quick Data Add-in, you can access the WebFOCUS Quick Data
Options, which are described in this topic. Except for Settings and Web Servers List, these
options are also available from Excel right-click context menus.

Create Query. Available for new queries only, this option opens the Web Server Connection
dialog box so that you can connect to WebFOCUS BUE. It continues by opening the Data
Source Selection dialog box so that you can select a Master File. It then opens InfoAssist+,
where you can create a query.

Edit Query. Available for existing queries only, this option opens InfoAssist+, where you can
edit a query.

Edit Query is not enabled for password-protected cells.

Edit Connection. Available for existing queries only, this option opens the Web Server
Connection dialog box, where you can edit the connection settings including the Web Server
URL, the HTML Alias, and the Client Path. The ability to edit connection information saves
time when you are reusing reports and helps facilitate the sharing of workbooks across an
organization.

Data Range Properties. Available for existing queries only, this option opens the External
Data Range Properties dialog box, where you can set Excel query properties.

Refresh Data. Available for existing queries only, this option refreshes the data in the
existing report query.

Refresh is not enabled for password-protected cells.
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Settings. This option opens the WebFOCUS Quick Data Settings dialog box, as shown in
the following image.

The WebFOCUS Quick Data Settings dialog box provides the following settings:

On-Demand Reporting Server Logon. This setting determines if the user will be
prompted to log on to the Reporting Server the first time that a connection to the server
is made during an Excel session (check this setting), or each time that a request is
made to the Reporting Server during an Excel session (do not check this setting).

Show Properties dialog when the query is created. When this setting is selected, a
dialog box with options on how to insert data into Excel opens each time that a new
query is executed.

Enable Tracing. This option allows you to capture WebFOCUS Quick Data information in
a trace file to troubleshoot communication problems and issues that may occur when
you attempt to create and run report requests.

The captured information includes tasks performed by the tool when it attempts to
connect to the web server and Reporting Server, when requests are made for data, and
when data is retrieved. The default name of the trace file is wfquickdata.txt. It is created
in the same directory as the WebFOCUS Quick Data Add-in file, for example:

C:\Users\user_id\AppData\Roaming\Microsoft\Addins\
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Traces are captured for the duration of a single active Excel session. Tracing is
automatically turned off when you close an Excel session. The trace file content is
cumulative. Added to the file is trace information from each session in which tracing is
enabled.

When you select Enable Tracing, the Trace File field is automatically populated with the
full path to the trace file. The path includes the trace file name. You can change the
location and name of the trace file by either typing the changes in this field, or by
clicking the ellipsis and browsing to a new trace file location.

To view the current trace file, click Open Trace.

To delete the contents of the current trace file, click Clear Trace.

You can forward your trace file to Information Builders Customer Support Services (CSS)
for analysis by the technical support team.

Web Servers List. This option opens a dialog box that displays a list of the configured web
servers, as shown in the following image. You can move the servers up or down in the list
to change the order of appearance, and delete servers from the list.

Configuring a Default WebFOCUS BUE Environment

A configuration file is provided with the Quick Data add-in for the Administrator to use as a
template when designing a default WebFOCUS BUE environment. The configuration file defines
items such as the WebFOCUS BUE web server port number, alias, and client path.
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Providing users with a default WebFOCUS BUE environment allows them to bypass the
additional step of manually defining web server connection parameters.

The configuration file is named wfquickdata.cfg. It is originally located in the following
directory: ..\ibi\WebFOCUS_BUE82\WebFOCUS\utilities\quickdata. After you have distributed
the Quick Data Add-in in your environment, the configuration file is placed in the new directory,
such as: C:\Users\userid\AppData\Roaming\Microsoft\AddIns.

The configuration file can contain multiple WebFOCUS configurations. Keep in mind that if the
configuration file contains more than one WebFOCUS configuration, the last one appearing in
the file is the configuration that is used when Quick Data is opened.

The configuration file provided as a template with the Quick Data add-in contains examples of
configurations and instructions to help you create your own configuration. The following
example displays a typical configuration:

SERVER_START
     PROTOCOL=”http”
     HOST=”localhost”
     PORT=”26000”
     HTML_ALIAS=”/ibi_apps/ibi_html”
     CLIENT_PATH=”/ibi_apps/WFServlet.ibfs”
SERVER_END

Note:

The use of double quotation marks around a parameter value, as shown in the example, is
optional.

Begin a comment line in the file with a number sign (#).

Use the following guidelines to create the configuration file:

The configuration file must have the same name as the Quick Data Add-in file, and must
have the extension .cfg, such as wfquickdata.cfg

The configuration file must reside on the machine running the Quick Data Add-in, in the
same directory as the .xla file.

Each WebFOCUS configuration must begin with the delimiter, SERVER_START, and end with
the delimiter, SERVER_END.

Each configuration must contain the following parameters in order to connect to WebFOCUS
BUE:

PROTOCOL. The protocol used in the environment running WebFOCUS BUE. If
WebFOCUS BUE is running in a Secure Sockets Layer (SSL) environment, you must
specify https as the protocol value. The default value is http.
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HOST. The name of the server on which the WebFOCUS BUE web application is
installed.

PORT. The port number of the application server on which WebFOCUS BUE is installed.

HTML_ALIAS. The alias of the web server or application server on which the WebFOCUS
BUE static pages are located. The default value is /ibi_apps/ibi_html.

Note: The leading slash is required.

CLIENT_PATH. The path to the WebFOCUS BUE Servlet, as defined in the WebFOCUS
BUE web application file, web.xml. The default value is

/ibi_apps/WFServlet.ibfs

where:

/ibi_apps

Is the default context root of the WebFOCUS BUE web application. The leading
slash is required. You can configure this value.

WFServlet.ibfs 

Is the name of the WebFOCUS BUE Servlet.

Managing the Server or Global Profile

A server or global profile, edasprof.prf, is created during installation of the WebFOCUS
Business User Edition. You can customize this profile, which is applied to all users.

The server profile can include almost any command that a client application can send to the
server. However, the server profile is used most frequently for application setup commands,
such as SET commands.

The server profile remains in effect throughout a user session. You can modify the server
profile default settings. You can also add any commands or code that all connected users
require before application processing begins.

Procedure: How to Manage the Server or Global Profile

1. Sign in to the WebFOCUS Business User Edition with the Manager user ID.

2. From the menu bar, click Administration, and then click Reporting Server Console.

3. Click the Workspace tab.

4. On the Workspace tree panel, expand Configuration Files.
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5. Right-click Server Profile and click Edit.

The server profile, edasprof.prf, opens.

6. Type the desired command, such as an application setup command, at the end of the file.

An example of an application setup command is SET ACRSVRBTITL = ON. For an Active
Technologies report, this command displays the title specified in the Master File, instead
of the name, to identify a column in an ACROSS group.

7. Click Save.
All commands typed in the profile in step 6 are in effect for any user who submits a
request for a report.
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Chapter3
Working With Data

Upload your own data sources and connect, join, and blend data, or learn about the
sample data sources that are packaged with the WebFOCUS BUE software.

In this chapter:

Working With Data Overview

Preparing Data for Upload

Uploading, Appending, and Merging Spreadsheets

Uploading Images and Documents

Connecting to Data and Editing Data

Using Data Preparation Options

Joining and Blending Data

Creating Virtual Fields

Working With Data Overview

There are two ways that you can connect to data in WebFOCUS BUE. You can upload a
Microsoft Excel spreadsheet or CSV file using the Upload wizard, or you can connect to an
existing table in a data source of your choice, using the Connect to Data wizard. Both
processes begin with identifying and preparing the data that you want to use. After your file or
table selection is complete, the wizard shows you the default breakdown of your data as
measures, dimensions, and hierarchies.

At similar points during the upload and connect processes, you can access options to
transform your data beyond the default settings. This includes joining multiple tables into a
cluster to create more fields and expand the scope of a synonym, editing geo roles and geo
encoding to prepare the synonym for use in mapping and location analysis, data profiling and
statistical analysis, changing columns or groups of columns into rows, and creating new or
editing existing field roles.
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Once a synonym is complete, you can upload it to a target environment or append it or merge
it with an existing synonym. You can also save it as a template to allow repeated
transformations if the same file is uploaded again in the future.

Understanding Your Data Structures

When you upload or connect to data in WebFOCUS BUE, you create a synonym that can be
used to build analytical content. Synonyms define unique names (or aliases) for each object
that is accessible from the Reporting Server. Synonyms are useful because they hide the
underlying data source location and identity from client applications. They also provide support
for extended metadata features of the Reporting Server, such as virtual fields and additional
security mechanisms.

Depending on the structure of the synonym that you are creating, the data inside a synonym is
typically broken down into categorized roles, such as measures, dimensions, hierarchies, and
attributes. As of WebFOCUS Release 8.2 Version 01M, you can utilize the Business View Plus
(BV+) functionality when you upload or connect to data. BV+ combines the power and
capabilities of traditional Business View (BV) and traditional Dimension View (DV) into a single
feature from which you can create a customized view of the data source. It also enables you to
create joins, measures, hierarchies, attributes, expressions, and filters.

In a traditional Business View, you can customize the view of a data source by grouping related
items that reflect the business logic for an application rather than the physical position of the
items in the data source. However, you are unable to indicate the role of each field in a
request.

In a traditional Dimension View, fields are categorized on the basis of their roles in a request.
Measures, numeric values that you can aggregate, such as gross profit or cost of goods sold,
are placed in measure groups. Dimensions, fields that categorize your data or can be used to
analyze and compare measures, are organized within hierarchies. And attributes, fields that
you can assign to any dimension field whether or not it is in a hierarchy, are organized within
levels or dimensions. While you can modify the categorization of fields in a dimension view,
you do not have the ability to create a custom view of the data source.
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Using BV+, you can group fields into folders, which represents the business view of the data,
and assign a role to each field, which indicates its role in a request. The Master File syntax is
simple, and provides all of the functions of traditional Business Views and Dimension Views.
Additionally, with BV+, you have the flexibility to create folders anywhere in the structure, as
well as reusing fields in multiple folders. For example, if you assign the Dimension role to a
field, it will automatically be added to the BY field container when you create a report with the
data. If you assign the Drill Level role to a successive field in a folder, and turn AUTODRILL on,
automatic drill downs are generated from the top levels to the bottom level in the generated
output.

Introduction to BV Namespace Modes

When you upload a file using the Upload wizard or create or open a synonym using the Connect
to Data wizard, the synonym opens in one of two modes for creating a BV+ structure,
BV_NAMESPACE=OFF mode or BV_NAMESPACE=ON mode. The mode in which the synonym
opens determines the types of BV+ structures you can add to your synonym. It also controls
the type of field name qualifiers that will be used, after the synonym is saved, when you create
a request using WebFOCUS tools, such as InfoAssist+ or App Studio.

You can set your Web Console preferences to open the Upload and Connect to Data wizards in
your preferred BV Namespace mode by going to the Workspace tab, clicking FOCUS Sets and
Info, clicking Settings for Web Console Preferences, and setting the parameter
AUTO_BV_NAMESPACE to OFF or ON. If you install a new Reporting Server, the default is OFF.
If you are editing a synonym, and it already contains a BV or DV structure, the presence of this
existing structure overrides your setting with BV_NAMESPACE=ON or BV_NAMESPACE=OFF,
respectively.

When you upload a file, the synonym has no existing BV or DV structure, so it respects the
mode you set in the Web Console. If you create a new synonym, or open an existing synonym
that has no BV or DV, it respects the parameter you set in the Web Console.

Reference: BV_NAMESPACE=OFF Mode

BV_NAMESPACE=OFF mode uses physical segment names to qualify field references in
reports. If you open an existing synonym that has a DV, it opens in this mode, regardless of
the setting you configured in the Web Console. In this mode, you can only add nodes that
conform to the DV structure. That is, you can add new measure groups and dimensions under
the existing measure group and dimension structure.
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The following describes the structures and actions that are available when you create new or
edit existing synonyms in BV_NAMESPACE=OFF mode:

Creating a new cluster synonym or opening an existing synonym that has no BV or DV. If
the synonym has no logical view defined, it opens with three default nodes in the Business
View pane, Filters and Variables, Measure Groups, and Dimensions, as shown in the
following image.

These nodes are based on a DV structure, and any edits you make to the synonym in this
pane using BV_NAMESPACE=OFF mode must adhere to this structure. The context menu
options provide only the structures available for a DV. You can insert a new measure group
under the Measure Group node or a new dimension folder under the Dimensions node, but
you cannot create a new node in the synonym. In a measure group folder, you can only
place measures. In a dimensions folder, you can only place dimensions. Under a
dimension, you can only add hierarchies, and under a hierarchy field, you can only add
attributes.
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Opening an existing synonym with a DV defined. Opens showing the DV organization and
icons in the Business View pane. The synonym syntax is converted to use BV+ folders with
the DV structure. You cannot create new folders, as you are limited to the structure already
defined in the Business View pane. The context menu options provide only the structures
available for a DV, as shown in the following image, which shows the content menu options
for the Measure Group folder.

Reference: BV_NAMESPACE=ON Mode

BV_NAMESPACE=ON mode uses logical folder names to qualify field references in reports. If
you open an existing synonym that has a BV, it opens in this mode, regardless of the setting
that you configured. In this mode, you can create your own logical view of the synonym. You
are free to add new folders and assign DV roles to fields and folders.

The exception to this is the Upload wizard. When you select a file in the Upload wizard, the BV
default structure. which is automatically populated is based on the three DV nodes. For
BV_NAMESPACE=ON, you are able to insert new folders anywhere in the structure. You are not
limited to the three default nodes.
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The following describes the structures and actions that are available when you create new or
edit existing synonyms in BV_NAMESPACE=ON mode:

Creating a new cluster synonym or opening an existing synonym with no DV or BV. No
nodes are pre-configured, as shown in the following image.

The context menu options provide all BV+ options.
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Opening an existing synonym with a BV defined. Opens in BV_NAMESPACE=ON mode,
showing the Business View structure defined within it. The context menu options provide
BV+ options, as shown in the following image.

Preparing Data for Upload

Uploading data to WebFOCUS BUE can be made easier if you familiarize yourself with the data
file first and ensure that it is properly formatted for upload, so geographic data, dimensional
hierarchies, and other important aspects of your data are recognized. This is important so that
the synonym created for your uploaded data provides the basis for quality analytical content.

You can use the following techniques to prepare your data for the uploading process.

Naming Conventions and Excel Sheet Names

For Excel spreadsheets, the name of the file is not important but the name of the worksheet
that contains your data is used to generate the synonym name. For the best results, follow the
guidelines below:

Ensure that the worksheet name is meaningful. For example, Store Sales is better than
Sheet1.
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Remove special characters from the worksheet name. Spaces will be converted to
underscores but all non-alphanumeric characters should be removed from the name, such
as:

/`~!@#$%^()-+={}|;,

Remove or replace NLS characters with standard alphanumeric characters.

The image below shows a worksheet with a meaningful name, Retail Sales.

While you have an opportunity to edit the worksheet name within the Upload wizard, doing it in
Excel may be preferable. Note that your spreadsheet data and column titles may contain
National Language Support data and special characters.

For CSV files, there is no worksheet name, so the CSV file name is used to generate the
synonym name. For this reason, all of the limitations identified for Excel worksheet names
apply to the CSV file name. Be sure to check and adjust the file name prior to the upload.
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Removing Introductory Information

Sometimes, an Excel spreadsheet contains formatted headings in the first few rows. This
information cannot be imported into WebFOCUS BUE and should be removed. Delete the
introductory rows and save the file before uploading. Alternatively, you can define a data range
within your worksheet and leave the introductory information in place. The following image
shows an example spreadsheet with a heading and subheadings highlighted.

Placing Column Titles in the First Row

For data to be useful in WebFOCUS BUE, your data columns must be identified and properly
described in the synonym that is generated during the upload process. You can make this
easier by ensuring that the first few rows of your Excel spreadsheet contain column titles that
are meaningful to you and to other users who will be using it. An example of meaningful
column titles is shown in the following image.

If your spreadsheet has more than one row of column titles, WebFOCUS BUE can merge the
information when creating the synonym. You will be given an option to specify how many first
rows of the Excel file contain title information in the Upload wizard.
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Removing Aggregated Information

Excel spreadsheets may contain subtotals, grand totals, and other non-data row information.
Data aggregation is performed by WebFOCUS BUE, so you should remove these kinds of rows
from your spreadsheet and save the file before uploading it.

Using Excel Named Ranges

Data ranges defined within your Excel worksheet can be helpful for the following reasons:

Your worksheet may have introductory information, such as formatted headings or non-data
information, in the first few columns.

You may not want to import all of the data columns found on your worksheet.

You can define a data range in your worksheet to remove the data that you want WebFOCUS
BUE to process during upload, and leave your spreadsheet in its original format. An example of
this is shown in the following image.

Preparing Hierarchical Data Columns

WebFOCUS BUE recognizes columns of data that have hierarchical relationships. This is useful
because the field names are arranged more logically in InfoAssist+ and because it facilitates
Auto drill capabilities in the content. Auto-drill lets you drill up and down a field hierarchy
automatically, making the content engaging and useful.
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To help WebFOCUS BUE recognize hierarchical columns correctly, ensure that the column titles
begin with a common word or words and are arranged left-to-right in the correct top-to-bottom
direction, as shown in the image below. In the Upload wizard, you can define and edit
dimension hierarchies prior to creating the synonym. You can also do this prior to the upload in
Excel.

Removing Date Formulas

Spreadsheets may contain a date column where the values are computed by Excel using a
formula. You need to convert these computed values into simple values before uploading a
spreadsheet. To remove date formulas, select a column, right-click, and then click Copy. Then
right-click the selected column again, and click Values. This can be found under the Paste
Options menu, which is highlighted in the following image. Menu options may vary by Excel
release. Now you can see that each cell contains a date value, and WebFOCUS BUE can
decompose your dates into useful components for use in InfoAssist+.
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Uploading, Appending, and Merging Spreadsheets

You can upload, append, or merge Excel spreadsheets or CSV files using the Upload wizard.
Before uploading a new file, you should review Preparing Data for Upload on page 293, to
ensure that your upload runs successfully.

After you upload a new file, you can append a file by adding new data to an existing synonym,
without changing the structure. This option is useful when you are working with a complex or
heavily edited synonym, by allowing you to retain all previous edits and data transformations.
You can also merge a file with your data and enhance the existing structure.

The procedures in this section provide step-by-step instructions for uploading, appending, and
merging files using the default settings in the Upload wizard.

Procedure: How to Upload Excel Spreadsheets

1. Launch the Upload wizard in one of the following ways:

From the Resources tree, right-click a domain or folder, point to Upload, and then click
Data.

In the Open dialog box, in InfoAssist+, click Upload Data.

On the Home page, under Quick Links, click Upload Data.

2. Drag the file that you want to upload into the Upload pane or click Select File, and navigate
to the location of the file on your machine.

Uploading, Appending, and Merging Spreadsheets

298  Information Builders



The next screen of the Upload wizard opens, as shown in the image below. You can use
the options on this screen to preview and change spreadsheets and delimited data files
before you upload them to the target environment. This screen shows you the default
breakdown of your data as measures, dimensions, and hierarchies.

For more information about the options that are available in this screen, see Wizard
Metadata Screen Reference on page 310.

3. On the ribbon, click Load and Next.

The Target Load Options dialog box opens.

Note: In WebFOCUS BUE the default target for the Upload Wizard is Hyperstage, which is
configured with a bulk load feature. If you change your target environment from the default,
and do not have a bulk load program that supports this environment, you may need to
clear the Bulk Load check box. For example, if you are using Microsoft SQL Server, you
may use a Bulk Copy Program (BCP). If you are unsure about whether you have a bulk load
program installed, contact your system Administrator.

4. Click Proceed to Load.
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If the load is successful, a window opens, and provides options to automatically generate
content from your data, create content using the new Master File, or close the Upload
wizard, as shown in the following image.

Note: If there are informational messages or if your upload is unsuccessful, the Status
screen opens.

5. Select what you want to do next.

Related Information:

Wizard Metadata Screen Reference on page 310

Procedure: How to Append New Data to an Existing Synonym

1. Launch the Upload wizard.

2. Drag the file containing the data that you want to append into the Upload pane or click
Select File, and navigate to the location of the file on your machine.

The next screen in the Upload wizard opens.

3. On the ribbon, in the Load group, click Load Options.

The Target Load Options dialog box opens.

4. From the Load Option drop-down list, click Append into Existing.

In the Select Target Synonym dialog box, select the synonym to which you want to append
data.
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Note: In WebFOCUS BUE the default target for the Upload Wizard is Hyperstage, which is
configured with a bulk load feature. If you change your target environment from the default,
and do not have a bulk load program that supports this environment, you may need to
clear the Bulk Load check box. For example, if you are using Microsoft SQL Server, you
may use a Bulk Copy Program (BCP). If you are unsure about whether you have a bulk load
program installed, contact your system Administrator.

5. Click OK.

6. On the ribbon, click Load and Next.

If the load is successful, a window opens, and provides options to automatically generate
content from your data, create content using the new Master File, or close the Upload
wizard.

Note: If there are informational messages or if your upload is unsuccessful, the Status
screen opens.

7. Select what you want to do next.

Related Information:

Wizard Metadata Screen Reference on page 310.

Procedure: How to Merge New Data With an Existing Synonym

1. Launch the Upload wizard.

2. Drag the file containing the data that you want to merge into the Upload pane or click
Select File, and navigate to the location of the file on your machine.

The next screen in the Upload wizard opens.

3. On the ribbon, in the Load group, click Load Options.

The Target Load Options dialog box opens.

4. From the Load Option drop-down list, click Merge into Existing.

In the Select Target Synonym dialog box, select the synonym to which you want to merge
your data.

5. From the If the record exists drop-down list, click the action you want to occur when a
record in the new spreadsheet matches a record in the existing data. You can choose to
reject the matching record, update the existing record, or delete the existing record. By
default, Update the existing record is selected.

6. From the If the record does not exist drop-down list, click the action you want to occur
when a record in the new spreadsheet does not match the record in the existing data. You
can choose to include or reject the record that does not match the existing record.
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Note: In WebFOCUS BUE the default target for the Upload Wizard is Hyperstage, which is
configured with a bulk load feature. If you change your target environment from the default,
and do not have a bulk load program that supports this environment, you may need to
clear the Bulk Load check box. For example, if you are using Microsoft SQL Server, you
may use a Bulk Copy Program (BCP). If you are unsure about whether you have a bulk load
program installed, contact your system Administrator.

7. Click OK.

8. In the Merge Editor dialog box, you can make additional changes to how your data is
merged, for each column in the spreadsheet.

You must create at least one matching expression before you load your data.

9. Click OK.

10. On the ribbon, click Load and Next.

If the load is successful, a window opens, and provides options to automatically generate
content from your data, create content using the new Master File, or close the Upload
wizard.

Note: If there are informational messages or if your upload is unsuccessful, the Status
screen opens.

11. Select what you want to do next.

Related Information:

Wizard Metadata Screen Reference on page 310.

Uploading Images and Documents

In WebFOCUS, you can upload other files, such as images and documents. These files can be
used to enhance visualizations and shared with other users and groups.

Procedure: How to Upload an Image

1. From the Resources tree, right-click a domain or folder, point to Upload and then click
Image. 
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The Image upload dialog box opens, as shown in the following image.

Note: Upload options may appear differently across browsers, because each browser
utilizes its own upload dialog box.

2. Click Browse to select your image. You can upload the following formats: .jpg, .png,
and .gif.

3. Select Publish Image(s) to provide other users with access to your images.

4. Click Upload.

A confirmation window opens.

5. Click OK.

Procedure: How to Upload a Document

1. From the Resources tree, right-click a domain or folder, point to Upload, and then click
Document. 

The Document upload dialog box opens, as shown in the following image.
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Note: Upload options may appear differently across browsers, because each browser
utilizes its own upload dialog box.

2. Click Browse to select your document.

3. Select Publish Document(s) to provide other users with access to your documents.

4. Click Upload.

The confirmation window opens.

5. Click OK.

Connecting to Data
and Editing Data

Aside from uploading data, you can create synonyms by connecting to various data sources.
The Connect to Data wizard leads you through this process and allows you to establish a
connection to many native data sources. The data source being used determines the type of
metadata that is required. For example:

When the server accesses a relational data source, it needs to know how to interpret the
data stored there. You must create a synonym that describes the structure of the data
source and the server mapping of the data types.

When the server invokes a transaction or procedure, it needs to know how to build the
request, what parameters to pass, and how to format an answer set from the response.
You must create a synonym that describes the layout of the request or response area.

Whatever your data source, the adapter you are using manages the synonym creation process
for you, creating a synonym that meets your specific requirements.

Note: Although all synonym creation panes have the same look and feel, the parameters are
specific to each adapter. To obtain detailed information for an adapter, click the question mark
(?) next to a parameter.

Creating a Synonym With the Connect to Data Wizard

The Connect to Data wizard provides a step-by-step process for configuring adapters that
connect to data sources that you can use to build reports, charts, and visualizations in
InfoAssist+.

Using the Connect to Data wizard, you can perform the following steps:

1. Connect to SQL. Configure an adapter, create a new connection, or change connection
parameters.

2. Import Metadata. Create a synonym for one or more data sources.
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3. Edit Metadata. Enhance metadata by adding measures, dimensions, and dimension
hierarchies.

These steps are displayed in the navigation screen, as shown in the following image. As you
complete the tasks for each step, the tool automatically takes you to the next step in the
process. If you want to go directly to a specific step, click the step and the corresponding
window opens.

You can launch the Connect to Data wizard in one of the following ways:

From the Resources tree, right-click a domain or folder, point to Metadata, and then click
Connect to Data. 

In the Open dialog box, in InfoAssist+, click Connect to Data.

On the Home page, under Quick Links, click Connect to Data.

Step One: Connect to SQL

The first step in the Connect to Data wizard is creating a connection to your data, which will
allow you to modify your data for use in WebFOCUS. You can configure a new adapter or
connection, add a connection to an existing adapter, or change adapter connections. 

Procedure: How to Configure a New Adapter/Connection

1. From the Configure connection screen, click New Adapter/Connection.
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The Configure Adapter screen opens, as shown in the following image.

2. Select the radio button for the adapter and click Next.

Note: To sort the available adapters, click the column headers and choose from the
available options to sort in ascending or descending order. You can also reset to the
original order.

The Add to Configuration screen opens.

3. Enter the parameters for the specific adapter and click Configure.

Procedure: How to Add a Connection

1. From the Configure connection screen, click Add Connection.

The Add Connections screen opens.

2. Select the radio button for the adapter and click Next.

3. Enter the parameters for the specific adapter and click Configure.

Procedure: How to Change a Connection

1. From the Configure connection screen, click Change Connection.

The Edit Connections screen opens.

2. Select the radio button for the connection and click Next.

Note: You can click the Adapter, Connection, Connection string, or Profile columns to sort
the available connections.

3. Change the parameters for the specific connection and click Configure.
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Step Two: Import Metadata

Once you configure a connection, you must select the metadata that you want to import. The
first screen that you see is the Select connection to create synonyms screen. Here, you select
the connection to your data.

Procedure: How to Import Metadata

1. Select the radio button for the adapter and click Next. 

The Select Synonym Candidates screen opens.

2. Select or enter the parameters for each screen and click Next.

The Create Synonym screen opens.

3. Select one or more synonym check boxes.

4. Click Next.

The synonyms are created in the application directory.

Step Three: Edit Metadata

Using the first screen in this step, you can manage and enhance your metadata as required, to
simplify and enrich future analytics. This screen shows you the default breakdown of your data
depending on the BV+ mode you have set in the Web Console parameter,
AUTO_BV_NAMESPACE. By default, when you install a new Reporting Server, this parameter is
set to OFF, which means that your data is uploaded in BV_NAMESPACE=OFF mode, and is
categorized into measures, dimensions, and hierarchies. By default, you can see your fields
interpreted as measures and dimensions, as shown in the following image. You can modify the
synonym structure by using the ribbon functions and the shortcut menu options available in the
Business View Pane.
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For more information about the options that are available in the Edit Metadata screen in the
Connect to Data wizard, see Wizard Metadata Screen Reference on page 310.

Related Information:

Pivoting Repeating Columns Into Rows on page 342.

Creating Hierarchies on page 344.

Creating Clusters on page 341.

Creating Folders and Assigning DV Roles on page 345.

Editing And Deleting Metadata

You are able to edit or delete previously created synonyms using the shortcut menu.

Procedure: How to Edit a Synonym

1. Right-click a synonym and click Open, as shown in the following image.
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The Data Assist opens, where you can modify your synonym.

Note: When you open an existing synonym in this way, the Master File opens in
BV_NAMESPACE=OFF or BV_NAMESPACE=ON mode, depending on the existing BV or DV
structure.

2. Make edits to the synonym, as required.

3. To save your synonym, click File, and then click Save.

4. Close the Reporting Server window.

Procedure: How to Delete Metadata

1. Right-click the synonym that you want to delete, point to Data Management, and then click
Delete All Data.

A confirmation window opens, alerting you that you are deleting every row of data.
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2. Click OK to proceed.

3. To remove the synonym file from the view, right-click this synonym again and then click
Delete.

4. Close the Reporting server window.

Using Data
Preparation Options

The Upload wizard and Connect to Data wizard offer a suite of data preparation options, which
are designed to help you prepare your data for future analytics. With these data preparation
tools, you can assess your data for validity and consistency, troubleshoot errors, and enhance
accuracy and uniformity of your data. The following sections describe these options and
explain how to use them.

Wizard Metadata Screen Reference

When you use the Upload wizard or Connect to Data wizard, your data opens in a wizard
metadata screen, where you can preview and modify your synonym before you upload it to the
target environment. The options available to you in this screen, in either wizard, are context
sensitive. The following screen shows the metadata screen that opens when you upload a
spreadsheet using the Upload wizard.
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The wizard metadata screens consist of two sections:

Ribbon. Provides access to data preparation functions that you can use to customize your
synonym.

Panes. Present areas of functionality that you can use to preview or modify the elements of
the synonym.

Ribbon

The following image shows the ribbon of the wizard metadata screen that is available when you
upload a spreadsheet.

The following sections describe the groups and functions of the wizard metadata screen
ribbon. Some options are specific to the Upload wizard, while others are specific to the
Connect to Data wizard.

Help

The Help group contains the Test, Tutorials, and Help buttons. You can use the Test button to
open the Session Log window, clear the session log, view the synonym being prepared in a text
window, and view a list of prepared worksheets.

The options in the Test button include:

Session Log 

Opens the Session Log window. The session log contains all of the commands that have
been processed for the current upload session. Using this window, you can filter the log
file, clear the log file, download the log file to your machine, refresh the log, and manage
your server agents.

Clear Session Log 

Deletes all content from the log file.

View MFD 

Opens the Master File being prepared in a text window. You can search for text within the
Master File.
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View AFD 

Opens the Access File being prepared in a text window. You can search for text within the
Access File.

Prepared Worksheets 

Opens a window that lists the prepared Worksheets and the details of each, including the
date on which it was prepared, the number of rows and columns, whether there is a
header row, and the names of the target application, target synonym, target table, target
adapter, and target connection.

The Tutorials button opens two high-level documents that outline the main functions of the
Upload wizard, including the basic flow of common procedures, and the Business View +
capabilities.

The Help button opens the Web Console online Help.

Undo/Redo

The Undo / Redo group contains the Undo and Redo options. You can use these options to
reverse the last action you performed, or to cancel your last Undo action. For example, if you
renamed a field, but do not want to save it, you can click Undo.
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Preparation

The Preparation group contains options that you can use to review your data and prepare it for
upload. The options are only available when you use the Upload wizard, and include:

Preparation Options 

Opens the Preparation Options dialog box, where you can set the following options for
Excel spreadsheets.

Scan all rows 

Scans all records to determine data type for each column

Row scan limit 

Indicates how many worksheet rows are scanned to determine the formats of the
columns. Set this value to 0 if you want to scan all of the worksheet rows.

Extend character length 

Extends character length by the percentage specified.

Column format recognition
Sets the column format to loose or strict.

Number of header rows 

Sets the number of rows used as a header row in the worksheet. Set the value to 0 if
a header is not used.

Add RowID Column
Adds a row ID column to your data. This option is only available for Excel
spreadsheets.

Decompose Date fields into components 

Decomposes Date fields into Year, Quarter, Month, and Day components.

Date Order 

Allows you to select a format in which the Date fields appear.

Activate GEOGRAPHIC_ROLE assignment 

Assigns geographic roles based on column name analysis.
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The following options are also available from the Preparations Options dialog box, when
you upload a comma separated values (CSV) file:

Non-printable Delimiter 

Defines whether the string in the delimiter field is a printable string or a non-printable
decimal character.

Field Enclosure 

Allows you to select an enclosure characters for each field from the number of
available options, which include: none, single quote, double quote, space, and type-in
enclosure. The default value is double quote.

Header row 

Defines if the header line be used as column names.

Preserve format 

Indicates whether the original data layout, including empty records and linefeeds, will
be preserved.

CODEPAGE 

Specified the code page for the stored data that will be added to the Master File of the
generated synonym.

CDN 

Continental Decimal Notation (CDN) determines the punctuation used in numerical
notation for input data.

Raw Data 

Displays the raw data of the file to be uploaded in the Output Pane.

Error Check 

Produces informational messages, if the uploaded file contains inconsistent data, based
on the first row of data. The Error Check result is displayed in the Output Pane.

Templates

The Templates group contains options that you can use to create and apply a template to your
selected file. These options are only available when you use the Upload wizard, and include:

Save 

Saves the existing synonym as a template.
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Invoke 

Opens the Select Template name dialog box, where you can choose a saved template that
you created earlier.

Metadata

The Metadata group contains several data preparation options that you can use to enhance
your data. This includes defining virtual fields, creating Compute and Variable fields, joining
data sources, and pivoting rows of data into columns. The options include:

Define 

Opens the Expression builder, where you can create a define field.

Compute 

Opens the Expression builder, where you can create a compute field.

Variable 

Opens the properties dialog box, which provides access to the following options:

Variable Name 

Specifies the name of the variable.

Prompt Caption 

A description of the variable that will appear in the prompt.

Default Value 

Specifies the default value of the variable.

Prompt Values 

Provides a drop-down menu of optional prompt values for the variable. The options are
Input box, Static list of values, Static list of values/captions, Synonym based dynamic
list of values, and Procedure based dynamic list of values.

Quoted 

If selected, this option adds single quotation marks around the variable.

Usage Format 

Provides a drop-down menu of date formats for the variable. The options are Integer,
Character (fixed), and Decimal.
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Join Editor 

Opens the Join Editor dialog box, where you can join multiple worksheets to create a
cluster.

DBA
Opens the DBA dialog box, where you can edit the access to your data. This option is
available only when you use the Connect to Data wizard.

Pivot 

Opens the Pivot Prepared Data dialog box, where you can pivot any repeating columns or
groups of columns into rows.

Sample Data

The Sample Data group contains options that you can use to toggle the Autorun and Data
Preview options On and Off, stop the current request, and view the Sample Data in the Output
Pane to instantly visualize field values.

Autorun 

Provides access to the following options:

Off 

Disables autorun in the Output Pane.

On

Enables autorun in the Output Pane.

Data Preview

Provides access to the following options:

Off

Disables the display of data values in the Business View Pane.

On

Enables the display of data values in the Business View Pane.

Sample Data

Runs the Sample Data request in the Output Pane.

Options

The Options group consists contains the View and Options functions. You can use the View
button to customize your view of the wizard you are using. You can use the Options button to
specify options for generating and displaying the synonym and set upload limits.
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Click View to access the following options to customize your screen:

Reset View 

Reverts all your screen customizations to the default view.

Grid Details 

Provides access to the following options:

View as Columns 

Displays data in columns inside panes. This option is enabled, by default.

View as Tooltip 

Displays data in tooltips, as you hover over fields.

Table/Column Pane 

Provides access to the options that control placement of the Table/Column Pane on the
screen, such as:

Tile Horizontal 

Displays panes on the screen in the horizontal succession. This option is enabled, by
default.

Tile Vertical 

Displays panes on the screen in the horizontal succession.

Show 

Displays the Table/Column Pane on the screen.

Hide 

Hides the Table/Column Pane from view. This option is enabled, by default.

Business View Pane
Provides access to the options that control placement of the Business View Pane on the
screen, such as:

Show
Displays the Business View Pane on the screen.

Hide
Hides the Business View Pane from view. This option is enabled, by default.
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Filters/Groups Pane 

Provides access to the options that control placement of the Filters/Groups Pane on the
screen, such as:

Show 

Displays the Filters/Groups Pane on the screen.

Hide 

Hides the Filters/Groups Pane from view. This option is enabled, by default.

Output Pane 

Provides access to the options that control the placement of the Output Pane on the
screen, such as:

Show Floating 

Undocks the Output Pane, so it can be moved around the screen.

Show Docked 

Docks the Output Pane on the right side of the screen. This option is enabled, by
default.

Show Maximized 

Enlarges the Output Pane to the size of the screen.

Hide 

Hides the Output Pane.

Multiple Output Panes 

Provides access to the options that control the appearance of multiple Output Panes on
the screen, such as:

Show All Tabbed 

If this option is selected, all output requests are shown in the Output Pane in tabs.
This option is selected, by default.

Show Only Latest 

If this options is selected, the single-tab Output Pane is reloaded to display the latest
output request.
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Click Options and select Advanced to open the Options dialog box and select the following
synonym creation options:

Synonym Editor
Provides access to the following options, when you use the Connect to Data wizard.

Support extended options
Allows you to insert sort object styling.

Column Management 

Provides access to the following options.

Name display strategy 

You can select how the column names are displayed in the Tables/Columns Pane
from one of the following choices:

Name. Assigns the FIELDNAME attribute from the synonym as the column name
displayed in the Tables/Columns Pane.

Title. Assigns the TITLE attribute from the synonym as the column name displayed
in the Tables/Columns Pane. TITLE is the default value.

Description. Assigns the DESCRIPTION attribute from the synonym as the column
name displayed in the Tables/Columns Pane.

Alias. Assigns the ALIAS attribute from the synonym as the column name displayed
in the Tables/Columns Pane.

Function display strategy 

Selects the functions information that displays in the Expression Builder, and on the
shortcut menu for a column, when you add a function to the synonym. Select one of the
following values:

Syntax. The function syntax (function name and parameters) is displayed. This is the
default value.

Short Description. A short description of what the function calculates is displayed.
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Language Generation Options 

Provides options for generating field names and synonym references in the synonym being
prepared.

Use segment to qualify field reference 

Specifies when the segment name should be added to the field name in order to
qualify the field name. Select one of the following values:

For duplicate fields. Uses the segment name to qualify the field name only when
multiple segments contain the same field name. This is the default value.

Always. Uses the segment name to qualify the field name.

Use application name to qualify synonym reference 

Specifies whether synonym references in the synonym being prepared will include the
application name. Select one of the following values:

Yes. Adds the application name to synonym references (appname/synonymname).
This is the default value.

No. Does not add the application name to synonym references.
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Limits 

Sets limits for working with the Upload or Connect to Data wizard.

Maximum number of rows for test 

Sets the maximum number of rows of sample data displayed. The default value is 50.

Maximum number of columns for test 

Sets the maximum number of columns of sample data displayed. The default is
999999.

Maximum number of identical error messages 

Sets the maximum number of identical error messages that can be generated by the
wizard.

Random Sampling limit (in %) 

Defines the percentage for the random sample that is used for statistical analysis.

Undo/Redo Limit 

Sets the maximum number of undo and redo actions supported. The default value is
50.

Omit missing (null) values in Data Profiling charts
Omits any missing or null values in the data source.

Load

The Load group contains the Load Options and Load Data items. These options are only
available when you use the Upload wizard.
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Click Load Options to select the following data loading options. These options may change
depending on the target adapter selected.

Load Option 

Provides access to the following options:

New 

Uploads a new worksheet to create a synonym.

Append Existing Data 

Adds new data to the existing synonym without changing the structure and parameters
of the synonym.

Merge with Existing Data
Merges new data with the existing synonym.

Adapter 

Allows you to select a database, in which the unloaded data is stored.

Connection 

Specifies a connection for the selected adapter.

Synonym Application 

Specifies the application directory for the synonym. Click the ellipsis button to change this
directory.

Synonym 

Specifies the name of the synonym, as appears in the repository. By default, the name is
the same as the name of the source worksheet.

Data File 

Contains the name of the DFIX target data file in the database. This option is only
available if you are uploading a .CSV file.

Table Name 

Indicates the name of the target table in the database.

Bulk Load 

Specifies the method of loading data. This option is enabled, by default.

Key columns derived from
Contains a list of candidate fields from which you can select one or more to be used as
the primary key of the target table.
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Field Delimiter 

Allows you to select a column separator from the number of available options, which
include: none, comma, tab, pipe, space, semi-colon, colon, type-in delimiter. The default
value is comma. This option is only available if you are uploading a .CSV file.

Header row 

Defines if the header line be used as column names. This option is only available if you
are uploading a .CSV file.

Field Enclosure 

Allows you to select an enclosure characters for each field from the number of available
options, which include: none, single quote, double quote, space, and type-in enclosure.
The default value is double quote. This option is only available if you are uploading a .CSV
file.

Overwrite Existing Synonym 

Overwrites the existing synonym with the same name.

Click Load Data to upload your synonym to the repository without leaving the Upload wizard.
The Load Data button also brings up the Load Options dialog box, allowing to review and
modify your loading parameters.

Load and Next

The Load and Next function uploads your synonym to the repository and brings you to the next
screen, where you can select how to use your synonym. This option is only available when you
use the Upload wizard.

Save and Next

The Save and Next function saves your changes and brings you to the next screen, where you
can select how to use your synonym. This option is only available when you use the Connect to
Data wizard.

Panes

The wizard metadata screen contains the following panes:

Table/Column

Business View

Filters/Groups
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Output

The default view displays Business View and Output Panes. You can customize the view of your
screen by clicking View on the ribbon.

Table/Column Pane

The Table/Column Pane displays the fields in the same order as they are displayed in the
source file.

The Table/Column Pane is shown in the following image.

The Table/Column Pane has the following options:

Display 

Toggles between the Columns, Business View, and the Join Editor view of folders options.
The Join Editor option launches the Join Editor dialog box, where you can create clusters.
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Find 

Opens the search field, where you can type the name of the field that you want to find and
allows you to modify your search options.

View 

Provides access to the following options:

Expand All 

Expands all nodes, folders, and hierarchies.

Collapse All 

Collapses all nodes, folders, and hierarchies.

Choose Columns 

Opens the Choose Columns dialog box, where you can select the columns that you
want to display in the Business View Pane.

Reset to defaults 

Reverts the pane to its default view.

Business View Pane

The Business View Pane shows you how the Upload wizard and Connect to Data wizard
interpret and categorize your data. The numeric values, such as Gross Profit or Cost of Goods,
are interpreted as measures. The alphanumeric values, such as Product or Geography,
become dimensions. Dimensions, which categorize data, can be organized into hierarchies to
define the relationships between the fields in the hierarchies. For example, a Geography
hierarchy can contain the Continent, Country, State, and City dimensions. You can also assign
dimension attributes to any dimension field, whether or not it is in a hierarchy. When applied to
a field, attributes provide supplementary information that can be used for analysis or display.
For example, in a Geography hierarchy, which includes the Country, State, and City dimensions,
Population can be assigned as an attribute of the City dimension. Each category of data is
represented by an icon. The following table identifies these icons and describes what they
represent.

Icon Identifies Description

Measure group Contains individual measures.
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Icon Identifies Description

Measure Measure is a numeric field. It resides inside a
measure group. Measures can be moved between
measure groups and between measures and
dimensions areas.

Dimension folder Contains dimensions, dimension hierarchies, and
attributes.

Dimension Hierarchy Resides inside the dimension folder and contains
individual dimensions and associated attributes.

Dimension Dimension is an alphanumeric field. It resides
inside the dimension hierarchies. Dimensions can
be moved between dimension folders, between and
outside dimension hierarchies. You can move a
dimension into a measure group and turn it into a
measure. You can also move a dimension inside an
attribute folder and turn it into an attribute.

Attribute folder Contains individual attributes associated with a
dimension.

Attribute Resides inside an attribute folder. Attributes can be
moved between attribute folders. If you move an
attribute outside an attribute folder, it inherits the
identity of a hierarchical level to which it is moved.
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The Business View Pane is shown in the following image.

The Business View Pane has the following options:

Reset Defaults 

Eliminates all changes and reverts the view back to the initial categorization of your data.

Flatten 

Removes dimension hierarchies and displays individual dimensions under the Dimensions
folder.

Display
Toggles between the Columns, Folders, and Modeling View of Folders displays.

Hide All 

Hides all fields from the view.

Note: When a field is hidden, it is moved to the Table/Column Pane. This pane is hidden,
by default. For more information on how to access this pane, see Options.
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BV
Opens a menu, where you can change BV_NAMESPACE=OFF and BV_NAMESPACE=ON
modes for your session. By default, the wizards create a Business View structure in with
BV_NAMESPACE=OFF, which adheres to a fixed structure of measures, followed by
dimensions, hierarchies, levels, and attributes, using a folder structure in the synonym.
You can insert new entries, but are limited to existing structure types. When you select
BV_NAMESPACE=ON, you can insert new folders and increase the flexibility of your
metadata.

Find 

Opens the search field, where you can type the name of the field that you want to find and
allows you to modify your search options. Any occurrence of the search string found in the
pane is highlighted.

View 

Provides access to the following options:

Expand All 

Expands all nodes, folders, and hierarchies.

Collapse All 

Collapses all nodes, folders, and hierarchies.

Choose columns 

Opens the Choose Columns dialog box, where you can select the columns that you
want to display in the Business View Pane.

Reset to defaults 

Reverts the pane to its default view.
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Each node in the Business View Pane opens a context-sensitive shortcut menu that can be
used to insert and modify folders or fields, view sample data, perform statistical analysis and
data preparation techniques. You can access these options by right-clicking each level. These
shortcut menu options are conditional and depend on the type of an element and its place in
the synonym structure. In addition, these options are different if you are editing your synonym
in BV_NAMESPACE=OFF mode or BV_NAMESPACE=ON mode. The following list identifies the
shortcut menu options for your synonym in both modes.

Insert 

Depending on the context, provides access to the following options:

New Measure Group 

Creates a new measure group inside this Measure Group folder.

New Dimension Folder 

Creates a new dimension folder inside the Dimensions node.

New Parent/Child Hierarchy 

Opens the Create a Parent/Child Hierarchy dialog box, where you can create a new
hierarchy.

New Levels Hierarchy 

Creates a new level hierarchy inside this dimension folder.

New Folder
Creates a new folder, which functions as a segment to provide a view of the synonym
and to define the accessible fields and their relationships. You can assign a DV role,
such as Dimension, Measure, or Attributes to each new folder that you create. This
option is only available in BV_NAMESPACE=ON mode.

Filter 

Opens the Filters/Groups Pane, where you can create or modify a filter.

Character Function 

Provides a choice of preconfigured character functions that open in the Function Assist
for New Define dialog box.

Conversion Function
Provides a choice of preconfigured conversion functions that open in the Function
Assist for New Define dialog box.

Geography Function
Provides a choice of preconfigured geographical functions that open in the Function
Assist for New Define dialog box.
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Numeric Function 

Provides a choice of preconfigured numeric functions that open in the Function Assist
for New Define dialog box.

Advanced Function 

Opens the Define dialog box, where you configure a new function.

Grouping 

Opens the Filters/Groups Pane, where you can configure group values.

Group Numeric (Binning) 

Opens the Binning wizard, where you can configure a numeric group.

Aggregation Function 

Provides a choice of preconfigured aggregation functions that open in the Function
Assist for New Compute dialog box.

Analytic Function 

Provides a choice of preconfigured analytic functions that open in the Function Assist
for New Compute dialog box.

Advanced Aggregation 

Opens the Compute dialog box, where you can a compute field using advanced
aggregation options.

Properties 

Opens the Properties dialog box. For more information, see Using the Properties Dialog Box.

Pivot 

Opens the Pivot Prepared Data dialog box, where you can pivot any repeating columns or
groups of columns into rows.

DV Role
Opens a sub-menu that allows you to assign a DV role, such as Dimension (Standalone or
Drillable), Measure, or Attribute, explicitly to a field or folder. You can also choose to have
the field inherit its role from a parent. This role moves with the field if you drag it to
another location in the BV+ structure. If you do not explicitly assign a DV role, the role
changes as you move the object under a new parent, except if you drop it onto a field with
the Drill Level role. This option is only available if you are in BV_NAMESPACE=ON mode.

Geographic Role 

Opens a sub-menu, where you can configure a geographic role for the field.
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Create Hierarchy 

Transforms the dimension into a hierarchy. This option is only available for standalone
dimensions.

Remove Hierarchy 

Removes a hierarchy and displays all the items inside this hierarchy as individual
dimensions.

Remove from Hierarchy 

Removes the field from a hierarchy. This option is only available for the dimensions that
are part of a hierarchy.

Show/Hide Attribute 

Toggles between displaying or hiding attributes for the field.

Sample Data 

Displays the sample data for all the measure groups inside this measure group folder in
the Output Pane.
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Data Profiling 

Provides access to the following options:

Statistics 

Displays statistic analysis of the field in the Output Pane.

Hex View
Displays the data in hexadecimal format.

Values 

Displays the values for this field for the selected number of rows in the Output Pane.

Values (Bar Chart) 

Displays the values for the field in a bar chart in the Output Pane. The chart is limited
to 50 values.

Values (Pie Chart) 

Displays the values for the field in a pie chart in the Output Pane.

Duplicate Values 

Displays the duplicate values for this field for the selected number of rows in the
Output Pane.

Outliers
Displays the outliers for this field in the Output Pane.

Impact Analysis 

Displays the impact analysis results in the Output Pane.

Rename 

Opens the Rename dialog box where you can rename the field.

Hide 

Moves the field to the Table/Column Pane.

Note: This pane is hidden, by default. For more information on how to access this pane,
see Options.

Cut 

Cuts the field from its directory.
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Paste 

Pastes an item inside the directory.

Using the Properties Dialog Box

You can use the Properties dialog box to change settings for your data, such as appearance,
formatting, data descriptions, and others. The options in this dialog box change depending on
the type of data you are editing.

An example of the Properties dialog box is shown in the following image.

The Properties dialog box is organized into various groups, as described below.

Note: The location of these properties within the different groups may change if you are using
BV_NAMESPACE=OFF mode or BV_NAMESPACE=ON mode.

General Group

Contains general properties that can be applied to various elements.

FOLDER
Indicates the name of virtual segment that you have selected.

PARENT
Identifies the name of the parent, for the virtual segment that you have selected.

DESCRIPTION
Provides additional information about the folder that you are viewing. This is an optional
attribute.
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FIELDNAME 

Indicates the name that is used to reference this data element in the request.

BELONGS_TO_SEGMENT
Identifies the segment where the field resides in the original Master File.

TITLE 

Specifies an alternative report column title for the field.

Usage Format 

Describes how to format a field when displaying it in a report or using it in a calculation.

Type 

Allows you to select a data type for this field, as it is stored in the data source.

Length 

Describes the length of data as it is stored in the data source.

Number of decimal places 

Specifies the number of digits that follow the decimal point.

Options 

Displays options for this field.

Negative 

Allows you to select a format in which negative numbers are displayed.

Comma 

Allows you to choose whether large numbers are displayed with a comma.

L - Leading zeroes 

If selected, adds leading zeroes to a number.

S - Print blank for zero 

Specifies whether to display the blank field, if the data value is zero.

Percent sign 

For the percentage values, toggles between displaying a percentage sign only, or
calculating the percentage value and displaying a percentage sign.

E - Scientific notation 

If selected, only significant digits are displayed.
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Currency
If selected, provides access to the Currency Code and Currency Symbol Position options.

Currency Code 

Provides access to ISO currency code formats.

Currency Symbol Position
Indicates the position of the currency symbol.

Legacy Currency
Provides the extended currency symbol display options. Select a currency symbol that
displays in the report output, regardless of the default currently symbol that is configured
for National Language Support (NLS).

Component Order
Sets the order of the date components, such as MDYY or DMYY.

Month
Sets the display options for a month component.

Day of the Week
Sets the display options for the day of the week component.

Separator
Specifies the element that you can use to separate date components, such as with
commas or hyphens.

DV Role 

Identifies the dimension view hierarchy the property represents. These options include
Dimension (Standalone), Dimension (Drill Level), Measure, Attribute, and Inherit from
parent.

DBMS/Source Data Attributes

Contains supplemental properties that you can define for metadata.

ALIAS
Specifies the name of the field, as it appears in the synonym. If you are using
BV_NAMESPACE=ON mode, this property appears under the General group.

ACTUAL
Describes the type and length of data as it is stored in the data source.

Type 

Allows you to select a data type for this field, as it is displayed in a report or used it in a
calculation.
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Length 

Describes the length of data as it is displayed in a report or used it in a calculation.

DATEPATTERN
Specifies the date pattern that is used for conversion from a date or date time that is
stored as an alphanumeric field to a data or data time format.

MISSING 

If selected, allows null values to be entered into and read from a field in data sources that
support null data.

Miscellaneous Group

Contains supplemental properties. All properties in the Miscellaneous group are disabled, by
default.

REDEFINES
Enables you to redefine or recompute a field name that exists in more than one segment.
A DEFINE expression may not contain qualified field names.

WITH
Associates the DEFINE with a real field from the synonym.

DESCRIPTION 

Creates an attribute for comments and remarks within a field.

ACCEPT 

Creates an attribute that can be used to populate an auto-prompt dialogue box or to
validate data as it is entered into a field from a MODIFY procedure.

PROPERTY 

Indicates the place of the field in the hierarchy of the Master File.

REFERENCE 

Shows field attributes, such as physical parent/child relationships among the elements in
the file.

DATASET 

Specifies a physical name of the data source or alternate index.

FIELDTYPE 

Specifies the type of the field.

I - Index 

If selected, the field is displayed as an index field.
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R - Readonly 

If selected, the field is displayed as a read-only field.

Prompt Values
Adds optional prompt values for a define.

ACCESS_PROPERTY 

Specifies access options for the field's data. If you are using BV_NAMESPACE=ON mode,
this property appears under the General group.

INTERNAL 

If selected, the field does not appear in the list of available fields or Sample Data. If you
are using BV_NAMESPACE=ON mode, this property appears under the General group.

NEED_VALUE 

If selected, the field requires a value to access the data.

Select By 

Allows you to set a selection parameter. The choices are: value, range, and multiple
values.

HELPMESSAGE 

Allows you to add a help message to the field.

GEOGRAPHIC_ROLE 

Defines a geographic role of the field.

TEMPORAL_PROPERTY 

Specifies a temporal property of the field.

USE_STYLE 

Allows you to select a style for the field.

Filters/Groups Pane

The Filters/Groups Pane automatically opens when you create a new filter or group. When you
open two or more items at the same time, they display nested in the same pane.
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An example of the Filters/Groups Pane is shown in the following image.

Depending on the field type, the Filters/Groups Pane displays the following options:

Find 

Opens the search field, where you can type the name of the field that you want to find and
allows you to modify your search options.

Expand 

Maximizes the section of the pane.

Drop-down arrow 

Provides access to the following options for filters:

Display 

Determines a display format for the filter. The options include: text box, double list,
check-box list, pull-down list, and slider. The default option is slider for Numeric fields
and check box for all other fields.
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Relation 

Creates a relational expression. The options include: EQ, NE, LT, GT, LE, GE, and
Range. The default value is Range for Numeric and EQ for all other fields.

Values 

Toggles between showing and hiding the NULL values for this field.

Hide Filter Card 

Removes filter data from the Filters/Groups Pane, while leaving the pane open.

Delete Filter 

Deletes the filter from the synonym.

Properties 

Opens the Filter properties dialog box, where you can change the Title for the filter,
and view its Name and Base field name properties.

Move Up 

Moves the filter up in the Filters/Groups Pane.

Move Down 

Moves the filter down in the Filters/Groups Pane.

Provides access to the following options for groups:

Display 

Determines a display format for the group. The options are: Double List and Single
List. The default value is Single List.

Add all shown values to a new group 

Selects all values and adds them to a new group.

Create a New Group 

Creates a new empty group, to which you can add values manually.

Edit properties 

Opens the Edit properties dialog box, where you can edit the Name, Title, and Default
Value properties.

Hide Group Card 

Removes the group data from the Filters/Groups Pane.
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Move Up 

Moves the group up in the Filters/Groups Pane.

Move Down 

Moves the group down in the Filters/Groups Pane.

Additionally, if the list of values spans through multiple pages, you can increase or decrease
the number of values displayed on each page by clicking the Increase Page Size or Decrease
Page Size buttons. You can use the First Page, Previous Page, Next Page, and Last Page
buttons to navigate between pages.

Output Pane

The Output Pane displays data and status messages for various features. The Output Pane is
shown in the following image.
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The Output Pane has the following options:

Find 

Opens the search field, where you can type the name of the field that you want to find and
allows you to modify your search options.

View 

Provides access to the following options:

Expand All 

Expands all nodes, folders, and hierarchies.

Collapse All 

Collapses all nodes, folders, and hierarchies.

Choose columns 

Opens the Choose Columns dialog box, where you can select the columns that you
want to display in the Business View Pane.

Reset to defaults 

Reverts the Pane to its default view.

If more than one tab is open, you can right-click a tab to access the tab menu, as shown in the
following image. The menu allows you to close all other tabs, close tabs to the right, or show
only the latest tab.

Creating Clusters

When you need to add more tables to your synonym, you can use the Join feature to create a
cluster. This allows you to enhance the structure of your synonym by introducing more data.

Procedure: How to Create a Cluster

1. When uploading data or connecting to data on the main metadata screen, on the ribbon, in
the Metadata group, click Join Editor.

The Join Editor dialog box opens.
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2. Click Insert Child.

The Insert Child dialog box opens.

3. Click a Master File from the list, and then click OK. You can select several Master Files by
holding the Shift key.

The completed cluster displays in the Join Editor dialog box, as shown in the following
image.

4. Close the Join Editor dialog box.

The new columns are added to the Table/Column pane.

5. Drag columns to the Business View pane to modify the synonym.

Related Information:

Wizard Metadata Screen Reference on page 310.

Pivoting Repeating Columns Into Rows

Some Excel spreadsheets may contain repeating columns, such as sales figures for a series of
years. There may even be repeating column groups, such as both budget and actual figures for
a series of years. You can use the pivot option to transform these columns or groups of
columns into rows.

Procedure: How to Pivot Columns Into Rows

1. When uploading data or connecting to data on the main metadata screen, on the ribbon, in
the Metadata group, click Pivot.

The Pivot Prepared Data dialog box opens.

2. Set the Pivot Type option to Repeating column.

3. In the First column drop-down box, select the first column in the range of repeating
columns.
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4. In the Last column drop-down box, select the last column in the range of repeating
columns.

5. In the Column Title for Pivoted Data, type the new column title that reflects the numeric
cell that you are describing.

6. In the Title for Pivoted Key field, type the new column title that represents the repeating
columns that you are pivoting into rows.

7. Leave the Formula for Pivoted Key field value unedited. This value is automatically
generated by the wizard, it should not be changed.

An example of the completed configuration for pivoting columns is shown in the following
image.

8. Click OK.

The repeating columns now display as rows. The Pivot button turned into the Remove Pivot
button, allowing you to quickly revert your pivoting changes.

Related Information:

Wizard Metadata Screen Reference on page 310.

Procedure: How to Pivot Column Groups into Rows

1. When uploading data or connecting to data on the main metadata screen, on the ribbon, in
the Metadata group, click Pivot.

The Pivot Prepared Data dialog box opens.

2. Set the Pivot Type option to Repeating group of columns.

3. In the Number of groups field, specify the number of groups of columns that you are
pivoting.
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4. In the Column Title for Pivoted Data, type the new column title that will be used for all the
columns across the repeating groups.

5. In the Title for Pivoted Key field, type the new column title that represents the repeating
columns that you are pivoting into rows.

6. Edit the automatically generated formula in the Formula for Pivoted Key field by clicking the
ellipsis button. Make sure there are no repetitive alphanumeric values in the Pivoted
Column field.

An example of the completed configuration for pivoting groups of columns is shown in the
following image.

7. Click OK.

The repeating groups of columns now display as rows. The Pivot button turned into the
Remove Pivot button, allowing you to quickly revert your pivoting changes.

Related Information:

Wizard Metadata Screen Reference on page 310.

Creating Hierarchies

When you upload a data file, using the default wizard settings, the wizard creates dimension
hierarchies automatically, based on name pattern-matching and date-time analysis. Optionally,
you can create additional hierarchies to organize individual columns, enable drill-downs in your
data, and add more flexibility to your synonym.

Note: If you set BV_NAMESPACE=ON, you are able to add new folders, but will not be able to
create new hierarchies.
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Procedure: How to Create a Hierarchy

1. When uploading data or connecting to data on the main metadata screen, in the Business
View Pane, right-click a dimension folder, point to Insert, and then click New Levels
Hierarchy.

The Hierarchy is added to the dimension folder.

2. Right-click the Hierarchy, and then click Rename.

The Rename dialog box opens.

3. Type the name of your new hierarchy and click OK.

Note: You can also turn an existing dimension into a dimension hierarchy. To do so, right-
click the dimension, and then click Create Hierarchy.

4. Drag individual columns into the new hierarchy in a logical order to populate it.

5. To remove a field from the hierarchy, right-click the field, and then click Remove from
Hierarchy.

6. Once you have edited your metadata, click Next.

The Save As dialog box opens.

7. Enter a name for the synonym in the File Name field and click OK.

A pop-up window opens, providing access to the following options:

Create. 

Allows you to create a report, chart, document, or visualization with your new Master
File.

Finish. 

Closes the wizard.

Related Information:

Wizard Metadata Screen Reference on page 310.

Creating Folders and Assigning DV Roles

When using BV+ capabilities, specifically, when you are working in a Business View, you can
create folders to organize your data. Folders function as segments to provide a view of the
synonym and define the accessible fields and their relationships. Folder relationships are the
same as segment relationships, with parent folders, child folders, and sibling folders. Once
you create a new folder, you can add data fields and assign roles.
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You can create a new folder by right-clicking a folder or field, clicking Insert, and then clicking
Folder, as shown in the following image.

Assigning DV Roles

While you have total flexibility defining a structure using any fields from your data source, when
you issue a report request against the synonym, the retrieval path for the data must conform
to any constraints imposed by your DBMS entity diagrams and by the rules of WebFOCUS BUE
retrieval.

Only the folders will be displayed in the WebFOCUS tools, not the real segments, and only the
fields within the folder structure will be accessible for reporting.
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You can assign a DV role to a folder or field by right-clicking the folder or field and assigning a
DV role. The following image shows the context menu and options for a folder.

You can explicitly assign a DV role to a folder or field, or have it automatically inherit its role
from its parent. If you explicitly assign a DV role, that role moves with the object if you drag it
to another location within the BV+ structure. If you do not explicitly assign a DV role, the role
changes as you move the object under a new parent, except if you drop it onto a field with the
Drill Level role. If dropped onto a Drill Level field, the moved field inherits the Drill Level role.

You can assign the following DV roles.

Dimension. A dimension field, when double-clicked or dragged onto the report or chart
canvas in the WebFOCUS BUE tools, is automatically added to the request as a vertical
(BY) sort field.

A folder can be assigned the role Dimension.
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A field can be assigned the role Dimension (Standalone) or Dimension (Drill Level). When it
is assigned the role Dimension (Drill Level), it becomes part of a hierarchy, where the levels
depend on the order of the fields in the folder. Then, when AUTODRILL is turned on,
automatic drill-downs are created in the report or chart output. The following image shows
the choices for DV role when you right-click a dimension field.

A folder can contain only one drill level hierarchy. However, you can use the same fields in
multiple hierarchies by placing each hierarchy in a separate folder. A folder with a drill level
hierarchy is not limited to just the hierarchy. It can contain other fields with different
DV_ROLEs.

Measure. A measure field, when double-clicked or dragged onto the report or chart canvas
in the WebFOCUS BUE tools, will automatically be added to the request as an aggregated
value (SUM), if it is numeric. If it is alphanumeric, it will be added as a vertical (BY) sort
field. A folder or field can be assigned the role Measure.

Attribute. An attribute field, when double-clicked or dragged onto the report or chart canvas
in the WebFOCUS BUE tools, will automatically be added to the request as an aggregated
value (SUM), if it is numeric, or as a vertical sort field (BY), if it is alphanumeric.

Folder. A folder is a virtual segment in a BV+. It can be assigned the roles Dimension,
Measure, or Attribute.
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Note: When a folder is inserted as a child of a field, the attribute PARENT_FIELD describes
this relationship. By default, such a folder and its fields will be assumed to have the
Attribute role.

None. If no role is assigned, the field or folder will inherit its role from its parent. If a role
has been assigned, you can remove it by selecting the option to inherit its role from its
parent, as shown in the following image.

For more information about the Business View pane, see Wizard Metadata Screen Reference
on page 310.

Joining and Blending Data

You can join two or more related data sources to create a larger integrated data structure from
which you can report in a single request. The joined structure is virtual. It is a way of accessing
multiple data sources as if they were a single data source. This can greatly increase the
number of fields available for use in your content, giving you an expanded selection for your
reporting and charting purposes.

Joins

Using conditional joins, you can establish joins based on conditions other than equality
between fields. In addition, the host and cross-referenced join fields do not have to contain
matching formats, and the cross-referenced field does not have to be indexed.

Note: You can edit the description of a join by clicking Edit in the Join dialog box and typing in
the Description section. You can only use letters, numbers, and underscores in your
description. No special characters are allowed.
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The conditional join is supported for FOCUS and all relational data adapters. Because each
data source differs in its ability to handle complex conditional criteria, the optimization of the
WHERE syntax differs depending on the specific data sources involved in the join and the
complexity of the conditional criteria.

For FOCUS data sources, if the host and cross-referenced join fields do not have common
matching formats, the following message appears.

Note: If you click Yes, the Filter dialog box opens, where you can create a Where-Based Join.

If the cross-referenced join field does not have an index, the following message appears.

Note: If you click Yes, the Filter dialog box opens, where you can create a where-based join.

Blending Data

The blend option allows you to explicitly select the data fields that you want to include. More
specifically, you can join multi-fact data structures and combine pertinent external data into
your current data source, creating a blended data resource. This can be from local or other
system resources. 

Blending is used to create customized data sources. For example, you may have some of the
basic fields available in the current data source, but you can use the blend option to add
relevant data fields from a different data source to the current data source in order to create a
unique data set.
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The blend option allows a new fact table to be added to a cluster master as a parent segment
to an existing child segment. This option is available from the Join dialog box. You may want to
blend data if you are reporting from two different fact tables that share a common dimension,
such as a product dimension. For an example of this, you can view the sample retail database,
wf_retail_lite. The wf_retail_lite Master File contains the WF_RETAIL_STORE_SALES segment
and the WF_RETAIL_SALES segment. The WF_RETAIL_SALES segment is defined as the parent
of the WF_RETAIL_STORE_SALES segment. You may want to add a second fact table to the
report. The second fact table in this example will be an Excel spreadsheet that you upload to
InfoAssist+ for use with a report or chart. The data in the spreadsheet file that you upload will
be joined to the WF_RETAIL_LITE database using a common field.

Note: You can find supported, common fields in your selected database (for example,
WF_RETAIL_LITE) using the search feature in the Data pane. If necessary, you may need to add
a field in your spreadsheet to map your data to the structure of the database. For example,
ID_CUSTOMER. In addition, the name of the primary sheet in Microsoft Excel becomes the
name of your data source, so be sure to name the file accordingly.

The following list provides some general rules that apply to the Blend option:

1. The result of blending is that a single dimension is shared between two fact tables. The
table must be based on a cluster with at least two segments. One segment is for Fact table
1, the second segment is for the dimension.

2. Two uploaded files cannot be blended because they result in single segment Master Files.

3. Do not use the fields from the blended table as a sort field, since these fields will not have
common field when used with fields from other fact tables.

Procedure: How to Blend Data

This procedure describes how to blend data from an external data source into an existing data
source. This example uses a Microsoft Excel spreadsheet file. 

1. On the Data tab, in the Join group, click Join.

The Join dialog box displays.

2. Click Add New.

The Open dialog box displays.

Note: The options that display on the Open dialog box depend on your user privileges.

3. At the top of the Open dialog box, click Upload Data.

The Upload wizard opens.

4. Drag your Microsoft Excel spreadsheet file on to the Upload pane, or click Select Upload
File to locate the file on your local drive.
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The next screen of the Upload wizard opens. You can use the options on this screen to
preview and change spreadsheets and delimited data files before you upload them to the
target environment. This screen shows you the default breakdown of your data as
measures, dimensions, and hierarchies.

5. On the ribbon, click Load and Next.

The Target Load Options dialog box opens.

Note: In WebFOCUS BUE the default target for the Upload Wizard is Hyperstage, which is
configured with a bulk load feature. If you change your target environment from the default,
and do not have a bulk load program that supports this environment, you may need to
clear the Bulk Load check box. For example, if you are using Microsoft SQL Server, you
may use a Bulk Copy Program (BCP). If you are unsure about whether you have a bulk load
program installed, contact your system Administrator.

6. Click Proceed to Load.

The Upload wizard closes, and you return to the Open dialog box.

Note: If there are informational messages or if your upload is unsuccessful, the Status
screen opens.

7. In the Open dialog box, click the name of your uploaded data source and then click Open.

8. In the Join dialog box, create a connection between the common fields by dragging your
mouse pointer from the field in the Master File to the common field in the newly uploaded
file.

9. Click Blend, and then click OK.

The blended data source fields are now available in the Data pane.

Creating Virtual Fields

A temporary field is a field whose value is not stored in the data source, but can be calculated
from the data that is there, or assigned an absolute value. A temporary field takes up no
storage space in the data source, and is created only when needed. DEFINE fields and
COMPUTE fields are two different types of temporary fields. 

When you create a temporary field, you determine its value by writing an expression. You can
combine fields, constants, and operators in an expression to produce a single value. For
example, if your data contains salary and deduction amounts, you can calculate the ratio of
deductions to salaries using the following expression: deduction / salary.
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You can specify the expression yourself, or you can use one of the many supplied functions
that perform specific calculations or manipulations. In addition, you can use expressions and
functions as building blocks for more complex expressions, as well as use one temporary field
to evaluate another.

Note: When creating a DEFINE or a COMPUTE field, the following characters are suppressed
and cannot be entered in the Format text box.
space ! " # $ & ' ( ) * + , / : ; < = > ? @ [ \ ] ^ _ ` { | } ~

Selecting a Temporary Field

The following information is provided to help you choose the kind of temporary field that you
need.

Choose a virtual field when you want to:

Use the temporary field to select data for your report. You cannot use a calculated
value, since it is evaluated after data selection takes place.

Use the temporary field to sort on data values. A calculated value is evaluated after the
data is sorted. With the BY TOTAL phrase, you can sort on this type of field.

Choose a calculated value when you want to:

Evaluate the temporary field using total values or prefix operators (which operate on
total values). You cannot use a virtual field, since it is evaluated before any totaling
takes place.

Evaluate the temporary field using fields from different paths in the data structure. You
cannot use a virtual field, since it is evaluated before the relationship between data in
the different paths is established.

Detail (DEFINE)

A virtual field (DEFINE) is evaluated as each record that meets the selection criteria is retried
from the data source. The result of the expression is treated as though it were a real field
stored in the data source.

The calculation that determines the value of a virtual field is performed on each retrieved
record that passes any screening conditions on real fields.

You can define a virtual field in the following ways:

In a Master File. These virtual fields are available whenever the data source is used for
reporting. These fields cannot be cleared by JOIN or DEFINE FILE commands.
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In a procedure. A virtual field created in a procedure lasts only for that procedure.

A DEFINE field is an optional attribute used to create a virtual field for reporting. You can derive
the virtual field value from information already in the data source (that is, from permanent
fields).

You may define fields simultaneously (in addition to fields defined in the Master File) for as
many data sources as desired. The total length of all virtual fields and real fields cannot
exceed 32,000 characters.

The Detail Field (DEFINE) dialog box allows you to create a defined field, type a name for the
field, and enter a format. 

Summary (COMPUTE)

A calculated value (COMPUTE) is evaluated after all of the data that meets the selection
criteria is retrieved, sorted, and summed. Therefore, the calculation is performed using the
aggregated values of the fields. Calculated values are available only for the specified report
request. You specify the COMPUTE command in the body of the report request, following the
display command and optionally, introduced by AND. You can compute more than one field
with a single COMPUTE command.

The Summary Field (COMPUTE) dialog box allows you to create a computed field, type a name
for the field, and enter a format.

The Field List provides similar functionality, including options to display data source fields in a
Logical, List, or Structured view. You can also view a complete set of functions, instead of data

source fields, by clicking the Functions button .

Creating Temporary Fields Independent of a Master File

The temporary fields that you create with the DEFINE and COMPUTE commands are tied to a
specific Master File, and in the case of values calculated with the COMPUTE command, to a
specific request. However, you can create temporary fields that are independent of either a
Master File or a request using the DEFINE FUNCTION command.

A DEFINE function is a named group of calculations that use any number of input values and
produce a return value. When calling a DEFINE function, you must first define the function.

A DEFINE function can be called in most of the same situations that are valid for Information
Builders-supplied functions. Data types are defined with each argument. When substituting
values for these arguments, the format must match the defined format. Alphanumeric
arguments shorter than the specified format are padded with blanks, while longer
alphanumeric arguments are truncated.
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All calculations within the function are done in double precision. Format conversions occur only
across equal signs (=) in the assignments that define temporary fields.

Enabling the Display of Missing Values for a DEFINE or COMPUTE

When working with DEFINEs and COMPUTEs, you can use the Missing Values option to enable
or disable the display of missing values for a DEFINE or COMPUTE field. This allows you to
accurately display missing values in reports, charts, and visualizations. The Missing Values
option, which is accessible through the Additional Options button, is shown in the following
image.

The following descriptions explain each option on the Missing Values drop-down list:

Off. When selected, MISSING syntax is removed from the DEFINE or COMPUTE field
definition. This is the default selection. MISSING treats missing values for numeric fields
as zeros and missing values for alphanumeric fields as blanks.

On. When selected, MISSING ON is added after the format in the DEFINE or COMPUTE field
definition. MISSING ON interprets the temporary field as missing.

On All. When selected, MISSING ON ALL is added after the format in the DEFINE or
COMPUTE field definition. MISSING ON ALL indicates that if all fields in the expression have
values, then the temporary field has a value. If at least one field in the expression has a
missing value, the temporary field also has a missing value.
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Chapter4
Creating Content

Create reports, documents, charts, and interactive visualizations using the available
features and functionality.

In this chapter:

Generating Sample Content

Creating Reports

Creating Charts

Creating Your Own Chart Types

Building a Document

Creating Multi-Page Documents

Building Visualizations

Creating Matrix Charts

Using Active Technologies

Using Navigation Options for Reports

Creating Maps to Illustrate Trends

Building InfoMini Applications

Viewing Data Behind Visuals

Creating HOLD Files

Creating Shortcuts and URLs

Creating Blogs

Working With Pages

Working With the WebFOCUS BUE Portal

Creating Report Queries With InfoAssist+

Ribbon Command Reference

Generating Sample Content

This topic describes how to generate sample content from uploaded or existing data using the
Samples Generator. It also provides information about how to interpret and analyze the sample
content.

Generating Sample Content Overview

The Samples Generator automatically generates a suite of analytic content based on uploaded
Excel workbooks, CSV files, or existing single-segment Master Files in your repository. The
Samples Generator populates your directory with sample charts, reports, and dashboards.
Additionally, the suite contains charts and reports that provide quick and easy navigation
through the levels of each available hierarchy. You can view, edit, or delete this content, or use
it as a starting point to create new dashboards.
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The Samples Generator feature is useful to the novice user, because it introduces all major
analytic content types in the InfoAssist+ toolset. Depending on the structure of your source
worksheet or synonym, the Samples Generator automatically creates the following items:

Active dashboards:

Initial Dashboard

Initial Dashboard by Year

Note: This item is only generated if your source dataset includes an eligible date, which
contains data for minimum three unique months.

Reports:

Auto-drill report starting at the top of each identified hierarchy

Overview accordion report

Overview active report

Charts:

Pie chart

Bar chart

Line chart

Note: Line charts are only created if your source dataset includes an eligible date, which
contains data for minimum three unique months.

The dashboards, auto-drill reports, overview accordion report, and overview active report are
stored in the Analytics folder. All other items are placed in the folders that are named after the
measures for which they are created. The content may vary depending on the structure and
size of your synonym.

To see the most complete suite of analytical content, it is recommended that you use a data
source that contains at least four measures, six dimensions, and data for a minimum of three
unique months. Additionally, a record count called Trans appears in the sample content, if
there are not sufficient measures available for analysis.

Note: Virtual fields, such as COMPUTE and DEFINE, are not eligible for selection as
dimensions or measures in the generated content.
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The following image shows an example of a synonym and the suite of sample content
generated from this synonym and displayed in the Resources tree.

Note: If you generate sample content more than once from the same source worksheet or
synonym in the same location, the Samples Generator creates a new folder with an underscore
and number appended to the title. For example, if a retail_sample folder already exists in a
domain or folder, a new folder with the new set of content is created and titled
retail_sample_1. The number is incremented each time you repeat this action.

You can generate sample content from one of the following ways:

By navigating to the Sample Content option from the New option in the Resources tree for
access to existing data.

By uploading an Excel spreadsheet or CSV file and selecting the Gain Insight option at the
end of the upload procedure.

Procedure: How to Generate Sample Content From the Resources Tree

1. In the Resources tree, right-click a domain or folder, point to New, and then click Sample
Content.

The Open dialog box opens.

Note: Only single-segment Master Files are displayed for selection.
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2. Locate a single-segment Master File that you want to use for generating sample content
and click Open.

The new folder with the same name as your Master File appears in your chosen directory.
It contains sample charts, reports, and dashboards.

Procedure: How to Generate Sample Content From the Upload Wizard

1. Upload a spreadsheet.

After the Upload procedure is complete, a selection screen opens, as shown in the
following image.

Note: Generating sample content on Master Files uploaded to a temporary folder, such as
FOCCACHE, may produce unexpected results.

2. Click Automatically generate content from your data.

The sample content is generated in the same folder that you selected for your upload.
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Analyzing Sample Content

The following section provides a closer look at each content type, and explains how this
content is generated. These examples have been generated using the retail_data_extract.xlsx
spreadsheet that is provided with your WebFOCUS installation.

Initial Dashboard by Year 

The Initial Dashboard gives you a quick overview of your data. It is comprised of three
charts and one report, as shown in the following image. Additionally, it displays a drop-
down menu, which allows you to narrow down your results to a specific year. The Initial
Dashboard by Year is only generated if your source worksheet or synonym includes an
eligible date, which contains data for a minimum of three unique months.

The bar chart is generated from the first measure and first dimension in the source
spreadsheet or synonym. It shows the Top 10 values.

The first pie chart is generated from the second measure and second dimension. It shows
the Top 5 values.
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The second pie chart is generated from the third measure and third dimension. It shows
the Top 5 values.

The active report shows an overview of all measures and dimensions in the source
worksheet or synonym.

Initial Dashboard 

The Initial Dashboard is identical to the Initial Dashboard by Year, with the exception that
the year drop-down menu is not displayed.

Auto-drill reports 

The auto-drill reports are generated for each of the identified hierarchies in the synonym.
For example, if your data set contains three hierarchies, the Samples Generator
automatically creates three auto-drill reports and one overview auto-drill report. In each
auto-drill report, the first four measures in the data set will be summed up by the
dimension values in the hierarchy. The report also features data bars and grand totals for
each dimension in the hierarchy. The name of the hierarchy is reflected in the title of the
report. For example: Dimension_Auto_Drill_Report.fex where Dimension is the top level of
the hierarchy. The following image shows an example of an Overview Auto-Drill Report.
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Click one of the links to drill-down to the lower level, as shown in the following image. You
can use the breadcrumbs to navigate back to the original report.

Overview Accordion Report 

The Overview Accordion Report provides a way to control the amount of sorted data that
appears on a page with the expandable views of data for each vertical sort field. It
contains up to three dimensions and the first four measures that are found in your source
synonym. The report displays total values for each measure. The following image shows an
example of an Overview Accordion Report.
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Overview Active Report 

The Overview Active Report contains one BY field for each dimension. The report displays
maximum of six dimensions and four measures. The total values are displayed for each
measure. Each field features a drop-down menu, where you can access active report
options. The Overview Active Report is always generated and resides in the Analytics
folder. The following image shows an example of an Overview Active Report.
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Pie Charts 

The Samples Generator uses the first four measures to create Pie charts, by pairing these
measures with up to three different dimensions found in the source synonym. Each pie
chart shows the Top 10 values. The number of pie charts may vary depending on your
synonym structure. The following image shows an example of a pie chart created by the
Samples Generator.
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Bar Charts 

The Sample Generator creates bar charts for each measure paired with up to three
different dimensions. Each bar chart shows all values in the dataset for that dimension. If
there are more values than can be displayed on the screen, a scrollbar appears. The
number of bar charts may vary depending on the structure of your synonym. The following
image shows an example of an automatically generated bar chart.
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Line Charts 

Line charts are only generated, if your source dataset includes an eligible date, which
contains data for minimum three unique months. If this data is present in the dataset, a
line chart is created for each measure. The following image shows an example of a line
chart.

Creating Reports

You can use the following procedures to create a basic report.

Procedure: How to Create a Report From the BUE Portal

After you have signed in to the WebFOCUS Business User Edition, you can work with an
existing folder, or create a new folder in the Resources tree to store your reports.

1. Right-click the folder that you want to use, point to New, and then click Report.

Or

Select a folder and on the Home page, on the Quick Links tab, under Create, click Report.

InfoAssist+ opens.

2. From the Open dialog box, select the data source that you want to use, and click OK.

The data source that you selected appears in the Data pane.

3. Drag fields onto the canvas or into the Query pane to begin building your report.
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Procedure: How to Create a Report From the Application Main Menu

1. In the upper-left corner of the InfoAssist+ interface, click the IA button to open the
Application Main Menu.

2. From the Application Main Menu, click New.

The InfoAssist+ splash screen opens.

3. On the InfoAssist+ splash screen, select Build a Report.

The Open dialog box opens.

4. From the Open dialog box, select the data source that you want to use, and click Open.

The data source that you selected appears in the Data pane of the Resources panel.

5. Drag fields onto the canvas or into the Query pane to begin building your report.

Procedure: How to Create a Report From the Quick Access Toolbar

1. On the Quick Access Toolbar, click the New icon.

The InfoAssist+ splash screen opens.

2. On the InfoAssist+ splash screen, select Build a Report.

The Open dialog box opens.

3. From the Open dialog box, select the data source that you want to use, and click Open.

The data source that you selected appears in the Data pane of the Resources panel.

4. Drag fields onto the canvas or into the Query pane to begin building your report.

Procedure: How to Create a Report From an Existing Chart

1. Open the chart that contains the data that you want to present in a report.

2. On the Home tab, in the Format group, click Report.

The data is presented as a report.

Choosing a Report Output

The following output types are available for reports:

HTML

active report

PDF
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Excel

PowerPoint

Note: When you create a report in Document view, you have access to Excel only.

When you create a report in Live Preview or Query Design view, you have access to the
following Excel output types: 

Excel (xlsx). Outputs the report in Excel 2007 (and higher) format.

Excel. Outputs the report in Excel format.

Excel Formula (xlsx). Outputs the report, using Excel formulas that calculate and display
the results of any type of summed information, such as column totals, row totals, and
subtotals. This format is for Excel 2007 (and higher).

Excel Formula. Outputs the report, using native Excel formulas for totals and computed
values.

Creating Charts

On the Format tab, the Chart Types group provides buttons for each of the five most commonly-
used chart types. These include Bar (default), Pie, Line, Area, and Scatter. You also have
access to Esri Choropleth and Proportional Symbol maps. A button labeled Other gives you
access to the complete chart library of advanced charts. 

The Chart Types group is shown in the following image.
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When switching between chart formats that use a different syntax, you are prompted with a
message that allows you to proceed with the change, or cancel your request. This message is
shown in the following image.

On the Chart Attributes Modified dialog box, you can click Yes to accept the changes or click
No to save the changes to a different file and preserve the originating procedure (.fex).

Procedure: How to Create a Basic Chart

You can run this procedure in Query Design view or Live Preview.

1. On the Format tab, in the Chart Types group, click the button of the chart that you want to
create. Bar chart is the default.

The chart appears on the canvas.

2. Populate the chart with your data in one of the following ways:

Drag the dimension fields and measure fields onto the chart.

Drag the dimension fields and measure fields into the appropriate Query field
containers in the Query pane.

Procedure: How to Create an Advanced Chart

You can run this procedure in Query Design view or Live Preview.

1. On the Format tab, in the Chart Types group, click Other.

The Select a chart dialog box opens. The chart types, depicted by icons, display on the left
side of the dialog box.

2. To display the name of a chart type, hover over the chart type with the mouse.

From top to bottom, the chart type categories are Bar, Line, Area, Pie, XY Plots, 3D, Stock,
Special, HTML5, and Map.
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Note: For streamgraphs, which are in the HTML5 category, the tooltip has been enhanced
to display specific information, by data point, depending on the underlying data source.

3. Click a chart type.

All supported variations of the chart type appear as thumbnail images in the dialog box.

4. Click an image to display a detailed description of that chart type.

If you are not familiar with a chart type, be sure to read the description carefully before
finalizing your selection. Some chart types require a certain number of data values, or a
certain type of data values. If your data does not satisfy the requirements, the chart will
not accurately represent the data.

You can also hover over an image with your mouse to display the chart type name.

5. In the Select a chart dialog box, click OK to finalize your selection and close the dialog
box.

6. Populate the chart with your data in one of the following ways:

Drag the dimension fields and measure fields onto the chart.

Drag the dimension fields and measure fields into the appropriate Query field
containers in the Query pane.

Procedure: How to Create a Combination Chart

You can run this procedure in Query Design view or Live Preview.

1. On the Format tab, in the Chart Types group, click the button of the chart that you want to
create. Bar chart is the default.

The chart appears on the canvas.

2. Populate the chart with your data in one of the following ways:

Drag the dimension fields and measure fields onto the chart.

Drag the dimension fields and measure fields into the appropriate Query field
containers in the Query pane.

3. Change a series type in one of the following ways:

Ribbon: On the Series tab, in the Select group, select the series that you want to
display in a different chart type. Then, in the Properties group, from the Type drop-down
menu, select the chart type.

Shortcut Menu: Right-click the series that you want to display in a different chart type,
point to Series Type, and click the chart type.
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The series appears in the new chart type.

Procedure: How to Create a Dual-Axis Chart

When you create a dual-axis chart, you assign one data series to the Y1 axis and another data
series to the Y2 axis.

1. Create a chart.

2. On the Format tab, in the Chart Types group, click Other.

The Select a chart dialog box opens.

3. Select a dual-axis chart, such as dual-axis bar, and then click OK.

4. Drag one field onto the Y1 field, and then drag another field onto the Y2 field.

Procedure: How to Create a Multi-Axis Chart

When you create a multi-axis chart, you assign one data series to the Y1 axis and another data
series to the Y2, Y3, Y4, and Y5 axes (as needed). 

1. Create a chart.

2. On the Format tab, in the Chart Types group, click Other.

The Select a chart dialog box opens.

3. Select a multi-axis chart, and then click OK.

4. Drag fields onto the Y1, Y2, Y3, Y4, and Y5 fields, as needed.

Narrating Charts

Narrative charts tell the story of your data. When creating a bar, line, area, or pie chart, you
can bring your chart to life with words that describe your data, as shown in the following image.
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If your administrator has activated this feature for you, you can enable Narrative Charts from
the ribbon. On the Format tab, in the Features group, click Narrative. This will add descriptive
text for the current chart or visual.

Narrative charts let you communicate about your data, summarizing data values and providing
an interpretation of the results.

Chart Outputs

You can create charts using one of the following output formats:

HTML

HTML5 (default)

active report

PDF

Excel

PowerPoint
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The HTML5 output format allows you to render a chart in the browser using a built-in JavaScript
engine. Charts with this output format utilize the very latest capabilities of the HTML5 Web
standard, including animation, high-quality vector output, and attractive alpha-channel and
gradient effects.

Note: Not every chart type can be output in every format listed here. To make sure that the
chart that you are creating can be output in the format that you want, please see the topic for
that particular chart type.

Creating Your Own Chart Types

WebFOCUS BUE supports the ability to add new, custom chart types to its list of built-in charts.
These custom chart types are called extensions or plug-ins. An extension is a block of code
that accesses resources external to WebFOCUS BUE. This topic describes the structure of an
extension and the steps necessary to create your own and add it to the chart library. 

Introducing Chart Extensions

Chart extensions are written in JavaScript. The visual part of a visualization can be drawn with
HTML, Canvas, or SVG. Extensions can include external CSS and JS libraries (such as d3),
which can be used to build almost any visualization. The WebFOCUS Extension API is limited to
new, complete chart types only. It is not possible to add features to existing chart types, and it
is not possible to modify or extend parts of WebFOCUS BUE outside of the chart area allocated
to your extension. 

This topic summarizes the process of writing, configuring, and installing a chart extension.
Detailed instructions can be found on the Information Builders GitHub site:

https://github.com/ibi/wf-extensions-chart

WebFOCUS BUE extensions must be placed in the extensions folder under the web_resource
folder of your WebFOCUS BUE installation. By default, this is the following location:

c:\ibi\install_dir\config\web_resource\extensions

where:

install_dir

Is your WebFOCUS BUE installation directory.
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Several sample chart extensions have already been installed in the extensions folder so that
you can see their code, their structure, and how they are accessed in the WebFOCUS BUE
tools.

Note: The user installing the extension must know how to write JavaScript code for what the
chart extension needs to generate. The GitHub site documents how to make the extension
conform to the WebFOCUS API and how to install the extension in the WebFOCUS BUE chart
library. It does not describe how to write JavaScript code.

Creating a Chart Extension

This section summarizes the build cycle for creating an extension and the structure and
components of an extension. 

Reference: Build Cycle for Writing an Extension

Creating an extension often involves cycles of writing, running, and then debugging code.

When you make changes to the properties.js file for your extension, you need to clear the
WebFOCUS BUE cache in order for those changes to be recognized. Clear the cache using the
Clear cache link in the Administration Console.

If you change the .js code for your extension (for example, com.ibi.simple_bar.js), you do not
need to make any changes to WebFOCUS BUE. You only need to clear your own browser cache,
to ensure that the new JavaScript file is downloaded. The same is true if you change any
additional .js files included by your extension. 

Reference: Extension Structure

The Simple Bar extension example demonstrates the required and optional files in an
extension, and how those files are typically laid out. 

You can open com.ibi.simple_bar and com.ibi.simple_bar.js in a text editor to see exactly how
an extension is written.

The extension ID (ext_id) is a string in the form com.your_company.extension_name. The ext_id
must be all lowercase, and can include only letters, numbers, underscores and dots. The
entire extension lives in a folder named ext_id. The core of the extension lives in a file named
ext_id.js. This file includes code to render the extension as a new chart type within WebFOCUS
BUE.

The properties.json file configures your extension to run in WebFOCUS BUE. This file includes
all the metadata needed to include your extension in the WebFOCUS BUE user interface, as
well as a list of all properties you wish to expose to end users, so they can customize the
behavior of your extension.
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The extension folder can also include optional additional folders for external css and lib
resources. If your extension uses any additional CSS or JavaScript library files, you can keep
those resources organized in dedicated folders, such as css and lib, as you choose. External
resources are configured and loaded inside the base ext_id.js file of your extension.

Using the Chart Extension API

To see examples of everything that the chart extension API provides, look at
com.ibi.simple_bar.js. It is divided into two main parts, chart rendering and extension
configuration. 

Rendering Charts

The extension API provides three entry points that you can use as needed by defining your own
JavaScript callback functions. They are passed a set of properties in a config object. Some
properties are available during the entire rendering process, and some are only available
during render callback.

Reference: Chart Rendering Callback Functions

You can define the following three JavaScript callback functions. Only the renderCallback
function is always required. 

initCallback(successCallback, config) This optional function is invoked by the engine
exactly once during library load time, providing a way to implement document.onload
initialization code. This function is passed a successCallback, which you must invoke with
true if your initialization code succeeded or false if was not successful. If you call
successCallback(false), no further interaction with your extension will occur, and your
extension will render as an empty page. 

preRenderCallback(config) This optional function is invoked each time your extension is to
be rendered, as the very first step in the overall rendering process. This is a good place to
examine and tweak or override any internal chart properties that will affect the subsequent
rendering. 

renderCallback(config) This required function must contain all of the code that will actually
draw your chart. The config object will contain the properties described in the following
sections. 

Each of the three entry point callbacks is passed a config object, which contains a set of
useful properties.
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Example: Sample renderCallback Function

The following sample renderCallback code renders the Simple Bar extension.

function renderCallback(renderConfig) {
  var chart = renderConfig.moonbeamInstance;
  var props = renderConfig.properties;
  var container = d3.select(renderConfig.container)
   .attr('class', 'com_ibi_chart');
  var data = renderConfig.data;
  if (renderConfig.dataBuckets.depth === 1) {
   data = [data];
  }
   
  var seriesCount = data[0].length;
  var seriesLabels = data[0].map(function(el){return el.labels;});
  data = d3.transpose(data).map(function(el, idx) {
   el = el[0];
   var v = Array.isArray(el.value) ? el.value : [el.value];
   var y0 = 0;
   return v.map(function(d, s) {
    return chart.mergeObjects(d, {y0: y0, y1: y0 += d, seriesID: s, 
value: d, labels: seriesLabels[idx]});
   });
  });
  
  var w = renderConfig.width;
  var h = renderConfig.height;
  var x = 
d3.scale.ordinal().domain(pv.range(seriesCount)).rangeRoundBands([0, 
w], 0.2);
  var ymax = d3.max([].concat.apply([], data), function(d){return 
d.y1;});
  var y = d3.scale.linear().domain([0, ymax]).range([25, h]);
  var svg = container.selectAll("g")
   .data(data)
   .enter().append('g')
   .attr('transform', function(d, i){return 'translate(' + x(i) + ', 
0)';});
   

  svg.selectAll("rect")
   .data(function(d){return d;})
   .enter().append('rect')
   .attr("width", x.rangeBand())
   .attr("y", function(d) {return h - y(d.y1);})
   .attr("height", function(d){return y(d.y1) - y(d.y0);})
   .attr('tdgtitle', function(d, s, g) {
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//To support tooltips, each chart object that should draw a tooltip
//must set its 'tdgtitle' attribute to the tooltip's content string.
    
    // Retrieve the chart engine's user-defined tooltip content with 
getToolTipContent():
    // 's' and 'g' are the series and group IDs for the riser in 
question.
    // 'd' is this riser's individual datum, and seriesData is the 
array of data for this riser's series.
    var seriesData = chart.data[s];
    var tooltip = renderConfig.modules.tooltip.getToolTipContent(s, g, 
d, seriesData);
    // getToolTipContent() return values:
    //  - undefined: do not add any content to this riser's tooltip
    //  - the string 'auto': you must define some 'nice' automatic 
tooltip content for this riser
    //  - anything else: use this directly as the tooltip content
    if (tooltip === 'auto') {
     if (d.hasOwnProperty('color')) {
      return 'Bar Size: ' + d.value + '<br />Bar Color: ' + d.color;
     }
     return 'Bar Size: ' + d.value;
    }
    return tooltip;
   })
   .attr('class', function(d, s, g) {
    // To support data selection and tooltips, each riser must include 
a class name with the appropriate seriesID and groupID
    // Use chart.buildClassName to create an appropriate class name.
    // 1st argument must be 'riser', 2nd is seriesID, 3rd is groupID, 
4th is an optional extra string which can be used to identify the 
risers in your extension.
    return chart.buildClassName('riser', s, g, 'bar');
   })
   .attr('fill', function(d) {
    // getSeriesAndGroupProperty(seriesID, groupID, property) is a 
handy function
    // to easily look up any series dependent property.  'property' can 
be in
    // dot notation (eg: 'marker.border.width').
    return chart.getSeriesAndGroupProperty(d.seriesID, null, 'color');
   });
   
  svg.append('text')
   .attr('transform', function(d) {return 'translate(' + 
(x.rangeBand() / 2) + ',' + (h - 5) + ')';})
   .text(function(d, i){return seriesLabels[i];})
   
  renderConfig.modules.tooltip.updateToolTips();  // Tell the chart 
engine your chart is ready for tooltips to be added
  renderConfig.modules.dataSelection.activateSelection();  // Tell the 
chart engine your chart is ready for data selection to be enabled
 }
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Reference: Properties That Are Always Available

The following properties are always available.

Property Name Description

moonbeamInstance The chart instance currently being rendered.

data The data set being rendered.

properties The block of properties for your extension, as set by the
user.

Reference: Properties Available Only During Render Callback

The following properties are available only during render callback, and are used by your chart
rendering code (renderCallback).

Property Name Description

width Width of the container your extension renders into, in pixels.

height Height of the container your extension renders into, in
pixels.

containerIDPrefix The ID of the DOM container your extension renders into.
Prepend this to all IDs your extension generates, to ensure
multiple copies of your extension work on one page.

container DOM node for your extension to render into, either an HTML
DIV element or an SVG G element, depending on your
chosen containerType extension configuration

rootContainer DOM node containing the specific chart engine instance
being rendered.
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Configuring Your Chart Extension

Extension configuration consists of two parts. 

Chart Engine Configuration configures the extension to interact with the chart engine and
chart canvas in WebFOCUS BUE. This part of the extension configuration is defined in the
config object that is passed to the chart renderer functions.

Chart Interface Configuration interacts with the chart type picker in the user interface and
the chart attribute categories. This part of the extension configuration is defined in the
properties.json file.

Creating a config Object for Chart Engine Configuration

To configure your extension, create a config object with all the information unique to your
extension, then register your extension with the extension API. 

Reference: Creating a config Object for Your Extension

Required and optional properties in your config object are described in the following table.

Property Name Description

id Is the extension ID described in Extension Structure on page
375.

name Is the name for the chart type to be displayed in the user
interface.

description Is a description for the chart type to be displayed in the
user interface.

containerType Is either 'html' or 'svg' (the default).

initCallback Optional. References your initCallback function, described in 
Rendering Charts on page 376.

preRenderCallback Optional. References your preRenderCallback function,
described in Rendering Charts on page 376.

renderCallback Required. References your renderCallback function,
described in Rendering Charts on page 376.
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Property Name Description

resources Optional. Are additional external resources (CSS and JS)
required by this extension.

Example: Sample config Object

The following code is a sample of the config object used with the Simple Bar extension.

var config = {
    id: 'com.ibi.simple_bar',     // string that uniquely identifies 
this extension
    containerType: 'svg',  // either 'html' or 'svg' (default)
    initCallback: initCallback,  // Refers to your init callback fn 
(optional)
    preRenderCallback: preRenderCallback,  // Refers to your preRender 
callback fn (optional)
    renderCallback: renderCallback,  // Refers to your render fn 
(required)
    resources:  {  // Additional external resources (CSS & JS) required 
by this extension (optional)
        script: ['lib/d3.min.js'],
        css: ['css/extension.css']
    },
   }

Reference: Registering Your Extension

To register your extension with the WebFOCUS extension API, call: 

tdgchart.extensionManager.register(config);

Reference: Tips for Building Your Extension

The easiest way to build your own extension is to clone the Simple Bar example, then tweak it.
Assume the ID of the new extension is com.foo.bar: 

1. Rename root folder to com.foo.bar. Rename com.ibi.simple_bar.js to com.foo.bar.js.

2. In com.foo.bar.js, delete the inner content of the three callback functions.

3. In com.foo.bar.js, change the entries for each property in config to match the requirements
of your extension.

4. Add any external resources you need to lib and css, and load them by setting
config.resources in com.foo.bar.js.

5. Implement renderCallback in com.foo.bar.js to draw your extension.
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Configuring the Chart Interface

Each extension must include a properties.json file, which defines the information needed by
WebFOCUS BUE when drawing its user interface. 

The properties.json file consists of the following blocks.

info. This block defines several general purpose configuration options.

properties. This block defines any properties of your extension that the end user may want
to change. The user can change these properties in the GRAPH_JS blocks in a WebFOCUS
BUE chart procedure.

propertyAnnotations. This block validates the content of the properties block. Everything in
properties must appear in propertyAnnotations. The possible types of any non-object (leaf)
property in properties must be notated as one of "str", "bool", or "number".

dataBuckets. This block defines the set of chart attribute categories that appear in the
Query pane in the WebFOCUS BUE user interface when creating a chart. Each member in
the dataBuckets collection is a bucket.

There are two types of buckets, built-in and custom. Built-in buckets provide an easy way to
reuse the existing WebFOCUS BUE data bucket logic. There are currently two built-in
buckets, tooltip, and series_break. Use any of these buckets by setting the associated
dataBuckets property to true.

bucket. Each bucket block defines one custom chart attribute category. Each custom
bucket requires the following properties:

id. This property corresponds exactly to the dataArrayMap and data properties that will
be received by the render function for your chart.

type. This property defines the type of data field this bucket accepts, "measure",
"dimension", or "both".

count. Consists of count.min and count.max, which define the minimum and maximum
number of fields this bucket can accept. A minimum of 0 means this bucket is optional.

translations. Defines translations in different languages for every label to be drawn in the
WebFOCUS BUE interface. The translation object has one property for each language the
extension supports, keyed by ISO-639 two letter locale strings.
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Example: Sample properties.json File

The following properties.json file is from the Simple Bar extension.

{
    // Define some general extension configuration options
    "info": {
        "version": "1.0",  // version number of your extension.
        "implements_api_version": "1.0",  // version number of the 
WebFocus API used by your extension.
        "author": "Information Builders",
        "copyright": "Information Builders Inc.",
        "url": "https://github.com/ibi/wf-extensions-chart/tree/master/
simple_bar%20example",
        "icons": {
            "medium": "icons/medium.png"  // Reference to an image in 
the extension, used in the WF chart picker
        }
    },
    // Define any properties of your extension that end user may want 
to change.  
    "properties": {
        "exampleProperty": 50
    },
    // Define the possible values for each property in 'properties'.
    "propertyAnnotations": {
        "exampleProperty": "number"
    },
    // Define the available data buckets drawn in WF's 'Query' data 
bucket tree.  
    "dataBuckets":  {
        // Choose whether or not to reuse existing WF data buckets.  
All optional.
        "tooltip": false,
        "series_break": true,
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        // Define your own custom data buckets.  Optional
        "buckets": [
            {
                "id": "value",
                "type": "measure",
                "count": {"min": 1, "max": 5}
            },
            {
                "id": "labels",
                "type": "dimension",
                "count": {"min": 1, "max": 5}
            }
        ]
    },
    // Define the set of labels used in the WF interface for buckets 
and chart type picker.
    "translations": {
        "en": {
            "name": "My Simple Bar Chart",
            "description": "This chart is just a simple bar chart, 
nothing to see here.",
            "icon_tooltip": "This extension does ...", 
            "value_name": "Value Bucket", 
            "value_tooltip": "Drop a measure here", 
            "labels_name": "Label Bucket", 
            "labels_tooltip": "Drop a dimension here"
        },
        "fr": {
            "name": "Un Bar Chart tres simple",
            "description": "C'est un Bar Chart vraiment simple",
            "icon_tooltip": "This extension does ...", 
            "value_name": "Value Bucket", 
            "value_tooltip": "Drop a measure here", 
            "labels_name": "Label Bucket", 
            "labels_tooltip": "Drop a dimension here"
        }
    }
}

Accessing Data for Your Extension

Each time an extension is rendered, the render callback for the extension is passed the
current data set using the renderConfig.data argument. The overall structure of the data set is
defined by the set of buckets listed in the properties.json file, while the specific content of the
data is defined by the data fields the user has added to each bucket. 
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Defining and Using Buckets in an Extension

The data set is passed into an extension using the data property of the first argument of the
render callback, typically named renderConfig. Additional information about the current set of
fields in each bucket is in renderConfig.dataBuckets. 

A data set is represented in JavaScript as arrays of objects. If an extension defines only
custom buckets, the data set will be a flat array of objects. If an extension uses some built-in
buckets, the data set may contain deeply nested arrays of arrays. The
renderConfig.dataBuckets.depth property will be set to the number of array dimensions in the
current data set.

Custom Buckets

Each innermost object within the arrays of data (called a datum) will have one property for each
data bucket that contains a field. Each property will be the id of a custom bucket, as defined in
the dataBuckets.buckets section of properties.json. The type of values of these properties
depend on the bucket type. Dimension buckets have string values, while measure buckets
have numeric values. If a bucket contains more than one field, the associated property for
each innermost object will be an array of string or number values.

Built-in Buckets

An extension can use buckets that are built-in and predefined by WebFOCUS BUE. These
buckets will affect more than just the data set. Each bucket will also set specific chart engine
properties, to pass in additional information related to that bucket.

Each built in WebFOCUS BUE bucket is either a standard bucket or a break bucket.

Standard buckets behave exactly like custom buckets. The data set remains a single array,
and each datum object will include an additional property named after the bucket.

Break buckets divide the data set into additional arrays of data. For each break bucket
used, each datum object will be transformed into a full array of datum objects. The number
of datum objects in each array will remain unchanged, but the number of arrays or datum
arrays will correspond to the number of entries in the break field.
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Types of Break Buckets

Break buckets can be of two types:

A series-break bucket breaks the data set into one array for each entry in the series break
field chosen by the user. A series-break bucket uses series-dependent properties defined in
the chart engine, and the data names are now listed in those series-dependent properties.
Each entry in the series-break field will generate a corresponding series property object in
the chart engine, retrievable with renderConfig.moonbeamInstance.getSeries(x), where x is
an integer for the series to be retrieved. getSeries returns an object with properties such as
color and label, which are unique to the chosen series.

A matrix-break bucket is used for the sort fields that define the columns and rows in a
matrix chart. A matrix-break bucket also adds more array dimensions to the data set. A
matrix-break bucket is broken into column and row sub-buckets. If either the row or column
bucket contains any fields, the data set will contain two additional dimensions of data,
even if one of the matrix buckets is empty. That is, the data set will either contain neither
row nor column data, or both row and column data, never just one or the other.
bucket.depth will always be at least three.

The Tooltip Bucket

The tooltip bucket is not a break bucket, and does not add any additional array dimensions to
the data set. Instead, tooltip behaves like a custom bucket. Each inner datum object will
contain a property named tooltip, with a value of type string for dimensions, number for
measures, and an array of values for multiple fields in the bucket.

The usefulness of this bucket is that in addition to including tooltip-specific data in the data
set, WebFOCUS BUE also generates meaningful tooltip content for each series. This tooltip
content is the same content used for all of the built in WebFOCUS BUE chart types. Using the
tooltip bucket means the extension does not have to figure out what ought to go into each
tooltip.

Example: Sample Series-Break Bucket Definition

This example uses the following sample data.

Car Country Seats

BMW Germany 5

Audi Germany 4

Creating Your Own Chart Types

386  Information Builders



Car Country Seats

Peugeot France 5

Alfa Romeo Italy 4

Maserati Italy 2

Toyota Japan 4

The following code defines a series-break bucket.

dataBuckets:
        series_break: true,
        buckets: [
            {id: "label", type: "dimension"},
            {id: "value", type: "measure"}
        ]

Consider the following fields assigned to each of the buckets:

"Country" assigned to the "series_break" bucket.

"Car" assigned to the "label" bucket.

"Seats" assigned to the "value" bucket.

In the renderConfig function, the renderConfig.data object will be similar to the following, in
which the Country values are no longer part of the data array. However, a new array starts for
each change in the Country value:

 [{labels: "PEUGEOT", value: 5}],
        [{labels: "ALFA ROMEO", value: 4}, {labels: "MASERATI", value: 
2],
        [{labels: "TOYOTA", value: 4}],
        [{labels: "AUDI" ,value: 4}, {labels: "BMW", value: 5}]

The renderConfig.dataBuckets object will be defined as follows:

renderConfig.dataBuckets = {
        depth: 2,
        series_break: {title: "Country"},
        buckets: {
            label: {title: "Car"},
            value: {title: "Seats"}
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Handling Partial and Null Data in an Extension

In many cases, the end user working with an extension cannot populate all of the extension
buckets immediately. An extension must correctly handle these partial data cases, and cannot
crash if one or more buckets are empty. It is important to check renderConfig.dataBuckets to
see which buckets have been populated, and act accordingly. 

In addition, data sets are often incomplete, missing some values for a given combination of
dimensions and measures. These missing values may show up in the data set as null entries
within an array (instead of datum objects), or they may show up as entirely empty arrays. It is
important to detect and handle these missing data cases, and render a visualization
appropriate for such missing data.

Most extensions require some minimum number of populated buckets before anything can be
rendered. Use the count.min properties of each dataBuckets.bucket entry in properties.json to
define these minimum requirements. If the fields in all buckets do not meet the minimum
counts, then the renderCallback for the extension will not be called. Instead, the
noDataPreRenderCallback for the extension is called. This allows the extension to render in a
special no data mode. In this mode, the extension should render in grey scale, using
renderCallback.baseColor as the main color. This should be a very simplified, sample rendering
of the extension.

Example: Sample noDataPreRenderCallback Function

The following noDataPreRenderCallback function is from the Simple Bar sample extension.

function noDataRenderCallback(renderConfig) {
  var grey = renderConfig.baseColor;
  renderConfig.data = [{value: [3, 3]}, {value: [4, 4]}, {value: [5, 
5]}, {value: [6, 6]}, {value: [7, 7]}];
  renderConfig.moonbeamInstance.getSeries(0).color = grey;
  renderConfig.moonbeamInstance.getSeries(1).color = 
pv.color(grey).lighter(0.18).color;
  renderCallback(renderConfig);
 }

Installing a Chart Extension

1. Find the extensions folder for your local WebFOCUS BUE installation. This is typically the
following folder. 

C:\ibi\install_dir\config\web_resource\extensions

where:

install_dir

Is your WebFOCUS BUE installation directory.
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Note: The WebFOCUS Extension section of the Information Builders GitHub page maintains
a list of publicly available and supported extensions. To install one of those, click the
extension you want to install, then right click the zip file for that extension, for example
com.ibi.xyz.zip, and choose Save link as...

2. Unzip the downloaded zip file into the WebFOCUS BUE extensions folder. For example, for
the com.ibi.xyz.zip zip file, this should create the following folder.

C:\ibi\install_dir\config\web_resource\extensions\com.ibi.xyz

If you are installing your own extension from your own environment, copy or download it to
the WebFOCUS BUE extensions folder, using the same naming conventions for the folder
and the extension ID as described for the sample extensions.

3. Edit C:\ibi\install_dir\config\web_resource\extensions\html5chart_extensions.json. Create
a new line for the new extension in the form:

"com.ibi.abc": {"enabled": true},

where:

abc

Is the name of the extension.

4. In the Administration Console, click Clear cache. This will force WebFOCUS to reload all
extensions.

Following is a sample html5chart_extensions.json.

{
        "com.ibi.simple_bar": {enabled: true},
        "com.ibi.liquid_gauge": {enabled: false},
        "com.ibi.sankey": {enabled: true}
    }

Reference: Preserving Custom Chart Types When Reinstalling the WebFOCUS Client

If you reinstall the WebFOCUS Client, your extensions folder will be overwritten. Therefore, if
you have installed any custom chart extensions, you should preserve them by copying them to
another location prior to reinstalling the WebFOCUS Client and copying them back to the
extensions folder after reinstalling the WebFOCUS Client. 

You will also have to copy the entries for your custom extensions into the new
html5chart_extensions.json file installed with the new version of the WebFOCUS Client.
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Note: The extensions that are delivered as part of WebFOCUS BUE will be reinstalled
automatically, so you should not preserve those extensions. In that way, if any enhancements
have been made to those extensions, you will automatically have access to the enhanced
versions when you reinstall the WebFOCUS Client.

Using Your Extension in a WebFOCUS Request

If you have installed and configured your extension as described, your extension will be
available for use in the WebFOCUS BUE tools as a chart type in the Other format category
under HTML5 Extension, as shown in the following image. 

The attribute categories you defined in the dataBuckets object of your extension are available
in the query pane.

In the FOCEXEC:

The LOOKGRAPH value is EXTENSION.

The actual extension to use is identified in the chartType property of the *GRAPH_JS block
in the StyleSheet. For example:
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*GRAPH_JS
chartType: "com.ibi.simple_bar",
}

Each custom attribute category name is prepended with a greater-than character (>). For
example:

TYPE=DATA, COLUMN=N1, BUCKET= >labels, $
TYPE=DATA, COLUMN=N2, BUCKET= >value, $
TYPE=DATA, COLUMN=N3, BUCKET= >value, $
TYPE=DATA, COLUMN=N4, BUCKET= >value, $
TYPE=DATA, COLUMN=N5, BUCKET= >value, $

The following is a sample request using the Simple Bar extension.

GRAPH FILE WF_RETAIL_LITE
SUM COGS_US
GROSS_PROFIT_US
REVENUE_US
DISCOUNT_US
BY PRODUCT_CATEGORY
ON GRAPH PCHOLD FORMAT JSCHART
ON GRAPH SET LOOKGRAPH EXTENSION
ON GRAPH SET AUTOFIT ON
ON GRAPH SET STYLE *
INCLUDE=IBFS:/FILE/IBI_HTML_DIR/javaassist/intl/EN/combine_templates/
ENWarm.sty,$
TYPE=DATA, COLUMN=PRODUCT_CATEGORY, BUCKET= >labels, $
TYPE=DATA, COLUMN=COGS_US, BUCKET= >value, $
TYPE=DATA, COLUMN=GROSS_PROFIT_US, BUCKET= >value, $
TYPE=DATA, COLUMN=REVENUE_US, BUCKET= >value, $
TYPE=DATA, COLUMN=DISCOUNT_US, BUCKET= >value, $
*GRAPH_JS
chartType: "com.ibi.simple_bar",
*END
ENDSTYLE
END
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Run the chart. The output is shown in the following image.

Building a Document

Document view allows you to build multiple reports and charts on the same canvas. The
styling, design, and report building functionality of Live Preview and Query Design view is
available in Document view.

In addition, there are many other features that simplify building documents. You can build and
insert multiple reports in the form of reports and charts into documents. You can also insert
images and text for presentation and organizational purposes.

Inserting Reports From Multiple Data Sources

With InfoAssist+ opened in Document view, you can insert multiple charts and reports onto the
canvas. These reports can be from different data sources. With documents, you have the
option to add additional data sources to the document.

In order to insert reports from different data sources, the document must have multiple data
sources loaded. For more information on adding and switching between data sources, see 
Data Tab on page 81.

Procedure: How to Insert Two Reports From Two Different Data Sources

A document can display multiple reports from multiple data sources in the same document.

1. With InfoAssist+ open in Document view, click the Insert tab and select chart or report.
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2. If your document has only one data source, insert additional data sources.

For more detailed instructions on inserting multiple data sources, see Data Tab on page
81.

3. Switch to a data source different than the one used in step 1.

For more detailed instructions on switching to a different data source, see Data Tab on
page 81.

4. Insert a chart or report using this new data source, following the instructions given in 
Inserting a New Report on page 393.

Your document is now populated with reports that have data from different data sources.
You can add as many data sources as you need.

Inserting a New Report

With InfoAssist+ opened in Document view, you can insert multiple charts and reports onto the
canvas. The procedures in the following sections detail how to insert reports into documents.

In Document view, you can insert a report in the following ways.

Use the Insert tab.

Double-click a data source field.

Right-click a data source field.

Drag a data source field onto the canvas.

Note:

When you use the Insert tab, double-click a data source field, or right-click a data source
field, a report placeholder is added to the canvas.

When you insert an existing report, which has already been created and is referenced via-
INCLUDE syntax, and then select it on the Document canvas, the data fields do not display
in the Query pane.

Dragging a data source field onto the canvas inserts the place holder at the location you
dropped it.

The following procedures describe how to insert new reports. For more information on how to
edit existing reports, see How to Style and Customize a Report on page 401.
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Procedure: How to Insert a Report

Do one of the following, while in Document mode:

On the Insert tab, in the Reports group, click Report. Add fields to the placeholder
report.

On the Home tab, in the Format group, click Report. Double-click a data source to
automatically create a report with that data.

On the Home tab, in the Format group, click Report. Drag a field to the canvas to create
a report.

Inserting a New Chart

With InfoAssist+ opened in Document view, you can bring multiple charts and reports onto the
canvas. The procedures in the following sections describe how to insert charts into
documents.

In Document view, you can insert a chart in the following ways:

Use the Insert tab.

Double-click a data source field.

Right-click a data source field.

Drag a data source field from the Resources panel onto the canvas.

Note: When you use the Insert tab, double-click a data source field, or right-click a data source
field, a chart placeholder is added to the canvas.

Dragging a data source field onto the canvas inserts the place holder at the location you
dropped it.

The following procedures describe how to insert new charts. For more information on how to
edit existing charts, see How to Style and Customize a Chart on page 401.

Procedure: How to Insert a Chart

1. Do one of the following, while in Document mode:

On the Insert tab, in the Reports group, click Chart. Add fields to the placeholder chart.

On the Home tab, in the Format group, click Chart. Double-click a data source to
automatically create a chart with that data.
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On the Home tab, in the Format group, click Chart. Drag a field to the canvas to create
a chart.

2. Optionally, change the chart format using the options on the Format tab, in the Chart Types
group.

Inserting an Existing Report

With InfoAssist+ opened in Document view, you can insert existing charts and reports onto the
canvas from the Insert tab. The following procedure describes how you can insert reports into
new documents and documents that are already populated with reports, text, and images.

Note: When working in Document view, you cannot insert an existing report that has a HOLD.

Procedure: How to Insert an Existing Report With the Insert Tab

You can create a document in the Custom Reports section of the domain and use Standard
Reports items as Existing Report components. You cannot use other Custom Report items as
components.

1. With InfoAssist+ open in Document view, click the Insert tab.

2. In the Reports group, click Existing Report.

An Open dialog box appears.

3. Browse to the report that you want to insert and click Open.

The report placeholder is added to the canvas.

Note: You cannot edit an existing report that is inserted into a document.

Creating a Document From a Single Report

You can take a single report created in Live Preview or Query Design view and convert it into a
document, displaying it in Document view.

When you convert a single report into a document, the original report is preserved and a copy
of that report is opened as a document in Document view. You can then add additional
reports, charts, images, and text.

Inserting Text and Images

With InfoAssist+ opened in Document view, you can bring text and images onto the canvas.
The following procedures describe how you can insert text and images into new documents
and documents that are already populated with reports, text, and images.

Note: You can only do this in Document view.
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The following procedures detail how to insert text and images. For more information on how to
edit existing text and images, see Editing Components in a Document on page 396.

Procedure: How to Insert Text

1. With InfoAssist+ open in Document view, click the Insert tab.

2. In the Objects group, click Text Box.

A text component is added to the canvas, containing default text.

3. Double-click, or right-click, the text component to edit the text.

For more information on editing and styling the text, see How to Edit Text on page 402.

Procedure: How to Insert an Image

1. With InfoAssist+ open in Document view, click the Insert tab.

2. In the Objects group, click Image.

An Open dialog box appears.

Note: By default, the Open dialog box displays image files in the current WebFOCUS
Content folder.

3. Browse to the desired image and click OK.

The selected image is added to the canvas.

Editing Components in a Document

The reports, controls, and text in a document can be edited, moved, resized, and deleted.
Each of these components has a context menu which can be accessed by right-clicking the
component.

Images can be moved, resized, and deleted, but they have no context menu and cannot be
edited. Right-clicking a image brings up the option to delete it.

Procedure: How to Resize a Component

You can resize a component in the following ways:

Using the component sizing handles.

Changing the height and width on the Layout tab, in the Size & Arrange group.

Accessing the options on the Size tab in the Size and Position dialog box.
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The resize feature is available for all components that can be added to a document.

1. Open or create a document with at least one report, text component, control, or image.

2. Resize the component in one of the following ways:

Sizing Handles: Select the component and drag the sizing handles that appear around
it. As you manually increase the height and width of the component, the new values
appear in the corresponding text boxes in the Size & Arrange group of the Layout tab.

Ribbon: You can use the ribbon in one of the following ways:

Select the component in the document. On the Layout tab, in the Size & Arrange
group, enter values in the Height and Width fields.

On the Layout tab, in the Size & Arrange group, click the dialog box launcher to
open the Size and Position dialog box, as shown in the following image.

Shortcut Menu: Right-click the component and select Size and Position. The Size and
Position dialog box opens.

Note: You must right-click the corner of the component. For charts, if you click on any
other point in the chart, the Size and Position option will not display.

From the Size and Position dialog box, open the Size tab. 

Use the Height and Width options to change the position of the selected component.
You can adjust the pixel size of the object with the Size options or the scale
percentage of the object with the Scale options.
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You can lock the aspect ratio using the Aspect Ratio button, which is available when
working with charts, images, and text boxes while working in Document view. With the
aspect ratio locked, changing the width automatically changes the height to keep the
component to scale, and changing the height automatically changes the width.

Note: The Auto Overflow option is only available while working with reports in Document
view through the Size & Arrange group. With Auto Overflow set, you cannot manually set
the height and width of a report. The area of the report expands automatically to show all
data.

When two objects are selected, the Relative Position button sets the bottom-left corner of
the component that is higher on the page to the upper-left corner of the one that is lower.
Once a relationship is created, arrows appear to show that relationship while both items
are still selected.

Procedure: How to Move a Component

You can move a component by clicking it, or by accessing the Position section of the Size and
Position dialog box. This feature is available for all components that can be added to a
document. 

You can also align components with each other so that their horizontal or vertical position
matches. For more information, see How to Align Components on page 398.

1. Open or create a document with at least one report, text component, control, or image.

2. Select the component and move it by using one of the following methods:

Drag the component anywhere on the canvas.

or

Right-click the component and click Size and Position.

On the Size and Position dialog box, click the Position tab.

Use the Horizontal and Vertical options to change the position of the selected
component.

Procedure: How to Align Components

You can align components with each other so that their horizontal or vertical positions match.
You must have multiple components selected to use the align options.
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The alignment is anchored by the component that is in the farthest position of the selected
alignment. For example, if you select two components and click Align Left, the components
align horizontally with the component farthest to the left.

1. Open or create a document with at least two components.

2. Select a component.

3. Select a second component by holding the Ctrl key and clicking a component.

Note: You can select multiple components simultaneously by holding the Ctrl key and with
the left mouse dragging a selection box around the components. When you release the
mouse, sizing handles appear around each component that you selected. If the
components display with light-grey coloring, this indicates that the components are
selected.

Sizing handles appear around the components, as shown in the following image.
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4. Align the components using one of the following methods:

Right-click one of the selected components and select an alignment option from the
Align drop-down menu, as shown in the following image.

or

Access the alignment options from the Align drop-down menu. The menu is available on
the Layout tab, in the Size & Arrange group.

The selected components align, as shown in the following image.

5. Click anywhere in the canvas to deselect the components.
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Procedure: How to Style and Customize a Report

When you select a component, you can perform various functions on the component, such as
moving and resizing it, as explained in How to Move a Component on page 398 and How to
Resize a Component on page 396. After clicking a component, you can use the ribbon to affect
all settings of the selected component, except for fields. You can right-click a component to
select individual fields to edit through the context menu.

In addition to reports, you can style and customize charts and text. For more information on
charts, see How to Style and Customize a Chart on page 401. For more information on text,
see How to Edit Text on page 402.

Note: Images cannot be edited.

1. Open or create a document with at least one report.

2. Click the report.

The Query pane becomes active and you can now select fields within the report. Select a
field by clicking it in the canvas or in the Query pane.

Procedure: How to Style and Customize a Chart

When you select a component, you can perform various functions on the component, such as
moving and resizing it, as explained in How to Move a Component on page 398 and How to
Resize a Component on page 396. After clicking a component, you can use the ribbon to affect
all settings of the selected component, except for fields. You can double-click or right-click a
component to select individual fields to edit through the context menu or Field tab.

In addition to charts, you can style and customize reports and text. For more information on
reports, see How to Style and Customize a Report on page 401. For more information on text,
see How to Edit Text on page 402.

Note: Images cannot be edited.

1. Open or create a document with at least one chart.

2. Click the chart.

The Query pane becomes active and you can now select fields within the chart. Select a
field by clicking it in the canvas or in the Query pane.

You can now edit the selected chart using commands available through the context menu
or the ribbon.
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Procedure: How to Edit Text

When you select a component, you can perform various functions on the component, such as
moving and resizing it, as explained in How to Move a Component on page 398 and How to
Resize a Component on page 396. After clicking a component, you can use the ribbon to affect
all settings of the selected component, except for fields. You can right-click a component to
select individual fields to edit through the context menu. 

In addition to editing text, you can style and customize reports and charts. For more
information on reports, see How to Style and Customize a Report on page 401. For more
information on charts, see How to Style and Customize a Chart on page 401.

Note: Images cannot be edited.

1. Open or create a document with at least one text component.

2. Click the text box.

Sizing handles appear around the border and the text box toolbar becomes active.

3. Click anywhere in the text box and begin entering text.

4. Highlight the text you would like to edit, and right-click it. A menu of options appears, as
shown in the following image.

5. Using the menu options, you can style the text and insert quick text.

The text component menu options are as follows:

Font. Opens a list of available fonts for the selected text.
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Size. Opens a list of available text sizes for the selected text.

Bold. Formats the selected text in bold.

Italic. Formats the selected text in italics.

Underline. Underlines the selected text.

Text color. Opens the Color dialog box where you can select a color for the selected
text.

Cut. Cuts the selected text.

Copy. Copies the selected text to the clipboard.

Paste. Pastes the selected text from the clipboard.

Date. Opens a list of date quick text in various formats.

Time. Opens a list of time quick text in various formats.

page #. Opens a list of page number quick text in various formats.

Procedure: How to Delete a Component

The following procedure applies to all components in Document view. 

1. Open or create a document with at least one component.

2. Right-click the component and click Delete.

The component is deleted from the canvas.

Note: You can also delete a component by clicking it and pressing the Delete key.

Creating Multi-Page Documents

In Document mode, content can be created on multiple pages. The available output formats
are: HTML, active report, PDF, Excel (xlsx), and PowerPoint (pptx). Additional Excel formats are
available, as well. 

Note: When working in Document mode using the active report format, you can create a rich,
multi-object document that integrates various reports and charts, closely resembling a
dashboard.
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Microsoft Excel 2007 and Microsoft PowerPoint 2007 are enabled by default in the
Administration Console. To enable or disable formats, you must do so in the Administration
Console.

The active report output format combines multiple reports and charts into one document,
resulting in a tabbed active dashboard.

Excel combines multiple reports as different sheets in a workbook.

PowerPoint combines multiple reports and charts in a single slide.

Creating Multi-page Documents

You can create multi-page documents, allowing you to display an array of information across
different pages.

Procedure: How to Create a Multi-page Document

1. Create a new document.

Page 1 appears on the canvas title bar.

2. Add content, such as a new or existing report, chart, text, and images to Page 1.

3. To add another page, do one of the following:

On the Insert tab, in the Pages group, click Page.

On the canvas title bar, click the page icon. From the Page menu that opens, select
New Page.

A new page, for example, Page 2, is inserted after the current page, and appears on the
canvas.

Each new page that you add is named Page n, where n is a unique number increasing by
an increment of 1.

4. Add content to Page 2.

5. Repeat steps 3 - 4 until your document is complete.

To navigate between pages, open the Page menu by clicking the Page icon at the top of
the canvas.

Creating a Multi-page Active Technologies Dashboard

You can create a multi-page active technologies dashboard using InfoAssist+.
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Procedure: How to Create a Multi-page Active Technologies Dashboard

1. Create a new active dashboard by setting the output format to active report.

Page 1 appears on the canvas title bar.

2. Add content, such as a new or existing report, chart, text, images, and active dashboard
prompts to Page 1.

3. To add another page, do one of the following:

On the Insert tab, in the Pages group, click Page.

On the canvas title bar, click the page icon. From the Page menu that opens, select
New Page.

A new page, for example, Page 2, is inserted after the current page, and appears on the
canvas.

Each new page that you add is named Page n, where n is a unique number increasing by
an increment of 1.

4. Add content to Page 2.

5. Repeat steps 3 - 4 until your dashboard is complete.

To navigate between pages, open the Page menu by clicking the Page icon at the top of
the canvas.

6. Run the active dashboard.

The tabs appear at the top of the canvas.

Navigating the Page Menu

You can access the Page menu by clicking the Page icon in Design mode. 

The Page menu lists the pages in the order in which you created them. You can rearrange the
pages using drag-and-drop functionality. You can also select multiple pages and delete them.

In addition, the Page menu contains the New Page option to add a new page to the document.
The Duplicate option creates a duplicate page.

The Page menu also contains Page Options which you can click to launch a dialog box of the
following options:

Rename Page

Move Page Up
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Move Page Down

Delete

When you select a page, the Rename, Move Up, Move Down, and Delete options become
active in the menu bar at the top of the dialog box. Also, when you right-click a page, a context
menu of these same options opens.

The position of the page that you have selected determines which directional options are
available. For example, Move Up would not be an option for Page 1. Move Down would not be
an option for the last page.

To close the dialog box, click OK.

Using the Active Cache Option

Because all post-retrieval processing is performed in the memory of the web browser, an active
report has a processing limit of approximately 5,000 records or 100 pages of output. The
active cache option enables you to send only the first page of active report output to the
browser and retrieve subsequent pages from a temporary cache on the Reporting Server. 

Tip: It is recommended that you set the number of rows retrieved five times greater than the
number of lines retrieved per page (as indicated in SET LINES). The minimum number of rows
retrieved is 100.

Enabling Active Cache Through InfoAssist+

Active cache is enabled when you select active report as the output type and the Pages on
Demand button (Format tab, Navigation group) is enabled. 

The Advanced tab on the active report options dialog box contains the Rows Retrieved drop-
down list. Use this setting to establish the increments in which the cached data stored in a
binary file is returned to the output window. The default is 100.

Note: In a multi-page document, active cache must be enabled per component. It is not
globally set. Therefore, when creating a document in AHTML format, you must select each
component separately to enable active cache. When you do so, the Pages on Demand button
is activated. 

Building Visualizations

Visualizations centralize information by providing different views of data that are pertinent to a
particular objective. For example, reviewing trends or fluctuations in data over a period of time
or within a region. A visualization provides you with a quick glance of information on a single
screen.
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Visualizations support the use of different types of charts, maps, and grids. For example, you
may want to use a bar, pie, and line chart to show different views of the same data.
Alternatively, you may want to offset a particular visual by showing other types of related data
that employ a different type of visual. You can also add a text cell to your visualization to
provide explanatory text or information that other users can reference.

Visualizations allow you to monitor changes in data. They also serve to provide information in
real-time, based on changes in underlying data or other components. A visualization can be
updated, changed, or revised at any time to account for shifts in data needs.

Creating a Visual

You can create charts, maps, and grids to visually represent your data. You can add multiple
visuals to the canvas to create a complete visualization.

The default visual is a bar stacked chart. You can use the Change option in the Visual group
on the Home tab to change the visual type.

The following visual is a matrix marker chart that shows sales data for a range of electronic
products.
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Procedure: How to Create a Visualization From InfoAssist+

You can have multiple file types opened at once. To create a visualization:

1. On the Quick Access toolbar, click New.

or

Click the Application Main Menu button, and click New.

The InfoAssist+ splash screen displays.

2. Click Build a Visualization.

3. In the Open dialog box, select a data source and click Open.

InfoAssist+ switches to visualization mode.

Changing the Visual Type

You can create a visual using the default chart type, which is a stacked bar chart. You can add
your data to this chart and then change the chart type, or you can change the chart type prior
to making your data selections.

Once you have started exploring your data, you can switch between the different types to
obtain the graphical image that you wish to display.

You change the visual type from the Home tab.

Procedure: How to Change the Visual Type

1. On the Home tab, in the Visual group, click Change, as shown in the following image. 

Note: The Change icon updates depending on the chart, map, or grid that you select from
the Select a Visual menu. By default, the Change icon displays a stacked bar chart.

The Select a Visual menu displays.

2. On the Select a Visual menu, click the type of visual that you want to use.

Your canvas refreshes and displays the visual that you selected.
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Note: Depending on the type of visual that you select, you may need to select additional or
different data fields.

Narrating Charts

Narrative charts tell the story of your data. When creating a bar, line, area, or pie chart, you
can bring your chart to life with words that describe your data, as shown in the following image.

If your administrator has activated this feature for you, you can enable Narrative Charts from
the ribbon. On the Format tab, in the Features group, click Narrative. This will add descriptive
text for the current chart or visual.

Narrative charts let you communicate about your data, summarizing data values and providing
an interpretation of the results.

Selecting a Visual

It is important that you select a chart, grid, or map that appropriately displays a meaningful
view of your data. InfoAssist+ provides a library of visuals.

You can select a visual type from the Select a Visual menu, on the Home tab, in the Visual
group. The following table describes the types of charts available.
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Icon Visual Type Description

Grid Grids provide a tabular view of data. They allow
you to review data in a row and column format,
similar to a printed report.

Bar chart Bar charts plot numerical data by displaying
rectangular blocks against a scale (numbers or
variable measure fields that appear along the
axis).

Stacked bar chart A stacked bar chart is the default visual.

Absolute line chart Line charts allow you to trace the evolution of a
data point by working backwards or
interpolating. Highs and lows, rapid or slow
movement, or a tendency towards stability are
all types of trends well suited for a line chart.

Area chart Area charts analyze trends over time and look
for differences in values.

Stacked area chart Stacked area charts allow you to stack data on
top of each other.

Pie chart Pie charts are circular charts that represent
parts of a whole. A pie chart emphasizes where
your data fits, in relation to the other
components in the pie.

Ring pie chart Ring pie charts are useful when you want to
review the value of each segment, which
represents the measure value for the selected
dimension, as it relates to the total for the
selected measure.
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Icon Visual Type Description

Scatter Plot Scatter charts enable you to plot data using
variable scales on both axes. When you use a
scatter chart, the data is plotted with a hollow
marker, so that you can visualize the density of
individual data values around particular points,
or discern patterns in the data.

Bubble chart Bubble charts can have two column fields
representing X and Y data values, or have
three column fields representing X, Y, and Z
data values. The third variable (Z) represents
size. The size of each bubble is used to show
the relative importance of the data.

Matrix Marker chart Matrix marker charts are useful for analyzing
one or two measures against a crosstab of two
categorical dimensions. The result is a color-
scaled matrix chart that shows categorized
trends.

Treemap Treemaps are used to display large amounts of
hierarchically structured data. Using a set of
nested rectangles to illustrate data
relationships, sections of a treemap represent
branches of a tree.

Gauge Gauges are used to display the value of a
measure. In particular, circular gauges are
used to represent a single data value within a
given spectrum. You can create a single
circular gauge for a measure or a matrix
circular gauge, which shows the value of the
selected measure across different dimensions,
such as product category or yearly sales.

Choropleth map A geographically-based heat map. It is useful
for visualizing location-based data, trends, and
distributions across a geographic area.
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Icon Visual Type Description

Proportional symbol
map

A technique that uses symbols of different
sizes to represent data associated with
different areas or locations within the map.

Heatmap A heatmap is a graphical representation of
data where the individual values that comprise
a matrix are represented as colors. Using
radiant hues, you can track the intensity of a
data relationship using the colors defined in
the legend.

Note: When new data is added to a bar, line, area, pie, scatter, bubble, gauge, or treemap
chart, the chart will morph and rebuild, revealing the new values in a smooth transition.

Use the topics in this section to select and create your visuals.

Grids

Grids provide a tabular view of data. They allow you to review data in a row and column format,
similar to a printed report. 

In the following example, we review the Sale Year and Product Category data for the following
measure fields:

Revenue
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Gross Profit

Procedure: How to Create a Grid

1. Change the visual to a grid, or insert a new grid.

2. Drag data fields to the canvas or to the Query field containers to add them to your visual.
The following Query field containers must be populated for this visual:

Rows or Columns - one or more data fields

Measure - one or more data fields

As you add, edit, or rearrange the fields in your Query field containers, your canvas
refreshes.
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Bar Charts

Bar charts plot numerical data by displaying rectangular blocks against a scale (numbers or
variable measure fields that appear along the axis). The length of a bar corresponds to a value
or amount. You can clearly compare data series (fields) by the relative heights of the bars. Use
a bar chart to display the distribution of numerical data. You can create horizontal and vertical
bar charts. 

Note: If you are working with a large dataset, a scroll bar displays under your chart, enabling
you to easily scroll through your data from left to right. In visualization mode, scroll bars are
automatically enabled, but if you want to disable or re-enable scroll bars, click the Format tab
and then click Interactive Options. In the Interactive Options dialog box, select the Auto Enable
X-Axis Scrolling check box. If you are working in any other mode, you must enable this
functionality.

Use a bar chart when individual values are important. For example, the following image is a
basic vertical bar chart that compares the individual products sold to the total amount in sales
for each product. A retailer would find it important to know which pieces of inventory are selling
and how much revenue each item is generating for the company.
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A horizontal bar chart becomes useful when you want to emphasize a ranking relationship in
descending order, or the X-axis labels are too long to fit legibly side-by-side. For example, the
following image is a basic horizontal bar chart that ranks which products are generating the
most revenue for the retailer.

Note: You can swap the orientation of your data in a bar chart. To do so, on the Home tab, in
the Visual group, click Swap.

Procedure: How to Insert a New Bar Chart

1. Change the visual to a bar chart or insert a new bar chart.

2. Drag data fields to the canvas or to the Query field containers to add them to your visual.
The following Query field containers must be populated for this visual:

Vertical Axis - one or more data fields

Horizontal Axis - one data field

Note: You can also double-click a data field to add it to your Query field containers.

The bar chart displays on the canvas. You can add additional data fields for comparative
purposes. You can also view underlying data by hovering over any particular point on the
bar chart.
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Procedure: How to Create a Stacked Bar Chart

The bar stacked visual is the default visual.

1. Change the visual to a stacked bar chart or insert a new stacked bar chart.

2. Drag data fields to the canvas or to the Query field containers to add them to your visual.
The following Query field containers must be populated for this visual:

Vertical Axis - one or more data fields

Horizontal Axis - one or more data fields

Color - one data field

Note: You can also double-click a data field to add it to your Query field containers.

The stacked bar chart displays on the canvas. You can add additional data fields for
comparative purposes. You can also view underlying data by hovering over any particular
point on the stacked bar chart.

Line Charts

Line charts allow you to trace the evolution of a data point by working backwards or
interpolating. Highs and lows, rapid or slow movement, or a tendency towards stability are all
types of trends well suited for a line chart. 

You can also plot line charts with two or more scales to present a comparison of the same
value, or set of values, in different time periods.

Note: If you are working with a large dataset, a scroll bar displays under your chart, enabling
you to easily scroll through your data from left to right. In visualization mode, scroll bars are
automatically enabled, but if you want to disable or re-enable scroll bars, click the Format tab
and then click Interactive Options. In the Interactive Options dialog box, select the Auto Enable
X-Axis Scrolling check box. If you are working in any other mode, you must enable this
functionality.

Building Visualizations

416  Information Builders



Use a line chart when you want to trend data over time, for example, monthly changes in
employment figures, or yearly sales of an item in your inventory. The following image is a line
visual that shows the gross profit in monthly sales for products.

Procedure: How to Create a Line Chart

1. Change the visual type to a line chart or insert a new line chart.

2. Drag data fields to the canvas or to the Query field containers to add them to your visual.
The following Query field containers must be populated for this visual:

Vertical Axis - one or more data fields

Horizontal Axis - one data field

Color - one data field (optional)

Note: You can also double-click a data field to add it to your Query field containers.

To add insight, you can drag a data field to the color Query field container. This displays
the values for this field using color.

4. Creating Content

Online Help PDF  417



The line chart displays on the canvas. You can add additional data fields for comparative
purposes. You can also view underlying data by hovering over any particular point on the
line chart.

Area Charts

Area charts analyze trends over time and look for differences in values by using the see-thru
nature of the area fills. Stacked area charts allow you to stack data on top of each other.
Stacking allows you to highlight the relationship between data series, showing how some data
series approach a second series. 

Note: If you are working with a large dataset, a scroll bar displays under your chart, enabling
you to easily scroll through your data from left to right. In visualization mode, scroll bars are
automatically enabled, but if you want to disable or re-enable scroll bars, click the Format tab
and then click Interactive Options. In the Interactive Options dialog box, select the Auto Enable
X-Axis Scrolling check box. If you are working in any other mode, you must enable this
functionality.

Use an area chart when you want to distinguish the data more dramatically by highlighting
volume with color. For example, the following image is a basic area chart that depicts the
yearly gross profit for various electronic products.
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Procedure: How to Create an Area Chart

1. Change the visual type to an area chart or insert a new area chart.

2. Drag data fields to the canvas or to the Query field containers to add them to your visual.
The following Query field containers must be populated for this visual:

Vertical Axis - one or more data fields

Horizontal Axis - one data field

Color - one data field (optional)

Note: You can also double-click a data field to add it to your Query field containers.

The area chart displays on the canvas. You can add additional data fields for comparative
purposes. You can also view underlying data by hovering over any particular point on the
area chart.

Procedure: How to Create a Stacked Area Chart

1. Change the visual type to a stacked area chart or insert a new stacked area chart.

2. Drag data fields to the canvas or to the Query field containers to add them to your visual.
The following Query field containers must be populated for this visual:

Vertical Axis - one or more data fields

Horizontal Axis - one data field

Color - one data field (optional)

Note: You can also double-click a data field to add it to your Query field containers.

The stacked area chart displays on the canvas. You can add additional data fields for
comparative purposes. You can also view underlying data by hovering over any particular
point on the stacked area chart.

Pie Charts

Pie charts are circular charts that represent parts of a whole. A pie chart emphasizes where
your data fits, in relation to the other components in the pie. Pie charts work best when there
are a limited number of slices (for example, less than 10) and the slices are all of a sufficient
value as to reveal their fill color inside their wedge. 
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Use a pie chart when you have segments of data that you want to display as a whole. For
example, the following image is a pie chart that shows the proportions of various electronic
products based on the quarterly revenue.

You can add one or more measures to the Measure field container. Each measure will be used
to create a separate, unique pie chart, to which you can add a measure or dimension to the
Color field container to add color to your chart.

Note: When working with pie charts, you can add one measure field to the Color field
container. This adds the measure as a By field, and determines how the pie chart is colored.
Depending on your measure data, this may result in a large number of pie segments.

Procedure: How to Create a Pie Chart

1. Change the visual type to a pie chart or insert a new pie chart.

2. Drag data fields to the canvas or to the Query field containers to add them to your visual.
The following Query field containers must be populated for this visual:

Measure - one data field. Data in this category is used to indicate the size of the pie
slice for the relevant category.

Color - one data field. Data in this category indicates the colors in your pie chart.
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Note: You can also double-click a data field to add it to your Query field containers.

The pie chart displays on the canvas. You can add additional data fields for comparative
purposes, or to create another pie chart on the same canvas. You can also view underlying
data by hovering over any particular point on the pie chart.

Ring Pie Charts

Ring pie charts are circular charts that display the total for the selected measure, as well as
the individual segments that comprise the ring pie chart. You can hover over each segment to
review the underlying data values. This is useful when comparing the measure value for an
individual segment against the total for the measure, which displays in the center of the ring
pie. 

You can add one or more measures to the Measure field container. Each measure will be used
to create a separate, unique ring pie chart, to which you can add a measure or dimension to
the Color field container to add color to your chart.

Note: The font size of the value label in the middle of the ring is automatically set by the chart
engine.
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Use a ring pie chart when you want to review the value of each segment, which represents the
measure value for the selected dimension, as it relates to the total for the selected measure.
The following image is an example of a ring pie chart.

Procedure: How to Create a Ring Pie Chart

1. Change the visual type to a ring pie chart or insert a new ring pie chart.

2. Drag data fields to the canvas or to the Query field containers to add them to your visual.
The following Query field containers must be populated for this visual:

Measure - one data field. Data in this category is used to indicate the size of the ring
pie segment for the relevant category.

Color - one data field. Data in this category indicates the colors in your ring pie chart.

Note: You can also double-click a data field to add it to your Query field containers.

The ring pie chart displays on the canvas. The total for the selected measure displays in
the center of the ring pie chart. You can view underlying data by hovering over any of the
ring pie chart segments.
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Scatter Charts

Scatter charts enable you to plot data using variable scales on both axes. When you use a
scatter chart, the data is plotted with a hollow marker, so that you can visualize the density of
individual data values around particular points, or discern patterns in the data. A numeric X
axis, or sort field, always yields a scatter chart, by default.

Note: You can specify a non-measure (dimension) data field on the horizontal or vertical axis,
or both.

If your chart reveals clouds of points, there is a strong relationship between X and Y values. If
data points are scattered, there is a weak relationship, or no relationship. 

Adding data fields to the Detail Query field container creates additional BY fields on the scatter
chart. For example, the following image shows the results when adding the
Product,SubCategory and Model dimension fields to Detail Query field container in a scatter
chart which showed gross profit and MSRP data.

Procedure: How to Create a Scatter Chart

1. Change the visual type to a scatter chart or insert a new scatter chart.
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2. Drag data fields to the canvas or to the Query field containers to add them to your visual.
The following Query field containers must be populated for this visual:

Vertical Axis - one data field

Horizontal Axis - one data field

Detail - one or more data fields

Color - one data field

Note: You can also double-click a data field to add it to your Query field containers.

The scatter chart displays on the canvas. You can also view underlying data by hovering
over any particular point on the scatter chart.

Bubble Charts

A bubble chart is a chart in which the data points are represented by bubbles. Bubble charts
can have two column fields representing X and Y data values, or have three column fields
representing X, Y, and Z data values, in that order. The Z variable represents size. The size of
each bubble is used to show the relative importance of the data. 

When you add a data field to the Size field container, this value is represented as the Z Axis
Title in the legend. It displays as an empty Z Axis Title when a size data field is not specified. If
you choose to indicate a Z, or size, data value, the data label displays in the legend. A Size
Legend also displays, showing the estimated data value for a range of circle sizes. This allows
you to estimate the value of the data based on the size of the circle.

Note:

You can hover over the circles in the visual to obtain exact data values for any given point.

You can specify a non-measure (dimension) data field on the horizontal or vertical axis, or
both.

In Visualization mode and for HTML5 charts, if you select the No fill option for your Series
style when creating a bubble chart, the series displays in shades of black. For active
charts, you must enable the Show Border Color option in order to view the bubbles in your
chart at run time, otherwise the bubbles are invisible.
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In the following image, a bubble chart is used to show the Manufacturers Suggested Retail
Price (MSRP) plotted against Revenue for a variety of electronics products. It also shows the
values for Gross Profit, which was specified in the Size field container in the Query pane.

Procedure: How to Create a Bubble Chart

1. Change the visual to a bubble chart or insert a new bubble chart.

2. Drag data fields to the canvas or to the Query field containers to add them to your visual.
The following Query field containers must be populated for this visual:

Vertical Axis - one data field

Horizontal Axis - one data field

Detail - one or more data fields

Size - one data field

Color - one data field (optional). Labels for the values in this data field will comprise
the legend.

Note: You can also double-click a data field to add it to your Query field containers.

The bubble chart displays on the canvas. You can also view underlying data by hovering
over any particular point on the bar chart.
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Matrix Marker

Matrix marker charts are useful for analyzing one or two measures against a crosstab of two
categorical dimensions. You can use the Size Query field container for one measure and the
Color Query field container for a second measure. The result is a color-scaled matrix chart that
shows categorized trends, as shown in the following image. 

Procedure: How to Create a Matrix Marker Chart

1. Change the visual to a matrix marker chart or insert a new matrix marker chart.

2. Drag data fields to the canvas or to the Query field containers to add them to your visual.
The following Query field containers must be populated for this visual:

Matrix Rows - one data field

Matrix Column - one data field

Size - one data field. The data for this field determines the size of the marker.

Color - one data field. The data in this field determines the color of the marker.

The matrix marker chart displays.
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Treemaps

Treemaps are used to display large amounts of hierarchically structured data. Using a set of
nested rectangles to illustrate data relationships, sections of a treemap represent branches of
a tree. Each branch is given a rectangle, to which any number of smaller sub-branches can be
assigned. The size of each branch is proportional to the summed values of the elements
inside the branch. 

The following treemap shows the categories of the selected dimension fields, using two data
fields to determine the size and color of the treemap segments.

Procedure: How to Create a Treemap

1. Change the visual to a treemap or insert a new treemap.

2. Drag data fields to the canvas or to the Query field containers to add them to your visual.
The following Query field containers must be populated for this visual:

Grouping - one or more data fields, which establishes the hierarchy of the Treemap
grouping.

Size - one data field. This data controls the size of the branches that display.

Color - one data field. This data controls the colors that display based on the
accompanying gradient.
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The treemap displays.

Gauges

Gauges are used to display the value of a measure. In particular, circular gauges are used to
represent a single data value within a given spectrum. These gauges have a circular shape.
You can create a single circular gauge for a measure or a matrix circular gauge, which shows
the value of the selected measure across different dimensions, such as product category or
yearly sales. The value of the measure that displays in a circular gauge is determined by the
underlying data stored for that measure in the database. 

The circular gauge functionality uses only one measure in its presentation. The legend reflects
the color of the measure within the circular gauge.

In the following example, we review revenue data for each product category by quarterly sales
in a matrix circular gauge chart.

Procedure: How to Create a Circular Gauge

1. Change the visual type to a gauge or insert a new gauge.
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2. Drag data fields to the canvas or to the Query field containers to add them to your visual.
The following query field containers must be populated for this visual:

Measure - one data field. Data in this category is used to indicate the value of the
selected measure, which displays within the gauge.

Tooltip - one or more data fields. The fields that you add provide you with the ability to
review additional related, underlying data for different measures. Tooltips are optional.

Note: You can also double-click a data field to add it to your Query field containers.

The circular gauge displays on the canvas. You can select additional measure fields for
which to include in the tooltip.

Heatmaps

A heatmap is a graphical representation of data where the individual values that comprise a
matrix are represented as colors. Using radiant hues, you can track the intensity of a data
relationship using the colors defined in the legend.

Heatmaps are useful when you are looking for hot spots in your data, or areas of focus or
interest, as shown in the following image.
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Procedure: How to Create a Heatmap

1. Change the visual to a heatmap or insert a new heatmap.

2. Drag data fields to the canvas or to the Query field containers to add them to your visual.
The following Query field containers must be populated for this visual:

Color - one data field. This data controls the colors that display based on the
accompanying gradient.

Horizontal field container - one data field.

Vertical field container - one data field

Note: You can optionally populate the Matrix Row and Column fields to increase the
segmentation of your heatmap.

The heatmap displays.

Interacting With Visualizations

A visualization is comprised of one or more visuals, such as charts, maps, or grids and text.
You can create different views of your data in a single visualization, and share that
visualization with others in your enterprise.

The following image shows a sample visualization. This visualization includes a map, a matrix
grid, and a stacked area chart.
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This section summarizes the tasks that are available to you when working with visuals. It
provides centralized instructional information on performing each task and offers links to the
most common topics when working with visuals.

Task How To

Change visual On the Home tab, in the Visual group, click Change.

Note: The Change icon updates depending on the
chart, map, or grid that you select from the Select
a Visual menu. By default, the Change icon
displays a stacked bar chart.

Select a chart, map, or grid from the Select a
Visual menu.

Insert new visual On the Home tab, in the Visual group, click Insert.
Use the default stacked bar chart or click Change
to select a different chart, map, or grid from the
Select a Visual menu.

Note: You can also add additional charts, maps, or
grids to a visualization by dragging a data field onto
the canvas and placing it using the handles that
are available.

Rearrange visuals Drag a visual on top of another visual to activate a
shaded area that contains handles, which can be
used to indicate placement.

Copying a visual On the canvas, select a visual. On the Home tab, in
the Clipboard group, click Copy.

Note: You can also press CTRL+C to copy a
selected visual.

Pasting a visual Copy a visual. On the Home tab, in the Clipboard
group, click Paste.

Note: You can also press CTRL+V to paste a
copied visual on the canvas.
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Task How To

Duplicating a visual On the canvas, select a visual. On the Home tab in
the Clipboard group, click Duplicate. A duplicate
visual is created and a sequential number is
assigned based on the type of visual.

Delete visual Select a visual. On the Home tab, in the Clipboard
group, click Cut. You can click the Close button in
the upper-right corner of the current visual. From
the Query pane, right-click a visual and click Delete.
You can also press the Delete key when a visual is
selected.

Apply Filter Drag a dimension field or measure field into the
Filter pane to access the filter options that are
available. To add filter options for a field that is
already in the Query pane, select the field and on
the Field tab, in the Filter group, click Filter.

Add visuals to the storyboard Create a visual. On the Home tab, in the Storyboard
group, click Add.

Procedure: How to Insert a New Visual

1. On the Home tab, in the Visual group, click the down arrow next to Insert. 

2. On the menu, click one of the following options:

Chart. Inserts a stacked bar chart visual.

Grid. Inserts a grid visual.

Text. Inserts a blank text cell.

3. Populate your visual with data or add text to the text cell.

Note:

By default, when you click Insert, a stacked bar chart visual is inserted.
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You can also drag a data field from the Data pane to the canvas to insert a new visual.
This inserts the default visual, a stacked bar chart. You can use the placement
handles to position your new visual on the canvas, for example, above an existing
visual or to the side of an existing visual.

Procedure: How to Add Text to Your Visualization

1. On the Home Tab, in the Visual group, click the down arrow on next to Insert. 

2. On the menu, click Text.

A text cell opens on the canvas.

3. Add text to your visualization.

Note: You can resize the text cell and use the text formatting options to customize the
display of any text that you add, as shown in the following image.

You can also position the text cell in your visualization by dragging the text cell on top of a
visual. Use the placement handles to indicate placement of the text cell.

Procedure: How to Create a Visualization

1. Begin with the default canvas, which consists of a stacked bar chart template. 
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2. Insert a new visual in one of the following ways:

a. Drag a data field from the Data pane onto the canvas. Handles display, which allow
you to select the location for the new visual, for example, top (above) or left of the
current visual, as shown in the following image.

b. On the Home tab, in the Visual group, click Insert.

Note: You can optionally click the down arrow on the Insert button to specify the
addition of a chart, grid, or text.

3. Add another visual.

Now, three visual cells display side-by-side.

4. Click a visual to select it.

Note: You can click a visual to activate it, or double-click on the visual number or name in
the Query pane.

5. Reorganize your visuals using the handles.
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6. Once you have organized the placement of your visuals, select one and specify the visual
type.

a. On the Home tab, in the Visual group, click Change.

Note: The Change icon updates depending on the chart, map, or grid that you select
from the Select a Visual menu. By default, the Change icon displays a stacked bar
chart.

b. In the Select a Visual menu, click the type of visual you want to use. For example,
Line, Area, or Map.

c. Repeat these steps for all three visuals on your canvas.

7. Populate each visual with your data.

You can change the type of visual that you previously selected at any time. You can also
resize or reorganize the position of each visual as you add data.

For example, move the lower-left visual to the top of the visualization.

4. Creating Content

Online Help PDF  435



The bubble chart now runs across the top of the visualization.

8. Click Save to save your visualization.

Minimizing or Maximizing a Visual

When working on a visualization with more than one chart, map, or grid, you can maximize and
minimize individual visuals. This allows you to focus on one visual at a time, and then minimize
it to view it alongside the other visuals.

The maximize and minimize icons are located in the top-right corner of each visual, next to the
Close button. When you click the Maximize icon, the current visual moves to the foreground
and is the only visual that displays on the canvas. You can work on this visual, and then
minimize it to view the other visuals.

Note: You can view other visuals in the maximized mode by selecting a different visual in the
Query pane.

Procedure: How to Minimize or Maximize a Visual

1. Create a visualization with two or more visuals.
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2. Perform the following actions to minimize or maximize your visual:

Click the maximize icon or double-click on the Title bar to maximize your visual.

Click the minimize icon or double-click on the Title bar to minimize your visual.

You can maximize one visual at a time, and you can switch between visuals in this mode
by double-clicking a different visual in the Query pane.

Procedure: How to Delete a Visual

1. In your visualization, select the chart, map, or grid that you want to delete.

2. Perform one of the following tasks to delete the visual:

Press the Delete key.

On the Home tab, in the Clipboard group, click Cut.

Click the Close button in the upper-right corner of the current visual.

From the Query pane, right-click on a visual, and click Delete.

Note: You can use the Undo and Redo options on the Quick Access Toolbar to reverse or
redo any prior actions.

Renaming a Visual

You can rename a visual on the canvas or within your visualization. You may want to do this for
presentation and organizational purposes, as each visual has a default label (for example, Bar
1, Bar 2, and Bar 3). You can change these labels by renaming the visual in the Query pane.

Once new labels are in place, it is easier to recognize which visual you want to select at any
given time.

Using the shortcut menu for a visual in the Query pane, you can also rename your visual.

Procedure: How to Rename a Visual

1. Create a visualization with one or more chart, map, or grid.

2. In the Query pane, right-click the visual number for which you want to modify the title.

3. Click Rename.

4. In the Edit Title dialog box, enter a new name for the visual.

5. Click OK.
The visual is renamed in the Query pane and the new title is reflected at the top of the
selected visual.
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Creating Matrix Charts

Matrix charts are powerful, comparative tools. They provide enough detail to show a trend and
they organize information in a categorical fashion.

Matrix charts display data in a grid, showing the comparative values on either axis. They
provide you with a quick glance at trends over time, giving you a succinct synopsis of a
situation (for example, sales or investment trends).

You can use various formats in your matrix chart (for example, pie or line chart).

In the following example, we review quarterly revenue data, by product category, for a range of
years (2014 - 2016, specifically). Using a bar chart for the matrix, we are able to review how
gross profit for each product category shifts over time.

You can plot one value on the X axis and one value on the Y axis. For example, sales against
region. You can also plot just one value for the rows or columns in the matrix chart.
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Procedure: How to Create a Matrix Bar Chart

1. Launch InfoAssist+ in Chart or Visualization mode.

In Visualization mode, on the Format tab, in the Chart Types group, click Bar chart.

In Visualization mode, on the Home tab, in the Visual group, click Change and click Bar
chart.

2. Drag data fields to the canvas or to the Query field containers to add them to your chart.
The following Query field containers must be populated for this chart:

Vertical Axis - one or more data fields

Horizontal Axis - one data field

Matrix Rows - one data field

Matrix Columns - one data field

Note: You can also double-click a data field to add it to your Query field containers.

The matrix bar chart displays on the canvas. You can add additional fields for comparative
purposes. In Visualization mode, you can also view underlying data by hovering over any
particular point on the matrix bar chart.

Procedure: How to Create a Matrix Line Chart

1. Launch InfoAssist+ in Chart or Visualization mode.

In Chart mode, on the Format tab, in the Chart Types group, click Line chart.

In Visualization mode, on the Home tab, in the Visual group, click Change and click Line
chart.

2. Drag data fields to the canvas or to the Query field containers to add them to your chart.
The following Query field containers must be populated for this chart:

Vertical Axis - one or more data fields

Horizontal Axis - one data field

Matrix Rows - one data field

Matrix Columns - one data field

Note: You can also double-click a data field to add it to your Query field containers.
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The matrix line chart displays on the canvas. You can add additional fields for comparative
purposes. In visualizations mode, you can also view underlying data by hovering over any
particular point on the matrix line chart.

Related Information:

Working with Visualizations

Procedure: How to Create a Matrix Area Chart

1. Launch InfoAssist+ in Chart or Visualization mode.

In Chart mode, on the Format tab, in the Chart Types group, click Area chart.

In Visualization mode, on the Home tab, in the Visual group, click Change and click
Area chart.

2. Drag data fields to the canvas or to the Query field containers to add them to your visual.
The following Query field containers must be populated for this visual:

Vertical Axis - one or more data fields

Horizontal Axis - one data field

Matrix Rows - one data field

Matrix Columns - one data field

Note: You can also double-click a data field to add it to your Query field containers.

A matrix area chart displays on the canvas. You can add additional data fields for
comparative purposes. In Visualization mode, you can also view underlying data by
hovering over any particular point on the matrix area chart.

Procedure: How to Create a Matrix Pie Chart

1. Launch InfoAssist+ in Chart or Visualization mode.

In Chart mode, on the Format tab, in the Chart Types group, click Pie chart.

In Visualization mode, on the Home tab, in the Visual group, click Change and click Pie
chart.

2. Drag data fields to the canvas or to the Query field containers to add them to your chart.
The following Query field containers must be populated for this chart:

Measure - one data field

Note: Each unique measure field is represented by a separate pie chart.
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Color - one data field

Matrix Rows - one data field

Matrix Columns - one data field

Note: You can also double-click a data field to add it to your Query field containers.

The matrix pie chart displays on the canvas. You can add additional data fields for
comparative purposes, or to create another pie chart unique to the additional measure
fields you select. In Visualization mode, you can also view underlying data by hovering over
any particular point on the matrix pie chart.

Procedure: How to Create a Matrix Ring Pie Chart

1. Launch InfoAssist+ in Chart or Visualization mode.

In Chart mode, on the Format tab, in the Chart Types group, click Other. In the Select a
chart dialog box, click Pie, then click Ring Pie.

In Visualization mode, on the Home tab, in the Visual group, click Change and click Line
chart.

2. Drag data fields to the canvas or to the Query field containers to add them to your chart.
The following Query field containers must be populated for this chart:

Measure - one data field

Note: Each unique measure field is represented by a separate ring pie chart.

Color - one data field

Matrix Rows - one data field

Matrix Columns - one data field

Note: You can also double-click a data field to add it to your Query field containers.

The matrix ring pie chart displays on the canvas. You can add additional fields for
comparative purposes, or to create another pie chart unique to the additional measure
fields you select. In Visualization mode, you can also view underlying data by hovering over
any particular point on the matrix ring pie chart.
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Procedure: How to Create a Matrix Circular Gauge

1. Launch InfoAssist+ in Chart or Visualization mode.

In Chart mode, on the Format tab, in the Chart Types group, click Other. In the Select a
chart dialog box, click Special, then click Gauge.

In Visualization mode, on the Home tab, in the Visual group, click Change and click
Gauge.

2. Drag data fields to the canvas or to the Query field containers to add them to your chart.
The following query field containers must be populated for this chart:

Measure - one data field. Data in this category is used to indicate the value of the
selected measure, which displays within the gauge.

Note: Since the gauge relies on a constant (measure field), each intersection of the
matrix chart is calculated using that measure along with the various matrix rows and
columns in the matrix chart.

Matrix Rows - one data field.

Matrix Columns - one data field.

Tooltip - one or more data fields. The fields that you add provide you with the ability to
review additional related, underlying data for different measures. Tooltips are optional.

Note: You can also double-click a data field to add it to your Query field containers.

The matrix circular gauge displays on the canvas. You can select additional measure fields
for which to include in the tooltip.

Using Active Technologies

This topic provides an overview of Active Technologies and discusses security and active cache
processing. It includes additional information about the features of the product that will help
you use it. It is intended for administrators and developers who are responsible for creating
active reports, charts, and dashboards.

This topic also describes the features of an Active Technologies report, which is a report that
is enabled to use the full capabilities of Active Technologies. An Active Technologies report is
also called an active report.
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Active Technologies Report Overview

An active report is a report that is designed for offline analysis. When using an active report,
you can:

Interact with the data, using analysis options similar to those found in an Excel
®
 workbook,

without any connection to a server. Analysis options include filtering, sorting, charting, and
much more.

Work offline without any additional plug-ins or programs. An active report is a self-contained
report, meaning that it contains all the data and JavaScript

®
 within the HTML output file.

Packaging the data and the interactive functions in the HTML file also makes the output
highly compressible for email and transparent to security systems.

Save the report on a local machine with active report functionality. Since no connection to a
server is required to view the data or use the analysis options, you can save and use the
report anywhere.

Performance may vary across browsers due to browser-specific memory limitations. For very
large reports, Internet Explorer

®
 may produce an error. For more information, refer to the

Microsoft
®
 website.

When working with an active report, you can:

Filter or highlight data.

Sort data within any column in ascending or descending order.

Apply calculations to columns and choose the location at which to display results.

Control the display of data by hiding columns, freezing columns, limiting the number of rows
per page, and using graphic visualization to compare column values.

Create a variety of simple or advanced charts (pie, line, bar, or scatter) and Rollup Tables.

Apply a global filter to multiple reports within the same HTML page. 

Export report data and chart data.

Restore original report settings.

Run active reports on your mobile device with the Opera browser (Version 8.60 U2 or
higher) installed. See the Opera website for a list of supported devices.

Run active reports on your iPhone® mobile device. For the best performance results, it is
recommended that you set a maximum of 500 records for a mobile report.
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Some active report functionality is drag and drop based, and thus not supported with
iPhone.

The following image shows an HTML active report. The pop-up menu is open for the Sale
Unit(s) column, with the Calculate Avg operator selected.
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The following image shows the options that are available at the cell level for a report in active
report format. Included are the options that reflect Auto Drill, Multi Drill, and Auto Linking
functionality. For more information, see Customizing Content.

Security Features

You can password protect an active report. This feature restricts users from viewing the report
by requiring them to enter a password before opening the report. The data is encrypted using
the 256-bit Advanced Encryption Standard (AES) specification. The password is used as the
key for decrypting and encrypting the data. Therefore, the password is not stored in the report,
and you do not need a connection to go back to the server for password verification.

The HTML page that you receive contains both the JavaScript and the data for the report so
that you can interact with the data in a disconnected mode. Internet Explorer detects the
JavaScript and issues a warning. If you look at the Internet Explorer warning, it mentions
explicitly the detection of active content, which is the JavaScript. The same warning appears
when pop-ups are blocked in the browser.

Handling a Large Amount of Data

Because all post-retrieval processing is performed in the memory of the web browser, an active
report has a processing limit of approximately 5,000 records or 100 pages of output.
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Distribution and Viewing Considerations

Active Technologies stores an active report as an HTML file. The HTML file created by Active
Technologies contains both the report data and the JavaScript code that enables you to
interact with the data in disconnected mode.

An active report is designed for distribution to users who need to perform offline analysis and
interactive functions without connection to a server.

You can save an active report from your web browser to another location. You can also send
an active report to another person by email, as an HTML attachment. However, when you
distribute an active report, you must keep in mind how it will be viewed.

For example, when you send an active report as an HTML attachment to email, many client
email programs on a mobile device can block the JavaScript in the attachment. A third-party
tool, such as the Mobile Faves App for a mobile device, may be used to correctly view the
attachment.

If you try to view an active report in a web browser, and JavaScript is blocked or disabled on
your web browser, you will receive a message reminding you that JavaScript must be enabled
on the browser. If you are using a mobile device, the message directs you to use the Mobile
Faves App. If the Mobile Faves App is not installed, you can download it from the App Store®

for iOS devices or from the Google Play™ store for Android™ devices. In the message, App
Store and Google Play store are hyperlinks to the Mobile Faves App.

The message is displayed on the Desktop or on a supported mobile device when JavaScript is
disabled in a web browser used to open an online or offline active report. It is also displayed
on the Preview pane or window of an application used to preview the content of an offline
active report.
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The following image shows JavaScript disabled in Google Chrome™.

Usage Notes for Active Technologies

The following apply to browser support.

ActiveX, a technology from Microsoft, is not supported in Microsoft Edge. Any Active
Technologies feature that requires the use of ActiveX controls is therefore not available in
Microsoft Edge. These features include the following, which are accessible in other
browsers at run time, using the column drop-down menu on an active report:

Send as E-mail (supported only in Internet Explorer)

Save Changes (supported only in Internet Explorer)
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Export to XML (Excel) when active cache is disabled

If you are using a Firefox browser and you export an AHTML report to Excel, the file
extension that displays is incorrect (for example, .xls.xls). You can override this default
value using the browser settings. Specifically, if you click the Always ask me where to save
files radio button, located under Options, you will be prompted, upon download, to either
open or save the file. You can then provide a name and extension for the file.

The following apply to Active Technologies reports.

Active reports employ left and right cell padding, by default. This enables you to view the
active report consistently, without the concatenation of any values or spacing issues
related to the cell padding. In cases where these settings are not defined in the
StyleSheet, the default settings for the left and right cell padding are used.

By default, Active Technologies displays the name specified in the Master File to identify a
column in an ACROSS group on a tabular active report. With the following WebFOCUS SET
command, you can display the title specified in the Master File, instead of the name, to
identify the column:

SET ACRSVRBTITL = ON

Active Technologies derives the title from the TITLE attribute in the Master File (for
example, TITLE = 'Product ID'). It derives the name from the FIELDNAME or FIELD attribute
(for example, FIELD = PCD).

InfoAssist+ in the Business User Edition does not allow you to create or modify your active
report procedures with a text editor. In the Business User Edition, you must issue the SET
ACRSVRBTITL = ON command in a server profile (for example, edasprof.prf). When issued
in edasprof.prf, the setting is applied globally. It affects all users and all procedures run in
the Business User Edition.

For more information on customizing the server profile in the Business User Edition, see
Managing the Server or Global Profile, in Setting Up Your Environment.

The following applies to filtering Active Technologies content.

When using active content in Cache Mode, filtering may not work properly if the content
contains a text field (for example, TX50). As a workaround, consider using an alphanumeric
field (for example, A50).

The following apply when using the Export to Excel functionality.

When using the Export to Excel option while creating and generating an active report with
active cache enabled, the request will be generated in XLSX format rather than EXL2K. This
applies to the following browsers: Microsoft Edge, Internet Explorer, Firefox, and Chrome.
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The export behavior is controlled by the WebFOCUS Reporting Server, and an ActiveX plugin
is not required for Internet Explorer. When the export is performed, an Office Open XML
document is produced, which you can download and save in the required format (default
is .xlsx).

When using the Export to XML (Excel) option with active cache disabled, the export behavior
is controlled by the active JavaScript layer.

An ActiveX plugin is required for Internet Explorer. This is used to export the output directly
into Microsoft Excel, enabling you to save the document in the required format (.xlsx or .xls
depending on the Microsoft Excel version installed).

In Firefox and Chrome, when the export is performed, an MS Office XML document is
produced, which you can download and save in the required format (the default is .xls).

In Microsoft Edge, the Export to XML (Excel) option is not supported. The option is available
with active cache disabled, but when the export is performed, the output is displayed as
text inside the browser window.

Creating an Active Technologies Report

An active report is a self-contained report that is designed for offline analysis.

Procedure: How to Create an Active Technologies Report

With InfoAssist+ in Report mode, you can perform this procedure in Query Design view or Live
Preview.

1. On the status bar, in the Output Types menu, click active report.

2. Populate the report with your data in one of the following ways:

Drag the dimension fields and measure fields onto canvas.

Drag the dimension fields and measure fields into the appropriate field containers in
the Query pane.

Active Technologies Report Menu Options

Menu options for an active report are described in the following table.

Note: The following options described in the table require the use of ActiveX controls. Since
Microsoft Edge does not support ActiveX technology, these options are not available in that
browser:

Send as E-mail
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Save Changes

Export to XML (Excel) when active cache is disabled

Option Definition

Sort Ascending Sorts the column in ascending order.

Sort Descending Sorts the column in descending order.

Filter Filters the data. Options are:

Equals

Not equal

Greater than

Greater than or equal to

Less than

Less than or equal to

Between

Not Between

Contains

Contains (match case)

Omits

Omits (match case)
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Option Definition

Calculate Calculation types that you can apply to the column:

Clear

Clear All

Count

Distinct, which counts the number of distinct values within a
field.

For numeric fields, you can also apply:

Sum

Avg

Min

Max

% of Total

Chart Creates an active chart from the report. Options are Pie, Line,
Column, and Scatter.

Rollup Lists the fields available to create a table.

Pivot (Cross Tab) Lists the fields available to create a Pivot table.

Visualize Adds visualization bars to, or removes them from, the selected
column. The Visualize option is available for numeric data
columns.

Hide Column Suppresses the display of the selected column in the report.

Show Columns Lists the names of the columns that are hidden in the report,
allowing you to individually restore a column.

Select the name of a specific column in the hidden columns list to
restore that column to the report.
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Option Definition

Freeze Column Freezes the report at a particular point so that columns to the left
of the freeze point remain in view while the user scrolls through
the other report columns.

Note: If the report can be fully viewed in the browser window,
freeze is not applied. The Freeze column option is not available for
expandable report (Accordion) views.

Unfreeze All Unfreezes the columns.

Grid Tool Opens the Grid Tool, which you can use to change the column
order, select multiple columns to sort ascending or descending,
hide and show columns, add a calculation result to a column, and
add subtotals to the active report.

Chart/Rollup Tool Opens the Chart/Rollup Tool, which you can use to select multiple
group fields to generate the chart or rollup table. The Chart/Rollup
Tool contains a list of columns available in the active report to add
to Group By and Measure fields. Drag the columns into the field
that you want.

Pivot Tool Opens the Pivot Tool, which you can use to select multiple group
fields to generate the chart or pivot table. The Pivot Tool contains
a list of columns available in the active report to add to Group By,
Across, and Measure fields. Drag the columns into the field that
you want.

Show Records Opens the Show Records menu option to list the number of
records available for display per page in the report. Select a
number (for example, 10) to display, per page. Default displays the
number of records (lines) per page that is specified in the
WebFOCUS report procedure.

Comments Options to display comments under cells or hide indicators for
comments in the active report output.
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Option Definition

Send as E-mail Enables you to save the current state of the active report and send
the report as email.

Note: To use this feature, you must have ActiveX enabled in your
browser security settings.

This feature is only supported in Internet Explorer.

Save Changes Saves the current state of the active report.

When you save an active report using the browser Save as option,
the report is saved in its original default state. In the browser Save
as dialog box, it is recommended that you select the Webpage,
HTML Only save option to ensure that the page is saved properly.

Note: To use this feature, you must have ActiveX enabled in your
browser security settings.

This feature is only supported in Internet Explorer.

Export When active cache is enabled, exports all records or filtered only
records to HTML, CSV, Excel, or PDF.

Note: active cache is enabled on an active report when you click
Pages On Demand on the Format tab, in the Navigation group.

When active cache is disabled, exports all records or filtered only
records to HTML, CSV, or XML (Excel). To use this feature, you
must enable ActiveX in your browser security settings.

Print Prints all records or filtered only records.

Window Displays reports in a cascade or separate tabs.

Restore Original Restores the active report to the default state specified in the
report procedure.

Active Technologies Cell Menu Options

When you are working in active report format, the following data cell options display.
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Option Definition

Drill down Enables you to drill down one level in the hierarchy of your
data source. This option displays for reports that have Auto
Drill enabled.

Drill up Enables you to drill up one level in the hierarchy of your
data source. This option displays for reports that have Auto
Drill enabled.

Restore Original Restores the active report to the default state specified in
the report procedure.

Auto Links Displays a list of target reports that are linked to the Auto
Link enabled report. This option displays for reports that
have Auto Linking enabled.

Comments Enables you to add comments about data in your report.
The result is an annotation that displays when you hover
over it run time.

Highlight Value Enables you to highlight a particular value in your report.

Highlight Row Applies highlighting to the selected row in your report.

Unhighlight All Removes any applied highlighting from values or rows in
your report.

Filter Cell Enables you to filter the output, showing only a selected
row of data.

Remove Cell Filter Removes any applied cell filters.

Configuring Active Technologies Report Options

You can configure active report options, including menu options, based on user role, through
the active report options dialog box.

You can access the dialog box on the Format tab, in the Features group, by clicking the active
report options button. The button is available when active report is selected as the output type.
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The active report options dialog box contains the following tabs:

General

Menu Options

Colors

Advanced

General Tab

Use the General tab to set common properties specific to active reports.

The General tab contains the following options:

Display. This area contains options to set the window to cascade or tabs, and options to
freeze columns.

Window. Select the window setting. The options are Cascade and Tabs.

Freeze Columns. Select the columns you would like to freeze. You can also select None.

Page Options. This area contains options to set the number of records per page, enable the
display of page information, edit the alignment, and set the location of the page information.

Records Per Page. Select or type the number of records that you would like to display per
page. The default value is 57.

Display Page Information. Select this option to display page navigation information. Clear
this option to disable the display of page navigation information.

Alignment. Click the appropriate button to set the alignment of the page navigation
information. Options are Left, Center, and Right.

Location. Select the location for the page navigation information. The options are Top Row
and Bottom Row.

Menu Options Tab

Use the Menu Options tab to select a user type and which options to display in the menu. 

The Menu Options tab contains the following options:

User Type. The options are Power, Analyst, Basic, and Custom.

Power. This is the default user type. It enables all functionality.
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Analyst. This user type has the following functionality: Show Records, Freeze, Hide/
Unhide, Export, Sorting, Pivot, Filter, Calculations, Chart, Visualize, Restore Original,
Save Changes, and Accordion.

Basic. This user type has the following functionality: Show Records, Freeze, Hide/
Unhide, Sorting, Filter, Calculations, Visualize, and Restore Original.

Custom. If you select a combination of options that does not match one of the existing
user types (Power, Analyst, Basic), the User level name that appears in the User Type
field is Custom. This is not a default user type or a selectable user type. It indicates
that options for this user do not match any of the existing user types.

The options available according to user type include the following:

Show Records. Shows all records or specific numbers of records.

Freeze. Freezes and unfreezes columns.

Hide/Unhide. Hides and shows columns.

Export. Exports data to HTML, CSV, Excel, or PDF if active cache is enabled, or to
HTML, CSV, or XML (Excel) if active cache is disabled.

Sorting. Sorts data in ascending or descending order.

Pivot. Lists the fields available to create a Pivot table.

Window Type. Shows windows as cascade or tabs.

Send as Email. Enables you to save the current changes and send a report as email.

Print. Prints all records or filtered-only records.

Advanced Tools. Accesses the Chart/Rollup, Pivot, and Grid Tools.

Filter. Opens the Filter Selection dialog box.

Calculations. Performs the following calculations: Sum, Avg, Min, Max, Count, Distinct,
% of Total.

Chart. Converts a report to a pie, line, bar, or scatter chart.

Visualize. Adds data visualization bars to a report.

Rollup. Performs rollup on data.

Comments. Adds comments.
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Restore Original. Restores the active report to the default state specified in the report
procedure.

Save Changes. Saves the current changes.

Accordion. Produces accordion reports.

Grid Tool. Opens the Grid Tool dialog box.

Colors Tab

Use the Colors tab to select colors for various objects on the report. 

The Colors tab contains the following options:

Page. This area contains options to set the colors for the font and background of the page
text.

Font. Opens the Color dialog box, where you can select the font color.

Background. Opens the Color dialog box, where you can select the background color for the
page text.

Row Selection. This area contains options to set the colors that appear when you point to or
select a row on the report.

Hover. Opens the Color dialog box, where you can select the color that the row becomes
when you hold the mouse over the row.

Selected. Opens the Color dialog box, where you can select the highlight color that the row
becomes when you use the highlight option.

Visual. This area contains options to set the colors for the data visualization bars.

Positive. Opens the Color dialog box, where you can select the color for a data visualization
bar that represents a positive number.

Negative. Opens the Color dialog box, where you can select the color for a data
visualization bar that represents a negative number.

Calculations. This area contains options to set the colors for values in a calculation.

Font. Opens the Color dialog box, where you can select the font color for the calculation.

Background. Opens the Color dialog box, where you can select the background color for the
calculation.
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Menu. This area contains options to change the color of the menu.

Normal

Font. Opens the Color dialog box, where you can select the color for the text of the
options on the column menus.

Background. Opens the Color dialog box, where you can select the background color for
the column menus.

Border. Opens the Color dialog box, where you can select the color for the border of the
column menus.

Hover

Font. Opens the Color dialog box, where you can select the color for the text of the
options on the column menus when you point to them.

Background. Opens the Color dialog box, where you can select the background color
that appears behind options on the column menus when you point to them.

Advanced Tab

Use the Advanced tab to control the number of rows retrieved from active cache and to add
security settings.

Note: active cache is enabled when you select active report as the output type, and click Pages
On Demand on the Format tab, in the Navigation group.

The Advanced tab contains the following options:

active cache. Enables a report to cache the data in a binary file and return the data to the
output window in pre-set increments.

Rows Retrieved. Select the number of rows retrieved in the output. The default value is
100.

Security. This area allows you to set a password to access the report and enable expiration by
date or by days.

Note: When setting security options for active reports, be aware that security options can be
set for each individual component on the canvas, but only one password can be set for the
entire document.
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Creating an Active Technologies Chart

An active chart is a chart that is designed for offline analysis. For more information, see Active
Technologies Report Overview on page 443. 

Procedure: How to Create an Active Technologies Chart

With InfoAssist+ in Chart mode, you can perform this procedure in Query Design view or Live
Preview.

1. On the status bar, in the Output Types menu, click active report.

2. On the Format tab, in the Chart Types group, click the button of the chart that you want to
create. Bar chart is the default.

The chart appears on the canvas.

3. Populate the chart with your data in one of the following ways:

Drag the dimension fields and measure fields onto the chart.

Drag the dimension fields and measure fields into the appropriate field containers in
the Query pane.

Active Technologies Options for Charts

Active chart toolbar options are shown in the following image.

Menu options for an active chart are described in the following table.
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Option Definition

More Options New. Creates a new instance of the chart. This option is available
only when the chart is created from a column menu on a tabular
report.

Group By (X). Changes groups by the horizontal sort field.

Add (Y). Adds a vertical sort field.

X-Axis. Specifies a measure or dimension sort field. Applies to
scatter charts.

Y-Axis. Specifies a measure. Applies to scatter charts.

Arrange By. Specifies the marker color. The marker color depends
on the field assigned to the color attribute. If no field is assigned to
this category, then all of the markers will be the same color. Applies
to scatter charts.

Export to. Exports to Excel, Word, or PowerPoint.

Stacked. Stacks the risers on top of each other, with the length of
each riser representing the data value. Applies to column charts.

Top. Displays the top values. Options are Top 3, Top 5, Top 10, and
Clear Top. Applies to pie charts.

Trend. Draws a trendline and equation label for an individual series.
Applies to scatter charts.

Chart/Rollup Tool. Opens the Chart/Rollup Tool, which you can use
to select multiple group fields in the chart or rollup table generated.
The Chart/Rollup Tool contains a list of columns available in the
active report and Group By and Measure sort fields. Drag the
columns into the desired sort field.

Note: When working with the Chart/Rollup Tool for active charts
(specifically those with the new chart attribute syntax), the Series
tab is not supported. It is available with charts that are created with
tabular reports or stand-alone charts that do not use the new chart
attribute syntax.

Restore Original. Restores the active report to the default state
specified in the report procedure.
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Option Definition

Column Displays data as a column chart.

Pie Displays data as a pie chart.

Line Displays data as a line chart.

Scatter Displays data as a scatter chart.

Rollup Displays the chart as a rollup table.

Advanced Chart Opens the Chart/Rollup Tool.

Original Chart Restores the active chart to the chart type specified in the report
procedure.

Lock/Unlock Freezes the chart or rollup table. You can link or unlink a chart or
rollup table to the filters that you have applied in your report using
the Freeze Chart or Freeze Rollup icon. The icon indicates whether
the report is linked to the filter (Freeze Chart or Freeze Rollup) or not
(Unfreeze Chart or Unfreeze Rollup).

This option is available only when the chart is created from a column
menu on a tabular report.

Aggregation Applies the following options to a Measure field: Sum, Avg, Min,
Max, Count, and Distinct. The default value is Sum.

Remove Filter Removes a filter from a chart. You can apply a filter by pointing to or
lassoing an area of the chart and then clicking the Filter Chart or
Exclude from Chart option from the chart tooltip.

Creating an Active Technologies Dashboard

You can create an active dashboard by inserting multiple content types, such as reports,
charts, images, and text, into a document. An active dashboard will run any report or chart
using the active output format, even if the report or chart itself is not in active output format.

You can also insert active dashboard prompts into a document to act as filters for the reports
and charts on the dashboard. You can cascade (chain) prompts to populate them based on the
selections from the previous prompts.
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The output format of the active dashboard must be active report in order to add active
dashboard prompts.

Active Technologies Dashboard Prompts

The Active Dashboard Prompts group contains buttons that insert active dashboard prompts
into your dashboard. This group is only visible when the output format of the dashboard is set
to active report. You can access the active dashboard prompts on the Insert tab, in the active
dashboard prompts group.

The following are the types of active dashboard prompts that you can use to apply filters to an
active dashboard:

Drop Down. Inserts a drop down prompt placeholder in the upper-left corner of the canvas.

List. Inserts a list prompt placeholder in the upper-left corner of the canvas.

Checkbox. Inserts a check box prompt placeholder in the upper-left corner of the canvas.

Radio Button. Inserts a radio button prompt placeholder in the upper-left corner of the
canvas.

Text. Inserts a text area prompt placeholder in the upper-left corner of the canvas.

Note: The display of values populated in active dashboard prompts is dependent on the data
setting. For example, if sample data is turned on, then active dashboard prompts will show
sample data, such as:

WF_RETAIL1
WF_RETAIL2
WF_RETAIL3

Target Reports

When you bind a field to an active dashboard prompt, the default target report is the report
from which you dragged the field. You can add or remove target reports from an active
dashboard prompt through the active dashboard properties dialog box. For more information on
using the active dashboard properties dialog box, see Using Multiple Reports as Targets and
Sources on page 463.

A report must meet one of the following requirements to be a target report:

The report must contain a field with the same name as the source field (actual field name
or AS name).

The Master File of the report must contain a field with the same name as the source field.
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If a report is eligible to be a target report because the field has the same user-supplied title
and the title is changed, the report is automatically removed as a target.

Procedure: How to Add an Active Technologies Dashboard Prompt to a Dashboard

This procedure describes how to begin to create a dashboard by creating one report and
binding a single prompt to one of the fields of the report.

With InfoAssist+ in Document mode:

1. On the status bar, in the Output Types menu, accept the default output type (active
report).

2. On the Insert tab, in the Reports group, click Report.

A placeholder appears on the canvas.

3. Drag fields onto the canvas, or into the Query pane, to create the report and start building
the dashboard.

4. On the Insert tab, in the active dashboard prompts group, select a dashboard prompt to
insert into the document.

An active dashboard prompt appears in the upper-left corner of the canvas. If the report is
located in the upper-left corner of the canvas, you will have to drag the prompt off the
report.

5. Select the report and bind one of its data source fields to the prompt in one of the
following ways:

Query pane: Select the report. From the Query pane, drag the field that you want to
bind onto the prompt.

Report on the canvas: Click the report on the canvas. You can now edit it. Highlight
the column that contains the data that you want and drag it onto the prompt.

Once you have bound the field to the prompt, the values of the field appear in the prompt.

Note: Once an active dashboard prompt is added to the canvas, the document is locked in
an active output format. You cannot change the active report format if there are prompts
present on the canvas. To switch to a non-active output format, you must remove all
prompts.

Using Multiple Reports as Targets and Sources

You can add multiple reports and charts to an active dashboard. Each report can have multiple
prompts associated with it.
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Procedure: How to Build a Dashboard With Multiple Reports as Targets and Sources

The following procedure describes how to set up active dashboard prompts for two reports on
a dashboard. In the example that is used, the first report contains information about the
categories of electronics products sold in various regions. The Product,Category field will be
bound to a group of radio buttons. Each radio button will represent a particular product
category of electronics. When you select a radio button for a product category, for example,
Accessories, the report will be filtered by your selection.

The second report contains information about the gender and geographic location of
electronics consumers. The Gender field will be bound to a drop-down list. The list will display
the values, F (female) and M (male). When you select a gender from the drop-down list, the
report will be filtered by your selection.

1. Open InfoAssist+ in Document mode using the wf_retail_lite Master File.

2. Create an active dashboard by adding two reports with the following components,
respectively:

Report 1:

Product,Category

Store,Business,Region

Discount

Gross Profit

Report 2:

Gender

Customer, Continent

Product, Category

3. On the Insert tab, in the Active Dashboard Prompts group, add the following active
dashboard prompts to the dashboard, positioning them relative to each respective report.

Radio Button: This prompt will be used for Report1.

Drop Down: This prompt will be used for Report2.

For more information on working with active dashboard prompts, see How to Add an Active
Technologies Dashboard Prompt to a Dashboard on page 463.

4. Right-click the radio button active dashboard prompt for which you want to bind a field to
and click Properties.

The active dashboard properties dialog box opens.
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The Prompts list displays the two prompts (for example, radiobutton_1 and radiobutton_2)
that were added to the dashboard in step 3.

5. From the Report drop-down menu, select the report that contains the field to which you
want to bind an active dashboard prompt.

In this example, the radio button list (radiobutton_1) has been selected as the prompt for
the region report (Report1), as shown in the following image.

The next step describes how to bind the Product,Category field from the region report to
the radio button list to filter that report.

6. From the Field drop-down menu, select the field to which you want to bind the active
dashboard prompt.
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In this example, the Product,Category field has been selected for the radio buttons list
(radiobutton_1), as shown in the following image.

Note: You can optionally specify an ascending or descending sort order for the current
scenario.

7. Click OK.

The prompt is now bound to the field on the dashboard.
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In the following image, the radio buttons list is bound to the Product,Category field. It
displays all product categories by which a user can filter the report.

The following steps describe how to bind the Gender field in the gender report (Report2) to
the drop-down list prompt.

8. Right-click the Drop Down active dashboard prompt for which you want to bind a field and
click Properties.

The active dashboard properties dialog box opens again.
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Notice that combobox_2, the prompt selected on the dashboard, is selected in the
Prompts list.

9. From the Report drop-down menu, select the report (Report2) that contains the field to
which you want to bind an active dashboard prompt.

The next step describes how to bind the Gender field from the gender report to the drop-
down list to filter that report.

10. From the Field drop-down menu, select the field (Gender) to which you want to bind the
active dashboard prompt.

Once the Gender field has been selected, Report2 (gender report) appears in the Targets
list and Report1 (region report) appears in the Candidate Reports list.

Note: To move a report from the Candidate Reports list box to the Targets list box, select
it and click the Add to List arrow. To remove a report from the Targets list box, select it
and click the Remove from List arrow. You can select multiple reports by holding down the
Ctrl key and clicking each one.

11. Click OK.
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The prompt is now bound to the field on the dashboard. You can now filter the gender
report by female or male, as shown in the following image.
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The final active dashboard displays, as shown in the following image.

Procedure: How to Change the Field

You can change the field to which the active prompt is bound.

1. Create an active dashboard in Document mode, or open an existing dashboard, and bind
an active prompt to a field.

2. Right-click the active dashboard prompt that you want to configure, and click Properties.

The active dashboard properties dialog box opens.

3. From the Field menu, select a different field.

A warning message alerts you that changing the source field for the prompt will remove the
existing prompt and any dependent (child) prompts from the cascades.

4. Click OK to close the warning.

5. Click OK to close the active dashboard properties dialog box.
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The active dashboard prompt is updated with the new source field.

Procedure: How to Change the Filter Condition

1. Create an active dashboard in Document mode, or open an existing dashboard, and bind
an active dashboard prompt to a field, as described in How to Add an Active Technologies
Dashboard Prompt to a Dashboard on page 463.

2. Right-click the active dashboard prompt that you want to work with, and from the shortcut
menu, select Properties.

The active dashboard properties dialog box opens.

3. From the Condition drop-down menu, select the filter condition for the active dashboard
prompt. The options are Equal to, Not equal to, Less than, Less than or equal to, Greater
than, and Greater than or equal to.

4. Click OK.

The filter condition is applied to the active dashboard prompt.

Procedure: How to Add Multiple Prompts to a Dashboard

1. Create an active dashboard in Document mode, or open an existing dashboard containing
at least one report, and add at least two active dashboard prompts, as described in How
to Add an Active Technologies Dashboard Prompt to a Dashboard on page 463.

2. Bind the fields to prompts that you have added, as described in How to Add an Active
Technologies Dashboard Prompt to a Dashboard on page 463.

Procedure: How to Cascade Prompts

When you have more than one prompt on the canvas, you can cascade prompts to populate
them based on the selections of the previous prompts. Cascading prompts have a parent-child
relationship, in which the parent filters the available options of the child.

An active prompt can be the parent of more than one other prompt, but cannot be a child of
more than one prompt.

1. Create an active dashboard in Document mode, or open an existing dashboard, and bind
at least two active prompts to fields.

2. Right-click the active dashboard prompt that you want to configure, and click Properties.

The active dashboard properties dialog box opens.

3. Click Cascades.
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By default, a cascade named Cascade1 appears in the Cascades section of the active
dashboard properties dialog box.

You can click the Create a new cascade  button to create a new cascade.

You can click the Delete selected cascade  button to delete the selected cascade.

4. Select the cascade to which you want to add prompts.

5. From the Available Prompts list box, select the prompt that you want to add.

6. Click the Add to List arrow to move the selected prompt to the Selected Prompts list box.

Note: You can remove prompts from the Selected Prompts list box by selecting them and
clicking the Remove from List arrow.

7. Add any additional prompts you want to be part of the cascade by repeating steps 5 and
6.

By default, the hierarchy of the prompts is determined by the order in which they are
added to the Selected Prompts list. The cascade of the prompts is from top to bottom.
The prompts that come first in the Selected Prompts list are the parents of the lower
prompts.

8. You can change the hierarchy of the prompts by selecting a prompt in the Selected Prompt
list box and clicking the Move Up and Move Down arrows.

9. Click OK.

The cascade is created.

10. Run the report.

Note: If you set up more than one cascade, the cascade that you interact with last is the
one that filters the report.

Using Navigation Options for Reports

When working with reports, you can use the following options to customize output display and
navigation.

Table. Generates standard browser output. This is the default.

Table of Contents. Generates output by displaying a table of contents icon in the upper-left
corner where report output typically appears. Clicking Table of Contents opens a menu that
enables you to select (view) individual values of the first Sort By (By) field, one value at a
time.

You can also select options to view the entire report or remove the table of contents.
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Note:

The Table of Contents option is activated only when HTML, active report, Excel, or
PowerPoint output format is selected.

You cannot use the Table of Contents option with the Accordion feature.

Freeze. Generates output with column titles that freeze (remain in view) when you scroll
through pages of the report output.

Pages On Demand. Provides access to two distinct features depending upon the output
type that you have selected.

HTML. If you select this output type, and click Pages on Demand, then the report opens
in the WebFOCUS Viewer.

active report. If you select this output type, and click Pages on Demand, then active
cache is enabled. For more information on active cache, see Using the Active Cache
Option on page 406.

Auto Drill. Provides access to Auto Drill functionality, which enables you to navigate the
hierarchy of your data at run-time. For more information, see Using Auto Drill on page 703.

Note: Auto Drill functionality is only available for the HTML and active report output formats.

Creating Maps to Illustrate Trends

Using InfoAssist+, you can create maps to identify patterns or trends in your data. By
converting data into values that can be displayed on a map, you are able to visualize
scenarios, illustrate hot spots, and identify potential problem areas. For example, a law
enforcement agency may use mapping functionality to identify areas of higher crime within the
locations they cover. You can also use maps to determine how places are related, understand
where things are located, and identify the best actions to take. By illustrating trends on a map,
a decision maker can identify patterns easily, and reach conclusions sooner. 
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An early example of how maps can be used to illustrate trends is the case of Dr. John Snow,
an epidemiologist who was one of the first to use data to map occurrences of cholera to find
the cause of infection. By plotting the cholera data on a map of a town, Dr. Snow was able to
visualize a trend that showed higher incidences of cholera closest to water pumps. This
example is shown in the following image.

Maps also allow you to measure size, shape, and distribution to detect and quantify patterns,
and even perform predictive analytics. An example of how maps can help detect and quantify
patterns is the scenario in which a state agency used a WebFOCUS mapping application to
solve a problem with their food stamp system. Using this application, odd food stamp
redemptions, such as rounded numbers transactions, were discovered. By plotting those
transactions on a map, the agency discovered that the redemptions appeared in the same
geographic location. Upon further investigation, the agency identified that individuals were
selling their food stamps at reduced prices, $50 worth of food stamps for $40 in cash, to
others instead using them as intended. This map example is shown in the following image.
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When working with maps, the concepts of location intelligence and business intelligence are
important to understand. A Geographic Information System (GIS) captures, stores, analyzes,
manages, and presents data linked to a location, while Business Intelligence (BI) relies on the
conversion of raw data into meaningful information. Location intelligence is the process of
analyzing data to make better business decisions. It combines GIS and BI/Analytics to allow
the recognition of patterns in your data, including the visualization and discovery of geospatial
outliers, which would not be easily discovered if you use the technology independently and
separately.

More specifically, maps use non-intrusive GIS workflows with existing data. You can view
symbol layers for data bound to a geo-location, such as state, country, and ZIP code, in an
integrated map viewer. Using metrics from your data, you can also visualize geographic roles or
dimensions. Geographic roles, or dimensions, can be built directly into your Metadata or
assigned to a data field when you create a map.

InfoAssist+ and Esri Integration

Using WebFOCUS InfoAssist+ with the Esri integration, you can create maps that help you
illustrate or identify trends, so that you can take action quickly. WebFOCUS architecture
provides the framework in which this system operates. Using a Javascript map viewer, you can
navigate the interface easily, as shown in the following image.
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In addition, this integration utilizes the capabilities of Esri by leveraging the ArcGIS Javascript
API and content. Specifically, you can integrate data into maps with published content in
ArcGIS Online platform. For more information, see http://www.esri.com/software/arcgis/
arcgisonline. Additionally, by using this integration, you can include information about
demographics, spending habits, crime, and lifestyle to maps that contain your data. These
maps include layers with extensive demographic or reference detail and topography and allow
you to view information about people, businesses, climate, and much more.

You can create the following maps in InfoAssist+:

Choropleth. A common thematic map that uses geographical measures (for example,
states and countries), representing the values aerially while employing a varying intensity of
colors. It is useful for visualizing location-based data, trends, and distributions across a
geographic area. The color hues for Choropleth maps are dictated by the legend, based on
the selected measure, enabling you to determine data concentration across your map.

Proportional Symbol (Bubble). A map that represents coordinates, such as an address or
intersection, using symbols of different sizes to represent any measure. These maps focus
on specific areas, for which data concentrations may vary. When the data concentration is
larger, the bubble will be bigger.

Both maps can be created in Chart or Visualization mode. Built-in zooming capabilities allow
you to drill down to a specific geographic area of focus easily. This allows you to get a closer
look at regional or local data, draw inferences, and make recommendations, without changing
the initial view of your data.

In Chart mode, you can also use the Auto Drill and Auto Linking features that are available
when you create charts or reports in InfoAssist+. In Visualization mode, you can also drill up
and down within different levels in a data hierarchy in a map. Auto Drill allows you to navigate
through the geographical hierarchy of your map data at run time. You can use this information
to visualize the same measure at different geographical hierarchies, such as Countries to
States and States to Cities. Auto Linking allows you to connect to related charts or reports in
your environment that share similar data parameters.

Using the Esri integration in InfoAssist+, you can also add the following layers to your map:

Backgrounds. Display a layer that positions data as it is located, in context to other
geographical features, such as streets, terrain, and imagery. Some standard Background
options may combine road, aerial, and topographic data using a variety of symbols. Hosted
on ArcGIS, you can change your background at any time, to review your data in a different
context.
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When you apply a Background to your map, its appearance changes. You can then adjust
the view of your data, showing different terrain or geographical views. Backgrounds provide
at least 17 levels of zoom. For more information, see https://developers.arcgis.com/
javascript/jsapi/esri.basemaps-amd.html.

Reference Layers. Display a layer of boundaries and locations that range from a
continental scale to country, state, and even local neighborhood. For example, if you are
viewing World data on electricity usage, you may want to add a Reference Layer that
displays the borders and concentration of your data within each country.

Demographic Layers. Display a layer of information about people and businesses in a
specific demographic area. This includes the United States and 120 other countries.
Demographic Layers are thematic maps that provide additional information about the
location, such as spending habits, population, and lifestyles. You can add Demographic
Layers to a map about sales data, to identify new locations for stores, based on the
spending habits for a specific area.

Both mapextent and the Layers menu functionality are applied to your map when you select a
Background, Reference Layer, or Demographic Layer. Mapextent is an automatic view of the
map. Layers is a menu that appears on the map and provides access to options that allow you
to adjust the information that is being displayed.

The map example in the following image shows the use of layers.

Note: Backgrounds, Demographic Layers, and Reference Layers can be accessed from the
Format tab for maps in both Chart and Visualization mode. These layers are static, standard
options that Esri provides for use with InfoAssist+, and do not change based on the data
source that you select.
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Configuring an Esri On Premise Environment

The Esri On Premise functionality enables you to download and access mapping files through
the use of a local Application Programming Interface (API). Once you download and configure
the API, you do not need an internet connection to utilize the robust mapping features that Esri
provides. For information on downloading and configuring the API that controls this feature, see 
How to Download and Configure the ArcGIS JavaScript API on page 478.

The Ersi On Premise functionality provides you with local access to Esri mapping files. This is
particularly useful if you are away from your office or without an Internet connection. You may
also be using a mobile device, such as an iPad or smartphone with a large screen, without an
Internet connection. The following mapping components are supported when using the Esri On
Premise functionality:

Offline Basemaps. Basemaps are an offering from ArcGIS. Standard basemaps are
provided for your use offline. For example, there is an Oceans basemap and a Terrain with
Labels basemap. In InfoAssist+, these basemaps are also known as backgrounds. In an
online setting, there are 10 basemaps available. In order to use offline basemaps, you
need to use a tiled mapservice published in the ArcGIS Server.

Offline Geographic Roles. Geographic Roles are used to visualize measures with commonly
known dimensions (for example, Country, State, Cities, and so on). These provide the
location information often in the form of (x/y) needed to plot on a map. Geographic roles
are pre-defined for online users through ArcGIS Online. In InfoAssist+, a geographic role
defines the geographic component that you can select when creating a map (for example,
State or Continent). For an offline user, the options that display can be customized in the
geoservices.xml file. For more information, see Adding a Custom Geographic Role on page
499.

Note: Demographic Layers are not supported in an Esri On Premise environment.

Procedure: How to Download and Configure the ArcGIS JavaScript API

You can use this procedure to download and configure the API that controls the Esri On
Premise environment.

1. In your browser, navigate to the following URL to download the API: https://
developers.arcgis.com/downloads

2. Sign in to access the download options that are available to you.
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3. Select Version 3.15 of the ArcGIS API for JavaScript, as shown in the following image.

4. Click API to download the API.

5. In drive:\ibi\config\web_resource, create a folder named arcgis_api.

6. Open the arcgis_js_v315_api.zip file downloaded in step 4 and navigate to
arcgis_js_v315_api\arcgis_js_api\library\3.15\3.15.

7. Extract the files in that folder to the drive:\ibi\config\web_resource\arcgis_api folder.

8. Next, verify the path to the API in the WebFOCUS Administration Console, as shown in the
following image.

Note: This is the path to which you extracted the API files.

This field identifies the path to the internal ArcGIS Javascript API Source that develops
ESRI-based maps. This setting is blank, by default, indicating that the use of the internal
API source to develop ESRI maps is not activated. The API that is referenced is https://
js.arcgis.com/3.15/, by default. To direct WebFOCUS to use the internal ArcGIS Javascript
API to develop ESRI maps, enter the path to the local API files that you extracted into this
setting. For more information, see the WebFOCUS Security and Administration manual.

Note: This path should be a relative path that is accessible within the local WebFOCUS
install.
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9. Click Save.

10. Next, open the following two local API files:

drive:\ibi\config\web_resource\ arcgis_api\init.js

drive:\ibi\config\web_resource\ arcgis_api\dojo\dojo.js

In both files, search for HOSTNAME_AND_PATH_TO_JSAPI. Replace '//' +
"[HOSTNAME_AND_PATH_TO_JSAPI]dojo" with '//' + HOSTNAME_AND_PATH_TO_JSAPI +
"dojo"

11. In the WebFOCUS Administration Console, click Clear Cache to clear the browser cache.
Your configuration is complete.

Creating and Customizing Maps in InfoAssist+

The following procedures provide step-by-step instructions on how to create and customize
maps.

As you create your maps, you can use the following built-in map viewer features:

You can use the plus (+) and minus (-) symbols, , within the map to zoom in and out of
different areas of the map. You can also click your left mouse button to zoom in to a
specific location.

Like all HTML5 visualizations, the highlighted markers and regions on a map support drill,
multi-drill, auto-linking, and informational tooltip features.

When working with maps in Chart mode, you can use the Pan / Selection button to
alternate between the Pan and Selection controls. This option is in the upper-right corner of
the map.

When working with maps in Visualization mode, you can toggle the Pan or Selection button
to make a selection. The Pan control allows you to click, hold, and move the map with your
mouse. The Selection control allows you to lasso a specific area of the map and select
data in the map.

Procedure: How to Create an Esri Choropleth Map

Note: The default option of creating a map utilizes the ArcGIS Javascript API that Esri provides.

1. Launch InfoAssist+ in Chart or Visualization mode.

In Chart mode, on the Format tab, in the Chart Types group, click Choropleth.
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In Visualization mode, on the Home tab, in the Visual group, click Change and click
Choropleth.

A blank map displays and the Layer field container is enabled, as shown in the following
image.

2. Add a Geolocation field to the Layer field container.
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This field, which already has a geographic role assigned, is denoted with a Layer icon, ,
in the Data panel, as shown in the following image. You can also hover over a data field to
view the geographic role assignment.

For more information, see Geographic Roles on page 495.

The canvas refreshes, and your map displays.

3. Before saving your map, to add insight, you can also do following:

Click Run, to preview your map.

Add a measure or dimension to the Color field container, to color your chart by that
underlying data value. When you add a measure or dimension field to the Color field
container, a legend displays for that data value. If you specify a dimension in the Color
field container, the label changes to Color BY.

Add a dimension or measure to the Tooltip field container, which will display tooltip
information when you place your mouse over an area of the map.

Add a Background, Demographic Layer, or Reference Layer.

4. Click Save to save your map.
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Procedure: How to Create an Esri Proportional Symbol (Bubble) Map

1. Launch InfoAssist+ in Chart or Visualization mode.

In Chart mode, on the Format tab, in the Chart Types group, click Proportional Symbol.

In Visualization mode, on the Home tab, in the Visual group, click Change and select
Proportional Symbol.

A blank map displays and the Layer field container is enabled.

2. Place a data field with a defined geographic role in the Layer field container.

This field, which already has a geographic role assigned, is denoted with a Layer icon, ,
in the Data panel, as shown in the following image. You can also hover over a data field to
view the geographic role assignment.

For more information, see Geographic Roles on page 495.
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A basic bubble map displays, as shown in the following image.

3. Before saving your map, to add insight, you can also do following:

Click Run, to preview your map.

Add a measure or dimension to the Color field container, to color your chart by that
underlying data value.

Add a measure to the Size field container, to control the size of the bubbles on your
map.

Add a measure to the Tooltip field container, to display tooltip information when you
place your mouse over an area of the map at run time.

Add a Background, Demographic Layer, or Reference Layer.

4. Click Save to save your map.

Procedure: How to Assign a Geographic Role to a Data Field

1. Launch InfoAssist+ in Chart or Visualization mode.

In Chart mode, on the Format tab, in the Chart Types group, click Choropleth.
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In Visualization mode, on the Home tab, in the Visual group, click Change and click
Choropleth.

2. In the Data pane, select a data field without a geolocation assignment.

3. Perform one of the following tasks to open the Map dialog box and assign a geographic
role:

Right-click the desired data field, click Map As and select a geographic role, as shown
in the following image.

Drag the desired data field into the Layer field container.
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The Map dialog box displays, as shown in the following image.

4. In the Map dialog box, select a geographic role. For example, State.

Note: When specifying a geographic role, you can use Name or an ISO-2 value for
countries. The ISO-2 codes are recognized worldwide, as published in http://
www.iso.org/iso/country_codes

The Map dialog box refreshes and shows the Depends on section, as shown in the
following image.
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Note: If you used the Map As option, the Depends on section automatically displays, since
a geographic role was selected at that time.

5. In the Depends on section, choose from the following options:

Field. Identifies a specific field on which the geographic role depends. For example,
you can select Country or Continent.

User Defined. Enables the definition of a specific value from the data source.
Selections can be as simple as a specific country. For example, you can select US.

The Geographic Role field automatically populates based on the hierarchy of your data
source. For example, if your primary geographic role was State, and in your metadata
hierarchy, State depends on Country, this option displays.

6. Click OK.
If you used the Map As option, you must place the data field with the defined geographic
role in the Layer field container. If you placed a data field in the Layer field container and
defined a geographic role, the field is automatically added to the Layer field container.

A basic map displays, as shown in the following image.
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7. Before saving your map, to add insight, you can also do following:

Click Run, to preview your map.

Add a measure or dimension to the Color field container, to color your chart by that
underlying data value.

Add a measure to the Size field container, to control the size of the bubbles on your
map.

Add a measure to the Tooltip field container, to display tooltip information when you
place your mouse over an area of the map at run time.

Add a Background, Demographic Layer, or Reference Layer.

8. Click Save to save your map.

Procedure: How to Change the Geographic Role of a Geolocation Field

You can change the geographic role assignment of any geolocation field using the following
steps.

1. Launch InfoAssist+ in Chart or Visualization mode.

In Chart mode, on the Format tab, in the Chart Types group, click Choropleth.

In Visualization mode, on the Home tab, in the Visual group, click Change and click
Choropleth.

2. From the Data pane, right-click a geolocation field and click Map As.

3. Select a geographic role.

The Map dialog box displays using the selected Geographic Role.

4. In the Map dialog box, optionally select a geographic role from the drop-down list. For
example, Country.

Note: This changes the selection that you made on the Map As list.

5. Accept the default value for Stored As, or choose a new value from the drop-down list, for
example, ISO code. Stored As indicates how the data values are represented in the table.

6. Click OK.

The geographic role changes for the selected Geolocation field in the Data pane, and the
map refreshes using the new geolocation that you specified.
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Procedure: How to Change the Default Background of a Map

1. Create a new map or open an existing map in InfoAssist+.

2. On the Format tab, expand the Map group and click Background, as shown in the following
image.

3. Select one of the following options:

World Street Map

Terrain with Labels
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Oceans Basemap

OpenStreetMap

World Imagery

Light Gray Canvas

National Geographic World Map

Dark Gray Canvas

None

Note: The Imagery with Labels Background provides the terrain for your map, ranging from
land contours to city streets.

Once you make a selection, the background of the map refreshes. You can continue to
change your background until it displays the desired information.

Procedure: How to Add Demographic Layers to a Map

1. Create a new map or open an existing map in InfoAssist+.

2. On the Format tab, expand the Map group and click Demographic Layers.
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3. Select from various population and lifestyle groups, as shown in the following image.

Note: These are pre-defined demographic profiles, provided by ArcGIS. You can select
multiple options in either category to gain additional insight into your data. Specifically,
each Demographic Layer has its own profile and provides a layering option, when
comparing values across different layers or profiles.

4. Click OK.
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The Demographic Layers that you select are applied to your map. The map engine displays
the different groups with unique hues and coloring. You can use the Table of Contents or
Layers option, to toggle between the different layers that you have specified. The Layers
option is shown in the following image.

Note: You can select and clear the check boxes to enable the display of one or more
Demographic Layers to compare and contrast the different demographic scenarios.

Procedure: How to Add Reference Layers

1. Create a new map or open an existing map in InfoAssist+.

2. On the Format tab, expand the Map group and click Reference Layers.
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The Reference Layers dialog box displays, as shown in the following image.

3. Select one or more Reference Layers, such as World Countries, to add to your map, and
then click OK.
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Your map refreshes, and the definitions and borders of the References Layers display on
the canvas. You can use the Table of Contents or Layers option, to toggle different
Reference Layers in your map. These options are shown in the following image.

Reference: Query Field Containers by Map Type

This section presents the Query field containers that display for both charts and visualizations,
by map type.

Query field container Chart mode Visualization mode

Layer. One data field, specifically a field
containing location data (for example,
State).

Color. One data field.
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Query field container Chart mode Visualization mode

Tooltip. Up to one data field (not required).

Multi-graph. Up to one data field (not
required).

Size. One data field.

Reference: Geographic Roles

This section contains information on the geographic roles that are supported for Esri maps in
InfoAssist+.

Geographic Role Description Maps Supported

POINT OF INTEREST Points of Interest Proportional Symbol

CITY World Cities Proportional Symbol

CONTINENT World Continents Choropleth, Proportional
Symbol

COUNTRY World Countries Choropleth, Proportional
Symbol

COUNTRY_ISO2 World Countries (ISO2 Code) Choropleth, Proportional
Symbol

COUNTRY_ISO3 World Countries (ISO3 Code) Choropleth, Proportional
Symbol

STATE World Admin Divisions Choropleth, Proportional
Symbol

STATE_ISO_SUB World Admin Divisions (by
ISO_SUB)

Choropleth, Proportional
Symbol

USCITY USA Major Cities Proportional Symbol

USCITY_FIPS USA Major Cities_FIPS Proportional Symbol
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Geographic Role Description Maps Supported

USCOUNTY USA_Counties Choropleth, Proportional
Symbol

USCOUNTY_FIPS USA_Counties_FIPS Choropleth, Proportional
Symbol

USSTATE USA_States Choropleth, Proportional
Symbol

USSTATE_FIPS USA_States_FIPS Choropleth, Proportional
Symbol

USSTATE_ABBR USA_States (by abbreviation) Choropleth, Proportional
Symbol

ZIP3 USA ZIP3 Choropleth, Proportional
Symbol

ZIP5 USA ZIP5 Choropleth, Proportional
Symbol

The following table summarizes additional geographic role information.

Note: All of the following roles are geographic roles, with the exception of Latitude and
Longitude, which are coordinates.

Role Name Role Format Geographic Role

Address Full ADDRESS_FULL

Line ADDRESS_LINE

City Name CITY

Continent ISO-3166 code CONTINENT_ISO2

Name CONTINENT
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Role Name Role Format Geographic Role

Country FIPS code COUNTRY_FIPS

ISO-3166-2 code COUNTRY_ISO2

ISO-3166-3 code COUNTRY_ISO3

Name COUNTRY

Country (NUTS level 0) NUTS code NUTS0_CC

Name NUTS0

District (NUTS level 3) NUTS code NUTS3_CC

Name NUTS3

Geometry area GEOMETRY_AREA

Geometry line GEOMETRY_LINE

Geometry point GEOMETRY_POINT

Latitude LATITUDE

Longitude LONGITUDE

Postal code POSTAL-CODE

Province (NUTS level 2) NUTS code NUTS2_CC

Name NUTS2

Region (NUTS level 1) NUTS code NUTS1_CC

Name NUTS1

State FIPS code STATE_FIPS

Name STATE

US County FIPS FIPS code USCOUNTY_FIPS
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Role Name Role Format Geographic Role

US city FIPS code USCITY_FIPS

Name USCITY

US county Name USCOUNTY

US Postal code 3 digits ZIP3

5 digits ZIP5

US state Abbreviation USSTATE_ABBR

FIPS code USSTATE_FIPS

Name USSTATE

US ISO subdivision code STATE_ISO_SUB

The following table illustrates the geographic roles and their dependencies. Level 1 indicates
the highest level of hierarchy and level 5 is the lowest level of hierarchy.

Region Hierarchy Level Geographic Role

United States 1 COUNTRY, COUNTRY_ISO_CC

2 USSTATE, USSTATE_ABBR,
USSTATE_FIPS

3 USCOUNTY, USCOUNTY_FIPS

4 USCITY, USCITY_FIPS

5 ZIP3, ZIP5
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Region Hierarchy Level Geographic Role

World 1 CONTINENT, CONTINENT_ISO_CC

2 COUNTRY, COUNTRY_FIPS,
COUNTRY_ISO_CC,
COUNTRY_ISO2, COUNTRY_ISO3

3 STATE, STATE_ISO_SUB

4 CITY

5 POSTAL CODE

Adding a Custom Geographic Role

Customers with Enterprise Data often have map layers that represent their territories, events,
or logistical information. These are published as Map Services to either a subscription based
in the Esri Cloud (ArcGIS.com) or on an internal portal. This portal is available with ArcGIS
Server 10.3 installations. More information can be found at http://server.arcgis.com/en/
portal/.

The WebFOCUS Reporting Server comes with a configuration file (geo_services.xml) that
contains elements that describe all of the geographic roles, geographic hierarchies, URLs to
the map services, and base maps available to the Esri map viewer. This file is located in the
catalog directory under the server home directory:

c:\ibi\srvnn\home\catalog

where nn is the release of your WebFOCUS Reporting Server. For example, 82 for version 8.2.

The geographic role selections that you can make while using the InfoAssist+ Map As option
are built dynamically using this configuration file. Each role definition in the configuration file,
when selected in InfoAssist+, generates Metadata and a request that is sent to Esri in order to
download the appropriate map and place the markers or polygons on the map.

Note: When you run a map that has too many polygons, it fails to draw. This applies to maps
that use the US Zipcode 5 layer, in particular.

A geographic role can be part of a hierarchy. For example, the World geographic role is at the
top of a hierarchy that contains continents, countries, states, and cities. These hierarchies are
also described in the geo_services.xml file. The default location is:

C:\ibi\srvnn\home\catalog\geo_services.xml
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where nn is the release of your WebFOCUS Reporting Server. For example, 82 for version 8.2.

To add a custom geographic role, you must add the necessary parameters for the geography to
this file.

Reference: Geographic Role Definitions

A geographic role is stored as geo_role element in the geo_roles object of the
geo_services.xml file. A geographic role must be defined with:

An ID that will identify the role in the configuration file.

A format and length for the data to be returned.

A role name.

A display title for the role name (to appear as a selection when using the InfoAssist+ Map
As option).

An optional role format (if the role can have multiple formats, such as a name and an
abbreviation).

A display title for the format.

A role type (GEOGRAPHY for polygons or GEOMETRY for points).

An optional vocabulary rule element containing vocabulary elements for associating the role
with a field in the metadata.

The following attributes define a geographic role.

id
Is an alphanumeric uppercase value, up to 50 characters, used to identify the geographic
role.

type
Is the data type for the ID. Can be one of the following.

"alpha". For alphanumeric data, formats An or In.

"integer". For integer numeric data, format In.

"numeric". For fractional numeric data, formats Pn.m, Dn.m, or Fn.m.

"text". For text data, format TXn.

value_size
Is the optional number of characters in USAGE format length (any, if not set).
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role_name
Is the name of the geographic role.

role_name_title
Is the title of the geographic role, which displays when you hover over a data field with a
geographic role assigned. You can also assign a geographic role, by title, using the Map As
option.

role_format
Is an optional format for the geographic role. This is useful when the role can be
referenced using multiple formats, such as a name, an ISO code, and an abbreviation.

role_format_title
Is an optional title for the format of the geographic role. It will be shown in parentheses
along with the role title when you use the Map As option. For example, US State
(abbreviation).

geo_type
Is one of the following predefined role types.

"geography". For geographic objects, such as country or city.

"geometry". For geometry objects, such as latitude, longitude, or geometry point and
area.

vocabulary_rules
Is an element that consists of a group of vocabulary elements that explicitly describe
column names for the geographic role. These rules will be used to select the best
geographic data for the role.

Elements in a rule are connected by the Boolean logic operation OR (only one needs to be
satisfied). Each vocabulary element contains words enclosed with special characters.
Words in the rule element are connected by the Boolean logic operation AND (all need to
be satisfied).

A word may be prefixed and/or suffixed with the percent character (%), which is a place
holder for any sequence of characters. If an element contains more than one word, each
word has to be prefixed by the character plus (+) or minus (- ). Plus indicates that the word
must be found in the column name. Minus indicates that the word must not be found in
the column name.
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Example: Sample Geographic Role Definitions

The following defines the State Abbreviation geographic role. The role ID is USSTATE_ABBR.
The role name is USSTATE with a role format of ABBR. The titles that show when using the
Map As option are US State (Abbreviation). The format is A2, and the vocabulary rules specify
that the characters state must be present, but the characters iso, capital, and population must
not be present. The geo type is geography, indicating that the returned data will be a
geographic area.

<geo_role 
id="USSTATE_ABBR"
 value_size="2"
 type="alpha" 
role_name="USSTATE" 
role_name_title="US state" 
role_format="ABBR" 
role_format_title="Abbreviation"
 geo_type="geography">
<vocabulary_rules>
<vocabulary>+%state%-%iso%-%capital%-%population%</vocabulary>
</vocabulary_rules>
</geo_role>

The following is a role definition for latitude values. The role ID is LATITUDE. The role name is
also LATITUDE. Its format is numeric. The title that displays when you hover over a field with a
geographic role assigned (or when using the Map As option) is Latitude. The geo type is
geometry, indicating that the returned data will be points or areas described using points. The
vocabulary rules specify that the characters latitude must be present.

<geo_role
 id="LATITUDE"
 type="numeric"
 role_name="LATITUDE" 
role_name_title="Latitude"
 geo_type="coordinate">
 <vocabulary_rules>
  <vocabulary>%latitude%</vocabulary>
 </vocabulary_rules>
</geo_role>

The following is the definition for the city role. The ID is CITY. The role name is also CITY. Its
format is NAME. The title that displays when you hover over a field with a geographic role
assigned (or when using the Map As option) is City (Name). The definition has a set of
vocabulary elements. Only one of the elements in the list must be true. Therefore, the
characters city, or town, or country plus capital, or state plus capital must be present.
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<geo_role
 id="CITY" 
type="alpha" 
role_name="CITY" 
role_name_title="City" 
role_format="NAME" 
role_format_title="Name"
 geo_type="geography">
 <vocabulary_rules>
  <vocabulary>+%city%-%population%</vocabulary>
  <vocabulary>+%town%-%population%</vocabulary>
  <vocabulary>+%country%+%capital%-%population%</vocabulary>
  <vocabulary>+%state%+%capital%-%population%</vocabulary>
 </vocabulary_rules>
</geo_role>

Reference: Geographic Hierarchy Definitions

Some geographic roles exist as part of a hierarchy, and the data for the hierarchical roles are
stored at the same map services endpoint (URL). Hierarchical role relationships are stored as
hier elements in the geo_services.xml file.

Hierarchy definitions provide WebFOCUS with the information needed to use Auto Drill from a
geographic role at a higher level of the geographic hierarchy to a geographic role at a lower
level of the geographic hierarchy.

Each hierarchy has the name of hierarchy (attribute ID) and a group of LEV elements with the
attributes level, geo_role, and, optionally, value. Not all defined roles can be used in
hierarchies. The same role can be included in more than one hierarchy and may be on different
hierarchical levels in each. However, the same role cannot be used more than once in the
same hierarchy. Multiple geographic roles can be assigned to the same hierarchical level in a
hierarchy.

Geographic hierarchies are defined with the following attributes:

id
Is a name of up to 50 alphanumeric characters used to identify the hierarchy.

level
Is a natural number (integer starting with 1 for the top level) that specifies the level of the
role within the hierarchy.

geo_role
Is the ID attribute of a geographic role (geo_role element).
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value
Is an alphanumeric value, up to 50 characters, predefined for this geo role in this
hierarchy.

Example: Sample Geographic Hierarchy Definition

The following element defines the world hierarchy. The top level is CONTINENT, both the Name
role and the ISO code role. Level 2 has four COUNTRY geographic roles, corresponding to four
different country formats. Level 3 contains three state formats, level 4 contains the city name,
and level 5 contains two address formats and the postal code.

<hier id="World">
<lev level="1" geo_role="CONTINENT"/>
 <lev level="1" geo_role="CONTINENT_ISO2"/>
 <lev level="2" geo_role="COUNTRY"/>
 <lev level="2" geo_role="COUNTRY_FIPS"/>
 <lev level="2" geo_role="COUNTRY_ISO2"/>
 <lev level="2" geo_role="COUNTRY_ISO3"/>
 <lev level="3" geo_role="STATE"/>
 <lev level="3" geo_role="STATE_ISO_SUB"/>
 <lev level="3" geo_role="STATE_FIPS"/>
 <lev level="4" geo_role="CITY"/>
 <lev level="5" geo_role="ADDRESS_FULL"/>
 <lev level="5" geo_role="ADDRESS_LINE"/>
 <lev level="5" geo_role="POSTAL_CODE"/>
</hier>

Reference: Adding the Federal Reserve Districts Geographic Role

These steps describe how to add the Federal Reserve Districts geographic role to the
geo_services.xml file.

1. Open the geo_services.xml file. The default location is:

C:\ibi\srvnn\home\catalog\geo_services.xml

where nn is the release of your WebFOCUS Reporting Server. For example, 82 for version
8.2.

2. Add the role to the end of the GEO_ROLES object:

<geo_role id="FED-DIST" value_size="50" type="alpha" 
role_name="FEDDIST"
role_name_title="FED District" role_format="FR_Distric"
role_format_title="FED District Name" geo_type="geography">
   <vocabulary_rules>
    <vocabulary>+%FR_Distric%</vocabulary>
   </vocabulary_rules>
  </geo_role
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3. The ID is FED-DIST. The role name is also FED-DIST. Its format is FR_Distric. The title that
displays when you hover over a field with a geographic role assigned (or when using the
Map As option) is FED District. The definition has a vocabulary rule. The characters
FR_Distric must be present.

4. Add this role to the US Hierarchy:

<hier id="US">
   <lev level="1" value="United States" geo_role="COUNTRY"/>
   <lev level="1" value="US" geo_role="COUNTRY_ISO2"/>
   <lev level="1" value="USA" geo_role="COUNTRY_ISO3"/>
   <lev level="2" geo_role="USSTATE"/>
   <lev level="2" geo_role="USSTATE_ABBR"/>
   <lev level="2" geo_role="USSTATE_FIPS"/>
   <lev level="3" geo_role="USCOUNTY"/>
   <lev level="3" geo_role="USCOUNTY_FIPS"/>
   <lev level="4" geo_role="USCITY"/>
   <lev level="4" geo_role="USCITY_FIPS"/>
   <lev level="5" geo_role="ADDRESS_FULL"/>
   <lev level="5” geo_role="ADDRESS_LINE"/>
   <lev level="5" geo_role="ZIP3"/>
   <lev level="5" geo_role="ZIP5"/>
   <lev level="6" geo_role="FED-DIST"/> 
</hier>

5. Add the URI to the map server layer for this role at the end of the URIS object:

<uri description="FedReserve Districts">
   <returned_geometry>GEOMETRY_AREA </returned_geometry>
   <returned_georole>FED-DIST</returned_georole>
   <url type="esri" authorization="none" synonym="">
http://services7.arcgis.com/L95Wwv9OjRQ0tjAs/arcgis/rest/services/
FRDISTRICTS/FeatureServer/0</url>
   <parameters>
    <parm order="1" parm_name="FR_Distric" parm_georole="FED-DIST"/>
   </parameters>
  </uri>
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You will now be able to select this role when using the Map As option the next time you
start InfoAssist+, as shown in the following image.

Building InfoMini Applications

InfoMini applications are built from an InfoAssist+ report and contain a subset of InfoAssist+
functionality available at run time.

You can build an InfoMini application and provide the run-time user with the option to interact
with and edit the report.

Understanding InfoMini Applications

When you create a report in InfoAssist+, you have the option to activate InfoMini. You can run
a report with InfoMini activated, which creates an InfoMini application. An InfoMini application
contains a subset of the functionality available in the full version of the report or chart. You
can limit or expand the functionality that is available to the user at run time when you build the
report in InfoAssist+.

An InfoMini application opens in its own browser window when it is run from within InfoAssist+
to test. An InfoMini application does not open in its own browser window in the BUE Portal or in
any other application that you build yourself.
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An InfoMini application has many of the components an InfoAssist+ report has, with the
following exceptions:

The main menu is not accessible.

The New, Open, and View code buttons on the Quick Access Toolbar are not available.

Certain tabs and groups are unavailable or limited.

The status bar is not accessible.

The navigation taskbar is not accessible.

InfoMini does not support referencing existing procedures.

For more information on the available components and their functionality, see InfoAssist+
Application Window on page 72.

Using the InfoMini Button

The InfoMini button can be found on the Format tab, in the Destination group. You can click
the InfoMini button to activate the InfoMini option. With the InfoMini button active, you can run
a report to open the InfoMini application.

To deactivate the InfoMini option, click the InfoMini button again. There must be at least one
option selected from the InfoMini button menu for InfoMini to be activated.

You can set the options available to the user at run time from the menu on the InfoMini
button. If you select an option from the menu when the InfoMini button is inactive, the InfoMini
option is activated. The options are:

Format Tab

Slicers Tab

Run Immediately

Run Deferred

When you select an option from the menu, a check mark appears next to the option. The check
mark indicates the option is available for the user at run time within the InfoMini application. If
you select a checked option to clear it, the check mark disappears, and the option is no longer
available through the InfoMini application. If you clear all of the options from the menu,
InfoMini is deactivated. All options are selected by default.
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The Run Immediately option enables reports to run immediately when InfoMini first launches.
You might want to clear this option so that the user can choose a format and pick slicers
before running a report.

Understanding the InfoMini Layout

The Resources panel is not available in InfoMini. If no options are selected from the InfoMini
button when the application runs, an error message displays, indicating that you must select
at least one tab.

From the Format tab, you can access the Output Types group, with the following exceptions:

The Destination and Features groups, which are on the Format tab in InfoAssist+, are not
available in an InfoMini application.

The Other button, which is on the Format tab, in the Chart Types group in InfoAssist+, is
not available in an InfoMini application.

The InfoMini button, which is on the Format tab, in the Destination group in InfoAssist+, is
not available in an InfoMini application.

The Output Types group contains commands to create output in any of the supported formats.

For reports and charts, you also have access to the Auto Linking group. This group contains
options for enabling the functions of Auto Linking, a feature that allows you to create a suite of
referenceable reports and charts in your enterprise.

For more information on the functionality of the available groups on the Format tab, see Format
Tab on page 80.

From the Slicers tab, you can access the Options, Record Limit, and Slicer Group groups, with
the following exceptions:

The New Group option, which is on the Slicers tab, in the Options group in InfoAssist+, is
not available in an InfoMini application.

The Update Preview option, which is on Slicers tab, in the Options group in InfoAssist+, is
not available in an InfoMini application.

The Preview list, which is on the Slicers tab, in the Record Limit group in InfoAssist+, is not
available in an InfoMini application.

For more information on the functionality of the available groups on the Slicers tab, see 
Working With Slicers on page 725.
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Creating an InfoMini Application

To create an InfoMini application in InfoAssist+, build a report as you normally would, then
activate InfoMini and add the functionality you want the user to have available to them at run
time. For more information on what functionality is available to InfoMini applications, see 
Understanding InfoMini Applications on page 506.

Procedure: How to Activate InfoMini

1. With a report or chart open, click the Format tab.

2. In the Destination group, click InfoMini.

Note: At least one option from the InfoMini menu must be selected in order to activate
InfoMini. By default, the Format tab and Slicers tab are selected on the menu when you
activate InfoMini in a new report. For more information on enabling InfoMini options, see 
How to Enable and Disable InfoMini Application Options on page 509.

The InfoMini button is highlighted and the InfoMini mode is activated. For more information
about running an InfoMini application, see How to Test an InfoMini Application on page
509.

Procedure: How to Enable and Disable InfoMini Application Options

You can choose which options will be available at run time in an InfoMini application. By
default, the Format tab and Slicers tab are selected on the menu when you activate InfoMini in
a new report. For more information about the functionality of each option, see Understanding
InfoMini Applications on page 506.

1. With a report or chart open, click the Format tab.

2. Click the arrow next to the InfoMini button. A menu of available tabs and options displays.

InfoMini does not have to be active for you to access the menu. When you select an
option from the menu, InfoMini is activated.

3. From the menu, select any options you want to display in your InfoMini application.

Procedure: How to Test an InfoMini Application

1. With an InfoAssist+ report open, activate InfoMini as described in How to Activate InfoMini
on page 509.

2. Enable the options that you want, as described in How to Enable and Disable InfoMini
Application Options on page 509.

3. Run the report.
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An InfoMini application opens in a new window.

Procedure: How to Interact With an InfoMini Application

With an InfoMini application open, you can edit the application using the functionality that was
enabled in InfoAssist+. You have access to certain options, depending on which options were
enabled.

You have the ability to alter the InfoMini application at run time. Changes to the application are
not reflected on the canvas dynamically and you must run the report to see the updates.

1. Run a report with InfoMini activated, as described in How to Test an InfoMini Application on
page 509.

An InfoMini application opens in a new window.

2. By default, the ribbon is hidden in an InfoMini application. To display the ribbon, do one of
the following:

Click one of the tabs (Format or Slicers).

Click the down arrow next to the Help icon.

The available options on these tabs provide the same functionality as they do in InfoAssist
+. You can use this embedded functionality to change the report at run time.

3. After making your changes, click Run to see an updated version of the report.

Viewing Data Behind Visuals

You use InfoAssist+ to analyze your data by creating or building interactive visualizations. As
you develop these visualizations, you can create different views of the data, and find patterns
or trends.

As you gain insight and spot patterns, you may want to share only the underlying data that
comprises a specific visual with others in your enterprise. You can do this using the data
options, as shown in the following image.

The Show data option provides options for you to view and share this data. The Export data
option enables you to export the data specific to your visualization in a summary or detailed
format. You can also review related data by using the Show Data with Related Columns option.
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The Show Data with Related Columns functionality allows you to review more specific
underlying data based on the fields that you have selected. Specifically, it displays data related
to other fields that are part of the dimension hierarchy that you select. For example, if you
selected the Product,Category dimension field, the related column data would include data
from the Product,Subcategory and Model dimension fields, because these data fields are part
of that dimension hierarchy.

Similar to the Show data option, the Show Data with Related Columns option provides more
detailed data based on the data fields that you select. You can sort and review the data
columns, which display in a separate browser window. Depending on the size and breadth of
your dimension hierarchy, a multiple page report may be produced.

Note: You can export data in .xls or .csv format.

When you select the option to show data or show data with related columns, a report is
generated in a separate browser window. This report is an active report, which you can review,
sort, and modify using the drop-down menus that are available.

When you point to the Export Data option, you can:

Export data in summary format, which includes totals for categories based on the data
fields that you selected for your visual.

Export more granular data based on the data values that you selected in your visual.

Note:

When exporting data using the Summary or Data Detail options, you can save the resulting
data file, which is in Microsoft

®
 Excel

®
 format, to your local machine for further analysis and

sharing.

The maximum number of records that can be exported is 100,000.

Procedure: How to Show the Data Behind Your Visual

1. Create a visual, such as a chart, map, or grid.

2. In the upper-right corner of the visual cell, click the down arrow.

3. In the menu that appears, click Show Data.

A new browser window opens. This window displays the data for your visual as a
WebFOCUS active report. You can use this active report to create and share lightweight,
browser-based data discovery analytics that are portable, and only require access to a
browser.
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Procedure: How to Show Data With Related Columns

1. Create a visual, such as a chart, map, or grid.

2. In the upper-right corner of the visual cell, click the down arrow.

3. In the menu that appears, click Show Data with Related Columns.

A new browser window opens. This window displays the data for your visual as a
WebFOCUS active report. You can use this active report to sort and work with the
underlying hierarchical data in your visual.

Procedure: How to Export the Data Behind Your Visual

1. Create a visual, such as a chart, map, or grid.

2. In the upper-right corner of the visual cell, click the down arrow.

3. In the menu that appears, point to Export Data, and then click one of the following:

Summary. A prompt appears, asking you to open or save a Microsoft Excel file. This
file is a summary of your data from a high level for a general analysis, as shown in the
following image.

Data detail. Generates a detailed report that provides specific data regarding your data
analysis.

Creating Multi-Y Axis Comparative Visuals

When creating a chart with more than one measure (numeric) field, you can split the Y axis to
create multiple charts, based on each unique measure field.

Note: Measure fields are selected from the Data pane and display under the Vertical Axis (Y) in
the Query pane.
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This functionality is useful when analyzing trends for multiple measure fields, as you can view
data for each measure field separately within the same chart, as shown in the following image.

This functionality is available for Bar, Bar Stacked, Line, Area, and Area Stacked charts.

Procedure: How to Create a Multi-Y Axis Comparative Visual

1. Launch InfoAssist+ in visualization mode.

2. On the Home tab, in the Visual group, click Change.

3. Select one of the following visual types: Bar, Bar Stacked, Line, Area, or Area Stacked.

Note: Bar Stacked is the default visual type.

4. Add multiple measure fields to the visual. For example, Gross Profit and Revenue.

5. Add at least one dimension field to the visual. For example, Product Category.

6. In the Query pane, right-click Vertical Axis.

7. Click Multi-Y split.

The chart changes to display individual charts for each measure field.

Note: You can revert your chart to an integrated display by right-clicking Vertical Axis and
then clicking Multi-Y split.
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Creating HOLD Files

A HOLD file is the output of a report request stored in a file that you can use as input to
another WebFOCUS procedure.

You can then create new report requests that extract data from the HOLD file, resulting in
multi-step report.

HOLD files can be created to use in a report, chart, document, or visualization.

Valuable Applications of HOLD Files

A HOLD file is valuable when you want to do the following:

Extract fields from a large data source for faster and more efficient retrieval in subsequent
requests.

Store virtual field values or summary values calculated in one request for further processing
in another request.

Storing HOLD Files

HOLD files can be created for immediate use and saved temporarily or they can be stored for
future and repeated use.

Output Formats for Reports

You can save a HOLD file for a report in the following formats:

Binary (*.ftm)

FOCUS (*.foc). For more information, see FOCUS Format Index Fields on page 518.

Comma Delimited with Titles (*.csv)

Plain Text (*.ftm)

Tab Delimited (*.tab)

Tab Delimited with Titles (*.tab)

Database Table (*.sql)

Note: The Database Table output is only available when working against an SQL database.

SQL Script (*.sql)

Hyperstage (*.bht)
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Note: The Hyperstage output is only available when the reporting server has a Hyperstage
adapter configuration.

XML (*.xml)

Visual Discovery AE (*.txt)

Note: The Visual Discovery AE output option is only available with a Visual Discovery
Analyst Edition license.

Creating Hold Files

This section contains examples of how you would use a HOLD file.

Note:

Across fields are not allowed in HOLD files.

Using the Change Title option in the Query pane, you can change the title of a field prior to
creating a HOLD file. A blank space in the title will be replaced by an underscore. This
functionality enables you to control the names used for the fields included in the HOLD file,
and makes it easier to find the fields when creating report.

When creating a HOLD file, the Temporary dialog box displays only those reporting server
applications to which you have access.

When a report contains a HOLD procedure, dots or periods (.) in the AS name of the Define
field are automatically converted to an underscore (_).

You can use Auto Linking when working with HOLD files. For more information, see Using
the Auto Linking Feature to Link Content on page 705.

Procedure: How to Create a Tabular Report From a HOLD File

To create a tabular report from a HOLD file, begin by creating a report.

1. In the Open dialog box, select the wf_retail_lite Master File.

2. Add the following measure fields to the report:

Cost of Goods

Discount

Gross Profit

Quantity,Sold

4. Creating Content

Online Help PDF  515



Revenue

3. Add the following dimension fields to the report:

Product Category

Product,SubCategory

Sale,Year

4. On the Home tab, in the Format group, click File.

The Temporary dialog box opens.

5. In the Temporary dialog box, name the HOLD file, keep the default file type, Binary (*.ftm),
and click Save.

6. At the bottom of the canvas, click Create Report.

The custom database structure displays in the Resources panel. The canvas is returned to
a default blank state, enabling the development of a new report using the HOLD file.

7. From the HOLD file, drag Quantity,Sold to the canvas.

8. On the canvas, select the Quantity,Sold column heading.

9. On the Field tab, in the Display group, click Aggregation and then click First Value.

Note: The heading changes to FST Quantity Sold.

10. Select the FST Quantity Sold heading.

11. On the Field tab, in the Display group, click Hide Field to hide Quantity,Sold, as it will be
used in a subsequent calculation.

12. On the Data tab, in the Calculation group, click Summary (Compute).

13. In the Summary Field (COMPUTE) dialog box, do the following:

In the Format field, type D8.2%.

Double-click the Quantity,Sold field to add it to the formula box.

Add / 100 after the Quantity Sold field to calculate the percentage.

14. Click OK to close the dialog box.

15. Drag Product,Category to the By Query field container.

16. In the Query pane, select the Product,Category field.

17. On the Field tab, in the Break group, select Subtotal to create Subtotals on
Product,Category.

18. Drag Product, Subcategory to the By Query field container.
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19. Drag Sale,Year to Across.

20. On the Home tab, in the Report group, click Row Totals.

The final report displays.

Procedure: How to Rearrange HOLD File Components

The following procedure describes how to rearrange file components in a HOLD file.

Note: This procedure creates a binary HOLD file and a subquery to illustrate how to rearrange
HOLD files. It also shows the result of this rearrangement.

1. Create a new document, using the wf_retail_lite Master File for the data source.

2. On the Insert tab, in the Reports group, click Report. Populate the report with the following
fields from the Data pane:

Gross Profit

Quantity,Sold

Revenue

Product,Category

Product,Subcategory

3. On the Home tab, in the Format group, click File to create a HOLD file.

In the Temporary dialog box, enter a name for the file. For example, File1_binary.

4. Click Save.

5. Create a report using the HOLD file, specifying Product,Category, Product,Subcategory, and
Quantity,Sold.

6. Next, using the following steps, add a subquery SQL script for use as a filter on the first
report.

a. On the Data tab, in the Data Source group, click Switch.

Select the original master file (wf_retail_lite.mas).

b. Locate and double-click the Product,Category dimension field.

This creates a second report, which you can drag and resize as needed on the
Document canvas.

c. Create a filter on Product,Category, where the product category is equal to Televisions.

7. With the new component selected, click the Home tab and in the Format group, click File.
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In the File name field, enter File2_subquery and select the SQL Script (*.sql) format from
the file types menu.

8. Click Save.

9. Rearrange the order of the HOLD files so that the File2_subquery is positioned above the
File1_binary HOLD file using the following steps:

a. Right-click Files in the Query pane and click Arrange Files, as shown in the following
image.

The Arrange Files dialog box opens.

b. Using the Arrange Files dialog box that displays, select File2_subquery and click Move
Up to move the file above File1_binary.

c. Click OK.

10. Edit the first report and create a filter using the subquery.

11. Click OK to exit the Create a filtering condition dialog box.

Your report is refreshed to reflect the filtering you have applied.

FOCUS Format Index Fields

FOCUS is the only format that supports an index field. The maximum number of fields to index
is four. If the file format is FOCUS, then Index appears on the Query pane.

Creating a Subquery Filter Using a HOLD File

You can create a subquery using a HOLD file. A subquery is a nested query that is added to
the Where clause of an SQL statement. A subquery is valuable because it is highly reusable.

Procedure: How to Create a Subquery Filter Using a HOLD File

This procedure describes how to create a subquery filter using a HOLD file created in the
previous procedure.

1. Build a report.
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2. On the Data tab, in the Filter group, click Filter.

The Filter dialog box opens.

3. In the Filter dialog box, from the Type drop-down menu, select Subquery as the filter type
for the left-most part of the expression.

4. From the Subquery drop-down menu, select In list as the comparison operator.

5. From the list of subqueries, select the subquery that was created (in this example, File1)
for the right-most part of the expression.

6. Click OK.

The report is filtered by the subquery that you created.

Note: To view the SQL statements generated by the request, go to the Quick Access
Toolbar, open the Run drop-down menu, and select SQL Trace.

Creating Shortcuts and URLs

The use of shortcuts and URLs can simplify workflow and provide additional context to your
analytics. The following sections explain how to use shortcuts and URLs and describe how to
create these content items in your repository.

Creating Shortcuts

Authorized users can create shortcuts to repository resources and Master Files. Once a
shortcut to a Master File is created, you can use it to build visualizations and reports. Once a
shortcut to a repository resource is created, you can copy, delete, edit, and run this item. You
can also publish and share your shortcuts to make them available to other users and groups.

Procedure: How to Create a Shortcut to a Repository Resource

1. In the Resources tree, right-click a domain or folder, point to New, point to Shortcut, and
then click To Repository Resource.

The Create Shortcut dialog box opens.

2. Click Browse.

The Shortcut Target dialog box opens.

3. Navigate to the resource of your choice, such as folder, report, chart, dashboard, or
visualization, and then click OK.

The Title field is automatically populated with the name of the original item and the word
Shortcut.

4. Optionally, edit the Title and populate the Summary field.

4. Creating Content

Online Help PDF  519



5. Click OK.

A confirmation message indicates that your shortcut is created successfully.

6. Proceed in one of two ways:

Click Browse again to create another shortcut.

Click Cancel to close the Create Shortcut dialog box and begin using your new shortcut.

Procedure: How to Create a Shortcut To a Master File

1. In the Resources tree, right-click a domain or folder, point to New, point to Shortcut, and
then click To Master File.

The Open dialog box opens.

2. Navigate to a Master File, previously generated through the Upload wizard or Connect to
Data wizard, and then click Open.

The shortcut to the Master File appears in your selected directory in the Resources tree.
You can use this shortcut to create reports and visualizations. You can also publish or
share the shortcut to make it available to other users.

Creating URLs

Authorized users can create URLs to webpages and store them within the repository. These
URLs can further enhance analytics, providing an additional interactive context to your data.
You can run a URL in a new tab, use it in a dashboard, and add it to a personal page. You can
also publish a URL to make it available to other users and groups.

Procedure: How to Create a URL

1. In the Resources tree, right-click a domain or folder, point to New, and then click URL.

The Create URL dialog box opens.

2. Populate the Title field, type the URL to your selected webpage in the URL field, and then
click OK.

The URL appears in your selected location in the Resources tree.
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The following image shows how a URL appears in the Resources tree and displays in a
new tab inside a portal.

Creating Blogs

A blog is an interactive content item that operates as commonly-seen blogs on the internet. It
allows users to post and view comments. Blogs abide by the same security rules that apply to
other items in the repository. You can publish, unpublish, hide, and move blogs between
domains or folders. You can also share blogs with other users and groups.

Procedure: How to Create a Blog

1. In the Resources tree, right-click a domain or folder, point to New, and then click Blog.

The New Blog dialog box opens.

2. Type the requested information in the dialog box, as follows.

Title. Value displayed in the Resources tree that is used to identify the blog.

Summary. Optional explanation of the blog. It is displayed in the ToolTip when the
mouse hovers over the blog.

3. Once you have provided the appropriate information, click OK.

The Comments window opens.
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4. Click the Add comment link to add a new comment.

5. Once you are done adding and editing comments, click Post to post the comment and
close the Comments window.

6. You can optionally interact with the comments by using the following commands:

Click the Refresh icon  in the comments menu, to refresh comments.

Click the Search button  in the comments menu, and type a key word or words in
the search field, to search through comments. You can specify the search criteria by
clicking the arrow next to the Search button and selecting search criteria, such as user
name, content, or meta tags.

Click the Remove All button  to remove all comments from all users. The Remove
All option is only available to managers, developers, and group administrators.

You can now publish, share, and add your blog to a page.

Working With Pages

Pages are a vital part of the BUE portal architecture. Depending on the type of a page, the BUE
portal allows different levels of versatility in the way you organize, share, and interact with this
page.

There are three types of pages in a portal. These include:

Base Page. Created in the Page Designer and added to the BUE portal by a manager or
developer. If a base page is unlocked, users can customize it at run time. If the user
removes customizations, all changes made by the user are removed, and the base page
reverts to its default state.

Personal Page. Added to the BUE portal at run time by the user. Personal pages are stored
in the repository but they are not visible in the Resources tree. Personal pages are only
visible to the user that has created these pages.

Domain Page. Created with the Page Designer directly in a domain or folder. A domain page
can be copied or added to a portal, in which case it becomes a base page. If a page is
removed from a portal, it becomes a stand-alone domain page and can be edited, moved,
unpublished, or hidden.
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Note: To avoid unwanted behaviors, you should not edit pages in the Page Designer, or
move or hide pages in the repository, while users are running these pages in the BUE
portal.

Page Designer Overview

The Page Designer allows you to create domain pages inside domains and folders of your
choice. This section explains how to use the Page Designer to create a domain page. It also
describes the different components of the Page Designer interface.

Procedure: How to Use the Page Designer to Create a Domain Page

1. In the Resources tree, right-click a domain or folder, point to New, and then click Page.

The Page Designer opens, and the Add Page dialog box opens inside the Page Designer.

2. Select a page template and, optionally, edit the Title and Name fields.

3. Click Create.

The page displays in the Page Designer.

4. Optionally add content to the page.

If left blank, panels behave like Easy Selector containers at run time. To learn more about
the Easy Selector, see Using the Easy Selector on page 733.

5. Optionally, unlock the page to allow run time edits. Clear the Lock Page check box in the
Properties panel.

Note: The Lock Page option is enabled, by default.

6. Save and close the Page Designer.

A new domain page is created and now displays inside the selected domain or folder. It is
ready to be added to the BUE portal.
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Page Designer Interface

The following image shows the Page Designer.

The Page Designer contains the following components, located from the top of the interface to
the bottom:

Page Templates

Application menu

Quick Access toolbar

Ribbon

Canvas

Properties panel

Breadcrumb trail

The components are described in the following topics.
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Page Templates

Page templates provide a quick way of creating page layouts . When you create a new domain
page, the Add Page window opens and displays layout presets from which you can choose
before adding any content.

Note: Page templates are only available for domain pages.

The Add Page window is shown in the following image.

The Add Page window contains the following options:

Page Templates. This area contains custom and default page templates. Each template is
accompanied by a thumbnail, which allows you to preview the layout. The default templates
are:

1 Column

2 Column

3 Column

4 Column

Fluid Canvas

Responsive 2-2
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Responsive 3-2-2

Responsive 3-3

Responsive 3-3-3

Responsive 4-2

Responsive 4-2-2

Responsive 4-4-2

Single Area

New Page Information. This area provides access to the following options:

Title. The title of the page. The default title matches the name of the selected page
template.

Name. The name of the page. The default name matches the name of the selected
page template.

Location. The location of the page in the repository. To change the location, click
Change Location and navigate to a different domain or folder.

Copy Existing Page. Creates a copy of an existing page in the repository.

Application Menu

You can access the Application menu through the BIP icon at the upper-left corner of the Page
Designer window.

The menu contains options to:

Create a page

Open an existing page in the Page Designer

Save the current page

Save the current page as specified

Exit

Quick Access Toolbar

The Quick Access toolbar allows you to save your changes to the current page.
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Ribbon

The ribbon is a rectangular area of distinct groups of buttons that spans the top of the Page
Designer window and provides access to commonly used tools.

The ribbon contains three tabs:

Layout.Specifies the theme and layout settings.

Insert.Inserts content into the page.

Style.Applies styles to common properties (background, border, and font).

Note: You can hide the ribbon by clicking the arrow in the upper right corner of your page.

Layout Tab

The following image shows the Layout tab.

The layout tab has two groups, Preview and Page.

Preview Group

The Preview group has a single Theme button. The Theme menu consists of two parts:

Portal Theme Files Browser. Allows you to configure CSS files, apply a predefined theme,
including a Custom theme.

CSS Editor. Enables you to edit specific components of the existing CSS theme.

The default theme is Neutral.

Page Group

The Page group has a single Layout button. You can use the Layout option to change to a
column-based layout or to a fluid layout. In a column-based layout, dragging a panel results in
a drop indicator, showing where the panel goes. In a fluid layout, the content automatically fills
the page area in equal proportions. You can manually rearrange and nest these elements on
the page. The display area changes its size depending on your browser dimensions.
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The Layout menu has the following options:

Single Area. There is no grid, and all items are free flowing.

Fluid Canvas. Items are dragged to a floating drop target that arranges the content evenly
and redistributes space as more items are added.

One Column. The content stretches to fill the entire page area.

Two Columns. The page is evenly divided into two columns.

Three Columns. The page is evenly divided into three columns.

Four Columns. The page is evenly divided into four columns.

When you choose any option other than Single Area, items snap to place within the area.

Insert Tab

The Insert tab is used to insert two types of items:

Containers. Adds a panel, accordion, tabbed, responsive, or easy selector container to the
page.

Content. Inserts WebFOCUS content (for example, visualizations, reports, charts,
documents, dashboards, and URLs), images, and text.

Style Tab

The following image shows the Style tab.

The Style tab is used to configure styling of objects, options for the background and borders,
as well as fonts and colors of the text. This tab functions in the same way as does the Style
tab in the Portal Designer.

State

From the State group, you choose which of the available states you are styling for an object.
The state options are:

Normal. This is the default state of an object in which an event, such as a hover, is not
occurring, or if styling for that event is not defined.
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Active. This is the state in which the object is currently in use. An example is the
background color of the current page tab.

Hover. This is the state in which the mouse cursor is resting on the object.

Background

You can use an image, a color, or a combination of options when styling the background of an
object.

Image

The Image button is a split button. Clicking the left side of the button launches an Open dialog
box. Clicking the right side of the button displays the Background Image Options. The
Background Image Options allow you to change or remove an image.

Click Change Image to launch the Open dialog box. From this dialog box, select an existing
image in the Repository to use as the background, and click Open.

To add a new image, use the Resources tree, and right-click the folder that you wish to place
the new image in. Point to Upload and click Image.

Repeat

The Select Background Repeat menu enables you to choose whether or not to repeat the
background. The options are:

None. Displays the background image only once.

Everywhere. Repeats the background image horizontally and vertically. This is the default
value.

Horizontally. Repeats the background image horizontally.

Vertically. Repeats the background image vertically.

Position

If you do not choose to repeat the image everywhere, you can select a background position
using a visual menu. For example, you can position the background image at the bottom of the
window, on the right. This feature is similar to Menu Bar positioning.

The default background position is top left.
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Background Color

The Background Color icon  launches the color selection dialog box for setting a page
background color. The same icon is used in the Border and Font groups to set the border and
font colors, respectively.

Reset Background

The Reset Background icon  in the Background group resets the background styling to the
theme settings for the currently selected state. The same icon is used in the Border and Font
groups to reset those groups.

Border

In addition to color and reset, the Border group has style and width controls.

Style

The Select Border Style menu is a visual menu that enables you to choose one of nine border
styles. In the order of left to right (by row), the styles are:

None (This is the default border style.)

Solid

Dotted

Dashed

Double

Groove

Ridge

Outset

Inset

Width

The Width control sets the border thickness in pixels (px). If the style is set to none (the
default for most objects), the Width control has no effect.

Working With Pages

530  Information Builders



Color

The Border Color icon  launches the color selection dialog box for setting the Border color.

Reset Border

The Reset Border icon  in the Border group resets the border styling to the theme settings
for the currently selected state.

Font

The Font group enables you to set:

Font family

Font size in pixels

Formatting

Bold

Italic

Underline

In addition, the Font group contains:

Color

The Font Color icon  launches the color selection dialog box for setting the font color.

Reset Font

The Reset Font icon  in the Font group resets the font styling to the theme settings for the
currently selected state.
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Canvas

The following image shows the canvas of the Page Designer.

The canvas is the design area of your page.

Properties Panel

The Properties panel appears near the bottom of the window, below the canvas. It shows
properties that apply specifically to the currently selected item.

Breadcrumb Trail

The breadcrumb trail appears at the bottom of the Page Designer window. It serves two
purposes:

It indicates the currently selected item.

You can use it to change the currently selected item.

Click any portion of the breadcrumb trail to change the currently selected item on the page
canvas. This feature is another way to select an item, in addition to selecting it through the
canvas. This feature is especially useful when you are working with hidden or layered content.
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Page Components

The page is made up of different components, such as columns, containers, and resources.
This section describes the different components of a page and their properties.

Page

The Page, while not a component itself, does have properties that you can set.

The following are the properties of a page.

Title. The title or label shown in the navigation menu and any tree that displays the list of
pages in the portal.

Page Icon.

This is an icon displayed to the left of the page name throughout WebFOCUS. You can
turn it on or off. It is disabled, by default.

The maximum display size of the icon is 16 x 16 pixels. Upload an image that is visible
at that size.

Change the portal icon by clicking the preview icon or the Change Image button.

Lock Page. Turns off customization on the page. Customization includes moving content
and adding content.

Note: The Lock Page check box is selected by default. Clear it to grant permission to end
users from moving and adding content.

Refresh on Click. Refreshes the page when you click the page title. This feature is useful if
another page changes the parameters used by the reports on this page. When you switch
back, the reports rerun with the appropriate parameters.

Show in Navigation. Used to hide the page from the navigation. You can use this property
to create a Home page for a portal that displays the first time that a user runs the portal,
but the user cannot navigate to it again. In a future WebFOCUS release, there will be
support for a URL for each page, allowing you to link to a page that is not included in the
navigation.

Prevent Layout Change. Restricts layout changes on unlocked pages at run time. This
option is only active when the Lock Page option is disabled.

Relative Path. References a specific path for the content that was added to a page and
allows you to move the page in the repository without losing any content or resources.
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Show Refresh. If enabled, displays the Refresh option in the page menu at run time.

Margins. Sets page margins in pixels or as a percentage. Use the Same for All option to
set equal margins on all four edges of a page.

Comments. Controls the placement of the comments on a page. The options include: none,
top, bottom, left, and right.

Container Defaults. Opens the Container Defaults dialog box, where you can set a default
size, appearance, and list of behaviors for all containers on a page.

Columns

Columns have the following properties:

Column Number. A label that indicates the column that is selected on the page.

Width. Set in pixels or as a percentage.

Lock Width. Prevents a designated column width from being changed at run time. This
option is disabled, by default.

Container Padding. The space between either container and the column edge (left and right
of each container, the top of the first container, and the bottom of the last container) or
each other (vertical space between each container). These work like page margins, but are
set only in pixels.

Freeze Column. Prevents users from adding content to the column or any of the containers
inside this column at run time. It also prevents users from removing any content or
containers from this column at run time. This option is not available when the Lock Page
option is selected.

Show Easy Selector. Activates the Easy Selector function at run time.

Select Folder. Opens the Browse For Folder dialog box, where you can select a folder that
is available from the Easy Selector option at run time.

Containers

There are five types of containers:

Panel. A simple container that can hold a single piece of content.

Accordion. A compound container that can hold one or more pieces of content. It uses
accordion panes to switch between the content.
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Tabbed. Similar to the accordion, but uses tabs to switch between the content.

Responsive. A compound container that responds to the layout changes based on the size
of the browser or device.

Easy Selector. A simple container that a flexible way of adding content to a portal at run
time without opening the Resources tree.

Panels

The panel container holds a single piece of content, as shown in the following image.

The panel consists of three sections:

Overall panel

Title Bar

Content Area
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When you hover over a panel in Page Designer, the Change Panel Type button is illuminated.
When you then hover over this button, you are presented with a menu where you can change
the type of the panel.

To change the title of the panel, right-click the title bar and click Change Title, as shown in the
following image.

Panel Properties

The properties for all panel types are:

Properties Tab. Contains the properties that apply to the panel.

Panel Title. This is the name of the panel. In a simple panel, the title begins as Paneln,
where n is a unique number, starting at 1.

Size. In a single area layout, this is both height and width in pixels. In column-based
layouts, this is height only. You can set the height, in pixels, to Auto, Dynamic, or a
numeric value. The Dynamic height option is only available when you use a responsive
container.

Responsive Properties. Opens the Responsive Panel Properties dialog box, where you
can edit the layout of the responsive container.
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Behaviors. You can configure how the panel behaves. By default, all options are on. The
options that require a menu click are available by hovering over the title bar and
accessing the menu at the upper-right (in accordion and tabbed containers, each area
has a menu as well). The options are as follows:

Move. If selected, allows you to move a panel on a page at run time.

Resize. If selected, allows you to resize a panel at run time.

Minimize. Adds the Minimize option to the panel drop-down menu.

Maximize. Adds the Maximize option to the panel drop-down menu.

Refresh. Adds the Refresh option to the panel drop-down menu.

Hide. Adds the Hide option to the panel drop-down menu.

Delete. Adds the Delete option to the panel drop-down menu. When a user deletes a
panel, they delete it only from their version.

Show Comments. Displays comments on a panel, and adds the Show/Hide
Comments option to the panel drop-down menu, if selected.

Appearance. You can control the following options:

Hide Panel. When this option is selected, the panel is not initially visible. The user
can add it by clicking Hidden Content in the page shortcut menu or the Menu Bar.
You can use the Hidden Content feature to give the user a choice of widgets to view
on their page.

Freeze Container. Prevents users from adding content to and removing content from the
container at run time. This option also restricts any interaction with the container at run
time except minimizing, maximizing, and restoring the panel to its original size. This
option is not available when the Lock Page option is selected.

Title Tab. Contains the properties that apply to the title bar of the panel.

Title. This is the text displayed in the title bar. When you add content, it automatically
changes to the current title of that content. You can edit this field to override the
automatic change.

Panel Icons. Works just like the page icon. It is disabled by default.

Change Image. Allows you to select a different image for the icon.
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Appearance. You can control the following options:

Hide Title Bar. You can hide the title bar to save space. This feature is very useful
when you have only a single piece of content on a page.

Show Menu Icons. Determines whether the icons that display with the options in a
container shortcut menu are visible.

Content Tab. Contains the properties for a content item that is displayed inside the panel.

Content Area. The properties for the Content Area differ based on the type of content. A
blank panel has a blank properties panel.

Auto Refresh. If enabled, refreshes the content automatically. This property is off by
default. When it is enabled, the default time is 30 seconds.

Dynamic Report Styling. When this property is enabled, all reports that run within the
BUE portal inherit their styling from the portal.

Tabs/Areas Tab. Contains the properties that apply to tabs and areas. This tab is only
visible in the properties panel of a tabbed or accordion container. Here you can style
different areas of the container by selecting Buttons or Bar. You can also hide the new tab
button from a tabbed container, or the new area button from an accordion container, to
restrict adding more tabs and areas to this container at run time.
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Accordion Container

The accordion container can hold more than one piece of content, as shown in the following
image.

In the preceding image, notice how the chart fits perfectly in the container. WebFOCUS
InfoAssist+ has an option to AutoFit charts. When enabled, it accepts the sizing from the
portal. This prevents the person who develops the chart and the person who uses it from
having to coordinate sizing. Additionally, you can easily resize the container and see the entire
chart.

The title bar and content area properties are the same. The overall properties have an
additional section labeled Area.

In the Area section, you can use the icons in the order in which they appear to add, rename,
delete, and reorder the areas. You can also create a new area using the new area bar in the
container or delete containers using the menus. You must use the Properties panel to rename
or reorder the areas.

There is also an additional Properties panel, the Pane Title Bars, which is accessible only
through the breadcrumb trail. This feature lets you style the title bars of the areas. They are all
styled together, but you can style the different states to distinguish the currently active one
from the one on which the mouse pointer is resting.
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Tabbed Container

The tabbed container can hold more than one piece of content, as shown in the following
image.

The tabbed container has all the same properties as the accordion container. Instead of the
Pane Title Bars properties, it has a property panel called Tab Bar. You can access this property
panel by clicking it.

Unlike the Pane Title Bars, it is not blank. You can choose to style the buttons or the bar.
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Responsive Container

The responsive container is designed to help you build a responsive portal that automatically
adapts to different screen sizes and mobile devices, providing an optimal viewing experience
for users everywhere. You can build your responsive portal on your desktop, and make it
available to users on different platforms. The following image shows an example of a
responsive portal displayed on a desktop, tablet, and smartphone.

The responsive container intuitively changes its layout when you change the size of your
browser. The default width and height of the container, and the inserted items, are pre-
configured to offer the best positioning of the elements on the screen. You can manually
change the dimensions of the items in the Responsive Item Properties dialog box. You can
also change the layout options in the Responsive Panel Properties dialog box.

Responsive Item Properties

The Responsive Item Properties dialog box provides options to change the dimensions of an
individual item within the responsive container. You can access the Advanced Responsive Item
Properties dialog box at design time by clicking the Responsive Properties button in the
property sheet.

The properties for a responsive item are:

Custom CSS Classes. Enables custom CSS classes for the item.
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Width. Defines the width of the item.

Height. Defines the height of the item.

Margin. Defines the space between the adjacent items.

Shrink. Defines the ability of the item to shrink if necessary.

Grow. Defines the ability of the item to grow if necessary.

Basis. Specifies the initial size of the item, before any available space is distributed
according to the responsive factors.

Minimum Width. Sets the minimum width of the specified element. This setting overrides
the Width setting.

Maximum Width. Sets the maximum width of the specified item. This setting overrides the
Width setting.

Minimum Height. Sets the minimum height of the specified item. This setting overrides the
Height setting.

Maximum Height. Sets the maximum height of the specified item. This setting overrides
the Height setting.

Self Align. Provides access to the following options:

Auto. Intuitively places the item in the best available space inside the responsive
container.

Start. Aligns the item to the left side of the responsive container.

End. Aligns the item to the right side of the responsive container.

Center. Aligns the item to in the center of the responsive container.

Stretch. Stretches the item to fill the available space inside the responsive container,
while respecting width and height constraints.

Baseline (text). Aligns the baseline of text inside the responsive container.

Note: In a responsive layout, setting fixed dimensions for items is not recommended, because
the viewport width and height continually change from device to device. Responsive layouts
need to adapt to this change, whereas fixed dimensions create too many constraints. For this
reason, you must only set a range between minimum and maximum width and height, defining
an amplitude with which the item can vary in size.
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Easy Selector Container

The easy selector container provides a simple way to add content to a portal at run time,
without opening the Resources tree. It also gives you the option to control which items users
can access. When you insert an easy selector container into a page at design time, the Browse
For Folders dialog box opens, as shown in the following image. Here you can select a folder
that users can access at run time.

To change a target folder, click the Change Folder button in the Properties panel.

Content

You can add content to a page in a few ways. The first way is to use the ribbon. Navigate to
the Insert tab and choose a type of content in the Content group. The second way is to insert a
blank panel, area, or tab container, and use the WebFOCUS Resources option to populate it.
The Resources tree opens, allowing you to drag content into the page.

Note: When you click and drag one or multiple resources or folders from a tree to a blank
page, a tabbed container is created, showing each resource.

The other three options (Image, Resource Tree, and Text) place their content in the content
area that is selected, if applicable. Alternatively, they create a new panel with the content on
the page.
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WebFOCUS Resources

The WebFOCUS Resource option opens the Resources tree on the right-hand side of the
window. The tree shows you the content stored in the WebFOCUS Repository. You can access
this content in the Domains section of the tree. Alternatively, you can find a resource that you
marked as a Favorite.

The Resources tree is docked on the right. When it is docked, you can keep it open, close it, or
unpin it so that it collapses to the side. The Resources tree is shown in the following image.

Text

The last type of content is text. The text area is simple to use. All styling is applied to all the
text. You cannot style individual words or characters.

The text area has no properties other than the content type and the Area ID.

Working With the WebFOCUS BUE Portal

The first page that you see as a Manager, is the Getting Started page. If you sign in as any
other user, the first page you see is the Home page. If you add a new personal page and sign
out of the portal with the new page in focus, the new page opens, by default, the next time you
sign in. You can create new pages in the WebFOCUS Business User Edition to display the
content that is available to you.
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Procedure: How to Add a New Personal Page

Click the Add Page icon, as shown in the following image.

A blank page and the WebFOCUS Resources panel opens. You can drag content from the
Resources tree panel to the page.

Procedure: How to Add a New Base Page

1. In the Resources tree, right-click a domain page, and then click Publish.

For more information on how to create domain pages, see How to Use the Page Designer to
Create a Domain Page on page 523.

2. Right-click your published page, and then click Add to Portal.

The confirmation message appears indicating that the page is added to the portal.

3. Click OK to close the confirmation message.

The BUE portal refreshes, the new page appears in the new tab.

Note: The domain pages added to the BUE portal behave as base pages. Base pages are
locked by default at design time to prevent users from making run-time changes.

Procedure: How to Add Content to the BUE Portal at Run Time

1. Navigate to the page that you want to populate with content.

2. On the Menu bar, click Resources.

The WebFOCUS Resources panel opens.
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3. Drag an item on the page. Use the shaded area to position the item on the page, as
shown in the following image.

Note: When you drag one item on top of another and position your cursor in the center of
the other item, you have a choice to either replace the existing item or add the new item
as a new tab. If you choose the latter, a tabbed container will be automatically created. If
you choose the latter, a tabbed container will be automatically created. If you multi-select
several items and drag them to a page, they will display as tabs inside a single panel. You
can refresh or delete each tab individually. You can rearrange content by moving it on the
page with your pointer. Optionally, you can change the layout of the page by right-clicking
the page title, and then clicking Page Layout. The default layout of the personal pages is
Fluid Canvas.

4. After you finish adding content to the page, close the WebFOCUS Resources panel by
clicking the Close icon in the upper-right corner of the panel.
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Accessing Page Shortcut Menu Options

Right-click the page title of a personal page or an unlocked base page to access page shortcut
menu options. The shortcut menu opens, as shown in the following image.

Change Title 

Renames the selected page.

Move Left 

Moves the selected page to the left.

Move Right 

Moves the selected page to the right.

Page Layout 

Allows you to choose a page layout to align your content into the desired number of
columns.

Delete 

Deletes the selected page.

Note: The Home and Getting Started pages do not have shortcut menu options, since these
are static base pages for the BUE portal.

Creating Report Queries With InfoAssist+

You can create a new report query directly from Excel by accessing the WebFOCUS Quick Data
Add-in. Specify connection attributes and the data source for your query, and then build your
report using InfoAssist+. You can place multiple queries in the same worksheet, or spread
them out over multiple worksheets in a workbook.

There are limitations with queries that overlap. However, there are data layout options
available in the Query properties of Excel that can assist with overlapping queries. This
behavior is governed by Excel, not WebFOCUS Quick Data. 

4. Creating Content

Online Help PDF  547



Note: Quick Data is a WebFOCUS Business User Edition option, which requires a separate
license and installation. For more information about licensing Quick Data, contact your
Information Builders representative.

Procedure: How to Create a New Report Query in InfoAssist

1. Open an Excel file.

2. Select a cell in which to place the query results.

3. With the Add-Ins tab selected, click the WebFOCUS option in the Excel menu, and then
click Create Query.

You can also right-click any cell and select Create WebFOCUS Query.

4. In the Web Server Connection dialog box, specify the desired Web Server URL and
connection settings, and then click Next.

Note: Do not end the URL with the / sign.

5. If prompted for sign-in credentials, sign in with your WebFOCUS Business User Edition
login and password.

The next screen opens, where you can select a folder to open a list of available data
sources.

6. Select a folder and click Next.

7. In the Data Source Selection dialog box, select a Master File, as shown in the following
image, and then click Finish.

InfoAssist+ opens, where you can build a query and run it to return the output data to
Excel.
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Example: Creating a New Report Query in InfoAssist

This example covers multiple aspects of creating a new report query using the WebFOCUS
Quick Data tool from an Excel file.

1. Open an Excel file, select a cell in which to place the query results, select the ADD-INS tab,
click the WebFOCUS option in the Excel menu, and select Create Query.

The Web Server Connection dialog box opens.

2. In the Web Server URL field, type the URL for a web server in your reporting environment, or
select one from the drop-down list. An example of a Web Server URL is:

http://localhost:26000

Note: Do not end the URL with the / sign.

3. Click Next.

4. Select a folder to open a list of available data sources. In this example we use the Retail
Samples folder. Click Next.

5. In the Data Source Selection dialog box that opens, select WF_RETAIL_LITE from the Data
Source list, and click Finish.

InfoAssist+ opens.

6. Drag fields from the Data pane to the Query Pane to create a report.

7. On the Home tab, in the Report group, select Column Totals.

After you perform the steps up to this point, the InfoAssist window looks similar to the
following.
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8. Click the Save button.

The report query data is transferred to the Excel file, as shown in the following image.

9. Click the drop-down arrow to the right of the Name Box. You will see named ranges that are
automatically added to the query, as shown in the following image.
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Named ranges are added to the entire data table. The named range for the entire data
table is QDATA1.

10.Select QDATA1 from the Name Box. The data in the table is automatically highlighted.

11.Save the Excel file so that it can be reused in the example on editing an existing report
query.

Ribbon Command Reference

The ribbon is contextual and changes depending on the type of file that you are developing.
This topic describes each of the available ribbons and commands for each InfoAssist+ tool.

Ribbon Commands for Reports

When creating and customizing reports in Report mode, you can use the following ribbons and
commands to customize report functionality.

Home Tab

Command Description

Format Group

Output File Format Displays a drop-down menu of all supported output
formats.

Chart Switches to Chart mode. Converts a report to a chart
using the fields specified in the report.

Report Indicates that you are in Report mode.

File Creates a data file from a report.

Design Group

Query (Design view) Displays the Data, Query, and Filter panes across the
entire canvas, eliminating Live Preview. This view
provides a larger work area for creating the report.

Live Preview (Design view) Displays the report on the canvas as you create the
report. You can use the Live Preview to add, remove, and
arrange fields, as well as style the report.
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Command Description

Document (Design view) Converts a report into a document. Opens the document
on canvas, which you can use to add text, images, lines,
reports, and charts to create documents.

Data from Source Uses the selected data source to display a live preview
of the output on the canvas.

Use Sample Data Displays sample data, which reduces processing time by
eliminating the need to access the actual data source.

Records Limits the number of rows retrieved from the data source
when Live Preview is selected. This feature is useful in
reducing response time if you are working with a large
amount of data. Type the number of rows that you want
directly in the Records field, or use the drop-down menu
to select one of the preset record limits. The preset
choices are All rows, 1, 10, 50, 100, 500, 1000, 2000,
5000, and 10000.

Filter Group

Filter Opens the Filter dialog box for creating filters. Filters
enable you to select only the data that you want and to
exclude unwanted data.

Exclude Turns off a filter.

Include Turns on a filter.

Report Group

Theme Opens a dialog box where you can select a theme to
style your report or chart. You can use the default style
sheet by clicking the Use Default Stylesheet button.

You can also select a document styling theme or an
application theme to style all reports created. Use the
Environment and Styling section of the Options window,
which is accessible by clicking Options in the Application
main menu.
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Command Description

Style Opens a Report Style dialog box for applying global
styling to the entire report. For more information about
styling reports, see Styling Reports on page 610.

Banded Opens a Color dialog box for choosing a color that
provides an alternating color scheme for the report. The
report output displays alternating rows of data, using a
white background for one row and a background of the
selected color for the next row. This pattern continues
throughout the report.

Header & Footer Opens the Header & Footer dialog box, from which you
can add and style headings and footings.

Column Totals Adds a grand total row to the bottom of the report to sum
numeric data in each column.

Row Totals Adds a grand total column to the right side of the report
to sum numeric data in each row.

Format Tab

Command Description

Destination Group

InfoMini Enables the creation of an InfoMini application. For more
information on using InfoMini, see Building InfoMini
Applications on page 506.

Chart Switches to Chart mode. Converts a report to a chart
using the fields specified in the report.

Report Indicates that you are in Report mode.

File Creates a data file from a report.

Navigation Group
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Command Description

Table Generates standard browser output. This is the default.

Table of Contents Generates output by displaying a table of contents icon
in the upper-left corner where report output typically
appears. Clicking Table of Contents opens a menu that
enables you to select (view) individual values of the first
Sort By (By) field, one value at a time.

You can also select options to view the entire report or
remove the table of contents.

Freeze Generates output with column titles that freeze (remain
in view) when you scroll through pages of the report
output.

Pages On Demand Provides access to two distinct features, depending upon
the output type that you have selected.

Features Group

Title Popup Displays pop-up titles when the mouse pointer hovers
over a column title in the report output.

Accordion Creates expandable views of data for each vertical sort
field. This option displays data values only for the first
vertical sort field when you first view the output. You can
manually expand your view to expose the data values of
lower-level sort fields.

Repeat Sort Value Displays all repeated sort values instead of blanks in the
output after the first instance of a new sort value, which
is the default behavior.

Stack Measures Displays all numeric measure field names in a column of
the report output with the corresponding numeric data
values.
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Command Description

active report Options Opens the active report options dialog box where you can
configure your active report options such as menu items,
graph engine, and colors. For more information, see 
Using Active Technologies on page 442.

Accessibility Allows a title to be added to a report, chart, or document
that is Section 508-compliant.

Auto Drill Group

Auto Drill Enables you to navigate through different levels within
the dimension hierarchy of your data source. Click Auto
Drill to enable the functionality. For more information,
see Using Auto Drill on page 703.

Auto Linking Group

Enable Auto Linking Enables auto linking. For more information, see Using the
Auto Linking Feature to Link Content on page 705.

Auto Link Target Sets procedure as an available target for auto linking.

Data Tab

Command Description

Calculation Group

Detail (Define) Opens the Detail Field (DEFINE) dialog box, where you
can create a defined field, type a name for the field, and
enter a format. A Define field is an optional attribute
used to create a virtual field for reporting. You can derive
the virtual field value from information already in the data
source (that is, from permanent fields).

Summary (Compute) Opens the Summary Field (COMPUTE) dialog box, where
you can create a computed field, type a name for the
field, and enter a format.
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Join Group

Join Opens the Join dialog box, where you can create a new
join, edit or delete existing joins, and add data sources
to a join.

Filter Group

Filter Opens the Filter dialog box for creating filters. Filters
enable you to select only the data that you want and to
exclude unwanted data.

Display Group

Missing Data This option is disabled for reports.

Data Source Group

Add Opens the Open dialog box, where you can add additional
data sources to a document, enabling you to insert
reports from different data sources into the same
document. This option is activated when you add a HOLD
file. This option is unavailable, by default.

Switch Opens a drop-down list of all the data sources that have
been added. You can choose which data source is
currently active and being used to create new reports.
This option is activated when you add a HOLD file. This
option is unavailable, by default.

Slicers Tab

Command Description

Options Group

New Group Creates a new group of similar slicers.

Clear Slicers Resets all slicers so that no filtering is done.
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Update Preview Applies slicers to preview.

Options Opens the Edit Slicers dialog box to the General tab,
where you can set general options for your slicers.

Record Limit Group

Preview Sets the number of records retrieved from the data
source for preview.

Run Time Sets the number of records retrieved at run time.

Record Limit Opens the Edit Slicers dialog box to the Record Limit tab,
where you can set record limits for your slicers.

Group Number Group

Group n Contains a group for each Slicer group that is added.
Group 1 is the default slicer group to which you can drag
fields to create slicers. To access slicer group options,
click Group n to open the Edit Slicers dialog box where
you can rename the slicer group and modify the order of
the slicers in the group.

Layout Tab

Command Description

Page Setup Group

Margins Enables you to set margin values by choosing Normal (1
inch all around), Narrow (.5 inch all around), Moderate (.5
inch left or right), Wide (1.5 inch left or right), or Custom.
Choosing Custom opens the Margins dialog box, where
you can set specific margins as needed.

Orientation Enables you to set the orientation of your report to
portrait or landscape.
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Size Enables you to select the size of the paper for printing
output. You can choose A3, A4, A5, Letter, Tabloid,
Legal, PowerPoint, or Large Size (34 x 44 Inches).

Units Enables you to select the unit of measurement used for
customizing the dimension fields of your report. You can
choose Inches, Centimeters, or Points.

Page Numbers Enables you to select page numbering options. You can
choose one of the following:

No Lead (no space for headers)

On (page numbers only in headers)

Off (space for headers, but no page numbering)

The Page Numbers value is overridden by header and
footer text options.

Report Group

Cell Padding Opens the Cell Padding dialog box, where you can set
specific values to control the amount of space inserted
between rows and columns in a report. For more
information, see How to Use Cell Padding in a Report on
page 619.

AutoFit Limits the width of columns in a report to be no wider
than the largest value in each column. AutoFit Column is
selected, by default.

View Tab

Command Description

Design Group
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Query (Design view) Displays the Data, Query, and Filter panes across the
entire canvas, eliminating Live Preview. This view
provides a larger work area for creating the report.

Live Preview (Design view) Displays the report on the canvas as you create the
report. You can use the Live Preview to add, remove, and
arrange fields, as well as style the report.

Document (Design view) Converts a report into a document. Opens the document
on canvas, which you can use to add text, images, lines,
reports, and charts to create documents.

Show/Hide Group

Resources Minimizes the Resources panel and expands the size of
the canvas to also occupy the area where the Resources
panel typically appears. The canvas can display a preview
of a report, output of a report, or the Query Design pane.

Data Panel Group

Logical Displays the data source fields by type. This is the
default view. The Logical view options include Title,
Description, Field, and Alias.

List Displays the data source fields in a tabular list format.
This list contains a header row. You can sort fields
differently by clicking a column header. The List view
options include Title, Description, Field, Alias, Format,
Segment, Filename, and Reference.

Structured Displays the hierarchical structure of the data source
files. The Structured view options include Title,
Description, Field, and Alias.

Query Panel Group

Areas 2x2 Displays data in a two column by two-row grid.

Areas 1x4 Displays data in a one column by four-row grid.
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Tree Displays data in a tree. This is the default.

Output Window Group

Arrange Opens a drop-down menu where you can choose how to
display multiple output windows. The options are
Cascade, Tile Horizontally, and Tile Vertically.

Output Location Opens a drop-down menu where you can choose how to
direct new output. The options are Single tab (default),
New Tab, Single Window, and New Window.

Switch Output Opens a drop-down menu for choosing to view any active
output window.

Report Group

Switch Report Lists any active reports, charts, documents, and visuals
to which you can switch.

Field Tab

Command Description

Filter Group

Filter Opens the Filter dialog box for creating filters. Filters
enable you to select only the data that you want and to
exclude unwanted data.

Exclude Removes, but does not delete, the filter from the report.

Include Restores a filter that was previously excluded from a
report.
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Prompt Opens the Create a filtering condition dialog box for
creating an auto prompting parameter that you can select
when you run a report. The Create a filtering condition
dialog box is used to create both filters and auto
prompting parameters. The following prompt options are
available when Parameter is selected from the Type drop-
down menu:

Simple. This is used for prompts using Text Input.
This is the default value.

Static. This is used for prompts using Selection. This
option allows you to select multiple values at run
time.

Dynamic. This is used for prompts using Data Values.
This option allows you to select multiple values at run
time.

Optional. This is used for prompts using Single or
Multiselect parameters.

Sort Group

Up Sorts the selected field in ascending order. This option is
activated when you click on a measure or dimension.

Down Sorts the selected field in descending order. This option
is activated when you click on a measure or dimension.

Rank Inserts a rank column immediately to the left of the
report if a Sort By field is selected. It also adds a rank
column to the left of the Sort By field if a Measure field is
selected. Ranking a Measure field results in two copies
of the field, the original Measure field, and the Sort By
field that is created during ranking. This option is
activated when you click on a measure or dimension.
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Group Opens the Create a Group dialog box where you can
create a group to combine values together. This option is
activated when you click on a dimension.

Limit Opens a drop-down menu that allows you to specify the
number of unique values to display for a sort group that
has been added. This option is activated when you click
on a measure or dimension.

Break Group

Page Break Starts a new page when the primary sort field changes.
Clicking the drop-down icon enables you to select Reset
Page Numbers, which allows you to reset page numbers
on a page break to start at 1. This option is activated
when you click on a dimension.

Line Break Inserts a line in the report output when the primary sort
field changes. This option is activated when you click on
a dimension.

Subtotal Inserts a line, total text (TOTAL FIELD Value), and
subtotals for all numeric fields when the primary sort
field changes. This option is activated when you click on
a dimension.

Sub Header Opens a dialog box where you can type text to add a
subheading just below the column titles in the report
output when the primary sort field changes. This option is
activated when you click on a dimension.

Sub Footer Opens a dialog box where you can type text to add a
subfooting at the end of the data on each page of the
report output when the primary sort field changes. This
option is activated when you click on a dimension.

Style Group

Font Opens the Font list, which you can use to change the
font.
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Font Size Opens the Font Size list, which you can use to change
the numeric value for the font size.

Font Color Opens the Color dialog box, where you can select the
font color.

Style Reset Resets all settings to the default settings from the
template.

Bold Applies bold font formatting to the selected text.

Italic Applies italic font formatting to the selected text.

Underline Underlines the selected text.

Justify Left Aligns the text to the left of the report.

Justify Center Aligns the text to the center of the report.

Justify Right Aligns the text to the right of the report.

Background Color Opens the Color dialog box, where you can select the
background color for the report.

Data Style Styles only the data for the selected data source field.

Title Style Styles only the column title for the selected data source
field.

Data + Title Styles both the data and the column title for the selected
data source field.

Format Group

Decimal The default value for the data format of the selected
measure is Decimal. Use the drop-down menu to select
Alphanumeric, Integer, or More options to open the Field
Format Options dialog box.

Change currency options Changes the currency options for the selected field. This
option is activated when you click on a measure.
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Percent Specifies the value of the field as a percentage. This
option is activated when you click on a measure.

Comma Specifies the use of commas for the selected field. This
option is activated when you click on a measure.

Increase Decimal Places Increases the number of decimal places that display for
the selected field. This option is activated when you click
on a measure.

Decrease Decimal Places Decreases the number of decimal places that display for
the selected field. This option is activated when you click
on a measure.

Display Group

Hide Field Allows you to hide a selected field.

Hide Missing Allows you to hide fields that have no value.

Aggregation Enables you to apply an aggregation function to a field in
a report. Opens a drop-down menu of the following
options: None (default), Sum, Average, Count, Count
Distinct, Percent of Count, First Value, Last Value,
Maximum, Minimum, Total, Percent, Row Percent,
Median, Average Square.

Traffic Lights Opens the Traffic Light Condition dialog box. From this
dialog box, you can add new conditional styling by
applying traffic light (and other) colors to a selected field
in the output when the field meets specified criteria,
modify existing conditional styling, and enable conditional
drill-down.

Data Bars Adds a data visualization column to the right of a
selected numeric field. The column displays values in
each row using horizontal bars that extend from left to
right in varying lengths, depending on the corresponding
data values.
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Within Allows you to use specific aggregation tasks at different
report levels. You can use the Within phrase to
manipulate display field values as they are aggregated
within a sort group rather than a report column.

Column(s) This option is disabled for reports.

Links Group

Drill Down Opens the Drill Down dialog box, where you can configure
a hyperlink or a drill-down procedure for the selected
field. Clicking that field in the report output, at run time,
redirects you to the URL you specified or executes the
indicated procedure.

Ribbon Commands for Charts

When creating and customizing charts in Chart mode, you can use the following ribbons and
commands to customize chart functionality.

Home Tab

Command Description

Format Group

Output File Format Displays a drop-down menu of all supported output
formats.

Chart Indicates that you are in Chart mode.

Report Switches to Report mode. Converts a chart to a report
using the fields specified in the chart.

File Creates an image file from a chart. This option is
disabled by default and is only enabled for HTML format.

Design Group
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Query (Design view) Displays the Data, Query, and Filter panes across the
entire canvas, eliminating Live Preview. This view
provides a larger work area for creating the chart.

Live Preview (Design view) Displays the chart on the canvas as you create the chart.
You can use the Live Preview to add, remove, and
arrange fields, as well as style the chart.

Document (Design view) Opens the document on canvas, which you can use to
add text, images, lines, reports, and charts to create
documents.

Data from Source Uses the selected data source to display a live preview
of the output on the canvas.

Use Sample Data Displays sample data, which reduces processing time by
eliminating the need to access the actual data source.

Records Limits the number of rows retrieved from the data source
when Live Preview is selected. This feature is useful in
reducing response time if you are working with a large
amount of data. Type the number of rows that you want
directly in the Records field, or use the drop-down menu
to select one of the preset record limits. The preset
choices are All rows, 1, 10, 50, 100, 500, 1000, 2000,
5000, and 10000.

Filter Group

Filter Opens the Filter dialog box for creating filters. Filters
enable you to select only the data that you want and to
exclude unwanted data.

Exclude Turns off a filter.

Include Turns on a filter.

Report Group
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Theme Opens a dialog box where you can select a theme to
style your report or chart. You can use the default style
sheet by clicking the Use Default Stylesheet button.

You can also select a document styling theme or an
application theme to style all reports created. Use the
Environment and Styling section of the Options window,
which is accessible by clicking Options in the Application
main menu.

Style This option is disabled for charts.

Banded This option is disabled for charts.

Header & Footer Opens the Header & Footer dialog box, from which you
can add and style headings and footings.

Column Totals This option is disabled for charts.

Row Totals This option is disabled for charts.

Format Tab

Command Description

Destination Group

InfoMini Enables the creation of an InfoMini application. For more
information on using InfoMini, see Building InfoMini
Applications on page 506.

Chart Indicates that you are in Chart mode.

Report Switches to Report mode. Converts a chart to a report
using the fields specified in the chart.

File Creates an image file from a chart. This option is
disabled by default and is only enabled for HTML format.
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Chart Types Group

Bar Changes the chart type to a bar chart.

Pie Changes the chart type to a pie chart.

Line Changes the chart type to a line chart.

Area Changes the chart type to an area chart.

Scatter Changes the chart type to a scatter chart.

Choropleth Changes the chart type to a choropleth map.

Proportional Symbol Changes the chart type to a proportional symbol (bubble)
map.

Other Opens the Select a chart dialog box. The chart types,
depicted by icons, display on the left side of the dialog
box. The first chart type represents the bar chart
category, which is selected by default. When a chart type
is selected, the dialog box displays thumbnail images of
bar chart variations that are supported.

Map Group

Background Provides terrain options and various other geographical
views. This option only displays when a map is selected
as the chart type.

Demographic Layers Allows you to apply one or more pre-defined demographic
layers, which can narrow the scope of your data using
these underlying layers of demographic categorization.
This option only displays when a map is selected as the
chart type.

Reference Layers Enables you to define one or more reference layers,
which creates borders based on your geographical
selection. This option only displays when a map is
selected as the chart type.
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Features Group

3D Effect Sets the three-dimensional view to on or off. The 3D
Effect feature is disabled for 3D, stock, gauge, gauge
thermometer, Pareto, spectral map, and funnel chart
types. This is the default. This option is not available for
maps.

Rotate Toggles between a vertical display or horizontal display of
a chart. For more information, see How to Rotate a Chart
on page 694. The Rotate feature is disabled for pie,
scatter, 3D, stock, gauge, gauge thermometer, Pareto,
spectral map, and funnel chart types. This option is not
available for maps.

Reference Opens a drop-down menu that provides the Add
Reference Line to Y-Axis and Add Reference Line to X-
Axis options. Selecting one of these options opens the
appropriate Reference Line dialog box, where you can set
the specific X-axis or Y-axis value, type the text that you
want, and position the reference line on a chart. For
more information, see How to Display a Static Reference
Line on page 694. The Reference feature is disabled
for pie, 3D, stock, gauge, gauge thermometer, Pareto,
spectral map, and funnel chart types. This option is not
available for maps.

Annotate Opens a drop-down menu that provides the Add an
annotation option. Selecting this option opens the
Annotation dialog box, where you can type the text that
you want and position the annotation on a chart. For
more information, see How to Display Annotations on
page 697.

The annotation option is not available in HTML5. This
option is not available for maps.
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Grid Opens a drop-down menu allowing you to expand options
for Horizontal or Vertical Gridlines. Both selections allow
you to enable or disable Major and Minor Gridlines.
Clicking More Options opens the Format Grid Lines dialog
box. This option is not available for maps. For more
information, see Formatting Gridlines on page 653.

Frame & Background Opens the Frame & Background dialog box where you can
edit the background style and frames for charts. The
dialog contains different options depending on the chart
type selected. This option is not available for maps. For
more information, see Formatting a Frame and a
Background on page 672.

Narrative Adds narration to your chart. This option must be
enabled by an administrator.

Gauges Opens the Gauge dialog box where you can edit your
gauge chart. This button is only available when a gauge
chart type is selected. This option is not available for
maps. For more information, see How to Style a Gauge
Needle on page 689.

active report Options Opens the active report options dialog box where you can
configure your active report options, such as menu
items, graph engine, and colors. This button is available
when the output type is set to active report. This option
is not available for maps.

Accessibility Allows a title to be added to a report, chart, or document
that is Section 508 compliant. This option is only
available for reports and charts when the output type is
HTML or PDF. For documents, the output type must be
set to PDF.

The chart features are unavailable when designing a
chart that will be output in active report format. This
option is not available for maps.
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Labels Group

Axes Opens a drop-down menu, where you can enable and
rotate horizontal and vertical axis labels, and stagger
horizontal axis labels. You can also edit the axis labels
by clicking More Horizontal Axis Options or More Vertical
Axis Options. For more information, see Formatting Axis
Labels on page 663. This option is not available for
maps.

Legend Opens a drop-down menu, where you can select the
Show Legend option to display the legend on the chart,
or clear your selection to hide the legend, change the
default legend position, and change the default legend
orientation. For more information, see Format Legend
Dialog Box on page 648. This option is not available for
maps.

Interactive Group

Interactive Options Opens the Interactive Options dialog box, which enables
you to specify animation and mouse over effects in your
chart. This option is only available for HTML5 and active
outputs. This option is not available for maps.

Auto Drill Group

Auto Drill Enables you to navigate through different levels within
the dimension hierarchy of your data source. Click Auto
Drill to enable the functionality.

Note: Auto Drill functionality requires the specification of
at least one dimension sort field in the request.

For more information, see Using Auto Drill on page
703.

Auto Linking Group

Enable Auto Linking Enables auto linking.

4. Creating Content

Online Help PDF  571



Command Description

Auto Link Target Sets procedure as an available target for auto linking.

Data Tab

Command Description

Calculation Group

Detail (Define) Opens the Detail Field (DEFINE) dialog box, where you
can create a defined field, type a name for the field, and
enter a format. A Define field is an optional attribute
used to create a virtual field for reporting. You can derive
the virtual field value from information already in the data
source (that is, from permanent fields).

Summary (Compute) Opens the Summary Field (COMPUTE) dialog box, where
you can create a computed field, type a name for the
field, and enter a format.

Join Group

Join Opens the Join dialog box, where you can create a new
join, edit or delete existing joins, and add data sources
to a join.

Filter Group

Filter Opens the Filter dialog box, enabling you to set filtering
options. Filter options include Where, Where Total, the
And conjunction, and the Or conjunctions in a single
expression.

Display Group

Missing Data Includes options for how to display missing values in
charts.

Data Source Group
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Add Opens the Open dialog box, where you can add additional
data sources to a document, enabling you to insert
reports from different data sources into the same
document. This option is only enabled if the chart was
created from a HOLD file.

Switch Opens a drop-down list of all the data sources that have
been added. You can choose which data source is
currently active and being used to create new reports.
This option is only enabled if the chart was created from
a HOLD file.

Slicers Tab

Command Description

Options Group

New Group Creates a new group of similar slicers.

Clear Slicers Resets all slicers so that no filtering is done.

Update Preview Applies slicers to preview.

Options Opens the Edit Slicers dialog box to the General tab,
where you can set general options for your slicers.

Record Limit Group

Preview Sets the number of records retrieved from the data
source for preview.

Run Time Sets the number of records retrieved at run time.

Record Limit Opens the Edit Slicers dialog box to the Record Limit tab,
where you can set record limits for your slicers.

Group Number Group
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Group n Contains a group for each Slicer group that is added.
Group 1 is the default slicer group to which you can drag
fields to create slicers. To access slicer group options,
click Group n to open the Edit Slicers dialog box where
you can rename the slicer group and modify the order of
the slicers in the group.

Layout Tab

Command Description

Page Setup Group

Margins Enables you to set margin values by choosing Normal (1
inch all around), Narrow (.5 inch all around), Moderate (.5
inch left or right), Wide (1.5 inch left or right), or Custom.
Choosing Custom opens the Margins dialog box, where
you can set specific margins as needed.

Orientation Enables you to set the orientation of your report to
portrait or landscape.

Size Enables you to select the size of the paper for printing
output. You can choose A3, A4, A5, Letter, Tabloid,
Legal, PowerPoint, or Large Size (34 x 44 Inches).

Units Enables you to select the unit of measurement used for
customizing the dimension fields of your report or chart.
You can choose Inches, Centimeters, or Points.

Page Numbers This option is disabled for charts.

Size & Arrange Group

Height Sets the height of the chart.

Width Sets the width of the chart.
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Auto Overflow This option is disabled for charts.

Aspect Ratio Lock the height and width aspect ratio. With the aspect
ratio locked, changing the width automatically changes
the height to keep the component to scale, and changing
the height automatically changes the width.

AutoFit Expands the chart, at design time, when additional fields
are added. At run time, the chart is resized dynamically
to fit into the container in which it is placed. AutoFit is
enabled, by default.

Align This option is available in Document mode only.

Relative Position This option is available in Document mode only.

View Tab

Command Description

Design Group

Query (Design view) Displays the Data, Query, and Filter panes across the
entire canvas, eliminating Live Preview. This view
provides a larger work area for creating the chart.

Live Preview (Design view) Displays the chart on the canvas as you create the
report. You can use the Live Preview to add, remove, and
arrange fields, as well as style the chart.

Document (Design view) Converts a chart into a document. Opens the document
on canvas, which you can use to add text, images, lines,
reports, and charts to create documents.

Show/Hide Group
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Resources Minimizes the Resources panel and expands the size of
the canvas to also occupy the area where the Resources
panel typically appears. The canvas can display a preview
of a report, output of a report, or the Query Design pane.

Data Panel Group

Logical Displays the data source fields by type. This is the
default view. The Logical view options include Title,
Description, Field, and Alias.

List Displays the data source fields in a tabular list format.
This list contains a header row. You can sort fields
differently by clicking a column header. The List view
options include Title, Description, Field, Alias, Format,
Segment, Filename, and Reference.

Structured Displays the hierarchical structure of the data source
files. The Structured view options include Title,
Description, Field, and Alias.

Query Panel Group

Areas 2x2 Displays data in a two column by two-row grid. This
option is disabled for charts that use the new field
container syntax.

Areas 1x4 Displays data in a one column by four-row grid. This
option is disabled for charts that use the new field
container syntax.

Tree Displays data in a tree. This is the default.

Output Window Group

Arrange Opens a drop-down menu where you can choose how to
display multiple output windows. The options are
Cascade, Tile Horizontally, and Tile Vertically.

Ribbon Command Reference

576  Information Builders



Command Description

Output Location Opens a drop-down menu where you can choose how to
direct new output. The options are Single tab (default),
New Tab, Single Window, and New Window.

Switch Output Opens a drop-down menu for choosing to view any active
output window.

Report Group

Switch Report Lists any active report or chart to which you can switch.

Field Tab

Note: The Format group is disabled in Chart mode.

Command Description

Filter Group

Filter Opens the Filter dialog box for creating filters. Filters
enable you to select only the data that you want and to
exclude unwanted data.

Exclude Removes, but does not delete, the filter from the chart.

Include Restores a filter that was previously excluded from a
chart.
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Prompt Opens the Create a filtering condition dialog box for
creating an auto prompting parameter that you can select
when you run a chart. The Create a filtering condition
dialog box is used to create both filters and auto
prompting parameters. The following prompt options are
available when Parameter is selected from the Type drop-
down menu:

Simple. This is used for prompts using Text Input.
This is the default value.

Static. This is used for prompts using Selection. This
option allows you to select multiple values at run
time.

Dynamic. This is used for prompts using Data Values.
This option allows you to select multiple values at run
time.

Optional. This is used for prompts using Single or
Multiselect parameters.

Sort Group

Up Sorts the selected field in ascending order.

Down Sorts the selected field in descending order.

Rank This option is disabled for charts.

Group Opens the Create a Group dialog box where you can
create a group to combine values together. This option is
enabled for dimension fields only.

Limit Opens a drop-down menu that allows you to specify the
number of unique values to display for a sort group that
has been added.

Format Group

Note: These options are disabled for charts.
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Display Group

Hide Field Allows you to hide a selected field.

Hide Missing Allows you to hide fields that have no value. This option
is disabled for charts.

Aggregation Opens a drop-down menu of the following options: None
(default), Sum, Average, Count, Count Distinct, Percent
of Count, First Value, Last Value, Maximum, Minimum,
Total, Percent, Row Percent, Median, Average Square.
This option is only available for measure fields or
dimensions (alpha field only) that are in a numeric field
container. Otherwise, aggregations will not display.

Traffic Lights Opens the Traffic Light Condition dialog box. From this
dialog box, you can add new conditional styling by
applying traffic light (and other) colors to a selected field
in the output when the field meets specified criteria,
modify existing conditional styling, and enable conditional
drill-down. This option is only available for measure
fields.

Data Bars This option is disabled for charts.

Within Allows you to use specific aggregation tasks at different
report levels. You can use the Within phrase to
manipulate display field values as they are aggregated
within a sort group rather than a report column. This
option is disabled for charts.

Column(s) Allows you to indicate the number of columns in which
you wish to display multiple graphs. The value can be
between 1 and 512. The default is 1. This option is also
available from the Query Design pane shortcut menu for
a Multi-graph component. This option is only enabled
when the multi-graph field container is populated.

Links Group
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Command Description

Drill Down Opens the Drill Down dialog box, where you can configure
a hyperlink or a drill-down procedure for the selected
field. Clicking that field in the report output, at run time,
redirects you to the URL you specified or executes the
indicated procedure. This option is available for measure
fields only. If you are working in PDF format, this option is
disabled.

Series Tab

Command Description

Select Group

Series drop-down list Lists the available series in the current chart.

Style Group

Style Opens the Format Series dialog box, where you can edit
the styling options for the selected series. You can also
open this dialog box by right-clicking a series, and then
clicking More Style Options.

Properties Group

Data Labels Adds data labels to the chart. The drop-down menu
contains the following data position options for selecting
where to display data values as labels on a chart: Above
(default), On top edge, Below top edge, Center, and
Base. If you are working with a Pie chart, the options are:
On Slice, Outside Slice, and Outside with feeler lines.

Clicking More Data Label Options opens the Format
Labels dialog box, where you can further edit your data
labels.
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Command Description

Type Opens a drop-down menu with the following options for
selecting different chart types: None (default), Bar, Line,
and Area.

Note: When you make a change to the chart type using
the Type button on the Series tab, changes to the chart
type on the Format tab are overwritten.

Trendline Opens a drop-down menu that provides options for
adding a trendline to a chart.

Equation Displays the associated mathematical equation for the
selected trendline on the chart.

The equation is not available in HTML5.

Line Group

Smooth Line Draws the chart using smooth lines.

Connect Lines Controls the display of connecting lines between markers
on a line or scatter chart. By default, lines are connected
on a line chart and disconnected on a scatter chart.

Marker Opens a drop-down menu from which you can select
options to change the display of the default data and
legend markers on line and scatter chart types. For more
information, see How to Change the Appearance of a
Marker on page 635.

Pie Group

Note: The following options are only enabled when you are working with a pie chart.

Expand Expands pie slices.

Hide Hides pie slices.

4. Creating Content

Online Help PDF  581



Ribbon Commands for Documents

When creating and customizing documents in Document mode, you can use the following
ribbons and commands to customize document functionality.

Home Tab

Command Description

Format Group

Output File Format Displays a drop-down menu of all supported output
formats.

Chart Determines whether chart-specific functionality is
available in the InfoAssist+ tool. The default name Chart
(data source) is given for each new chart created in a
given InfoAssist+ session, where data source is the
name of the underlying data source you are using. You
can rename the chart by right-clicking Chart in the Query
pane and clicking Rename.

Report Determines whether report-specific functionality is
available in the InfoAssist+ tool. The default name
Report (data source) is given for each new report created
in a given InfoAssist+ session, where data source is the
name of the underlying data source you are using. You
can rename the report by right-clicking Report in the
Query pane and clicking Rename.

File Creates a data file from a report component of a
document.

Design Group

Query (Design view) This option is disabled in Document mode.

Live Preview (Design view) This option is disabled in Document mode.
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Command Description

Document (Design view) Once you are in Document mode, it is selected by default
in the Design group. The document displays on the
canvas, to which you can add text, images, lines,
reports, and charts.

Data from Source Uses the selected data source to display a live preview
of the output on the canvas.

Use Sample Data Displays sample data, which reduces processing time by
eliminating the need to access the actual data source.

Records Limits the number of rows retrieved from the data source
when Live Preview is selected. This feature is useful in
reducing response time if you are working with a large
amount of data. Type the number of rows that you want
directly in the Records field, or use the drop-down menu
to select one of the preset record limits. The preset
choices are All rows, 1, 10, 50, 100, 500, 1000, 2000,
5000, and 10000.

Filter Group

Filter Opens the Filter dialog box for creating filters. Filters
enable you to select only the data that you want and to
exclude unwanted data.

Exclude Turns off a filter.

Include Turns on a filter.

Clipboard Group

Paste Enables you to paste a text, report, or chart object that
you have copied to or placed on the clipboard.

Cut Enables you to cut a text, report, or chart object from
your document, placing it on the clipboard.

Copy Enables you to copy a text, report, or chart object to the
clipboard.
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Command Description

Duplicate Enables you to duplicate a text, report, or chart object in
your document, placing it on the clipboard.

Report Group

Theme Opens a dialog box where you can select a theme to
style your report or chart. You can use the default style
sheet by clicking the Use Default Stylesheet button.

You can also select a document styling theme or an
application theme to style all reports created. Use the
Environment and Styling section of the Options window,
which is accessible by clicking Options in the Application
main menu.

Style Opens a Report Style dialog box for applying global
styling to the entire report. This option is disabled for
charts in Document mode. For more information about
styling reports, see Styling Reports on page 610.

Banded Opens a Color dialog box for choosing a color that
provides an alternating color scheme for the report. The
report output displays alternating rows of data, using a
white background for one row and a background of the
selected color for the next row. This pattern continues
throughout the report. This option is disabled for charts
in Document mode.

Header & Footer Opens the Header & Footer dialog box, from which you
can add and style headings and footings.

Column Totals Adds a grand total row to the bottom of the report to sum
numeric data in each column. This option is disabled for
charts in Document mode.

Row Totals Adds a grand total column to the right side of the report
to sum numeric data in each row. This option is disabled
for charts in Document mode.
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Insert Tab

Command Description

Pages Group

Page Adds a new page to a document.

Reports Group

Report Inserts a report placeholder on the canvas.

Chart Inserts a chart placeholder on the canvas.

Existing Report Opens the Open dialog box, where you can browse to the
report that you want to insert in the upper-left corner of
the canvas.

Objects Group

Text Box Inserts an inline text object in the upper-left corner of the
canvas.

Image Opens the Open dialog box, where you can browse to the
image that you want to insert in the upper-left corner of
the canvas.

active dashboard Prompts group

Drop Down Inserts a drop-down control placeholder in the upper-left
corner of the canvas.

List Inserts a list control placeholder in the upper-left corner
of the canvas.

Checkbox Inserts a check box control placeholder in the upper-left
corner of the canvas.

Radio Button Inserts a radio button control placeholder in the upper-
left corner of the canvas.

Text Inserts a text area control placeholder in the upper-left
corner of the canvas.
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Format Tab

Command Description

Destination Group

InfoMini Enables the creation of an InfoMini application. For more
information on using InfoMini, see Building InfoMini
Applications on page 506.

Report Makes report-specific functionality available. In
Document mode, if you select a report object, the Report
option is enabled on the Home tab and the ribbon
options change. For more information, see Ribbon
Commands for Reports on page 551.

Chart Makes chart-specific functionality available. In Document
mode, if you select a chart object, the Chart option is
enabled on the Home tab and the ribbon options change.
For more information, see Ribbon Commands for Charts
on page 565.

File Creates a data file from a report component of a
document.

Navigation Group

Table Generates standard browser output. This is the default.
This option is only available for reports in Document
mode.

Table of Contents Generates output by displaying a table of contents icon
in the upper-left corner where report output typically
appears. Clicking Table of Contents opens a menu that
enables you to select (view) individual values of the first
Sort By (By) field, one value at a time.

You can also select options to view the entire report or
remove the table of contents. This option is unavailable
for charts in Document mode, and is disabled for reports
in Document mode.
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Freeze Generates output with column titles that freeze (remain
in view) when you scroll through pages of the report
output. This option is unavailable for charts in Document
mode, and is disabled for reports in Document mode.

Pages On Demand Provides access to two distinct features depending upon
the output type that you have selected. This option is
available for reports in Document mode.

Features Group

Title Popup Displays pop-up titles when the mouse pointer hovers
over a column title in the report output.

Accordion Creates expandable views of data for each vertical sort
field. This option displays data values only for the first
vertical sort field when you first view the output. You can
manually expand your view to expose the data values of
lower-level sort fields.

Repeat Sort Value Displays all repeated sort values instead of blanks in the
output after the first instance of a new sort value, which
is the default behavior.

Stack Measures Displays all numeric measure field names in a column of
the report output with the corresponding numeric data
values.

active report Options Opens the active report options dialog box where you can
configure your active report options such as menu items,
graph engine, and colors. For more information, see 
Using Active Technologies on page 442.

Accessibility Allows a title to be added to a report, chart, or document
that is Section 508-compliant.

Auto Drill Group

Auto Drill This option is disabled in Document mode.
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Data Tab

Command Description

Calculation Group

Detail (Define) Opens the Detail Field (DEFINE) dialog box, where you
can create a defined field, type a name for the field, and
enter a format. A Define field is an optional attribute
used to create a virtual field for reporting. You can derive
the virtual field value from information already in the data
source (that is, from permanent fields).

Summary (Compute) Opens the Summary Field (COMPUTE) dialog box, where
you can create a computed field, type a name for the
field, and enter a format.

Join Group

Join Opens the Join dialog box, where you can create a new
join, edit or delete existing joins, and add data sources
to a join.

Filter Group

Filter Opens the Filter dialog box, enabling you to set filtering
options. Filter options include Where, Where Total, the
And conjunction, and the Or conjunctions in a single
expression.

Display Group

Missing Data Includes options for how to display missing values in
charts.

Data Source Group

Add Opens the Open dialog box, where you can add additional
data sources to a document, enabling you to insert
reports from different data sources into the same
document.
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Command Description

Switch Opens a drop-down list of all the data sources that have
been added. You can choose which data source is
currently active and being used to create new reports.

Slicers Tab

Command Description

Options Group

New Group Creates a new group of similar slicers.

Clear Slicers Resets all slicers so that no filtering is done.

Update Preview Applies slicers to preview.

Record Limit Group

Preview Sets the number of records retrieved from the data
source for preview.

Run Time Sets the number of records retrieved at run time.

Group Number Group

Group n Contains a group for each Slicer group that is added.
Group 1 is the default slicer group to which you can drag
fields to create slicers.

Layout Tab

Command Description

Page Setup Group

Margins This option is disabled in Document mode.

4. Creating Content

Online Help PDF  589



Command Description

Orientation Enables you to set the orientation of your report to
portrait or landscape.

Size Enables you to select the size of the paper for printing
output. You can choose A3, A4, A5, Letter, Tabloid,
Legal, PowerPoint, or Large Size (34 x 44 Inches).

Units Enables you to select the unit of measurement used for
customizing the dimension fields of your report or chart.
You can choose Inches, Centimeters, or Points.

Page Numbers Enables you to select page numbering options. You can
choose one of the following:

No Lead (no space for headers)

On (page numbers only in headers)

Off (space for headers, but no page numbering)

The Page Numbers value is overridden by header and
footer text options.

Size & Arrange Group

Height Sets the height of the selected document component.

Width Sets the width of the selected document component.

Auto Overflow Automatically expands the query area to show all data.

Aspect Ratio Lock the height and width aspect ratio.

AutoFit In Document mode, this option is disabled.

Align Opens a drop-down menu of available alignment options,
when two or more document components are selected.

Relative Position Positions the top-left corner of the lower component, to
the bottom-left corner of the higher component, when two
or more document components are selected.
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Command Description

Size and Arrange Opens the Size and Position dialog box where you can
set size and position options for the object in your
document.

Report Group

Cell Padding Opens the Cell Padding dialog box, where you can set
specific values to control the amount of space inserted
between rows and columns in a report. For more
information, see How to Use Cell Padding in a Report on
page 619.

Autofit Column When working with a report component, this option
automatically compresses the columns in the report to
the width of the widest data instance. Autofit Column is
selected, by default.

View Tab

Command Description

Design Group

Query (Design view) This option is unavailable in Document mode.

Live Preview (Design view) This option is unavailable in Document mode.

Document Enables Document mode by default.

Show/Hide Group

Resources Minimizes the Resources panel and expands the size of
the canvas to also occupy the area where the Resources
panel typically appears. The canvas can display a preview
of a report, output of a report, or the Query Design pane.

Ruler Displays a ruler above the canvas and to the left of the
canvas for a document.
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Command Description

Grid Displays a grid as a visual aid for aligning objects in a
document.

Relationships Shows the relative positioning relationship among
objects.

Data Panel Group

Logical Displays the data source fields by type. This is the
default view. The Logical view options include Title,
Description, Field, and Alias.

List Displays the data source fields in a tabular list format.
This list contains a header row. You can sort fields
differently by clicking a column header. The List view
options include Title, Description, Field, Alias, Format,
Segment, Filename, and Reference.

Structured Displays the hierarchical structure of the data source
files. The Structured view options include Title,
Description, Field, and Alias.

Query Panel Group

Areas 2x2 Displays data in a two column by two-row grid. When
working with the new field container syntax, this option is
unavailable.

Areas 1x4 Displays data in a one column by four-row grid. When
working with the new field container syntax, this option is
unavailable.

Tree Displays data in a tree. This is the default.

Output Window Group

Arrange Opens a drop-down menu where you can choose how to
display multiple output windows. The options are
Cascade, Tile Horizontally, and Tile Vertically.
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Command Description

Output Location Opens a drop-down menu where you can choose how to
direct new output. The options are Single tab (default),
New Tab, Single Window, and New Window.

Switch Output Opens a drop-down menu for choosing to view any active
output window.

Report Group

Switch Report Lists any active report or chart to which you can switch.

Field Tab

Command Description

Filter Group

Filter Opens the Filter dialog box for creating filters. Filters
enable you to select only the data that you want and to
exclude unwanted data.

Exclude Removes, but does not delete, the filter from the report
or chart.

Include Restores a filter that was previously excluded from a
report or chart.
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Command Description

Prompt Opens the Create a filtering condition dialog box for
creating an auto prompting parameter that you can select
when you run a report. The Create a filtering condition
dialog box is used to create both filters and auto
prompting parameters. The following prompt options are
available when Parameter is selected from the Type drop-
down menu:

Simple. This is used for prompts using Text Input.
This is the default value.

Static. This is used for prompts using Selection. This
option allows you to select multiple values at run
time.

Dynamic. This is used for prompts using Data Values.
This option allows you to select multiple values at run
time.

Optional. This is used for prompts using Single or
Multiselect parameters.

Sort Group

Up Sorts the selected field in ascending order.

Down Sorts the selected field in descending order.

Rank Inserts a rank column immediately to the left of the
report if a Sort By field is selected. It also adds a rank
column to the left of the Sort By field if a Measure field is
selected. Ranking a Measure field results in two copies
of the field, the original Measure field, and the Sort By
field that is created during ranking.

Group Opens the Create a Group dialog box where you can
create a group to combine values together.
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Limit Opens a drop-down menu that allows you to specify the
number of unique values to display for a sort group that
has been added.

Break Group

Page Break Starts a new page when the primary sort field changes.
Clicking the drop-down icon enables you to select Reset
Page Numbers, which allows you to reset page numbers
on a page break to start at 1.

Line Break Inserts a line in the report output when the primary sort
field changes.

Subtotal Inserts a line, total text (TOTAL FIELD Value), and
subtotals for all numeric fields when the primary sort
field changes.

Sub Header Opens a dialog box where you can type text to add a
subheading just below the column titles in the report
output when the primary sort field changes.

Sub Footer Opens a dialog box where you can type text to add a
subfooting at the end of the data on each page of the
report output when the primary sort field changes.

Style Group

Note: The options in this group are only available for reports in Document mode.

Font Opens the Font list, which you can use to change the
font.

Font Size Opens the Font Size list, which you can use to change
the numeric value for the font size.

Font Color Opens the Color dialog box, where you can select the
font color.

Style Reset Resets all settings to the default settings from the
template.
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Command Description

Bold Applies bold font formatting to the selected text.

Italic Applies italic font formatting to the selected text.

Underline Underlines the selected text.

Justify Left Aligns the text to the left of the visual.

Justify Center Aligns the text to the center of the visual.

Justify Right Aligns the text to the right of the visual.

Background Color Opens the Color dialog box, where you can select the
background color for the visual.

Data Style Styles only the data for the selected data source field.

Title Style Styles only the column title for the selected data source
field.

Data + Title Styles both the data and the column title for the selected
data source field.

Format Group

Note: The options in this group are only available for reports in Document mode.

Change currency options Changes the currency options for the selected field.

Percent Specifies the value of the field as a percentage.

Comma Specifies the use of commas for the selected field.

Increase Decimal Places Increases the number of decimal places that display for
the selected field.

Decrease Decimal Places Decreases the number of decimal places that display for
the selected field.

Display Group

Hide Field Allows you to hide a selected field.
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Command Description

Hide Missing Allows you to hide fields that have no value.

Aggregation Opens a drop-down menu of the following options: None
(default), Sum, Average, Count, Count Distinct, Percent
of Count, First Value, Last Value, Maximum, Minimum,
Total, Percent, Row Percent, Median, Average Square.

Traffic Lights Opens the Traffic Light Condition dialog box. From this
dialog box, you can add new conditional styling by
applying traffic light (and other) colors to a selected field
in the output when the field meets specified criteria,
modify existing conditional styling, and enable conditional
drill-down.

Within Allows you to use specific aggregation tasks at different
report levels. You can use the Within phrase to
manipulate display field values as they are aggregated
within a sort group rather than a report column.

Data Bars Adds a data visualization column to the right of a
selected numeric field. The column displays values in
each row using horizontal bars that extend from left to
right in varying lengths, depending on the corresponding
data values.

Column(s) Allows you to indicate the number of columns in which
you wish to display multiple graphs. The value can be
between 1 and 512. The default is 1. This option is also
available from the Query Design pane shortcut menu for
a Multi-graph component.

Links Group
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Command Description

Drill Down Opens the Drill Down dialog box, where you can configure
a hyperlink or a drill-down procedure for the selected
field. Clicking that field in the report output, at run time,
redirects you to the URL you specified or executes the
indicated procedure. This option is disabled in Document
mode.

Series Tab

In Document mode, the Series tab is enabled for chart components.

Command Description

Select Group

Series drop-down list Lists the available series in the current chart.

Style Group

Style Opens the Format Series dialog box, where you can edit
the styling options for the selected series. You can also
open this dialog box by right-clicking a series, and then
clicking More Style Options.

Properties Group

Data Labels Adds data labels to the chart. The drop-down menu
contains the following data position options for selecting
where to display data values as labels on a chart: Above
(default), On top edge, Below top edge, Center, and
Base. If you are working with a Pie chart, the options are:
On Slice, Outside Slice, and Outside with feeler lines.

Clicking More Data Label Options opens the Format
Labels dialog box, where you can further edit your data
labels.

Trendline Opens a drop-down menu that provides options for
adding a trendline to a chart.
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Command Description

Line Group

Smooth Line Draws the chart using smooth lines.

Connect Lines Controls the display of connecting lines between markers
on a line or scatter chart. By default, lines are connected
on a line chart and disconnected on a scatter chart.

Marker Opens a drop-down menu from which you can select
options to change the display of the default data and
legend markers on line and scatter chart types. For more
information, see How to Change the Appearance of a
Marker on page 635.

Pie group

Note: The following options are only enabled when you are working with a pie chart.

Expand Expands pie slices.

Hide Hides pie slices.

Ribbon Commands for Visualizations

When creating and customizing visualizations in Visualizations mode, you can use the following
ribbons and commands to customize visualization functionality.

Home Tab

Command Description

Clipboard Group

Paste Enables you to paste a text, report, or chart object that
you have copied to or placed on the clipboard.

Cut Enables you to cut a text, report, or chart object from
your document, placing it on the clipboard.
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Command Description

Copy Enables you to copy a text, report, or chart object to the
clipboard.

Duplicate Enables you to duplicate a text, report, or chart object in
your document, placing it on the clipboard.

Data Group

Calculation Opens a menu from which you can choose to create
Define or Compute fields.

Join Opens the Join dialog box, where you can create a new
join, edit or delete existing joins, and add data sources
to a join. You can also create blends, which allow you to
combine data from local or system resources into your
current data source.

Visual Group

Insert Inserts a new visual. The left side of the Insert button
inserts the default visual, which is a stacked bar chart.
Click the down arrow next to the Insert button to specify
a visual type, such as a chart, grid, or text.

Change Opens the Select a Visual menu, from which you can
select the type of chart, map, or grid that you want to
add to your visualization.
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Command Description

Swap Changes the vertical or horizontal orientation of data in a
visual. When you add one or more fields to the canvas,
Swap is enabled. When you have data fields in the
vertical and horizontal field containers, clicking Swap
switches the axis of these data fields to display on the
opposite axis. When working with matrix charts, the rows
and columns are similarly switched when you click Swap.
Swap is available for bar, line, area, scatter, bubble, and
matrix marker charts. It is also available for grids.

Note:

Swap is disabled when the canvas is empty.

Swap is unavailable for maps.

Clear Clears the current visual. You can use the split button to
select the option to clear a component, or the entire
visualization, which clears all visuals on the canvas. If
you have created a filter, you can also clear it. The Clear
button is disabled until you begin developing a visual on
the canvas.

Storyboard Group

Add Takes a snapshot of the current visual or visualization,
adding it to the storyboard.

Show Opens your storyboard as a PowerPoint presentation,
where you can choose to view or save your storyboard.
All storyboards display in Microsoft PowerPoint format.

Format Tab

Command Description

Report Group
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Command Description

Theme Opens the Templates dialog box, where you can select a
theme to style your grid. You can use the default style
sheet by clicking the Use Default Stylesheet button.

You can also select a styling theme for your grid or an
application theme to style all visualizations created.

Header & Footer Opens the Header & Footer dialog box, from which you
can add and style headings and footings.

Column Totals Adds a grand total row to the bottom of the grid object to
sum numeric data in each column.

Features Group

Note: These options do not display for grids or maps.

Reference Opens the reference menu, where you can access the
Add Reference Line to Y-Axis and Add Reference Line to
X-Axis options. Selecting one of these options opens the
Reference Line dialog box, where you can set the
following: the X-axis or Y-axis value, the text that you
want to appear, and the position of the reference line on
a chart.

Grid Opens the grid menu, where you can access the
Horizontal or Vertical Gridlines options. Both selections
allow you to enable or disable Major and Minor Gridlines.
Clicking More Grid Lines Options opens the Format Grid
Lines dialog box.

Frame & Background Opens the Frame & Background dialog box, where you
can edit the background style and frames for charts. This
dialog box contains different options depending on the
chart type that you have selected.

Narrative Adds narration to your visual. This option must be
enabled by an administrator.
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Command Description

Labels Group

Note: These options do not display for grids or maps.

Axes Opens the Axes menu, where you can enable and rotate
horizontal and vertical axis labels, as well as stagger
horizontal axis labels. You can also edit the axis labels
by clicking More Vertical Axis Options or More Horizontal
Axis Options.

Legend Opens the Legend menu, where you can select the Show
Legend option to display the legend on the chart. You
can also clear your selection to hide the legend. In
addition, you can change the default legend position and
orientation.

Interactive Group

Note: These options do not display for grids or maps.

Interactive Options Opens the Interactive Options dialog box, which enables
you to specify animation and mouse over effects in your
chart.

View Tab

Command Description

Show/Hide Group

Resources Minimizes the Resources panel, expanding the size of
the canvas to occupy the area where the Resources
panel typically appears. When you click the Resources
button again, the Resources panel displays and the
chart, map, or grid adjusts accordingly.

Data Panel Group
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Command Description

Logical Displays the data source fields by type. This is the
default view. The Logical view options include Title,
Description, Field, and Alias.

List Displays the data source fields in a tabular list format.
This list contains a header row. You can sort fields
differently by clicking a column header. The List view
options include Title, Description, Field, Alias, Format,
Segment, Filename, and Reference.

Structured Displays the hierarchical structure of the data source
files. The Structured view options include Title,
Description, Field, and Alias.

Report Group

Switch Report Lists any active report or chart to which you can switch.

Field Tab

Command Description

Filter Group

Note: Options on the Field tab are contingent on the visual type that you select.

Filter Opens the Filter dialog box for creating filters. Filters
enable you to select only the data that you want and to
exclude unwanted data.

Exclude Select an existing filter in the Filter pane and choose
Exclude to remove, but not delete, the filter from the
visual.

Include Select an existing filter in the Filter pane and choose
Include to restore the filter, which was previously
excluded from the visual.

Sort Group
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Up Displays the data source fields by type. This is the
default view. The Logical view options include Title,
Description, Field, and Alias.

Down Displays the data source fields in a tabular list format.
This list contains a header row. You can sort fields
differently by clicking a column header. The List view
options include Title, Description, Field, Alias, Format,
Segment, Filename, and Reference.

Group Opens the Create a Group dialog box where you can
create a group to combine values together. For grids, this
option is activated when you select a dimension.

Display Group

Hide Field Hides a selected field.

Aggregation Specifies an aggregation for a specific field. Commonly
used options include: Sum, Average, Count, Minimum,
and Maximum.

Traffic Lights Specifies conditional styling to the selected field.

Series Tab

Command Description

Select Group

Note: This group is not available for grids. For maps, this group is disabled.

Series drop-down list Lists the available series in the current visualization.

Style Group
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Command Description

Style Opens the Format Series dialog box, where you can edit
the styling options for the selected series. You can also
open this dialog box by right-clicking a series, and then
clicking More Style Options.

Properties Group

Data Labels Adds data labels to the chart. The drop-down menu
contains the following data position options for selecting
where to display data values as labels on a chart: Above
(default), On top edge, Below top edge, Center, and
Base. If you are working with a Pie chart, the options are:
On Slice, Outside Slice, and Outside with feeler lines.

Trendline Opens a drop-down menu that provides options for
adding a trendline to a chart.

Line Group

Smooth Line Draws the chart using smooth lines.

Connect Lines Controls the display of connecting lines between markers
on a line or scatter chart. By default, lines are connected
on a line chart and disconnected on a scatter chart.

Marker Opens a drop-down menu from which you can select
options to change the display of the default data and
legend markers on line and scatter chart types. For more
information, see How to Change the Appearance of a
Marker on page 635.

Pie Group

Note: The following options are only enabled when you are working with a pie chart.

Expand Expands pie slices.

Hide Hides pie slices.
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Chapter5
Customizing Content

After you create your content, you can use the WebFOCUS Business User Edition's vast
array of features and styling options to customize your content.

In this chapter:

Customizing Reports

Customizing Charts and Visualizations

Using Storyboards

Animating Visualizations

Using Filters to Customize the Display of
Data

Using Auto Drill

Using the Auto Linking Feature to Link
Content

Using Multi Drill

Adding Parameters for Data Selection at
Run Time

Working With Slicers

Changing a Field Format

Dynamic Grouping

Customizing Domain Pages

Customizing Reports

You can customize reports using the various options on the Layout tab and Field tab.

Cell Padding. Opens the Cell Padding dialog box, where you can set specific values to
control the amount of space inserted between rows and columns in a report. For more
information, see How to Use Cell Padding in a Report on page 619.

AutoFit. Limits the width of columns in a report to be no wider than the largest value in
each column. When additional fields are added, the report automatically grows at design
time. AutoFit Column is selected, by default.

Page Break. Starts a new page when the primary sort field changes. Clicking the drop-down
icon enables you to select Reset Page Numbers, which allows you to reset page numbers
on a page break to start at 1.

Line Break. Inserts a line in the report output when the primary sort field changes.

Sub Header. Opens a dialog box where you can type text to add a subheading just below
the column titles in the report output when the primary sort field changes.
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Sub Footer. Opens a dialog box where you can type text to add a subfooting at the end of
the data on each page of the report output when the primary sort field changes.

Subtotal. Inserts a line, total text (TOTAL FIELD Value), and subtotals for all numeric fields
when the primary sort field changes.

The drop-down menu on the Field tab, in the Format group provides three field-type options for
the selected column, which are Alphanumeric, Integer, and Decimal. Selecting the fourth
option, More options, opens the Field Format Options dialog box, which provides further
formatting options for the selected field. For more information, see Changing a Field Format on
page 728.

You can also apply floating and non-floating currency, percent signs, and commas. You can
increase and decrease decimal places by clicking the appropriate buttons under the drop-down
menu.

The Currency button is a split button that turns the currency symbol on or off. Click the
Currency button to turn on the default floating currency option. Click the Currency button a
second time to turn off the floating currency option.

To turn on the non-floating currency option, open the drop-down menu and select Non floating
currency. To turn off the non-floating currency option, click the Currency button.

The following options on the Field tab, in the Display group:

Hide Field. Allows you to hide a selected field.

Hide Missing. Allows you to hide fields that have no value.

Aggregation. Opens a drop-down menu of the following options:

None (default)

Sum

Average

Count

Count Distinct

Percent of Count

Distinct Values

First Value

Last Value
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Maximum

Minimum

Total

Percent

Row Percent

Median

Average Square

Sum is the default aggregation type value for all numeric fields added to the Measure Query
field container in the Query pane. Changing the Measure Query field container from Sum to
Print, Count, or List overrides all assigned aggregation type values. For more information
related to charts, see How to Display Aggregations on Measure Data on page 638.

Traffic Lights. Opens the Traffic Light Condition dialog box. From this dialog box you can do
the following:

add new conditional styling by applying traffic light (and other) colors to a selected field
in the output when the field meets specified criteria

modify existing conditional styling

enable conditional drill-down

For more information related to reports, see Styling Reports on page 610. For more
information related to charts, see Traffic Light Condition Dialog Box on page 629.

Data Bars. (Reports only.) Adds a data visualization column to the right of a selected
numeric field. The column displays values in each row using horizontal bars that extend
from left to right in varying lengths, depending on the corresponding data values.

Within. Allows you to use specific aggregation tasks at different report levels. You can use
the Within phrase to manipulate display field values as they are aggregated within a sort
group rather than a report column. 

Column(s). Allows you to indicate the number of columns in which you wish to display
multiple graphs. The value can be between 1 and 512. The default is 1. This option is also
available from the Query pane shortcut menu for a Multi-graph component.

5. Customizing Content
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Styling Reports

You can apply custom styling to specific areas of a report. When creating a report, you can
perform the following styling customization.

Global styling for the entire report.

Style data and column titles.

Style headings and footings. For more information, see How to Style Headings and Footings
in a Report on page 614.

Style the rows of data with alternating colors. For more information, see How to Style Rows
of Data With Alternating Colors in a Report on page 615.

Apply traffic light conditional styling to data. For more information, see How to Apply Traffic
Light Conditional Styling to a Report (By Constant) on page 616 and How to Apply Traffic
Light Conditional Styling to a Report (By Field) on page 617.

Increase or decrease the amount of space inserted between rows and columns. For more
information, see How to Use Cell Padding in a Report on page 619.

Procedure: How to Apply Styling to an Entire Report

1. Create a report, or open an existing report.

2. On the Home tab, in the Report group, click Style.

The Report Style dialog box opens.

3. Select any of the following styling options that are available in the Style group.

Font. Opens a drop-down list, which you can use to change the font.

Font size. Opens a drop-down list, which you can use to change the font size value.

Bold. Applies bold font formatting to the selected text.

Italic. Applies italic font formatting to the selected text

Underline. Underlines the selected text.

Justify Left. Aligns the text to the left of the canvas.

Justify Center. Aligns the text to the center of the canvas.

Justify Right. Aligns the text to the right of the canvas.

Font color. Opens the Color dialog box, where you can select the font color.
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Background color. Opens the Color dialog box, where you can select the background
color for the report.

Note: If you have chosen to specify a color, you must click OK to return to the Report
Style dialog box.

Currency Symbol. Opens a drop-down menu, from which you can choose a currency
symbol. Options are US dollar, British Pound, Japanese Yen, Euro, New Israeli Shekel.

Reset to Quick Styles from Template. Resets all settings to the default settings from
the template.

Note: Reset only works while the Report Style dialog box is open. Once you click OK, all
changes are committed. To undo global styling after it has been committed, you must use
the Undo command on the Quick Access Toolbar.

Preview. Displays the text as you have formatted it.

4. Click OK. The report is styled accordingly.

Procedure: How to Perform Field-Level Styling in a Report

You can style data, column titles, or both, in the report output for the selected data source
field. 

1. Create a report.

2. In the Query pane, select a data source field.

The Field tab appears on the ribbon.

3. In the Style group, click one of the following:

Data Style. Styles only the data for the selected data source field.

Title Style. Styles only the column title for the selected data source field.

Data + Title. Styles both the data and the column title for the selected data source
field.

4. Select any of the following styling options that are available in the Style group.

Font. Opens a drop-down list, which you can use to change the font.

Font size. Opens a drop-down list, which you can use to change the font size value.

Font color. Opens the Color dialog box, where you can select the font color.

Reset to Quick Styles from Template. Resets all settings to the default settings from
the template.

5. Customizing Content
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Note: Reset only works while the Report Style dialog box is open. Once you click OK, all
changes are committed. To undo global styling after it has been committed, you must
use the Undo command on the Quick Access Toolbar.

Bold. Applies bold font formatting to the selected text.

Italic. Applies italic font formatting to the selected text

Underline. Underlines the selected text.

Justify Left. Aligns the text to the left of the canvas.

Justify Center. Aligns the text to the center of the canvas.

Justify Right. Aligns the text to the right of the canvas.

Background color. Click the button to open the Color dialog box, where you can select
the background color for the report.

Note: When working with font or background colors, you must click OK on the Color
dialog box to return to the Report Style dialog box.

5. Click OK. The report is styled accordingly.

Procedure: How to Add Headings and Footings to a Report

You can make a report more meaningful by adding headings and footings. Headings and
footings supply context and key information about a report, such as its purpose and audience.
Headings and footings also provide structure, helping you navigate to the detail sought. They
enhance visual appeal. 

In this procedure, you will add and style a report heading and page heading. The procedure
uses sample values, but you can supply values that apply to your own, reports.

Headings and Footings are available in Query Design view, Live Preview, and Document view.

1. Create a report.

2. On the Home tab, in the Report group, click the Header & Footer button.

The Header & Footer dialog box opens.

3. Click the tab for the heading or footing element that you want to add.

For a report, you can add a report heading, page heading, page footing, or report footing.
By default, the Report Header tab is selected. In this procedure, accept the default.

4. Click inside the design area of the dialog box, and type the text for the heading.

For example, the text for a sample report heading might be Quantity Sold by Product.
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5. Using the styling ribbon, apply styling to the report heading text.

For example, click HELVETICA from the Font drop-down list. From the Font size drop-down
list, click 12.

The sample report heading with the selected styling values is shown in the following
image.

6. Click Apply to save the changes you have made so far, without closing the dialog box.

7. To add a page heading, click the Page Header tab.

In this procedure, you are going to add one of the supplied quick text options.

8. Click the last icon  (Insert preformatted text content for headers/footers) on the
right of the styling ribbon, and click Confidential in the list.

9. Change the font and font size. For example, change the font to HELVETICA and the size to
10.

You can add your own text before or after the supplied text, for example, For Regional
Managers Only.

10. Click OK to save the report heading and page heading and close the Header & Footer
dialog box.
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The report heading and page heading that you added and styled are shown in Live Preview
in the following image.

11. To make changes, to either the report, or page heading, right-click the heading and click
Edit. You can also double-click on the header to open the Header & Footer dialog box.

Procedure: How to Style Headings and Footings in a Report

You can style headings and footings in the report output for the selected heading or footing
field. 

1. Create a report.

2. With the report opened in Live Preview, select the heading or footing text that you want to
style.

3. On the Home tab, in the Report group, click Header & Footer.

The Header & Footer dialog box opens.

4. Select any of the following styling options that are available in the Style dialog box.

Font. Opens a drop-down list, which you can use to change the font.

Font size. Opens a drop-down list, which you can use to change the font size value.

Bold. Applies bold font formatting to the selected text.
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Italic. Applies italic font formatting to the selected text

Underline. Underlines the selected text.

Justify Left. Aligns the text to the left of the canvas.

Justify Center. Aligns the text to the center of the canvas.

Justify Right. Aligns the text to the right of the canvas.

Font color. Opens the Color dialog box, where you can select the font color.

Background color. Opens the Color dialog box, where you can select the background
color for the report.

Reset to Quick Styles from Template. Resets all settings to the default settings from
the template.

Note: Reset only works while the Report Style dialog box is open. Once you click OK, all
changes are committed. To undo global styling after it has been committed, you must
use the Undo command on the Quick Access Toolbar.

5. Click OK. The report is styled accordingly.

Procedure: How to Style Rows of Data With Alternating Colors in a Report

You can style rows of data in a report with alternating colors. 

1. Create a report.

2. Open the report in Live Preview.

3. On the Home tab, in the Report group, click Banded.

The Color dialog box opens.

4. Select a color.

5. Click OK.
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The selected color provides an alternating color scheme for the report. The report output
displays alternating rows of data, using a white background for one row and a background
of the selected color for the next row. This pattern continues throughout the report, as
shown in the following image of Banded report output.

Procedure: How to Apply Traffic Light Conditional Styling to a Report (By Constant)

You can apply traffic light conditional styling to data for a selected measure field. By default
the report displays the values that satisfy the first condition in green, and the values that
satisfy the second condition in red.

1. Open a report in Live Preview. 

2. Open the Traffic Light Condition dialog box in one of the following ways:

Ribbon: Select a field on the report, and then on the Field tab, in the Display group,
click Traffic Lights.

Shortcut Menu: Right-click a field on the report, point to More, and then click Traffic
Light Conditions.

The Traffic Light Condition dialog box opens.

3. From the Relational Operators drop-down menu below the field name, click a relational
operator. For example, Equal to.

4. In the field to the right of the Relational Operators drop-down menu, click the down arrow
for the Type drop-down menu.

The Type menu opens.

5. In the Type drop-down list, click Constant.

6. Enter a value in the Value field.
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or

a. From the Get Values drop-down menu, select one of the following values: All, First,
Last, Minimum, Maximum, or From File. The value that you select appears in the Get
Values field.

b. Select the value in the Get Values field. The value that you selected appears in the
Value field.

7. Click OK.

The value that you selected appears in the field to the right of the Relational Operators
drop-down menu.

8. Click the Style button.

The Style menu opens.

9. From the Style menu, click the Font Color or Background Color button.

The Color dialog box opens.

10. Select a color.

11. Click OK.

The color appears in the Preview box.

12. Click Apply to apply the colors to the report.

13. Click the Drill Down button.

The Drill Down dialog box opens.

14. In the Drill Down dialog box, use the radio buttons to specify the action you wish to
perform. For example, drill down to a report or webpage, create an auto link target, or
refresh a BI portal.

15. Click OK to close the dialog box.

16. In the Traffic Light Condition window, click the New button to set traffic light conditions for
additional fields.

Procedure: How to Apply Traffic Light Conditional Styling to a Report (By Field)

You can apply traffic light conditional styling to data for a selected measure field. By default
the report displays the values that satisfy the first condition in green, and the values that
satisfy the second condition in red.

1. Open a report in Live Preview. 
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2. Open the Traffic Light Condition dialog box in one of the following ways:

Ribbon: Select a field on the report, and then on the Field tab, in the Display group,
click Traffic Lights.

Shortcut Menu: Right-click a field on the report, point to More, and then click Traffic
Light Conditions.

The Traffic Light Condition dialog box opens.

3. From the drop-down menu below the field name, select a relational operator. For example,
Equal to.

4. In the field to the right of the Relational Operators drop-down menu, click the arrow for the
Type drop-down menu.

The Type dialog box opens.

5. In the Type drop-down list, select Field.

The Type dialog box displays a list of the data fields that you can choose from.

6. Select a data field from the list.

7. Click OK.

The field that you selected appears in the field to the right of the Relational Operators
drop-down menu.

8. Click the Style button.

The Style menu opens.

9. From the Style menu, click the Color button.

The Color dialog box opens.

10. Select a color.

The color appears in the Preview box.

11. Click OK.

12. Click the Drill Down button.

The Drill Down dialog opens.

13. In the Drill Down dialog, specify each of the following:

Drill down to a report or a webpage

URL of the webpage

An alternate comment
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Target (New Window, Same Window)

Parameters that you want to use (Name, Value)

14. Click OK.

15. Click the New button to set traffic light conditions for additional fields.

Procedure: How to Use Cell Padding in a Report

You can customize the amount of space inserted between rows and columns in a report. 

1. Open a report in Live Preview.

2. On the Layout tab, in the Report group, click Cell Padding, and then click Custom.

The Cell Padding dialog box opens.

3. Type the cell padding values that you want in the Top, Bottom, Left, and Right fields.

4. Click OK.

The report reflects the cell padding that you set.
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The following image shows a report with custom cell padding.

Report Style Dialog Box

The Report Style dialog box provides options to style your report, as described below.

Font. Use the drop-down menu to change the font.

Font size. Use the drop-down menu to change the numeric value for the font size.

Font style. Click the appropriate button (bold, italic, underline) to style the selected text.

Text alignment. Click the appropriate button (left, center, right) to align the selected text.

Font color. Click the button to open the Color dialog box, where you can select the font
color. For more information, see Color Dialog Box on page 621.
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Background. Click the button to open the Color dialog box, where you can select the
background color for the report.

Currency Symbol. Click the button to access the following currency symbols US Dollar,
British Pound, Japanese Yen, Euro, New Israeli Shekel.

Note: The New Israeli Shekel currency symbol can be displayed with the following settings
only:

Server codepage = 1255, 65001, 424, or 65002.

Client codepage = 1255 or 65001.

Application server encoding = Cp1255 or UTF8.

Font name = Lucida Sans Unicode or Arial Unicode MS.

Reset to Quick Styles from Template. Click the button to reset all settings to the default
settings from the template.

Note: Reset only works while the Report Style dialog box is open. Once you click OK, all
changes are committed. To undo global styling after it has been committed, you must use
the Undo command on the Quick Access Toolbar.

Color Dialog Box

The Color dialog box provides options for working with color in your report.

The Color dialog box options are:

Standard Color Swatches. Provides a set of 48 predefined colors from which to choose on
the left side of the dialog box. Your selection appears in the Selected Color field.

Custom Color Palette. Provides a palette on the right side of the dialog box to define a
custom color. Your selection appears in the Selected Color field.

Luminosity bar. Drag the slider to change the luminosity (relative lightness or darkness) of
a color. The corresponding numerical value appears in Lum.

Hue. Indicates the hue value of your selected color. You can enter a value, or increase or
decrease the hue value by using the up and down arrows, respectively.

Sat. Indicates the saturation value of your selected color. You can enter a value, or
increase or decrease the saturation value by using the up and down arrows, respectively.
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Lum. Indicates the luminosity (lightness or darkness) of your selected color. You can enter
a value, or increase or decrease the luminosity value by using the up and down arrows,
respectively.

Red. Represents the numeric value of red (0 to 255).

Green. Represents the numeric value of green (0 to 255).

Blue. Represents the numeric value of blue (0 to 255).

Selected Color. Displays the color that you selected.

Transparent. Makes the color transparent. This is only available for background colors.

Report Group

The Report group on the Home tab contains commands to enhance a report. 

Theme. Opens a dialog box where you can select a theme to style your report. You can use
the default style sheet by clicking the Use Default Stylesheet button.

You can also select a document styling theme or an application theme to style all reports
created. Use the Environment and Styling section of the Options window, which is
accessible by clicking Options in the Application main menu.

Note: If you switch themes when working in Report mode, all custom styling is removed
from the procedure.

Style. Opens a Report Style dialog box for applying global styling to the entire report. For
more information about the Report Style dialog box, see Report Style Dialog Box on page
620. For more information about styling reports, see Styling Reports on page 610.

Banded. Opens a Color dialog box for choosing a color that provides an alternating color
scheme for the report. The report output displays alternating rows of data, using a white
background for one row and a background of the selected color for the next row. This
pattern continues throughout the report. For more information about the Color dialog box,
see Color Dialog Box on page 621. For more information about banded styling, see How to
Style Rows of Data With Alternating Colors in a Report on page 615.

Header & Footer. Opens the Header & Footer dialog box, from which you can add and style
headings and footings.

For a report, you can add and style report headings, page headings, page footings, and
report footings. In the dialog box, the tab for Report Header is active by default.
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For a chart, you can add and style page headings and page footings. Page Header is
active by default.

You can drag fields from the Data pane into the Header & Footer dialog box.

Another way to access the Header & Footer dialog box is to click the down arrow next to the
Header & Footer button. It opens a drop-down menu from which you can select the heading
or footing that you want to work with (Report Header, Page Header, Page Footer, Report
Footer). After you make your selection, the Header & Footer dialog box opens, and the
heading or footing that you selected is active.

From the Header & Footer dialog box, you can add and style the active heading or footing,
or choose a different heading and footing to work with by selecting the applicable tab. You
can switch among tabs, but InfoAssist+ does not save changes made on the tabs until you
click Apply or OK. If you click Apply, the Header & Footer dialog box remains open. If you
click OK, the dialog box closes.

You can style a selected heading or footing using the options on the styling toolbar. From
left to right, you can customize the font type, font size, and font style (bold, italic, or
underline). You can justify text (left, center, or right), select the font color and background
color, and restore styling settings to their default value from the template.

You can also add page footings to your reports or charts. From the Header & Footer dialog
box, select Page Footer. When working with reports, you may use the Additional alignment

options icon , to specify whether you want to align the footer relative to the data
(default) or relative to the page. The Align Relative to Data option places the footer directly
below the data, and the Align Relative to Page option positions the footer at the bottom of
the page. When working with charts, only the default page footer alignment option is
supported.

Note: The Align Relative to Page option works with reports that use positioned formats (for
example, PDF, PS, DHTML, PPT, and PPTX).

You can also insert quick text into a heading or footing. Quick text is supplied for you. It
includes information that is typically useful in identifying a report or chart. From the
preformatted text drop-down menu, you can select:

Draft

Page X of Y

Confidential

Date (multiple formats)
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Time (multiple formats)

Created by (followed by a name)

For charts, an icon  on the far right of the styling ribbon is enabled. This icon
provides two options for controlling the way in which the page heading and page footing are
rendered. The default option, Create Header and Footer as text, renders the heading and
footing as text elements that are separate from the chart image. The option, Embed Header
and Footer in the chart, renders the heading and footing text as part of the chart image.

Once you have added a heading or footing to a report or chart, you can double-click it on
the canvas in design mode to reopen the Header & Footer dialog box. You can also right-
click an existing heading or footing in design mode and click Edit from the menu to open
the dialog box.

For more information on adding and styling headings and footings, see How to Add
Headings and Footings to a Report on page 612.

Column Totals. (Reports only) Adds a grand total row to the bottom of the report to sum
numeric data in each column.

Row Totals.(Reports only) Adds a grand total column to the right side of the report to sum
numeric data in each row.

Report Features

The options on the Format tab, in the Features group, while in Report mode, allow you to add
pop-up titles to columns, stack measures, and more.

Title Popup. Displays pop-up titles when the mouse pointer hovers over a column title in
the report output.

Accordion. Creates expandable views of data for each vertical sort field. This option
displays data values only for the first vertical sort field when you first view the output. You
can manually expand your view to expose the data values of lower-level sort fields.

Note: You cannot use the Table of Contents with the Accordion feature.

Repeat Sort Value. Displays all repeated sort values instead of blanks in the output after
the first instance of a new sort value, which is the default behavior.

Stack Measures. Displays all numeric measure field names in a column of the report
output with the corresponding numeric data values.
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active report options. Opens the active report options dialog box where you can configure
your active report options such as menu items, graph engine, and colors.

The following table lists the output for which each feature is available. Yes means the output is
available for the feature. No means that the output is not available for the feature.

HTML HTML5 active
report

PDF Excel PowerPoint

Title Popup yes no no no no no

Accordion yes no yes no no no

Repeat Sort Values yes yes yes yes yes yes

Stack Measures yes no no no no no

active report options no no yes no no no

Customizing Charts and Visualizations

Once you have created a visualization or chart, you can customize and style your content. For
example, you can add axis titles or a header. The customization options vary depending on the
type of chart or visual you are developing.

Chart Features

The options on the Format tab, in the Features group allow you to add effects and different
functionality to your charts.

3D Effect. Sets the three-dimensional view to on or off. The 3D Effect feature is disabled
for 3D, stock, gauge, gauge thermometer, Pareto, spectral map, and funnel chart types. By
default, 3D effect is off for all chart types.

Note: When working with charts in HTML5 format, the 3D Effect option is not supported.

Rotate. Toggles between a vertical display or horizontal display of a chart. For more
information, see How to Rotate a Chart on page 694. The Rotate feature is disabled for
pie, scatter, 3D, stock, gauge, gauge thermometer, Pareto, spectral map, and funnel chart
types.
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Reference. Opens a drop-down menu that provides the Add Reference Line to Y-Axis and
Add Reference Line to X-Axis options. Selecting one of these options opens the appropriate
Reference Line dialog box, where you can set the specific X-axis or Y-axis value, type the
text that you want, and position the reference line on a chart. For more information, see 
How to Display a Static Reference Line on page 694. The Reference feature is disabled
for pie, 3D, stock, gauge, gauge thermometer, Pareto, spectral map, and funnel chart
types.

Annotate. Opens a drop-down menu that provides the Add an annotation option. Selecting
this option opens the Annotation dialog box, where you can type the text that you want and
position the annotation on a chart.

Grid. Opens a drop-down menu allowing you to expand options for Horizontal or Vertical
Gridlines. Both selections allow you to enable or disable Major and Minor Gridlines. Clicking
More Options opens the Format Grid Lines dialog box. For more information, see Formatting
Gridlines on page 653.

Frame & Background. Opens the Frame & Background dialog box where you can edit the
background style and frames for charts. The dialog contains different options depending on
the chart type selected. For more information, see Formatting a Frame and a Background
on page 672.

Narrative. Adds narration to your chart. This option must be enabled by an administrator.

Gauges. Opens the Gauge dialog box where you can edit your gauge chart. This button is
only available when a gauge chart type is selected. For more information, see How to Style
a Gauge Needle on page 689.

active report Options. Opens the active report options dialog box where you can configure
your active report options, such as menu items, graph engine, and colors. This button is
available when the output type is set to active report.

Note: Annotate is not available in HTML5.

Labeling Charts

You can add labels to charts and visualizations using the Labels group on the Format tab.

Axes. Opens a drop-down menu, where you can enable, stagger, and rotate horizontal and
vertical axis labels. You can also edit the axis labels by clicking More Horizontal Axis
Options or More Vertical Axis Options. For more information, see Formatting Axis Labels on
page 663.
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Legend. Opens a drop-down menu, where you can select the Show Legend option to display
the legend on the chart, or clear your selection to hide the legend, change the default
legend position, and change the default legend orientation. For more information, see 
Format Legend Dialog Box on page 648.

Accessing Chart Formatting Tools

Your presentation of data on a chart or visualization is successful when it communicates to
your audience the message that you intend. InfoAssist+ helps you meet the needs of your
audience and convey your message by providing numerous chart features. For example, you
can adjust the appearance of a chart, add layers of information, or customize the labels that
identify the data on the chart.

Using Live Preview

In Live Preview, the canvas on the right of the window provides a preview of the content that
you can interact with. The preview is context sensitive, meaning that depending on what
portion you select different options become available. 

In Live Preview, when you hover the mouse over a graph element (for example, legend, axis
label, title), the bounding area is highlighted with a dotted line.

In Live Preview, when you select a graph element (for example, legend, axis label, title), the
bounding area is highlighted with a solid line.

Once you select a chart element, you can access all available design options on the ribbon, or
you can right-click an element to open a shortcut menu of frequently-used design options. Once
you have selected your design option from the ribbon or the menu, InfoAssist+ instantly
applies it to the chart element, so that you see the result immediately.

Shortcut menus are enabled for charts that are generated with either sample data, or live data
from your data source.

The following sections describe the chart elements and the ribbon options that you can work
with to design your charts in Live Preview.

Related Information:

Using Field Containers on page 96

Formatting a Series

A series is a measure field that is included in a chart or visualization. You can format a series
in a variety of ways. For example, you can change the color of a series, add a trendline to a
series, or change the appearance of markers on a series.
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You can access the full set of formatting options on the Series tab and Field tab. For more
information, see Series Tab on page 84 and Field Tab on page 83.

You can also access a subset of frequently-used options by right-clicking a series element on a
chart to open a menu of those options.

Tip: The options that you see on the menu depend on the type of chart that you are creating.
For example, the Series Type option would not appear on the menu for a pie chart, but it would
appear for a bar, line, and area chart.

Associated Dialog Boxes

Whether you access series options from the ribbon or the shortcut menu, you are presented
with a dialog box of options. The following dialog boxes are commonly used for formatting a
series:

Format Series

Edit Title

Traffic Light Condition

For Instructions on how to open these dialog boxes, see the procedures in Using Series
Properties on page 633.

Format Series Dialog Box

The Format Series dialog box contains options to format the fill and border of each series on a
chart. To access this dialog box, on the Series tab, in the Style group, click Style. 

The Format Series dialog box contains the following tabs:

Fill

Border

Use the Fill tab to modify the color of a chart series. 

The Fill tab contains the following options:

No fill. Select this option to remove the color from the series.

Solid fill. Select this option to display the Color and Transparency options.

Color. Click this icon to open the Color dialog box, where you can select a color for the
series.

Transparency. Move the slider to make the bands opaque (0%) or transparent (100%).
The default is 0%.
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Gradient fill. Select this option to display the direction of the gradient, the color pattern of
the gradient, and the degrees of transparency for the two colors that make up the gradient.
A gradient is a smooth color transition or blending of one color to another. The number of
colors to use in a gradient is defined by the stop or pin elements.

Direction. Select from this drop-down menu to set the direction of the gradient fill. For
example, Gradient right or Gradient left.

Use the Border tab to specify a border for a chart series. 

Note: When you create a bubble chart and attempt to apply a border using the Style options on
the Series tab, the border does not display.

The Border tab contains the following options:

Show Border Color. Select this option to show a border color around each series.

Border Color. Click this icon to open the Color dialog box, where you can select a color for
the border.

Edit Title Dialog Box

To edit the title of a series, right-click a series on the canvas, and click Change Title. The Enter
Title dialog box contains a text field in which you can type the title for a series on a chart. Click
OK and the title appears on the chart.

Traffic Light Condition Dialog Box

The Traffic Light Condition dialog box contains fields for adding new conditional styling or
modifying existing conditional styling by applying a traffic light color to the selected field.

The Traffic Light Condition dialog box contains the following fields.

Relational Operators. Select from this drop-down menu to set the relational operator. For
example, Equal to.

Type/Value. Click this unlabeled field to open a dialog box that contains the following
fields:

Type. Opens a drop-down menu of the following values Constant and Field. Select
Constant to enter a constant value. Select Field to open a visual display of the fields in
your data source.

Value: Enables you to specify a value based on the Type that you select.

5. Customizing Content

Online Help PDF  629



Note: If you are creating a Traffic Light condition on a full date field, the Value field will
have a calendar icon adjacent to it. You can use this icon to select a date using a
calendar control.

Get Values. Select a value option from this drop-down list. For example, All or First.

The Traffic Light Condition dialog box contains the following buttons:

Selected Condition. Click this icon to select a condition to work on.

New. Creates a new rule.

Delete. Deletes a rule.

Color. Opens the Color dialog box.

Drill Down. Opens the Drill Down dialog box, where you can drill down to a webpage or a
URL. Specify the following:

URL of the webpage or location of the report

A description

Target (New Window, Same Window, a value that you enter)

Parameters that you want to use (Name, Value)

Series Elements Shortcut Menu

When you right-click a series, a menu of options opens. The menu contains options that are
available on the Field and Series tabs. 

The menu options are described in the following table. The table provides links to the sections
of this document in which those options are also discussed.

Option Description

Filter Values Enables you to create or modify a WHERE statement, using the
Filter dialog box. With a WHERE statement, you select only the
data that you want to display, and exclude unwanted data.

For information on filtering your data, see Data Tab on page 81
and Field Tab on page 83.
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Option Description

Sort Enables you to sort the series in either ascending or
descending order.

Visibility Controls the display of the selected series (field) on a chart.
The value Hide suppresses the display of the series, and the
default value Show displays the series.

For instructions, see How to Hide a Field in a Series on page
637.

Change Title Enables you to edit the title of the selected series. In the Edit
Title dialog box, type the new title in the Enter Title field, and
click OK.

Series Type Changes the chart type of the selected series to bar, line, or
area. The option None (default) returns the series to the chart
type that was in effect before you changed it. This option
applies to bar, line, and area chart types only.

Series Color Enables you to specify the color of the selected series, using
the Color dialog box. For more information, see Color Dialog Box
on page 621.

More Style Options Opens the Format Series dialog box. For more information, see 
Format Series Dialog Box on page 628.

Data Labels Controls the display of data labels (values) on the selected
series. The default value Hide suppresses the display of labels,
and the value Show displays labels.

This option does not apply to the gauge chart type.

For instructions, see How to Show and Hide Data Labels on
page 647.
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Option Description

Color Mode Controls how color is applied to a series (measure field) on a
chart. The possible settings are By Series (default) and By
Group. For example, assume that there is only one series on a
sample bar chart. The By Series setting applies the same color
to all the bars in the series. The By Group setting applies a
different color to each bar. 

For instructions, see How to Control the Color Mode on page
641.

Add Trendline Draws a line on a chart to indicate a statistical trend.

This option does not apply to the pie, funnel, 3D, gauge, or
stock chart type.

For an example of a chart with a trendline, see How to Add a
Trendline on page 634.

Drill Down Opens the Drill Down dialog box, where you can configure a
hyperlink or a drill-down procedure for the selected field.
Clicking that field in the report output, at run-time, redirects you
to the URL you specified or executes the indicated procedure.

More Contains the Aggregation Functions, Traffic Light Conditions,
and Missing options.

Aggregation Functions assign an aggregation value to a numeric
measure field in a report. For instructions, see How to Display
Aggregations on Measure Data on page 638.

Traffic Light Conditions enables you to specify the color of
numeric measure fields in the output, depending on conditions
that you set. You can use the Traffic Light Condition dialog box
to specify the conditions and colors.

For instructions, see How to Apply Traffic Light Conditions With
Drill-Down to a Numeric Measure Field (By Constant) on page
638 and How to Apply Traffic Light Conditions With Drill-Down
to a Numeric Measure Field (By Field) on page 639.

The Missing option allows you to show or hide fields with no
value.
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Option Description

Delete Removes the selected series from the report and updates the
Live Preview accordingly.

Using Series Properties

The following sections contain procedures for customizing a series. 

Procedure: How to Select a Series

1. Create a chart or visualization.

2. On the Series tab, in the Select group drop-down menu, select the Series that you want to
customize.

The Series appears in the drop-down menu field.

Procedure: How to Format the Fill and Border of a Series

1. Create a chart or visualization.

2. Open the Format Series dialog box in one of the following ways:

Ribbon: On the Series tab, in the Style group, click Style.

Shortcut Menu: Right-click a series on the chart, and click More Style Options.

The Format Series dialog box opens.

3. Use the fill and border options to format the series.

For more information, see Format Series Dialog Box on page 628.

4. Click OK to close the dialog box.

The Format Series dialog box closes. The series fill and border are formatted accordingly.

5. Click Run to generate the report.

Enhancing Series Using the Series Tab

The Properties group contains commands for enhancing charts, such as changing the type or
adding a trendline, for the selected series.

Procedure: How to Change the Type of a Series

1. Create a bar, line, or area chart.
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2. Access the list of series types in one of the following ways:

Ribbon: On the Series tab, in the Properties group, open the Type drop-down menu.

Shortcut Menu: Right-click a series on the chart, and point to Series Type.

3. Select the type that you want the series to become.

The chart contains the new series type.

Procedure: How to Add a Trendline

A trendline is a line that is drawn over the plot area of a chart or visual to show the pattern of
data points. The pattern reveals a statistical trend. In particular, the slope of the trendline,
which is calculated by subtracting and dividing two different x, y coordinate values, is a value
that indicates the rate at which the y value of a line rises or falls as the x value increases.
Once the slope of your chart or visual is determined, you can further extrapolate your results
and gain further insight into your data. 

Note: The mathematical equation for the selected trendline option is only available in chart
mode. It is not available in visualization mode.

1. Create a chart or visualization.

2. Access the menu of trendline types in one of the following ways:

Ribbon: On the Series tab, in the Properties group, open the Trendline drop-down menu.

Shortcut Menu: Right-click a series on the chart or visual, and point to Add Trendline.

3. Select the type of trendline that you want to display.

The trendline appears on the canvas.

4. Optionally, to display the mathematical equation for the selected trendline option, on the
Series tab, in the Properties group, click Equation. 

Formatting Charts Using the Series Tab

The Series tab contains options for formatting charts.

Procedure: How to Apply Smooth Line Effect to a Line Chart

1. Create a line chart.

2. Select a series on the line chart.

3. On the Series tab, in the Line group, click Smooth Line.

The Smooth Line effect is applied to the series.
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Procedure: How to Hide a Series Line Between Markers

Lines appear between markers by default. 

To hide a series line between a marker:

1. Create a line chart.

2. Select a series on the line chart.

3. On the Series tab, in the Series group drop-down menu, select the series that you want to
hide.

4. In the Line Group, click Connect Lines.

The series line between the markers disappears.

To make the series line reappear, click Connect Lines again.

Procedure: How to Change the Appearance of a Marker

Markers are used to display points of data on a line chart. They are also used in the legend to
identify the data that is on the chart. The different marker shapes distinguish one series from
another.

1. Create a line chart.

2. Select a series on the line chart.

3. On the Series tab, in the Line group, click Marker to open a drop-down menu of options.

4. From the Marker drop-down menu, select the marker shape. For example, Diamond or
Hourglass.

The markers are formatted.
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The following image shows a triangle marker for gross profit data and a star marker for
revenue data.

Procedure: How to Expand Pie Slices

1. Create a pie chart.

2. On the Series tab, in the Select group, from the drop-down menu, select one of the
following:

All Series expands all slices out from the center of the pie.

A specific series expands that particular slice out from the center of the pie.

3. In the Pie group, click Expand.

The pie expands accordingly.

Procedure: How to Hide a Pie Slice

1. Create a pie chart.

2. On the Series tab, in the Select group, from the drop-down menu, select the series that you
want to hide. Then, in the Pie group, click Hide.

The slice is hidden.
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Procedure: How to Filter Values in a Series

1. Create a chart.

2. Select a series on the chart.

3. Open the Filter dialog box in one of the following ways:

Ribbon: On the Field tab, in the Filter group, click Filter.

Shortcut Menu: Right-click a series, and click Filter Values.

The Filter dialog box opens.

4. Select values for values and prompts.

5. Click OK to close the dialog box.

The series values are filtered.

Procedure: How to Sort the Fields in a Series

1. Create a chart.

2. Select a series.

3. Sort the series in one of the following ways:

Ribbon: On the Field tab, in the Sort group, click Up to sort the series values from
smallest to largest, or click Down to sort the series values from largest to smallest.

Shortcut Menu: Right click a series on the chart, and point to Sort, and then Sort
again. Click Ascending to sort the series values from smallest to largest, or click
Descending to sort the series values from largest to smallest. Select Limit to open a
list of values to display for a sort group.

The chart appears with the series sorted accordingly.

Procedure: How to Hide a Field in a Series

1. Create a chart or visualization.

2. Hide a field in a series in one of the following ways:

Select the field in the Query pane.

Right-click the field in the chart.

Ribbon: Select the field in the Query pane or by right-clicking it in the chart. On the
Field tab, in the Display group, click Hide Field. Click Hide Field again to make the
series reappear.
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Shortcut Menu: Right-click a series in the Query pane, or in the chart, point to Visibility,
and then click Hide. Right-click the same series, point to Visibility, and then click Show
to make the series reappear.

The field is hidden.

Procedure: How to Display Aggregations on Measure Data

You can display numeric measure data using a variety of aggregation values.

1. Create a chart or visualization.

2. Open the list of Aggregation options in one of the following ways:

Ribbon: On the Field tab, in the Display group, click Aggregation.

Shortcut Menu: Right-click a series, point to More, and then Aggregation Functions.

3. Select an aggregation function.

The aggregation function is applied to the series.

Note: If you change the Measure (Sum) Query field container in the Query pane from Sum
to Print, Count, or List, the change overrides all assigned aggregation values.

Procedure: How to Apply Traffic Light Conditions With Drill-Down to a Numeric Measure Field (By
Constant)

1. Create a chart or visualization.

2. Open the Traffic Light Condition dialog box in one of the following ways:

Ribbon: In the Query pane, select a field, and then on the Field tab, in the Display
group, click Traffic Lights.

Shortcut Menu: Right-click a series on the chart, point to More, and then click Traffic
Light Conditions.

The Traffic Light Condition dialog box opens. For more information, see Traffic Light
Condition Dialog Box on page 629.

3. From the Relational Operators drop-down menu below the field name, select a relational
operator. For example, Equal to.

4. In the field to the right of the Relational Operators drop-down menu, click the down arrow
for the Type drop-down menu.

The Type dialog box opens.
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5. In the Type dialog box, select Constant.

6. Enter a value in the Value field, or

a. From the Get Values drop-down menu, select one of the following values All, First,
Last, Minimum, Maximum, From File. The value that you select appears in the Get
Values field.

b. Select the value in the Get Values field. The value that you selected appears in the
Value field.

7. Click OK.

The value that you selected appears in the field to the right of the operator drop-down
menu.

8. Click the Color button.

The Color dialog box opens.

9. Select a color.

10. Click OK.

The color appears in the Preview box.

11. Click OK.

12. Click the Drill Down button.

The Drill Down dialog box opens.

13. In the Drill Down dialog box, specify each of the following:

Drill down to a report or a webpage

URL of the webpage

An alternate comment

Target (New Window, Same Window)

Parameters that you want to use (Name, Value)

14. Click OK to close the dialog box.

15. Click the New button to set traffic light conditions for additional fields.

Procedure: How to Apply Traffic Light Conditions With Drill-Down to a Numeric Measure Field (By
Field)

1. Create a chart or visualization.
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2. Open the Traffic Light Condition dialog box in one of the following ways:

Ribbon: In the Query pane, select a field, and then on the Field tab, in the Display
group, click Traffic Lights.

Shortcut Menu: Right-click a series on your chart, point to More, and then click Traffic
Light Conditions.

The Traffic Light Condition dialog box opens. For more information, see Traffic Light
Condition Dialog Box on page 629.

3. From the Relational Operators drop-down menu below the field name, select a relational
operator. For example, Greater than.

4. In the field to the right of the operator drop-down menu, click the arrow for the Type drop-
down menu.

The Type dialog box opens.

5. In the Type dialog box, select Field.

The Type dialog box displays the Dimensions, and Measures and Properties of your data.
You can display the data in the following ways:

View fields in business order. Select from the following options: Title, Description,
Name, or Alias.

View fields in a sortable grid. Select from the following options: Name, Title, Alias,
Format, Segment, Filename, Description, or Reference.

View the hierarchical structure of the data. Select from the following options: Title,
Description, Name, or Alias.

6. Select a field.

7. Click OK.

The field that you selected appears in the field to the right of the operator drop-down
menu.

8. Click the Color button.

The Color dialog box opens.

9. Select a color.

The color appears in the Preview box.

10. Click OK.

11. Click the Drill Down button.

The Drill Down dialog box opens.
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12. In the Drill Down dialog box, specify each of the following:

Drill down to a report or a webpage

URL of the webpage

An alternate comment

Target (New Window, Same Window)

Parameters that you want to use (Name, Value)

13. Click OK to close the dialog box.

14. Click the New button to set traffic light conditions for additional fields.

Procedure: How to Change the Title of a Series

1. Create a chart or visualization.

2. Open the Edit Title dialog box in one of the following ways:

Shortcut Menu: Right-click a series on the chart, and click Change Title.

Query Pane: Right-click a series, and click Change Title.

The Edit Title dialog box opens.

3. In the Enter Title field, type the new name for the series.

4. Click OK to close the dialog box.

The series has a new title.

Procedure: How to Control the Color Mode

When you create a single-series chart, all series groups appear in the same color. To use a
different color for each group, set the color mode to By Group. 

1. Create a chart or visualization.

2. Right-click a series on the chart, point to Color Mode, and then click By Group.

A different color is applied to each group in the series. To return to the default display of
the series in one color, right-click the series, point to Color Mode, and then click By Series.

3. Click Run to generate the report.

Procedure: How to Delete a Series

1. Create a chart or visualization.

5. Customizing Content

Online Help PDF  641



2. Right-click a series on the chart, and click Delete.

The series is deleted.

Formatting Data Labels

Data labels highlight important data points on a chart. They identify exact numbers. You can
customize data labels in a variety of ways to make them stand out more clearly on the chart.
For example, you can change the position, angle, color, or size of data labels. 

Associated Dialog Boxes

Whether you access data label options from the ribbon or the shortcut menu, you are
presented with a dialog box of options. The following dialog boxes are commonly used for
formatting data labels:

Format Labels

Style

Line Style

For instructions on how to open these dialog boxes, see the procedures in Using Data Labels
Properties on page 647.

Format Labels Dialog Box

The Format Labels dialog box contains options for editing data labels. The Format Labels
dialog box offers different options depending on the chart type that you are using. Bar, line,
and area charts share the same tabs.

The Format Labels dialog box contains the following tabs:

General Options

Advanced

Pie Title (for pie charts only)

Pie Labels (for pie charts only)

Funnel Labels (for funnel and pyramid charts)

General Options Tab

Use the General Options tab to add data labels to a chart and set their position, angle, and
radius. 
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The General Options tab contains the following options:

Show Data Labels. Select this option to show data labels on a chart. Clear this option to
suppress data labels.

Position. Select an option from this drop-down menu to determine where the data label will
be positioned. The options are:

Above

Below top edge

Center

Base

Center back

Format Labels. Select from this drop-down menu of preset formats that can be applied to
the labels. Some of the options include Use Pattern, Currency General, and Date Full.

Custom Format. Enter a standard number format pattern for the data label. This option is
only available when you select the Use Pattern option from the Format Labels drop-down
menu.

The following table describes the characters that you can use in a custom format.

Character Description

# Is a digit.

0 (zero) Shows as absent.

. (period) Is a placeholder for decimal separator.

, (comma) Is a placeholder for grouping separator.

; (semicolon) Separates formats.

- (dash) Is the default negative prefix.

% (percent) Divides by 100 and shows as a percentage.

x Determines that any other characters can be used in
the prefix or suffix.
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Character Description

‘ (apostrophe) Is used to quote special characters in a prefix or
suffix.

Style Labels. Click this icon to open the Style dialog box, where you can style text. For
more information, see Style Dialog Box on page 646.

Show Cumulative Sums. Select this option to have the data text labels show cumulative
sums. Clear this option to have data text labels show individual sums. This option is
available for stacked charts.

Show Stacked Total. Select this option to display stacked totals. Data position should be
set to Center to display a stacked total. This option is available for stacked charts.

Advanced Tab

Use the Advanced tab to modify additional data labels properties. 

The Advanced tab contains the following options:

Show Zero Labels. Select this option to display zero values in a chart. Clear this option to
display all data values except zero.

Apply color to negative data labels. Select this option to style negative data labels
separately from positive data labels.

Color. Click this icon to open the Color dialog box, where you can select a color for the
negative number.

Pie Title Tab

Use the Pie Title tab to create and style a pie title. 

The Pie Title tab contains the following options:

Show Pie Title. Clear this option to suppress a pie title. Select this option to display a pie
title. This is the default option.

Style Title. Click this icon to open the Style dialog box, where you can style pie title text.

Pie Labels Tab

Use the Pie Labels tab to customize your pie data labels. 

The Pie Labels tab contains the following options:

Label Position. Select from this drop-down menu an option to control the display of feeler
lines and labels on a pie chart.
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Label Display. Select from this drop-down menu an option to control the format of labels
displayed next to feelers on a pie chart.

Format Labels. Select from this drop-down menu of preset formats that can be applied to
labels.

Custom Format. Select this option to use a custom format from a list of preset formats.
See the following table for a list and description of the characters that you can use in a
custom format.

Style Labels. Click this button to open the Style dialog box, where you can style text.

Ring Label

Show Ring Label. Select this option to control the display of the total label on a pie ring
chart.

Format Labels. Select from this drop-down menu of preset formats that can be applied to
labels.

Custom Format. Enter a standard number format pattern for the data label. This option is
only available when you select the Use Pattern option from the Format Labels drop-down
menu.

Style Labels. Click this button to open the Style dialog box, where you can style text.

Feeler Line

Line Style. Click this button to open the Line Style dialog box, where you can edit the color,
weight, and style of the feeler line.

Funnel Labels Tab

Use the Funnel Labels tab to customize the labels on a funnel or a pyramid chart. 

The Funnel Labels tab contains the following options:

Label Position. Select an option from this drop-down menu to control the display of feeler
lines and labels on a funnel chart.

Format Labels. Select from this drop-down menu of preset formats that can be applied to
labels.

Custom Format. Select this option to use a custom format. See the table in the previous
section for a list and description of the characters that you can use in a custom format.

Style Labels. Click this button to open the Style dialog box, where you can style text.
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Style Value. Opens the Style dialog box, where you can style the value.

Feeler Line

Show Feeler Lines. (Default) Clear this option to suppress feeler lines. Select this option to
display feeler lines.

Line Style. Click this button to open the Line Style dialog box, where you can edit the color,
weight, and style of the feeler line.

Note: While some style options, such as Show Pie Title and Show Feeler Lines, are enabled
by default, a stylesheet applied to the chart may contain different settings that will override
these default settings.

Style Dialog Box

The Style dialog box contains options to style the data labels. 

The Style dialog box contains the following options:

Font. Use the drop-down menu to change the font.

Font size. Use the drop-down menu to change the numeric value for the font size.

Font style. Click the appropriate button (bold, italic, underline) to style the selected text.

Text alignment. Click the appropriate button (left, center, right) to align the selected text.

Font color. Click the button to open the Color dialog box, where you can select the font
color.

Reset to Quick Styles from Template. Click the button to reset all settings to the default
settings from the template.

Note: Reset only works while the Style dialog box is open. Once you click OK, all changes
are committed. To undo global styling after it has been committed, you must use the Undo
command on the Quick Access Toolbar.

Line Style Dialog Box

The Line Style dialog box contains options to style lines on a chart. 

The Line Style dialog box contains the following options:

Color. Click this button to open the Color dialog box, where you can select the color for the
line.
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Weight. Click this button to open a drop-down menu of line weight options.

Style. Click this button to open a drop-down menu of line style options.

Reset. Click this button to reset the line to the default options.

Data Labels Elements Shortcut Menu

When you right-click a data label on a bar, line, or area chart, a menu of the following options
opens:

Data Labels. Point to this option to toggle between Show and Hide.

More Label Options. Click this option to open the Format Labels dialog box.

The shortcut menu contains options that are available on the Series tab.

Using Data Labels Properties

The following sections contain procedures for customizing data labels. 

Procedure: How to Show and Hide Data Labels

1. Create a chart or visualization.

2. You can access the option to show data labels in one of the following ways:

Ribbon: On the Series tab, in the Properties group, click Data Labels, and from the drop-
down menu, click More Data Label Options. The Format Labels dialog box opens. On
the General Options tab, select the Show Data Labels check box, and click OK to close
the dialog box. You can use this dialog box to format and style the data labels. For
more information, see Format Labels Dialog Box on page 642. To hide data labels,
clear this option.

Shortcut Menu: Right-click a series on the chart, point to Data Labels, and then click
Show. To hide data labels, right-click a series on the chart, point to Data Labels, and
then click Hide.

The data labels appear, and are formatted and styled accordingly.
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The following image shows a chart with data labels.

Procedure: How to Change the Position of Data Labels

1. On the Series tab, in the Properties group, click Data Labels.

2. On the menu, select the position for the data labels.

The data labels are positioned accordingly.

Formatting a Legend

A legend contains information that is necessary to accurately interpret the data on a chart. By
default, a chart displays either a vertical axis title if there is a single measure field, or a legend
if there are multiple measure fields. 

Format Legend Dialog Box

Whether you access legend options from the ribbon or the shortcut menu, you are presented
with the Format Legend dialog box of options. For instructions on how to open this dialog box,
see Using Legend Properties on page 651.
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The Format Legend dialog box contains options for formatting a legend on a chart or
visualization. It contains the following tabs:

Legend Options

Markers & Labels

Fill

Border Styles

For instructions on how to open this dialog box, see the procedures in Using Legend Properties
on page 651.

Use the Legend Options tab to customize the appearance of a legend on a chart or
visualization. 

The Legend Options tab is shown in the following image.

The Legend Options tab contains the following options.

Show Legend. When selected, a legend displays on a chart or visualization. Clear this
option to suppress a legend on a chart or visualization.

Legend Position. Opens a drop-down menu of options to position the legend. For example,
top or left.
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Reverse Legend Order. Specifies that the legend be drawn in reverse order. Clear this
option to specify that the legend be drawn in normal order.

Docking State. This option dictates how the legend is docked. It is set to Expanded, by
default, but you can set it to Collapsed, which will show that the legend is available (using
the grey arrow). This option saves real estate in your chart by collapsing the categorical text
labels in the legend while preserving the legend label colors. This is particularly useful
when items in your legend have long labels and you wish to truncate them for the purposes
of display. If you set this option to None, the ability to expand or collapse the legend is
removed and the grey arrow no longer displays.

Enable Scrolling. Select this check box to enable scrolling in your legend. This is
particularly useful when you have numerous entries in your legend. This check box is
selected, by default. To disable scrolling in your legend, clear the Enable Scrolling check
box. All legend options display in columns, and a scroll bar does not display.

Use the Markers & Labels tab to customize the appearance of markers and labels on legends. 

The Markers & Labels tab contains the following options:

Style Labels. Opens the Style dialog box, where you can style text.

Marker Position. Opens a drop-down menu of options to set the position of text relative to
the legend marker. For example, Left of Text or Above Text.

Use the Fill tab to modify the color of the legend area. For more information, see Format Series
Dialog Box on page 628.

Use the Border Styles tab to place a border around a legend. For more information, see Format
Series Dialog Box on page 628.

The Border Styles tab contains the following options:

Show Border. Select this option to place a border around a legend.

Color. With the Show Border option selected, you can click this button to open the Color
dialog box, where you can select a color for the border.

Legend Elements Shortcut Menu

When you right-click a legend on a chart, a menu of options opens. The menu contains options
that are available on the Format tab. 

The shortcut menu options are described in the following table. The table provides links to the
sections of this document in which those options are also discussed.
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Option Description

Show legend Controls the display of the legend. InfoAssist+ displays the legend
by default. When you clear this option, InfoAssist+ suppresses
the legend. For instructions, see Using Legend Properties on page
651.

The background shortcut menu has an option to restore the
legend after it has been suppressed.

Legend Position Controls the placement of the legend on the chart. For
instructions see, Using Legend Properties on page 651.

Legend Area Color Enables you to specify the color of the legend background area
using the Color dialog box.

This option is available only when you right-click the area around
the legend. For instructions see, Using Legend Properties on page
651.

Legend Border Color Enables you to specify the color of the border around the legend
background area using the Color dialog box.

This option is available only when you right-click the area around
the legend. For instructions see, Using Legend Properties on page
651.

More Legend Options Opens the Format Legend dialog box.

Using Legend Properties

The following sections contain procedures for customizing legend. The procedures are
organized by the tab and group in which their associated options appear on the ribbon.

Procedure: How to Hide a Legend

1. Create a chart or visualization with multiple measure fields.

2. Clear the Show legend option in one of the following ways:

Ribbon: On the Format tab, in the Labels group, click Legend, then click Show legend to
clear the option.

Shortcut Menu: Right-click the legend, and clear the Show legend option.
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The legend is hidden.

Procedure: How to Position a Legend

1. Create a chart or visualization with multiple measure fields.

2. Open the menu of label position options in one of the following ways:

Ribbon: On the Format tab, in the Labels group, click Legend, then point to Legend
Position.

Shortcut Menu: Right-click the legend, and point to Legend Position.

3. Select a position for the legend. For example, Auto or Right.

Procedure: How to Specify the Color of a Legend Border

1. Create a chart or visualization with multiple measure fields.

2. Open the Format Legends dialog box in one of the following ways:

Ribbon: On the Format tab, in the Labels group, click Legend, then click More Legend
Options.

Shortcut Menu: Right-click the legend, and click More Legend Options.

The Format Legends dialog box opens. For more information, see Format Legend Dialog
Box on page 648.

3. On the Border Styles tab, select the option to Show Border.

4. Click the Color icon to open the Color dialog box, where you can specify the color of the
legend border.

5. Click OK to close the Color dialog box.

6. Click OK to close the Format Legend dialog box.

The legend border is formatted accordingly.
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The following image is an example of a bar chart with a styled legend.

Formatting Gridlines

Gridlines are used on a chart as a reference to help you understand the quantities and values
of your data and decode information on the axis. There are four types of gridlines that you can
display and edit on your chart. They are: 

Horizontal major gridlines

Horizontal minor gridlines

Vertical major gridlines

Vertical minor gridlines

Major gridlines enhance the display of values, while minor gridlines supplement major
gridlines. If a plot point falls in between major gridlines, you can use minor gridlines for more
precise interpretation of the data.

Vertical gridlines in a vertical chart run on the X axis.

Horizontal gridlines in a vertical chart run on the Y axis.

Horizontal major gridlines enhance the display of values, compared to the Y-axis scale
alone. They are enabled by default on many charts. They do not apply to the pie, 3D,
gauge, spectral map, or funnel chart type.
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Horizontal minor gridlines are disabled by default. They do not apply to the pie, 3D, gauge,
spectral map, or funnel chart type.

Vertical major gridlines enhance the display of values, compared to the X-axis scale alone.
They are enabled by default. They do not apply to the pie, 3D, gauge, spectral map, or
funnel chart type.

Vertical minor gridlines are disabled by default. They do not apply to the pie, 3D, gauge,
spectral map, or funnel chart type.

Note: The orientation of a chart determines the available gridline options.

Format Grid Lines Dialog Box

You can format horizontal and vertical gridlines, color bands, and frames on a chart using the
options in the Format Grid Lines dialog box. For instructions on how to open this dialog box,
see the procedures in Using Gridline Properties on page 657. 

Color bands come in a pair, with each band uniquely colored. They appear in a continually
repeating pattern behind a series on a chart. The contrast of colors is designed to make the
chart easier to read.

Alternate formatting can be used to apply different colors to sections, called regions, of an
axis.

The Format Grid Lines dialog box contains the following tabs:

Major Grid Lines

Minor Grid Lines

Color Bands

Frames

Use the Major Grid Lines tab to format the major gridlines on the chart. 

The Major Grid Lines tab contains the following options:

Show Grid Lines. Select this option to display major gridlines on a chart if minor gridlines
are the default for the chart.

Line Style. Click this icon to open the Line Style dialog box, where you can edit the color,
weight, and style of the gridline.

Show Ticks. Select this check box to enable or disable the tick mark functionality.

Customizing Charts and Visualizations

654  Information Builders



Tick Style. Select from this drop-down menu of tick styles (Inside, Outside, Spanning).

Line Style. Click this icon to open the Line Style dialog box, where you can edit the color,
weight, and style of the gridline.

Use the Minor Grid Lines tab to format the minor gridlines on your chart. 

The Minor Grid Lines tab contains the following options:

Show Grid Lines. Select this option to display minor gridlines on a chart. By default, this
option is enabled.

Line Style. Click this icon to open the Line Style dialog box, where you can edit the color,
weight, and style of the gridline.

Grid count. Set the number of minor gridlines that will appear between major gridlines.

Show Ticks. Select this check box to enable or disable the tick mark functionality.

Tick Style. Select from this drop-down menu of tick styles (Inside, Outside, Spanning).

Line Style. Click this icon to open the Line Style dialog box, where you can edit the color,
weight, and style of the gridline.

Use the Color Bands tab to format the color bands on your chart. 

The Color Bands tab contains the following options:

Band 1. Select this option to add Band 1 to a chart.

Color. Click this icon to open the Color dialog box, where you can edit the color of Band
1.

Transparency. Move the slider to make Band 1 opaque (0%) or transparent (100%). The
default is 0%.

%. Enter or select the percentage of the transparency of Band 1.

Band 2. Select this option to add Band 2 to a chart.

Color. Click this icon to open the Color dialog box, where you can edit the color of Band
2.

Transparency. Move the slider to make the Band 2 opaque (0%) or transparent (100%).
The default is 0%.

%. Enter or select the percentage of the transparency of Band 2.
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Use the Quadrant Lines tab to control the placement and style of the quadrant lines in your
scatter and bubble chart. 

The Quadrant Lines tab contains the following options:

Show Quadrant Line. Select this option to show the quadrant line. Clear this option to
suppress the quadrant line.

Value. Enter a value to control where the quadrant line will be placed on the X axis.

Line Style. Click this icon to open the Line Style dialog box, where you can edit the
color, weight, and style of the quadrant line.

Use the Frames tab to enable or disable frame regions, and to set the location and style of the
frame text. 

The Frames tab contains the following options:

Show Frame Regions. Select this option to show a frame region. Clear this option to
suppress a frame region.

Region. Select from this drop-down list, the region that you want to format.

Add. Click this button to add a region.

Remove. Click this button to remove a region.

Location. Enter the location of the region.

Color. Click this icon to open the Color dialog box, where you can edit the color of the
frame.

Border Color. Click this icon to open the Color dialog box, where you can edit the color of
the frame border.

Text. Enter the text that you want to appear on the frame.

Style Text. Click this icon to style the frame text.

For instructions on how to open this dialog box, see the procedures in Using Gridline Properties
on page 657.

Gridline Elements Shortcut Menu

When you right-click a gridline on a chart, a menu of options opens. The options for the gridline
elements are described in the following table.
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Element Option Description

Horizontal Major Gridlines

Horizontal Minor Gridlines

Vertical Major Gridlines

Vertical Minor Gridlines

Delete Removes the gridline from the
chart and updates the Live
Preview accordingly.

Set Line Color Enables you to specify the color of
the gridline, using the Color dialog
box. For more information, see 
Color Dialog Box on page 621.

More Grid Lines
Options

Opens the Format Gridlines dialog
box.

Using Gridline Properties

The following sections contain procedures for customizing gridlines. 

Procedure: How to Display Horizontal Major Gridlines

If your chart does not display gridlines by default, use this procedure to generate gridlines.

1. Create a chart or visualization.

2. On the Format tab, in the Features group, open the Grid drop-down menu, point to
Horizontal Gridlines, and then click Major Gridlines.

Horizontal major gridlines are added to the chart.

Procedure: How to Display Horizontal Minor Gridlines

1. Create a chart or visualization.

2. Access the option to show gridlines in one of the following ways:

Ribbon: On the Format tab, in the Features group, open the Grid drop-down menu. On
the Grid drop-down menu, point to Horizontal Gridlines, and then click Minor Gridlines.

Shortcut Menu: Right-click the gridlines on the chart, and click More Grid Lines Options.
The Format Horizontal Grid Lines dialog box opens. On the Minor Grid Lines tab, select
Show Grid Lines.

Horizontal minor gridlines are added to the chart.
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Procedure: How to Display Vertical Major Gridlines

1. Create a chart or visualization.

2. Access the option to show gridlines in one of the following ways:

Ribbon: On the Format tab, in the Features group, open the Grid drop-down menu. On
the Grid drop-down menu, point to Vertical Gridlines, and then click Major Gridlines.

Shortcut Menu: Right-click the gridlines on the chart, and click More Grid Lines Options.
The Format Vertical Grid Lines dialog box opens. On the Major Grid Lines tab, select
Show Major Grid Lines.

Vertical major gridlines are added to the chart.

Procedure: How to Display Vertical Minor Gridlines

1. Create a chart or visualization.

2. Access the option to show gridlines in one of the following ways:

Ribbon: On the Format tab, in the Features group, open the Grid drop-down menu. On
the Grid drop-down menu, point to Vertical Gridlines, and then click Minor Gridlines.

Shortcut Menu: Right-click the gridlines on the chart, and click More Grid Lines Options.
The Format Vertical Grid Lines dialog box opens. On the Minor Grid Lines tab, select
Show Minor Grid Lines.

Vertical minor gridlines are added to the chart.

Procedure: How to Set the Color, Weight, and Style of a Gridline

1. Open the Format Grid Lines dialog box in one of the following ways:

Ribbon: On the Format tab, in the Features group, open the Grid drop-down menu, point
to the gridline type that you want to format, and click More Grid Lines Options.

Shortcut Menu: Right-click a gridline, and click More Grid Lines Options.

The Format Grid Lines dialog box opens.

2. Click the Line Style icon.

The Line Style dialog box opens.

3. Set the color, weight, and style of the gridline.

4. Click OK to close the Line Style dialog box.

5. Click OK again to close the Format Grid Lines dialog box.
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The gridline is formatted accordingly.

The following image shows a line chart with styling applied to the gridlines.

Procedure: How to Set Ticks

Ticks are short lines which are perpendicular to a gridline. They are used to tick off specific
increments along the gridline.

1. Create a chart or visualization with gridlines.

2. Open the Format Grid Lines dialog box in one of the following ways:

Ribbon: On the Format tab, in the Features group, open the Grid drop-down menu, point
to the gridline type that you want to format, and click More Grid Lines Options.

Shortcut Menu: Right-click a gridline, and click More Grid Lines Options.

The Format Grid Lines dialog box opens.

3. From the Tick Style drop-down menu select a tick style option. The options are:

Inside

Outside

Spanning
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4. Click the Line Style icon to open the Line Style dialog box, where you can edit the color,
weight, and style of the gridline.

5. Click OK to close the Line Style dialog box.

6. Click OK again to close the Format Grid Lines dialog box.

The tick marks are formatted accordingly.

The following image shows a chart with tick marks spanning both the vertical axis and
horizontal axis.

Procedure: How to Set Color Bands

1. Create a chart or visualization with gridlines.

2. Open the Format Grid Lines dialog box in one of the following ways:

Ribbon: On the Format tab, in the Features group, open the Grid drop-down menu, point
to the gridlines that you want to format, and click More Grid Lines Options.

Shortcut Menu: Right-click a gridline, and click More Grid Lines Options.

The Format Grid Lines dialog box opens.

3. On the Color Bands tab, click the Color icon to open the Color dialog box, where you can
set the color of the color bands.
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4. Use the transparency slider, or the percentage box, to type or select the percentage of the
transparency that you want to apply to the color.

5. Click OK to close the Color dialog box.

6. Click OK again to close the Format Grid Lines dialog box.

The following image shows a chart with color bands along the horizontal gridline.

Procedure: How to Delete a Gridline

1. Create a chart or visualization with gridlines.

2. Select a gridline.

3. Delete the gridline in one of the following ways:

Ribbon: On the Format tab, in the Features group, open the Grid drop-down menu. From
the menu, point to the gridline that you want to format, and click More Grid Lines to
open the Format Grid Lines dialog box. On the tab for the gridline that you want to
delete, clear the Show Grid Lines option, and click OK.

Shortcut Menu: Right-click the gridline, and from the menu, select Delete.

The gridline is deleted from the chart.
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Procedure: How to Display Quadrant Lines

Use the options on the Quadrant Lines tab to control the placement and style of the quadrant
lines in your scatter and bubble chart.

1. Create a scatter chart.

2. On the Format tab, in the Features group, click Grid.

3. On the drop-down menu, point to either Horizontal Gridlines or Vertical Gridlines, and then
click More Grid Lines Options.

The Format Grid Lines dialog box opens.

4. On the Quadrant Lines tab, select Show Quadrant Line.

The quadrant line displays on the chart.

5. Click OK to close the Format Grid Lines dialog box.

Procedure: How to Add Frames to Regions on a Chart

1. Create a chart or visualization.

2. On the Format tab, in the Features group, click Grid.

3. On the drop-down menu, point to either Horizontal Gridlines or Vertical Gridlines, and then
click More Grid Lines Options.

The Format Grid Lines dialog box opens.

4. On the Frames tab, select the Show Frame Regions check box.

5. Click Apply.

Colored frames are added to the chart, using the default styling options. Optionally, you
may use the color and border color options to change these.
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The following image shows a bar chart with colored frames around each region.

Formatting Axis Labels

Vertical and horizontal axes are based on the orientation of the graph. For example, in a
vertical graph, the horizontal axis refers to the X axis and the vertical axis refers to the Y axis.
In a horizontal graph, the horizontal axis refers to the Y axis and the vertical axis refers to the
X axis. This is important to consider, since options could change depending on the orientation
of the graph.

A chart can contain the following types of axis labels:

Horizontal axis labels represent the X axis. They do not apply to pie, funnel, or gauge
charts.

Vertical axis labels represent the Y1 axis in a single axis chart. They represent a numeric
scale, usually located on the left side of a vertical chart.
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Secondary horizontal and vertical labels can only be used when dual axes charts are
selected.

Format Axis Dialog Box

Whether you access axis options from the ribbon, or the shortcut menu, you are presented
with the Format Axis dialog box of options for formatting for both vertical and horizontal axes.
The Format Axis dialog box contains the following tabs:

General

Scale

Title

Labels

Advanced

Reference: Format Vertical Axis Dialog Box

You use the Format Vertical Axis dialog box to specify formatting options for the vertical axis in
your chart.

Use the Scale tab to modify scale properties. 

The Scale tab contains the following options:

Automatic Minimum. Supplies the minimum value on the Y-axis scale automatically. To
use manual scaling, clear this option. You can then set the minimum value by entering a
number into the Value text box.

Value. Type the minimum value in this text box if you have not selected Automatic
Minimum.

Automatic Maximum. Supplies the maximum value on the Y-axis scale automatically. To
use manual scaling, clear this option. You can then set the maximum value by entering a
number into the Value text box.

Value. Type the maximum value in this text box if you have not selected Automatic
Maximum.
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Automatic Grid Step. Calculates the number of major grid steps automatically. To use
manual scaling, clear this option. You can then set the value by typing the number into the
Value text box.

Value. Type the value in this text box if you have not selected Automatic Grid Step.

Logarithmic Scale. Controls whether or not the Y-axis scale progresses logarithmically
instead of linearly. This option is disabled by default. When selected, the logarithmic base
is set to 10.0, but can be changed by entering another value.

Log scale base. Type the base value to be shown on the logarithmic scale.

Include zero on scale. Controls whether or not a zero (0) value appears on the scale. This
option is enabled by default.

Use the Title tab to show or hide the axis title, and create and style the title for the axis. 

The Title tab contains the following options:

Show title. Select this check box to show the axis title (default) or clear the check box to
hide the axis title.

Text. Type a title for the axis in the Text field.

Style text. Opens the Style dialog box, where you can style the text.

Use the Labels tab to format the layout of the axis labels. 

The Labels tab contains the following options:

Show Labels. Displays labels next to the axis. This is enabled by default. Clear this option
to suppress labels.

Axis side. Contains a list of position options for the labels on the axis. The options are
Left (default), Right, or Both.

Style labels. Opens the Style dialog box, where you can style text.

Format Labels. Contains a list of preset formats that can be applied to the labels.

Custom Format. Allows you to use a custom format. This option is activated when Use
Pattern /100 and Use Pattern are selected as the format labels.

The Format Labels drop-down menu provides a list of preset formats that you can apply to
labels. When you select a custom format, it must be defined using a custom format pattern.
See the following table for a list and description of the characters that you can use in a
custom format.
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Character Description

# Is a digit.

0 (zero) Shows as absent.

. (period) Is a placeholder for a decimal separator.

, (comma) Is a placeholder for a grouping separator.

; (semicolon) Separates formats.

- (dash) Is the default negative prefix.

% (percent) Divides by 100 and shows as a percentage.

x Determines that any other characters can be used in the
prefix or suffix.

‘ (apostrophe) Is used to quote special characters in a prefix or suffix.

Use the Advanced tab to modify additional axis properties. 

The Advanced tab contains the following options:

Exclude Minimum Label. Excludes the label with the lowest axis value from the chart.

Exclude Maximum Label. Excludes the label with the highest axis value from the chart.

Descending Axis. Draws the axis in descending order.

Show axis line. Controls the display of the axis baseline.

Line Style. Opens the Line Style dialog box, where you can edit the color, weight, and
style of the axis line.

Show zero line. Controls the display of the zero line.

Line Style. Opens the Line Style dialog box, where you can edit the color, weight, and
style of the zero line.

Custom Baseline. Controls the display of the custom baseline.

Value. Type a value for the custom baseline.

Line Style. Opens the Line Style dialog box, where you can edit the color, weight, and
style of the custom baseline.
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For instructions on how to open this dialog box, see the procedures in Using Axis Properties on
page 669.

Reference: Format Horizontal Axis Dialog Box

You use the Format Horizontal Axis dialog box to specify formatting options for the horizontal
axis in your chart.

The General tab contains the Show axis line check box, which controls the display of the axis
line. When this check box is selected, you can style the axis line. 

The General tab contains the following options:

Show axis line. Enables the display of the axis line.

Line Style. Opens the Line Style dialog box, where you can edit the color, weight, and
style of the axis line.

Use the Title tab to create and style the title for the axis. 

The Title tab contains the following options:

Text. Type a title for the axis in the Text field.

Style. Opens the Style dialog box, where you can style the text.

Use the Labels tab to format the layout of the axis labels. 

The Labels tab contains the following options:

Show Labels. Displays labels next to the axis. This is enabled by default. Clear this option
to suppress labels.

Axis side. Contains a list of position options for the labels on the axis. The options are
Left (default), Right, or Both.

Style labels. Opens the Style dialog box, where you can style text.

Stagger Labels. Sets the labels to appear staggered.

Concatenate Labels. Concatenates the labels in your chart. This is enabled by default.

Use the Advanced tab to modify additional axis properties. 

The Advanced tab contains the following options:

Exclude Minimum Label. Excludes the label with the lowest axis value from the chart.

Exclude Maximum Label. Excludes the label with the highest axis value from the chart.
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Reverse Groups. Reverses the order of the display of the groups on the horizontal axis.

For instructions on how to open this dialog box, see the procedures in Using Axis Properties on
page 669.

Secondary Axes Options

Formatting options are available for secondary axes in dual-axis charts. For example, in a
vertical dual-axis chart, the secondary vertical axis refers to the Y2 axis.

The Format Secondary Axis dialog box contains the following tabs for both vertical and
horizontal axes:

General. For more information, see the Scale tab options in Format Axis Dialog Box on page
664.

Title. For more information, see the equivalent tab in Format Axis Dialog Box on page 664.

Labels. For more information, see the equivalent tab in Format Axis Dialog Box on page
664.

Advanced. For more information, see the equivalent tab in Format Axis Dialog Box on page
664.

Axis Elements Shortcut Menu

When you right-click an axis label or title in a chart in Live Preview, a menu of options opens.
The options for the right-click axis label elements are described in the following table.

Element Option Description

Axis Title Delete Deletes the axis title from the chart and updates the Live
Preview accordingly.

Change Title Enables you to change the axis title.

Style Title Enables you to apply styling to the axis title, using the Style
dialog box. For more information, see Style Dialog Box on
page 646.
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Element Option Description

Horizontal
Labels

Delete Deletes labels from the chart and updates the Live Preview
accordingly.

Stagger Controls the positioning of the labels. The On value
positions the labels in a zigzag pattern. The Off default
value positions the labels in a straight row.

Rotate Rotates the labels a specified number of degrees.

Style Labels Enables you to apply styling to the labels, using the Style
dialog box. For more information, see Style Dialog Box on
page 646.

More Axis
Options

Opens the Format Axis dialog box. For more information,
see Formatting Axis Labels on page 663.

Vertical
Labels

Delete Deletes labels from the chart and updates the Live Preview
accordingly.

Rotate Rotates the labels a specified number of degrees.

Format
Labels

Formats the labels according to the value that you specify.

Style Labels Enables you to apply styling to the labels, using the Style
dialog box. For more information, see Style Dialog Box on
page 646.

More Axis
Options

Opens the Format Axis dialog box. For more information,
see Formatting Axis Labels on page 663.

Using Axis Properties

The following sections contain procedures for customizing an axis. The procedures are
organized by the tab and group in which their associated options appear on the ribbon.

Axis labels appear by default.

Procedure: How to Delete Axis Labels

1. Create a chart or visualization.
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2. You can delete axis labels in one of the following ways:

Ribbon: On the Format tab, in the Labels group, open the Axes drop-down menu, point
to the axis that you are working with, and clear the Show Labels option.

Shortcut Menu: Right-click an axis label on the chart, and click Delete.

The axis labels are deleted from the chart.

Procedure: How to Stagger Axis Labels

Note: You can only apply a staggered effect to horizontal axis labels.

1. Create a chart or visualization with at least one axis label on display.

2. Access the Stagger option in one of the following ways:

Ribbon: On the Format tab, in the Labels group, open the Axes drop-down menu, point
to the axis that you are working with, and click Stagger Labels.

Shortcut Menu: Right-click an axis label on the chart, point to Stagger and select On.

The axis labels are staggered.

Procedure: How to Rotate Axis Labels

1. Create a chart or visualization with axis labels.

2. Access the Rotate option in one of the following ways:

Ribbon: On the Format tab, in the Labels group, open the Axes drop-down menu, point
to the axis that you are working with, point to Rotate Labels, and then click the degree
to which you want to rotate the axis labels.

Shortcut Menu: Right-click an axis label on the chart, point to Rotate, and then click
the degree to which you want to rotate the axis labels.

The axis labels are rotated.

Procedure: How to Format Axis Labels

1. Create a chart or visualization with an axis label.

2. Access the list of axis label options in one of the following ways:

Ribbon: On the Format tab, in the Labels group, open the Axes drop-down menu, point
to the axis that you are working with, and click More Axis Options to open the Format
Axis dialog box. Open the Labels tab, and from the Labels option drop-down menu,
select the formatting option that you want.
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Shortcut Menu: Right-click an axis label, point to Format Labels, and click the
formatting option that you want.

The axis labels are formatted accordingly.

Procedure: How to Manually Set the Scale of an Axis

1. Create a chart or visualization.

2. Open the Format Axis dialog box in one of the following ways:

Ribbon: On the Format tab, in the Labels group, open the Axes drop-down menu, point
to the axis that you are working with, and click More Axis Options.

Shortcut Menu: Right-click an axis value on the chart, and click More Axis Options.

The Format Axis dialog box opens.

3. On the scale tab, clear the Automatic Minimum option and enter your own minimum value
in the Value text box.

4. Clear the Automatic Maximum option, and enter your own maximum value in the Value text
box.

5. Clear the Automatic Grid Step option, and enter your own grid step value in the Value text
box.

6. Optionally, you can select the Logarithmic Scale option and enter the log scale base in the
text field of that name. You can also clear the Include zero on scale option if you do not
want zero to appear on the axis.

7. Click OK to close the dialog box.

The axis scale is set accordingly.

Procedure: How to Add an Axis Title

1. Create a chart or visualization with an axis label.

2. Open the Format Axis dialog box in one of the following ways:

Ribbon: On the Format tab, in the Labels group, open the Axes drop-down menu, point
to the axis that you are working with, and click More Axis Options.

Shortcut Menu: Right-click an axis label, and click More Axis Options.

The Format Axis dialog box opens.

3. On the Title tab, type the axis title in the Text field.

4. Click the Style text icon to open the Style dialog box, where you can style the text.
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The axis title is styled accordingly.

Note: Right-click the axis title to delete, change, or style the axis title.

Procedure: How to Set Advanced Axis Properties

1. Create a chart or visualization with an axis label.

2. Open the Format Axis dialog box in one of the following ways:

Ribbon: On the Format tab, in the Labels group, open the Axes drop-down menu, point
to the axis that you are working with, and click More Axis Options.

Shortcut Menu: Right-click an axis label, and click More Axis Options.

The Format Axis dialog box opens.

3. On the Advanced tab, set the following options:

Exclude Minimum Label

Exclude Maximum Label

Descending Axis

Show axis line

Show zero line

Custom Baseline (Value)

You can edit the color, weight, and style of all the lines that you set in the Line Style
dialog box.

4. Click OK.

The axis advanced options are set accordingly.

Formatting a Frame and a Background

The frame of a chart is the area that contains the plot points. It is also the area in which
horizontal and vertical gridlines are drawn. 

The background of a chart is the area around the frame.
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You can adjust the appearance of the frame and background to achieve different visual effects
for your charts. For example, you can change the appearance of the chart frame line, or you
can change the color of the background of your chart, as shown in the following image.

Frame & Background Dialog Box

Whether you access frame and background options from the ribbon, or the shortcut menu, you
are presented with the Frame & Background dialog box of options for formatting the frame and
background of a chart. The Frame & Background dialog contains the following tabs:

Frame

Frame Edge

Background

The Frame & Background dialog box and pertinent tabs are discussed in this section for the
following types of charts:

2D Charts and 2D Charts with 3D Effects (Frame and Frame Edge tabs)

Pie Charts (Frame and Frame Edge tabs)

3D Charts (Left Wall, Right Wall, Floor, and Advanced tabs)

Note: The options in the Frame tab vary based on the chart type selected.
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Use the Frame tab for 2D charts and 2D charts with 3D effects to set a frame depth angle and
depth radius, select a fill for a frame, and set a shadow for a frame for these types of charts. 

The Frame tab for 2D charts and 2D charts with 3D effects contains the following options:

Depth Angle. Enter the angle from the front of the chart to the back where the chart risers
and frames are drawn. You can set the depth angle from zero to 180 degrees, but it must
be used along with Depth Radius.

Depth Radius. Enter how far out the extruded frame will be extended. Small values, such
as zero, produce very narrow charts. Large values, the maximum being 100, produce
thicker charts.

Fill

No fill. (Default). Select this option to keep the legend colorless.

Solid fill. Select this option to display the Color and Transparency options.

Color. Click this icon to open the Color dialog box, where you can select a color for a
frame.

Transparency. Move the slider to make the frame opaque (0%) or transparent (100%).
The default is 0%.

Gradient fill. Select this option to display the direction of the gradient, the color pattern of
the gradient, and the degrees of transparency for the two colors that make up the gradient.
A gradient is a smooth color transition or blending of one color to another. The number of
colors to use in a gradient is defined by the stop or pin elements.

Direction. Select from this drop-down menu to set the direction of the gradient fill. For
example, Gradient right or Gradient left.

Gradient style

Color Pattern. Select the color pattern for the data series. The color pattern option on the
left is an AB wash that uses two colors in the pattern color1 - color2, for example, red-
green. The color pattern option on the right is an ABA wash that uses two colors in the
pattern color1 - color2 - color1, for example, red-green-red.

First Color. Click this icon to open the Color dialog box, where you can select a color for the
first color.

Second Color. Click this icon to open the Color dialog box, where you can select a color for
the second color.
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Shadow

Show Shadow. Select this option to set a shadow.

Use the Frame Edge tab for 2D charts and 2D charts with 3D effects to set a frame depth
angle and depth radius, select a fill for a frame, and set a shadow for a frame for these types
of charts. 

The Frame tab for 2D charts and 2D charts with 3D effects contains the following options:

Automatically Shade Frame Edge. Select this option to automatically shade the frame
edge. Clear this option to enable the Side Frame and Bottom Frame options.

Side Frame

Show Color. Select this option to show the color of the side frame.

Color. Click this icon to open the Color dialog box, where you can select a color for the side
frame.

Show Border Color. Select this option to show the color of the border of the side frame.

Border Color. Click this icon to open the Color dialog box, where you can select a color for
the border of the side frame.

Bottom Frame

Show Color. Select this option to show the color of the bottom frame.

Color. Click this icon to open the Color dialog box, where you can select a color for the
bottom frame.

Show Border Color. Select this option to show the color of the bottom frame.

Border Color. Click this icon to open the Color dialog box, where you can select a color for
the border of the bottom frame.

Use the Frame tab for pie charts to set pie depth and tilt, select a fill and color for a pie frame,
and set a shadow for the frame. 

The Frame tab for pie charts contains the following options:

Pie Depth. Set the depth of the edge of a pie chart. You can select a value from zero to
100 to set the thickness of an edge.

Pie Tilt. Set the tilt of the pie chart. The smaller the value you add, the flatter the pie chart
appears. The larger the value you add, more of the pie edge appears.
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Fill

No fill. (Default). Results in no color added to the edge of the pie.

Solid fill. Select this option to display the Color and Transparency options.

Color. Click this icon to open the Color dialog box, where you can select a color for the
frame.

Transparency. Move the slider to make the fill opaque (0%) or transparent (100%). The
default is 0%.

Gradient fill. Select this option to display the direction of the gradient, the color pattern of
the gradient, and the degrees of transparency for the two colors that make up the gradient.
A gradient is a smooth color transition or blending of one color to another. The number of
colors to use in a gradient is defined by the stop or pin elements.

Direction. Select from this drop-down menu to set the direction of the gradient fill. For
example, Gradient right or Gradient left.

Gradient Style

Color Pattern. Select the color pattern for the data series. The color pattern option
on the left is an AB wash that uses two colors in the pattern color1 - color2, for
example, red-green. The color pattern option on the right is an ABA wash that uses
two colors in the pattern color1 - color2 - color1, for example, red-green-red.

First Color. Click this icon to open the Color dialog box, where you can select a color
for the first color.

Second Color. Click this icon to open the Color dialog box, where you can select a
color for the second color.

Shadow

Show Shadow. Select this option to set a shadow around the frame.

Use the Frame Edge tab for pie charts to set the edge of a pie frame. 

The Frame Edge tab for pie charts contains the following options:

Automatically Shade Frame Edge. Select this option to automatically shade the frame
edge. Clear this option to enable the Side Frame and Bottom Frame options.

Show Color. Select this option to show the color of the side frame.

Color. Click this icon to open the Color dialog box, where you can select a color for side
frame.
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Show Border Color. Select this option to show the color of the border of the side frame.

Border Color. Click this icon to open the Color dialog box, where you can select a color for
the border of the side frame.

Bottom Frame

Show Color. Select this option to show the color of the bottom frame.

Color. Click this icon to open the Color dialog box, where you can select a color for the
bottom frame.

Show Border Color. Select this option to show the color of the bottom frame.

Border Color. Click this icon to open the Color dialog box, where you can select a color for
the border of the bottom frame.

Use Wall and Floor tabs to set the walls and floor of a 3D chart. 

These Wall and Floor tabs contain the following options:

Show Wall or Show Floor. Select this option to show the wall or floor (depending on the
tab) of the 3D chart.

Wall Thickness. Specify the thickness of the wall or floor.

Cube Size. Specify the cube size of the wall or floor.

Color. Click this icon to open the Color dialog box, where you can select a color for the wall
or floor.

Border Color. Click this icon to open the Color dialog box, where you can select a color for
the border of the wall or floor.

Show Wall (Left Wall). Select this option to show the left wall.

Show Wall (Right Wall). Select this option to show the right wall.

Show Floor. Select this option to show the floor.

Use the Advanced tab for 3D charts to modify additional properties for 3D frames. 

The Advanced tab contains the following options:

Viewing Angles. Select from a drop-down menu of viewing angles for three-dimensional
charts. For example, Standard or Group View.

Isometric Projection. Select this option to ignore perspective distortion in a project graph
cube from an isometric view.
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Proportional Cube. Select this option to define the axis size proportional to the number of
series or groups.

Automatic shading of walls. Select this option to shade chart walls.

Automatically Shade Frame Edge. Select this option to automatically shade the frame
edge.

3D Zoom Factor. Enter a value in the text box to set the global scaling factor for
zooming in and out in a 3D chart. Smaller values zoom out and produce a smaller
display of the chart within a frame. Larger values zoom in and produce a larger display
of the chart within a frame.

Pan Horizontally. Enter a value in the text box to pan a 3D chart in the horizontal
direction. Smaller values move the frame of the chart to the left. Larger values move the
frame of the chart to the right.

Pan Vertically. Enter a value in the text box to pan a 3D chart in the vertical direction.
Smaller values move the frame of the chart upward. Larger values move the frame of
the chart downward.

Use the Background tab to set and customize a border for a chart. 

The Background tab contains the following options:

Show Border Color. Select this option to show the color of the border.

Border Color. Click this icon to open the Color dialog box, where you can select a color for
the border.

Solid fill. Select this option to display the Color and Transparency options.

Color. Click this icon to open the Color dialog box, where you can select a color for the
frame.

Transparency. Move the slider to make the background opaque (0%) or transparent
(100%). The default is 0%.

Gradient fill. Select this option to display the direction of the gradient, the color pattern of
the gradient, and the degrees of transparency for the two colors that make up the gradient.
A gradient is a smooth color transition or blending of one color to another. The number of
colors to use in a gradient is defined by the stop or pin elements.

Direction. Select from this drop-down menu to set the direction of the gradient fill. For
example, Gradient right or Radial.
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Gradient Style

Color Pattern. Select the color pattern for the data series. The color pattern option on the
left is an AB wash that uses two colors in the pattern color1 - color2, for example, red-
green. The color pattern option on the right is an ABA wash that uses two colors in the
pattern color1 - color2 - color1, for example, red-green-red.

First Color. Click this icon to open the Color dialog box, where you can select a color for the
first color.

Second Color. Click this icon to open the Color dialog box, where you can select a color for
the second color.

For instructions on how to open this dialog box, see the procedures in Using Frame and
Background Properties on page 680.

Frame and Background Shortcut Menu

When you right-click a chart background, a menu of options opens. The options for the
background and frame elements are described in the following table.

Element Option Description

Background Background Color Enables you to specify the color of the
background, using the Color dialog box. For
instructions, How to Change the Color of
the Background on page 681.

Show legend Controls the display of the legend on the
background. When selected, it displays the
legend. When cleared, it suppresses the
display of the legend.

More Frame and
Background Options

Opens the Frame & Background dialog box.
For more information, see Frame &
Background Dialog Box on page 673.
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Element Option Description

Frame Frame Color Enables you to specify the color of the
frame, using the Color dialog box. For more
information, see Color Dialog Box on page
621.

Show 3D Controls the depth of the frame. The value
On renders the frame in 3D depth. The
value Off renders the frame in one
dimension.

More Frame and
Background Options

Opens the Frame & Background dialog box.
For more information, see Frame &
Background Dialog Box on page 673.

Using Frame and Background Properties

The following sections contain procedures for customizing frame and background properties.
The options for the following procedures are found in the Features group of the Format tab.

Procedure: How to Change the Color of the Frame

The default color of the frame in a chart is determined by the Document Theme selected on
the Options window. For more information, see Changing InfoAssist+ User Preferences on page
251.

This procedure describes how to change the color of the frame.

1. Create a chart or visualization.

2. Access the Frame & Background dialog box in one of the following ways:

Ribbon: On the Format tab, in the Features group, click Frame & Background.

Shortcut Menu: Right-click the chart, and click More Frame & Background Options.

The Frame & Background dialog box opens.

3. On the Frame tab, in the Fill area, click the Color icon.

Note: Solid fill must be selected for the Color icon to appear.

The Color dialog box opens. Select a new color for the frame. For more information on the
Color dialog box, see Color Dialog Box on page 621. You can also set the depth angle and
depth radius for the frame, as well as set a shadow for the frame.
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4. Click OK.

The chart displays the new frame color.

Procedure: How to Change the Color of the Background

The default color of the background of a chart is determined by the Document Theme selected
on the Options window. For more information, see Changing InfoAssist+ User Preferences on
page 251.

1. Create a chart or visualization.

2. Open the Frame & Background dialog box in one of the following ways:

Ribbon: On the Format tab, in the Features group, click Frame & Background.

Shortcut Menu: Right-click the background of the chart, and click Background Color.

The Frame & Background dialog box opens.

3. On the Background tab, in the Fill area, click the Color icon.

The Color dialog box opens. Select a new color for the background. For more information
on the Color dialog box, see Color Dialog Box on page 621.

4. Click OK.

The chart displays the new background color.

Formatting a Gauge Chart

A gauge chart is a circular chart that indicates the current position of a single data value within
a given spectrum.

You can change the appearance of a gauge chart by using the gauge chart options found on
the Format Gauge dialog box. To access the Format Gauge dialog box, on the Format tab, in
the Features group, click Gauges.

Format Gauge Dialog Box

Whether you access gauge options from the ribbon, or the shortcut menu, you are presented
with the Format Gauge dialog box of options for formatting a gauge chart. Such options include
setting and styling a title for the gauge chart, setting tick marks, enabling and styling color
bands, as well as setting advanced options, such as the gauge start and stop angle. 

The Format Gauge dialog box contains the following tabs:

General Options
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Axis Scale & Labels

Tick Marks

Bands

Advanced

Use the General Options tab to set general gauge options. 

The General Options tab contains the following options:

Gauges per row. Enter or select how many gauges appear on each row. The default setting
displays two gauge charts. A maximum of 32 gauge charts can appear on each row.

Note: The number of charts displayed per row can differ, based on the output format
selected. For example, HTML format will display two charts per row, and HTML5 will display
three.

Gauge Needle

Style. Select a style from a drop-down menu of options to be applied to the gauge needle.
For example, Pencil.

Color. Click this icon to open the Color dialog box, where you can select a color for the
gauge needle.

Note: If you are working with a gauge chart with more than one series, then you use the
Format Series dialog box to format the color of the gauge needle and its border.

Border Color. Click this icon to open the Color dialog box, where you can select a color for
the gauge needle border.

Note: If you are working with a gauge chart with more than one series, then you use the
Format Series dialog box to format the color of the gauge needle and its border.

Gauge Title

Show title. (Default) Displays a gauge title appear for each gauge. Clear this option to
suppress the title.

Position. Select a position for the gauge title. Above is the default value.

Style. Click this icon to open the Style dialog box, where you can style text.

Gauge value

Show value. (Default) Clear this option to suppress the gauge value.
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Style. Click this icon to open the Style dialog box, where you can style text.

Format Value. Contains a list of preset formats that can be applied.

Custom Format. Allows you to use a custom format. This option is activated when Use
Pattern /100 and Use Pattern are selected as the format labels.

Use the Axis Scale & Labels tab to set the axis scale and label properties for the gauge
needle. 

The Axis Scale & Labels tab contains the following options:

Scale

Automatic Minimum. (Default) Sets the engine to automatically supply the minimum value
on the scale. Clear this option to manually set the minimum value by entering a number
into the Value text box.

Value. Enter the minimum value in this text box if you have not selected Automatic
Minimum.

Automatic Maximum. (Default) Sets the engine to automatically supply the maximum value
on the scale. Clear this option to manually set the maximum value by entering a number
into the Value text box.

Value. Enter the maximum value in this text box if you have not selected Automatic
Maximum.

Labels

Show Labels. (Default) Displays labels next to the axis. Clear this option to suppress
labels.

Style Labels. Click this icon to opens the Style dialog box, where you can style text.

Format Labels. Select from a drop-down menu of present formats that can be applied to
the labels. When a custom format is selected, the format must be defined using a custom
format pattern. For a list and description of the characters that you can use in a custom
format, see the table in Formatting Data Labels on page 642.

Custom Format. Text field to enter the custom format that you want to use.

The Tick Marks tab contains options to format tick marks on a gauge chart. 
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The Tick Marks tab contains the following options:

Automatic Grid Step. (Default) Automatically calculates the number of major grid steps in a
gauge chart. Clear this option to manually set the value by entering a number in the Value
text box.

Value. Enter the value in this text box if you have not selected Automatic Grid Step.

Tick Color. Click this icon to open the Color dialog box, where you can select a color for the
tick marks.

Tick Mark Length. Enter a value for the relative length of major tick marks in a gauge chart.
The valid range is from 0.0 to 0.5. If you set the smallest value, major tick marks do not
appear.

The Bands tab contains options to format the color of the scale background on a gauge chart. 

The Bands tab contains the following options:

Band 1. Opens a drop-down menu of available bands.

Add. Adds the band selected from the drop-down menu of bands to the gauge chart.
You can create up to five bands for a gauge chart.

Remove. Removes the band selected from the drop-down menu of bands to the gauge
chart.

Minimum Value. Enter a minimum value to a quality band in the gauge chart.

Maximum Value. Enter a maximum value to a quality band in the gauge chart.

Border Color. Opens the Color dialog box, where you can edit the color of the gauge band
border.

Fill

No fill. Removes fill from the quality band.

Solid fill. (Default) Applies a solid color to the quality band.

Color. Click this option to open the Color dialog box, where you can select the color for the
quality band.

Transparency. Move the slider to make the band opaque (0%) or transparent (100%). The
default is 0%.

The Advanced tab contains options to set additional properties for the gauge needle. 
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The Advanced tab contains the following options:

Descending Axis. Select this option to draw the gauge scale in descending order. When
this option is cleared (default), the gauge scale is drawn in ascending order.

Show Zero Label. Displays the zero label on the axis scale. Clear this option to start the
gauge at another value. This option is selected by default.

Gauge Center by Quality. Select this option to have the center of the gauge needle appear
in the same the color as the band to which it is pointing.

Gauge Start Angle. Enter a value to rotate the gauge start angle to a specified number of
degrees. Values can range from 0 to 359 degrees. The default is 220 degrees.

Gauge Stop Angle. Enter a value to rotate the gauge stop angle to a specified number of
degrees. Values can range from 0 to 359 degrees. The default is 320 degrees. Setting a
start angle to 0, and a stop angle to 180, creates a semi-circle.

Relative Inner Radius. Enter a value to define the inner radius of the gauge bands and
labels relative to the outer background of the gauge. Smaller values, such as 0.0, place the
inner radius closer to the center of the gauge. A maximum value of 1.0, places the inner
radius close to the gauge outline.

Relative Thickness. Enter a value to define the relative thickness of the gauge bands.
Values can range from 0.0 to 1.0.

Same Size Gauges. This option applies to multi-category gauge charts. If you are working
with three or more gauges per row, you can select this option to have the gauges display in
the same size.

Gauge Elements Shortcut Menu

When you right-click a gauge chart, a menu containing the More Gauge Options becomes
available. Select this option to open the Format Gauge dialog box. This is only available when
using the HTML output format. 

Using Gauge Properties

The following sections contain procedures for gauge properties. The Gauges option can be
found on the Format tab, in the Features group. 

Note: This option is only available when you are working with a gauge chart.
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Procedure: How to Set the Number of Gauges Per Row

If you have multiple gauges on a chart, you might want to specify how many gauges appear on
each row.

1. Create a gauge chart that has multiple values.

2. Open the Format Gauge dialog box in one of the following ways:

Ribbon: On the Format tab, in the Features group, click Gauges.

Shortcut Menu: Right-click the gauge chart and select More Gauge Options.

The Format Gauge dialog box opens.

3. On the General options tab, in the Gauges per row field, enter or select the number of
gauges that you want to appear on one row.

4. Click OK.

The gauges now appear on one row.

After changing the setting from the default of 2 gauges per row to 3 gauges per row, all
the charts now appear on one row.

Procedure: How to Set the Minimum and Maximum Axis Scale Values

1. Create a gauge chart.

2. Open the Format Gauge dialog box in one of the following ways:

Ribbon: On the Format tab, in the Features group, click Gauges.

Shortcut Menu: Right-click the gauge chart, and click More Gauge Options.

The Format Gauge dialog box opens.

3. On the Axis Scale & Labels tab, in the Scale area, either accept the minimum and
maximum values for the scale automatically supplied by the chart engine, or enter your
own in the Value fields.

4. Click Apply.

The gauge scale reflects the selections that you have made.

Procedure: How to Style Axis Labels

1. Create a gauge chart.
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2. Open the Style dialog box in one of the following ways:

Ribbon: On the Format tab, in the Features group, click Gauges to open the Format
Gauge dialog box. In the Format Gauge dialog box, open the Axis Scale & Labels tab. In
the Labels area, click the Style Labels icon.

Shortcut Menu: Right-click an axis label, and click Style.

The Style dialog box opens.

3. Select your styling options.

4. Click OK.

The scale labels reflect the style selections that you have made.

Procedure: How to Format Axis Labels

1. Create a gauge chart.

2. Access the menu of available format options for axis labels in one of the following ways:

Ribbon: On the Format tab, in the Features group, click Gauges to open the Format
Gauge dialog box. In the Format Gauge dialog box, open the Axis Scale & Labels tab. In
the Labels area, open the Format Labels drop-down menu.

Shortcut Menu: Right-click an axis label, and point to Format.

The menu of available format options opens.

3. Select your format option.

Note: If you select a custom format (for example, User Pattern, or Use Pattern /100), from
the Format Labels menu on the Format Gauge dialog box, the Custom Format menu
becomes available. When you select a custom format, it must be defined using a custom
format pattern. For a list and description of the characters that you can use in a custom
format, see the table in Formatting Data Labels on page 642.

4. Click OK.

The scale labels reflect the format selection that you have made.

Procedure: How to Rotate Axis Labels

1. Create a gauge chart.

2. Right-click an axis label.

3. On the shortcut menu, point to Rotate, then select the degree to which you want the labels
rotated.
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Procedure: How to Set Gauge Tick Marks

This procedure describes how to set the grid step, tick color, and tick length for the major and
minor tick marks.

1. Create a gauge chart.

2. Open the Format Gauge dialog box in one of the following ways:

Ribbon: On the Format tab, in the Features group, click Gauges.

Shortcut Menu: Right-click the gauge chart and select More Gauge Options.

The Format Gauge dialog box opens.

3. On the Tick Marks tab, for the Automatic Grid Step, either accept the value automatically
supplied by the chart engine, or enter your own, in the Value fields.

4. Click the Tick Color icon, to open the Color dialog box, where you can select a color for the
tick mark.

5. For the Tick Mark Length, either accept the value automatically supplied by the chart
engine, or enter your own, in the Value fields.

Procedure: How to Set Gauge Color Bands

1. Create a gauge chart.

2. Open the Format Gauge dialog box in one of the following ways:

Ribbon: On the Format tab, in the Features group, click Gauges.

Shortcut Menu: Right-click the gauge chart, and click More Gauge Options.

The Format Gauge dialog box opens.

3. Set the minimum and maximum value for each band that you want to appear on the gauge
chart.

4. Set the color of the fill and border for each color band.

Note: The gradient fill option is not available for color bands.

5. Click OK to close the Format Gauge dialog box.

The bands are formatted accordingly.
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Procedure: How to Match Needle Center Color to Band Color (Gauge Center by Quality)

This option matches the needle center color to the color of the band that the needle is pointing
to.

1. Create a gauge chart.

2. On the Format tab, in the Features group, click Gauges.

The Format Gauge dialog box opens.

3. On the Bands tab, set the minimum and maximum value for each band that you want to
appear on the gauge chart

4. Set the color of the fill and border for each color band.

Note: The gradient fill and transparency options are not available for gauge needles.

5. On the Advanced tab, select Gauge Center by Quality.

Note: This option displays in HTML, but not in HTML5.

6. Click OK to close the Format Gauge dialog box.

The color of the center of the gauge needle now matches the color of the band.

Procedure: How to Style a Gauge Needle

This procedure explains how to change the gauge needle from the Normal style to the Pencil
style.

1. Create a gauge chart.

2. Open the Format Gauge dialog box in one of the following ways:

Ribbon: On the Format tab, in the Features group, click Gauges.

Shortcut Menu: Right-click the gauge chart, and click More Gauge Options.

3.
The Format Gauges dialog box opens.

4. In the General Options tab, in the Gauge Needle section, from the Style drop-down menu,
select Pencil.

5. Click OK.

The gauge needle changes to a pencil.

5. Customizing Content

Online Help PDF  689



Procedure: How to Set Gauge Needle Colors in a Multi Series Gauge Chart

You cannot change the fill color and border color of the needles in a multi-series gauge chart
through the General Options tab of the Format Gauge dialog box. You can do so through the
Format Series dialog box. However, you can still use the General Options tab to change the
style of the needle.

1. Create a gauge chart with more than one measure field.

2. On the Series tab, from the Series drop-down menu, select the series that you want to
style.

3. In the Properties group, click Style.

The Format Series dialog box opens.

4. On the Fill tab, select the fill and color options for the gauge needle for the selected
series.

5. On the Border tab, select the Show Border Color option, if you want the gauge needle to
have a border. You can select the color for the border, as well.

6. Click Apply.

7. Repeat steps 2 through 5 for each series gauge needle that you want to style.

8. When you are finished, click OK to close the Format Series dialog box.

The color of the gauge needles and their borders changes accordingly.

Formatting Page Headings and Page Footings

Page headings and page footings supply context and key information about a chart, such as its
purpose, audience, and author. Page headings and page footings also enhance visual appeal.

Procedure: How to Add a Page Heading and Page Footing to a Chart

The procedure uses sample values, but you can supply values that apply to your own charts. 

This feature is available in Query Design view, Live Preview, and Document view.

1. Create a chart or visualization.

2. On the Home tab, in the Report group, click Header & Footer.

The Header & Footer dialog box opens.

Tip: Another way to access the Heading & Footing dialog box is to click the arrow next to
the Header & Footer button. Doing so opens a drop-down menu from which you can select
the heading or footing that you want to work with. After you make your selection, the
Header & Footer dialog box opens, and the heading or footing that you selected is active.
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3. Click the tab for the page heading or page footing, depending on which you want to add.

By default, the Page Heading tab is selected. In this procedure, accept the default to add
a page heading first.

4. Click inside the design area of the dialog box, and type the text for the page heading.

For example, the text for a sample page heading might be Customers By Occupation.

5. Using the styling options, apply styling to the page heading text.

For example, 14 pt. bold Helvetica with center alignment.

6. Click Apply to save the changes that you have made, without closing the dialog box.

7. To add a page footing, click the Page Footer tab.

For this procedure, you are going to add one of the supplied quick text options, followed by
some text of your own.

8. Click the down arrow next to the preformatted text button, and click Created by from the
drop-down list.

9. Complete the text by typing the applicable value within the supplied text, for example,
Sales Manager.

10. Change the styling as you want.

11. Click OK to save the page heading and page footing and close the Header & Footer dialog
box.

The chart contains the page heading and page footing that you added and styled.
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The following image shows a chart with a styled header and footer.

12. To make changes to either the page heading or page footing, return to Design view. Right-
click the header or footer, and click Edit from the drop-down menu.

Procedure: How to Control the Rendering of a Page Heading and Page Footing

You can control the way in which a page heading and page footing are rendered on a chart at
run time.

1. Create a chart or visualization.

2. Open the Header & Footer dialog box, as described in How to Add a Page Heading and
Page Footing to a Chart on page 690.

3. Click the Text options for chart button .

A drop-down menu, with two options for rendering the page heading and page footing,
opens.

Tip: Your selection for a page heading also applies to a page footing, and vice versa.

Create Header and Footer as text renders the heading and footing as text elements
that are separate from the chart image.

Embed Header and Footer in the chart renders the heading and footing text as part of
the chart image. This is the default value.
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4. Click OK to save your selection and close the Heading & Footing dialog box.

Using Additional Formatting Features

This section describes additional formatting features that are available for charts.

Procedure: How to Set 3D Depth on a Bar Chart

You can apply a 3D-effect to a 2D-chart. 

Note: If you find that the depth of the 3D effect makes it difficult to distinguish the values on
the Y-axis scale, then you can turn this option off. This procedure explains how to set the 3D
effect for a default vertical bar chart.

The following image shows a bar chart before the 3D effect is applied.

1. Create a 2D chart.

2. In Live Preview, apply the 3D effect in one of the following ways:

Ribbon: On the Format tab, in the Features group, click 3D Effect.

Shortcut Menu: Right-click the frame of the chart, point to Show 3D, and click On.
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The 3D effect is applied to the chart, as shown in the following image.

Procedure: How to Rotate a Chart

You can rotate bar, line, and area charts to change the orientation of the data.

1. Create a chart or visualization.

2. On the Format tab, in the Features group, click Rotate.

The chart is rotated 90 degrees clockwise.

Procedure: How to Display a Static Reference Line

Reference lines draw attention to specific data locations on a chart. You can add up to three
horizontal (X axis) and three vertical (Y axis) reference lines to a chart. 

Reference lines can be created using either a constant or a computed field.

Field values allow a property to be dynamic, so that the reference line can change position
dynamically on the chart depending on the value of the field that is assigned to it.
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Note: A reference line value should be a single value, such as 10K, for example. In the
Reference line dialog box, if you select a field with multiple values, (Quantity Sold, for
example), then InfoAssist+ plots the last value on the chart.

1. Create a chart or visualization.

2. On the Format tab, in the Features group, click Reference.

3. In the drop-down menu that opens, select one of the following:

Add Reference Line to Y-Axis

Add Reference Line to X-Axis

The Reference Line dialog box opens. 

4. Create the reference line with a static value that you set.

a. Select the Value option.

b. In the Value text field, type the value that you want to distinguish with the reference
line.

5. In the Text field, type the text for the reference line.

6. In the Position drop-down menu, select the position for the reference line on the chart. For
example, Above Center.

7. Click the Style button to set the style for the reference line. For example, Solid.

8. Click the Color button to open the Color dialog box, where you can select a color for the
reference line and the text.

9. Click the Weight button to select the weight of the reference line. For example, 1px - Light.

10. Click OK to save the options that you have selected, and close the Reference Line dialog
box.

The reference line is added to the chart.

Procedure: How to Display a Dynamic Reference Line

Reference lines can be created using either a constant or a computed field. 

Field values allows a property to be dynamic, so that the reference line can change position
dynamically on the chart depending on the value of the field that is assigned to it.

Note: A reference line value should be a single value, such as 10K, for example. In the
Reference line dialog box, if you select a field with multiple values, (Quantity Sold, for
example), then InfoAssist+ plots the last value on the chart.
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The following procedure provides an example of how to create a dynamic reference line, where
the value changes based on the date. In this example, you can track the number of estimated
delivery days per shipping company, where the number of days estimated for delivery are
based on whether or not the sale date is a holiday.

1. Create a COMPUTE field to calculate the Reference Line.

a. On the Data tab, in the Calculation group, click Summary (Compute).

The Summary Field (COMPUTE) dialog box opens.

b. In the Field text box, enter Reference.

c. Set the format to D12.2.

d. Enter IF WF_RETAIL_LITE.WF_RETAIL_TIME_SALES.TIME_HOL EQ 'Y' THEN 5 ELSE 2
into the expression.

e. Click OK to close the dialog box.

2. Hide the Reference field from the chart.

3. Add a dynamic reference line.

a. On the Format tab, in the Features group, click Reference.

b. From the drop-down menu, select Add Reference Line to Y-Axis.

The Reference Line dialog box opens.

c. Select the Field option.

d. From the Field drop-down menu, select Reference.

e. In the Text field, enter Acceptable.

f. From the Weight drop-down menu, select 2px - Medium.

g. From the Position drop-down menu, select Above Left.

h. Optionally, you can change the color and style of the Reference line.

i. Click OK to close the Reference Line dialog box.

4. Run the chart.

Auto Prompt appears.

a. Select 20100101 (January 1, 2010) and click Run to see that five days are
acceptable since the date is a holiday.

b. Select 20100202 (January 2, 2010) and click Run again to see that two days are
acceptable since the date is not a holiday.

5. Click Save.
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Procedure: How to Display Annotations

Annotations are explanatory notes or comments. You can add up to eight annotations on a
chart. 

1. Create a chart or visualization.

2. On the Format tab, in the Features group, click Annotate.

3. In the drop-down menu that opens, click Add an annotation.

The Annotation dialog box opens.

4. In the text input field, type the text for the annotation.

5. In the Position drop-down menu, select the position for the annotation on the chart. For
example, Top Left.

6. Click OK to save the options that you selected, and close the Annotation dialog box.

The annotation is added to the chart.

7. Click Run to generate the report.

Collation in Charts

Charts that have the new attribute syntax respect collation, which provides alphabetical
sorting. Collation is also used in other areas, such as filtering.

Collation is set to CODEPAGE by the WebFOCUS Business User Edition installation, by default.
This can be changed in the Custom Settings section of the Administration Console. For more
information, see How to Configure Collation Sequence Settings on page 120.

Using Storyboards

The Storyboard feature allows you to capture and preserve snapshots of your visualizations as
you create them. 

Each time you add something to the storyboard, it is placed onto a unique PowerPoint slide.
When you click Show, you can open and review your slides in PowerPoint.

Since storyboards give you the ability to turn your visualizations into a PowerPoint presentation,
you can modify your storyboard to create a customized demo. For example, you can rearrange
or delete slides, or add titles and text.

You can also make your visualization portable by saving the PowerPoint files that you create
and sharing the slides through email or other electronic distribution.
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Procedure: How to Create a Storyboard

1. Create a visual, for example, a bar chart or a grid.

2. On the Home tab, in the Storyboard group, click Add.

Note: When you receive the Added to Storyboard message, click OK.

3. Insert another visual. On the Home tab, in the Visual group, click Insert.

Note: You can also click the down-arrow on the Insert button to insert a chart, grid, or text.

4. On the Home tab, in the Storyboard group, click Add.

Repeat steps 2 through 4 until you complete your data analysis.

5. On the Home tab, in the Storyboard group, click Show.

A new browser window opens, and you are prompted to open or save the PowerPoint file
that contains your storyboard.

If you click Open, the storyboard opens in PowerPoint. You can save the file as a
PowerPoint presentation on your machine.

If you click Save, the storyboard will be saved to a PowerPoint (.pptx) file and placed in
the Downloads folder on your machine. Click the down arrow on the right side of the
Save button to perform a Save as. This allows you to specify the drive and directory to
which the file will be saved.
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In PowerPoint, each storyboard frame displays as a PowerPoint slide, as shown in the
following image.

Animating Visualizations

You can animate visuals in a visualization. Each individual visual can have different animation
settings. The animations for each visual execute when you run the visualization.

Procedure: How to Add Animation to a Visual

1. Create a visualization with one or more visuals.

2. Select the visual that you want to animate.

3. On the Format tab, in the Interactive group, click Interactive Options.

4. On the Interactive Options dialog box, select the Show Animation check box.

This animates the visual.

5. Set the duration for the animation, which determines the speed at which the animation
occurs. The default value is 1400ms. Increase the value to make the animation slower,
and decrease the value to make it faster.

6. Optionally, clear the Enable Hover Over Effect check box.

This option lightens or adds a border to the segment of the visual that you move your
mouse over.

7. Click OK.
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8. Click Run.

Your visual animates automatically based on the options that you specified.

Using Filters to Customize the Display of Data

Filters enable you to customize the display of data in your report, chart, document, or
visualization. This gives you the advantage of viewing only the data that you want to see and
use.

When creating a report, you refer to fields in several parts of the request. For example, in
display commands (PRINT, SUM), in sort phrases (BY, ACROSS), and in selection criteria
(WHERE, WHERE TOTAL, IF). 

Note: When using ESSBASE hierarchical data sources, creating a filter on a sort field is not
supported.

The WHERE phrase selects records from the data source to be included in a report. The data is
evaluated according to the selection criteria before it is retrieved from the data source. You
can use as many WHERE phrases as necessary to define your selection criteria.

In WHERE TOTAL tests, however, data is selected after all the data has been retrieved and
processed.

You can group conditions and expressions within filter criteria. In addition, you can apply
functions and calculations within criteria. For more information on filtering options, see Field
Tab on page 83. 

You can create Where and Where Total filters in the Filter dialog box by clicking WHERE.

Double-clicking the Double-click or press F2 to edit! text opens drop-down menus for Fields and
Subqueries, Operators, and Values.

You can retrieve fields and values from the Master File and data source and Subqueries from a
HOLD file.

The Field drop-down menu provides a field list from the Master File. The Field list can be
viewed as follows:

In business order (default)

In a sortable grid
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In a hierarchical structure of the data

If you select Subquery, then the Operator drop-down menu is replaced by a menu with the
options of In list and Not in list.

In list. Activates a drop-down menu in the right-most part of the expression. The drop-
down menu contains a list of all subqueries that you have created from the Master file
in use, and an EXISTING option.

Click EXISTING to open the Open dialog box, where you can select a subquery from a
different Master file.

Not in list. Opens the Open dialog box, where you can select a subquery from a
different Master file.

The Operator (default) drop-down menu provides various operators for your filter. For example,
Equal to.

The Value drop-down menu opens a dialog box with multiple options.

Note: If you are creating a filter on a full date field, the Value field will have a calendar icon
adjacent to it. You can use this icon to select a date using a calendar control.

The Type drop-down menu contains the following options:

Constant. Enables the entry of a literal constant value.

Parameter. Enables you to specify a parameter by entering a name and description in the
provided text input areas, as well as selecting the type of parameter (Simple, Static,
Dynamic, or Optional).

Field. Enables the specification of a field name to compare against.

The value area generally contains a text input box that you can use to manually insert values.
However, if you are working with a date field, the Value field is set to Today. You can optionally
select Beginning of Month, End of Month, Beginning of Quarter, End of Quarter, Beginning of
Year, End of Year, or you can specify a Custom date using the calendar that displays when you
make that selection.

Note: The default date of Today applies to Report, Chart, and Document modes only.

The value area also contains a Get Values drop-down menu, which supplies the following
options:

All. Retrieves all the values from the selected field.

First. Retrieves the first value from the selected field.
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Last. Retrieves the last value from the selected field.

Minimum. Retrieves the minimum value from the selected field.

Maximum. Retrieves the maximum value from the selected field.

From File. Retrieves a value that you specify. Selecting this option opens the Select From
File dialog box, where you can browse to a local file and specify a file format, such as a flat
file (CSV) or an Excel spreadsheet (XLS or XLSX).

Note: The Get Values drop-down menu is only accessible if you have already selected a field.

After selecting the values that you want, you can move them into and out of the Multiple
Values area with the left and right arrows. You can also change the value order and delete
values with the up and down arrows and the Delete icon.

After creating a condition, you can insert additional conditions before and after the selected
condition by using the Insert Before and Insert After buttons at the top of the Filter dialog box.
You can use either the And or the Or conjunction to link conditions and the Group and Ungroup
buttons to nest and organize conditions.

You can create additional filters by clicking the New Filter button at the top of the Filter dialog
box.

After creating the filters that you want, click OK to save and apply the filters. You can access
them from the Filter pane of the Resources panel.

Note: Dates shown in the live preview reflect the format specified in the data source. However,
when Filters are applied to a date formatted field, the format of dates shown in the Filter
interface is derived from the locale. When the report, chart or visualization is executed, the
output as well as any prompt will reflect the format specified in the data source.

Including or Excluding a Filter

Once you have created a filter, you can make decisions about when and where you want to
include it in your report. For example, you might want to include one filter and exclude another.
Using the Include and Exclude options in the Filter group on the Home or Field tabs, you can
set filters accordingly.

You can use the following information to make decisions about your filters:

Exclude. Removes, but does not delete, the filter from the report.

Include. Restores a filter that was previously excluded from a report.
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Using the Prompt Functionality to Select Field Information at Run Time

Using the prompt functionality, you can create an auto prompting parameter for which you can
define a value at run time. This feature is located in the Filter Group on the Field tab.

To create an auto prompting parameter:

1. Select a field for which you want to create a parameter in your report.

2. On the Field tab, in the Filter group, click Prompt.

The Create a filtering condition dialog box displays.

3. Double-click the Value field.

Note: Parameter is selected, by default, when you are defining a prompt.

The following options display, from which you can make a selection:

Simple. This is used for prompts using Text Input. This is the default value.

Static. This is used for prompts using Selection. This option allows you to select
multiple values at run time.

Dynamic. This is used for prompts using Data Values. This option allows you to select
multiple values at run time.

Optional. This is used for prompts using Single or Multiselect parameters.

4. Click OK, and click OK again to close the Create a filtering dialog box.

When you run your report, you will be prompted for information based on the parameters
you created.

Using Auto Drill

Auto Drill enables you to navigate through different levels within the dimension hierarchy of
your data source. This allows you to review underlying data for a particular area, and move
through the structure of your data source based on your informational needs.

In order to use Auto Drill, you must enable it by clicking the Auto Drill button on the Format tab,
in the Auto Drill group.

Once you have enabled Auto Drill, you can develop your report or chart and run it to activate
the hyperlinks that Auto Drill creates. This enables you to navigate up or down through the
related hierarchy of your data source by clicking the links that display.
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When you click a hyperlink, the option to drill up or drill down displays, depending on where you
are in the hierarchy of your data. You can then select one of these options to begin navigating
your data. For example, if you have Product Category in your hierarchy, you would be able to
drill down to Product SubCategory. When you drill down, you can subsequently drill back up to
the originating dimension sort field. If you have selected a data source that has multiple levels
and your report or chart uses a component in the middle of the hierarchy, both the Drill up and
Drill down options will display. Once you have started navigating your data using the Drill up
and Drill down options, the Restore Original option displays, enabling you to start your data
analysis over by re-executing the original Auto Drill request.

At run-time, the Auto Drill functionality displays a breadcrumb header. This defines your current
location in the hierarchy of your data source and enables you to navigate back and forth
between different levels in your data.

Important:

The Auto Drill functionality is only available for data sources that have a dimension
hierarchy.

If you have Auto Drill enabled and you attempt to run your report or chart in deferred mode,
the hyperlinks will not display. This is also true for Auto Drill enabled reports that are
distributed through ReportCaster.

With the exception of Visualization mode, Auto Drill is available at run-time, but not in Live
Preview.

Auto Drill is supported for HTML and active report output format reports.

Auto Drill is automatically enabled in Visualization mode for data sources that have a
dimension hierarchy.

Auto Drill functionality is not available in reports distributed by ReportCaster, because Auto
Drill uses live data, in an interactive session, for data drilling. Data values and totals may
not be the same if the data has changed since the last distribution. Mixing past data with
current data could impact data analysis.

Auto Drill is not supported for HTML5 output format charts that do not support the new
chart attributes syntax.

Auto Drill is not supported on Across fields in active reports.

You must use dimension fields as a sorting field, either BY or ACROSS.
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Procedure: How to Use Auto Drill to Navigate the Hierarchy of Your Data Source

1. Select a data source that has a dimension hierarchy. For example, wf_retail_lite.mas.

2. Create a report or chart with one or more hierarchical fields (for example,
Product,Category).

3. On the Format tab, in the Auto Drill group, click Auto Drill.

4. Click Run.

The report or chart displays.

5. For reports, click a hyperlinked field within your report. For charts, hover over a chart
aspect (for example, a bar).

A menu appears.

6. Select a hierarchical value to which to drill down to.

Once you have drilled down on a field, you can subsequently drill up.

7. To return to the default state of the report or chart, click a hyperlink or hover over a chart
aspect, and then click Restore Original.

Using the Auto Linking Feature to Link Content

Auto Linking makes it easy to connect reports and charts in your development environment,
expanding the reporting capabilities of your organization. Using Auto Linking, you can
dynamically link HTML reports, active reports, and HTML5 charts with a single report or chart of
any format, based on their common sort (BY) fields and parameters referenced in any filters. It
is this commonality that dynamically links content in your WebFOCUS repository, allowing you
to discover new possibilities in your data, and explore new relationships within your reporting
enterprise. In addition, Auto Linking saves development time and effort, because drilldowns do
not need to be manually created and maintained.

To use Auto Linking, you must use the Enable Auto Linking option in InfoAssist+ to set the
reports or charts that can be auto-linked. In addition, you must also set reports or charts to be
Auto Link targets. The options to enable and disable Auto Linking and Auto Link Target
functionality are available on the Format tab, in the Auto Linking group, in InfoAssist+.

Note:

The Auto Link Enabled option is activated only when the HTML, HTML5, and active report
output format is selected.

You can open an existing report or chart and enable Auto Linking or set the item as an Auto
Link target.
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When Auto Link functionality is activated, your reports or charts display a link for each sort (BY)
field with qualifying target reports or charts at run time. In Auto Link enabled reports, you must
add sort (BY) fields in the BY field container. In Auto Link enabled charts, you can add sort (BY)
fields to the Horizontal Axis, Vertical Axis, or Color field containers.

To qualify a report or chart as an Auto Link target, you must include filters that contain the
parameters that you selected as the sort field or fields in the enabled report or chart. The
parameter names defined in these filters must be the same as the sort (BY) field names in the
Auto Link enabled report. When you select a report or chart as the Auto Link Target, it specifies
that the parameter information should be catalogued, and will be evaluated when an Auto Link
enabled report or chart is run.

For an Auto Link enabled report at run time, the qualifying target reports and charts are those
that have filters with parameters for the selected sort field and the sort fields that precede it,
which appear to the left. For an Auto Link enabled chart at run time, the target reports and
charts are those that have filters with parameters for all sort fields. For run time for both
reports and charts, the linked sort field values in the Auto Link enabled report or chart are
passed to the Auto Link target report so that it can be filtered by the sort (BY) field values.

For example, you may have an Auto Link enabled report that contains sort (BY) fields Product
Category and Model, with a measure (Sum) field, Revenue. To qualify as an Auto Link target,
other reports or charts in your repository can contain a single filter with a parameter for
Product Category, or two filters with parameters for both Product Category and Model. When
you run the Auto Link enabled report, the Product Category field will link to target reports or
charts that have a filter with a parameter for Product Category and the Model field will link to
target reports or charts that have filters for both Product Category and Model.

If you use the same example for an Auto Link enabled chart instead of a report, you can
access the target reports or charts from a tooltip option that displays when you point your
mouse over an area of the chart, such as a bar that represents Revenue by Product Category
and by Model.

Note:

The linked reports displayed are limited to those that you are authorized to run or run
deferred.

When running an HTML report with On-demand Paging enabled, the qualifying Auto Link
targets appear on the menu in the order that they are specified in the request. This is also
true for a chart request that is a legacy graph format (PFJ-based formats, such as PNG and
non-bucket HTML5). In reports, horizontal lines appear in the menu to separate user
specified drilldowns and Auto Link navigation options.
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Consideration should be given to how many reports or charts are indicated as Auto Link
targets, as the run time Multi-drill menu for the qualifying target reports may become long in
length. In these cases, some browsers may display a script processing warning message.

The Auto Link Enabled and an Auto Link Target options can be set individually or both can
be set on the same report or chart if that item meets the Auto Linking requirements.

Procedure: How to Set an Existing Report or Chart as Auto Link Enabled

1. In the Resources tree, right-click a report or chart and click Edit.

InfoAssist+ opens in the relevant mode.

2. Verify that there is a sort (BY) field in the report or chart.

For reports, sort fields are added to the BY field container.

For charts, sort fields are added to the Horizontal, Vertical, or Color field containers.

3. On the Format tab, in the Auto Linking group, click Enable Auto Linking.

4. Save the report or chart.

Your existing report or chart is now Auto Link enabled.

Procedure: How to Set an Existing Report or Chart as an Auto Link Target

1. In the Resources tree, right-click a report or chart and click Edit.

InfoAssist+ opens in the relevant mode.

2. On the Format tab, in the Auto Linking group, click Auto Link Target.

Note: Selecting Auto Link Target specifies that the parameter information for this report or
chart will be stored, adding it to the repository of reports and charts that will be evaluated
when an Auto Link enabled report is run.

3. Add a filter with a simple or optional parameter to the target report or chart. Qualifying
target reports are those that have filters with parameters for the sort (BY) fields in Auto
Link enabled reports or charts.

a. From the Data pane, drag a sort (BY) field into the Filter pane.
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b. Using the Create a filtering condition dialog box, add the selected parameter as
simple, as shown in the following image.

c. Click OK, and then click OK again to exit the Create a filtering dialog box.

4. Save the report or chart.

Your existing report or chart is now set as an Auto Link target.

Procedure: How to Create a New Auto Link Enabled Report or Chart

1. Open InfoAssist+ in report or chart mode.

2. From the Open dialog box, select a data source.

3. On the Format tab, in the Auto Linking group, click Enable Auto Linking.

4. Add fields to the report or chart, ensuring that one is a sort (BY) field.

For reports, sort fields are added to the BY field container.
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For charts, sort fields are added to the Horizontal, Vertical, or Color field containers.

5. Save the report or chart.

Your report or chart is now set as Auto Link Enabled.

Procedure: How to Create a New Auto Link Target Report or Chart

1. Open InfoAssist+ in report or chart mode.

2. From the Open dialog box, select a data source.

3. On the Format tab, in the Auto Linking group, click Auto Link Target.

Note: Selecting Auto Link Target specifies that the parameter information for this report or
chart will be stored, adding it to the repository of reports that will be evaluated when an
Auto Link enabled report is run.

4. Add fields to the report or chart.

5. Add a filter with a simple or optional parameter to the target report or chart.

a. From the Data pane, drag a sort (BY) field into the Filter pane.

b. Using the Create a filtering condition dialog box, add the selected parameter as
simple or optional.

Note: When creating a parameter for a field, the parameter name defaults to the
fieldname that you select. In the previous image, the creation of a filter with
parameter Product Category is shown. To ensure that the name of the parameter is
the same as the sort (BY) field in the Auto Link enabled report or chart, do not change
the name of the parameter that is generated by your field selection.
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c. Click OK, and then click OK again to exit the Create a filtering dialog box.

6. Save the report or chart.

Your report or chart is stored as an Auto Link target.

Procedure: How to Run an Auto Link Enabled Report or Chart

You can run an Auto Link enabled report or chart from within InfoAssist or from the Portal.

1. Open and run an Auto Link enabled report or chart in one of the following ways:

In InfoAssist+, open or create an Auto Link enabled report and on the Quick Access
toolbar, click Run.

From the Portal, right-click a report or chart that is Auto Link enabled and click Run.

2. Use the hyperlinks to link to other reports and charts, based on the following information:

Reports. Displays with hyperlinks on the sort (BY) fields that have qualifying target
reports. Click a hyperlink to display the menu with the Auto Links option, which
cascades to list the qualified Auto Link target reports and charts, as shown in the
following image.
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Charts. Displays with aspects over which you can hover (for example, a bar) in the
chart. A tooltip displays with the Auto Link target reports and charts, as shown in the
following image.

Using Multi Drill

The Multi Drill functionality enables you to create multiple drill down links on a data field in a
report or chart. This is useful when you want to define custom links to other reports or
websites.

Using the Multi Drill functionality, you can define conditions for drilling down or through the
data element that you select. Once drill down information is saved and you run the report or
chart, the drill down options display when you click or hover over the defined area of a report or
chart, respectively.
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You can create drill down links by selecting a field in the Query pane. On the Field tab, in the
Links group, click Drill Down to open the Drill Down dialog box. You can also right-click a field in
the Query pane, and click Drill Down. The Drill Down dialog box is shown in the following image.

When you access the Drill Down dialog box, the name of the field that you selected displays in
the title bar. This enables you to identify the current field and is useful when working with Drill
Down parameters.

In the Drill Down dialog box, you can configure a hyperlink or drill-down procedure. When you
run the report, you can click the link that is created, which would take you to the specified URL
or execute the specified procedure.

You can also create multiple drilldowns for a selected field. The drill down links that you define
display as separate entries in the drill down list, also known as the drill menu, at run-time. The
display of these entries is based on the naming conventions that you applied when creating
the multi-drill scenario.
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Once your drilldown options are defined, you must run your report in order to access the drill
down links that you have created. For reports, the links display when you click on a hyperlink
for the data field that you selected. For charts, they display when you hover over an area of the
chart for which the drill down has been defined (that is, the field that you selected when you
defined the drill down).

These links enable you to drill directly through to an external procedure or URL.

For example, you can create one drill down link for an existing procedure, and another for a
webpage. Both drill downs are stored for the underlying field that you selected. Once you
define the first drill down, additional options display on the toolbar, as shown in the following
image.

Note: You can rename a drill down using the Description field in the right pane of the Drill
Down dialog box.
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The following icons are available on the Drill Down dialog box toolbar:

Create a new drill down. This option is enabled when all required information is provided
for the first drill down. When you click Create a new drill down, a new drill down item is
created. This switches the drill down functionality from a regular drill down to multi-drill. By
default, the name of the drilldown is Drill Down n, where n is a consecutive integer, such as
Drill Down 1, Drill Down 2, etc. This option is initially disabled, but is enabled after you
have created at least one drill down link.

Duplicate the selected drill down. When an existing drill down item is selected, clicking
this option duplicates the item. A (Copy n) is appended to the name of the drill down, where
n is the consecutive number assigned to the duplicated drill down. Once assigned, the
name can subsequently be changed in the Description field. Consecutive copies can also
be rearranged by dragging the drill down items into the desired order.

Note: The Duplicate button is only active when sufficient information is available for the
selected drill down item.

Rename the selected drill down. This option enables you to rename an existing drilldown
and is active by default. When this option is selected, the Description field is selected,
allowing you to provide a new name for the drill down link. You can enter a description up to
100 characters long. If you remove the description, the drilldown is renamed to the default
name.

Remove the selected drill down. If you have a drill down item selected, the Remove the
selected drill down option is active. When you select this option, the current drilldown is
deleted. If a drill down item is removed, the next drill down item is automatically selected. If
you remove the last drill down item, the Drill Down dialog box resets to its initial state,
restoring Drill Down 1 as the default value.

Options. The Options functionality enables you to change the order of your drill down items.
This allows you to control the order in which the items are presented in the drill menu when
you run your report and click on a hyperlink. You can change the order by selecting a
defined drill down in the list that is presented under Edit Order and then clicking the Move
Up or Move Down button. You can also remove one or more drill down items from the list by
selecting the desired items and then clicking the Remove from List button. If you multi-
select your drill down items using the CTRL key, the Move Up and Move Down buttons are
disabled.

Note: Move Up, Move Down, and Delete are also available as context menu options when
you right-click a drill down item in the Edit Order list.

The Drill Down dialog box contains the following options for specifying drill down information for
the selected field:
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Note: When specifying parameters for your drill down, click Add Parameter to add them to your
parameters list.

Report. Select this option to choose a report for the current drill down. This option is
selected by default.

Report. Enables you to browse to a stored report.

Description. Provides a field in which to describe the report. If you selected a report by
browsing, this field is automatically populated with the title of the procedure or the
name where procedure titles are not accessible. This field is also used to rename a
specified drill down.

Target. Allows you to specify a target for the drill down. Options include: New Window,
Same Window, or a value that you specify. The default value for report is New Window.

Parameters. Displays the parameters that you have indicated for the current drill down.

Refresh BI Portal. Select this option to refresh the components of the BI Portal and pass
parameters to them.

Refresh. Provides options by which to refresh the page. Options include Current Page
and All Pages.

Description. Provides a field in which to describe the refresh process. This field is also
used to rename a specified drill down.

Target. Reflects the target for the drill down. The only applicable value for Refresh BI
Portal is Same Window.

Parameters. Displays the parameters that you have indicated for the current drill down.

Auto Link Target. Select this option to create an explicit list of Auto Link targets. Upon
selection, these will be available in the drill down menu at run time.

Note: When working with reports, the Auto Link Target drill down option is only available for
a selected dimension (BY) field. For more information, see Using the Auto Linking Feature to
Link Content .

Auto Link Target. Enables you to browse to a stored target report.

Description. Provides a field in which to describe the target report. If you originally
selected a report by browsing, this field is automatically populated with the report title
or the name where titles are not accessible. This field is also used to rename a
specified drill down.
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Target. Enables you to specify a target for the drill down. Options include: New Window,
Same Window, or a value that you specify. The default value for Auto Link Target is New
Window.

Parameters. Displays the parameters that meet the column-to-parameter requirement
for the selected target report.

For more information, see Using the Auto Linking Feature to Link Content .

Web Page. Select this option to indicate that you want to drill through to a webpage. Enter
a value in the URL field.

URL. Enables you to specify the URL for the webpage to which to drill down. This option
is available only when Web Page is selected.

Description. Enables you to enter additional comments related to the drill down. This
field is also used to rename a specified drill down.

Target. Enables you to specify a target for the drill down. Options include: New Window,
Same Window, or a value that you specify. The default value is New Window.

Parameters. Displays the parameters that you have indicated for the current drill down.
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If you are working with a report that has parameters, the parameter names are automatically
retrieved and made available from the Name control in the Parameters section of the Drill
Down dialog box, as shown in the following image.

By default, the field is labeled with a value of Name. If there are multiple parameters to choose
from, you can use the drop down list to make a selection. You can also manually enter a name
to create a new parameter. The parameters that display are populated from the underlying
report procedure (.fex) that you selected for your drill down.

The Type field enables you to specify a field or constant value. The options in the Value list are
based on the fields that you selected for your report. The item that you select determines the
value for the parameter (for example, Discount or Revenue).

Note: If you switch the Type field from Field to Constant or from Constant to Field, the Value
field is reset, enabling you to specify a unique value.
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Procedure: How to Create a Single Drill Down Link

You can create a single drill down link on a measure field.

1. Create a report or chart with at least one measure field.

2. In the Query pane, do one of the following:

Right-click the measure field and click Drill Down.

Click the measure field and on the Field tab, in the Links group, click Drill Down.

The Drill Down Dialog box displays, as shown in the following image.
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3. Select one of the following Drill Down options:

Report

Refresh BI Portal

Auto Link Target

Web Page

4. Populate the fields based on the drill down option you selected.

Note: Descriptions for these fields are provided earlier in this topic.

5. Optionally, rename the Drill Down using the Description field. This dictates how the Drill
Down will appear in the left pane of the Drill Down dialog box.

6. Click OK.

The drill down link displays when you hover over the defined area of a report or chart, at
run time.

Procedure: How to Create Multi Drill Links

You can create a multiple drill down links on a single dimension field.

1. Create a report or chart with at least one dimension field.

2. In the Query pane, do one of the following:

Right-click the dimension field and click Drill Down.

Click the dimension field and on the Field tab, in the Links group, click Drill Down.
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The Drill Down Dialog box displays, as shown in the following image.

3. Select one of the following Drill Down options:

Report

Refresh BI Portal

Auto Link Target

Web Page

4. Populate the fields based on the drill down option you selected.

Note: Descriptions for these fields are provided earlier in this topic.

5. Optionally, rename the Drill Down using the Description field. This dictates how the Drill
Down will appear in the left pane of the Drill Down dialog box.

6. Repeat steps 3-5 until you have added all of the drill down links required.

Note: The following image defines three unique drill down links for the selected dimension
field.
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7. Click OK.

The links display when you hover over the defined area of a report or chart, at run time, as
shown in the following image.
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Adding Parameters for Data Selection at Run Time

You can add new parameters to your report or chart to create parameter options for selection
at run time. This enables you to dynamically select and review different scenarios with your
data, offering you on-demand, dynamic report or chart creation at run time.

When you add a parameter, it becomes a field container into which you can add one or more
measures and dimensions. You create a new parameter by right-clicking on a field container in
the Query pane and clicking New Parameter. This creates a numbered parameter (for example,
Parameter 1). In cases where you have multiple parameters defined, the numbering is applied
sequentially.

Once you add a parameter, you can rename the variable by right-clicking the Parameter-n field
container and clicking Rename Variable, where n is the number of the parameter that was
added. Once you rename a parameter field container, the new title displays in the Query pane
and at run-time. This allows you to easily identify the parameters while categorizing the data
fields that you want each to contain. For example, if you add a number of Sales-related fields
to a parameter, you can rename the parameter with a title of Sales to encapsulate the data
fields that you selected. Parameters should be renamed before you run the report or chart so
that they are easy to identify.

In order to populate parameters in your report or chart, data fields must be placed in the
parameter field container. You can do this by selecting fields from the Data pane and dragging
them into the relevant parameter field containers that you create.

Note: Double-clicking the data fields in the Data pane places the data field in the default field
containers in the Query pane, not the parameter field container. For example, in a report, if you
double-click Discount, the data field is placed in the Sum container (outside of the parameter
field container that you created). You can always drag a data field into a parameter container
from another field container in the Query pane if you wish to consider it a parameter.

You can also reorder the data fields that you have placed in a given parameter field container
by dragging them into the order that you wish to display them at run time. Parameters can be
specified in any field container, with the exception of Multi-graph. Once you have defined your
parameters and selected the relevant data fields, run the report or chart. Using the drop-down
lists for each parameter, you can select different options from the parameter lists to view the
data in your report or chart dynamically. To load different scenarios, select the values and then
click Run.
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The following image shows the Query pane with a number of parameters and data fields
specified.

Procedure: How to Add a Parameter

1. Create a new report or chart or open an existing one.

2. Add a new parameter by right-clicking a field container and clicking New Parameter , as
shown in the following image.

A new parameter field container is added.
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3. Add the data fields that you would like to display in a parameter list at run time to the new
parameter field container.

4. Optionally, rename the parameter by right-clicking the parameter and clicking Rename
Variable.

This is not required, but it does help in differentiating the various numbered parameters
that display, depending on how many you define.

5. Optionally, add one or more additional parameters, and relevant data fields, into the field
containers for which you would like to select data values at run time.

6. On the Quick Access toolbar, click Run.

You can use the Parameter drop-down lists that display at run-time to create different
views of your data, as shown in the following image.

Note: You can optionally run your report or chart using the default parameters without
making a selection. Click the down arrow on the Run button in the Quick Access toolbar
and select Run with Default Parameter Values.

The following navigational icons display at run time:

Icon Description

Close Filter Panel. Click this option to collapse the filter panel,
displaying more of the report or chart in the right pane.

Reset filter values. Click this option to reset the filter values to
their default values, as indicated when the parameter was initially
set up.
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Icon Description

Run with filter values. Click this option to run the report or chart
based on your selections.

Show filter panel. Click this option to show the filter panel when
viewing a report or chart. When viewing the filter panel, you can
close it by clicking Close Filter panel.

Working With Slicers

Slicers provide a quick and easy way to add dynamic user controls to a chart or report, giving
you the ability to filter the data in use as you create or view content. Slicers are dynamic filters
that can be changed by making a selection from a menu of fields. You can use them to filter
your content by modifying a slicer in the Slicers tab and running the chart or report, or you can
use them at run time when running a report in InfoMini with the Slicers tab selected.

Creating Slicers

You can create slicers by dragging fields to the Slicers tab or through the context menu of a
field. When you create a slicer group, it appears on the Slicers tab.

You can use slicers to dynamically filter reports at design time.

You can dynamically filter reports at run time when they are included in an InfoMini application.
For more information on InfoMini, see Building InfoMini Applications on page 506.

Procedure: How to Create a Slicer

1. Click the Slicers tab.

2. Create a new slicer by using one of the following methods:

Click the New Group button to create a new slicer group.

Select a field from the Data pane and drag it onto the Drag Fields Here to Create Slicers
text on the Slicers tab.

Note: You cannot drag parent-child hierarchies onto the Slicers tab.

The field is added to the new group.

or

Right-click a field in the Data pane, point to Slicers, and then click New Group.

The field is added to the new group.
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If you are creating a slicer on a full date field, a calendar icon displays adjacent to the
field. You can use this icon to select a date using a calendar control.

Procedure: How to Add a Field to an Existing Slicer Group

1. Click the Slicers tab.

2. Add a field to an existing slicer group using one of the following methods:

Select a field from the Data pane and drag it onto an existing slicer group.

or

Right-click a field in the Data pane, point to Slicers, and then click Existing Group.

Select an existing group from the menu, and then click OK.

The field is added to the existing group.

Procedure: How to Add a Hierarchy as a Slicer Group

Note: You cannot drag parent-child hierarchies onto the Slicers tab.

1. Click the Slicers tab.

2. Add a hierarchy as a slicer group using one of the following methods:

Select a hierarchy from the Data pane and drag it onto an existing slicer group.

The hierarchy is added as a new group, not as a slicer in the existing group. The new
group is given the same name as the hierarchy.

or

Click the New Group button to create a new slicer group.

Select a hierarchy from the Data pane and drag it onto the Drag Fields Here to Create
Slicers text of the Slicers tab.

The hierarchy is added to the new group. The name of the new group changes to the
name of the hierarchy automatically.

Note: Hierarchies cannot be added to existing slicer groups. If a hierarchy is dragged onto
an existing slicer group, a new group is created automatically.

There is no right-click context menu for hierarchies. To add a hierarchy as a slicer group,
you must drag it into a new slicer group.
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Filtering With Slicers

Once you add slicers to an InfoAssist+ report, you can use them to filter the report. You can
select values from the slicers menus, change the number of records that appear, create new
slicer groups, clear existing slicer groups, and update the report preview. 

Slicers that are not selected have their values filtered by the selected slicers. Only values that
meet the criteria for previously selected slicers will appear in the menu for the next slicer.
Slicers are not filtered in the order they appear in the slicer group, but by the order they are
selected. Cascading of slicers is only valid for hierarchies.

Procedure: How to Change the Relationship Operator in a Slicer

1. With at least one slicer added to the report, click the Slicers tab.

2. Click the operators button on the slicer for the operation you want to change.

A list of operators (numeric) appears in the menu.

Note: Alpha fields just flip between equal and not equal.

3. Select the operator that you want from the menu. You can rest the mouse on an operator
to display a tooltip describing the operation.

How Slicers Cascade Together

Slicers cascade within a hierarchy (cube or dimension builder-based), rather than in the order
of user interaction, eliminating potential performance issues.

Procedure: How to Cascade Slicers

Controls with fields from the same hierarchy are cascaded together.

1. Create a report.

2. Create multiple slicer groups, as described in How to Create a Slicer on page 725.

Note: You can select multiple values by holding down the CTRL key while selecting items
in the drop-down list box. In cases where multiple items are selected, the label for the
drop-down list is set to Multiple. You can click the drop-down list to review the selections.

Once you click OK, the new control appears in the drop-down menu.

The 1 prior to the decimal point indicates that this is the first cascade you have interacted
with. The 1 after the decimal point indicates that it is the first control in that cascade.

3. Filter the report using the controls in the slicer groups that you created.
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Note: The order of a cascade is dynamic. For example, if you selected Camcorder from
Product Subcategory first, then the Product Category control would have a value of Video
Production.

Changing a Field Format

You can change the format of any field except a Sort field. You can change the format of
measure fields, as well as any calculated fields. 

The following procedures show how to change a field format from the Field Format Options
dialog box. For more information on how to use the Format group options, see Field Tab on
page 83.

Procedure: How to Assign an Alphanumeric Format

1. With a report open in Live Preview, right-click a virtual field or column measure field, and
select Edit Format. 

The Field Format Options dialog box opens.

2. From the Field type list, select Alphanumeric.

3. To assign a different length, specify a number between 1 and 4095 in the Total length
field. The default value is 20.

4. Click OK to close the Field Format Options dialog box and return to the canvas.

The new format appears in the previously selected column.

Procedure: How to Assign a Numeric Format

1. With a report open in Live Preview, right-click a virtual or column measure field, and click
Edit Format. 

The Field Format Options dialog box opens.

2. From the Field type list, click one of the following options:

Floating Point (default length 7.2)

Integer (default length 5)

Decimal (default length 12.2)

Packed (default length 12.2)
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If the selected field matches the selected format type, its current length appears in the
Field Length field. Otherwise, the default length appears in the Field Length field. The
Decimals field shows the numbers of decimal places for Floating Point, Decimal, and
Packed.

To assign a different length, specify it in the Field Length field for format types as
follows: 1-9 for Floating Point, 1-11 for Integer, 1-20 for Decimal, and 1-33 for Packed.

To assign a different number of decimal places for Floating Point, Decimal, or Packed,
specify the number in the Decimals field.

3. Click OK to close the Field Format Options dialog box and return to the canvas.

The new format appears in the previously selected column.

Procedure: How to Assign a Date Format

1. With a report open in Live Preview, right-click a virtual or column measure field, and select
Edit Format. 

The Field Format Options dialog box opens.

2. From the Field type list, click Date.

3. To assign a different date display format, select a date format from the Date Format list.

The default date display format is MDY.

4. Click OK to close the Field Format Options dialog box and return to the canvas.

The new format appears in the previously selected column.

Procedure: How to Assign a Date-Time Format

1. With a report open in Live Preview, right-click a virtual or column measure field, and select
Edit Format. 

The Field Format Options dialog box opens.

2. From the Field type list, click Date-Time.

3. To assign a different date-time format, select the date format you want to use from the
Date Format list. Expand Year First, Month First, or Day First to see the available options.

4. Select a time format (if applicable) from the Time Format list.

If you select the Time Only check box then you can only set a time format. Expand Hour
First, Minute First, or Seconds First to see the available options.

Note: These expansion options are only visible when you select Time Only.
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5. Click OK to close the Field Format Options dialog box and return to the canvas.

The new format appears in the previously selected column.

Procedure: How to Add a Percent Sign to a Numeric Field

You can add a percent sign to the end of a numeric value (Decimal, Integer, and Floating Point
formats). This numeric display option includes a percent sign along with the numeric data, but
does not calculate the percent.

1. With a report open in Live Preview, right-click a virtual or column measure field, and select
Edit Format. 

The Field Format Options dialog box opens.

2. From the Field type list, click a numeric value format (Floating point, Integer, Decimal, or
Packed), and then select the Percent (%) check box.

3. Click OK to close the Field Format Options dialog box and return to the canvas.

The new format appears in the previously selected column.

Dynamic Grouping

Dynamic grouping allows you to create groups of elements based on the field data type that
you select. For example, in the wf_retail_lite database, there are a number of brands of
televisions. Using the dynamic grouping functionality, you can create groups based on the
popularity of a particular brand. The first group might include top sellers such as LG and Sony.
The second group might contain the remaining brands (Panasonic, GPX, Supersonic, Tivax, and
Audiovox). This would allow you to group top sellers into one group, and the remaining brands
into another group.

Note: The Create Group option is only available for dimension fields of non-numeric format or
attribute.

You can also specify multiple, unique groupings in the same session. For example, you might
want to group the data to indicate groups or products, or specific regions.

Note: If you want to exclude a specific data element from your analysis, you can use the filter
functionality.

The grouping that you specify is applied and this new group then replaces the original field that
you selected in the Query pane. The name that you specify when creating the group is reflected
in the Query pane.

Note: You can edit the group once it has been created by right-clicking on the higher-level field
and clicking Edit Group .
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Procedure: How to Create a Dynamic Group

1. From the Data pane, add one or more data fields to your report or chart.

2. In the Query pane, right-click the data field for which you want to apply dynamic grouping.

Note: The Create Group option is also available in the Data pane shortcut menu.

3. Click Create Group.

The Create a Group dialog box displays.

4. In the Field text box, optionally type a name for the new group.

5. Select the data values that you want to group. Use CTRL + click to select more than one
value, as shown in the following image.

6. Click Group .

Note: To ungroup values, click a group and then click Ungroup.
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7. Optionally, create additional groups, as shown in the following image.

8. Click OK.
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Your grouped data will display in the Data pane when your report, chart, or visualization
refreshes, as shown in the following image.

Customizing Domain Pages

This section describes page customization features, such as configuring responsive behavior,
using the Easy Selector, working with comments, and removing customizations.

Using the Easy Selector

The Easy Selector provides a simple way to add content to a page at run time, without opening
the Resources tree. It also allows you to control which items users can access.

You can enable the Easy Selector feature on a container or a column level.

Procedure: How to Use the Easy Selector Container

1. Sign in to the BUE portal as a developer or a manager.

2. In the Resources tree, under the Domains node, create a new folder.
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3. Populate this folder with the content that you intend to make available through the Easy
Selector at run time.

Note: Ensure that the folder only includes file content and no subfolders.

4. Publish the folder.

5. In the Resources tree, right-click a domain or folder, point to New , and then click Page.

The Page Designer opens.

6. Select a columnar template from the Add Page window and click Create.

7. In the Insert tab, in the Containers group, click Easy Selector.

The Easy Selector container is inserted into the page. The Browse For Folder dialog box
opens next to the Easy Selector container, allowing you to select a target folder.

8. Optionally, navigate to the folder that you that want to display inside the Easy Selector at
run time, and then click OK. If no target folder is selected, the entire repository is
displayed at run time, allowing the user to explore all available domains and folders.

Note: You can change the folder location by clicking the Select Folder button in the
Properties panel and navigating to a different folder. It is not recommended to change the
folder location after the end users have begun using the Easy Selector.

9. Repeat steps 7 and 8 to create more Easy Selector containers, if needed.

Note: You can multiselect the containers by holding the Ctrl key.

10. Click Save and close the Page Designer.

11. In the Resources tree, right-click your new page and click Publish.

The page is now available for adding to the BUE portal.

12. Right-click the page and click Add to Portal.

The confirmation message appears.

13. Click OK.

The BUE portal refreshes and the page displays in the new tab.

14. Click the Add content button.

The Select Item dialog box opens.
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15. Navigate to an item that you want to display and click Add, as shown in the following
image.

The selected item opens inside the Easy Selector container.

Procedure: How to Use Easy Selector in a Column

1. Sign in to the BUE portal as a developer or a manager.

2. In the Resources tree, under the Domains node, create a new folder.

3. Populate this folder with the content that you intend to make available through the Easy
Selector at run time.

Note: Ensure that the folder only includes file content and no subfolders.

4. Publish the folder.

5. In the Resources tree, right-click a domain or folder, point to New , and then click Page.

The Page Designer opens.

6. Select a columnar template from the Add Page window and click Create.

7. With the page canvas selected, in the Properties panel, clear the Lock Page check box and
select the Prevent Layout Change check box.
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Note: This configuration allows users to add new content to a page at run time, while
preventing them from changing the column layout, which is important for the Easy
Selector.

8. In the Properties panel, click Container Defaults.

The Container Defaults dialog box opens. Here you can customize the drop-down menu for
the items that are displayed on the page at run time. Click OK to close the Container
Defaults dialog box.

9. Select a column.

10. In the Properties panel, select the Show Easy Selector check box.

The Browse For Folder dialog box opens and displays the same folder structure as the
Domains node in the Resources tree.

11. Click the folder you that want to display inside the Easy Selector at run time, and then
click OK.

Note: You can change the folder location by clicking the Select Folder button and
navigating to a different folder. It is not recommended to change the folder location after
the end users have begun using the Easy Selector.

12. Repeat steps 9-11 for other columns, if needed.

Note: You can multiselect the columns by holding the Ctrl key.

13. Click Save and close the Page Designer.

14. In the Resources tree, under the Portals node, right-click your new page, and click Publish.

15. Right-click the page again and click Add to Portal.

The confirmation message appears.

16. Click OK.

The BUE portal refreshes and the page displays in the new tab.

17. Click the Add content button.

The Select Item dialog box opens.

18. Select an item from the list and click Add.
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The selected item opens and a new Add content button displays in the next column, as
shown in the following image. This allows you to add the remaining items that are
available to you. You can also multiselect items inside the Select Item dialog box.

Additionally, you can replace an item on the page with any item from the Select Item dialog
box. You can access the Replace menu option by clicking the arrow in the upper-right
corner of the container panel.

Note: The Add content button disappears and the Replace option becomes inactive after
the last item in the Select Item dialog box is added to the page.

Building a Responsive Layout

A responsive layout resizes dynamically to any width based on screen size, device, and
orientation, thus eliminating the need to design for a specific device preference. This approach
takes your content beyond the desktop and delivers a quality experience to users, on any
display. The Page Designer offers you a series of versatile presets, that make the task of
creating a responsive portal a quick and straightforward process.

A user must have the privileges of a developer or manager to be able to build a responsive
layout.
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Procedure: How to Build a Responsive Layout

1. Sign in to the BUE portal as a developer or a manager.

2. In the Resources tree, right-click a domain or folder, point to New , and then click Page.

The Page Designer opens.

3. Select the 1 Column template from the Add Page window and click Create.

All responsive layouts are created in a one column page layout.

4. Click inside the column that you just created. On the Properties panel, set the Container
Padding to 5px and select the Same for All check box.

5. On the Insert tab, in the Containers group, click Responsive.

The Responsive container is inserted, taking up the full width of the page.

6. On the Insert tab, in the Content group, click WebFOCUS Resources.

7. Populate the responsive container with content from the folder of your choice, by dragging
them to the container.

When you drag items sequentially, you can choose the order in which they display, using
the shaded placement indicator as a guide. When you drag items simultaneously, using
the multiselect option (Ctrl key), they display in the order in which they are selected.

8. Multi-select the panels to which you want to assign the Custom CSS Classes by holding
the Ctrl key and clicking a title bar of each panel.

For example, if you were going to create a responsive portal that contained four items in
the first row, and two items in the second row, you would select the first four panels.

Note: You can only multi-select panels by clicking its title bars. If the title bars are hidden,
you cannot multi-select these panels.

9. On the Properties tab of the Properties panel, click the Responsive Properties button.

The Advanced Responsive Item Properties dialog box opens.

10. In the Custom CSS Classes field, type bip-responsive-n.

where:

n

Is the responsive folding behavior that you want to apply the content on your page.
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For example, bip-responsive-4-2-1 means that the content will display four items across
on wide screens, two items across on medium screens, and one item across on
narrow screens. If you use bip-responsive-3-2-1, the content will display three items
across, then two items across, then one item across. If you use bip-resposive-2-1,
content will display two items across, then one item across. If you choose bip-
responsive-1, the item will fill the entire row.

In the following image, we have updated the Custom CSS Classes field for a page that
uses the 4-2-1 responsive folding behavior for the first four items on the page.

Note: When one of the built-in responsive classes is used in the Custom CSS Classes
field, it sets the width of the panel as a percentage of the page width, based on media
queries. The percentage width setting made in these built-in responsive classes overrides
any width settings defined on the panel.

11. Click OK to close the Advanced Responsive Properties dialog box.

The first row of panels are now stretched evenly across the Responsive container.

12. Multiselect the remaining panels by holding the Ctrl key and clicking each panel.

13. On the Properties panel, click the Responsive Properties button.

The Advanced Responsive Item Properties dialog box opens.
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14. In the Custom CSS Classes field, type bip-responsive-2-1, as shown in the following image.
This will enable the remaining two panels to go from two across to one across on a
smaller screen.

15. Set Minimum Height to 440px.

16. Click OK to save the properties.

The remaining panels now stretch across the Responsive container, in the second row.

Note: You can create multiple layouts using this principle and varying the CSS classes to
reflect the desired percentage.

17. With the Responsive container selected, make the following changes:

On the Properties tab of the Properties panel, set Height to Dynamic.

On the Title tab of the Properties panel, select the Hide Title Bar check box.

On the Style tab of the Ribbon, in the Border group, click Style, and then select None.

Note: These changes render the Responsive container invisible on the page at runtime,
and in the Page Designer. To edit the content in your Responsive container or access its
properties, you can use the breadcrumb trail below the Property sheet to select it.

18. Click the Save button and close the Page Designer.

19. Publish your page.

20. Right-click the page and click Add to Portal.

The confirmation message appears.
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21. Click OK.

The BUE portal refreshes and the page displays in the new tab.

22. Change the size of your browser window to observe the responsive behavior.

All items rearrange perfectly to fill the page.

Working With Comments

In domain pages, you can use comments to interact with your peers in a multi-user
environment. Developers and managers can enable comments in the Page Designer. You can
enable comments on pages, containers, and individual content items.

Procedure: How to Enable Comments on a Domain Page

1. Sign in to the BUE portal as a developer or manager.

2. In the Resources tree, right-click a domain or folder, point to New , and then click Page.

The Page Designer opens.

3. In the Add Page dialog box, choose a page template and, optionally, add new page
information.

4. Click Create.

5. In the Properties panel, click the Comments drop-down menu and update the style of your
comments to reflect any standards.

6. Save the page and close the Page Designer.

Procedure: How to Enable Comments on a Container

1. Sign in to the BUE portal as a developer or manager.

2. In the Resources tree, right-click a domain or folder, point to New , and then click Page.

The Page Designer opens.

3. In the Add Page dialog box, choose a page template and, optionally, add new page
information.

4. Click Create.

5. On the Insert tab, in the Containers group, click any container button.

The container is placed on the page canvas.

6. In the Properties panel, select Show Comments.

When enabled, this option allows you to show and hide comments on a container or item
at run time.
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7. Save the page and close the Page Designer.

Using Comments at Run Time

When enabled, comments display at run time, as shown in the following image.
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To enable comments on an item at run time, click the arrow in the upper-right corner of the
container panel, and then click Show Comments, as shown in the following image.

Note: The Show Comments menu option is only available if comments were enabled on a
container at design time.
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Additionally, you can use the following controls to interact with comments:

Click the Minimize button  in the upper-right corner of the comment area, to minimize
comments, as shown in the following image.

Click the Restore button  in the lower-right corner of the container, to restore the
comments area.
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Customize the height of the comments area by dragging the height indicator to achieve a
desirable size, as shown in the following image.

Click the Refresh button  in the comments menu, to refresh comments.

Click the Search button  in the comments menu, and type a key word or words in the
search field, to search through comments. You can specify the search criteria by clicking
the arrow next to the Search button and selecting search criteria, such as user name,
content, or meta tags.

Click the Remove All button  to remove all comments from all users. The Remove All
option is only available to managers, developers, and group administrators.

Removing Customizations

If the domain page is unlocked and added to the BUE portal, users are able to customize it
and remove their customizations at run time.
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Procedure: How to Remove Customizations From a Base Page at Run Time

1. Inside the BUE portal, right-click a page tab of a base page.

2. Click Remove My Customizations, as shown in the following image.

The page refreshes. The customizations are removed from the modified page.

Note: This option is not available when the Lock Page option is selected.
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Chapter6
Using Content

After you have created and customized your content, learn how to distribute the content
and create schedules.

In this chapter:

Creating Distribution Lists

Maintaining Distribution Lists

Creating Schedules

Maintaining Schedules

Tracking Schedules

Using Favorites

Publishing Content

Using Visualizations at Run-Time

Using the Deferred Report Status Interface

Creating Distribution Lists

A Distribution List is an easy way to distribute content to multiple recipients by specifying the
name of a list stored in the Repository that contains the individual recipients rather than
entering each recipient separately into a schedule. A Distribution List can be made available to
other users by sharing it or changing its ownership to be managed or published. 

Creating a Distribution List

You create distribution list to distribute content to multiple recipients at one time. If you have
an LDAP data source, you can access Email information that is stored in it by configuring the
LDAP Email Setting in the ReportCaster Console Configuration tool. Once configured, you can
select email addresses from within the email address book of your company, eliminating the
need to type them in manually. For more information on the configuration of this functionality,
see LDAP Setting on page 178.

For more information on using this feature, see How to Retrieve Email Addresses from an LDAP
Data Source on page 749.
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Before creating a Distribution List, understand what groups or individual users require access
to it to determine the folder in which to create it.

Procedure: How to Create a Distribution List

1. Right-click a Repository folder and select New, Distribution List.

The Distribution List window opens, as shown in the following image.

2. In the Title box, type a descriptive name for the Distribution List.

3. From the Method drop-down list, select the distribution method for the Distribution List.
Email is the default distribution method.

If you select Email, you must provide a list of email addresses and can optionally burst
values associated with an address. For details on entering burst values, see Bursting a
Report on page 755.

In the Address box, specify the email addresses of the recipients (for example,
chuck_hill@ibi.com for an individual user or #sales@ibi.com for a email server list that
contains multiple email addresses). Be careful typing this information because there is
no edit checking. The maximum number of email addresses you can specify in a
Distribution List is 9999. You can specify a maximum of 800 characters within a single
Address line.

You can specify multiple email addresses within a single Address field. For more
information, see Specifying Multiple Email Addresses on page 759.

If the Email Delivery, Restrict Email Domains option is set to yes in the Server
Configuration tool, then only those email domains (the portion of the email address
following the at (@) symbol) listed in Allowed Email Domains (also in the Server
Configuration tool) are valid email recipients.
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If you select Print, you must specify the printers that will receive the distribution and,
optionally, burst values associated with the printer. For details on entering burst
values, see Bursting a Report on page 755.

In the Printer input field, specify the printer using the following format:

queue@printserver

where:

queue

Is the name of the printer queue.

printserver

Is the host name or IP address of the printer.

Although ReportCaster supports specifying only the print server (host name or IP
address), we recommend that you specify both the print queue and print server.
(ReportCaster differentiates between the printer queue and the printer server by
detecting the presence of the '@' separator.)

4. If you are finished creating a Distribution List, click Save & Close.

Note:

The maximum length of a title value for a file is 256 characters.

If the title of your file has the same name of an existing file in the folder, you will
receive a message asking if you wish to replace the file.

Procedure: How to Retrieve Email Addresses from an LDAP Data Source

Note: In order to use this procedure, LDAP must be configured. For more information, see 
Using the ReportCaster Console on page 144.

1. From the Distribution List toolbar, click Add New.
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The Add New Member dialog box displays, as shown in the following image.

2. Click the Search button adjacent to the email address field.
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The Find dialog box displays, as shown in the following image.

3. Select the criteria (Last Name, First Name, or Email) and the operator (Equals, Starts with,
Ends with, or Contains). Enter the search string (for example, M* to locate all records
beginning with that letter).

4. Click Search.

ReportCaster retrieves and displays the specified names from the LDAP data source.

Note: You can select one record at a time or use the CTRL key to select multiple records
simultaneously.

5. Click the To button to add the selected email address or addresses to your selection.

6. Click OK to save them in the Distribution List.

7. On the Add New Member dialog box, click OK.

The email recipients are then listed in the Email column on the Distribution List dialog box.
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Maintaining Distribution Lists

A Distribution List is an easy way to distribute content to multiple recipients by specifying the
name of a list stored in the Repository that contains the individual recipients rather than
entering each recipient separately into a schedule. A Distribution List can be made available to
other users by sharing it or changing its ownership to be managed or published.

Editing and Deleting a Distribution List

If you are authorized to access the Distribution List tool, you can view and edit the Distribution
Lists of which you are the owner. If the Distribution List is owned by a group or is published,
you have to be authorized to edit it. 

Procedure: How to Edit a Distribution List

1. From the Resources tree, select the Distribution List you want to edit, right-click and click
Edit. Optionally, you can double-click the distribution list to open it.

A window opens displaying the properties of the selected Distribution List, as shown in the
following image.

2. From this window, you can perform the following:

Change the name of the Distribution List by typing a new name in the Title field.

Change the Distribution Method.
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Click Add New or double-click within the area below the Burst Value column to add a
New Member to the Distribution List below Burst Value and Email. The Add New
Member dialog box appears, as shown in the following image.

Delete a Distribution List entry by selecting the item to be deleted, then click Delete.

3. When you have completed your changes, click Save & Close.

Note: If the title of your file has the same name of an existing file in the folder, you will
receive a message asking if you wish to replace the file.

To exit the editing window without making changes, click Close.

Accessing Distribution Lists

Sharing your private Distribution Lists allows you to permit groups and users to see its content
and use it in schedules while you retain ownership. Authorized users can share their private
Distribution Lists with groups and users with whom they are permitted to share. The
Distribution List can be accessed by users authorized to access the folder in which the shared
Distribution Lists are located.

Authorized users can publish and unpublish Distribution Lists to make them available to users
authorized to access the folder in which they are located. Publishing requires the folder the
item is located in to be published in order to publish an item within the folder. If the folder is
subsequently unpublished, all items in that folder are unpublished.
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Procedure: How to Share a Distribution List

From the Resources tree, if you are authorized to share your private content, you can share a
Distribution List with users authorized to access the folder in which the Distribution List is
located by right-clicking the folder or Distribution List in the Resources tree and selecting
Share.

Note: In order to share a Distribution List in the BUE, it must reside in the My Content folder. If
you have created the Distribution List in a different folder, simply drag the Distribution List into
the My Content folder to enable the sharing options that are available to you.

If you are authorized for advanced sharing, you can share your private content with specific
groups and users with whom you are authorized to share by performing the following steps.

1. In the Resources tree, select the Distribution List you want to share.

2. Right-click the Distribution List and select Share with.

The Set Sharing dialog box displays, as shown in the following image.

3. Use the left and right arrow buttons to select which Groups will have access to the
Distribution List.

4. Use the left and right arrow buttons to select which Users will have access to the
Distribution List.

5. Click OK.

Procedure: How to Publish Distribution Lists

The following steps allow you to publish a Distribution List or folder.

Note: A folder must be published in order to publish items within it. Published items or folders
display in color. Those that are unpublished display in black and white.

1. From the Resources tree or ReportCaster Explorer, select the Distribution List or folder
that you want to publish.

2. Right-click the folder or Distribution List and select Publish.

Procedure: How to Unpublish Distribution Lists

From the Resources tree or ReportCaster Explorer, you can unpublish a Distribution List or
folder.

1. From the Resources tree or ReportCaster Explorer, select the Distribution List or folder
that you want to unpublish.

2. Right-click the published folder or item that you want to unpublish and select Unpublish.

Maintaining Distribution Lists

754  Information Builders



Bursting a Report

Instead of distributing an entire report from a scheduled report procedure (FEX), you can use
the ReportCaster burst feature to break the report into sections to be distributed separately to
the same or different destinations. Bursting enables you to target relevant sections of a report
to individual users. Each report section is saved to a separate file. 

If you are distributing a burst tabular report, the burst value is determined by the first BY field.
If you are distributing a burst graph report, the burst value is determined by the second BY
field. The burst value is automatically determined by the internal matrix, which is a memory
area that stores each database field value and calculates values referenced by the TABLE or
GRAPH request.

You can send several report sections to one recipient by specifying the destination of that
recipient (email addresses and files or printers) for each section you want to send. You can
also send several report sections to one destination. The burst values you specify in the
Distribution List must exist in the data source you are reporting against.

Note:

If you want to burst a report, you must enable the bursting option within the Task for a
schedule. The burst values specified in the Burst Value column in the Distribution List are
ignored unless the Task specifies to burst the report.

Report names containing more than 60 National Language Support (NLS) characters are
truncated to 60 characters prior to distribution. This prevents a report name from becoming
corrupted when the report is emailed.
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Example: Specifying Burst Values in a Distribution List

You can specify sort field burst values and destinations (email addresses or printers) when
creating or editing a Distribution List. The following image shows burst values and the
destination email addresses specified in the Distribution List window.

Using the primary sort field values (Northeast Sales, South Sales, and Midwest Sales), the
email address of each representative is associated with the relevant sales report data. Since
Chuck Hill needs only the data for the Northeast branch, the sort value Northeast is listed in
the Burst Value column and is associated with his email address in the E-mail column.

However, Tom Gregory works in both the Midwest and South regions. Since he requires data
for both regions, his email address is listed in the E-mail column twice, next to a Burst Value
column entry for each region.

Note: You can click on a column heading to sort the data in that column.

Tip: You can specify multiple email addresses on a single Address line. For details, see 
Specifying Multiple Email Addresses on page 759.

Bursting Guidelines and Limitations

This section provides detailed information to assist you in defining burst values. 
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When a schedule task specifies to burst a report procedure (FEX), all data values generated for
each burst section are returned to the Distribution Server.

For the Repository each burst section is distributed to the repository. The owner of the
schedule must have write access to the repository folder specified in the schedule when
the scheduled job runs for the report output to be successfully distributed. Access to the
report sections is controlled by the repository security rules that are created when the
report is distributed.

For the email and printer distribution methods, specific burst sections are distributed
based on the burst values specified when creating the Distribution List or Single Address
used by the schedule.

The following are guidelines and limitations that apply to the burst feature:

Case. Burst values are case-sensitive.

Keywords. Burst values can contain the following keywords:

Wildcard Characters. Use an asterisk (*) and a question mark (?) as wildcards to
represent characters at the beginning, end, or middle of the burst values. The asterisk
represents one or more characters, while the question mark represents any single
character. Precede each instance of a burst value using a wildcard with the wildcard
keyword enclosed in brackets followed by a colon, [wildcard]:, as shown in the following
examples. 

[wildcard]:abc* = all values that start with 'abc'.

[wildcard]:a?c = all three-character values that start with 'a' and end with 'c'.

[wildcard]:a?c* = all values that start with 'a' and have a 'c' as the third character.

Java Regular Expressions. Use to identify strings of text. Precede each instance of a
burst value using a Java regular expression with the regular expression keyword
enclosed in brackets followed by a colon, [regexp]:, as shown in the following examples.

[regexp]:[bcr]at = values that are bat, cat, or rat.

[regexp]:[^bcr]at = any value that is not bat, cat, or rat.

Default Distribution. You can provide a default destination for burst values that are not
specified in the Distribution List. To do this, enter the following in the burst value
column of the Distribution List.

6. Using Content

Online Help PDF  757



[elsesend] = reports for burst values not contained in the Distribution List will be sent to
the named recipient.

'%BURST' Syntax. You can include a burst value in the name of a distributed file by
using the '%BURST' syntax in the name. The use of '%BURST' is not supported in a zip
file name when the Packet email setting is Yes.

The following are example entries in an email Distribution List that illustrate the use of the
wildcard and default distribution keywords in burst values.

Burst Value Address

[wildcard]:*an* sml@company.com

England ray@company.com

[elsesend]: jt@company.com

Using a scenario where the report output from a scheduled report procedure (FEX) is burst
on the Country field that contains values of Germany, USA, France, Canada, Italy, Chile,
England, and Japan, then:

Report information for Germany, France, Canada, England, and Japan will be delivered
to sml@company.com.

Report information for England will be delivered to ray@company.com.

Report information for USA, Italy, and Chile will be delivered to jt@company.com.

Formats. All formats support bursting except XML and EXCEL. Each burst section of the
report output from a scheduled report procedure (FEX) will be named
burstvalue_filename.format (for example, Northeast_Sales.pdf).

ACROSS command. This command is not evaluated as a primary sort field. To burst report
output from a scheduled report procedure (FEX), you must also include a BY field. Bursting
occurs on the BY field.

TABLEF. No internal sort processing is performed. The specification of a BY field requires
that the data already be sorted in the data source.
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ON TABLE SUBHEAD/ON TABLE SUBFOOT. Creates a SUBHEAD for only the first page of
the report output from a scheduled report procedure (FEX), and a SUBFOOT for only the last
page of the report output from a scheduled report procedure (FEX). When bursting report
output from a scheduled report procedure (FEX), the SUBHEAD and SUBFOOT should occur
for each sort break. Therefore, specify the primary sort field in place of TABLE in the ON
command. For example:

ON primarysortfield SUBHEAD

A n V field types. Bursting is not supported on a field with the AnV (where n is an integer
value) field type.

Specifying Multiple Email Addresses

When creating a schedule or Distribution List, you can specify multiple email addresses within
a single field, row, or record. 

When creating a schedule or Distribution List, you can separate each email address with a
comma (,) or a semicolon (;).

The multiple email addresses will appear in the To line of a single email when the scheduled
output is distributed.

Note:

To distribute separate emails for each address, specify the email addresses on separate
lines within the Distribution List.

If the Email Delivery, Restrict Email Domains option is set to yes in the Server Configuration
tool, then only those email domains (the portion of the email address following the at (@)
symbol) listed in Allowed Email Domains (also in the Server Configuration tool)are valid
email recipients.

Example: Specifying Multiple Burst Email Addresses

If you are using the default configuration (Packet Email = YES), one email is distributed for
multiple burst values specified for the same email address. The email address values
specified on each row are treated as a string that is a key. If there are multiple rows with the
same address value (key), one email is distributed with all the burst values. For example,
consider the following Distribution List:

Burst Value Address

A            user1@abcd.com;user2@abcd.com
B            user1@abcd.com
C            user1@abcd.com
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In this example, user1@abcd.com receives two emails when the scheduled output is
distributed. In the first email, user1@abcd.com; user2@abcd.com appears in the email To line
and one attachment is distributed for burst value A. In the second email, user1@abcd.com
appears in the To line and two attachments are distributed, one for burst value B and one for
burst value C.

If you are using the configuration that specifies to distribute a single email for each row
(Packet Email = NO), then the following behavior occurs for our example. Three separate
emails are distributed. In the first email, user1@abcd.com; user2@abcd.com appears on the
To line and one attachment is distributed for burst value A. The second email is sent to
user1@abcd.com with one attachment for burst value B. The third email is sent to
user1@abcd.com with one attachment for burst value C.

If a schedule has Packet Email = BURST, then for each burst value the output for each task is
combined and distributed. In our example, three separate emails are distributed. In the first
email, user1@abcd.com; user2@abcd.com appears on the To line and all output from the
tasks for burst value A are distributed. The second email is sent to user1@abcd.com with all
output from all tasks for burst value B. The third email is sent to user1@abcd.com with all
output from all tasks for burst value C.

Another consideration is when using the default configuration (Packet Email = YES) and the
same burst value is specified multiple times for the same Address (key) value. For example,
consider the following Distribution List:

Burst Value Address

A          user1@abcd.com;user2@abcd.com
B          user1@abcd.com
B          user1@abcd.com

In this Distribution List, only two emails are distributed for user1@abcd.com. In the first email,
user1@abcd.com; user2@abcd.com appears in the To line and the attachment is for burst
value A. In the second email, user1@abcd.com appears in the To line and the attachment is
for burst value B. The third row in the Distribution List is ignored since it contains the same
key and the same burst value, B, as the second row.

As a best practice, be sure to review your distribution information to make sure you have not
duplicated the same burst and address value pairs.
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Example: Specifying Multiple Non-Burst Email Addresses

Consider the following sample Distribution List, which does not contain burst values:

Address

user1@abcd.com;user2@abcd.com

user1@abcd.com

user2@abcd.com

user3@abcd.com

user1@abcd.com;user2@abcd.com;user3@abcd.com

In this Distribution List, an email is distributed for each address line regardless of whether
Packet Email is set to YES or NO. This is because each address value is unique. For the first
email, user1@abcd.com; user2@abcd.com appears in the To line and the attachment is for the
full report output from a scheduled report procedure (FEX). The second email is distributed to
user1@abcd.com, and so on.

If one of the address lines is repeated in the Distribution List (for example, if user3@abcd.com
is added as the sixth line in the example Distribution List), the behavior would work as follows.
If Packet Email = YES, only one email is distributed for user3@abcd.com. However, if Packet
Email = NO, two separate emails are distributed to user3@abcd.com.

Creating Schedules

A schedule allows you to specify when to run a report, the format in which to create the output,
and how it will be distributed.

About the Basic Scheduling Tool

The Basic Scheduling tool provides the ability to create a schedule for a procedure (FEX) from
the Resources tree when a report procedure (FEX) is selected from the BUE portal. The
WebFOCUS Client security authorization model controls whether users are authorized to
access the application content stored in the Repository and the Scheduling tools.

To create a new schedule for a report procedure (FEX), navigate to the Resources tree and
expand a folder to display your report procedures (FEX). Right-click the report procedure (FEX)
you want to schedule, select Schedule, and then select the method to distribute the report
procedure (FEX). You can distribute the report procedure (FEX) by Email, Printer, or Repository,
as shown in the following image.
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The following image shows the Basic Scheduling tool that consists of a Quick Access Toolbar
and the ribbon from which you access the schedule options.

Basic Scheduling Tool Quick Access Toolbar

The Quick Access Toolbar, located at the top of the Basic Scheduling tool, is always visible no
matter which options are selected. It provides access to the most commonly used functions.
From the Quick Access Toolbar, you can select the ReportCaster button to access the New
Distribution List, Save, Save As, Delete, and Close options. You can also access the Save,
Run, and Help options from the toolbar.

Run options are available for selection from the Run drop-down list.

Note: The schedule must be saved for Run options to be available or enabled.

The Run options you can select include: Run with default traces, Run with no traces, Run with
Schedule traces, and Run with Schedule and Report traces, as shown in the following image.

Note:

If you have the Session Traces privilege, you will have the Run with Traces options in the
schedule tools. If you are not authorized to run with traces, these options will not display.

Online help is available by clicking the online help icon .

Basic Scheduling Tool Ribbon

The Basic Scheduling tool ribbon partitions the scheduling options into the following
categories:

Actions
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The Actions portion of the ribbon is shown in the following image.

Save & Close. Saves and closes the schedule.

Delete. Deletes the schedule and closes the Scheduling tool.

Show

The Show portion of the ribbon is shown in the following image.

Properties. Provides a Title, Path where the schedule will be created or was opened
from, Summary, Job Priority Level, No Report to Distribute, and other settings for the
schedule. The Delete this schedule if it is not scheduled to run again check box specifies
to delete the schedule if, after it is run, it is not scheduled to run again. The Enabled
(Scheduled job runs at specified time) check box specifies to run the schedule as
specified by the Recurrence settings within the schedule. The No Report to Distribute
drop-down list box specifies whether to process a No Report to Distribute result as an
Error or a Warning.

Recurrence. Provides run-time intervals for distribution and repeat options.

Distribution. Provides options to specify the recipients or location to which the report
will be distributed.

Task. Provides information on the report procedure (FEX) that is being scheduled.

Notification. Provides the options to set up notification of the schedule status.

Log Reports. Shows the Number of Jobs and the Log Report for individual jobs.

Options
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The Options portion of the ribbon is shown in the following image.

Parameters. Specifies values for parameters that are required at run time by the report
procedure (FEX) being scheduled.

Advanced Task Settings. Allows you to input the report language and additional FOC
Errors to be processed as warnings.

Creating a Schedule in the Basic Scheduling Tool

This section provides the overall procedure to create a new schedule for a report procedure
(FEX). Some steps in the procedure contain details on the associated options, while other
steps direct you to a separate section that contains detailed descriptions of the options and
additional information, such as tips in making a selection.

To save a schedule, the required information in the Properties, Recurrence, Distribution and
Notification tabs must be provided. If required schedule information is missing when you save
the schedule, a message will display informing you of the schedule information that needs to
be entered.

Procedure: How to Create a Schedule

1. Open the Basic Scheduling tool, as described earlier in this section. The Basic Schedule
Distribution tab appears. For more information, see About the Basic Scheduling Tool on
page 761.

In the Distribution tab, you can adjust your distribution preferences for your schedule. The
options available will change depending on whether you have selected Email, Printer, or
Repository distribution. for more information, see Distribution Options in the Basic
Scheduling Tool on page 779.

2. In the Properties tab, you can edit the name for the schedule in the Title box.

This is a required field and a default name is provided.

3. Type a descriptive summary in the Summary box.

Note: This is an optional field.

4. Select a Job Priority Level.

Normal - 3 Job Priority Level is the default.
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5. Check the Delete this schedule if it is not scheduled to run again check box if you do not
want this schedule to be stored in the Repository if it will not run again as specified in the
Schedule recurrence settings.

6. Leave the Enabled (Scheduled job runs at specified time) check box checked if you want
scheduled jobs to run as specified in the recurrence settings.

7. Select the Recurrence tab and make the following selections.

a. From the Settings radio button list, select a time interval that the schedule will use to
run the report procedure (FEX).

You can set the interval to Run Once, Minutes, Hourly, Daily, Weekly, Monthly, Yearly,
or at Custom intervals.

b. From the Start Schedule options, select the date (from the drop-down calendar) and
time you want the schedule to begin running.

Note: To change the time setting, select either the hour or minutes and use the
arrows to increase or decrease the value.

c. If applicable to the Run Interval selection, from the End Schedule options, select the
date and time you want the schedule to stop running.

d. If applicable to the Run Interval selection, from the Advanced settings, click the
Repeat schedule every: check box to enable custom intervals.

Note: This option is disabled for the Run Once, Minutes, and Hourly settings options.

8. Select the Task tab. The Path, Procedure, Server Name, and Save Report As fields are
populated according to the report procedure (FEX) you selected to schedule. For a
description of the Task tab, see About Tasks in the Basic Scheduling Tool on page 766.

9. Select the Notification tab and specify whether or not you want to send a notification when
the schedule runs and under what conditions to send it. The notification options are:

Never. ReportCaster will not send a notification of the schedule status under any
circumstances. This is the default value.

Always. Send a notification each time the schedule runs.

On Error. Only send a notification when there is an error running the schedule.

For more information, see Notification Options in the Basic Scheduling Tool on page 785.

10. In the Log Reports tab, you can view log and manage log reports for the schedule.

11. To save the schedule, click Save & Close on the ribbon.

Note: You can optionally click Save on the toolbar to remain in the scheduling tool.
The Save dialog box appears.

12. Select the folder that will contain the schedule.
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Note:

You must be authorized to create content in this folder.

The default location for saving a schedule is dependent upon your privileges. If you can
create content in the folder where the scheduling tool is launched, the Save dialog will
be positioned in that folder. If you are not allowed to create content in that folder, the
Save dialog will be positioned in the My Content folder located under that folder. If a
My Content folder is not available, the Save dialog will be positioned in the first
writable folder found.

13. Enter a name for the schedule and click Save.

Note:

The maximum length of a title value for a file is 256 characters.

If the title of your file has the same name of an existing file in the folder, you will
receive a message asking if you wish to replace the file.

About Tasks in the Basic Scheduling Tool

When you access the Basic Scheduling tool, the information for the Task tab options is
predefined with the selected report procedure (FEX) information. You can complete the
available task options, such as specifying parameter values, as well as select whether or not
to burst the report.

Note: You can use parameters (amper variables) when specifying a value in the Save Report
As field of a schedule. These parameters can be system variables, such as &YYMD or any
amper variable for which a value is returned by the Reporting Server when the scheduled
procedure is executed. To use the dot file extension separator after a variable, terminate the
variable with the '|' character, for example, &YYMD|.htm. Similarly, to use the ampersand
character itself, follow the ampersand with the '|' character (for example, Smith&|Jones). If a
value for a parameter specified in a schedule is not returned by the Reporting Server when the
procedure executes, the schedule will fail with a "No report to distribute" error. If the
scheduled task is burst, you can also use the '%BURST' symbol to include the burst value in
the Save Report As field.

Task Options in the Basic Scheduling Tool

The options available when you select the Task tab are:

Path. Shows the report path in the Repository or on the Reporting Server.

Procedure. The name of the procedure you are scheduling.
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Server Name. The Reporting Server to which the report procedure (FEX) will be submitted.

Execution ID. The user ID running the report procedure (FEX) on the Reporting Server. Click
on the Password button to the right of this field to set the password.

Password. Enter a password for the Execution ID.

Alert. Specifies how to reactivate the alert or to deactivate the alert condition when it is
triggered. Click Alert to specify the alert options.

Select one of the following options from the Alert Options dialog box.

Automatically Reset. After the alert is triggered, reactivate the alert when the condition
is no longer true. The system will keep checking the condition after the alert has been
triggered. As soon as the condition is no longer true, it will reactivate the alert. This is
the default value.

Continue After Alert. After the alert is triggered, reactivate the alert immediately.

Deactivate Schedule After Alert. Deactivate the schedule after the alert is triggered.

Delay. Restart the alert after a specified period. You can specify to restart the alert after
a maximum of 99 hour(s), day(s), week(s), month(s), or year(s).

Caution: Be sure that you set the schedule interval to a time period greater than the
time it takes to run the scheduled procedure. When the schedule interval is less than
the time it takes to run the procedure and the Delay option is selected, an alert
schedule will distribute (based on the Distribution that you selected) more frequently
than expected. For email distribution, this can result in unnecessary distribution of
emails which can impact the business or operational goals of the Alert report
distribution.

Enabled. Selected by default, this option allows you to disable a task.

Report Properties

Burst Report. If you want to burst the report, select the Burst Report check box. The burst
feature enables you to instruct the Reporting Server to create the report in sections so that
they can be distributed separately.

Override the Format Specified in the Procedure. Select this check box to indicate a format
other than the one specified in the procedure.

Save Report As. Allows you to specify a different name for the report, which defaults to the
name of the report that you selected to schedule.
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Specifying Parameter Values

You can customize a report and control its execution with parameters. When scheduling a
report procedure (FEX), the schedule task Parameters section allows you to supply a value for
parameters referenced in the report procedure or add a parameter to the schedule by creating
a new parameter and specifying the parameter name and value.

Procedure: How to Specify Parameter Values

If the scheduled procedure contains parameters for which values must be supplied at run time,
these parameters are displayed in the parameters section of the scheduling tool.

In the Basic Scheduling tool, click the Parameters tab to open the Task Parameters dialog box,
shown in the following image.
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Parameters may have default values and may have values that can be selected from a static or
dynamic list. For more information about selecting parameters in the Scheduling Task
Parameters dialog box, see the examples provided in this chapter.

Reference: Considerations When Specifying Parameter Values

The following are considerations when specifying parameter values for a procedure:

The maximum number of characters for each individual parameter value is 3200. You can
store multiple values for a single parameter. Multiple values for a parameter are stored as
one entry, which must not exceed the 3200 maximum character limit.

ReportCaster displays the description for the parameter when it is specified in the
procedure. Otherwise, ReportCaster displays the parameter name.

ReportCaster displays default variable values, as well as static or dynamic single-select and
multiselect lists.

Note:

The No Selection option is displayed for dynamic multi-select lists. When selected, this
option does not perform any data selection test on that field.

ReportCaster does not support using the -HTMLFORM command to create a dynamic
selectable list of parameter values.

ReportCaster displays global variables that are used in FILTERS defined in Master Files and
referenced by a procedure. For example, if a Master File contains

FILENAME=CAR,SUFFIX=FOC
VARIABLE NAME=&&COUNTRY1, USAGE=A10, DEFAULT=ENGLAND,$
FILTER FILTER1=COUNTRY EQ '&&COUNTRY1'; $

and the procedure being scheduled contains

WHERE FILTER1

then ReportCaster displays COUNTRY1 in the Parameters window.

ReportCaster does not prompt for the value of its internal variables that are set by the
Distribution Server at schedule execution time. For example, &DSTOWNER is the user ID of
the schedule owner. If this parameter is referenced in a scheduled procedure, the value will
be available because the Distribution Server sets the value to the owner of the schedule at
schedule execution time. However, the scheduling tool will not prompt for this value in the
Task Parameters dialog box.
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Once a parameter is stored for a schedule, ReportCaster will continue to display that
parameter in the Parameter list and submit the parameter to the Reporting Server when the
schedule is run even if the parameter is removed from the underlying report. To remove the
parameter from the schedule information, edit the schedule and delete the parameter. For
information on how to delete a parameter from a schedule, see Deleting a Parameter on
page 776.

A parameter value that contains special characters should not be used in a schedule
setting that refers to an output file name, since file names cannot contain special
characters. Examples of affected schedule settings include the Save Report As value, the
Report Name value for single-file FTP distribution, and the Zip File Name.

A FEX can be coded to set the Display Value for any value. For example, if a value is named
ENGLAND, the Display Value can be set to display as England.

Example: Adding a Static Single-Select List of Parameter Values

The following image shows an example of a static parameter list for the CATEGORY parameter
created in WebFOCUS InfoAssist+.

For more information on how to create filters, see the WebFOCUS InfoAssist+ manual.
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The following image shows the Task Parameters dialog box displaying the CATEGORY
parameter. The CATEGORY parameter has been encoded to only use the values Coffee, Food
or Gifts. InfoAssist+, the content developer tool in WebFOCUS Business User Edition, does not
allow you to set default values. Therefore, the Use Default column will always be blank.

To supply a value for a single select parameter, select the Value field drop-down list box and
choose a value. Your selected value will be shown in the value column. You can select only
one value for a static single-select parameter.
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Example: Adding a Dynamic Single-Select List of Parameter Values

The following image shows an example of a dynamic single-select parameter list for the
Product parameter. This filter is created in WebFOCUS InfoAssist+.

For more information on how to create filters, see the WebFOCUS InfoAssist+ manual.
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The following image shows the Task Parameters dialog box displaying the PRODUCT
parameter. To change a parameter value, click the PRODUCT parameter in the table and
change the parameter value using the Value field drop-down list in the Parameter Properties
section.
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Example: Adding a Dynamic Multiselect List of Parameter Values

The following image shows an example of a dynamic multiselect parameter list for the Product
parameter. This filter is created in WebFOCUS InfoAssist+.

For more information on how to create filters, see the WebFOCUS InfoAssist+ manual.
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The following image shows the PRODUCT parameter selected in the Task Parameters table.
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In the Parameter Properties section, click the Value button to display the Parameter Value for
Amper Variable dialog box, as shown in the following image.

The check box All Values is selected by default. If the All Values check box is cleared, you can
select a single value, or you can select multiple values by holding down the Crtl key.

Deleting a Parameter

It is important to verify that the parameters you delete when scheduling a report procedure
(FEX) will be handled, as follows, so that the scheduled job will run successfully:

A default value is specified in the report procedure (FEX) being scheduled.

A value will be dynamically assigned to the parameter by the report procedure (FEX)
processing when the scheduled job runs on the Reporting Server.

The parameter will not be referenced when the report procedure (FEX) is processed by the
Reporting Server.

To delete a parameter so that it is not stored with the schedule information, highlight the
parameter in the parameter table you want to delete, and click the Delete button.
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Creating a New Parameter

If you need to have the schedule job send a parameter and value that is not defined in the
report procedure being scheduled, you can create a new parameter in the Task Parameters
dialog box. Parameters referenced during processing by the Reporting Server must be assigned
a value for the scheduled job to run successfully. The schedule job log report will contain
information when required parameter values were not provided.

Procedure: How to Create a New Parameter

You can create parameters for a task as follows:

1. On the ribbon, click Parameters to open the Task Parameters dialog box. The Task
Parameters dialog box is shown in the following image.

2. Click the New button located above the Parameter Properties section.
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The Task Parameter dialog box displays, as shown in the following image.

3. Enter a value in the Name and Value boxes.

4. Click OK.

The Name and Value boxes are populated in the Task Parameters dialog box Parameters
table.

5. If you would like to change the parameter value, select the parameter in the Parameters
table and specify the values in the Description and Value fields located in the Parameter
Properties section.

6. Click OK when you have completed entering parameter settings for the task.

Advanced Task Settings

The Advanced Task Settings option in the Options group provides access to the Additional FOC
Errors to be Processed as Warnings dialog box, where you can specify one or more FOCUS
error message numbers, separated by a comma. If one of these FOCUS error numbers is
encountered during schedule execution, ReportCaster will process it as a warning rather than
an error. For example, if a FOC1517 error is generated by the procedure, add 1517 to the text
box to convert this error to a warning. This means that if a report is produced, it will be
distributed in spite of the FOCUS error number. It also means that this FOCUS error number
will not trigger error notification if the schedule is configured to notify on error.

Note: When an accordion report is distributed through ReportCaster, an error may be
generated. To prevent this, the error FOC 3330 (EXPANDBYROW: Not Supported with BORDER)
can been added to the list of FOC Errors to be Processed as Warnings.
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The following image shows the error FOC 3330 saved in the Additional FOC Errors to be
Processed as Warnings dialog box.

Distribution Options in the Basic Scheduling Tool

The Distribution tab in the Basic Scheduling tool provides the options available for distributing
the report output for the scheduled report procedure (FEX). You can distribute a report output
using one of the following methods.

Email

Printer

Repository

Note:

Distribution methods can be limited globally (for all users) in ReportCaster configuration
and for groups or individual users by security operations. 

Maps can be distributed to the WebFOCUS Repository only. Maps distributed by Email do
not open correctly.

Using the Email Distribution Option in the Basic Scheduling Tool

When you distribute a report through email, you can include the report in the body of the email
(known as an inline email message) or send it as an attachment. Only the HTML, DHTML, WP,
and DOC formats can be distributed as an inline email message. 

Note: You must be authorized to distribute by Email in order to create a schedule that uses
Email distribution.

Distributing a report as an inline email message is particularly useful when the report is
distributed to mobile devices or through email systems that do not support attachments.
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You can also distribute a report to a fax machine, as explained later in this section. The
following image shows the email distribution options in the Distribution tab of the Basic
Scheduling tool when the email method is selected.

Note:

The availability of the inline message option when you create a schedule depends on the
Inline Report Distribution setting in the ReportCaster Configuration tool accessible from the
ReportCaster Console.

The display of a report that is distributed as an inline email message can be affected by
settings and restrictions of your email server or email client.

When distributing HTML reports by email, the scheduled report (.fex) must set a fully
qualified FOCEXURL and FOCHTMLURL for the report styling options defined below. These
reference the JavaScript components located on the web or application server where the
Client is configured. The Distribution Server will set a fully qualified FOCEXURL and
FOCHTMLURL for email distribution using the host name and port provided at installation
time. This can be overridden by setting these values in the scheduled procedure. For
example:

SET FOCEXURL='hostname:port/ibi_apps/'

SET FOCHTMLURL='hostname:port/ibi_apps/ibi_html'

Styling options include:

Accordion reports

Table of Contents (TOC) reports

Peer Graphics/Data Visualization graphical reporting

Multi-drill reports

HFREEZE options
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Procedure: How to Use the Email Distribution Option

Note: You can use parameters (amper variables) when specifying values in the Email settings
of a schedule. These parameters can be system variables, such as &YYMD, or any amper
variable for which a value is returned by the Reporting Server when the scheduled procedure is
executed. To use the dot file extension separator after a variable, terminate the variable with
the '|' character (for example, &YYMD|.htm). Similarly, to use the ampersand character itself,
follow the ampersand with the '|' character (for example, Smith&|Jones). If a value for a
parameter specified in a schedule is not returned by the Reporting Server when the procedure
executes, the schedule will fail with a "No report to distribute" error. If the scheduled task is
burst, you can also use the '%BURST' symbol to include the burst value. If the Packet Email
setting is Yes, the burst value will not be substituted in the Zip filename.

1. Right-click a report procedure (FEX), select Schedule, and then select Email.

The Basic Scheduling tool appears.

2. Select the Distribution tab.

3. From the Type drop-down list, select the method you will use to provide the email
addresses that will receive the distribution. The options are Distribution List, Distribution
File, Dynamic Distribution List, and Email Address(es). These options all show where the
report procedure (FEX) distributes To, From, Reply Address, and Subject. Additionally, in
the Email Information section, select whether you would like to send all reports as
attachments or send a report as an inline message.

Distribution List. The report will be sent to all email addresses in the selected email
Distribution List.

Email Address(s). This is the default method for supplying email addresses in the
scheduling tools. The default value of this field is the email address of the user that is
creating the schedule. You can specify multiple email addresses in the Email
Address(s) field. Separate each email address with a comma (,) or a semicolon (;). The
email addresses will appear in the To line of a single email when the scheduled output
is distributed. Each individual email address can be a maximum of 130 characters,
according to the SMTP specification. The total maximum length of this field is 800
characters.

6. Using Content

Online Help PDF  781



Additionally, you can use group mail lists (defined on your mail server) with the Email
Address(es) option. You can use group mail lists to distribute a report or notification to
multiple recipients without having to maintain multiple email addresses in the
Repository. The format of the group mail list depends on the mail server being used.
For example, if you are using a Microsoft Exchange Server and your group mail list is
defined as #group1, you would enter group1@listdomain in the Email Address(es) field.
If the group mail list contains a space within its name, enclose the space with double
quotation marks ('' ''). For more information, see your mail server administrator.

4. In the To box, type the email address of the recipient.

5. In the From box, type any value (for example, the name of the person creating the
schedule). ReportCaster does not require a value for this field, but your email system may
require one.

6. In the Reply Address box, type a valid email address. If recipients reply to the email, their
messages will be sent to this address. If your email system is unable to deliver the
content, the undeliverable output message is also returned to this address. ReportCaster
requires this field.

7. In the Subject box, type the text that you want to appear in the email subject line.
ReportCaster may not require this information, but it may be needed by your email system.
The value you entered in the schedule Title field is the default Subject value.

8. Specify whether you want to send the report as an email attachment, or within the body of
the email inline by selecting or clearing the Send all reports as attachments option. For
more information, see Using the Email Distribution Option in the Basic Scheduling Tool on
page 779.

9. Optionally, you can type a message to appear in the email body to replace the default
message, Please see attachment(s).

Note: You can also provide a custom default distribution message using the Email
Distribution and Notification settings in the ReportCaster Configuration tool in the
ReportCaster Console. This allows you to override the default message, Please see
attachment(s), by enabling you to create a custom message specific to your organization.
The message displays when creating a schedule using Email distribution. For more
information, see ReportCaster Configuration on page 153.

10. Optionally, select a file from the WebFOCUS Repository that contains the message you
want to distribute with your Email distribution.

Note: When you use the file option, the information can be maintained in one common
place. It can also be revised among multiple schedules. There is no size limit to the
contents of the file, other than what the email client and server support.
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11. Optionally, specify a value for the Packet Email or accept the default value. The Packet
Email option is set to the default value configured by the Manager. For a schedule that has
a task that is burst, you can decide how many emails to send to each recipient. Options
include:

No. Sends each attachment in a separate email.

Yes. Sends one email that contains all attachments.

By Burst Values. Sends one email with multiple attachments for each burst value.

12. Specify whether to send the report as a compressed (.zip) file by selecting or clearing the
Add Report to Zip File check box.

You have the option of converting your distributed report into a password-protected
compressed file. By default, the Add Report to Zip File check box is not selected and the
report will not be compressed. You can optionally password protect a zipped file by
including a password in a Distribution File or Dynamic Distribution List.

13. If the Add Report to Zip File check box is selected, enter the name of the Zip file in the Zip
File Name box.

Note: Support of Unicode characters in a Zip file name and content within a Zip file on
Windows 7 and Windows 2008 Server R2 requires the following hotfix from Microsoft: 
http://support.microsoft.com/kb/2704299/en-us. Without this hotfix, file names are
corrupted after you decompress a .zip file in Windows 7 or in Windows Server 2008 R2.

14. Additionally, you can specify the minimum size (in KBs) a file must exceed before it is
automatically added to a Zip file. The Zip minimum size is set to the default value
configured by the administrator. To automatically zip an attachment that exceeds a certain
size, set this value to the desired size.

15. Select the Notification tab to specify whether to send an email notification of the schedule
job status. If you select Always or On Error, then you have to specify the Reply Address,
Subject, Brief Message To, and Full Message To.

16. Next, select the Properties tab to specify the Title, Priority, whether to delete the schedule
if it will not run again, and whether the schedule is enabled to run. For more information,
see About Properties in the Basic Scheduling Tool on page 787.

17. Select the Recurrence tab to specify how often to run the schedule. If you want the
schedule to run on the current day, set the Start Date and Start Time to values later than
the current time. For more information, see About Recurrence in the Basic Scheduling Tool
on page 788.

18. Select Save & Close to save the schedule.
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Using the Printer Distribution Option in the Basic Scheduling Tool

The report formats that support printing are DOC, PDF (when you configure ReportCaster to
enable PDF to print and the printer has the appropriate driver), PS, and WP.

Note:

You must be authorized to distribute to a Printer in order to create a schedule that uses
Printer distribution.

Problems may occur in printed output if the distributed reports contain UTF-8 characters.

Since a Printer schedule will not work unless the report output format is a valid print
format, ReportCaster always sets the format of a schedule with distribution to a printer to a
valid format. If the default configuration of PDF as a valid print format is in place, the
override format is set to PDF. Otherwise, the override format is set to DOC. You can change
this format on the Task tab.

Procedure: How to Use the Printer Distribution Option

Note: You can use parameters (amper variables) when specifying a value for the Printer Name
field of a schedule. These parameters can be system variables, such as &YYMD, or any amper
variable for which a value is returned by the Reporting Server when the scheduled procedure is
executed. To use the dot file extension separator after a variable, terminate the variable with
the '|' character (for example, &YYMD|.htm). Similarly, to use the ampersand character itself,
follow the ampersand with the '|' character (for example, Smith&|Jones). If a value for a
parameter specified in a schedule is not returned by the Reporting Server when the procedure
executes, the schedule will fail with a "No report to distribute" error. If the scheduled task is
burst, you can also use the '%BURST' symbol to include the burst value.

1. Right-click a report procedure (FEX), select Schedule, and then select Printer.

The Basic Scheduling tool appears.

2. Click the Distribution tab.

3. From the Type drop-down menu, select the method in which you will provide the file names
to distribute to the printer. The options are:

Distribution List. The report will be sent to all printers in the selected Distribution List.
To select a Distribution List, click the icon next to the Distribution List field.

Printer Name. Specify the printer using the following format.

queue@printserver
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where:

queue 

Is the name of the printer queue.

printserver 

Is the host name or IP address of the printer.

ReportCaster can differentiate between the printer queue and the printer host name or
IP address due to the presence of the '@' separator. Although ReportCaster supports
specifying only the host name or IP address of the printer, we recommend that you
specify both the printer queue and host name or IP address when distributing
ReportCaster output to a printer. The maximum length of this field is 800 characters.

4. If you select Distribution List, click the Name button, which will display the Open dialog box
to allow you to select a Distribution List. If you select Distribution File, specify in the Name
field the fully qualified path and file name where the external Distribution File is located. If
you select Printer, specify the printer name in the Name field.

5. Select the Notification tab to specify whether to send an email notification of the schedule
job status. If you select Always or On Error, then you must specify the Reply Address,
Subject, Brief Message To, and Full Message To.

6. Select the Properties tab to specify the Title, Priority, whether to delete the schedule if it
will not run again, and whether the schedule is enabled to run. For more information, see 
About Properties in the Basic Scheduling Tool on page 787.

7. Select the Recurrence tab to specify how often to run the schedule. If you want the
schedule to run on the current day, set the Start Date and Start Time to values later than
the current time. For more information, see About Recurrence in the Basic Scheduling Tool
on page 788.

8. Select Save & Close to save your changes.

Notification Options in the Basic Scheduling Tool

The Notification tab in the Basic Scheduling tool, shown in the following image, provides the
options to send a notification of the schedule status to specific email recipients.

Note:

Notification will not work unless a mail server is configured. If a mail server is not
configured, notification will fail and an error message will be recorded in the schedule job
log. For more information about configuring a mail server, refer to the Installation topic in
the Information Center.
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You can use parameters (amper variables) when specifying values for the Notification fields
of a schedule. These parameters can be system variables, such as &YYMD, or any amper
variable for which a value is returned by the Reporting Server when the scheduled
procedure is executed. To use the dot file extension separator after a variable, terminate
the variable with the '|' character (for example, &YYMD|.htm). Similarly, to use the
ampersand character itself, follow the ampersand with the '|' character (for example,
Smith&|Jones). If a value for a parameter specified in a schedule is not returned by the
Reporting Server when the procedure executes, the schedule will fail with a "No report to
distribute" error.

The notification options are:

Never. ReportCaster will not send a notification of the schedule status under any
circumstances. This is the default value.

Always. The specified users are always notified when the schedule runs.

On Error. The specified users are notified when errors are encountered while running the
schedule. Information Builders recommends the use of the On Error notification option.

Setting On Error and Always Notification in the Basic Scheduling Tool

When you select the On Error or Always notification option, additional options become
available, as shown in the following image.

The On Error and Always notification options are:

Reply Address. Type the email address of the sender. If report recipients reply to the report
sender, then their messages are sent to this address. If your email system is unable to
deliver a report, then the undeliverable report message is also returned to this address.

Note:

If you are authenticating to the mail server with your user ID and password, then the
reply address will be the email address associated with that user ID.

If the mail server is configured with authentication and the Reply Address is configured
in the ReportCaster Configuration tool, then the Reply Address field in the scheduling
tools will be disabled. If a Reply Address is not configured, then the field is enabled to
allow a Reply Address to be sent to the email server, however the actual Reply Address
of the delivered email will be that of the authenticating account.

Subject. Type the text you want to display in the subject line of the email notification. There
is a limit of 255 alphanumeric characters. By default, this field contains the report name
and date and time stamp.
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Brief Message To. Type the email address where you want a full notification sent. There is
no syntax error checking for this field.

Tip: Use the Brief Message To option when you are sending notification to devices that
have limited memory, such as pagers and cell phones. If you want to notify multiple
recipients, you can use group mail lists defined on your mail server provided that you
append an at sign (@) followed by a valid domain.

Full Message To. Type the email address to which you want a full notification sent. There is
no syntax error checking for this field.

About Properties in the Basic Scheduling Tool

When you access the Basic Scheduling tool, the Title and Path Properties options are
predefined for the selected report procedure (FEX). The following image displays the Properties
tab in the Basic Scheduling tool.

The options within the Properties tab are:

Title. This allows you to provide a brief description of the purpose of the schedule. It is pre-
populated with the Title of the report procedure being scheduled when creating schedules
with the Basic Scheduling tool. You can edit the Title while creating the schedule or after
saving the schedule from within the Schedule tools. You can also edit the title from the
Properties option from the Resources tree after saving the schedule.

The Title of the schedule is the default name assigned when saving the schedule. If the
name value already exists in the selected tree folder, a message is displayed informing you
that the name already exists. You can change the Title field in the Save dialog box, which
when saved, will also update the Title field within the schedule information.

Path. This is the Repository path of the report procedure (FEX) you selected to schedule.

Summary. This allows you to insert a detailed description for the schedule. This is an
optional field.
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Job Priority Level. This specifies the priority the scheduled job will be given when
processed by the Distribution Server. The default Job Priority Level is set to Normal - 3.
However, you can use the drop-down list to set the priority level, as shown in the following
image.

No Report to Distribute. This option is set to the default value configured by the Manager.
To trigger error notification if no report is generated, set this value to Error. If you do not
want to trigger notification when no report is generated, set this value to Warning.

Delete this schedule if it is not scheduled to run again. This check box allows you to
specify that the schedule should be deleted after the scheduled job processing is
completed if the schedule is not scheduled to run again. Selecting this option for schedules
you will not utilize again is recommended as it will improve overall performance within the
Resources tree listing folder contents and within the ReportCaster Explorer tool when listing
schedules.

Enabled (Scheduled job runs at specified time). This check box is selected by default to
specify that the schedule should be evaluated by the Distribution Server when polling for
scheduled jobs to run. If you do not want to distribute the schedule based on its
NEXTRUNTIME value, clear this check box.

About Recurrence in the Basic Scheduling Tool

When you access the Basic Scheduling tool, the Recurrence tab options allow you to define
how often to run the schedule. The following image displays the Recurrence tab in the Basic
Scheduling tool.

Options that users must determine include frequency of distribution, start and end times, and
Advanced interval settings. Select one of the following frequency of distribution settings:

Run Once

Minutes

Hourly
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Daily

Weekly

Monthly

Yearly

Custom

You can assign start and end times by using the drop-down lists. When you click on the down
arrow, a calendar will display that enables an authorized user to set the date for schedule
distribution. Use the up and down arrows to set a specific time for schedule distribution.
Alternatively, you can enter the time manually.

If the user has the privilege to set Advanced settings, check the Repeat schedule every check
box to enable Advanced interval setting options. Set how often you want to repeat schedule
distribution, when you want to stop distributing the schedule (Until Time), and the duration to
distribute the schedule (Last For). Enter this information manually or use the up and down
arrows to set parameters.

The Run Once Interval

The Run Once option sets the job to execute immediately. This is the default value. You can
modify the date or time if you do not want the schedule to run immediately. You can specify
the date and time you want the schedule to run using the Start Schedule options, as shown in
the following image.
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To select a date, choose a date from the drop-down date calendar. To select a time, select
either the hour or minutes, and use the up and down arrows to increase or decrease the value.
Alternatively, you can enter the time manually.

The Minutes Interval

The Minute(s) option sets the schedule to run every n minutes.

In the Every minute(s) field, type or select the minutes interval (1 to 59), check the days of the
week on which you want to run the schedule, and select the Start and End date and time to
define the time period in which the schedule will run. For example, the following image shows a
schedule that will run every 30 minutes on Mondays beginning at noon May 16, 2012 and
ending 6:00 PM October 30, 2012. 

Tip: Selecting this option may affect system performance if you choose to run the schedule
every 5 minutes or less. We recommend specifying a minimum of 30 minutes. The minute
interval option is primarily for alert schedules.
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The Hourly Interval

The Hourly option sets the schedule to run every n hours.

In the Every hour(s) field, type or select the hours interval (1 to 24), check the days of the
week on which you want to run the schedule, and select the Start and End date and time to
define the time period in which the schedule will run. For example, the schedule shown in the
following image will run every three hours on Mondays and Fridays beginning at noon May 16,
2012 and ending 6:00 PM October 30, 2012. 
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The Daily Interval

The Daily option in the Run Interval drop-down list sets the schedule to run every n days. In the
Every day(s) field, type or select the days interval to run the schedule and select Start and End
date and time to define the period in which the schedule will run. For example, the schedule
shown in the following image will run every five days beginning at noon May 16, 2012 and
ending 6:00 PM October 30, 2012. 

You can also set a secondary run interval. For information about this setting, see Advanced
Settings on page 798.
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The Weekly Interval

The Weekly option in the Run Interval drop-down list sets the schedule to run every n weeks.

In the Every week(s) field, type or select the weekly interval to run the schedule, check the
days of the week on which you want to run the schedule, and select the Start and End date
and time to define the time period in which the schedule will run. The following image shows a
schedule that will run every two weeks on both Monday and Friday beginning at noon May 16,
2012 and ending at 6:00pm on October 30, 2012. 

Note: When selecting the Weekly interval, set the Start to the date of the first day (current or
future) of the week you want the schedule to run. If you select the current date, then you must
make sure that the Start time is later than the current time when you save the schedule. If the
Start time is less than or equal to the current time, the calculation for the next run time results
in the schedule not running on the current date.

You can also set a secondary run interval. For more information about this settings, see 
Advanced Settings on page 798.
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The Monthly Interval

The Monthly option sets the schedule to run every n months. You can then refine the monthly
interval with one of the following options. Note that these options are mutually exclusive.

Every first, second, third, fourth, or last n day of the week (where n is Monday, Tuesday,
Wednesday, Thursday, Friday, Saturday, or Sunday) every n months.

Specific days every n months.

Additionally, select the Start and End date and time to define the time period in which the
schedule will run. The following image shows a schedule set to run on the first Monday of
every month beginning at noon May 16, 2012 and ending 6:00 PM October 30, 2012. 
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The following image shows a schedule set to run on the 2nd, 9th, 16th, 23rd, and 30th of
every month, regardless of the day of the week on which those dates fall.

You can also select the Last Day of the Month option at the end of the calendar to run the
schedule on the last day of the month.

Note: When selecting the Month(s) interval, set the Start date to the date of the first day
(current or future) of the month you want the schedule to run. If you select the current date,
then you must make sure that the Start time is later than the current time when you save the
schedule. If the Start time is less than or equal to the current time, the calculation for the next
run time results in the schedule not running on the current date.

You can also set a secondary run interval. For information about this setting, see Advanced
Settings on page 798.
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The Yearly Interval

The Yearly option sets the schedule to run every n years during a specific time period. The
following image shows a schedule set to run every two years beginning at noon May 16, 2012
and ending 6:00 PM October 30, 2022. 

You can also set a secondary run interval. For information about this setting, see Advanced
Settings on page 798.

The Custom Interval

The Custom option allows you to select a set of dates that do not follow a specific pattern. For
example, if you want to run a quarterly report on a different day of each quarter, then you can
use the Custom run interval to set the schedule to run on dates, such as March 3 (Saturday),
June 4 (Monday), September 7 (Friday), and December 2 (Sunday).
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The following image shows the Custom Run Interval options, which includes Start (initially set
to the current date and time) and the End date and time options, the Custom calendar, and
the Custom Date List node that appears in the right panel.
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Define the time period in which the schedule will run by selecting the Start date and time and
the End date and time. Select the specific days on which to run the schedule by clicking the
day in the calendar. (Use the forward and back buttons at the top of the calendar to move
through the months and years.) As you select a date, it appears in the Custom Date List. If it
does not already exist, a folder for the year and month of the date you select is automatically
created under the Custom Date List node. The following image shows an example of a
selection of Custom dates in the calendar and the Custom Date List.

To remove a date from the list, click the date in the calendar. The date is no longer highlighted
in the calendar and will not appear in the Custom Date List. You can optionally use the left
single arrow to remove a date from the list. The double arrow button removes all defined lists.

You can also set secondary run interval. For information about this setting, see Advanced
Settings on page 798.

Advanced Settings

The Advanced settings option enables you to create a secondary run interval within the day the
schedule runs. You can apply the secondary run interval every n minutes or hours for a
specified number of hours and minutes or until a specified time. This option is available for
schedules that run every day(s), week(s), month(s), or year(s).

Note: When a schedule is saved, the hours setting is converted to minutes. When a schedule
is edited, this value appears as minutes.
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The secondary run interval will not be validated when the schedule is created. Instead,
validation is performed every time the next run time of the schedule is calculated when running
within the secondary run interval. The secondary run interval cannot exceed the next run time
for the primary run interval. For example, a daily schedule cannot have a secondary run interval
greater than Every 1 day(s). If you schedule a secondary run interval to run after the next
primary run interval of the schedule, the secondary run interval is stopped and an error
message appears. This error message is also written to the log file. 

The Advanced settings section allows you to specify repeat options, as well as time intervals.
The following image shows an example of set secondary run interval options.

The Apply secondary run interval options are:

Repeat schedule every. Applies the secondary run interval every n minutes or hours (in this
example, every 10 minutes) within the day the schedule runs.

Until Time. The time up until which the secondary run interval will be applied. In this
example, the schedule will rerun every 10 minutes until 4:10 PM when the Until Time
option is selected.

Last For. The duration, specified in hours and minutes, during which the secondary run
interval will be applied. This option and the Until Time option are mutually exclusive.

Note: When a schedule is updated, the next run time is recalculated based only on the primary
run interval. This means that if a schedule that includes a secondary run interval is updated
before the secondary schedule is able to run, then the secondary run interval is ignored and
the NEXTRUNTIME is calculated based on the primary interval.

For example, a schedule exists that is set to run daily at 2:00 PM with a secondary run interval
of every 10 minutes from 2:00 PM to 3:00 PM. When the schedule runs at 2:00 PM, the
NEXTRUNTIME resets to run at 2:10, which honors the secondary run interval. If this schedule
is updated at 2:03 PM, the NEXTRUNTIME is recalculated to be 2:00 PM the next day, rather
than 2:10 PM on the current day.
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Maintaining Schedules

Maintaining a schedule allows you to edit schedule properties or delete the schedule when it is
no longer needed. If a schedule contains properties that you want to use in a new schedule,
the duplicate or copy option creates a template with those properties for the new schedule.
You can also check the status of a schedule and run a log report to obtain detailed information
about the schedule.

About Maintaining a Schedule in the Basic Scheduling Tool

As a user with the ability to access the Basic Scheduling tool, you can perform various
maintenance functions on the schedules you are authorized to access. 

If you right-click a schedule in the Resources tree, the options shown in the following image
are available.

Note: The options shown are dependent on your security effective policy.

Edit 

Allows you to open and edit an existing schedule.

Run 

Runs the schedule.

View Log 

Allows you to view a log report for one or more selected schedules.

Duplicate 

Creates a new schedule with the same properties in the same folder. The new schedule is
disabled automatically, because it is a duplicate of an existing schedule.

Cut 

Allows you to move the schedule from the original folder to a target folder using the Paste
operation.

Copy 

Allows you to create a new schedule by copying an existing schedule.

Create Shortcut 

Allows you to create a shortcut to the schedule.

Delete 

Deletes the existing schedule.
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Change Title 

Allows you to rename the schedule.

Publish and Unpublish 

An owner of a schedule can make a schedule available to other members of the top-level
folder in which the schedule resides. The schedule owner remains the execution ID. The
following table describes the shortcut menu options permitted to the different groups
associated with a top-level folder.

Basic Advanced Developer Group
Administrator

Manager

Run

View Log

Edit

Publish/Unpublish

Security

Hide/Show

Copy/Duplicate

Properties

Change Title

Delete

Note: The default setting is Unpublish.

Hide and Show 

Once an owner publishes a schedule, they can elect to Hide the schedule from groups not
authorized to create content in the folder. To hide or show a schedule, right-click on a
schedule and select the Hide or Show option.

Note: The default setting is Show.
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Share 

Allows you to share the selected schedule. You can subsequently Unshare the schedule
via the same menu.

Share with 

Allows you to specify the groups and users with whom you want to share the selected
schedule.

Unshare 

Allows you to remove sharing on a shared schedule. This option only displays if you have
previously shared the schedule.

Security 

Allows you to view and modify the ownership of the schedule. Options include: Rules,
Rules on this Resource, and Effective Policy.

Properties 

Allows you to view properties of the schedule, as well as modify title and summary
information. You can also change the name of a schedule using the Properties dialog box.
In addition, you can access Security features, including Owner and Sharing.

Editing a Schedule in the Basic Scheduling Tool

From the Resources tree, you can edit the schedules you are authorized to access. 

Procedure: How to Edit a Schedule in the Basic Scheduling Tool

1. Right-click the schedule you want to edit and select Edit.

2. Make the required changes to the schedule. For details on the Basic Scheduling tool
options, see Creating a Schedule in the Basic Scheduling Tool on page 764.

3. Click Save & Close.

Reference: Considerations When Editing a Schedule in the Basic Scheduling Tool

When you open a schedule that uses unavailable options, such as a distribution method,
information is displayed that describes the change or changes that you must make for the
schedule to use available options. Changes to the schedule cannot be saved until the
schedule uses available options. 

If you selected Run once for the run interval, the schedule runs immediately unless you
change the Start Time to a time later than the current time. All other run intervals run at the
next primary run-time interval of the schedule.
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You must save your changes in order to be able to run from within the scheduling tool.

If you want your selected schedule or schedules to run immediately, click Run.

Copying a Schedule in the Basic Scheduling Tool

For your convenience, you can copy an existing schedule for use as a template to create a new
schedule. The copied schedule is created disabled because it is a duplicate schedule. 

Procedure: How to Copy a Schedule in the Basic Scheduling Tool

Note: The cut, copy, and paste options display when you are authorized to use these options.

1. From the Resources tree, right-click the schedule you want to copy and select Copy.

2. Right-click the folder you wish to copy the schedule into and select Paste.

Deleting a Schedule in the Basic Scheduling Tool

From the Resources tree, you can delete schedules using the following procedure. 

Procedure: How to Delete a Schedule in the Basic Scheduling Tool

Note that the Delete option displays when you are authorized to delete the selected schedule.

1. Right-click the schedule you want to delete and select Delete.

Note: To select multiple schedules, use the Shift key and Control (Ctrl) key as in a
standard Windows interface. A message appears asking to confirm if you want to delete
the selected schedules.

2. Click OK to delete the schedule or schedules.

Sharing Schedules

The owner of a schedule that is located in a My Content folder can share that schedule with
other users.

Procedure: How to Share Schedules

From the Resources tree, you can share one or more schedules by performing the following
steps.

1. In the Resources tree, select one or more Schedules that you want to share.

2. Right-click the selected schedule or schedules and select Share.
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If you are a group administrator or user with the share schedule privilege, the schedule or

schedules are shared. The Schedule icon  changes to denote that it is shared.

Procedure: How to Share Schedules With Specific Groups or Users

From the Resources tree, you can specify the groups or users with whom you want to share the
selected schedule or schedules.

1. In the Resources tree, select one or more schedules that you want to share.

2. Right-click the selected schedule or schedules and select Share with.

3. Use the left and right arrow buttons to select which Groups will have access to Schedules.

4. Use the left and right arrow buttons to select which Users will have access to Schedules.

5. Click OK.
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Publishing Schedules

A published schedule is visible to all users with access to the folder in which it resides. The
shortcut menu options that appear on the schedule depend upon the privileges of the user
that is signed in. For example, a user with the Run privilege is able to run the published
schedule. When a published schedule runs, it runs as the creator of the schedule and not as
the signed in user that initiated the run.

Note: A published schedule runs as the creator of the schedule. A user that is allowed to edit
a published schedule may make a change to the schedule that the creator of the schedule is
not permitted to make. In this case, the schedule will fail at run time. For example, a user may
change the Distribution List used in the schedule to a private Distribution List that is not
available to the creator of the schedule. When the changed schedule runs, it will fail due to
inability of the creator to retrieve the Distribution List from the WebFOCUS Repository.

Procedure: How to Publish a Schedule

From the Resources tree, you can publish a schedule by performing the following steps.

1. In the Resources tree, select a schedule that you want to publish.

2. Right-click the selected schedule and select Publish.

The schedule is published.

Tracking Schedules

Information about a schedule, such as date, time, execution status, and recipients of a
distributed job, can be accessed by running a log report and checking the job status in the
ReportCaster Console Job Status tool. 

Log Reports

Log reports are stylized HTML format and appear in a separate browser window. You can
search, print, or save the log report. The log report displays information according to your
specifications in a separate browser window. One log record is produced for each scheduled
job run in the specified time frame. 

Tracking Schedules in the Console

Information about a schedule, such as date, time, execution status, and recipients of a
distributed job, can be accessed by running a log report and checking the job status. For more
information, see Using the ReportCaster Console on page 144.
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Using Schedule Logs

Log reports enable you to view information about a distributed job, such as whether or not the
job executed successfully, when the scheduled output was distributed, in what format the
distributed output was sent, and the method of distribution. Log reports are stylized HTML
format and display in a separate browser window. You can search, print, or save the log report.
Log reports can be accessed within the scheduling tool when editing a schedule or by right-
clicking on a schedule from the Resources tree.

The log file accumulates information. You should periodically purge log records to manage the
number of log reports stored in the Repository, as well as the performance of log report
information that is displayed.

The list in the right panel provides basic information about the job execution, including the job
ID, the time the job started running, the amount of time it took to complete the execution of
the job, and the general status of the job. To view a full log report for a job, double-click the job
in the job list.

Checking the Job Status

Another resource for tracking schedules is the schedule job status. The schedule status
provides a list of scheduled jobs that are in the Distribution Server queue. Status information
includes the schedule ID, the time it started running, and the status of the job. 

To access the schedule job status information, see the Job Status tab in the ReportCaster
Console. For more information, see Using the ReportCaster Console on page 144.
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Procedure: How to View a Log Report From the Resources Tree

1. Right-click the schedule from the Resources tree and select View Log, as shown in the
following image.
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The Schedule Log Options dialog box appears, as shown in the following image.

2. Specify which log report you would like to view by selecting Last Executed, All, or Date.

If you select Date, you will have the option to specify your search using start date and time
and end date and time parameters.

3. Click OK.
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The log reports that match your search criteria appear, as shown in the following image.

The log report first lists the job description for the record, which is the unique description
identifier that you specified when you created the schedule. Underneath the Job
Description, the left column of the log report includes the following information: 

User. ReportCaster user ID, indicating the owner of the schedule.

Procedure. Unique key generated by ReportCaster that identifies a specific execution
of a scheduled job.

Schedule ID. Unique key generated by ReportCaster that was assigned to the job when
it was scheduled.

Start Time. Date and time the job started running.

End Time. Date and time the job finished running.

In the second column, the log report specifies messages consisting of the following:

General information, such as the method of distribution for a particular job (for
example, email distribution).

Processing information, indicating that the request started, distribution was
successful, and the request was completed. Processing information also includes
reasons why a request failed, such as the unavailability of a data source.

Procedure: How to View a Log Report in the Scheduling Tool

1. From the Resources tree, right-click the schedule for which you want to see the logs, and
click Edit.

The Basic Scheduling tool opens.
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2. From the Basic Scheduling tool, click the Log Reports tab.

The Log Reports panel appears, as shown in the following image.

3. Observe the Number of Jobs that have run.

4. Click the Job Number to view the log report information for that job in the panel below the
job listing.

Reference: Considerations When Viewing a Log Report

When viewing a log report, be aware of the following considerations.

Task and Report Names

The ReportCaster Log references WebFOCUS folders and procedures (FEXs) by their path and
file names and not their descriptions.

Email Addresses

ReportCaster cannot validate email addresses since email validation is performed by the mail
server. The log report will include any email addresses validated by the mail server and
returned to ReportCaster.
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Burst Reports

If a valid burst value is omitted in a Distribution List, Distribution File, or Dynamic
Distribution List, ReportCaster treats the blank value as if it is a valid burst value and no
entries indicating a blank burst value appear in the log file. This will significantly reduce the
size of the log file, particularly when the database contains many values for the primary
field and only a small subset of those values are burst.

If a burst value is specified in a Distribution List, Distribution File, or Dynamic Distribution
List and it is not found in the database, the following message appears in the log file:

Burst Value: value is not in the database.

When a report procedure (FEX) is successfully burst, the log file will include the following
message for each burst value:

FILE filename SUCCESSFULLY DISTRIBUTED TO destination FOR burst 
value.

Unavailable Options

When schedules with unavailable task types or distribution methods are not permitted to
run, an error notification is triggered. The error is shown in red text within the job process
log report. The log report, as well as the full and brief notifications, contains information on
the unavailable options that the owner of the schedule must change. 

When schedules with unavailable task types or distribution methods are permitted to run,
normal job execution occurs and a message appears in the log report indicating that
existing schedules using the unavailable task types or distribution methods are able to run.
For more information on configuring available task types and distribution methods, see 
Configuration Tab Folders on page 155.

Using Favorites

You can further customize your Personal Portal, by using the Favorites feature. When you save
content as a Favorite, it automatically appears in the Favorites node in the Resources tree.
Here, you can interact with your content and view its properties.

Procedure: How to Add Content to Favorites

1. In the Resources tree, right-click a report, chart, document, visualization, shortcut, or URL,
and then click Add to Favorites .
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The item is added to the Favorites node, as shown in the following image.

2. Right-click the item inside the Favorites node to access the shortcut menu for this item.

Procedure: How to Remove a Favorite

1. In the Resources tree, under the Favorites node, right-click an item.

2. Click Remove Favorite.

The item is removed from the Favorites node.

Publishing Content

When you create a new item (for example, folder, report, or chart), it is private. Only you can
see it, run it, edit it, and so on. A private item is illustrated with a gray icon.

When you are ready to allow others to access the item you can publish it. This turns on any
rules set on the item itself or inherited from a higher level. The icon of the item appears in full
color to indicate the item is live.

Managers and developers have the ability to publish items. Once the item id published, it
becomes visible to all users.
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Using Visualizations at Run-Time

In InfoAssist+, you can run visualizations that are either saved or run dynamically at run time.
In this case, the visualization opens in a separate browser window, as shown in the following
image.
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In the WebFOCUS BUE portal, all users can run stored visualizations that are available to them.
In this case, the visualization opens in a new page, as shown in the following image.

Working With Filters at Run Time

If you have added a filter to your visualization, you can use the Prompts panel to control the
display of information. When you run your visualization, the Prompts panel appears. This
enables you to select additional components by which to filter the visualization.

Note: The filters that you apply at run time can be removed using the Remove Filter option in
the Run-Time toolbar. This does not apply to filters that were added prior to running the
visualization.
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The following image shows an example of a visualization with an open Prompts panel.

Note: If you select (or lasso) components of your visualization, the Prompts panel does not
automatically update to reflect your selections.

Procedure: How to Filter Data With Tooltips at Run Time

1. Run a visualization from one of the following locations:

From the Resources tree in the WebFOCUS BUE portal.

From the Application Main Menu or Quick Access Toolbar in InfoAssist+.

2. Click, point to, or lasso data in your visualization.
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A tooltip opens, as shown in the following image.

The tooltip includes the following options:

Filter Chart. Filters the visualization by the data values that you have selected.

Exclude from Chart. Excludes the selected data values from the visualization.

Remove Filter. Removes the filter and returns the visualization to its original state.
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Note: The same run-time options are available when you run your visualization on a mobile
device.

Viewing Data at Run Time

When viewing data at run time, you can access the data behind each visual in your
visualization. Using the Show Data option, which is available from the Run-Time toolbar, you
can view your data in summary format. This grid display includes totals for the categories in
your visual, based on the data fields that you selected. All InfoAssist+ users can use this
option with the visualizations that are available to them.

Procedure: How to View Data at Run Time

1. Run a visual or visualization from one of the following locations:

From the Application Main Menu or Quick Access Toolbar in InfoAssist+.

From the Resources tree in the WebFOCUS BUE portal.

2. In the bottom-right corner of the visual cell, click the arrow.

The Run-Time toolbar opens.

3. Click the Show Data button .

The visual changes to the grid view, displaying the underlying data for the selected visual.

Click the Show Data button again to return to your visual.

Note: The same run-time options are available when you run your visualization on a mobile
device.

Using the Run-Time Toolbar Options

You can access the Run-Time toolbar by clicking the arrow button, which is located in the
bottom-right corner of each visual cell at run time. The Run-Time toolbar is shown in the
following image.

The Run-Time toolbar options are described in the following table:
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Icon Name Description

Show Data Alternates between the visual and the grid view,
which shows the underlying data. To return to the
visual view, click the Show Data button again.

Reset to Default Resets all changes and returns the visualization to its
original state.

Remove Filter Removes the filter and returns the visualization to its
original state. This option is only available if a filter is
applied at run time.

Note: The same run-time options are available when you run your visualization on a mobile
device.

Using the Deferred
Report Status Interface

The following topics provide an overview of the Deferred Report Status Interface including a
detailed description of its appearance and functions. Specific procedures guide you through
viewing, saving and deleting reports, deleting deferred reports that are being processed but are
not yet complete, and reviewing parameters for reports containing amper variables.

The Deferred Report Status Interface enables you to obtain information about deferred reports.
From this Interface, you can perform the following actions on a deferred report: 

Sort deferred report output by date, description, domain, and server ID.

View deferred report output.

Delete a deferred report from the WebFOCUS Reporting Server.

Save the report output as private content.

Review or change parameters associated with a deferred report.

View the number of days remaining prior to expiration (deletion) on the server.

Terminate a deferred request that is in the deferred report queue.

Terminate a deferred report that is running.

Delete all expired, unknown, completed, running, and queued tickets.

Using the Deferred Report Status Interface

818  Information Builders



You can access the Deferred Status Report Interface from the BUE portal, by clicking Tools, in
the Menu bar, and then clicking Deferred Status.

Running a Report as Deferred

When you run a report as deferred, the report title is assigned as the deferred report
description by default. If the Custom Deferred Report Description feature is enabled, you are
prompted to edit a report description. This feature allows you to distinguish between the
outputs of the same report that you ran at different times.

You can view information about a deferred report in the Deferred Report Status interface
window. The window indicates the time the report was submitted and whether the report was
completed, and also provides Delete, View, Save, as well as Run or Parameters options.

Procedure: How to Run a Report as Deferred

1. From the Resources tree, right-click a report that you want to run as deferred, and then
click Run Deferred.

If the Custom Deferred Report Description feature is enabled, the Deferred Report
Description dialog box opens, as shown in the following image. If you run a parameterized
report as deferred, the Deferred Report Description field is displayed in the Parameters
prompt window.

Note: The Custom Deferred Report Description feature is disabled by default. To enable
this feature, in the Administration Console, click Configuration. Under Application Settings,
click Deferred Reporting, and then set the IBI_Deferred_Custom_Description setting to
True.

2. Optionally, type a new or updated description and click OK.
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The Deferred Report Notification dialog box appears, reflecting the updated description, as
shown in the following image.

3. To open the Deferred Report Status window directly from the dialog box, click the Deferred
Report Status link.

4. To review the deferred report later, close the dialog box. On the BI Portal Menu bar, click
Tools, then click Deferred Status.

Deferred Report
Status Interface Features

The Deferred Report Status Interface includes:

A banner at the top of the window that lists the date and time of the request. 

A gray toolbar below the banner that contains Refresh and Help options, a Sort By drop-
down list to select sort values, a sort order button to toggle between ascending and
descending order, and a Delete drop-down list. The Delete drop-down list has options to
delete All, All Completed, All Running, All Queued, All Expired, or All Unknown reports,
depending on which report status types exist in the Interface. 

The status of each report within the Interface.

Sort Controls for the Deferred Report Status Interface

The sorting feature pertains to the entire report. When the default sort value (Date/Time
Submitted) is changed, the new primary sort becomes your choice, but the secondary sort is
always fixed as Date/Time Submitted. To resort the list, select the Sort by option:

Date (default)

Description

Domain

You can optionally change the sort order (ascending or descending) by clicking the Reverse

Sort Order  button, which toggles between A to Z and Z to A.
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Note: When the sort value is Date, the sort order option A to Z means from new to old and not
alphabetical from A to Z.

To see the results of the new sort options, click Refresh.

Deferred Report Status

The status of deferred requests are organized under the following sections within the Interface: 

Completed. Indicates that the Deferred Receipt request has finished processing.

Running. Indicates that the Deferred Receipt request is processing.

Queued. Indicates that the Deferred Receipt request is queued for processing.

Unknown. Indicates that the Deferred Receipt request cannot be identified. This can occur
when the file containing the deferred report results cannot be found. For more information,
see Deferred Report Expiration Setting on page 824.

The following image shows a sample Deferred Report Status window with one completed report
and two queued repots.

Column headings provide information about the published content including the date and time
the published content was submitted, the domain of origin, a description of the report (the
report name), an expiration indicator, and an Options heading for options within the Deferred
Report Status Interface. 

When you select the Deferred Status option, the status for all the deferred requests submitted
by your Managed Reporting user ID is retrieved. Depending on how Managed Reporting is
configured, deferred status may be coming from multiple WebFOCUS Reporting Servers on
various platforms. If credentials are required for the connections, you are prompted by the
WebFOCUS Dynamic Server System Signon feature. You can view the status of all the deferred
requests submitted by your Managed Reporting user ID, but can only delete, view, save, stop,
or review parameters for deferred requests submitted with an identical WebFOCUS Reporting
Server user ID.
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The options available in the Deferred Report Status Interface are based upon the status of the
report request and security validation. You can perform various functions by clicking the
buttons under the following options.

For more information on configuring Deferred Report Status options and buttons, see Technical
Memo 4719: Managed Reporting - Deferred Status Interface How to Hide Deferred Report
Options (Buttons).

Delete. Available for all report status types. The Delete option deletes the deferred request
according to the report status, as follows: 

Queued. When a deferred request is listed in the Queued tab, the Delete option
removes the deferred report from the WebFOCUS Reporting Server and deletes the
deferred request ticket from the WebFOCUS Repository.

Unknown. When a deferred request is listed in the Unknown tab, the Delete option
deletes the deferred request ticket from the WebFOCUS Repository.

Completed. When a deferred request is listed in the Completed tab, the Delete option
removes the report from the window, deletes the deferred report results from the
WebFOCUS Reporting Server, and deletes the deferred request ticket from the
WebFOCUS Repository.

Running. When a deferred request is listed in the Running tab, the Delete option
deletes the deferred request ticket from the WebFOCUS Repository and cancels the job
on the WebFOCUS Reporting Server. 

Note: The Delete drop-down list in the toolbar at the top of the Interface provides options to
delete All, All Completed, All Running, All Queued, All Expired, or All Unknown reports,
depending on which report status types exist in the Interface.

View. Available when the report status is Completed.

The View option displays the completed report in a new browser session, or the report
format may result in the opening of a Windows dialog box that prompts you to save the
report to disk or open the report within an application (such as Microsoft(R) Excel(R),
Microsoft(R) Word, or Adobe(R) Acrobat(R)).

Note: Auto Drill functionality is not available for reports that are run deferred because Auto
Drill uses live data, in an interactive session, for data drilling. Data values and totals may
not be the same if the data has changed since the last deferred execution. Mixing past
data with current data could impact the data analysis.

Save. Available when the report status is Completed.
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The Save option allows you to save Deferred Receipt reports to the WebFOCUS Repository,
if you are authorized to save deferred reports and to create private content. You can save
the report output to your My Content folder or a folder you are authorized to create content
in and write to. When your deferred report is saved to the WebFOCUS Repository, it is
removed from the Deferred Report Status Interface.

Note: This option appears for users authorized to save deferred reports.

Run. Available for reports without parameters when the report status is completed or
queued. The Run option runs the report deferred again.

Note: Auto Drill functionality is not available for reports that are run deferred because Auto
Drill uses live data, in an interactive session, for data drilling. Data values and totals may
not be the same if the data has changed since the last deferred execution. Mixing past
data with current data could impact the data analysis.

Parameters. Available for reports with parameters when the report status is completed or
queued. The Parameters option allows you to review or change report variables. Changing
report variables generates a new report that does not overwrite the original request. 

Note: Deferred reports run from within any report development tool do not have an option
to view or change amper variable parameter values in the Deferred Status Interface
window.

Under certain circumstances, WebFOCUS is unable to submit the request to run in deferred
mode. This can occur, for example, when the WebFOCUS Reporting Server is unavailable.
When WebFOCUS is unable to submit a deferred request, a Deferred Receipt Notification
window opens, notifying you of the failure.
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Deferred Report Expiration Setting

The number of days until expiration appears next to each report. On the last day, the value
Today appears. 

The following image shows the results of a deferred status request, run on the afternoon of
Tuesday, March 15. (The current date appears in the status bar at the top of the page.) Each
report is listed with the time remaining before it is deleted from the WebFOCUS Reporting
Server. The time remaining is based on 24-hour intervals (rather than whole days), beginning
with the time that the report was submitted. For example, the last report shown on the list will
be deleted shortly after 3:51 pm on March 14, not at midnight on March 13.

If a deferred report is not saved or deleted prior to its expiration, the output is automatically
deleted from the WebFOCUS Reporting Server dfm_dir directory and the deferred report is
moved to the Unknown status tab in the Deferred Report Status Interface. From here, you can
only delete the orphaned report.

If deferred output expiration is not configured on your WebFOCUS Reporting Server, then the
value never appears next to each report under the Expires In column.

Note: This setting does not affect deferred output saved to your private content area.

Saved Deferred Output Subject to Temporary Expiration

Saved Deferred Reports that utilize WebFOCUS features that create temporary files, such as
OLAP, On-demand paging, and redirected formats are subject to expiration as defined by the
WebFOCUS Client parameter, EXPIRE_REPORTS (located in cgivars.wfs).

Setting the Automatic Refresh Interval

You can set the automatic refresh interval to any value. The default is 5 seconds and there is
no maximum value. 

Procedure: How to Set the Automatic Refresh Interval

1. Enter a time interval (in seconds) in the input box below the gray toolbar. 

The default value is 5 seconds. There is no maximum value.
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2. Check the box to enable automatic refresh.

Viewing Deferred Reports

You must access the Deferred Report Status Interface to view deferred reports. 

Procedure: How to View a Deferred Status Report

1. Open the Deferred Report Status Interface. 

2. To view the output of a deferred report:

a. Locate the report description under the Completed tab.

b. Click View, under the Options column, to view the report.

The output appears in a new window.

3. The Deferred Report Status Interface remains open until closed.

a. To return to the Deferred Report Status Interface, close or minimize the report output
window.

b. To return to your reporting environment, close or minimize the report output window,
then close the Deferred Report Status Interface.

4. Click Refresh to obtain the most current status of deferred requests.

Reviewing Deferred Report Parameters

The Deferred Report Status Interface enables you to retrieve parameters submitted with a
deferred request. You access parameters by opening the Deferred Report Status Interface and
clicking the parameters button for the report of your choice. The parameters button is not
available when the deferred request is submitted from within a report development tool, such
as InfoAssist. 

You can also change the parameters associated with a report and submit the report to run
deferred with the new parameters you specified. WebFOCUS generates your report again using
the new parameters and does not overwrite your original report request.

Procedure: How to Retrieve Deferred Request Parameters

1. Open the Deferred Report Status Interface. 

2. In the Completed or Unknown tabs, identify the report containing the parameters to review.
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3. Click Parameter under the Options column heading.

An intermediate window (HTML form) opens.

a. To review and accept the original parameters, close the browser window.

b. To change the parameters, enter a new value in the input box.

The original request runs in addition to the newly submitted request.

4. Click Submit.

The Deferred Report Notification window opens.

5. Close the Deferred Report Notification window to return to the Deferred Report Status
Interface.

Saving Deferred Reports

You can save Deferred Receipt reports to the WebFOCUS Repository, if you are authorized to
save deferred reports. You can save the report output to your My Content folder or a folder you
are authorized to create content in and write to. When your deferred report is saved to the
WebFOCUS Repository, it is removed from the Deferred Report Status Interface. . 

Procedure: How to Save a Deferred Report

1. Open the Deferred Report Status Interface.

2. Under the Completed tab, locate the report you want to save.

3. Under the Options column, click Save, which is located to the right of the deferred report
description.

The Save File Content dialog box opens.

4. Navigate to your My Content folder or another folder you are permitted to create content in
and write to.

5. Click Save to save the deferred report results.

Note:

The maximum length of a title value for a file is 256 characters.

If the title of your file has the same name of an existing file in the folder, you will
receive a message asking if you wish to replace the file.

To return to your reporting environment, close the Deferred Report Status Interface.
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Deleting Tickets for all Report Status Types

From the Deferred Status Interface, you can delete tickets for all report status types using the
Delete drop-down list located in the toolbar at the top of the Interface. The drop-down list
provides options to delete All, All Completed, All Running, All Queued, All Expired, and All
Unknown reports, but only when one or more reports exist for that status type in the Deferred
Status Interface. If a report status type is not displayed in the Interface, the corresponding
status option does not appear in the Delete drop-down list.

You can also delete individual tickets using the Delete button, located in the Options column
next to each report.

The following image shows the Deferred Status Interface with the Delete drop-down list
expanded showing the available options.

For Unknown tickets, the status column shows:

Expired if the report has expired and is no longer stored on the Server.

Unknown for cases where the status cannot be determined, including situations where the
server is not running so a connection could not be made to determine the status.

Note: For Unknown reports, the Options column displays the Server ID that submitted the
report along with the Current ID.

Procedure: How to Delete Tickets for All Report Status Types

1. Open the Deferred Status Interface.

2. Click the down-arrow next to Delete and select one of the following from the drop-down list
that opens:

All

All Completed
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All Running

All Queued

All Expired

All Unknown

You are prompted to conform the deletion.

3. Click Ok to delete all tickets for the selected status type or click Cancel to cancel the
request.

Deferred Status Delete Confirmation Messages

The Deferred Status Interface presents the user with a delete confirmation message before
deleting a deferred report that is in Completed, Running, or Queued states. (A confirmation
message is already displayed for deferred reports in Unknown status.) 

When you click the delete button from the Deferred Status page, you are prompted to confirm
the delete before the deferred report is actually deleted. A similar confirmation message is
used for all deferred reports, but the message varies depending on the conditions.

The following are the confirmation messages and the associated conditions:

If the report is expired or was deleted from the server, the message recommends deletion
and indicates that there is no report output on the specific WebFOCUS server.

If the WebFOCUS server is unavailable, the message indicates there is an error attaching to
the specific WebFOCUS server.

If there is no entry for the server in the WebFOCUS client configuration, the message
recommends deletion and indicates that the specific WebFOCUS server is not defined in
the WebFOCUS client configuration file.

Each of the deletion confirmation messages also displays the date and time the deferred
report was submitted, and the description that is displayed in the Deferred Status Interface.
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Chapter7
Troubleshooting

Learn how to troubleshoot all areas of WebFOCUS Business User Edition.

In this chapter:

Troubleshooting WebFOCUS Business User Edition

Monitoring WebFOCUS Sessions

Exporting the Session Monitor Log

Viewing WebFOCUS Sessions

Working With Log Files

Understanding Warning Messages in InfoAssist+

Troubleshooting WebFOCUS Business User Edition

This topic describes how to troubleshoot the WebFOCUS BUE installation.

Starting the Reporting Server Service

If you receive a message during the installation process related to failure to start the Reporting
Server service, perform either of the following steps after the installation completes:

Start the WebFOCUS BUE 82 Reporting Server service from the Windows Services.

or

Use the Start WebFOCUS_BUE Services program shortcut.

Starting WebFOCUS BUE

If you are unable to launch WebFOCUS BUE, ensure that all services are running. If they are
not, do the following: 

Stop all services.

Restart the services, and launch WebFOCUS BUE.
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If this does not work, stop the services again. Before you restart the services, ensure that the
Hyperstage processes, ibengine.exe and postgres.exe, are also stopped. Restart your machine
if you are still unable to restart the services.

Port Assignment

By default, ports in the range of 26000 to 26040 are checked for availability. If the installation
program detects that no ports in that range are available, it then increases the range by 10
and checks again for availability. For example, if ports 26000 to 26040 are unavailable, ports
26010 to 26050 are then checked.

Default Port Assignment.

Ports 26000 to 26003 are used by the application server.

Port 26010 is used by the repository server.

Ports 26020 to 26023 and port 26040 are used by the Reporting Server

Port 26030 is used by the Distribution Server.

WebFOCUS Business User Edition Log Files

WebFOCUS BUE creates a log file in the following location for Windows 7:

drive:\Users\user_id\WebFOCUS_BUE82_Install_date_time.log

where:

user_id

Is your Windows user ID.

date_time

Is the date and time the log file was created. This log file provides information about the
WebFOCUS BUE installation. If you contact Customer Support Services with an installation
problem, have this file available.

Troubleshooting the Uninstall Process

If you choose to uninstall WebFOCUS BUE, and the uninstall process fails, you can follow one
of the procedures in this section to clean up your machine before reinstalling the product.

Before performing one of the following procedures, ensure that you have uninstalled
WebFOCUS BUE.
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Procedure: How to Manually Uninstall WebFOCUS Business User Edition Components Using the
Cleanup Utility

If the WebFOCUS BUE uninstall process fails, you can run the idis_cleanup.bat file to clean a
damaged installation on your machine. 

1. Navigate to the following location on your machine:

drive:\ibi\WebFOCUS_BUE82\WebFOCUS\utilities\install\

2. Copy the idis_cleanup.bat file from the install directory to a different directory (for example,
drive:\ibi\).

3. Right-click idis_cleanup.bat, and then click Run as administrator.

4. When prompted, type the location of the install directory to proceed.

Note: By default, the utility will back up the Reporting Server apps and the Derby
database.

Procedure: How to Manually Uninstall WebFOCUS Business User Edition Components

If the WebFOCUS BUE uninstall process fails, you can do the following to manually cleanup the
remaining WebFOCUS BUE components on your machine.

1. Stop any running WebFOCUS BUE services on the system
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2. Remove any remaining services from your machine.
a. Locate the existing WebFOCUS BUE services. To get the service name, right-click the

service in the Windows Services program and click Properties. The Properties dialog
box opens, where you can right-click the service name and click Copy, as shown in the
following image.

b. To remove a service, open the Command Prompt as an Administrator and issue the
following command:

sc delete "service name"  

where:
service name

Is the name of the service you are manually deleting. For example:

C:\sc delete "WfBUE82AppSrv"
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Note: The service name must be enclosed in double quotation marks.

Repeat this for the remaining services.

3. Open Task Manager and ensure that the process ibengine.exe is not running.

4. Remove files from disk, except for the Reporting Server application folders.

For example, if WebFOCUS BUE is installed on the C:\ drive, remove all folders under C:
\ibi\WebFOCUS_BUE82\ except for the C:\ibi\WebFOCUS_BUE82\data\ folder.

5. Click Start, point to All Programs, and expand the Information Builders folder.

6. Right-click the WebFOCUS Business User Edition 82 folder and click Delete.

7. Launch the Windows Registry Editor, and remove the following registry keys.

HKEY_LOCAL_MACHINE\SOFTWARE\WebFOCUS_BUE82

HKEY_LOCAL_MACHINE\SOFTWARE\Information Builders\Derby\WfBUE82DbSrv

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Apache Software Foundation
\Procrun 2.0\WfBUE82AppSrv

HKEY_LOCAL_MACHINE\SOFTWARE\Information Builders\WebFOCUS BUE 82
Reporting Server

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Information Builders
\ReportCaster\WfBUE82DistSrv
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Monitoring WebFOCUS Sessions

The Session Monitor enables Managers to track all client sessions, as well as connections
and activity on the Reporting Server. The Session Monitor displays information about
connected users, report requests, and Reporting Server nodes, as shown in the following
image. 

To refresh the information displayed, click the Refresh icon.

Managers can enable or disable logging for all current sessions by clicking All/None/Selective
next to URL Logging Level is currently set to. To enable or disable logging for individual
sessions, click Selective, and then On or Off under the URL Logging column for the individual
sessions. By default, all log information is located in the drive:/ibi/WebFOCUS_BUE82/
WebFOCUS/logs directory.

For each session, the following information is available:

IP Address

The numerical label assigned to the computer or other device that initiated the session.
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Using this address, you can identify the user assigned to the computer or other device that
initiated the session.

Mode

Identifies the product component that started the session and provides information about
all active requests. The product component values are as follows:

WEB

Specifies the Client.

WSRV

Specifies the Reporting Server.

Client User

Specifies the user ID that started the client session. A value of null indicates that it is a
request from a self-service application.

URL Logging

Enables or disables logging for an individual session or a current user.

Trace Control

Enables or disables tracing for a specific IP Address, that is, user.

Trace FEX

Enables or disables WFServlet, Client Connector, and Reporting Server traces for each
session. If tracing is enabled, click the View Trace icon to see the trace.

URL

Specifies the number, average duration, and maximum duration of dynamic URLs sent in
HTTP requests. Duration is measured in seconds, calculated to the millisecond. Not all
URLs in HTTP requests are forwarded to the server, and not all requests forwarded to the
server are then forwarded to the DBMS.

Server

Specifies the number, average duration, and maximum duration of dynamic URLs that run
reports on the Reporting Server. Duration is measured in seconds, calculated to the
millisecond. Not all URLs in HTTP requests are forwarded to the server, and not all
requests forwarded to the server are then forwarded to the DBMS.
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W/DBMS

Specifies the number, average duration, and maximum duration of dynamic URLs that run
reports against an external database. Duration is measured in seconds, calculated to the
millisecond. Not all URLs in HTTP requests are forwarded to the server, and not all
requests forwarded to the server are then forwarded to the DBMS.

Exporting the Session Monitor Log

You may need to export a session monitor log for troubleshooting.

1. In the Administration Console, click the Diagnostics tab, then click Session Monitor.

Current sessions appear in the right pane.

2. Set the Trace Control option for the chosen session to Details.

Information icons now appear in the Trace FEX column.

3. If necessary, run a request for logging, then return to the Administration Console.

4. Click the View Trace icon .

The Session Viewer appears, as shown in the following image.

5. Click on one of the Zip Session Traces links and save the zip file.

6. Close the Session Viewer and return to the Session Monitor pane.

7. Set Trace Control to its previous value. Typically, this is OFF.

WebFOCUS BUE confirms that tracing has been changed or stopped in a message above
the Session Monitor table.
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Viewing WebFOCUS Sessions

The Session Viewer enables you to review traces of system events that took place during
recent work sessions and export them to system administrators or customer support staff.
Traces of system events and error messages captured by the Session Viewer provide a clear
picture of system operations, and enable you to investigate the causes of system disruptions
or performance issues.

The Session Viewer complements the Session Monitor page by extending the range of
sessions under review, from those that are currently active, to those that occurred in the past.
The parameter Days Until Traces Are Deleted (IBI_TRACE_RETAIN_DAYS) defines the number of
days that the Session Viewer retains information about sessions. It also focuses your review
by limiting the range of available sessions to those created by you and by those users whose
session activities you have permission to review.

The Session Viewer is only available to Managers. To open the Session Viewer, sign in as a
Manager, and in the Portal Menu bar, click Tools, and then click Session Viewer. If you are
signed in as a Manager, you can also open the Session Viewer from the View Trace icons in
the Session Monitor page.

You can view sessions you started and sessions started by other users.

Reviewing the Session Viewer Main Page

The main page of the Session Viewer displays information about your current work session. It
also lists entries for all recently completed sessions that you have permission to review, as
shown in the following image.
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To open the main page of the Session Viewer, sign in as a Manager, and in the Portal Menu
bar, click Tools, and then click Session Viewer. When the main page opens, your sign-in
information and the ID of the session you are viewing appear at the top of the screen. The
session ID follows the format YYMMDD/username_HHMMSS. It contains the date, time, and
username of the session on display. For each session, the following information is available:

User Name

The name of the user that signed in to this work session.

Tracing Level

The level of traces captured by the current session. The default value for this field is Off,
but you can choose another value from the drop-down list. The Session Viewer saves this
selection when you close the viewer, and uses it as the default setting for your next
session.

The four tracing levels are cumulative, meaning each higher level includes the traces of all
of the levels below it. These levels include:

Basic. Generates a trace for each URL, which includes IBFS traces and procedure
traces.

Outputs. Includes Basic level traces and output from URLs that run requests on the
Reporting Server. This level of tracing affects the amount of disk space required to
capture output traces, but does not affect system performance.

Debug. Includes Outputs level traces and log4j debug level written to the Session
Viewer output.

Details. Includes Debug level traces and legacy WFServlet traces. This level of tracing
affects session performance.

Server. Includes Details level traces and generates traces for the Reporting Server
activity for the current work session.

Fex Echo Setting

The level of echo traces captured from the execution of FEX file commands. In a FEX file,
the &ECHO variable displays command lines as they execute in order to test and debug
procedures. These levels include:

On. Displays WebFOCUS commands that are expanded and stacked for execution in its
traces.

All. Displays Dialogue Manager commands and WebFOCUS commands that are
expanded and stacked for execution in its traces.
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Off. Suppresses the display of both stacked commands and Dialogue Manager
commands in its traces. This value is the default.

None. Prevents procedure code from being displayed (echoed). Once the value of
&ECHO has been set to NONE, it cannot be changed during the session or connection.

SQL Tracing

The level of traces captured from SQL events. These levels include:

On. Displays traces of all SQL request and response events. Even if you select this
setting, however, the Session Viewer will not display SQL event traces if there are no
requests issued to an SQL database.

Off. Suppresses the display of traces of SQL request and response events.

Viewing File 

The name of the Viewing File. File names are identified by their start time and end time in
HH.MM format. If an asterisk (*) is displayed as the end time, current traces are being
routed to that file.

You can click New File, to capture a new set of traces, which allows users to capture a set
of URLs to be reviewed. When you click this link, the Session Viewer automatically creates
a new file and assigns all subsequent traces to it. You can review prior traces by clicking a
file containing completed traces in the Viewing File list.

Session Started

The time that your active session started, in HH:MM:SS format.

Last Activity

The start time of the most recent activity in your active session, in HH:MM:SS format.

URL Count

The total number of URLs issued for the session that you are viewing.

Average Response

The average response time for all URLs issued for the session that you are viewing.

Server Requests

The number of requests made to your Reporting Server during your active session.

Average Server Time

The average time (in seconds) that it takes the Reporting Server to respond to a request.

7. Troubleshooting

Online Help PDF  839



Average DBMS Time

The average time (in seconds) that it takes the Reporting Server to respond to a request
directed to a non-WebFOCUS or RDBMS database.

If no current session file is available, the section below the status bar displays the following
text:

Session file does not exist.

If a current session file is available, the section below the status bar lists traces for that file.

You can also view a table containing links representing recently completed sessions. If
multiple viewable sessions occurred on a specific date, they are listed from left to right in that
table in the order in which they occurred, earliest to latest.

Information from completed sessions remains available for the period defined in the setting,
Days Until Traces Are Deleted (IBI_TRACE_RETAIN_DAYS).

To view a different session, click a session link on the main page or the session details page.
A new page displaying traces for your selected session opens.

Note: The session information links connect to completed sessions only. To view a current
session, open the Session Monitor page from the Administration Console, and click an
Information icon, if one appears.

Reviewing the Session Details Page

To open the session details page, click a session link in the Existing session traces column of
the main page. The session details page opens, as shown in the following image:
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This page displays a group of features that enables you to review relevant details about your
selected session, review summary versions of the traces it created, and move on to other
sessions.

When the review of your selected session is complete, close the session details page to return
to the main page.

When you open the session details page, your sign-in information and the ID of your selected
session appear at the top of the screen.

A table underneath the Session ID lists additional details identifying the session under review.
The User Name entry identifies the name of the user who initiated the session on display.

The Inactive Session entry identifies the session as being inactive or active. If this entry is
blank, the session on display is inactive. If a value appears in this entry, the session on
display is currently open.

The Viewing File entry identifies the range of trace entries on display, as defined by start time.
By default, this value displays the entire range of trace entries from the start time to an
undefined end time. If a drop-down button appears, you can select a different time range from
the drop-down menu.

You can use the following options to change the display of trace information that you want to
view.

Refresh. Adds any traces to the list that were generated after you opened an active
session. This option is not available to previously completed sessions.

Previous. Moves the display back to view an earlier set of traces.

Next. Moves the display forward to view a later set of traces.

Last. Moves the display to view the final set of traces captured right before the end of the
session.

View. Limits the list of traces by type.

All URLs. Displays URLs that return static content, such as .css files, .html files, .js
files, and dynamic URLs that perform a Client action, as well as URLs that perform an
action on the Reporting Server.

Work URLs. Limits the display to dynamic URLs, as well as Reporting Server requests.
This is the default setting.

Server Requests. Limits the display to URLs that access the Reporting Server.
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In groups of. Determines the number of trace entries that appear on a single page. You can
select 1, 5, 10, 25, 50, 100, or 200. Your selection in this field impacts the use of the
Previous, Next, and Last options. The larger the value you select, the fewer times you will
be required to move to the previous or next page.

HighLight. Assigns a yellow highlight to the start time field of all trace entries that contain
the search term that you type in this field.

For example, if you type the term short, a highlight appears in the Start Time field for any
trace entry that contains this term, such as:

IBFS checkPolicy Success
IBFS:/EDA/ACTWIN7/ibisamp/short.mas

Note: After your search results produce a match, the highlights from that match will not
clear until you close the session details window. Therefore, to prevent false matches to any
subsequent search, you must close and reopen the session details window.

ZIP Session Traces. Saves all of the traces from the session to a single.zip file. When you
click this link, you are prompted to open or save the file. Click Save As, browse to a storage
location for the.zip file, and then click Save.

The default name for this .zip file is sessionmonitor, followed by the number of trace and log
files it contains.

These options also appear below the trace information table.

The trace information table enables you to review individual session traces in more detail. It
displays one summary entry for each trace captured during the session. You can expand these
entries to review the detailed event messages captured by the trace.

The table located below the trace information table and options identify the User Agent and
Build that started the session. Details identifying the User Agent include the browser,
operating systems, and supporting applications. Details identifying the Build include, the
version number, build number, and generation date of the version of WebFOCUS BUE to which
this session was connected.

A list of recently completed sessions appears at the bottom of the page. This list is a duplicate
of the session list on the main page and appears here to enable you to move on to another
session without having to leave the session details page.
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Reviewing Trace Entries

Each entry in the list of traces on the session details page represents the record for a single
system activity, as shown in the following image.

One activity can include multiple events, and these events become visible when you expand
the icon next to a trace to view its full detail.

For each trace, the following information is available:

Start

The time, in hours, minutes, and seconds, that an event in the trace began. Hours are
expressed in twenty-four hour time notation.

End

The time, in hours, minutes, and seconds, that an event in the trace ended. Hours are
expressed in twenty-four hour time notation.

Number of Seconds Max

The number in the header of this column represents the maximum number of seconds that
were required to complete the longest trace in the list.

Entries in this column contain a (time) bar that represents the relative duration of the
events in the trace, as shown in the following image.

The darkest blue section of the bar represents the number of Web CPU seconds that
were required to process the events in this trace. It also identifies the trace as
containing a Work URL component.

The lightest blue section of the bar represents the number of Web wait seconds that
were required to retrieve a response from a database. It also identifies the trace as
containing a Work URL component.

The brown section of the bar represents the number of Reporting Server seconds that
were required to process the events represented in this trace. It also identifies the
trace as containing a Server Request component.

You can view tooltips that identify the exact number of seconds that each section of a bar
represents by pointing to that section with your mouse. If you are reviewing an active trace
in a current session, the bar appears green and occupies the entire column entry.
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Details

The ID of the trace. This is the URL of the destination of the request message that
launched the trace events. The first term in the URL identifies the servlet or other
application that launched the request. Each trace ID is unique.

When the URL ID number is highlighted in orange, events in the trace associated with it
include one or more error messages. Within the detail trace display, events that contain
error messages are also highlighted in orange to help you identify when the errors
occurred.

Reviewing Expanded URL Details

When you expand an individual Trace Details list entry, a nested list of system-generated
messages opens. These messages identify the events captured by that trace and the time, in
milliseconds, at which those events took place. Events include request and response
messages exchanged between the Client and the Reporting Server or between the Reporting
Server and the application server. They also include error messages, informational messages,
and system status messages generated by application programs as they execute commands.
Entries representing repetitive or subordinate events are nested to help you identify them more
quickly, as shown in the following image.

A trace entry begins with the event start time and the number of milliseconds after the trace
start time at which the event took place. This value helps you distinguish between individual
events, and places them in sequence within an individual trace.

The IBFS status code for the trace event follows the event start time.
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This column contains one of the following symbols:

Symbol Description

IBFS+ The starting event of a program or exchange of data between programs
or applications.

IBFS- The ending or final event of a program or exchange of data between
programs or applications.

IBFX* An error message.

IBFSX An administrative or informational message.

The text of the message generated by the application or program that describes the event
appears next. The type of text displayed in this section varies with the type of trace you have
selected from the View drop-down list.

If you select All URLs or Work URLs, an expanded URL entry displays the status and error
messages that were generated as the program ran.

Note: If your entry includes a Server Request message, the underlined Request ID term of
the trace entry links you to full details of the Reporting Server Request trace, and the
underlined Response ID entry links you to full details of the Reporting Server Response
trace.

If you select Server Request, an expanded URL entry displays the Reporting Server Request
procedure, followed by a list of status or error messages generated during that procedure.
(This is the same display that appears when you open a Server Request link from a
Session Monitor Information icon.)
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Reviewing Reporting Server Request Details

Traces captured from a Reporting Server Request identify the details of the query or other
request operation sent from the Client to the Reporting Server during the session, as shown in
the following image.

This information identifies the variables and commands sent during the request operation.
These requests are usually TABLE requests or -HTMLFORM BEGIN/END requests that are sent
from the Client to the Reporting Server.

The ID term in the first line above the procedure links it to the URL trace from which it was
generated. For example, the ID, URL85, links the procedure to the server request event line
within the activity captured in trace URL 85.

At the end of the list of variables and commands, the procedure displays a list of status
messages describing the results of the query or other operation, as shown in the following
image.
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Reviewing Reporting Server Response Details

Traces captured from a Reporting Server response identify the information returned in
response to a query or other request operation sent during a work session from the Reporting
Server to the Client during a work session.

To view output traces, click on the link from an underlined URL request response entry in a
URL Trace entry, such as:

URL103Req4Resp

The first part of this display identifies the format variables returned to the Client during the
response operation, as shown in the following image.

The second part of the display identifies the data returned to the Client during the response
operation, as shown in the following image.

The Session Viewer can display Reporting Server response traces in XML, HTML, or a standard
report format. Reporting Server responses usually contain data or status messages returned in
response to SQL-based queries, updates, or other database-related operations.

Working With Log Files

The Log Files page displays links to all log files. The main grid lists log files in alphabetical
order by name.
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Next to each log file entry is a list of Logger Names, that is, those pages or events that
contribute entries to that log. For example, the audit.log file captures events from com.ibi.uoa,
com.ibi.config, com.ibi.content, and others. The Log Level field, next to each Logger, identifies
the level of events captured by that contributor.

Event levels are cumulative. Events captured by a higher level are included when you select a
lower level. For example, if you set the level to Warn, you capture Fatal level and Error level
events as well as events that generate a warning.

The levels are defined below:

Off. Capture no events.

Fatal. Capture only events that disrupt system operations.

Error. Capture events that generate error messages in addition to fatal events.

Warn. Capture events that generate warning messages in addition to fatal and error events.

Info. Capture events that generate informational messages in addition to warning, error,
and fatal events.

Debug. Capture events that generate debug messages in addition to informational,
warning, error, and fatal events.

Trace. Capture events that generate trace messages in addition to debug, informational,
warning, error, and fatal events.

Understanding Warning Messages in InfoAssist+

This topic describes InfoAssist+ warning messages.
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InfoAssist+ Warning Messages

Message Description OK Cancel

Are you sure you want to switch
data source? Doing so will
delete your current report.

This warning message
displays when a report
is first saved in a
different format and
one or more additional
reports are created
and saved, and the
user clicks Switch on
the Data tab and
selects a different
report from the
shortcut menu.

Deletes the
current
report.

Preserves the
current report.

Are you sure you want to add a
data source? Doing so will
delete your current report.

This warning message
displays when a report
is first saved in a
different format and
an additional report is
created and saved,
and Add on the Data
tab is selected.

Deletes the
current
report.

Preserves the
current report.

User Selection in this request
is not allowed with your
configuration. Your report will
be converted to default output.

This warning message
displays when the
user selection option
is not available on
restore, or when you
are restoring a user
selection option when
it is disabled at global
preference.

Converts the
report to use
the default
output type.

No changes
are made to
the original
procedure and
it is closed.
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Unsupported Syntax and Objects

This section describes the syntax and objects that are not supported.

SUB-TOTAL syntax is not supported. If you try to open an existing procedure in InfoAssist+
from a legacy tool that contains SUB-TOTAL syntax, an unsupported syntax warning
message displays. If you choose to continue, InfoAssist+ will convert the syntax to
SUBTOTAL and add the converted syntax to all higher level sort breaks.

SUMMARIZE syntax is not supported. If you try to open an existing procedure in InfoAssist+
from a legacy tool that contains SUMMARIZE syntax, an unsupported syntax warning
message displays. If you choose to continue, InfoAssist+ will convert the syntax to
RECOMPUTE.

HTML FULL, FIXED, and PAGED syntax is not supported. If you try to open an existing
procedure in InfoAssist+ from a legacy tool that contains any of these three options, an
unsupported syntax warning message displays. If you choose to continue, InfoAssist+ will
convert the procedure to regular HTML output.

COLUMN-TOTAL syntax is not supported. If you try to open an existing procedure in
InfoAssist+ from a legacy tool that contains this syntax, an unsupported syntax warning
message displays. If you choose to continue, InfoAssist+ will convert it to use RECOMPUTE
syntax.

Line objects in a compound document imported from a legacy tool are not supported. If you
try to open an existing procedure that includes line objects, an unsupported syntax warning
message displays. If you choose to continue, InfoAssist+ will remove these line objects.
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